Version 13

Scripting Guide

“The real voyage of discovery consists not in seeking new landscapes, but in having new eyes.”

Marcel Proust
SAS software may be provided with certain third-party software, including but not limited to open-source software, which is licensed under its applicable third-party software license agreement. For license information about third-party software distributed with SAS software, refer to http://support.sas.com/thirdpartylicenses.

**Technology License Notices**

- **Scintilla** - Copyright © 1998-2014 by Neil Hodgson <neilh@scintilla.org>. All Rights Reserved.

  Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation.

  **NEIL HODGSON DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL NEIL HODGSON BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.**

- **Telerik RadControls**: Copyright © 2002-2012, Telerik. Usage of the included Telerik RadControls outside of JMP is not permitted.


- **Made with Natural Earth. Free vector and raster map data @ naturalearthdata.com.**

- **Packages** - Copyright © 2009-2010, Stéphane Sudre (s.sudre.free.fr). All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

  Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

  Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

  Neither the name of the WhiteBox nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

  **THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED**
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

• iODBC software - Copyright © 1995-2006, OpenLink Software Inc and Ke Jin (www.iodbc.org). All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
  – Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
  – Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
  – Neither the name of OpenLink Software Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

• bzip2, the associated library “libbzip2”, and all documentation, are Copyright © 1996-2010, Julian R Seward. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

The name of the author may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


• MATLAB software is Copyright © 1984-2012, The MathWorks, Inc. Protected by U.S. and international patents. See www.mathworks.com/patents. MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand names may be trademarks or registered trademarks of their respective holders.

• libopc is Copyright © 2011, Florian Reuter. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

– Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

– Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and / or other materials provided with the distribution.
– Neither the name of Florian Reuter nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

• libxml2 - Except where otherwise noted in the source code (e.g. the files hash.c, list.c and the trio files, which are covered by a similar licence but with different Copyright notices) all the files are:

Copyright © 1998 - 2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL DANIEL VEILLARD BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of Daniel Veillard shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization from him.

• Regarding the decompression algorithm used for UNIX files:

The Regents of the University of California. All rights reserved.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

1. Redistributions of source code must retain the above copyright notice, this list of
   conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
   conditions and the following disclaimer in the documentation and/or other materials
   provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to
   endorse or promote products derived from this software without specific prior written
   permission.

- Snowball - Copyright © 2001, Dr Martin Porter, Copyright © 2002, Richard Boulton.
  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
   conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
   conditions and the following disclaimer in the documentation and/or other materials
   provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be
   used to endorse or promote products derived from this software without specific prior
   written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Get the Most from JMP®

Whether you are a first-time or a long-time user, there is always something to learn about JMP.

Visit JMP.com to find the following:

• live and recorded webcasts about how to get started with JMP
• video demos and webcasts of new features and advanced techniques
• details on registering for JMP training
• schedules for seminars being held in your area
• success stories showing how others use JMP
• a blog with tips, tricks, and stories from JMP staff
• a forum to discuss JMP with other users

http://www.jmp.com/getstarted/
# Contents
## Scripting Guide

## 1 Learn about JMP
### Documentation and Additional Resources
- Formatting Conventions ............................................... 22
- JMP Documentation ......................................................... 23
  - JMP Documentation Library .......................................... 23
  - JMP Help .................................................................. 29
- Additional Resources for Learning JMP ................................. 29
  - Tutorials .................................................................. 30
  - Sample Data Tables ....................................................... 30
  - Learn about Statistical and JSL Terms ......................... 30
  - Learn JMP Tips and Tricks ........................................... 30
  - Tooltips .................................................................. 31
- JMP User Community ........................................................ 31
- JPer Cable .................................................................. 31
- JMP Books by Users ........................................................ 32
  - The JMP Starter Window ............................................ 32
- Technical Support .............................................................. 32

## 2 Introduction
### Welcome to the JMP Scripting Language ............................... 33
- What JSL Can Do for You .................................................. 34
- Help with Learning JSL ..................................................... 34
  - The Scripting Guide ....................................................... 34
  - The Scripting Index ....................................................... 35
  - Let JMP Teach You JSL .................................................. 36
- Terminology .................................................................. 37
- Basic JSL Syntax .............................................................. 40
- Book Conventions ............................................................ 41

## 3 Getting Started
### Let JMP Write Your Scripts .............................................. 43
- Capturing a Script for an Analysis Report .......................... 44
- Capturing a Script for a Data Table .................................. 45
- Capturing a Script to Import a File ................................... 46
- Gluing Scripts Together .................................................... 47
4 Scripting Tools
Using the Script Editor, Log Window, Debugger and Profiler ............................................. 51
Using the Script Editor ................................................................. 52
Run a Script ........................................................................ 52
Stop a Script ........................................................................ 53
Edit a Script ........................................................................ 53
Color Coding ......................................................................... 53
Auto Complete Functions ...................................................... 54
Tooltips ................................................................................ 54
Split a Window .................................................................... 55
Match Parentheses, Brackets, and Brace斯 ............................................ 56
Select a Rectangular Block of Text ........................................... 57
Select Fragmented Text .......................................................... 58
Drag and Drop Text ............................................................... 58
Find and Replace .................................................................. 58
Automatic Formatting ............................................................ 59
Add Code Folding Markers ..................................................... 59
Advanced Options .................................................................. 61
Set Preferences for the Script Editor ......................................... 61
Working with the Log ................................................................ 61
Show the Log in the Script Window .......................................... 63
Save the Log ......................................................................... 63
Debug or Profile Scripts ........................................................... 63
Debugger and Profiler Window .................................................. 64
Work with Breakpoints ........................................................... 67
View Variables ..................................................................... 70
Work with Watches ................................................................ 71
Modify Preferences in Debugger ............................................... 72
Persistent Debugger Sessions .................................................. 72
Examples of Debugging and Profiling Scripts .......................... 73

5 JSL Building Blocks
Learning the Basics of JSL .......................................................... 79
JSL Syntax Rules ................................................................... 80
Value Separators ................................................................... 80
Numbers .............................................................................. 83
Names ................................................................................ 83
Comments ........................................................................... 84
Operators ............................................................................. 85
Global and Local Variables ..................................................... 89
Local Namespaces .................................................................. 90
Named Namespaces ............................................................... 90
Show Symbols, Clear Symbols, and Delete Symbols .................. 90
6  **Types of Data**  
**Working with Numbers, Strings, Dates, Currency, and More**  

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numbers and Strings</td>
<td>120</td>
</tr>
<tr>
<td>Unicode Characters</td>
<td>121</td>
</tr>
<tr>
<td>Path Variables</td>
<td>121</td>
</tr>
<tr>
<td>Create and Customize Path Variables</td>
<td>125</td>
</tr>
<tr>
<td>Relative Paths</td>
<td>125</td>
</tr>
<tr>
<td>File Path Separators</td>
<td>125</td>
</tr>
<tr>
<td>Date-Time Functions and Formats</td>
<td>126</td>
</tr>
<tr>
<td>Date-Time Values</td>
<td>126</td>
</tr>
<tr>
<td>Program with Date-Time Functions</td>
<td>127</td>
</tr>
<tr>
<td>Date-Time Values in Data Tables</td>
<td>134</td>
</tr>
</tbody>
</table>
7 Data Structures

## Working with Collections of Data

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>138</td>
</tr>
<tr>
<td>Hexadecimal and BLOB Functions</td>
<td>139</td>
</tr>
<tr>
<td>Work with Character Functions</td>
<td>142</td>
</tr>
<tr>
<td>- Concat</td>
<td>142</td>
</tr>
<tr>
<td>- Munger</td>
<td>143</td>
</tr>
<tr>
<td>- Repeat</td>
<td>144</td>
</tr>
<tr>
<td>Regular Expressions</td>
<td>145</td>
</tr>
<tr>
<td>- Regex</td>
<td>145</td>
</tr>
<tr>
<td>- Regex Match</td>
<td>146</td>
</tr>
<tr>
<td>- Special Characters in Regular Expressions</td>
<td>148</td>
</tr>
<tr>
<td>- Escaped Characters in Regular Expressions</td>
<td>150</td>
</tr>
<tr>
<td>- Greedy and Reluctant Regular Expressions</td>
<td>151</td>
</tr>
<tr>
<td>- Backreferences and Capturing Groups</td>
<td>154</td>
</tr>
<tr>
<td>- Lookaround Assertions</td>
<td>154</td>
</tr>
<tr>
<td>Pattern Matching</td>
<td>155</td>
</tr>
<tr>
<td>- Patterns and Case</td>
<td>158</td>
</tr>
</tbody>
</table>

## Matrices

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Construct Matrices</td>
<td>170</td>
</tr>
<tr>
<td>Subscripts</td>
<td>171</td>
</tr>
<tr>
<td>Inquiry Functions</td>
<td>175</td>
</tr>
<tr>
<td>Comparisons, Range Checks, and Logical Operators</td>
<td>175</td>
</tr>
<tr>
<td>Numeric Operations</td>
<td>176</td>
</tr>
<tr>
<td>Concatenation</td>
<td>179</td>
</tr>
<tr>
<td>Transpose</td>
<td>179</td>
</tr>
<tr>
<td>Indexing into a Matrix or List with Another Matrix or List</td>
<td>180</td>
</tr>
<tr>
<td>Matrices and Data Tables</td>
<td>181</td>
</tr>
<tr>
<td>Matrices and Reports</td>
<td>183</td>
</tr>
<tr>
<td>Loc Functions</td>
<td>184</td>
</tr>
</tbody>
</table>
8 Programming Methods

Complex Scripting Techniques and Additional Functions

Lists and Expressions ................................................................. 218
    Stored expressions ........................................................... 218
    Macros .............................................................................. 228
    Manipulating lists .............................................................. 228
    Manipulating Expressions ................................................... 230

Advanced Scoping and Namespaces ............................................ 235
    Names Default To Here ....................................................... 235
    Scoped Names .................................................................... 238
    Namespaces ........................................................................ 241
    Referencing Namespaces and Scopes ................................... 247
    Resolving Named Variable References ................................ 249
    Best Practices for Advanced Scripting .................................. 251

Advanced Programming Concepts .............................................. 251
    Throwing and Catching Exceptions ..................................... 252
    Functions .......................................................................... 253
    Recursion .......................................................................... 256
    Includes .............................................................................. 256
    Loading and Saving Text Files ............................................. 257

File and Directory Operations ..................................................... 257
    Select a Directory or File .................................................... 257
    Get a List of Filenames ........................................................ 259

Scripting BY Groups .................................................................. 259

Encrypt and Decrypt Scripts ...................................................... 260
    Encryption and Global Variables ......................................... 262
    Encrypting Scripts in Data Tables ....................................... 262

Additional Numeric Operators .................................................. 263
    Derivatives ....................................................................... 263
    Algebraic Manipulations .................................................... 266
9 Data Tables

9.1 Working with Data Table Objects

9.1.1 Get Started

9.1.2 Basic Data Table Scripting

9.1.2.1 Open a Data Table

9.1.2.2 Create a New Data Table

9.1.2.3 Import Data

9.1.2.4 Set the Current Data Table

9.1.2.5 Name a Data Table

9.1.2.6 Save a Data Table

9.1.2.7 Hide a Data Table

9.1.2.8 Print a Data Table

9.1.2.9 Resize a Data Table

9.1.2.10 Close a Data Table

9.1.2.11 Set and Get a Data Table

9.1.2.12 Perform Actions on All Open Data Tables

9.1.2.13 Create Journals and Layouts

9.1.3 Advanced Data Table Scripting

9.1.3.1 Store Summary Statistics in Global Variables

9.1.3.2 Create a Table of Summary Statistics

9.1.3.3 Subset a Data Table

9.1.3.4 Sort a Data Table

9.1.3.5 Stack Values in a Data Table

9.1.3.6 Split Values in a Stacked Data Table

9.1.3.7 Transpose a Data Table

9.1.3.8 Vertically Concatenate Data Tables

9.1.3.9 Horizontally Concatenate Data Tables

9.1.3.10 Virtually Join Data Tables

9.1.3.11 Replace Data in Data Tables

9.1.3.12 Create a Table Using Tabulate

9.1.3.13 Find Missing Data Patterns

9.1.3.14 Compare Data Tables

9.1.3.15 Create a Summary Table

9.1.3.16 Subscribe to a Data Table

9.1.3.17 Move Data Between Matrices and Data Tables

9.1.4 Columns

9.1.5 Send Messages to Data Column Objects

Maximize and Minimize ................................................................. 267
Scheduling Actions ................................................................. 268
Functions that Communicate with Users ................................................................. 270
  Writing to the Log ................................................................. 270
  Send information to the User ................................................................. 271

Get Started ................................................................. 276

Basic Data Table Scripting ................................................................. 278
  Open a Data Table ................................................................. 278
  Create a New Data Table ................................................................. 280
  Import Data ................................................................. 281
  Set the Current Data Table ................................................................. 290
  Name a Data Table ................................................................. 291
  Save a Data Table ................................................................. 291
  Hide a Data Table ................................................................. 292
  Print a Data Table ................................................................. 293
  Resize a Data Table ................................................................. 293
  Close a Data Table ................................................................. 294
  Set and Get a Data Table ................................................................. 294
  Perform Actions on All Open Data Tables ................................................................. 295
  Create Journals and Layouts ................................................................. 295

Advanced Data Table Scripting ................................................................. 297
  Store Summary Statistics in Global Variables ................................................................. 297
  Create a Table of Summary Statistics ................................................................. 300
  Subset a Data Table ................................................................. 302
  Sort a Data Table ................................................................. 308
  Stack Values in a Data Table ................................................................. 309
  Split Values in a Stacked Data Table ................................................................. 309
  Transpose a Data Table ................................................................. 310
  Vertically Concatenate Data Tables ................................................................. 311
  Horizontally Concatenate Data Tables ................................................................. 312
  Virtually Join Data Tables ................................................................. 313
  Replace Data in Data Tables ................................................................. 314
  Create a Table Using Tabulate ................................................................. 315
  Find Missing Data Patterns ................................................................. 316
  Compare Data Tables ................................................................. 316
  Create a Summary Table ................................................................. 317
  Subscribe to a Data Table ................................................................. 318
  Move Data Between Matrices and Data Tables ................................................................. 319

Columns ................................................................. 319
  Send Messages to Data Column Objects ................................................................. 320
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Columns</td>
<td>321</td>
</tr>
<tr>
<td>Add Several Columns at Once</td>
<td>323</td>
</tr>
<tr>
<td>Group Columns</td>
<td>323</td>
</tr>
<tr>
<td>Select Columns</td>
<td>326</td>
</tr>
<tr>
<td>Rearrange and Move Columns</td>
<td>327</td>
</tr>
<tr>
<td>Add a Column Switcher</td>
<td>327</td>
</tr>
<tr>
<td>Compress Selected Columns</td>
<td>328</td>
</tr>
<tr>
<td>Delete Columns</td>
<td>328</td>
</tr>
<tr>
<td>Obtain Column Names</td>
<td>328</td>
</tr>
<tr>
<td>Column Attributes</td>
<td>329</td>
</tr>
<tr>
<td>Column Properties</td>
<td>335</td>
</tr>
<tr>
<td>Rows</td>
<td>341</td>
</tr>
<tr>
<td>Add Rows</td>
<td>341</td>
</tr>
<tr>
<td>Delete Rows</td>
<td>342</td>
</tr>
<tr>
<td>Select Rows</td>
<td>343</td>
</tr>
<tr>
<td>Find Rows</td>
<td>345</td>
</tr>
<tr>
<td>Move Rows</td>
<td>346</td>
</tr>
<tr>
<td>Assign Colors and Markers to Rows</td>
<td>346</td>
</tr>
<tr>
<td>Color Cells</td>
<td>347</td>
</tr>
<tr>
<td>Hide, Exclude, and Label Rows</td>
<td>348</td>
</tr>
<tr>
<td>Iterate on Rows in a Table</td>
<td>348</td>
</tr>
<tr>
<td>Row States and Operators</td>
<td>352</td>
</tr>
<tr>
<td>Accessing Data Values</td>
<td>369</td>
</tr>
<tr>
<td>Set or Get Values by Column Name</td>
<td>369</td>
</tr>
<tr>
<td>Additional Ways to Access Data Values</td>
<td>370</td>
</tr>
<tr>
<td>Add Metadata to a Data Table</td>
<td>371</td>
</tr>
<tr>
<td>Table Variables</td>
<td>371</td>
</tr>
<tr>
<td>Table Scripts</td>
<td>372</td>
</tr>
<tr>
<td>Formulas</td>
<td>373</td>
</tr>
<tr>
<td>Delete Metadata</td>
<td>375</td>
</tr>
<tr>
<td>Calculations</td>
<td>375</td>
</tr>
<tr>
<td>Pre-Evaluated Statistics</td>
<td>375</td>
</tr>
<tr>
<td>Calculator Formulas</td>
<td>377</td>
</tr>
<tr>
<td><strong>10 Scripting Platforms</strong></td>
<td></td>
</tr>
<tr>
<td>Example of Scripting a Platform</td>
<td>379</td>
</tr>
<tr>
<td>Send Messages to a Platform</td>
<td>380</td>
</tr>
<tr>
<td>Conventions for Messages and Arguments</td>
<td>383</td>
</tr>
<tr>
<td>Send Multiple Messages</td>
<td>383</td>
</tr>
<tr>
<td>Find Messages for Objects</td>
<td>384</td>
</tr>
<tr>
<td>Interpret the Show Properties List</td>
<td>385</td>
</tr>
<tr>
<td>Specify Which Columns to Analyze</td>
<td>387</td>
</tr>
</tbody>
</table>
11 Display Trees

Create and Interact with Windows

Create Column References
Specify Multiple Column Names at Once
Enable Users to Specify Columns
Specify a By Variable
Filter by Value or Column
Enable User Input
Execute Embedded Red Triangle Options
Make Platforms Invisible
Specify Report Titles
Common Messages for Platform Windows
Scripting Considerations by Platform
Explorer Outliers
Scripting-Only Messages and Arguments by Platform

Example of Creating a Graph Box
Extract Values from a Window
Constructors for New Windows
Interact with a Closing Window
Update an Existing Display
Set Function and Set Script
Get and Set Selected Values of Display Elements That Return Lists
Send Messages to Constructed Displays
Construct Display Boxes That Contain Platforms
Examples of Creating a Dashboard from Two Reports
Example of Creating a Cluster Platform Launch Window
Example of Constructing a Custom Platform

Modal Windows

Construct a Modal Window
Comparison of Column Dialog and New Window
Constructors for Column Dialogs

Script Editor Commands
Convert Deprecated Dialog to New Window
Scripting Guide

12 Scripting Graphs

13 Three-Dimensional Scenes
14 Extending JMP

External Data Sources, Analytical Tools, and Automation

Real-Time Data Capture

Create a Datafeed Object

Read in Real-Time Data

Manage a Datafeed with Messages

Examples of Datafeed

Dynamic Link Libraries (DLLs)

Using Sockets in JSL

Socket-Related Commands

Messages for Sockets

Database Access
15 Creating Applications

Application Builder

Create Applications with Application Builder

Example of Creating an Application

Application Builder Terminology

Design an Application

Application Builder Window

Application Builder Red Triangle Options

Create an Application

Edit or Run an Application

Options for Saving Applications

Additional Examples of Creating Applications

Compile Add-Ins with the JMP Add-In Builder

Compile Scripts into an Add-In Using Add-In Builder

Edit an Add-In

Share an Add-In

Register an Add-In Using JSL

Create an Add-In Manually

Manage JMP Add-Ins
16 Common Tasks
Getting Started with Sample Scripts .................................................. 685
Run a Script at Start Up ................................................................. 686
Convert Character Dates to Numeric Dates ....................................... 686
Format Date/Time Values and Subset Data ....................................... 688
Create a Formula Column ............................................................... 689
Extract Values from an Analysis into a Report ................................. 690
Create an Interactive Program ........................................................... 694

A Compatibility Notes
Changes in Scripting from JMP 12 to JMP 13 ................................. 697
Compatibility Issues ......................................................................... 697
Deprecated JSL ................................................................................. 699

B Glossary
Terms, Concepts, and Placeholders ................................................. 701

Index
Scripting Guide ................................................................................. 705
This chapter includes the following information:

- book conventions
- JMP documentation
- JMP Help
- additional resources, such as the following:
  - other JMP documentation
  - tutorials
  - indexes
  - Web resources
  - technical support options
Formatting Conventions

The following conventions help you relate written material to information that you see on your screen:

- Sample data table names, column names, pathnames, filenames, file extensions, and folders appear in *Helvetica* font.
- Code appears in *Lucida Sans Typewriter* font.
- Code output appears in *Lucida Sans Typewriter italic* font and is indented farther than the preceding code.
- **Helvetica bold** formatting indicates items that you select to complete a task:
  - buttons
  - check boxes
  - commands
  - list names that are selectable
  - menus
  - options
  - tab names
  - text boxes
- The following items appear in italics:
  - words or phrases that are important or have definitions specific to JMP
  - book titles
  - variables
  - script output
- Features that are for JMP Pro only are noted with the JMP Pro icon 📈. For an overview of JMP Pro features, visit [http://www.jmp.com/software/pro/](http://www.jmp.com/software/pro/).

**Note:** Special information and limitations appear within a Note.

**Tip:** Helpful information appears within a Tip.
JMP offers documentation in various formats, from print books and Portable Document Format (PDF) to electronic books (e-books).

- Open the PDF versions from the Help > Books menu.
- All books are also combined into one PDF file, called JMP Documentation Library, for convenient searching. Open the JMP Documentation Library PDF file from the Help > Books menu.
- You can also purchase printed documentation and e-books on the SAS website: http://www.sas.com/store/search.ep?keyWords=JMP

JMP Documentation Library

The following table describes the purpose and content of each book in the JMP library.

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Document Purpose</th>
<th>Document Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovering JMP</td>
<td>If you are not familiar with JMP, start here.</td>
<td>Introduces you to JMP and gets you started creating and analyzing data.</td>
</tr>
<tr>
<td>Using JMP</td>
<td>Learn about JMP data tables and how to perform basic operations.</td>
<td>Covers general JMP concepts and features that span across all of JMP, including importing data, modifying columns properties, sorting data, and connecting to SAS.</td>
</tr>
<tr>
<td>Basic Analysis</td>
<td>Perform basic analysis using this document.</td>
<td>Describes these Analyze menu platforms:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Distribution</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fit Y by X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tabulate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Text Explorer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Covers how to perform bivariate, one-way ANOVA, and contingency analyses through Analyze &gt; Fit Y by X. How to approximate sampling distributions using bootstrapping and how to perform parametric resampling with the Simulate platform are also included.</td>
</tr>
<tr>
<td>Document Title</td>
<td>Document Purpose</td>
<td>Document Content</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Essential Graphing</td>
<td>Find the ideal graph for your data.</td>
<td>Describes these Graph menu platforms:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Graph Builder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Overlay Plot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scatterplot 3D</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Contour Plot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Bubble Plot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Parallel Plot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cell Plot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Treemap</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scatterplot Matrix</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ternary Plot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Chart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The book also covers how to create background and custom maps.</td>
</tr>
<tr>
<td>Profilers</td>
<td>Learn how to use interactive profiling tools, which enable you to view cross-sections of any response surface.</td>
<td>Covers all profilers listed in the Graph menu. Analyzing noise factors is included along with running simulations using random inputs.</td>
</tr>
<tr>
<td>Design of Experiments Guide</td>
<td>Learn how to design experiments and determine appropriate sample sizes.</td>
<td>Covers all topics in the DOE menu and the Specialized DOE Models menu item in the Analyze &gt; Specialized Modeling menu.</td>
</tr>
<tr>
<td>Document Title</td>
<td>Document Purpose</td>
<td>Document Content</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fitting Linear Models</td>
<td>Learn about Fit Model platform and many of its personalities.</td>
<td>Describes these personalities, all available within the Analyze menu Fit Model platform:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Standard Least Squares</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Stepwise</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Generalized Regression</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mixed Model</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MANOVA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Loglinear Variance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Nominal Logistic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ordinal Logistic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Generalized Linear Model</td>
</tr>
<tr>
<td>Document Title</td>
<td>Document Purpose</td>
<td>Document Content</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Predictive and Specialized Modeling</td>
<td>Learn about additional modeling techniques.</td>
<td>Describes these Analyze &gt; Predictive Modeling menu platforms:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Modeling Utilities</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Neural</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Partition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Bootstrap Forest</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Boosted Tree</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• K Nearest Neighbors</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Naive Bayes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Model Comparison</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Formula Depot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Describes these Analyze &gt; Specialized Modeling menu platforms:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fit Curve</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Nonlinear</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gaussian Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Time Series</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Matched Pairs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Describes these Analyze &gt; Screening menu platforms:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Response Screening</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Process Screening</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Predictor Screening</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Association Analysis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The platforms in the Analyze &gt; Specialized Modeling &gt; Specialized DOE Models menu are described in Design of Experiments Guide.</td>
</tr>
<tr>
<td>Document Title</td>
<td>Document Purpose</td>
<td>Document Content</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><em>Multivariate Methods</em></td>
<td>Read about techniques for analyzing several variables</td>
<td>Describes these Analyze &gt; Multivariate Methods menu platforms:</td>
</tr>
<tr>
<td></td>
<td>simultaneously.</td>
<td>• Multivariate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Principal Components</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Discriminant</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Partial Least Squares</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Describes these Analyze &gt; Clustering menu platforms:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hierarchical Cluster</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• K Means Cluster</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Normal Mixtures</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Latent Class Analysis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cluster Variables</td>
</tr>
<tr>
<td><em>Quality and Process Methods</em></td>
<td>Read about tools for evaluating and improving processes.</td>
<td>Describes these Analyze &gt; Quality and Process menu platforms:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Control Chart Builder and individual control charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Measurement Systems Analysis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Variability / Attribute Gauge Charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Process Capability</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pareto Plot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Diagram</td>
</tr>
<tr>
<td>Document Title</td>
<td>Document Purpose</td>
<td>Document Content</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reliability and</td>
<td>Learn to evaluate and improve reliability in a product or system and analyze</td>
<td>Describes these Analyze &gt; Reliability and Survival menu platforms:</td>
</tr>
<tr>
<td>Survival Methods</td>
<td>survival data for people and products.</td>
<td>• Life Distribution</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fit Life by X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cumulative Damage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recurrence Analysis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Degradation and Destructive Degradation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reliability Forecast</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reliability Growth</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reliability Block Diagram</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Repairable Systems Simulation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Survival</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fit Parametric Survival</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fit Proportional Hazards</td>
</tr>
<tr>
<td>Consumer Research</td>
<td>Learn about methods for studying consumer preferences and using that insight</td>
<td>Describes these Analyze &gt; Consumer Research menu platforms:</td>
</tr>
<tr>
<td></td>
<td>to create better products and services.</td>
<td>• Categorical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Multiple Correspondence Analysis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Multidimensional Scaling</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Factor Analysis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Choice</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MaxDiff</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Uplift</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Item Analysis</td>
</tr>
<tr>
<td>Scripting Guide</td>
<td>Learn about taking advantage of the powerful JMP Scripting Language (JSL).</td>
<td>Covers a variety of topics, such as writing and debugging scripts, manipulating data tables, constructing display boxes, and creating JMP applications.</td>
</tr>
</tbody>
</table>
JMP Help

JMP Help is an abbreviated version of the documentation library that provides targeted information. You can open JMP Help in several ways:

- On Windows, press the F1 key to open the Help system window.
- Get help on a specific part of a data table or report window. Select the Help tool 🔄 from the Tools menu and then click anywhere in a data table or report window to see the Help for that area.
- Within a JMP window, click the Help button.
- Search the Help at http://jmp.com/support/help/ (English only).

Additional Resources for Learning JMP

In addition to JMP documentation and JMP Help, you can also learn about JMP using the following resources:

- Tutorials (see “Tutorials” on page 30)
- Sample data (see “Sample Data Tables” on page 30)
- Indexes (see “Learn about Statistical and JSL Terms” on page 30)
- Tip of the Day (see “Learn JMP Tips and Tricks” on page 30)
- Web resources (see “JMP User Community” on page 31)
- JMPer Cable technical publication (see “JMPer Cable” on page 31)
- Books about JMP (see “JMP Books by Users” on page 32)
- JMP Starter (see “The JMP Starter Window” on page 32)
• Teaching Resources (see “Sample Data Tables” on page 30)

Tutorials

You can access JMP tutorials by selecting Help > Tutorials. The first item on the Tutorials menu is Tutorials Directory. This opens a new window with all the tutorials grouped by category.

If you are not familiar with JMP, then start with the Beginners Tutorial. It steps you through the JMP interface and explains the basics of using JMP.

The rest of the tutorials help you with specific aspects of JMP, such as designing an experiment and comparing a sample mean to a constant.

Sample Data Tables

All of the examples in the JMP documentation suite use sample data. Select Help > Sample Data Library to open the sample data directory.

To view an alphabetized list of sample data tables or view sample data within categories, select Help > Sample Data.

Sample data tables are installed in the following directory:

On Windows: C:\Program Files\SAS\JMP\13\Samples\Data

On Macintosh: \Library\Application Support\JMP\13\Samples\Data

In JMP Pro, sample data is installed in the JMPPRO (rather than JMP) directory. In JMP Shrinkwrap, sample data is installed in the JMPsw directory.

To view examples using sample data, select Help > Sample Data and navigate to the Teaching Resources section. To learn more about the teaching resources, visit http://jmp.com/tools.

Learn about Statistical and JSL Terms

The Help menu contains the following indexes:

Statistics Index  Provides definitions of statistical terms.

Scripting Index  Lets you search for information about JSL functions, objects, and display boxes. You can also edit and run sample scripts from the Scripting Index.

Learn JMP Tips and Tricks

When you first start JMP, you see the Tip of the Day window. This window provides tips for using JMP.
To turn off the Tip of the Day, clear the **Show tips at startup** check box. To view it again, select **Help > Tip of the Day**. Or, you can turn it off using the Preferences window. See the *Using JMP* book for details.

**Tooltips**

JMP provides descriptive tooltips when you place your cursor over items, such as the following:

- Menu or toolbar options
- Labels in graphs
- Text results in the report window (move your cursor in a circle to reveal)
- Files or windows in the Home Window
- Code in the Script Editor

**Tip:** On Windows, you can hide tooltips in the JMP Preferences. Select **File > Preferences > General** and then deselect **Show menu tips**. This option is not available on Macintosh.

**JMP User Community**

The JMP User Community provides a range of options to help you learn more about JMP and connect with other JMP users. The learning library of one-page guides, tutorials, and demos is a good place to start. And you can continue your education by registering for a variety of JMP training courses.

Other resources include a discussion forum, sample data and script file exchange, webcasts, and social networking groups.

To access JMP resources on the website, select **Help > JMP User Community** or visit [https://community.jmp.com/](https://community.jmp.com/).

**JMPer Cable**

The JMPer Cable is a yearly technical publication targeted to users of JMP. The JMPer Cable is available on the JMP website:

[http://www.jmp.com/about/newsletters/jmpercable/](http://www.jmp.com/about/newsletters/jmpercable/)
JMP Books by Users

Additional books about using JMP that are written by JMP users are available on the JMP website:


The JMP Starter Window

The JMP Starter window is a good place to begin if you are not familiar with JMP or data analysis. Options are categorized and described, and you launch them by clicking a button. The JMP Starter window covers many of the options found in the Analyze, Graph, Tables, and File menus. The window also lists JMP Pro features and platforms.

- To open the JMP Starter window, select View (Window on the Macintosh) > JMP Starter.
- To display the JMP Starter automatically when you open JMP on Windows, select File > Preferences > General, and then select JMP Starter from the Initial JMP Window list. On Macintosh, select JMP > Preferences > Initial JMP Starter Window.

Technical Support

JMP technical support is provided by statisticians and engineers educated in SAS and JMP, many of whom have graduate degrees in statistics or other technical disciplines.

Many technical support options are provided at http://www.jmp.com/support, including the technical support phone number.
The JMP Scripting Language, or JSL, lets you write scripts to recreate results in JMP. Power users often develop scripts to extend JMP’s functionality and automate a regularly scheduled analysis in production settings. If you do not want to learn JSL, JMP can write the scripts for you.

JSL is used to perform many actions:

- implements column formulas
- launches platforms
- interactively modifies platforms
- creates graphics
What JSL Can Do for You

JMP can automatically save scripts to reproduce any data table or analysis in its current state. You can pause any time in your analysis to save a script to a script window (or script editor), in a data table, or in an analysis report. You can then modify the script as needed for future projects. When you are finished with your work, you can then save a script to reproduce your final results.

Here are some examples where JSL scripts can be helpful:

- Suppose you need to describe an analysis process in detail, from beginning to end. An example is to create an audit trail for a governing agency, or for peers reviewing your journal article.
- Suppose you have a set of analysis steps that should be followed routinely by your lab technicians.
- Suppose you fit the same model to new data every day, and the steps are always the same.

You can use JMP interactively as usual, save scripts to reproduce your work, and in the future run those scripts to reproduce your results.

There are a few things that JSL is not designed to do:

- JMP cannot record scripts while you are working. Though script-recording is a useful feature in some other scripting languages, it is less important for software like JMP, where the results are what matter. You cannot use script-recording to observe how a sequence of interactive steps is performed.
- JSL is not an alternative command-line interface for using the program.

Help with Learning JSL

There are several places within JMP to get help with writing or understanding a JSL script.

The Scripting Guide

The *Scripting Guide* begins with basic information (such as terminology and syntax) for JMP users who are not familiar with the scripting language. The book progresses to more advanced information.

| Chapters 2 through 4 | Includes information about learning JSL, producing basic scripts, and introduces you to the JSL scripting environment. |
Chapters 5 through 8  
Introduces the building blocks of the language; working with basic data types, such as numbers and strings; writing lists, matrices, and associate arrays; namespaces; and the fundamentals of programming in JSL.

Chapters 9 through 13  
Covers using JSL with objects in JMP, such as data tables, platforms, windows, and graphics.

Chapter 14  
Describes how to write scripts that work with external programs, such as SAS, R, and Microsoft Excel.

Chapter 15  
Introduces creating JMP applications in Application Builder, a drag-and-drop environment for visually designing windows with buttons, lists, graphs, and other objects. The chapter also describes how to use Add-In Builder to compile scripts into one easily shared file.

Chapter 16  
Contains a collection of recipes, or script examples, that you can copy and modify for your own use.

Appendices A and B  
Provides information about compatibility issues with the previous version of JMP and defines JSL concepts and terminology.

The Scripting Index

The Scripting Index on the Help menu provides a brief description and the syntax for JSL functions, objects, and display boxes. Each entry includes an example that you can run and modify to test your own code. And an embedded log window lets you see messages as examples are run.

The Scripting Index window includes the following buttons:

- Click the Search button to begin the search.
- Click the Clear button to clear the search text box to begin a new search.
- Click the Settings button to set search types and parameters.

Several types of searches are available from the Settings button:

Partial Match  returns all entries that contain at least a part of the “string” for example, a search for “leas” will return messages such as “Release Zoom” and “Partial Least Squares”. This option is the default search type.
**Exact Phrase** returns entries that contain the exact string, for example, a search for “text” will return all elements that contain the “text” string.

**All Terms** returns entries that contain either or both strings, for example, a search for “t test” will return all elements that contain either or both of the search strings, “Pat Test”, “Shortest Edit Script” and “Paired t test”.

**Any Term** returns entries that contain either of the search strings, for example, a search for “text string” returns “Context Box”, “Drag Text”, and “Is String”.

**Regular Expression** allows you to use the wildcard (*) and period (.) in the search box, for example, searching for “get *name” returns messages such as “Get Name Info” and “Get Namespace”. Searching for “get.*name” returns items such as “Get Color Theme Names”, “Get Name Info”, and “Get Effect Names”.

Several search parameters are also available from the **Settings** button:

- **All Fields** specifies that JMP search all fields in the index for the search string.
- **Titles Only** specifies that JMP search only index titles for the search string.
- **Examples Only** specifies that JMP search only index examples for the search string.
- **Without Examples** specifies that JMP exclude examples from the search.

Click an item’s **Topic Help** button to read more about the item in JMP’s online Help system.

---

**Let JMP Teach You JSL**

The best JSL writer is JMP. You can work in JMP interactively and then save the results as a script to reuse later. With simple modifications, your script can serve as a template for speeding up routine tasks.

Because JSL is a very flexible language, you can reach your goals in many different ways. Here is an example. Typically, the script that JMP saves for you specifies every detail of your analysis, even if most of the details happen automatically by default. Does that mean that the scripts that you write have to be just as complete and detailed? Not at all. You usually need to specify only those details that you would select in the graphical user interface (GUI). For example, if you open **Big Class.jmp** from the sample data folder and want to launch **Distribution** for **height**, **weight**, and **sex**, the following script is all that is necessary:

```javascript
Distribution( Y( :height, :weight, :sex ) );
```

Suppose you run the Distribution platform in the GUI and then select **Save Script > To Script Window** from the red triangle menu for the report. The following script appears:

```javascript
Distribution(   
  Nominal Distribution( Column( :sex ) ),
  Continuous Distribution( Column( :height ) ),
  Continuous Distribution( Column( :weight ) )
)
```
Both scripts give the same result.
Feel free to experiment with JSL. If you think something ought to be possible, it probably is. Give it a try, and see what happens.

Terminology

Before you begin creating scripts, you should become familiar with basic JSL terms used throughout this book.

Operators and Functions

An operator is one- or two-character symbol (such as + or =) for common arithmetic actions.

A function is a command that might contain additional information for the function to use.

Certain JSL functions work the same as operators but provide access to more complex actions. For example, the following two lines are equivalent:

```
2 + 3; // returns 5
Add( 2, 3 ); // returns 5
```

The first line uses the + operator. The second line uses the Add() function equivalent.

Although all JSL operators have function equivalents, not all functions have operator equivalents. For example, Sqrt(a) can be represented only by the Sqrt() function.

Note: In previous versions of JMP and its documentation, the terms operators and functions were used interchangeably. Now each term has a specific meaning.

Objects and Messages

An object is a dynamic entity in JMP, such as a data table, a data column, a platform results window, a graph, and so on. Most objects can receive messages that instruct the object to perform some action on itself.

A message is a JSL expression that is directed to an object. That object knows how to evaluate the message. In the following example, dt is the data table object. << indicates that a message follows. In the following example, the message tells JMP to create a summary table with the specified variables.

```
dt << Summary( Group( :age ), Mean( :height ) )
```

In this expression, dt is the name of a variable that contains a reference to a data table. You could use any name for this variable. This book commonly uses dt to represent data table
references. Here are some of the more common names used in this book to represent references to certain objects:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>dt</td>
<td>data table</td>
</tr>
<tr>
<td>col</td>
<td>column in a data table</td>
</tr>
<tr>
<td>colname</td>
<td>the name of a column in a data table</td>
</tr>
<tr>
<td>obj</td>
<td>an object</td>
</tr>
<tr>
<td>db</td>
<td>display box</td>
</tr>
</tbody>
</table>

These variables are not pre-assigned references. Each one must be assigned prior to its use. In the following example, the global variable named A is assigned the value “Hello, World”. When the Show( A ) command is processed, the result is the value of A.

```plaintext
A = "Hello, World"
Show( A );
A = "Hello, World"
```

Arguments and Parameters

An argument is additional information that you can provide to a function or message. For example, in Root(25), 25 is an argument to the Root() function. Root() acts on the argument that you provide and returns the result: 5.

Programming and scripting books commonly talk about parameters as well. A parameter is a description of the argument that a function accepts. For example, the general specification for Root() might be Root( number ), where number is the parameter.

Parameter and argument express two perspectives of the same concept: information that a function needs.

For simplicity in this book, we use the word argument in both cases.

A named argument is an optional argument that you select from a predetermined set and explicitly define. For example, title("My Line Graph") in the Graph Box() function is a named argument because the title is explicitly defined as such.

```plaintext
Graph Box( title( "My Line Graph" ),
            Frame Size( 300, 500 ),
            Marker( Marker State( 3 ), [11 44 77], [75 25 50] );
            Pen Color( "Blue" );
            Line( [10 30 70], [88 22 44] ));
```
Note that the Frame Size() arguments 300 and 500 are not named. The position of these arguments implies meaning; the first argument is always the width, the second argument is always the height.

Optional Arguments

Functions and messages require certain arguments, and other arguments are optional. You can include them, but you do not have to. In specifications, optional arguments are enclosed in angle brackets. For example:

\[
\text{Root( } x, <n> \text{ )}
\]

The \( x \) argument is required. The \( n \) argument is optional.

Optional arguments often have a default value. For example, for Root(), the default value of \( n \) is 2:

<table>
<thead>
<tr>
<th>Code</th>
<th>Output</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root( 25 )</td>
<td>5</td>
<td>Returns the square root of 25.</td>
</tr>
<tr>
<td>Root( 25, 2 )</td>
<td>5</td>
<td>Returns the square root of 25.</td>
</tr>
<tr>
<td>Root( 25, 3 )</td>
<td>2.92401773821287</td>
<td>Returns the cube root of 25.</td>
</tr>
</tbody>
</table>

Expressions

An expression is a section of JSL code that accomplishes a task. JSL expressions hold data, manipulate data, and send commands to objects. For example, the following expression opens the Big Class.jmp sample data table and creates a Bivariate graph:

\[
\begin{align*}
\text{dt} &= \text{Open( "$SAMPLE_DATA/Big Class.jmp" )}; \\
\text{dt} &\ll \text{Bivariate( Y( :weight ), X( :height ) );}
\end{align*}
\]

Or and the Vertical Bar Symbol

A single vertical bar (|) represents a logical OR. For brevity, | represents the word or when referring to alternative values.

For example, a pathname can be either absolute or relative. When you see an argument such as absolute|relative, this means that you enter \textit{either} one of the following two options:

- \texttt{absolute} indicates an absolute pathname.
- \texttt{relative} indicates a relative pathname.

More than two options can also be strung together with a vertical bar in this way.
Script Formatting

Whitespace characters (such as spaces, tabs, and newlines) and capitalization are ignored in JSL. This means that the following two expressions are equivalent:

```
// Expression 1
sum = 0;
For( i = 1, i <= 10, i++,
    sum += i;
    Show( i, sum );
);

// Expression 2
Sum = 0;
For( i = 1, i <= 10, i++,
    Sum += i;
    Show( i, Sum );
);
```

You can format your script in any way that you like. However, the script editor can also format your script for you. This book uses the script editor’s default formatting for capitalization, spaces, returns, tabs, and so on. See “Using the Script Editor” on page 52 in the “Scripting Tools” chapter for details about using the script editor.

**Note:** The only white space exception is two-character operators (such as `<=` or `++`). The operators cannot be separated by a space.

---

**Basic JSL Syntax**

A JSL script is a series of expressions. Each expression is a section of JSL code that accomplishes a task. JSL expressions hold data, manipulate data, and send commands to objects.

Many expressions are nested message names, with message contents enclosed in parentheses:

```
Message Name ( argument 1, argument 2, ... );
```

The meaning of JSL names depends on the context. The same name might mean one thing in a data table context and something entirely different in a function context. See “Rules for Name Resolution” on page 92 in the “JSL Building Blocks” chapter for more information.

Almost anything that follows certain punctuation rules, such as matching parentheses, is a valid JSL expression. For example:

```
win = New Window( "Window Example",
    <<Modal,
    Text Box( "Hello, World" ),
```
Note the following:

- Names can have embedded spaces. See “Names” on page 83 in the “JSL Building Blocks” chapter for more information.
- Message contents are enclosed in parentheses, which must be balanced. See “Parentheses” on page 80 in the “JSL Building Blocks” chapter.
- Items are separated by commas. See “Commas” on page 80 in the “JSL Building Blocks” chapter.
- JSL is not case sensitive; you can type “text box();” or “Text Box();”.
- Messages are commonly nested inside other messages.

**Book Conventions**

This book Capitalizes The Names of functions that you need to use exactly as they are shown. Arguments that are placeholders for actual choices are in lowercase. For example, `Connect Color` is a function that you need to type as is, and `color` stands for some color choice that you make yourself.

```
Connect Color(color);
```

In this case, the argument in parentheses must be some color value. For example, a JMP color number, or a supported color name like "red", "blue", and so on, or an RGB value given as a list, such as `{.75, .50, .50}`. Sometimes alternatives like these are shown with the vertical bar (|) character for “or,” like this:

```
Connect Color( number | "color name" | {r,g,b} );
```

Syntax coloring is applied to scripts that you can paste into a script editor and then run.
You often have to produce the same reports for the same data on a regular basis. This chapter shows you how to let JMP write scripts for common tasks like importing text data, opening Microsoft Excel files, and producing reports. A final tutorial shows you how to put it all together into a single script to open an Microsoft Excel file and produce three reports automatically.

This book is written for users who are familiar with JMP but might not be familiar with JSL. For information about performing common tasks, refer to the Using JMP book. The Discovering JMP book is also a good resource for learning basic concepts and understanding the JMP workflow.
Capturing a Script for an Analysis Report

The basic steps for capturing a script to reproduce an analysis are as follows:

1. Launch a platform, such as Distribution.
2. Make any changes or additions that you need. For example, add tests and other graphs.
3. Capture the script to recreate your results.

You can save the script in the data table, so that if you send the data table to others, they can run your script and duplicate your reports.

Example

Follow these steps to produce a distribution report, capture the script to reproduce it, and save it to the data table.

Note: The data tables that you use in examples are located in JMP’s Samples/Data folder.

1. Select Help > Sample Data Library and open Companies.jmp.
2. Select Analyze > Distribution to open the Distribution launch window.
3. Select Profits ($M) in the Select Columns box and click the Y, Columns button.
4. Click OK.
   The Distribution report window appears.
5. From the red triangle menu next to Distributions, select Stack to make your report horizontal.
6. From the red triangle menu next to Profits ($M), deselect Outlier Box Plot to turn the option off.
7. From the red triangle menu next to Profits ($M), select Test Mean.
   The Test Mean window appears.
8. Type 500 in the Specify Hypothesized Mean box.
9. Click OK.
   The test for the mean is added to the report window.
   Now you have your customized report.
10. From the red triangle menu next to Distributions, select **Save Script > To Data Table**.

Your data table now has a script named Distribution saved to it. From the red triangle menu for the script, select **Edit** to see the script.

Figure 3.2 Distribution Script Saved to the Data Table

11. To run the script and reproduce your final report exactly, select **Edit > Run Script** from the red triangle menu for the script.

Capturing a Script for a Data Table

The basic steps for capturing a script to reproduce a data table are as follows:

1. Open the data table.
2. Make any changes that you need. For example, add a script, correct values, add new columns.
3. Capture the script to recreate your data table.

**Example**

Use the data table from the previous example, where you saved a script to it.

1. In the data table, select the red triangle next to the data table’s name.
2. Select **Copy Table Script**.

**Figure 3.3** Copy the Table Script

3. Open a script window by selecting **File > New > Script**.
4. Select **Edit > Paste**.

You now have a script that duplicates your data table. You can save this script and run it at any time to recreate your data table, with all its scripts attached.

---

**Capturing a Script to Import a File**

To capture a script that imports a file, you open the file in JMP. JMP automatically records the steps that occurred when you opened the file.

**Import a Text File**

1. Select **File > Open**.
   
   The Open Data File window appears.
2. Select **Text Files** from the list next to **File name**.
3. In the Open as section, select **Data, using best guess**.
   
   JMP formats the data based on tabs, commas, white space, and other characters in the text file.
4. Browse to select the file, and then select **Open**.

The file is opened as a data table. The data table includes a script named Source. This JSL script imports your text file with the text import rules that you used.

5. From the red triangle menu for Source, select **Edit**.

You can copy this script, paste it into a new script window, and save it. Then you can run this script later to reimport the text file.

**Tip:** The import script is an `Open()` expression that specifies the text file and the import options to correctly import the file into JMP. The first part of this expression is the pathname to the specific file that you imported. If you save this script and want to run it a different place, you might need to edit the pathname so that it points to the text file. Pathnames are discussed in greater detail in “Path Variables” on page 121 in the “Types of Data” chapter.

---

**Gluing Scripts Together**

Suppose new data is saved out to an Microsoft Excel file once a week, and you need to produce the same reports every week. You could open the file and perform the same steps every week. However, creating a script that imports the new Microsoft Excel file into JMP and runs all analyses automatically is more efficient. The following example shows you how to set up your script and run it each week.

**Import the Microsoft Excel File**

1. Open a new script window (**File > New > Script**).

2. In your script window, enter the `Open()` expression to open the Solubil.xls sample import data file. The file is located in JMP’s Samples/Import Data folder.

   ```javascript
   dt = Open( "$SAMPLE_IMPORT_DATA/Solubil.xls" );
   ```

   Be sure to put the semicolon at the end of this expression, because you will add more expressions. The semicolon glues expressions together.

3. Run your script to import the Microsoft Excel file by selecting **Edit > Run Script**.

   The Microsoft Excel file opens as a data table.

**Notes:**

- You can also include the `Excel Wizard` argument in the `Open()` expression to preview the worksheet before importing it. See “Import Data from a Microsoft Excel File” on page 287 in the “Data Tables” chapter for details.

- You can specify an absolute or relative path to the file rather than using a path variable. For relative links, the script and file being opened must be in the same relative location each time you run the script. With absolute links, make sure that other users running the
script have access to the file’s location. See “Path Variables” on page 121 in the “Types of Data” chapter for more information about using pathnames.

Run Your Reports and Capture Their Scripts

You have three reports to produce: a distribution report, a 3D scatterplot, and a multivariate report. Perform each one using the GUI, and add its script to the script window.

1. With your new data table open, select Analyze > Distribution.
2. Select all the columns except Labels and click Y, Columns.
3. Click OK.
4. Hold down CTRL and select Histogram Options > Show Counts from the red triangle menu for eth.
   Bar counts are added to all six histograms.
5. In the Distribution window, select Script > Copy Script from the red triangle menu next to Distributions.
6. Place your cursor in the script window a line or two after your Open() expression and select Edit > Paste.
7. Type a semicolon after the last close parenthesis.
8. Select Graph > Scatterplot 3D.
9. Select all the columns except Labels and click Y, Columns.
10. Click OK.
11. Copy and paste the script for Scatterplot 3D into the script window just like you did for your Distribution report. Be sure to add the semicolon at the end.
13. Select all the columns except Labels and click Y, Columns.
14. Click OK.
15. Copy and paste the script for Multivariate into the script window just like you did for Distributions and Scatterplot 3D.

You should see the following script:

```plaintext
dt = Open( "$SAMPLE_IMPORT_DATA/Solubil.xls" );
Distribution(
    Continuous Distribution( Column( :eth ), Show Counts( 1 ) ),
    Continuous Distribution( Column( :oct ), Show Counts( 1 ) ),
    Continuous Distribution( Column( :cc14 ), Show Counts( 1 ) ),
    Continuous Distribution( Column( :c6c6 ), Show Counts( 1 ) ),
    Continuous Distribution( Column( :hex ), Show Counts( 1 ) ),
    Continuous Distribution( Column( :chc13 ), Show Counts( 1 ) ),
);
```
Scatterplot 3D(
    Y( :eth, :oct, :cc14, :c6c6, :hex, :chc13 ),
    Frame3D( Set Grab Handles( 0 ), Set Rotation( -54, 0, 38 ) )
); Multivariate(  
    Y( :eth, :oct, :cc14, :c6c6, :hex, :chc13 ),
    Estimation Method( "Row-wise" ),
    Scatterplot Matrix(  
        Density Ellipses( 1 ),
        Shaded Ellipses( 0 ),
        Ellipse Color( 3 )
    )
);  

Save the Script
You now have a script that reproduces all of the steps that you performed manually. Save the script, and close your data table and all its report windows.

1. In the script window that contains your script, select File > Save or File > Save As.
2. Specify a filename (for example, Weekly Report).
3. Click Save.

Run the Script
As long as your weekly updated Microsoft Excel file is saved in the same place and contains the same columns, you can run your script and automatically produce all your reports.

1. Open the script that you saved.
2. Select Edit > Run Script.
   
   Your Microsoft Excel file is opened in JMP, and all three of your reports appear.

You can send this script to others. As long as they have access to the same Microsoft Excel file in the same location, they can also run the script in JMP and see your reports.

Advanced Note: Auto-Submit
If you want a particular script to always be executed instead of opened into the script window, put the following command on the first line of the script:

    //!

If this is not the very first line, with nothing else on the same line, this command does nothing.

You can override this command when opening the file.

1. Select File > Open.
2. Hold the Ctrl key while you select the JSL file and click Open.
The script opens into a script window instead of being executed.

The command is also ignored when you right-click the file in the Home Window and select Edit Script.
Chapter 4

Scripting Tools

Using the Script Editor, Log Window, Debugger and Profiler

JMP provides several programming tools for script writers. The script editor supports syntax coloring, autocompletes functions as you type, highlights matching braces, allows for code folding, and has additional features to help you develop scripts more quickly. Error messages and output are shown in the log window, which can be displayed inside the script editor. The JMP Scripting Language (JSL) Debugger and Profiler can help you troubleshoot your scripts.

Figure 4.1 Script Editor with Embedded Log and the Debugger
Using the Script Editor

The script editor provides a friendly environment for writing and reading JSL scripts. Figure 4.2 shows basic features such as syntax coloring, inline commenting, and automatic formatting. Other common programming options are described later in this section.

Script editor features are also available in the log window and anywhere else that you can edit or write a script (for example, in the Scripting Index or Application Builder).

Figure 4.2 The Script Editor

Tip: Consider setting the Autosave Time Out value in the General preferences to automatically save open scripts at the specified number of minutes. This autosave value also applies to data tables, journals, scripts, projects, and reports.

Run a Script

To run an entire script, select Edit > Run Script.

To run specific lines in a script, select those lines and then select Edit > Run Script.

To run specific lines that are not adjacent, hold down the Control key, select the lines, and then select Edit > Run Script.
On Windows, you can also click in a line or select several lines and press Enter on your numeric keypad.

Run the script automatically when you open it by using one of the following methods:

- Type `//!` on the first line.
- Include `Run JSL(1)` in the `Open()` statement:
  ```jsl
  Open( "$SAMPLE_SCRIPTS/scoping.jsl", Run JSL( 1 ) );
  ```

**Stop a Script**

To stop the script, press ESC on Windows (or COMMAND-PERIOD on Macintosh). You can also select **Edit > Stop Script**. On Macintosh, **Edit > Stop Script** is available only when the script is running.

**Edit a Script**

To edit a script on Windows, press the Insert key. You can then type directly over (overwrite) any existing JSL code. Note that this feature is not available on Macintosh.

**Color Coding**

On Windows, the default font in the script editor is 10-point Consolas. On Macintosh, the default script editor font is 12-point Courier.

JMP applies the following colors in the script window:

- black for text, identifiers (JSL functions), braces, and user macros
- white for the script editor background
- gray for the disabled background and guides
- green for comments
- purple for strings
- maroon for platform names

**Note:** If a platform name is used in a message, the JSL messages color is used.

- teal blue for numbers
- dark blue for operator symbols, the first keyword, and JSL messages
- medium blue for operator names, second and third keywords, and macros
- red for unknown objects

You can customize colors and fonts in the Customize Styles section of the Script Editor preferences. Options are provided for JSL, the log, SAS code, and other types of code.
Auto Complete Functions

If you do not remember the exact name of a function, use auto completion to see a list of functions that match what you have typed so far. Type part of the name, and then press CTRL-SPACE on Windows (OPTION-ESC on Macintosh).

Suppose that you want to clear your JSL variables, but do not remember the command. You can type clear and then press CTRL-SPACE, to see a list of possible clear commands. Select the command that you want to insert.

**Figure 4.3** Autocomplete Example

![Autocomplete Example](image)

Tooltips

If you are using a function and do not remember the syntax or need more information about it, place the cursor over it to see a brief explanation. This works only with JSL function names, not platform commands, messages, or user-created functions. JSL function names are colored blue in the script editor.

The tooltip shows the syntax, arguments, and a brief explanation of the function (Figure 4.4). The tip also appears in the script editor window status bar.

**Figure 4.4** Tooltip for a JSL Function

![Tooltip for a JSL Function](image)

After running a script, you can also place the cursor over variable names to see their current value. To turn off variable tooltips, deselect Preferences > Script Editor > Show Variable Value Tips.

To turn off function tooltips, deselect Preferences > Script Editor > Show Operator Tips.

**Example of a Tooltip for a JSL Variable**

1. Enter and run the following line in a script window:
   ```javascript
   my_variable = 8;
   ```
2. Hover over the variable name after you run the line.
   A tooltip shows the name of the variable and its value: 8.
3. Enter and run the following line:
   ```javascript
   my_variable = "eight";
   ```
4. Hover over the variable name after you run the line.
   A tooltip shows the name of the variable and its value: “eight”.

## Split a Window

You can split the Script Editor window into two vertical or horizontal windows. This feature allows you to independently scroll through your code in two different places and edit the contents in both. When you make a change in one window, the change is immediately reflected in the other window.

- To split an open Script Editor window, right-click in the window and select **Split > Horizontal** or **Vertical**.
- To revert back to a single window, right-click and select **Remove Split**.
Match Parentheses, Brackets, and Braces

The script editor helps you match fences (or parentheses, square brackets, and curly braces) in the following ways:

- The matching closing fence is added when you type an opening fence.
- When you place your cursor next to either an opening or closing fence, the fence and its match are highlighted in blue. If the fence does not have a match, it is highlighted in red.
- If you double-click a fence, everything between the matching fence is selected (including the fences).
- If you put your cursor within an expression and press CTRL-] on Windows (COMMAND-B on Macintosh), the entire expression is selected. Fences that enclose the expression are included. Repeat this process to highlight the next-higher expression. Figure 4.6 shows an example.
When you type an opening brace, JMP adds the closing brace. Enter code between the braces, type the closing brace, and then your cursor automatically moves after the closing brace that JMP added. This prevents you from accidentally adding an unnecessary closing brace.

You can turn on and off the auto completion of braces in the JMP preferences. See “Set Preferences for the Script Editor” on page 61 for details.

**Select a Rectangular Block of Text**

To select a rectangular block of text, hold down the Alt key and drag your cursor from the starting point to the end of the block. You can either copy or cut the text enclosed in the block.

Suppose that you want to select all of the following code except for the comment marks.

```plaintext
// Y( :Y ),
// X( :X ),
```

Select a rectangular portion beginning with Y. When you paste, you get the following code:

```plaintext
Y( :Y ),
X( :X ),
```

The rectangular selection inserts returns where needed to maintain the structure of the text. Select `Get Menu Item State` on both lines in the following example.

```plaintext
bb << Get Menu Item State(1),
bb << Get Menu Item State(2),
```

When you paste, a return is inserted at the end of each line.

```plaintext
Get Menu Item State
Get Menu Item State
```
Select Fragmented Text

To select text that is not contiguous, hold down the Ctrl key on Windows or Command key on Macintosh and drag your cursor over the text. Continue this action for any other text that you want to select. You can then copy and paste your selection into a new script or you can run the selected text. Text will be pasted or run in the order it was selected.

Drag and Drop Text

You can drag and drop text within a script editor window or between windows or from a data table into a script editor window. On Windows, pressing CTRL before dragging and dropping copies the text. On Macintosh, the text is copied by default.

Drag and drop text as follows:

- Select a row or column, pause, and then drop it into the script editor window.
- Double-click text in a text field and then drop it into the script editor window. Examples are text in a data table cell and any other selectable text.

On Windows, you can also drag and drop text into a minimized window.

1. Drag the text over the Home Window button in the lower right corner of the window. The Home Window appears.
2. In the Home Window list, drag the text over the destination window. That window appears.
3. Drop the text where you want it.

Find and Replace

Many find and replace options are available in the script editor, including the support of regular expressions. For example, searching with the following regular expression:

get.*name

returns messages such as “Get Button Name”, and “GetFontName”

Basic regular expressions such as ^ and $ (which match the start of line and end of line) and /n (which matches a carriage return) are also supported.

See the Enter and Edit Data chapter in the Using JMP book for details about the Search options.
Automatic Formatting

The script editor can format a script for easier reading. Any generated script (for example, by saving a platform script) is automatically formatted with tabs and returns in appropriate places.

You can also reformat individual scripts that are difficult to read (for example, scripts in which all commands are strung together with no whitespace characters). From the Edit menu, select Reformat Script.

**Tip:** This command alerts you if your script is badly formed (for example, if your parentheses are not matched).

Add Code Folding Markers

You can add code folding markers that show the beginning and the end of the code block, allowing you to collapse and expand code inside stand-alone functions.

To turn on this feature, select JSL code folding in the Script Editor preferences. Then you can expand and collapse blocks of code by right-clicking on a script and selecting Advanced > Expand All or Collapse All.

**Tip:** To fold or expand all code in the entire script, press SHIFT and CTRL then click on a code marker.

After you select this preference, Function and Expr expressions are foldable. See “Add More Folding Keywords” on page 60 for details about adding folding markers to other expressions.

Figure 4.7 Code Folding Markers Shown in a Script

By default, code does not remain collapsed after you save the script and restart JMP. To save the state of the folded code, select Save and restore document state information in the Script Editor preferences.
Add More Folding Keywords

Custom code folding is supported for other stand-alone functions as shown in the following example:

{"If", "For", "For Each Row", "While", "Try", "New Window", "V List Box", "H List Box"} 

JMP supports multiple keyword lists. A system administrator can define a set of keywords in jmpKeywords.jsl and save the script in C:/ProgramData/SAS/JMP/ or designated directory listed below. You save your version of jmpKeywords.jsl in your C:/Users/<user>/Documents/ folder. JMP merges all keyword lists from the designated directories.

On Windows, the following directories are examined in the order listed:

- C:/ProgramData/SAS/JMP/13/
- C:/ProgramData/SAS/JMP/
- C:/Users/<user>/AppData/Roaming/SAS/JMP/13/
- C:/Users/<user>/AppData/Roaming/SAS/JMP/
- C:/Users/<user>/Documents/

On Macintosh, the following directories are examined in the order listed:

- /Library/Application Support/JMP/13/
- /Library/Application Support/JMP/
- ~/Library/Application Support/JMP/13/
- ~/Library/Application Support/JMP/
- ~/Documents/

Note that jmpKeywords.jsl is stored in the designated JMP directory, even if you are using JMP Pro.

Notes:

- The list in jmpKeywords.jsl is case insensitive.
- Code folding is not supported for messages, platforms, user-defined functions, and comments.
- After you edit and save the list in jmpKeywords.jsl, turn the Allow additional code folding keywords preference off and then back on for the changes to take effect. Messages in the log indicate that the keywords were loaded.
Advanced Options

Right-clicking on selected text in the Script Editor provides the following Advanced options:

- **Expand All**  (Appears only if JSL code folding is on) Expands all blocks of code.
- **Collapse All**  (Appears only if JSL code folding is on) Collapses all blocks of code.
- **Comment Block**  Makes the selected text comments.
- **Uncomment Block**  Uncomments the selected comments.
- **Make Uppercase**  Changes all selected text to uppercase.
- **Make Lowercase**  Changes all selected text to lowercase.

Set Preferences for the Script Editor

In the JMP preferences, customize the script editor settings such as the font, colors, and spacing options.

**Setting the Fonts**

1. Select File > Preferences.
2. Select the Fonts group.
3. Click Mono to set the font for the script editor.

For more details about font preferences, see the JMP Preferences chapter in the *Using JMP* book.

**Set Script Editor Preferences**

Select File > Preferences > Script Editor to further customize the editor. For more details about script editor preferences, see the JMP Preferences chapter in the *Using JMP* book.

Working with the Log

As you run a script, the output appears in the log window. The actual script is shaded in the log, and the output appears beneath it (Figure 4.8).
Figure 4.8 The Script Window (left) and the Log Window (right)

Syntax and compatibility errors are reported in the log, including the line number and code that JMP could not process (Figure 4.9).

Figure 4.9 Syntax Error Message

Open the log by selecting **View > Log** (Window > Log on Macintosh).

**Tips:**

- On Windows, you can control when the log opens: when JMP starts, when text is written to the log, or only when you open it. Select **File > Preferences > Windows Specific** to change the Open the JMP Log window setting.
- To omit compatibility warnings from the log, deselect **Show log warnings for JSL compatibility changes in 12** in the JMP General preferences.
- Change the log font and colors in the Script Editor preferences. See “**Color Coding**” on page 53 for details.
Show the Log in the Script Window

You can view the log inside the script window by right-clicking and selecting Show Embedded Log. This option makes it easy to edit and run a script, quickly see the results of your changes, and then continue to develop the script.

The embedded log always appears in the Scripting Index script window but is not available in Application Builder and the Debugger.

Save the Log

You can also save logs as text files, which can be viewed with any text editor. Double-clicking a log text file opens it in your default text editor, not in JMP.

1. Make the log window active (click the Log window to make it the front-most window).
2. From the File menu, select Save or Save As.
3. Specify a filename, including the extension .txt on Windows. On Macintosh you cannot save a log as a .txt file. .jsl is appended to the file name.
4. Click Save.

Debug or Profile Scripts

In an open script, click the Debug Script button 🔄 (or select Edit > Debug Script) to show the script in the JSL Debugger window. You can also use a keyboard shortcut:

- Press CTRL + SHIFT + R (Windows).
- Press SHIFT + COMMAND + R (Macintosh).

The JSL Debugger helps identify the point at which a script causes an error or fails. Rather than commenting out portions of the script or adding Print() expressions, you can use the Debugger to find the problem.

Once the JSL Debugger appears, you can continue in this mode, or you can click the Profile JSL Script button 🔄 to move into the JSL Profiler mode. The JSL Profiler helps with optimization. You can profile your scripts during execution to see how much time is spent executing particular lines or how many times a particular line is executed.

Tip: To debug a script automatically when you open it, include Run JSL(1) in the Open() statement:

```
Open( "$SAMPLE_SCRIPTS/scoping.jsl", Run JSL( 1 ) );
```
Debugger and Profiler Window

The Debugger opens in a new instance of JMP (Figure 4.10). The original instance is inoperable until the script produces something that requires interaction. At that point, the Debugger window becomes inoperable until you perform whatever action is required. Then control is returned to the Debugger. Close the Debugger to work again in the original instance of JMP.

Figure 4.10  The Debugger Window

Use the buttons at the top to control the Debugger or the JSL Profiler. One or more scripts that you are debugging or profiling are shown in tabs. If your script includes other scripts, each one opens in a new tab.

Tabs in the bottom portion of the Debugger provide options to view variables, namespaces, the log, and the current execution point; work with breakpoints; and set options.

Using the Execution Buttons

Use the buttons at the top to control execution of the script within the Debugger or JSL Profiler.
### Table 4.1 Description of the Debugger Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Run" /></td>
<td>Run</td>
<td>Runs the script in the Debugger until it reaches either a breakpoint or the end of the script. <strong>Note:</strong> If there is an error in the script, an abbreviated error message is displayed at the top of the window. Click More to see the complete error message.</td>
</tr>
<tr>
<td><img src="image" alt="Run without breakpoints" /></td>
<td>Run without breakpoints</td>
<td>Runs the script through the end without stopping.</td>
</tr>
<tr>
<td><img src="image" alt="Run profiler" /></td>
<td>Run profiler</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Break All" /></td>
<td>Break All</td>
<td>If the script is busy, click Break All to stop all action in the script and return to the Debugger or JSL Profiler, for example, if you are in a very long loop. The Debugger or JSL Profiler may not be able to break execution if the executing script is waiting on some interactive user action, such as completing a dialog or interacting with an opened window.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stop</td>
<td>Stops debugging the script and exits the Debugger or the JSL Profiler.</td>
</tr>
<tr>
<td><img src="image" alt="Restart" /></td>
<td>Restart</td>
<td>Closes the current Debugger session and opens a new session.</td>
</tr>
<tr>
<td><img src="image" alt="Step Into" /></td>
<td>Step Into</td>
<td>Lets you step into a function or an included file. Otherwise, it behaves the same as Step Over.</td>
</tr>
<tr>
<td><img src="image" alt="Step Over" /></td>
<td>Step Over</td>
<td>Runs all expressions on a single line, or a complex expression that spans multiple lines, without stepping into a called expression, function, or Include() file.</td>
</tr>
<tr>
<td><img src="image" alt="Step Out" /></td>
<td>Step Out</td>
<td>Runs the current script or function to a breakpoint or the end and returns to the calling point. If you are in the main script and the Debugger reaches the end, a message appears: Program execution terminated. The Debugger remains open in order for you to inspect the final program conditions.</td>
</tr>
</tbody>
</table>
**Variable Lists**

The tabs on the bottom left of the Debugger let you examine global variables, local variables, watch variables, and variables within namespaces.

### Globals

The Globals tab lists all global variables and updates their values as you step through the script. Each variable is added as it is initialized. If there are already global variables defined from running earlier scripts, they will be listed with their current values when you start the Debugger. See “View Variables” on page 70.

---

**Table 4.1 Description of the Debugger Buttons (Continued)**

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Action</th>
</tr>
</thead>
</table>
| ![Profile JSL Script] | Profile JSL Script | Opens the JSL Profiler. (Press the Run profiler button to start the JSL Profiler.) Use the JSL Profiler to see how much time is spent executing particular lines or how many times a particular line is executed. Note the following:  
- You can switch back and forth between the Debugger and JSL Profiler modes only prior to the start of the program.  
- Some of the debugger buttons are disabled when profiling.  
- All breakpoints are disabled when running in the JSL Profiler mode. |
| ![Show Profile by Line Count] | Show Profile by Line Count | Shows the number of times each line is executed. |
| ![Show Profile by Time] | Show Profile by Time | Shows how much time is spent executing a line. |
| ![Show Profile by Count] | Show Profile by Count | For line counts, shows the number of times the line is executed. For time, shows the number of microseconds (or milliseconds or seconds) the line takes to complete. |
| ![Show Profile by Percent] | Show Profile by Percent | For line counts, shows the individual line count divided by the total line count. For time, shows the percentage of time spent on an individual line (line time/total time*100). |
| ![Time Units] | Time Units | Sets the time unit to microseconds, milliseconds, or seconds. Available in the JSL Profiler after you click the Run profiler button. |
| ![Color Theme] | Color Theme | Sets the color of the shading for the JSL Profiler. Available in the JSL Profiler after you click the Run profiler button. |
Locals  The Locals tab lists all variables by scope and updates their values as you step through the script. Select a scope in the menu. See “View Variables” on page 70.

Watch  If there is a particular variable or value of an expression whose values you want to watch as you step through the code, you can add them here. This is particularly useful if your script uses many variables that might be hard to watch in the Globals or Locals lists. See “Work with Watches” on page 71.

Namespaces  As namespaces are defined, they are added to the menu. Select a namespace to view any variables and their values used within the namespace. See “View Variables” on page 70.

Debugger Options

The tabs on the bottom right of the Debugger let you view the call stack, work with breakpoints, set options, and view the log.

Call Stack  The call stack lists the current execution point in scripts and functions. The main script is always the first script listed. If you call a function, the function is added on top of the calling script. Likewise, any included files are added to the top of the list as you step through them. When you exit any function or script, it is removed from the list and you return to the next one in the list. The current line numbers are updated as you step through.

Double-click a row in the call stack to move the cursor to the specified line.

Breakpoints  Add, edit, delete, and disable or enable breakpoints on lines. See “Work with Breakpoints” on page 67. You can also double-click a row on the Breakpoints tab to move the cursor to the specified line.

Data Breakpoints  Add, edit, delete, and disable or enable breakpoints in variables. Data breakpoints watch for changes in variables, unlike breakpoints, which watch for changes in lines.

Options  Set the Debugger preferences interactively on this tab. See “Modify Preferences in Debugger” on page 72.

Log  The log from the script that you are debugging is shown on this tab.

Work with Breakpoints

A breakpoint interrupts the execution of a script. Although you can step through a script line by line, this can be tedious and lengthy for a long or complex script. You can set breakpoints at places of interest and simply run the script in the Debugger. The script is run normally until a breakpoint is reached. At the breakpoint, the Debugger stops executing the script so you can look at the values of variables or start stepping line by line.
Breakpoints that appear on the Breakpoints tab in the lower right corner watch for changes in a line. Breakpoints that appear on the Data Breakpoints tab watch for changes in variables. JMP preserves breakpoints across sessions. So when you close and reopen JMP, the breakpoints still appear.

**Tip:** Turn on line numbers by right-clicking in the script and selecting *Show Line Numbers*. You can also show line numbers by default in all scripts by modifying the Script Editor preferences.

### Create a Breakpoint

When creating a breakpoint, you can specify settings such as conditions and break behavior. To do so, click on the Breakpoints tab or Data Breakpoints tab, and then enter the breakpoint information.

Otherwise, create a quick breakpoint by doing one of the following:

- In the Debugger margin, click on the appropriate line (to the right of the line number if displayed).
- In the Debugger margin, right-click in the margin where you want the breakpoint and select *Set Breakpoint*.

The red breakpoint icon appears where you inserted the breakpoint and on the Breakpoints tab.

### Delete Breakpoints

Do one of the following:

- In the Debugger margin, click the breakpoint icon.
- In the Debugger margin, right-click the breakpoint icon and select *Clear Breakpoint*.
- On the Breakpoints tab, select the breakpoint and then click $\times$.
- On the Breakpoints tab, click $\times$ to delete all breakpoints (not just the selected breakpoints).

The red breakpoint icon is removed, and the breakpoint no longer appears on the Breakpoints tab.

### Disable and Enable Breakpoints

Disabling a breakpoint is helpful when you potentially fix a problem and then want to see whether the script will run correctly past that breakpoint. You can then enable the breakpoint when necessary rather than recreating it.
Do one of the following:

- In the Debugger margin, right-click the breakpoint icon and select **Enable Breakpoint** or **Disable Breakpoint**.
- On the Breakpoints tab, select or deselect the breakpoint’s check box.
- On the Breakpoints tab, click ![stop symbol] to disable or enable all breakpoints.

A disabled breakpoint turns white; enabled breakpoints are shaded red.

**Specify and Clear Conditional Expressions on Breakpoints**

Setting a condition on a breakpoint is an alternative to single-stepping through code. Rather than single-step and view the variables for each expression, you specify that the script break only when a condition is met. Then you can step through the code and figure out where the problem arises.

Suppose that a calculation in your script is incorrect, and you suspect the problem occurs when `i==19`. Set a conditional breakpoint for `i==18`. The Debugger will run until that condition is met, then you can step through the code to identify the problem.

**Specify a Breakpoint Condition**

1. Right-click the breakpoint icon and select **Edit Breakpoint**.
2. On the Condition tab, select **Condition** and enter the conditional expression.
3. Specify whether to break when the expression **Is true** or **Has Changed**.
4. Click **OK**.

**Disable or Enable a Condition**

1. Right-click the breakpoint icon and select **Edit Breakpoint**.
2. On the Condition tab, deselect or select **Condition**.

**Delete a Condition**

On the Breakpoints tab, click in the breakpoint’s Condition field and press DELETE.

**Specify Break Options**

Right-clicking the breakpoint and selecting **Edit Breakpoint** provides a quick way to manage breakpoint behavior. Alternatively, select the breakpoint on the Breakpoints tab and click ![stop symbol]. Both methods display the Breakpoint Information window, where you customize settings on the Hit Count and Action tabs.
Change the Hit Count

You can control the number of times a breakpoint must be hit and when the break occurs. For example, to break when the condition is met twice, select `break when the hit count is equal to` and type 2 on the Hit Count tab.

Define an Action

You also have the option of defining a JSL expression or script that the Debugger executes when a breakpoint is hit and execution has stopped. This script is called an action. On the Action tab, enter the JSL expression to be executed.

Run the Script to the Cursor

When you right-click and select Run To Cursor, all expressions before the location of the cursor are executed. Select this option when you only want to see values up to the current line. To see values when each expression is executed, use the stepping options.

Tips for Setting Breakpoints

- If you do not want to watch for errors in a specific loop, set a breakpoint after the loop ends. The Debugger will hit the next breakpoint rather than stepping through each line of the loop.
- Avoid inserting a breakpoint in lines that do not trigger an action (such as comments, blank lines, and end parentheses). Debugger will not break on these lines.
- When you insert breakpoints, close Debugger, and edit the script, the breakpoints remain on the original line numbers. You might need to delete and then reinsert the breakpoints.
- Breakpoints are remembered across Debugger sessions. This means that your breakpoints list includes breakpoints that have been set in all scripts, not just the script that you are currently debugging.
- Breakpoints are remembered by the Debugger session, not by each script. This means that breakpoints are listed even for scripts that have been moved or deleted.
- On the Breakpoints tab, click ![X] to remove all breakpoints in scripts whether they are currently open or not, or for scripts that no longer exist.

View Variables

The variables lists are populated as they appear in the script. Their values are updated every time the script changes them. If you are uncertain why a variable has a particular value when you run your script, you can watch its value at every step to see what happens.

You can also assign the variables whatever value you want. For example, if you are stepping through a For() loop but are interested only in what happens starting with a particular
iteration, you can assign your iterating variable that value. Step through the first part of the loop that initializes the iteration variable and then assign it the value that you want in the variable list at the bottom. Then when you step through, the loop begins executing at that point.

**Tips for Managing Variables**

- If you have run several scripts using the global scope, you might want to clear or delete global variables. This makes the list of variables in the Debugger shorter and relevant. Use the `Delete Symbols()` function to do so. You can also close JMP and restart to clear the space.
- If your script uses so many variables that they are difficult to find and watch in the variable lists, add watches for the specific variables in which you are interested.

**Work with Watches**

JMP preserves the Watch variables across sessions. So when you close and reopen JMP, the Watch variables are still listed on the Watch tab.

**Create a Watch**

- On the Watch tab, click \( \square \) and enter the value in the window.
- In the Debugger, right-click the line that you want to watch, select **Add Watch**, and then enter the variable name in the window.
- In the Debugger, place the cursor in or next to a variable name (or select the variable name), right-click, and select **Add Watch**.
- On the Watch tab, enter the variable in an empty **Variable** field.

**Modify a Watch**

Do one of the following on the Watch tab to enter a new value:

- Select the watch and click \( \square \).
- Click in the Variable field and enter a new value.

**Delete Watches**

Do one of the following on the Watch tab to delete watches:

- Select the watch and then click \( \times \).
- Click \( \times \) to remove all watches.
Modify Preferences in Debugger

The Debugger lets you change preferences as you work in the Debugger. Select the Options tab to find the following settings:

**Show Line Numbers**  Shows or hides the line numbers for the script in the Debugger.

**Break on Multiple Statements Per Line**  Stops executing the script between each expression in a single line.

**Break On Throw**  Breaks when the script executes the `Throw()` function. For example, `Throw()` might be enclosed in a `Try()` expression. The Debugger breaks on `Throw()` instead of continuing through the rest of the expression. This lets you identify where the problem occurred in the script and then return to debugging.

**Break On Execution Error**  Stops executing the script when the error occurs rather than closing the Debugger.

**Warn On Assignment In Condition**  Shows a warning when you enter a breakpoint condition that contains the assignment. For example, if you have a breakpoint on `x = 1` and add the condition `x = 1` to the breakpoint, you are prompted to verify the assignment of `x`.

**Enter Debugger Upon Termination**  Keeps the Debugger open after a JSL program terminates execution. On by default, this option lets you examine attributes of the executed program.

Persistent Debugger Sessions

JMP saves all breakpoints and watches until you delete them. Other user-specific settings, such as column widths on the tabs and the Debugger window size, persist between sessions of JMP.

These settings are stored in a file named `JMP.jdeb`, the location of which is defined in the `USER_APPDATA` variable:

- Windows 7 and higher: "/C:/Users/<username>/AppData/Roaming/SAS/JMP/13/"
- Macintosh: "/Users/<username>/Library/Application Support/JMP/13/"

As usual, the values of local variables, global variables, and namespaces clear when you close and reopen JMP.

**Note:** On Windows, the paths differ based on the JMP edition. In JMP Pro, the path refers to “JMPPro”. In JMP Shrinkwrap, the path refers to “JMPSW”.
Examples of Debugging and Profiling Scripts

This section includes examples of setting breakpoints to watch variables; stepping into, over, and out of expressions; watching variables in different scopes and namespaces; debugging interactive scripts; and profiling scripts with the JSL Profiler.

Example scripts are located in the Samples/Scripts folder.

**Tip:** Make sure that Show Line Numbers is selected on the Debugger Options tab before proceeding.

Using Breakpoints and Watching Global Variables

The following example shows how to set a breakpoint in a loop and watch variables change through each iteration of the loop.

1. Open the string.jsl sample script and click the Debug Script button.
2. Click in the margin for line 12 to add a breakpoint (Figure 4.11).
   You should have a breakpoint for the following expression inside the For() loop:
   ```javascript
   stringFunction(i);
   ```
   **Figure 4.11** Set the Breakpoint

3. Click Run.
   The first two expressions are evaluated:
   - stringFunction is defined as a function.
   - str is defined as an empty string.
   Both variables and their types and values have been added to the Globals list. In addition, the For() loop has been evaluated up to the line with the breakpoint, shown in Figure 4.11.
– i has been assigned to 0.
– i and its value and type have been added to the Globals list.
– i has been determined to be less than or equal to 9.
– stringFunction() has not yet been called.

Figure 4.12 View the Initial Global Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>10</td>
<td>Number</td>
</tr>
<tr>
<td>str</td>
<td>&quot;0123456789&quot;</td>
<td>String</td>
</tr>
<tr>
<td>stringFunction()</td>
<td>Function (i, y = Char(i); str = str</td>
<td></td>
</tr>
</tbody>
</table>

4. Click Run again.

The script runs until it hits the breakpoint. The results are shown in Figure 4.13.

– stringFunction() is called, evaluated, and returns to the loop.
– i is incremented and determined to be less than or equal to 9.
– In the Globals list, i is now 1 and str is now “0”.

Figure 4.13 Global Variables at First Breakpoint

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>1</td>
<td>Number</td>
</tr>
<tr>
<td>str</td>
<td>&quot;0&quot;</td>
<td>String</td>
</tr>
<tr>
<td>stringFunction()</td>
<td>Function (i, y = Char(i); str = str</td>
<td></td>
</tr>
</tbody>
</table>

5. Click Run again.

The script runs until it hits a breakpoint. The results are shown in Figure 4.14.

– stringFunction() is called, evaluated, and returns to the loop.
– i is incremented and determined to be less than or equal to 9.

In theGlobals list, i is now 2, and str is now “01”.

Figure 4.14 Global Variables at Second Breakpoint

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>2</td>
<td>Number</td>
</tr>
<tr>
<td>str</td>
<td>&quot;01&quot;</td>
<td>String</td>
</tr>
<tr>
<td>stringFunction()</td>
<td>Function (i, y = Char(i); str = str</td>
<td></td>
</tr>
</tbody>
</table>

You can continue to click Run and watch i and str change with each iteration of the loop. Or, click Run without breakpoints to complete running the script and exit the Debugger.
Stepping Into, Over, and Out

Step Into, Step Over, and Step Out offer flexibility when your script contains expressions, functions, or includes other JSL files.

1. Open the scriptDriver.jsl sample script and click the Debug Script button.
2. This script writes information to the log, so select the Log tab at the bottom of the Debugger to view the messages.
3. Click Step Over.
   The first line in the script is evaluated.
4. Click Step Over again.
   The current expression is evaluated, and the Debugger moves to the following line. In this case, the expression is a few lines long, and it assigns an expression to a variable.
5. Click Step Over again.
   This expression is several lines long, and assigns a function to a variable.
   Line 30 calls the expression that was created earlier.
6. Click Step Over.
   The Debugger steps into the expression, running it line by line.
7. Continue clicking Step Over until the expression ends.
   The Debugger returns to the line following the expression call.
   Line 31 calls the function defined earlier.
8. Click Step Over to run the function without stepping into it. The Debugger runs the entire function, and returns to the line following the function call.
   Line 33 includes another script.
9. Click Step Into.
   The Debugger opens the script in another tab and waits.
10. Click Step Over.
    The next line in the included script is run.
11. Click Step Out.
    The Debugger runs the rest of the included script and returns to the line following the Include() function.

Watching Variables in Different Scopes and Namespaces

Tabs at the bottom of the Debugger window let you watch variables as they are created and changed. This example shows variables in several scopes and a namespace.

1. Open the scoping.jsl sample script and click the Debug Script button.
2. Click **Step Over**.
   The fourth line turns off **Names Default To Here**. If you run this script again in the same JMP session, this line resets the scoping so that the first variable that is created is in the global scope.

3. Click **Step Over**.
   A global variable named \( x \) is created. On the Globals tab, \( x \) has been added to the list, showing its value as 5 and its type as number.

4. Select the **Locals** tab, and then select **Global** from the list of scopes.
   The global variable \( x \) is also shown here.

5. Click **Step Over** twice.
   **Names Default To Here** is turned on, which places the rest of the script into a Here scope.
   Then a new variable \( x \) is created in that scope.
   Notice that the value of the global variable \( x \) has not changed.

6. Select **Here** from the list on the Locals tab.
   The local \( x \) is listed under **Here**, with its value and type.

7. Click **Step Over**.
   A **Local** **Here** scope is created. A second Here scope is shown in the Locals list.

8. Click **Step Over**.
   A new \( x \) variable is created in this Here scope. On the Locals tab, select each of the three scopes from the list (**Here**, **Here**, and **Global**) to see three different \( x \) variables.

9. Click **Step Over**.
   Look in the Debugger’s log to see the output. Notice that **here**:\( x \) scopes to the local here, not the script window’s here.

10. Click **Step Over**.
    After writing an empty line to the log, the script exits the Local Here scope. The second Here, along with its’ \( x \) variable, has disappeared from the Locals list.

11. Click **Step Over**.
    A namespace called “test” is created, with another variable named \( x \). Select the **Namespaces** tab to see it.

12. Click **Step Over** and look at the log.

13. Click **Step Over** to exit the Debugger.
Using the Debugger with Interactive Scripts

When your script creates interactive elements, the Debugger hands control back to the main instance of JMP so that you can interact with it. When you are finished, control returns to the Debugger.

1. Open the `interactive.jsl` sample script and click the **Debug Script** button.
2. Click **Step Over** twice.
   The `New Window` expression is evaluated, and a modal window waiting for input is created. You might need to move the Debugger window to see the new modal window.
3. Enter two numbers in the `Assign X and Y` window and click **OK**.
   Control is given back to the Debugger.
4. Click **Step Over** three times and look at the log in the Debugger.
   The log shows the two new numbers that you entered in the window.
5. Click **Step Into** to exit the Debugger.

Using the JSL Profiler

Use the JSL Profiler to see how much time is spent executing particular lines or how many times a particular line is executed.

1. Open the `string.jsl` sample script.
2. Click the **Debug Script** button.
3. Click the **Profile JSL Script** button.

*Figure 4.15 Initial JSL Profiler Window*

4. Click the **Run** button to start profiling.
The profiler collects information on the number of times a statement is executed and the time it takes to execute it. Time is cumulative and collected each time a JSL statement is executed.

**Figure 4.16** Profiled Script Window

In the left margin, the selected statistics are displayed. Percent of time is displayed by default. Click the **Show Profile by Count** button to switch to percent of statement counts instead. The left margin is color-coded to allow for quick identification of problematic performance areas.
Studying the syntax and basics of JSL is crucial, whether you are a beginning or an advanced user. Some concepts (such as loops and variables) are common among many scripting languages, but punctuation rules differ in JSL.

Figure 5.1 Example of a JSL Script

This chapter introduces you to the basic concepts of JSL, from syntax rules and file path conventions to conditions and namespaces.
JSL Syntax Rules

All scripting and programming languages have their own syntax rules. JSL looks familiar if you have programmed in languages such as C and Java. However, rules for punctuation and spaces differ in JSL.

The following sections describe JSL syntax rules for the following basic components of the language:

- “Value Separators” on page 80
- “Numbers” on page 83
- “Names” on page 83
- “Comments” on page 84

Value Separators

Words in JSL are separated by parentheses, commas, semicolons, spaces, and various operators (such as +, –, and so on). This section describes the rules for using these separators and delimiters in JSL.

Commas

A comma separates items, such as items in a list, rows in a matrix, or arguments to a function.

```julia
my list = {1, 2, 3};
your list = List( 4, 5, 6);
my matrix = [3 2 1, 0 -1 -2];
If( Y < 20, X = Y);
Table Box( String Col Box( "Age", a ));
```

**Note:** To glue a sequence of commands into a single argument inside a function, separate each sequence with a semicolon. For more information, see “Semicolons” on page 81.

Parentheses

Parentheses have several purposes in JSL:

- Parentheses group operations in an expression. The following parentheses group the operations in the If() expression.

  ```julia
  y = 10;
  If(
      Y < 20, X = Y,
      X = 20
  );
  ```
• Parentheses delimit arguments to a function. In the following example, parentheses
enclose the argument to the `Open()` function.

```javascript
Open( "$SAMPLE_DATA/Big Class.jmp" );
```

• Parentheses also mark the end of a function name, even when arguments are not needed.
For example, the `Pi` function has no arguments. However, the parentheses are required so
that JMP can identify `Pi` as a function.

```javascript
Pi();
```

**Note:** Be careful that parentheses match. Every ( needs a ), or errors result.

The script editor can match fences (parentheses, brackets, and braces). Press CTRL-]
(COMMAND-b on Macintosh) with your cursor in any part of a script. The editor searches for
fences, highlighting the text between the first set of opening and closing fences that it finds.
Repeat this process to highlight the next-higher fence. See “Match Parentheses, Brackets, and
Braces” on page 56 in the “Scripting Tools” chapter for an example.

### Semicolons

Expressions separated by a semicolon are evaluated in succession, returning the result of the
last expression. In the following code, 0 is assigned to the variable `i` and then 2 is assigned the
variable `j`.

```javascript
i = 0;
j = 2;
```

You can also use semicolons to join arguments that are separated by commas as shown in the
following `If()` expression.

```javascript
If( x < 5, y = 3; z++; );
```

The semicolon in other languages is used as an expression terminator character. In JSL, the
semicolon is a signal to continue because more commands might follow. For details about
separating expressions with semicolons, see “Alternatives for Gluing Expressions Together”
on page 99.

Semicolons at the end of a script or at the end of a line of arguments are harmless, so you can
also think of semicolons as terminating characters. Trailing semicolons are allowed at the end
of a script stream and after a closing parenthesis or closing curly brace. In fact, terminating
each complete JSL expression with a semicolon helps avoid errors when you copy and paste
small scripts into a larger one.

The semicolon is equivalent to the `Glue()` function. See “Operators” on page 85 for more
information about semicolons and `Glue()`.
Double Quotes

Double quotes enclose text strings. Anything inside double quotes is taken literally, including spaces and upper- or lower-case; nothing is evaluated. If you have "Pi() ^ 2" (inside double quotes), it is just a sequence of characters, not a value close to ten.

You do have to be careful with text strings. Extra spaces and punctuation do affect the output, because text strings inside double quotes are used literally, exactly as you enter them.

To have double quotes inside a quoted string, precede each quotation mark with the escape sequence `\!' (backslash-bang). For example, run the following script and look at the title of the window:

```javascript
New Window("!'Hello!' is a quoted string.",
   Text Box( Char( Repeat( "*", 70 ) ) )
);
```

Table 5.1 Escape Sequences for Quoted Strings

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\b</td>
<td>blank</td>
</tr>
<tr>
<td>\t</td>
<td>tab</td>
</tr>
<tr>
<td>\r</td>
<td>carriage return only</td>
</tr>
<tr>
<td>\n</td>
<td>linefeed (newline) only</td>
</tr>
<tr>
<td>\N</td>
<td>inserts line breaking characters appropriate for the host environment(^a)</td>
</tr>
<tr>
<td>\f</td>
<td>formfeed (page break)</td>
</tr>
<tr>
<td>\0</td>
<td>null character</td>
</tr>
</tbody>
</table>

**Note:** The null character is dangerous to use, because it is typically treated as the end of the string. Be sure to type the number zero, not the letter O.

| \\   | backslash                                      |
| \"   | double quotation mark                          |

\(^a\) On Macintosh, this escape sequence is CR (carriage return character, hexadecimal ‘0D’). On Windows, this sequence is CR LF (carriage return followed by a linefeed, hexadecimal ‘0D0A’).

Sometimes, long passages require a lot of escaped characters. In these cases, use the notation `\[...\]` and everything between the brackets does not need or support escape sequences. Here is an example where `\[...\]` is used inside a double-quoted string.

```javascript
jslPhrase = "The JSL to do this is :\[```
```
Example script:

```javascript
a = "hello";
b = a|| " world.";
Show(b);
]\ and you use the Submit command to run it."
```

**Spaces**

JSL allows whitespace characters inside names; spaces, tabs, returns, and blank lines inside or between JSL words are ignored. This is because most JSL words come from the user interface, and most of those commands have spaces in them. For example, the JSL expression for the Fit Model platform is `Fit Model()` or `FitModel()`.

Spaces inside an operator or between digits in a single number are not allowed. In these cases, the script generates errors. For example, you cannot put spaces between the two plus signs in `i++ (i+ +)` or in numbers (`4 3` is not the same as `43`).

**Note:** Why does JSL allow whitespace characters inside names? For one reason, the names of commands and options match the equivalent commands in JMP menus and windows. Another reason is that data table column names often include spaces.

**Numbers**

Numbers can be written as integers, decimal numbers, dates, times, or datetime values. They can also be included in scientific notations with an `E` preceding the power of ten. For example, these are all numbers:

```
.   1   12   1.234  3E3  0.314159265E+1  1E-20  01JAN98
```

**Note:** A single period by itself is considered a missing numeric value (sometimes called `NaN` for “not a number”).

For more information about dates, times, and date-time values, see “Date-Time Functions and Formats” on page 126 in the “Types of Data” chapter. See “Currency” on page 138 in the “Types of Data” chapter for details about combining numbers with currency symbols.

**Names**

A name is simply something to call an item. When you assign the numeric value 3 to a variable in the expression `a = 3`, `a` is a name.

Commands and functions have names, too. In the expression `Log( 4 )`, `Log` is the name of the logarithmic function.
Names have a few rules:

- Names must start with an alphabetic character or underscore and can continue with the following:
  - alphabetic characters (a-z A-Z)
  - numeric digits (0-9)
  - whitespace characters (spaces, tabs, line endings, and page endings)
  - mathematical symbols in Unicode (such as \(\subseteq\))
  - a few punctuation marks or special characters (apostrophes (‘), percent signs (%), periods (.), backslashes (\), and underscores (_))

- When comparing names, JMP ignores whitespace characters (such as spaces, tabs, and line endings). Upper case and lower case characters are not distinguished. For example, the names Forage and for age are equivalent, despite the differences in white space and case.

You can still have a name that is any other sequence of characters. If the name does not follow the rules above, it needs to be quoted and placed inside a special parser directive called Name(). For example, to use a global variable with the name taxable income(2011), you must use Name() every time the variable appears in a script:

```julia
Name( "taxable income( 2011 )" ) = 456000;
tax = .25;
Print( tax * Name( "taxable income( 2011 )" ) );

114000
```

Name() is harmless when it is not needed. For example, tax and Name("tax") are equivalent.

Note: Name() is not a function that gets called when the script is run; it is a syntax marker for expressing names that are ambiguous. To evaluate the name of a column in an expression, use Column().

For more information about how JMP interprets names, see “Rules for Name Resolution” on page 92.

**Comments**

Comments are notes in the code that are ignored by the JSL processor (or parser). You include comments to describe sections of the script. Comments are also convenient for removing portions of a script temporarily. For example, you can insert comment symbols around code that might be causing an error and then rerun the script.

Type the comment symbols around code that you want to comment. The following example shows code commented with /* */ in the middle of a line. When the script is run, JMP considers both expressions to be identical.

```julia
tax /*percentage*/ = .25;
```
tax = .25;

Table 5.2 describes the comment symbols.

Table 5.2  Comment Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>//</td>
<td>// comment</td>
<td>Begins a comment. The comment does not have to be at the beginning of a line, but everything up to the end of the line is a comment.</td>
</tr>
<tr>
<td>/* */</td>
<td>/* comment */</td>
<td>Begins and ends a comment. This comment can appear in the middle of a line. Script text before and after the comment is parsed normally.</td>
</tr>
<tr>
<td>///</td>
<td>///</td>
<td>Add /// to the first line of the script, and the script runs automatically when opened in JMP. (In other words, the script editor does not open.)</td>
</tr>
</tbody>
</table>

Operators

Operators are one- and two-character symbols for common arithmetic actions. Operators come in several varieties:

- **infix** (with arguments on either side, such as + in 3 + 4, or = in a = 7)
- **prefix** (with one argument on its right side, such as ! for logical negation)
- **postfix** (with one argument on its left side, such as ++ for incrementing)

JSL operators all have function equivalents.

To make writing algebraic expressions easier, JSL uses certain special character operators. These operators have the same meaning as if the phrase had been written as a function. For example, the following two expressions are equivalent.

```julia
Net Income After Taxes = Net Income - Taxes;
Assign( Net Income After Taxes, Subtract( Net Income, Taxes ) );
```

The assignment operation can be written either as the Assign() function or as an infix operator =. Similarly, subtraction can be done with the Subtract() function or the infix minus sign; they are equivalent inside JMP.
Another common operator is the semicolon (;). You use the semicolon to:

- Separate yet join one expression to another in a programming sequence. The semicolon returns the result of its last argument, so \( a;b \) is the same as \( \text{Glue}(a,b) \).
- End an expression. Though the semicolon is permitted at the end of an expression, it is not the expression terminator used in other languages.

An expression can contain more than one operator. In these instances, the operators are grouped in order of precedence with decreasing priority. For example, * takes precedence over +:

\[
a + b * c
\]

So \( b * c \) is evaluated first, and then the result is added to \( a \).

+ takes precedence over -: 

\[
a + b * c - d
\]

So \( b * c \) is evaluated, and then the result is added to \( a \). \( d \) is then subtracted from the result of \( a + b * c \).

Table 5.3 shows operators shaded in order of precedence and each operator’s function equivalent.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>{ }</td>
<td>List</td>
<td>{a,b} List(a,b)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Construct a list.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Subscript</td>
<td>a[b,c] Subscript(a,b,c)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subscripts identify specific elements within a data element ( a ), where ( a ) could be a list, a matrix, a data column, a platform object, a display box, and so on.</td>
</tr>
<tr>
<td>++</td>
<td>Post Increment</td>
<td>a++ Post Increment(a)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adds one (1) to ( a ), in place.</td>
</tr>
<tr>
<td>--</td>
<td>Post Decrement</td>
<td>a-- Post Decrement(a)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subtracts one (1) from ( a ), in place.</td>
</tr>
</tbody>
</table>
Table 5.3 Operators and Their Function Equivalents in Order of Precedence (Continued)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td><code>a^b</code></td>
<td>Raise <code>a</code> to exponent power <code>b</code>. With only one argument, 2 is assumed as the power, so <code>Power(x)</code> computes $x^2$.</td>
</tr>
<tr>
<td></td>
<td><code>Power(a,b)</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>Power(x)</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-a</code></td>
<td>Reverses sign of <code>a</code>.</td>
</tr>
<tr>
<td></td>
<td><code>Minus(a)</code></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td><code>!a</code></td>
<td>Logical Not. Maps nonzero (or true) values to 0 (which means false). Maps 0 (or false) values to 1 (which means true).</td>
</tr>
<tr>
<td></td>
<td><code>Not(a)</code></td>
<td></td>
</tr>
<tr>
<td>*</td>
<td><code>a*b</code></td>
<td>Multiplies <code>a</code> by <code>b</code>.</td>
</tr>
<tr>
<td></td>
<td><code>Multiply(a,b)</code></td>
<td></td>
</tr>
<tr>
<td>:*</td>
<td><code>a:*b</code></td>
<td>Elementwise multiplication for matrices <code>a</code> and <code>b</code>. (Each element in matrix <code>a</code> is multiplied by each element in matrix <code>b</code>.)</td>
</tr>
<tr>
<td></td>
<td><code>EMult(a,b)</code></td>
<td></td>
</tr>
<tr>
<td>/</td>
<td><code>a/b</code></td>
<td>Divide(<code>a</code>, <code>b</code>) divides <code>a</code> by <code>b</code>.</td>
</tr>
<tr>
<td></td>
<td><code>Divide(a,b)</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>Divide(x)</code></td>
<td>Divide(<code>x</code>) interprets the argument as a denominator and implies 1 as the numerator, yielding the reciprocal 1/x.</td>
</tr>
<tr>
<td>:/</td>
<td><code>a:/b</code></td>
<td>Elementwise division for matrices <code>a</code> and <code>b</code>. (Each element in matrix <code>a</code> is divided by each element in matrix <code>b</code>.)</td>
</tr>
<tr>
<td></td>
<td><code>EDiv(a,b)</code></td>
<td></td>
</tr>
<tr>
<td>+</td>
<td><code>a+b</code></td>
<td>Adds <code>a</code> and <code>b</code>.</td>
</tr>
<tr>
<td></td>
<td><code>Add(a,b)</code></td>
<td></td>
</tr>
<tr>
<td>-</td>
<td><code>a-b</code></td>
<td>Subtracts <code>b</code> from <code>a</code>.</td>
</tr>
<tr>
<td></td>
<td><code>Subtract(a,b)</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>Concat(a,b)</code></td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>Function Syntax</td>
<td>Explanation</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>VConcat</td>
<td>matrix1|matrix2 VConcat(matrix1, matrix2)</td>
<td>Vertically concatenate matrices. (Use</td>
</tr>
<tr>
<td>Index</td>
<td>a::b Index(a,b)</td>
<td>For matrices, generates the integers from a to b. (Colons are also used as prefix operators for scoping, where :a means data table column a, and ::a means JSL global variable a. See “Scoping Operators” on page 94 for details.)</td>
</tr>
<tr>
<td>Send</td>
<td>object &lt;&lt; message Send(object, message)</td>
<td>Send message to object.</td>
</tr>
<tr>
<td>Equal</td>
<td>a==b Equal(a,b)...</td>
<td>Boolean values for comparisons. They all return 1 if true, 0 if false. Missing values in either a or b causes a return value of missing, which evaluates as neither true nor false. See “Missing Values” on page 113, for treatment of missing values.</td>
</tr>
<tr>
<td>Not Equal</td>
<td>a!=b Not Equal(a,b)...</td>
<td></td>
</tr>
<tr>
<td>Less</td>
<td>a&lt;b Less(a,b)...</td>
<td></td>
</tr>
<tr>
<td>Less or Equal</td>
<td>a&lt;=b Less or Equal(a,b)</td>
<td></td>
</tr>
<tr>
<td>Greater</td>
<td>a&gt;b Greater(a,b)</td>
<td></td>
</tr>
<tr>
<td>Greater or Equal</td>
<td>a&gt;=b Greater or Equal(a,b)</td>
<td></td>
</tr>
<tr>
<td>Less Equal Less</td>
<td>a&lt;=b&lt;c Less Equal Less(a,b,c)</td>
<td>Range check. Return 1 if true, 0 if false. Missing values in either a or b propagate missing values.</td>
</tr>
<tr>
<td>Less Less Equal</td>
<td>a&lt;b&lt;=c Less Equal Less(a,b,c)</td>
<td></td>
</tr>
<tr>
<td>Logical And</td>
<td>a&amp;b And(a,b)</td>
<td>Logical And. Returns true if both are true. If the value on the left is false, the value on the right is not evaluated. See “Missing Values” on page 113, for treatment of missing values.</td>
</tr>
</tbody>
</table>
Table 5.3 Operators and Their Function Equivalents in Order of Precedence (Continued)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Logical Or. Returns true if either or both are true. See “Missing Values” on page 113, for treatment of missing values.</td>
</tr>
<tr>
<td>=</td>
<td>Assign</td>
<td>$a=b$&lt;br&gt;Assign(a, b)</td>
</tr>
<tr>
<td>+=</td>
<td>Add To</td>
<td>$a+=b$&lt;br&gt;AddTo(a, b)</td>
</tr>
<tr>
<td>-=</td>
<td>Subtract To</td>
<td>$a-=b$&lt;br&gt;SubtractTo(a, b)</td>
</tr>
<tr>
<td>*=</td>
<td>Multiply To</td>
<td>$a*=b$&lt;br&gt;MultiplyTo(a, b)</td>
</tr>
<tr>
<td>/=</td>
<td>Divide To</td>
<td>$a/=b$&lt;br&gt;DivideTo(a, b)</td>
</tr>
<tr>
<td>;</td>
<td>Glue</td>
<td>$a;b$&lt;br&gt;Glue(expr, expr, ...)</td>
</tr>
</tbody>
</table>

Global and Local Variables

Variables are names that hold values, which you reference later in scripts. There are two types of variables:

- Global variables are shared among all scripts that you run in a JMP session.
- Local variables apply only to the script context in which you define them. They can also be local to only a piece of a script, as with variables local to a particular function.

To limit the scope of variables, you can define them in a namespace, which is a collection of variables, functions, and other unique names. JMP has a single global variable namespace that all scripts use by default. When you use a name plainly, without a qualifying syntax, the name is an unscoped variable and therefore in the global namespace.

$x = 1$;
Local Namespaces

Putting variables in the global namespace can cause conflicts. When two scripts have variables with the same names, the value of the variable in the last script that you run last overwrites the variable’s value in the first script.

To prevent this problem, we recommend that you begin each script with the following line:

```
Names Default To Here( 1 );
```

The `Names Default To Here( 1 );` function makes all unscoped variables in the script local to that script and does not affect the global variable namespace. “Advanced Scoping and Namespaces” on page 235 provides more details.

**Note:** The `Names Default to Here` option is true by default for custom menus and toolbar buttons. A script that runs when you select a custom menu item or click a custom toolbar button does not affect global variables.

Named Namespaces

You can also create a variable in a specific namespace. In the following example, the `x` variable is created in the `aa` namespace:

```
aa:x = 1;
```

Preceding local variables with the `Local()` function is another option. Both `a` and `b` are local variables in the following expression:

```
Local( {a = 1, b}, ... );
```

Scoping operators also distinguish a global variable from a local variable. For more information, see “Rules for Name Resolution” on page 92.

The following sections describe functions that help you manage variables.

Show Symbols, Clear Symbols, and Delete Symbols

The `Show Symbols()` function lists all variables and namespaces that are defined both globally and in the local script, along with their current values. Here is an example of `Show Symbols()` messages that are shown in the log:

```
Show Symbols();
  // Here
  a = 5;
  b = 6;
  // 2 Here
  // Global
  c = 10;
```
Tip: The JSL debugger also shows you the values of variables and namespaces. See “Debug or Profile Scripts” on page 63 in the “Scripting Tools” chapter for more information.

The Clear Symbols() function erases the values set for variables that are defined both globally and in the local script. For example, after you clear and then show symbols, the variables are empty.

Clear Symbols();
Show Symbols();

// Here
a = Empty;
b = Empty;
// 2 Here

// Global
c = Empty;
// 1 Global

Note: The older Show Globals() and Clear Globals() functions are aliases of the newer Show Symbols() and Clear Symbols() functions.

To remove all global variables and namespaces, use the function Delete Symbols(). After the last Show Symbols() in the following script is run, nothing shows up in the log. All variables have been completely removed from memory.

Delete Symbols();
Show Symbols();

To list variables in all namespaces, use Show Namespaces(). To delete only a specific namespace, use ns << Delete.Clear Symbols() and Delete Symbols() do not clear or delete variables in each namespace, although they do clear and delete variables that contain references to namespaces. See “Rules for Name Resolution” on page 92 for details about unscoped variables.

Note: Clear Symbols() and Delete Symbols() break all scripts that are currently in use. These functions can be very useful in a programming and debugging environment, but do not include them in any script that you plan to distribute. If you include Names Default To Here(1) in your scripts, clearing and deleting global symbols is unnecessary.

Lock and Unlock Symbols

If you want to lock a variable to prevent it from being changed, use the Lock Symbols() function. (Lock Globals() is an alias.)

Lock Symbols( name1, name2, ... );
To release the lock and enable the global to be changed, use the `Unlock Symbols()` function.  
( `Unlock Globals()` is an alias.)

\[
\text{Unlock Symbols(name1, name2, ... );}
\]

The primary use of these two commands is to prevent inadvertent changes to variables. For example, locking a variable prevents `Clear Symbols()` from clearing a variable that is being used by another script.

**Note:** You cannot use `Lock Symbols()` to lock a namespace. Instead, use `ns << Lock`.

### Hide a Global Variable

To hide (or protect) a global variable, put two underscores (\_\_\_) before the name. Protecting a global variable means that it will be hidden and can not be examined or shown. However, the behavior is different depending upon the content.

This example will not print the variable because it is protected:

\[
\text{Show(__xyz);}
\]

This example returns a NULL value for the protected variable:

\[
::a = \text{Name Expr(__xyz)};
\]

This example does return a value for the protected variable:

\[
\text{Show(Eval(__xyz));}
\]

### Rules for Name Resolution

In JMP, you identify the following types of objects by a name:

- Columns and table variables in a data table
- Global variables, which hold values for the remainder of a JMP session
- Scriptable object types
- Arguments and local variables inside formulas

Most of the time, you can just use an object’s name directly to refer to the object. Consider the following example:

\[
\text{ratio = height / weight;}
\]

Depending on the complexity of your script, it might be obvious that `ratio` is a variable and `height` and `weight` are data table column names. But what if the meanings are ambiguous? A script might use `ratio` as a global variable and as column names.
Variable Names Used as Arguments

Message arguments are evaluated as a rule. In previous versions of JMP, some messages interpreted a variable name as a string value. For example, the following script results in a linear scale in the current version of JMP and a log scale in JMP 11.

```js
Log = "Linear";
axis box << Scale( Log );
```

The syntax `Scale(  "Log"  )` is preferred for setting a string literal. To catch ambiguous instances, set the “Allow Unquoted Strings in JSL” General preference to “Yes (with a warning)” or “No”.

Resolving Unscoped Names

JMP interprets object names using name resolution. The following rules are applied sequentially to unscoped names:

1. When the name is part of a script for an object, it is usually the name of an option or method in the object. For example, `Show Points()` is an option in the Bivariate object:
   ```js
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Bivariate( y( weight ), x( height ) );
obj << Show Points( 1 );
```
2. If a name is not preceded by the `:` scoping operator, look it up in a namespace, such as Global or Here.
3. If a name is followed by a pair of parentheses `()`, look up the name as a built-in function (not a user-defined function).
4. If a name is preceded by the `:` scoping operator, look it up as a data table column or table variable.
5. If a name is preceded by the `::` scoping operator, look it up as a global variable.
6. Look it up as a local variable.
7. Look it up as a platform launch name (for example, Distribution or Bivariate).
8. If a name is used as the left side of an assignment (the L-value) and `Names Default To Here( 0 )` is at the top of the script, create and use a global variable.

Exception

- Some names are variables that refer to an object such as a data table, data column, or platform; they are not used for getting or setting a value. These names are passed through (or interpreted literally) rather than resolved.
- For function definitions, column formulas, and Nonlinear platform formulas, the scope is the same for each row in a column.
• If a name is a direct reference to a column in a data table that has been closed, the name is resolved again to that column when the table is reopened.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Show( :weight << Get As Matrix ); // weight resolves to a column name
Close( dt, NoSave );
Show( :weight << Get As Matrix ); // weight cannot be resolved
/* Reopen the data table */
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Show( :weight << Get As Matrix ); // weight resolves to a column name
```

However, the following example does not resolve the variable to the second instance of the data table:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
col = Column( dt, 1 ); // col is Column( "weight" );
Close( dt, NoSave );
/* Reopen the data table */
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Show( col << Get As Matrix ); // The reference to the first data table no longer exists.
```

The following sections describe how JMP resolves the names of data table columns. For more information about name resolution, see “Advanced Scoping and Namespaces” on page 235 in the “Programming Methods” chapter.

## Scoping Operators

Using *scoping operators* is an easy way to help JMP resolve ambiguous names (for example, when a name refers to both a variable and a column name).

In the following example, the prefix double-colon operator (::) identifies z as a global variable. The single-colon prefix operator (: ) identifies x and y as column names.

```julia
::z = :x + :y;
```

**Tip:** The `Names Default to Here(1)` function also affects name resolution. See “Names Default To Here and Global Variables” on page 236 in the “Programming Methods” chapter for details.

Two JSL functions are interchangeable with scoping operators. Table 5.4 describes the functions and syntax.
Table 5.4 Scoping Operators

<table>
<thead>
<tr>
<th>Operator and Equivalent Function</th>
<th>Function Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>: As Column</td>
<td>:name dt:name As Column(dt, name)</td>
<td>Forces name to be evaluated as a data table column. The optional data table reference argument, dt, sets the current data table. See “Scoped Column Names” on page 95 for examples.</td>
</tr>
<tr>
<td>:: As Global</td>
<td>:::name As Global(name)</td>
<td>Forces name to be evaluated as a global variable. <strong>Note:</strong> The double-colon is also used as an infix operator to represent ranges.</td>
</tr>
</tbody>
</table>

Scoped Column Names

Scoping column names is the simplest way to prevent conflicts with variable names. Use scoping operators to force names in a script to refer to columns.

1. The prefix colon (:) means that the name refers to a table column or table variable only, never a global variable. The prefix colon refers to the current data table context.

   ::age;

2. The infix colon (:) operator extends this notion by using a data table reference to specify which data table has the column. This is particularly important when multiple data tables are referenced in a script.

   In the following example, the dt variable sets the data table reference to Big Class.jmp. The infix colon separates the data table reference and age column.
   
   dt = Data Table( "Big Class.jmp" );
   dt:age // The colon is an infix operator.
   
   As Column() achieves the same results:
   
   dt = Data Table( "Big Class.jmp" );
   As Column( dt, age );

   Therefore, the following expressions are equivalent when only Big Class.jmp is open:

   ::age;
   As Column( dt, age );
   dt:age;

   The Column function can also identify a column. For Big Class.jmp, the following expressions all refer to age, the second column in the table:

   Column( "age" );
   Column( 2 );
Column( dt, 2 );
Column( dt, "age" );

Preventing Column Name and Variable Name Conflicts

When you run a script that includes a column and variable with the same name, an Invalid Row Number error occurs. To prevent this problem, use unique column and variable names, or scope the names as follows:

- When a global variable and a column have the same name, the global variable name takes precedence. In this situation, you must scope the column name.
  ```
  ::age = [];
  age = :age << Get As Matrix;
  ```
- To avoid ambiguity between the global variable and column name, scope both variables.
  ```
  ::age = :age << Get As Matrix;
  ```
- If more than one data table might be open, assign data table references to variables. Scope your columns to the appropriate table.
  ```
  dt1 = Open( "$SAMPLE_DATA/Big Class.jmp" );
  dt2 = Open( "$SAMPLE_DATA/Students.jmp" );
  ::age = dt1:age << Get As Matrix;
  ::height = dt2:height << Get As Matrix;
  ```

Note that JMP evaluates column formulas through each consecutive cell of the column, so scoping the column name is usually unnecessary. However, if a variable assigned in a formula has the same name as a column, you must scope the column name. For details, see “Scoped Names” on page 238 in the “Programming Methods” chapter.

Unscoped Column Names

Sometimes an unscoped name gets or sets a value. JMP resolves it as a column in a data table (rather than a global variable) under these circumstances:

- if no global variable, local variable, or an argument using that name already exists,
- and the data table in context has a column of that name,
- and
  - either the current row is set to a positive value
  - or the name is subscripted (for example, the subscript [1] in weight[1] selects the first value in the weight column).

If the data table has a table variable by that name, then the table variable takes precedence. In all other cases, it binds to a global, local, or argument. For more information about global and local variables, see “Global and Local Variables” on page 89.
Exception
In column formulas and Nonlinear formulas, column names take precedence over global variables.

Set the Current Data Table Row
By default, the current row is 0, an illegal row number. So the following expression assigns a missing value to the ratio global variable:

\[\text{ratio} = \text{height} / \text{weight};\]

Specify the row number with the Row() function. In the following example, the row is set to 3. The height in that row is divided by the weight, and the result is assigned to the ratio global variable.

\[
\begin{align*}
\text{Row()} &= 3; \\
\text{ratio} &= \text{height} / \text{weight};
\end{align*}
\]

Another possibility is to use subscripts to specify the row number. The following expression divides the height in row 3 by the weight in row 4.

\[\text{ratio} = \text{height}[3] / \text{weight}[4];\]

Specifying the row number is unnecessary when the script iterates a row at a time down the whole column. The following example creates the ratio column. For each row, the height is divided by the weight.

\[
\begin{align*}
\text{dt} &= \text{Open}('"\$SAMPLE\_DATA/Big Class.jmp"'); \\
\text{dt} &\ll \text{New Column('ratio')}; \\
\text{For Each Row}(:\text{ratio} = \text{height} / \text{weight});
\end{align*}
\]

JMP evaluates formulas and calculates pre-evaluated statistics iteratively down a column. In these instances, identifying the row number is also unnecessary. (Pre-evaluated statistics are single numbers computed from the data table, as discussed in “Pre-Evaluated Statistics” on page 375 in the “Data Tables” chapter.)

Troubleshooting Variables and Column Names
When you reference a column name using As Name(), and Names Default To Here(1) is set, JMP returns a variable reference. That reference is then processed using the standard reference rules.

In the following example, there is no height variable in the Here: scope, so JMP returns an error.

\[
\begin{align*}
\text{Names Default To Here}(1); \\
\text{Open('"\$SAMPLE\_DATA/Big Class.jmp"');} \\
\text{As Name('height')}[3]; \\
\text{As Name('height')}/[/*###*/3];
\end{align*}
\]
To prevent this problem, use one of the following methods:

- Use `As Column()` instead of `As Name()`:
  ```jsl
  Names Default To Here(1);
  Open("$SAMPLE_DATA/Big Class.jmp");
  As Column("height")[3];
  ```

- Explicitly scope `height` with `As Name()`:
  ```jsl
  Names Default To Here(1);
  dt = Open("$SAMPLE_DATA/Big Class.jmp");
  dt:( As Name("height") )[3];
  ```

These scripts return 55, the value of `height` in the third row of Big Class.jmp.

**Troubleshooting Variables and Keywords**

Name resolution errors can also occur when a variable and unquoted keyword have the same name. For example, one argument for `<<Preselect Role() is “Y”`. Quote this argument if your script also uses Y as a variable.

**Frequently Asked Questions about Name Resolution**

**Should you always scope?**

Yes. When in doubt, scope. Scoping is especially important in scripts that might be used by many people on a variety of data tables; you will not necessarily know whether a name is used in two contexts (such as for both a global variable and column name).

If you are writing such scripts, consider using explicit scoping and namespaces. See “Advanced Scoping and Namespaces” on page 235 in the “Programming Methods” chapter for more information.

Prefix scope operators do not take run-time overhead after the first resolution. Infix scope operators, which follow data table references, always take run-time overhead.

**What is the difference between a column reference and a column referred to by name? If I have a column reference in a global variable, how do I assign a value to a cell in the column?**

With a column reference, you can send messages to change specific characteristics of the column or to access its values (for example, coloring cells or setting a formula).

When a column has been assigned to a global variable, assign a value to a cell in the column using a subscript. Suppose that the name of the column `height` has been assigned to the `x` variable:

```jsl
x = Column("height");
```
Assign a value to the third row in the height column as follows:

```julia
x[3] = 64 // sets the third row of height to 64
```

**Note:** The current row in a JSL script is *not* determined by selecting rows or positioning your cursor in the row. The current row is defined to be zero (no row) by default. You can set a current row with `Row()` (for example, `Row() = 3`). Please note that such a setting only lasts for the duration of that script. Then, `Row()` reverts to its default value, zero. This behavior means that submitting a script all at once can produce different results than submitting a script a few lines at a time.

Another way to establish a current row for a script is to enclose it in `For Each Row()`. This method executes the script once for each row of the current data table. For an example, see “If” on page 106. See “Data Tables” chapter on page 275 for more information about working with data tables.

**Will a Scoping Operator “Stick” to its Name?**

Yes. Once you use a scoping operator with a name, that name continues to be resolved accordingly for all subsequent occurrences of the name. For example, a script might contain a column and a variable named `age`. When you declare the global variable `age` with the scoping operator `::` at the beginning of the script, `age` is always interpreted as a global variable in the script. The values in the `age` column are not affected by the variable.

```julia
::age = 70;
Open( "$SAMPLE_DATA/Big Class.jmp" );
age = 5; // age is a global variable.
Show( age ); // age is still a global variable.
```

**Which Has Precedence When Scoping, ":" or "[]"?**

Scoping occurs before subscripting. This means that these two lines of code are equal:

```julia
dataTable:colName[i]
(dataTable:colName)[i]
```

### Alternatives for Gluing Expressions Together

You can separate expressions with a semicolon, either on the same line or on different lines. JMP then evaluates each expressions in succession, returning the result of the last one. Here is an expression that first sets `a` to 2 and then sets `b` to 3:

```julia
a = 2;
b = 3;
```

The semicolon joins the two expressions and returns the value of the last one. So if `x = (a = 2; b = 3)`, the value of `x` is 3.
The `Glue()` function returns the result of the last expression. This function is equivalent to using semicolons. The following expressions both return 3:

```
Glue( a = 2, b = 3 );
```
```
a = 2; b = 3;
```

The `First()` function also evaluates each argument sequentially but returns the result of the first expression. The following expression returns 2:

```
First( a = 2, b = 3);
```

**Example**

What does `First()` do in the following script?

```
x = 1000;
First( x, x = 2000 );
```

The `First()` function returns the value of `x` (1000). 2000 is then assigned to `x`.

---

**Iterate**

JSL provides the `For()`, `While()`, `Summation()`, and `Product()` functions to repeat (or iterate) actions according to the conditions that you specify.

**Note:** A similar function called `For Each Row()` is for iterating actions over rows of a data table. See “If” on page 106 for an example. “Additional Ways to Access Data Values” on page 370 in the “Data Tables” chapter also describes iterating through table rows.

---

**For**

The `For()` function expects four arguments separated by commas. The first three arguments are rules for how many times to repeat the loop, and the fourth is what to do each time the loop is executed.

The basic syntax for `For()` is as follows:

```
For( initialization, while, iteration, body );
```

For example, the following script sums the numbers from 0 to 20:

```
s = 0;
For( i = 0, i <= 20, i++, s += i );
```

The script works like this:

```
s = 0;  // Sets the s variable to 0. This variable holds the sum.
```
### Infinite Loops

For loops that always evaluate as true create an infinite loop, which never stops. To stop the script, press ESC on Windows (or COMMAND-PERIOD on Macintosh). You can also select **Edit > Stop Script**. On Macintosh, **Edit > Stop Script** is available only when the script is running.

### Comparing For Loops in JSL to C and C++

The JSL `For()` loop works just like it does in the C (and C++) programming language, although the punctuation is different.

**Tip:** If you know C, watch out for the difference between JSL and C in the use of semicolons and commas. In JSL, `For()` is a function where commas separate arguments and semicolons join expressions. In C, `for` is a special clause where semicolons separate arguments and commas join them.

### While

A related function is `While()`, which repeatedly tests the condition and evaluates its body script as long as the condition is true. The syntax is:

```javascript
While( condition, body );
```

For example, here are two different programs that use a `While()` loop to find the least power of 2 that is greater than or equal to `x` (287). The result of both programs is 512.

```javascript
x = 287;
// loop 1:
```
```
y = 1;
While( y < x, y *= 2 );
Show( y );

// loop 2:
k = 0;
While( 2 ^ k < x, k++ );
Show( 2 ^ k );
```

The scripts work like this:

<table>
<thead>
<tr>
<th>x = 287;</th>
<th>Sets x to 287.</th>
</tr>
</thead>
<tbody>
<tr>
<td>// loop 1</td>
<td></td>
</tr>
<tr>
<td>y = 1;</td>
<td>Sets y to 1.</td>
</tr>
<tr>
<td>While(</td>
<td>Begins the While() loop.</td>
</tr>
<tr>
<td>y &lt; x,</td>
<td>As long as y is less than x, continues evaluating the loop.</td>
</tr>
<tr>
<td>y *= 2</td>
<td>Multiplies 1 by 2 and then assigns the result to y. The loop then repeats while y is less than 287.</td>
</tr>
<tr>
<td>);</td>
<td>Ends the loop.</td>
</tr>
<tr>
<td>Show(y);</td>
<td>Shows the value of y (512).</td>
</tr>
<tr>
<td>// loop 2</td>
<td></td>
</tr>
<tr>
<td>k = 0;</td>
<td>Sets k to 0.</td>
</tr>
<tr>
<td>While(</td>
<td>Begins the While() loop.</td>
</tr>
<tr>
<td>2 ^ k &lt; x,</td>
<td>Raises 2 to the exponent power of k and continues evaluating the loop as long as the result is less than 287.</td>
</tr>
<tr>
<td>k++</td>
<td>Increments k to 1. The loop then repeats while 2 ^ k is less than 287.</td>
</tr>
<tr>
<td>);</td>
<td>Ends the loop.</td>
</tr>
<tr>
<td>Show(2 ^ k);</td>
<td>Shows the value of 2 ^ k (512).</td>
</tr>
</tbody>
</table>

As with For() loops, While() loops that always evaluate as true create an infinite loop, which never stops. To stop the script, press ESC on Windows (or COMMAND-PERIOD on Macintosh). You can also select Edit > Stop Script. On Macintosh, Edit > Stop Script is available only when the script is running.
### Summation

The `Summation()` function adds the body results over all `i` values. The syntax is:

```
Summation( initialization, limitvalue, body );
```

For example:

```
s = Summation( i = 1, 10, i );
```

returns 55, the result of `1+2+3+4+5+6+7+8+9+10`.

The script works like this:

<table>
<thead>
<tr>
<th>s =</th>
<th>Sets the <code>s</code> variable to the value of the function.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summation(</td>
<td>Begins the <code>Summation()</code> loop.</td>
</tr>
<tr>
<td><code>i = 1</code>,</td>
<td>Sets <code>i</code> to 1.</td>
</tr>
<tr>
<td><code>10</code>,</td>
<td>Sets the limit of <code>i</code> to 10.</td>
</tr>
<tr>
<td><code>i</code></td>
<td>All values of <code>i</code> from 1 to 10 are added together, resulting in 55.</td>
</tr>
<tr>
<td><code>);</code></td>
<td>Ends the loop.</td>
</tr>
</tbody>
</table>

This behavior is similar to `Σ` in the Formula Editor. The following expression:

```
Summation( i = 1, N Row(), x ^ 2 );
```

is equivalent to the following formula in the Formula Editor:

```
\sum_{i=1}^{N\text{Row}} x^2
```

### Product

The `Product()` function is similar to `Summation()` except that it multiplies the body results rather than adding them. The syntax is the same as for `Summation()`. For example:

```
p = Product( i = 1, 5 , i );
```

returns 120, the result of `1*2*3*4*5`.

In this example, the initial value of `i` is 1, the upper limit is 5, then all integer values of `i` up to 5 are multiplied.

Here is the equivalent in the Formula Editor:

```
\prod_{i=1}^{5} i
```
**Break and Continue**

The `Break()` and `Continue()` functions give you more control over looping. `Break()` immediately stops the loop and proceeds to the next expression that follows the loop. `Continue()` is a gentler form of `Break()`. It immediately stops the current iteration of the loop and continues with the next iteration of the loop.

**Break**

`Break()` is typically used inside a conditional expression. For example:

```java
For( i = 1, i <= 5, i++,
    If( i == 3, Break() );
    Print( "i=" || Char( i ) );
); results in:
  "i=1"
  "i=2"
```

The script works like this:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>For()</code></td>
<td>Begins the <code>For()</code> loop.</td>
</tr>
<tr>
<td><code>i = 1,</code></td>
<td>Sets <code>i</code> to 1.</td>
</tr>
<tr>
<td><code>i &lt;= 5,</code></td>
<td>As long as <code>i</code> is less than or equal to 5, continues evaluating the loop.</td>
</tr>
<tr>
<td><code>i++</code>,</td>
<td>Increments <code>i</code> by 1. Note that this step is done after the <code>If</code> loop is evaluated.</td>
</tr>
<tr>
<td><code>If()</code></td>
<td>Begins the <code>If()</code> loop.</td>
</tr>
<tr>
<td><code>i == 3, Break()</code></td>
<td>If <code>i</code> is equal to 3, breaks the loop.</td>
</tr>
<tr>
<td><code>);</code></td>
<td>Ends the loop.</td>
</tr>
<tr>
<td><code>Print()</code></td>
<td>When <code>i</code> equals 3, opens the <code>Print()</code> loop.</td>
</tr>
<tr>
<td>&quot;i=&quot;</td>
<td>Prints the string &quot;i=&quot; to the log.</td>
</tr>
<tr>
<td>`</td>
<td></td>
</tr>
<tr>
<td><code>Char(i));</code></td>
<td>Prints the value of <code>i</code> to the log.</td>
</tr>
</tbody>
</table>

The `For()` loop then repeats until the value of `i` is less than or equal to 5, breaking and printing only when `i` is less than 3.
Note that when the If() and Break() expressions follow Print(), the script prints the values of i from 1 to 3, because the loop breaks after "i=3" is printed.

"i=1"
"i=2"
"i=3"

Continue

As with Break(), Continue() is typically used inside a conditional expression. For example:

```
For( i = 1, i <= 5, i++,
    If( i < 3, Continue() );
    Print( "i=" || Char( i ) );
);
```

results in:

"i=3"
"i=4"
"i=5"

The script works like this:

<table>
<thead>
<tr>
<th>For(</th>
<th>Begins the For() loop.</th>
</tr>
</thead>
<tbody>
<tr>
<td>i = 1,</td>
<td>Sets i to 1.</td>
</tr>
<tr>
<td>i &lt;= 5,</td>
<td>Evaluates 1 as less than or equal to 5.</td>
</tr>
<tr>
<td>i++,</td>
<td>Increments i by 1. Note that this step is done after the If loop is evaluated.</td>
</tr>
<tr>
<td>If(</td>
<td>Begins the If() loop.</td>
</tr>
<tr>
<td>i &lt; 3, Continue()</td>
<td>Evaluates i as 1 and continues as long as i is less than 3.</td>
</tr>
<tr>
<td>);</td>
<td>Ends the If() loop.</td>
</tr>
<tr>
<td>Print(</td>
<td>When i is no longer less than 3, opens the Print() loop.</td>
</tr>
<tr>
<td>&quot;i=&quot;,</td>
<td>Prints the string &quot;i=&quot; to the log.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Conditional Functions

JSL provides five functions to evaluate an expression conditionally: If(), Match(), Choose(), Interpolate(), and Step().

If

The If() function evaluates the first result expression when its condition evaluates as true (a nonzero or nonmissing value). Otherwise, it evaluates the second result expression.

The syntax is:

\[
\text{If} \left( \text{condition}, \text{result1}, \text{result2} \right);
\]

For example, the following script returns "Young" when the age is less than 12. Otherwise, the script returns "Young at Heart".

\[
dt = \text{Open}( \"\$SAMPLE\_DATA/Big Class.jmp\" );
For \text{ Each Row} \left( \text{age} = \text{If} \left( :\text{age} < 12, \text{"Young"}, \text{"Young at Heart"} \right) \right);
\]

You can also string together multiple conditions and results. The syntax is:

\[
\text{If} \left( \text{condition1}, \text{result1}, \text{condition2}, \text{result2}, \ldots, \text{resultElse} \right);
\]

In the preceding example, if condition1 is not true, the function continues evaluating until it finds a true condition. Then that condition’s result is returned.

The last result is returned when all conditions are false. And when a value is missing, the missing value is returned. For these reasons, it’s very important to include a default result at the end of the expression. Consider the following example, which recodes gender abbreviations in Big Class.jmp:

\[
dt = \text{Open}( \"\$SAMPLE\_DATA/Big Class.jmp\" );
For \text{ Each Row} \left( \text{sex} = \right.
If(
    \text{sex} = \text{"F"}, \text{"Female"},
    \text{sex} = \text{"M"}, \text{"Male"},
\left. \right)
\]
The script works like this:

```
"Unknown" );
);
```

You can also put actions and assignments in the result expression. The following example assigns 20 to x, because the first condition ($y < 20$) is false:

```
y = 25;
z = If( y < 20, x = y, x = 20 );
```

**Note:** Be careful to use two equal signs (==) for equality tests, not one equal sign (=). An `If` with an argument such as `name=value` assigns rather than tests the value.

---

### Match

You can use the `Match()` function to make several equality comparisons without needing to rewrite the value to be compared. The syntax is:

```
Match( x, value1, result1, value2, result2, ..., resultElse );
```

For example, the following script recodes gender abbreviations in Big Class.jmp:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
For Each Row( sex =
    Match( 
        sex, 
        "F", "Female", 
        "M", "Male", 
        "Unknown" );
    );
```

```
For Each Row( sex =
    Match( 
        sex, 
        "F", "Female", 
        "M", "Male", 
        "Unknown" );
    );
```

For each row in the table, `sex` is the column that is recoded.

If

- `sex == "F", "Female",` If the value of `sex` is F, replaces the value with Female.
- `sex == "M", "Male",` If the value of `sex` is M, replaces the value with Male.
- `"Unknown" );` If neither of the above conditions are true, replaces the value with Unknown. If this result were omitted and the value of `sex` were missing, the script would return a missing value.

```
);); Ends the loop.
```

You can always put actions and assignments in the result expression. The following example assigns 20 to x, because the first condition ($y < 20$) is false:

```
y = 25;
z = If( y < 20, x = y, x = 20 );
```

**Note:** Be careful to use two equal signs (==) for equality tests, not one equal sign (=). An `If` with an argument such as `name=value` assigns rather than tests the value.

---

### Match

You can use the `Match()` function to make several equality comparisons without needing to rewrite the value to be compared. The syntax is:

```
Match( x, value1, result1, value2, result2, ..., resultElse );
```

For example, the following script recodes gender abbreviations in Big Class.jmp:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
For Each Row( sex =
    Match( 
        sex, 
        "F", "Female", 
        "M", "Male", 
        "Unknown" );
    );
```

```
The script works like this:

```
For Each Row( sex = 
    Match( sex, 
        "F", "Female", 
        "M", "Male", 
        "Unknown" );
        If F or M are not matched, replaces the value with "Unknown".
    );
)

This Match() example is a simplified version of the example in “If” on page 106. The advantage of Match() is that you define the comparison value once rather than repeat it in each condition. The disadvantage is that you cannot use expressions with operators as you can with If; the argument sex == "F" returns an error in a Match() expression.

With more groups of conditions and results, the value of Match() becomes more apparent. The following script would require many additional lines of code with If().

```
dt = Open( "$SAMPLE_DATA/Travel Costs.jmp" );
For Each Row( sex = 
    Booking Day of Week = Match( Booking Day of Week, 
        "Sunday", "SUN", 
        "Monday", "MON", 
        "Tuesday", "TUE", 
        "Wednesday", "WED", 
        "Thursday", "THU", 
        "Friday", "FRI", 
        "Saturday", "SAT", 
        "Not Specified"
    );
)
```

Be careful with the data type of the condition and result. In the preceding example, the conditions and results are both character data. If the data types do not match, JMP automatically changes the column’s data type. The results are not what you want.

The following script changes the column’s data type from numeric to character based on the first cell’s data type. The first value, "12", is replaced with "Twelve", and the remaining cells are filled with "Other".

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
```
For Each Row(
    age = Match( age, 12, "Twelve", 13, "Thirteen", 14, "Fourteen", 15, "Fifteen", 16, "Sixteen", "Other" );
);

When data consists of integers such as 1, 2, and 3, you can save even more typing by using Choose(). See “Choose” on page 109 for more information.

Choose

The Choose() function shortens scripts even more than Match(), provided the arguments are tested against integers. The syntax is:

    Choose( expr, result1, result2, result3, ..., resultElse );

Suppose you have a data table with a group column of numeric values from 1 through 7. If the first cell contains the number 1, the following script returns x = "Low".

    x = ( Choose( group, "Low", "Medium", "High", "Unknown" ); );
    Show( x );

The script works like this:

<table>
<thead>
<tr>
<th>x =</th>
<th>Creates the x variable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose(</td>
<td>Begins the Choose() loop.</td>
</tr>
<tr>
<td>group,</td>
<td>Evaluates the value of group.</td>
</tr>
<tr>
<td>&quot;Low&quot;,</td>
<td>If the value of group is 1, return &quot;Low&quot;.</td>
</tr>
<tr>
<td>&quot;Medium&quot;,</td>
<td>If the value of group is 2, return &quot;Medium&quot;.</td>
</tr>
<tr>
<td>&quot;High&quot;,</td>
<td>If the value of group is 3, return &quot;High&quot;.</td>
</tr>
<tr>
<td>&quot;Unknown&quot;</td>
<td>Otherwise, return &quot;Unknown&quot;.</td>
</tr>
<tr>
<td>)</td>
<td>Ends the loop.</td>
</tr>
<tr>
<td>);</td>
<td>Closes the x variable.</td>
</tr>
<tr>
<td>Show( x );</td>
<td>Returns the value of x.</td>
</tr>
</tbody>
</table>

If the expression evaluates to an out-of-range integer (such as 7 when only 4 replacement values are listed), the last result is returned. In the preceding example, "Unknown" is returned.

Notice that If() and Match() require more code to achieve the same results as the Choose function:

    If(
JSL Building Blocks
Conditional Functions

```plaintext
group == 1, "Low",
group == 2, "Medium",
group == 3, "High",
"Unknown"
);
Match( group, 1, "Low", 2, "Medium", 3, "High", "Unknown" );

Note: If the data types in the expression do not match, JMP automatically changes the
column’s data type.

Interpolate

The Interpolate() function finds the y value corresponding to a given x value between two
points (x1, y1 and x2, y2). A linear interpolation is applied to the values. You might use
Interpolate() to calculate missing values between data points.

The data points can be specified as a list:

Interpolate( x, x1, y1, x2, y2, ... );

or as matrices containing the x and y values:

Interpolate( x, xmatrix, ymatrix );

Suppose that your data set includes the height of individuals from age 20 through 25.
However, there is no data for age 23. To estimate the height for 23-year-olds, use interpolation.
The following example shows the value that you want to evaluate (age 23), followed by
matrices for ages (20 through 25) and heights (59 through 75).

Interpolate( 23, [20 21 22 24 25], [59 62 56 69 75] );

returns:

62.5

The value 62.5 is halfway between the y values 56 and 69, just as 23 is halfway between the x
values 22 and 24.

- The data points in each list or matrix must create a positive slope. For example,
  Interpolate(2,1,1,3,3) returns 2. However, Interpolate(2,3,3,1,1) returns a missing
  value (.).

- Interpolate is best used for continuous data, but Step() is for discrete data. See “Step”
on page 110 for details.

Step

The Step() is like Interpolate() except that it finds the corresponding y for a given x from a
step-function fit rather than a linear fit. Use Step() with discrete y values (that is, when the y
value’s corresponding x value can be only $y_1$ or $y_2$. However, when the y value’s corresponding x value can fall between $y_1$ and $y_2$, use Interpolate().

As with Interpolate, the data points can be specified as a list:

```
Step( x, x1, y1, x2, y2, ... );
```

or as matrices containing the x and y values:

```
Step( x, xmatrix, ymatrix );
```

Suppose that your data table shows the discount percentage for purchases of $25, $50, $75, and $100. You want to create a graph that shows the discount for a $35 purchase, which the data table does not specify. The following example shows the value that you want to evaluate, 35, followed by matrices for purchases from $25 to $100.

```
Step( 35, [25 50 75 100], [5 10 15 25] );
```

returns:

5

If the discounts were on a sliding scale (in this example, between 5 and 10, you would use Interpolate()):

```
Interpolate( 35, [25 50 75 100], [5 10 15 25] );
```

returns:

7

As with Interpolate(), the data points must create a positive slope.

---

**Compare Incomplete or Mismatched Data**

Comparing data that contains missing values can return misleading results unless you specify a condition that is always true or use functions such as Is Missing() or Zero Or Missing(). Comparisons of data with mismatched types (numeric versus character) or data in matrices can also be confusing.

Table 5.5 shows examples of such comparisons and matrices and explanations of the results. For a review of operators used in comparisons, see “Operators” on page 85. The sections that follow the table provide more details about comparison and logical operators.

**Note:** Matrices must include the same number of columns or rows.
### Table 5.5 Some Special-Case Comparison Tests

<table>
<thead>
<tr>
<th>Test</th>
<th>Result</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>m=.; m==1</td>
<td>.</td>
<td>An equality test with a missing value returns missing.</td>
</tr>
<tr>
<td>m=.; m!=1</td>
<td>.</td>
<td>An inequality test with a missing value returns missing.</td>
</tr>
<tr>
<td>m=.; m&lt;1; m&gt;1; and so on</td>
<td>.</td>
<td>A comparison with a missing value returns missing (unless it could not possibly be true, see next).</td>
</tr>
<tr>
<td>m=.; 1&lt;m&lt;0</td>
<td>0</td>
<td>A comparison involving a missing value that could not possibly be true returns false; false takes precedence over missing for comparisons with more than two arguments (as with logical operators).</td>
</tr>
<tr>
<td>{a, b}==List(a, b)</td>
<td>1</td>
<td>An equality test of list arguments returns a single result.</td>
</tr>
<tr>
<td>{a, b}&lt;{a, c}</td>
<td>.</td>
<td>A comparison test of list arguments is not allowed.</td>
</tr>
<tr>
<td>1==&quot;abc&quot;</td>
<td>0</td>
<td>An equality test with mixed data types returns false.</td>
</tr>
<tr>
<td>1&lt;=&quot;abc&quot;</td>
<td>.</td>
<td>A comparison with mixed data types returns missing.</td>
</tr>
<tr>
<td>[1 2 3]==[2 2 5]</td>
<td>[0 1 0]</td>
<td>An equality test of matrices returns a matrix of elementwise results. When a matrix is compared to a matrix, comparison is done element-by-element and returns a matrix of 1s and 0s.</td>
</tr>
<tr>
<td>[1 2 3]==2</td>
<td>[0 1 0]</td>
<td>An equality test of a matrix and a matrix filled with 2s. If a matrix is compared to a number, the number is treated as a matrix filled with that number.</td>
</tr>
<tr>
<td>[1 2 3] &lt; [2 2 5]</td>
<td>[1 0 1]</td>
<td>A comparison of matrices returns a matrix of elementwise results.</td>
</tr>
<tr>
<td>[1 2 3] &lt; 2</td>
<td>[1 0 0]</td>
<td>A comparison of a matrix and a matrix filled with 2s.</td>
</tr>
<tr>
<td>Is Missing(m)</td>
<td>1</td>
<td>Returns 1 for a missing value and returns 0 otherwise. For missing character values, you can also use empty quotes for the comparison, as in m == &quot;&quot;.</td>
</tr>
<tr>
<td>Zero Or Missing(m)</td>
<td>1</td>
<td>Returns 1 when the value is 0 or missing. The argument must be numeric or a matrix and not a string.</td>
</tr>
<tr>
<td>All([2 2]==[1 2])</td>
<td>0</td>
<td>Summarizes elementwise comparisons; returns 1 only if all comparisons are true and returns 0 otherwise.</td>
</tr>
<tr>
<td>Any([2 2]==[1 2])</td>
<td>1</td>
<td>Summarizes elementwise comparisons; returns 1 if any comparison is true and returns 0 otherwise.</td>
</tr>
</tbody>
</table>
Missing Values

In a comparison, missing values typically return missing, not true or false. For this reason, it is very important to include a result that is always true. Suppose that a data table column contains the values 1, 2, 3, and a missing value in column A. A formula in column B sets up the comparison. For example, the following script:

```julia
New Table( "Testing Comparisons",
    Add Rows( 4 ),
    New Column( "A",
        Numeric,
        "Continuous",
        Format( "Best", 10 ),
        Set Values( [1, 2, 3, .] )
    ),
    New Column( "B", Character, "Nominal", Formula( If( :A, "true", 1, "false" ) ) )
);
```

The following values are stored in column B:

"true"
"true"
"true"
"false"

The script works like this:

| If(                                    | Begins the comparison. | 
| :A, "true",                            | If the value of A is nonmissing and nonzero, the result is "true". This comparison is true for the first three rows. |
| 1, "false"                             | The value of 1 is always true, so the missing value returns "false". |
|                                        | Closes the comparison. |

The two exceptions to this rule involve comparing a missing value to a known value:

- If one value is true and another is missing, Or() returns true. (Only one value in an Or() test needs to be true to get a true result.)
- If one value is false and another is missing, And() returns false. (Both values in an And() test must be true to get a true result.)

Is Missing

If you know that some values are missing, you can also compare with Is Missing(). The comparison in the preceding example can be rewritten to return "missing" for missing values:
If( :A, "true", Is Missing( :A ), "missing", "false" );

The preceding expression returns "true" when A is nonmissing and nonzero, "missing" when A is missing, and "false" otherwise.

**Zero Or Missing**

If the missing value could be 0, use the Zero Or Missing() function instead:

```
Zero Or Missing( A );
```

This expression returns 1 when A is 0 or missing.

**Tip:** You cannot compare a known value with an explicitly defined missing value, only with variables, matrices, or other things that could contain missing values.

---

**Inquiry Functions**

Inquiry functions identify the type of an element, such as a string, list, or matrix. You can then write a script specific to that element type.

JMP also uses inquiry functions to determine the writability of a directory or file and to identify a computer’s operating system and the JMP version.

**General Element Types**

The `Type()` function returns a string naming the type of the resulting value. For example:

```
Show( Type( 1 ), Type( "hi" ), Type( {"a", 2} ), Type( [10 24 325] ) );
```

results in:

```
Type(1) = "Integer"
Type("hi") = "String"
Type( {"a", 2} ) = "List"
Type([10 24 325]) = "Matrix";
```

**Specific Element Types**

Other inquiry operators (such as Is Matrix(), Is List(), Is Scriptable(), and so on) let you test for specific types of objects. In the following example, Is Matrix() evaluates as true, then the specified calculations are run:

```
a = [2 3];
b = [1, 1];
c = a * b;
If( Is Matrix( c ),
   (c ^ a) / (a * b),
   Print( "c is not a matrix." )
```
Is Scriptable() returns 1 when the object is scriptable. Four variables in the following example refer to a data table, column, platform, and report. All four objects are scriptable, so Is Scriptable() returns 1 for each example.

```javascript
dt = Open("$SAMPLE_DATA/Big Class.jmp");
col = Column("weight");
plat = Bivariate(Y(:weight), X(:height));
rep = Report(plat);
Show(Is Scriptable(dt));
    Is Scriptable(dt) = 1;
Show(Is Scriptable(col));
    Is Scriptable(col) = 1;
Show(Is Scriptable(plat));
    Is Scriptable(plat) = 1;
Show(Is Scriptable(rep));
    Is Scriptable(rep) = 1;
```

Is Empty() tests to see whether a variable has a value, a function, an expression, or a reference to an object. Otherwise, you get errors when referring to something that has not been created or assigned a value yet. Programmers call this an **uninitialized variable**.

Here is an example of a test to see whether a data table is opened and therefore assigned to the `dt` variable. If a data table is not opened, the `Open()` function prompts the user to open the table.

```javascript
If(Is Empty(dt = Current Data Table()),
    dt = Open();
)
```

You can use `Is Empty()` for any variable (such as global variable, local variable, and columns).

Table 5.6 shows functions that identify object types.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Associative Array(x)</td>
<td>Returns 1 if the evaluated argument is an associative array or 0 otherwise.</td>
</tr>
<tr>
<td>Is Directory(x)</td>
<td>Returns 1 if the x argument is a directory and 0 otherwise.</td>
</tr>
<tr>
<td>Is Empty(global)</td>
<td>Returns 1 if the global variable, data table, or data column does not have a value (is uninitialized) or 0 otherwise.</td>
</tr>
<tr>
<td>Is Empty(dt)</td>
<td></td>
</tr>
<tr>
<td>Is Empty(col)</td>
<td></td>
</tr>
<tr>
<td>Is Expr(x)</td>
<td>Returns 1 if the evaluated argument is an expression or 0 otherwise.</td>
</tr>
</tbody>
</table>
**Object Attributes**

JMP provides the following functions to determine whether a file or directory is writable before attempting to write to them. Use these functions in combination with `IsDirectory(path)` and `IsFile(path)` to verify a script destination and attribute. See the Functions chapter in the *JSL Syntax Reference* book for additional information.

The `IsDirectory Writable(path)` function returns 1 if the directory specified in the path argument is writable and 0 otherwise.

The `IsFile Writable(path)` function returns 1 if the file specified in the path argument is writable and 0 otherwise.

For example, the following code verifies the path refers to a directory and then checks to ensure the directory is writable:

```julia
If( Is Directory( "$SAMPLE_DATA/Loss Function Templates" ),
   If( Is Directory Writable( "$SAMPLE_DATA/Loss Function Templates" ),
      "Directory is writable."
     , "Directory is read only!"
   ),
   "Is a read only directory."
);"
Host Information

The `Host Is()` inquiry function identifies the current operating system. Then actions specific to that operating system can be performed.

For example, if the operating system is Windows, the following script loads a Windows Dynamic Link Library (DLL):

```javascript
If( Host is( "Windows" ),
    dll_obj = Load DLL( "C:/Windows/System32/user32.dll" )
);
```

You could also use `Host is()` to specify text sizes in reports for different operating systems. If you commonly write your scripts on Windows and share them with Macintosh users, the results can look different from what you intended. For example, the following expression sets the text to a larger size on Macintosh and a smaller size on Windows:

```javascript
textsize = If( Host is( "Mac" ), 12, 10 );
```

Version Information

The `JMP Version()` inquiry function returns the JMP version as a string. You might use this function to determine the JMP version and then run a script compatible with that version.

```javascript
JMP Version(); // returns "13.0.0" in JMP 13
JMP Version(); // returns "9.0.0" in JMP 9
```

Notice that a leading blank is inserted before versions less than 10.0.0. This blank helps when comparing version numbers. Without the leading blank, 9.0.0 is interpreted as greater than 10.0.0.
This chapter discusses basic data types:

- numbers and strings
- paths, which are a special type of string
- dates and times, which can be either special numbers or special strings
- currency
- hexadecimal values and blobs

At the end of the chapter are two sections that show more advanced methods of interacting with strings and pattern matching with regular expressions.
Numbers and Strings

*Numbers* can be written as integers, decimal numbers, in scientific notation with an E preceding the power of ten, and as date-time values. A single period by itself is the missing numeric value.

For example, these are all numbers:

```
.   1   12   1.234  3E3  0.314159265E+1  1E-20
```

One or more characters placed within double quotation marks constitute a *string*. For example, these are all strings:

```
"Green"  "Hello,\\World!"  "54"
```

Notice that if a number is in quotation marks, it is a string, not a number. There are two functions you can use to change a number into a string or a string into a number.

- **Use** `Num()` **to** convert a string into a number. For example:

  ```
  Num( "54" );
  54
  ```

  **Note:** `Num()` cannot convert non-numeric characters, so it produces a missing value.

  ```
  Num( "Hello" );
  .
  ```

- **Use** `Char()` **to** convert a number into a string. For example:

  ```
  Char( 54 );
  "54"
  Char( 3E3 )
  "3000"
  ```

To preserve locale-specific numeric formatting in `Num()` or `Char()` output, include the `<<Use Locale(1)` option as shown in the following example:

```
Char( 42, 5, 2, << Use Locale(1) );
// results in the character value "42,00" in the French locale
```

To look at each character in a string, use the `Substr()` function. This example looks for the letter “a” in the string and prints a message to the log:

```
ch = Substr( "alphabetic", 1, 1 ); // start and end with the first character
If( ch == "a",
   Print( "First letter is a." )
);
"First letter is a."
```
Unicode Characters

JMP supports both Unicode UTF-8 and UTF-16 standards for encoding and representing text for most of the world languages. Refer to the The Unicode Consortium for code charts and details on the Unicode standard.

To display Unicode characters in JMP, precede the Unicode code for the character with ‘\!’. For example:

- Greek letter sigma (σ) in Unicode = U+03C3; in JMP, use \!U03C3
- Greek letter mu (μ) in Unicode = U+03BC; in JMP, use \!U03BC

To use Unicode to express superscripts and subscripts:

- subscript 1 (₁) in Unicode = U+2081; in JMP, use \!U2081
- superscript 2 (²) in Unicode = U+00B2; in JMP, use \!U00B2

To express x² in Unicode, in JMP, use \!U0078\!U00B2.

Path Variables

Path variables are shortcuts to directories or files. Rather than enter the entire path to the directory or file, you use the path variable in a script. A path variable is a special type of string and is always contained within double quotation marks.

One common predefined path variable in JMP is $SAMPLE_DATA. This variable points to the sample data folder in your JMP or JMP Pro installation folder. The following example opens the Big Class.jmp sample data table.

    Open( "$SAMPLE_DATA/Big Class.jmp" );

Several path variables are predefined in JMP. The following table shows the definitions for the current JMP version. Variables in previous versions of JMP might differ.
### Table 6.1 Predefined Path Variable Definitions

<table>
<thead>
<tr>
<th>Variable</th>
<th>Path</th>
</tr>
</thead>
</table>
| **ADDIN_HOME**      | When you create an add-in through Add-In Builder, the $ADDIN_HOME definition is created based on your computer’s operating system:  
|                     | - Windows: \"C:/Users/<username>/AppData/Roaming/SAS/JMP/Addins/\"  
|                     | - Macintosh: \"/Users/<username>/Library/Application Support/JMP/Addins/\"  
|                     | Note that when you refer to an add-in from outside the add-in, you must reference the name of the add-in.  
|                     | \texttt{Pick File("$ADDIN_HOME('com.jmp.addins.test')")};  
|                     | To see if the directory exists, run the script \texttt{Is Directory("$ADDIN_HOME")}; If the folder exists, 1 is returned. |
| **ALL_HOME**        | Windows (JMP): \"C:/ProgramData/SAS/JMP/<version number>/\"  
|                     | Windows (JMP Pro): \"C:/ProgramData/SAS/JMPPro/<version number>/\"  
|                     | Windows (JMP Shrinkwrap): \"C:/ProgramData/SAS/JMPSW/<version number>/\"  
|                     | Macintosh: \"/Library/Application Support/JMP/<version number>/\"  
|                     | To see if the directory exists, run the script \texttt{Is Directory("$ALL_HOME")}; If the folder exists, 1 is returned. |
| **DESKTOP**         | Windows: \"C:/Users/<username>/Desktop/\"  
|                     | Macintosh: \"/Users/<username>/Desktop/\"  
| **DOCUMENTS**       | Windows: \"C:/Users/<username>/Documents/\"  
|                     | Macintosh: \"/Users/<username>/Documents/\"  
| **DOWNLOADS**       | Windows: \"C:/Users/<username>/Downloads/\"  
|                     | Macintosh: \"/Users/<username>/Downloads/\"  
| **GENOMICS_HOME**   | \"<JMP Genomics installation directory>\"  

### Table 6.1 Predefined Path Variable Definitions (Continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Path</th>
</tr>
</thead>
</table>
| HOME              | • Windows (JMP): "C:/Users/<username>/AppData/Roaming/SAS/JMP/<version number>/*"  
|                   | • Windows (JMP Pro): "C:/Users/<username>/AppData/Roaming/SAS/JMPPRO/<version number>/*"  
|                   | • Windows (JMP Shrinkwrap): "C:/Users/<username>/AppData/Roaming/SAS/JMPSW/<version number>/*"  
|                   | • Macintosh: "~/Users/<username>/"  
| SAMPLE_APPS       | • Windows: /C:/<JMP installation directory>/Samples/Apps/*"  
|                   | • Macintosh: "~/Library/Application Support/<JMP installation directory>/Samples/Apps/*"  
| SAMPLE_DASHBOARDS | • Windows: /C:/<JMP installation directory>/Samples/Dashboards/*"  
|                   | • Macintosh: "~/Library/Application Support/<JMP installation directory>/Samples/Dashboards/*"  
| SAMPLE_DATA       | • Windows: "~/C:/<JMP installation directory>/Samples/Data/*"  
|                   | • Macintosh: "~/Library/Application Support/<JMP installation directory>/Samples/Data/*"  
| SAMPLE_IMAGES     | • Windows: "~/C:/<JMP installation directory>/Samples/Images/*"  
|                   | • Macintosh: "~/Library/Application Support/<JMP installation directory>/Samples/Images/*"  
| SAMPLE_IMPORT_DATA| • Windows: "~/C:/<JMP installation directory>/Samples/Import Data/*"  
|                   | • Macintosh: "~/Library/Application Support/<JMP installation directory>/Samples/Import Data/*"  
| SAMPLE_SCRIPTS    | • Windows: "~/C:/<JMP installation directory>/Samples/Scripts/*"  
|                   | • Macintosh: "~/Library/Application Support/<JMP installation directory>/Samples/Scripts/*"  
| TEMP              | • Windows: "~/C:/Users/<username>/AppData/Roaming/Temp/*"  
|                   | • Macintosh: "~/private/var/folders/.../Temporary Items/*"  


Types of Data
Chapter 6
Path Variables

Path variable definitions are updated automatically based on the version of JMP you are using. For example, when you run a JMP 9 script in JMP 12, the JMP 12 path variable definitions are used.

To see the definition of any path variable, use the function `Get Path Variable`:

```
Get Path Variable( "HOME" );
"/C:/Users/<username>/AppData/Roaming/SAS/JMP/<version number>/"
```

Note that you don't include a dollar sign for `Set Path Variable()` or `Get Path Variable()`. But you must include the dollar sign when using the variable in a script.

### Trailing Slashes

Make sure to include a trailing slash after the path variable. In the following example, the root name "Big Class" is assigned to the `dtName` variable. The `Open()` expression evaluates `$SAMPLE_DATA` and the trailing slash and then appends the `dtName` value along with the file extension .jmp.

```plaintext
dtName = "Big Class";
dt = Open( "$SAMPLE_DATA/" || dtName || ".jmp" );
```

The path is interpreted as:

```
C:/Program Files/SAS/JMP/13/Samples/Data/Big Class.jmp
```

Without the slash that follows `$SAMPLE_DATA`, the path is interpreted as:

```
C:/Program Files/SAS/JMP/13/Samples/DataBig Class.jmp
```
Create and Customize Path Variables

You can create your own path variables or override some of the built-in variables with the Set Path Variable(). In the following example, the path variable is called root. The variable points to the c:/ directory.

```javascript
Set Path Variable( "root", "c:/" );
```

To get the value of the new variable, use Get Path Variable().

```javascript
Get Path Variable( "root" );
"c:/"
```

Use your path variable as you would other variables. The following expression opens the myimportdata.txt file in the c:/ directory.

```javascript
Open( "$root/myimportdata.txt" );
```

As with getting path variables, omit the dollar sign when setting path variables.

Relative Paths

If you plan to use relative paths in variables, you must set the default directory. Then any path not preceded by a drive letter is relative to the default directory. Here is an example:

```javascript
Set Default Directory( "c:/users/smith/data" );
```

To return the value of the default directory, use Get Default Directory().

```javascript
Get Default Directory(); // returns "c:/users/smith/data"
```

So the following expression resolves as C:/users/smith/data/cleansers.jmp:

```javascript
Open("cleansers.jmp");
```

File Path Separators

In JMP, the preferred file path format is the Portable Operating System Interface (POSIX), or UNIX, format with forward slashes (/) as separators. This means that you do not have to identify the current operating system in scripts run on both Windows and Macintosh. However, each host still accepts its native format for compatibility.

You can convert file path format from Windows to POSIX (and vice versa) using Convert File Path(). Converting from a POSIX to a Windows path might be useful when you need to output a path to a file or to another application. The syntax is:

```javascript
Convert File Path (path, <absolute|relative>, <POSIX|windows>, <base(path)>);
```

For example, the following script converts a POSIX path to a Windows path:

```javascript
Convert File Path( "c:/users/smith", windows);
"c:\users\smith"
```
You can substitute a path variable (such as $HOME) for the path inside quotes.

**Date-Time Functions and Formats**

A date-time value consists of any portion of a date or time. The value can be seconds (3388594698), a complete date (such as “Wednesday, May 18, 2011”), the date and time (“05/18/2011 8:18:18 PM”), the week number (3), and so on.

JMP lets you convert date-time values to common formats, perform arithmetic on the values, and manipulate the data in a number of ways.

**Tip:** For descriptions of all date-time functions and their arguments, see the JSL Functions chapter in the *JSL Syntax Reference*.

**Date-Time Values**

Date-time values are stored and calculated as the number of seconds since midnight, January 1, 1904. For example:

```plaintext
Today(); // returns 3388649872 on May 19, 2011 at 12:00:00 AM
```

As with `Today()`, the `Date DMY()` and `Date MDY()` functions also return month, day, and year arguments as seconds. For example, if it were 12:00:00 a.m. on May 19, 2011, all of the following statements would return the same value:

```plaintext
Date DMY( 19, 5, 2011 );
Date MDY( 5, 19, 2011 );
Today();
3388608000
```

The `As Date()` function takes the number of seconds and displays it as a date or duration.

- Values that represent one year or more are returned as dates:
  ```plaintext
  As Date( 3388608000 );
  19May2011
  ``

- Values that represent less than a year are returned as durations.
  ```plaintext
  As Date( 50000 );
  :0:13:53:20
  ``

You can use date-time values in two ways:

- a literal value, for example `19May2011:10:10`
- a string, for example "Thursday, May 19, 2011"

You can perform arithmetic with date-time literals, which use the number of seconds as the base number.
As Date( 19May2011 + 1 );
19May2011:00:00:01

Program with Date-Time Functions

Table 6.2 shows functions that convert seconds into date-time values and date-time values into seconds.

Table 6.2 Date-Time Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abbrev Date(date)</td>
<td>Returns a string representation for the date supplied. The format is based on your computer’s regional setting. So for the English (United States) locale, the date is formatted like &quot;02/29/2004&quot;. Even if you are running JMP in English with a different locale, the locale format is applied.</td>
</tr>
<tr>
<td>As Date(expression)</td>
<td>Formats a number or expression so that it shows as a date or duration in a text window. For example, values that represent one year or more are returned as dates.</td>
</tr>
<tr>
<td></td>
<td>x = As Date( 8Dec2000 + In Days( 2 ) );</td>
</tr>
<tr>
<td></td>
<td>shows as:</td>
</tr>
<tr>
<td></td>
<td>10Dec2000</td>
</tr>
<tr>
<td></td>
<td>Values that represent less than a year are returned as durations.</td>
</tr>
<tr>
<td></td>
<td>As Date( 50000 );</td>
</tr>
<tr>
<td></td>
<td>shows as:</td>
</tr>
<tr>
<td></td>
<td>:0:13:53:20</td>
</tr>
<tr>
<td>Date DMY(day, month, year)</td>
<td>Returns the specified date expressed as the number of seconds since midnight, 1 January 1904. For example, the second Leap Day of the third millennium is DateDMY(29,2,2004), which returns 3160857600.</td>
</tr>
<tr>
<td>Date MDY(month, day, year)</td>
<td>Returns the specified date expressed as the number of seconds since midnight, 1 January 1904. For example, the second Leap Day of the third millennium is DateMDY(2,29,2004), which returns 3160857600.</td>
</tr>
<tr>
<td>Day Of Week(date)</td>
<td>Returns an integer representation for the day of the week of the date supplied. Weeks are Sunday–Saturday.</td>
</tr>
</tbody>
</table>
### Table 6.2 Date-Time Functions (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day Of Year(date)</td>
<td>Returns an integer representation for the day of the year of the date supplied.</td>
</tr>
<tr>
<td>Day(date)</td>
<td>Returns an integer representation for the day of the month of the date supplied.</td>
</tr>
<tr>
<td>Format(date, &quot;format&quot;)</td>
<td>Returns the value in the format specified in the second argument. Most typically used for formatting datetime values from a number of seconds to a formatted date. Format choices are those shown in the Column Info dialog box. Also see Table 6.3 “How JMP Interprets Two-Digit Years” on page 133.</td>
</tr>
<tr>
<td>Hour(datetime)</td>
<td>Returns an integer representation for the hour part of the date-time value supplied.</td>
</tr>
<tr>
<td>In Days(n)</td>
<td>These functions return the number of seconds per n minutes, hours, days, weeks, or years. Divide by these functions to express an interval in seconds as an interval in other units.</td>
</tr>
<tr>
<td>In Hours(n)</td>
<td></td>
</tr>
<tr>
<td>In Minutes(n)</td>
<td></td>
</tr>
<tr>
<td>In Weeks(n)</td>
<td></td>
</tr>
<tr>
<td>In Years(n)</td>
<td></td>
</tr>
<tr>
<td>Long Date(date)</td>
<td>Returns a string representation for the specified date. The format is based on your computer’s regional setting. So for the English (United States) locale, the date is formatted like &quot;Sunday, February 29, 2004&quot;. Even if you are running JMP in English with a different locale, the locale format is applied.</td>
</tr>
<tr>
<td>MDYHMS(date)</td>
<td>Returns a string representation for the date supplied, formatted like &quot;2/29/2004 00:02:20 AM&quot;.</td>
</tr>
<tr>
<td>Minute(date-time)</td>
<td>Returns an integer representation for the minute part of the date-time value supplied.</td>
</tr>
<tr>
<td>Month(date)</td>
<td>Returns an integer representation for the month of the date supplied.</td>
</tr>
<tr>
<td>Num(date-time)</td>
<td>Returns an integer representation for the date-time value supplied.</td>
</tr>
<tr>
<td>InFormat(string, &quot;format&quot;)</td>
<td>Parses a string of a given format and returns datetime value expressed as if surrounded by As Date(), returning the date in ddMonyyy format.</td>
</tr>
</tbody>
</table>
Table 6.2 Date-Time Functions (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second(date-time)</td>
<td>Returns an integer representation for the second part of the date-time value supplied.</td>
</tr>
<tr>
<td>Short Date(date)</td>
<td>Returns a string representation for the date supplied, in the format mm/dd/yyyy, regardless of locale (for example, &quot;02/29/2004&quot;).</td>
</tr>
<tr>
<td>Time Of Day(date)</td>
<td>Returns an integer representation for the time of day of the date-time supplied.</td>
</tr>
<tr>
<td>Today()</td>
<td>Returns the current date and time expressed as the number of seconds since midnight, 1 January 1904. No arguments are accepted, but the parentheses are still needed.</td>
</tr>
<tr>
<td>Week Of Year(date, &lt;rule_n&gt;)</td>
<td>Returns the week of the year as a date-time value. Three rules determine when the first week of the year begins.</td>
</tr>
<tr>
<td></td>
<td>• With rule 1 (the default), weeks start on Sunday, with the first Sunday of the year being week 2. Week 1 is a partial week or empty.</td>
</tr>
<tr>
<td></td>
<td>• With rule 2, the first Sunday begins with week 1, with previous days being week 0.</td>
</tr>
<tr>
<td></td>
<td>• With rule 3, the ISO-8601 week number is returned. Weeks start on Monday. Week 1 is the first week of the year with four days in that year. It is possible for the first or last three days of the year to belong to the neighboring year's week number.</td>
</tr>
<tr>
<td>Year(date)</td>
<td>Returns an integer representation for the year of the specified date.</td>
</tr>
</tbody>
</table>

Examples of Common Date-Time Functions

You can use any function that returns seconds within a function that returns a date-time.

For example, if today is May 19, 2011 and the time is 11:37:52 AM, Today() returns the number of seconds, and the functions that follow show that number of seconds since the base time in different date-time formats:

```
Today()
3388649872
Short Date( Today() );
"05/19/2011"
```
Long Date( Today() );
   "Thursday, May 19, 2011"
Abbrev Date( Today() );
   "5/19/2011"
MDYHMS( Today() );
   "05/19/2011 11:37:52 AM"

The date argument in parentheses can be seconds (or any function that returns seconds), or any date-time literal value. For example, both of the following expressions return the same value:

Long Date( 3388649872 );
Long Date( 19May2011 );
"Thursday, May 19, 2011"

Note: Long Date() and Abbrev Date() values are formatted according to your computer's regional settings.

Extract Parts of Dates

You can extract parts of date values using the functions Month(), Day(), Year(), Day Of Week(), Day Of Year(), Week Of Year(), Time Of Day, Hour(), Minute(), and Second(), which all return integers. If today is May 24th, 2011, each of the following examples returns the 144th day of the year:

Day of Year( Today() );
Day of Year( 24May2011 );
Day of Year( Date MDY( 5, 24, 2011 ) );
   144

Example

A data table column named Date contains date-time values that are formatted as "m/d/y". You want to create a column that shows only the time. In the following script, the second column’s formula extracts the time of day from the Date value in the first column.

New Table( "Assembly Tests",
   Add Rows( 1 ),
   New Column( "Date",
      Numeric, Continuous,
      Format( "m/d/y" ),
      Set Values( [3389083557] )
   ),
   New Column( "Time",
      Numeric, Continuous,
      Formula( Format( Time Of Day( :Date ), "h:m:s") )
   )
);
Figure 6.1 shows the result. Note that the time of day does not appear in the Date column, because the Format function applies the “m/d/y” format.

**Figure 6.1 Example of Extracting the Time**

Rules for Determining the Week of the Year

Week of Year() returns the week of the year as a date-time value. Three rules determine when the first week of the year begins.

- With rule 1 (the default), weeks start on Sunday, with the first Sunday of the year being week 2. Week 1 is a partial week or empty.
  
  ```
  Week Of Year( Date DMY( 19, 6, 2013 ), 1 );
  25
  ```

- With rule 2, the first Sunday begins with week 1, with previous days being week 0.
  
  ```
  Week Of Year( Date DMY( 19, 6, 2013), 2 ) ;
  24
  ```

- With rule 3, the ISO-8601 week number is returned. Weeks start on Monday. Week 1 is the first week of the year with four days in that year. It is possible for the first or last three days of the year to belong to the neighboring year’s week number.
  
  ```
  Week Of Year( Date DMY( 19, 6, 2013 ), 3 );
  25
  ```

Arithmetic on Dates

You can perform the usual arithmetic operations with date-time data as with any other numeric data. One option is simple arithmetic, such as subtracting a number from a date-time value.

Another option is writing a formula to perform the arithmetic.

**Example**

The Date column in your data table shows when a customer uses his credit card to buy gas. You want to know how many days elapse between purchases. The following script creates a Days elapsed column. The formula in that column subtracts the Date value in the current row from that of the previous row.

```
New Table( "Gas Purchases",
  Add Rows( 3 ),
  New Column( "Date",
    Numeric,
    "Continuous",
```
Types of Data
Chapter 6
Date-Time Functions and Formats

```r
Format( "m/d/y" ),
Set Values( [3392323200 3393532800 3394828800] ),
New Column( "Days elapsed",
Formula(  
If( Row() == 1,
    ., // returns a missing value for the first row  
    (:Date[Row()] - :Date[Row() - 1]) / In Days()  
  )  
)  
);  
```

Figure 6.2 shows the result.

**Figure 6.2** Example of Calculating Date-Time Values

<table>
<thead>
<tr>
<th></th>
<th>Date</th>
<th>Days elapsed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>07/01/2011</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>07/15/2011</td>
<td>14</td>
</tr>
<tr>
<td>3</td>
<td>07/29/2011</td>
<td>15</td>
</tr>
</tbody>
</table>

**Time Intervals**

The `In Minutes`, `In Hours`, `In Days`, `In Weeks`, and `In Years` functions are used to express time intervals in units rather than seconds. Each of these functions returns the number of seconds associated with a particular period of time. For example, the following expression returns the number of weeks between now and July 4, 2012.

```
(Date DMY( 04, 07, 2012 ) - Today()) / In Weeks();
-208.225444775132
```

When the argument for the interval function is empty, JMP counts by 1. You can enter another number to change the count. For example, `In Years(10)` converts the interval to decades. The following expression returns the number of decades between now and December 31, 2037.

```
(Date DMY( 31, 12, 2037) - Today() ) / In Years( 10 );
2.18927583529799
```

**Two- and Four-Digit Years**

JMP applies its own algorithms for interpreting and displaying datetime strings rather than supporting operating system-specific datetime formats. However, JMP uses the date-time separators selected in the Region and Language control panel (Windows) or the Date & Time preferences (Macintosh) to interpret and display dates.

Two-digit years are interpreted according to the current system clock year and JMP rules. For example, when the year in a script is 11, and you run the script after 1990, the year shows as 2011.
To avoid ambiguity, enter four-digit years. The following expression returns 1911 (rather than 2011) as indicated:

```
Long Date( 25May1911 );
"Thursday, May 25, 1911"
```

Table 6.3 explains how JMP interprets two-digit years.

### Table 6.3 How JMP Interprets Two-Digit Years

<table>
<thead>
<tr>
<th>Two-Digit Year Value</th>
<th>When it is Evaluated</th>
<th>Result</th>
<th>Examples</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>00–10</td>
<td>before 1990 (on Windows)</td>
<td>19__</td>
<td>enter 5 in year 1979</td>
<td>1905</td>
</tr>
<tr>
<td></td>
<td>before or during 1990 (on Macintosh)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>during or after 1990 (on Windows)</td>
<td>20__</td>
<td>enter 5 in year 1991</td>
<td>2005</td>
</tr>
<tr>
<td></td>
<td>after 1990 (on Macintosh)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11–89 (on Windows)</td>
<td>any time</td>
<td>current century</td>
<td>enter 13 in year 1988</td>
<td>1913</td>
</tr>
<tr>
<td>11–90 (on Macintosh)</td>
<td></td>
<td></td>
<td>enter 13 in year 2024</td>
<td>2013</td>
</tr>
<tr>
<td>90–99 (on Windows)</td>
<td>before 2011</td>
<td>19__</td>
<td>enter 99 in year 1999</td>
<td>1999</td>
</tr>
<tr>
<td>91–99 (on Macintosh)</td>
<td>during or after 2011</td>
<td>20__</td>
<td>enter 99 in year 2015</td>
<td>2099</td>
</tr>
</tbody>
</table>

**Note:** JMP always displays four-digit years regardless of the regional settings. If you need to show two-digit years, use character string functions. See the “Types of Data” chapter on page 119.
Date-Time Values in Data Tables

Change Date-Time Input and Display Formats

In data tables, JMP can accept the input of date-time values in one format (the input format), store them internally as the number of seconds since the base date, and display them in a different date-time format. The Informat() and Format() functions give you this control.

- Informat() takes a string date-time value, defines the date format used in that string, and returns the date in ddMonyyyy format.
  
  \[
  \text{Informat( "19May2011 11:37:52 AM", "ddMonyyyy h:m:s" );} \\
  \hspace{1em} 19May2011:11:37:52
  \]

- Format() takes the number of seconds since the base date (or a date-time function that returns that number) and returns the date in the specified format.
  
  \[
  \text{Format( 3388649872, "ddMonyyyy h:m:s" );} \\
  \hspace{1em} "19May2011 11:37:52 AM" \\
  \text{Format( Today(), "ddMonyyyy h:m:s" );} \\
  \hspace{1em} "19May2011 11:37:52 AM"
  \]

Suppose that you are entering dates into a column using the d/m/y h:m format, but you want to see the dates in the m/d/y format. The Informat() function defines the input format, and the Format() function defines the display format. For example,

\[
\text{New Table( "Widget Assembly",} \\
\hspace{1em} \text{Add Rows( 1 ),} \\
\hspace{2em} \text{New Column( "Date",} \\
\hspace{3em} \text{Numeric,} \\
\hspace{4em} \text{"Continuous",} \\
\hspace{5em} \text{Format( "m/d/y" ),} \\
\hspace{6em} \text{Informat( "d/m/y h:m" ),} \\
\hspace{7em} \text{Set Values( [3126917100] )} \\
\hspace{2em} );}
\]

The Format() and Informat() values are shown in the data table’s column properties (Figure 6.3). Note that when you click in the cell to edit it, the date-time value appears in the input format. When you edit the value, or add a new value, the format specified in the data table column Format list is used to display the value.
Figure 6.3 Example of Date-Time Display and Input Values

Notes:

- In a script that converts a column from character to numeric, specify `Format()` and `Informat()` to prevent missing values. See “Convert Character Dates to Numeric Dates” on page 686 in the “Common Tasks” chapter for details.
- The date-separator character on your computer might differ from the forward slash (/) character shown in this book.
- You can enter time values in 24-hour format (military time) or with AM or PM designators.

Table 6.4 describes the formats used as arguments in date-time functions or as data table formats. You can also use the formats for the `format` argument to a `Format` message to a data column. See “Set or Get Formats” on page 332 in the “Data Tables” chapter.

For descriptions of specific date-time functions, see the JSL Functions chapter in the *JSL Syntax Reference*.

Table 6.4 Date-Time Formats

<table>
<thead>
<tr>
<th>Type</th>
<th>Format argument</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date only</td>
<td>&quot;m/d/y&quot;</td>
<td>&quot;01/02/1999&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;mmdyyyy&quot;</td>
<td>&quot;01021999&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;m/y&quot;</td>
<td>&quot;01/1999&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;d/m/y&quot;</td>
<td>&quot;02/01/1999&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;ddmmyyyy&quot;</td>
<td>&quot;02011999&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;ddMonyyyy&quot;</td>
<td>&quot;02Jan1999&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Monddyyyy&quot;</td>
<td>&quot;Jan021999&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;y/m/d&quot;</td>
<td>&quot;1999/01/02&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;yyyymddd&quot;</td>
<td>&quot;19990102&quot;</td>
</tr>
</tbody>
</table>
### Types of Data

#### Chapter 6

Date-Time Functions and Formats

Table 6.4 Date-Time Formats *(Continued)*

<table>
<thead>
<tr>
<th>Type</th>
<th>Format argument</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;yyyy-mm-dd&quot;</td>
<td>&quot;1999-01-02&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;yyyyQq&quot;</td>
<td>1999Q1</td>
<td></td>
</tr>
<tr>
<td>Date and time</td>
<td>&quot;m/d/y h:m&quot;</td>
<td>&quot;01/02/1999 13:01&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;01/02/1999 1:01 PM&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;m/d/y h:m:s&quot;</td>
<td>&quot;01/02/1999 13:01:55&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;01/02/1999 1:01:55 PM&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;d/m/y h:m&quot;</td>
<td>&quot;02/01/1999 13:01&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;02/01/1999 1:01 PM&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;d/m/y h:m:s&quot;</td>
<td>&quot;02/01/1999 13:01:55&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;02/01/1999 1:01:55 PM&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;y/m/d h:m&quot;</td>
<td>'1999/01/02 13:01'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'1999/01/02 1:01 PM'</td>
</tr>
<tr>
<td></td>
<td>&quot;y/m/d h:m:s&quot;</td>
<td>'1999/01/02 13:01:02'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'1999/01/02 1:01:02 PM'</td>
</tr>
<tr>
<td>&quot;ddMonyyyy h:m&quot;</td>
<td>&quot;02Jan1999 13:01&quot;</td>
<td>&quot;02Jan1999 1:01 PM&quot;</td>
</tr>
<tr>
<td>&quot;ddMonyyyy h:m:s&quot;</td>
<td>&quot;02Jan1999 13:01:02&quot;</td>
<td>&quot;02Jan1999 1:01:02 PM&quot;</td>
</tr>
<tr>
<td>&quot;ddMonyyyy:h:m&quot;</td>
<td>&quot;02Jan1999:13:01&quot;</td>
<td>&quot;02Jan1999:1:01 PM&quot;</td>
</tr>
<tr>
<td>&quot;ddMonyyyy:h:m:s&quot;</td>
<td>&quot;02Jan1999:13:01:02&quot;</td>
<td>&quot;02Jan1999:1:01:02 PM&quot;</td>
</tr>
<tr>
<td>&quot;Monddyyyy h:m&quot;</td>
<td>&quot;Jan021999 13:01&quot;</td>
<td>&quot;Jan021999 1:01 PM&quot;</td>
</tr>
<tr>
<td>&quot;Monddyyyy h:m:s&quot;</td>
<td>&quot;Jan021999 13:01:02&quot;</td>
<td>&quot;Jan021999 1:01:02 PM&quot;</td>
</tr>
<tr>
<td>Day number</td>
<td>&quot;::day:hr:m&quot;</td>
<td>&quot;34700:13:01&quot;</td>
</tr>
<tr>
<td>and time</td>
<td></td>
<td>&quot;33:001:01 PM&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;::day:hr:m:s&quot;</td>
<td>&quot;34700:13:01:02&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;33:001:01:02 PM&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;h:m:s&quot;</td>
<td>&quot;13:01:02&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;01:01:02 PM&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;h:m&quot;</td>
<td>&quot;13:01&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;01:02 PM&quot;</td>
</tr>
</tbody>
</table>
Table 6.4  Date-Time Formats (Continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Format argument</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;yyyy-mm-ddTh:mm&quot;</td>
<td>1999-01-02T13:01</td>
<td></td>
</tr>
<tr>
<td>&quot;yyyy-mm-ddTh:mm:ss&quot;</td>
<td>1999-01-02T13:01:02</td>
<td></td>
</tr>
<tr>
<td>Duration</td>
<td>&quot;:day:hr:m&quot;</td>
<td>“52:03:01” reads fifty-two days, three hours, and one minute</td>
</tr>
<tr>
<td></td>
<td>&quot;:day:hr:m:s&quot;</td>
<td>“52:03:01:30” reads fifty-two days, three hours, one minute, and thirty seconds</td>
</tr>
<tr>
<td></td>
<td>&quot;hr:m&quot;</td>
<td>“17:37” reads seventeen hours and thirty-seven minutes</td>
</tr>
<tr>
<td></td>
<td>&quot;hr:m:s&quot;</td>
<td>“17:37:04” reads seventeen hours, thirty-seven minutes, and 4 seconds</td>
</tr>
<tr>
<td></td>
<td>&quot;min:s&quot;</td>
<td>“37:04” reads thirty-seven minutes and 4 seconds</td>
</tr>
</tbody>
</table>

**Note:** The following formats display the date-time according to your computer’s regional settings. They are available only for the display of dates, not for date input in a data table. Examples are shown for the United States locale.

<table>
<thead>
<tr>
<th>Abbreviated date</th>
<th>&quot;Date Abbrev&quot;</th>
<th>(Display only) “01/02/1999”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long date</td>
<td>&quot;Date Long&quot;</td>
<td>(Display only) &quot;Saturday, January 02, 1999&quot;</td>
</tr>
<tr>
<td>Locale date</td>
<td>“Locale Date”</td>
<td>(Display only) “01/02/1999”</td>
</tr>
<tr>
<td>Locale date and time</td>
<td>&quot;Locale Date Time h:m&quot;</td>
<td>(Display only) “01/02/1999 13:01” or “01/02/1999 01:01 PM”</td>
</tr>
<tr>
<td></td>
<td>&quot;Locale Date Time h:m:s&quot;</td>
<td>(Display only) “01/02/1999 13:01:02” or “01/02/1999 01:01:02 PM”</td>
</tr>
</tbody>
</table>
Currency

JMP displays numbers as currency using the `Format()` function, which uses the following syntax:

```
Format(x,"Currency", "<currency code>", <decimal>);
```

Where:

- `x` is a column or a number
- "currency code" is an International Standards Organization (ISO) 4217 code
- `decimal` is the number of decimal places

To illustrate the `Format` function:

```
Format( 12345.6, "Currency", "GBP", 3 );
"£12,345.600"
```

If you do not specify the currency code, the currency symbol is based on the computer’s operating system locale. For example, running the following script in a Japanese operating system formats the number with the yen symbol.

```
Format( 12345.6, "Currency", 3 );
"¥12,345.600"
```

If the currency code is not supported by JMP, the currency code string appears before the number.

```
Format( 12345.6, "Currency", "BBD", 3 );
"BBD 12,345.600"
```

Table 6.5 lists the currencies supported in JMP.

<table>
<thead>
<tr>
<th>Code</th>
<th>Currency</th>
<th>Code</th>
<th>Currency</th>
<th>Code</th>
<th>Currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUD</td>
<td>Australian dollar</td>
<td>ILS</td>
<td>Israeli new shekel</td>
<td>RUB</td>
<td>Russian ruble</td>
</tr>
<tr>
<td>BRL</td>
<td>Brazilian real</td>
<td>INR</td>
<td>Indian rupee</td>
<td>SEK</td>
<td>Swedish krone</td>
</tr>
<tr>
<td>CAD</td>
<td>Canadian dollar</td>
<td>JPY</td>
<td>Japanese yen</td>
<td>SGD</td>
<td>Singapore dollar</td>
</tr>
<tr>
<td>CHF</td>
<td>Swiss franc</td>
<td>KRW</td>
<td>South Korean won</td>
<td>THB</td>
<td>Thai baht</td>
</tr>
<tr>
<td>CNY</td>
<td>Chinese yuan</td>
<td>MXN</td>
<td>Mexican peso</td>
<td>TRY</td>
<td>New Turkish lira</td>
</tr>
<tr>
<td>COP</td>
<td>Colombian peso</td>
<td>MYR</td>
<td>Malaysian ringgit</td>
<td>TWD</td>
<td>New Taiwan dollar</td>
</tr>
<tr>
<td>DKK</td>
<td>Danish krone</td>
<td>NOK</td>
<td>Norwegian krone</td>
<td>USD</td>
<td>US dollar</td>
</tr>
<tr>
<td>EUR</td>
<td>Euro</td>
<td>NZD</td>
<td>New Zealand dollar</td>
<td>ZAR</td>
<td>South African rand</td>
</tr>
</tbody>
</table>
Hexadecimal and BLOB Functions

JMP can also handle binary (large) objects, commonly called BLOBs. The functions below convert between hexadecimal values, numbers, characters, and BLOBs. Some of the functions are covered in more detail following Table 6.6.

See the JSL Functions chapter in the *JSL Syntax Reference* for details.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Hex(&quot;text&quot;)</code></td>
<td>Returns the hexadecimal codes for the characters in <code>text</code>, <code>number</code>, or <code>blob</code>.</td>
</tr>
<tr>
<td><code>Hex(&quot;num&quot;)</code></td>
<td>Char To Hex is an alias.</td>
</tr>
<tr>
<td><code>Hex(&quot;blob&quot;)</code></td>
<td></td>
</tr>
<tr>
<td><code>Hex To Blob(&quot;hexstring&quot;)</code></td>
<td>Returns a BLOB representation of the hexadecimal code supplied as a quoted string.</td>
</tr>
<tr>
<td><code>Hex To Char(&quot;hexstring&quot;, &quot;encoding&quot;)</code></td>
<td>Returns a character string that corresponds to the hexadecimal code supplied as a quoted string.</td>
</tr>
<tr>
<td>The default encoding for the character string is utf-8, utf-16le, utf-16be, us-ascii, iso-8859-1, ascii-hex, shift-jis, and euc-jp are also supported.</td>
<td></td>
</tr>
<tr>
<td><code>Hex to Number</code></td>
<td>Returns the number that corresponds to the hexadecimal code supplied as a quoted string.</td>
</tr>
<tr>
<td><code>Char To Blob(&quot;string&quot;)</code></td>
<td>Converts a character string into a binary (blob).</td>
</tr>
<tr>
<td>The default encoding for the blob is utf-8, utf-16le, utf-16be, us-ascii, iso-8859-1, ascii-hex, shift-jis, and euc-jp are also supported.</td>
<td></td>
</tr>
</tbody>
</table>
**Table 6.6 Hexadecimal and BLOB Functions (Continued)**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blob To Char(&quot;blob&quot;)</td>
<td>Converts binary data to a character string.</td>
</tr>
<tr>
<td>Blob To Char(&quot;blob&quot;, &quot;encoding&quot;)</td>
<td>The default encoding for the character string is utf-8. utf-16le, utf-16be, iso-859-1, ascii-hex, shift-jis, and euc-jp are also supported.</td>
</tr>
<tr>
<td>Blob Peek(&quot;blob&quot;, offset, length)</td>
<td>Returns a new BLOB that is a subset of the given BLOB that is length bytes long and begins at the offset. Note that the offset is 0-based.</td>
</tr>
</tbody>
</table>

Hex(string) returns the hexadecimal codes for each character in the argument. For example,

```plaintext
Hex( "Abc" );
```

returns

"416263"

since 41, 62, and 63 are the hexadecimal codes (in ASCII) for “A”, “b”, and “c”.

Hex_to_Char(string) converts hexadecimal to characters. The resulting character string might not be valid display characters. All the characters must be in pairs, in the ranges 0-9, A-Z, and a-z. Blanks and commas are allowed, and skipped. For example,

```plaintext
Hex To Char( "4142" );
```

returns

"AB"

since 41 and 42 are the hexadecimal equivalents of “A” and “B”.

Hex and Hex_to_Char are inverses of each other, so

```plaintext
Hex To Char( Hex( "Abc" ) );
```

returns

"Abc"

Hex_to_Blob(string) takes a string of hexadecimal codes and converts it to a binary object.

```plaintext
a = Hex To Blob( "6A6B6C" );
Show( a );
   a = Char To Blob("jkl", "ascii~hex")
```

Blob_Peek(blob,offset,length) extracts bytes as defined by the arguments from a blob.

```plaintext
b = Blob Peek( a, 1, 2 );
Show( b );
   b = Char To Blob("kl", "ascii~hex")
```
b = Blob Peek( a, 0, 2 );
Show( b );
b = Char To Blob("jk", "ascii~hex")
b = Blob Peek( a, 2 );
Show( b );
b = Char To Blob("l", "ascii~hex")

Hex(blob) converts a blob into hexadecimal.

c = Hex( a );
Show( c );
c = "6A6B6C"
d = Hex To Char( c );
Show( d );
d = "jkl"

Concat(blob1, blob2) or blob1 | blob2 concatenates two blobs.

e = Hex To Blob( "6D6E6F" );
Show( e );
f = a||e;
Show( f );
e = Char To Blob("mno", "ascii~hex")
f = Char To Blob("jklmno", "ascii~hex")

Length(blob) returns the number of bytes in a blob.

g = Length( f );
Show( g );
g = 6

Note: When blobs are listed in the log, they are shown with the constructor function Char To Blob("...").

Any hex code outside the ASCII range (space to }, or hex 20 - 7D) is encoded as the three-character sequence \[~\]hexdigit[hexdigit]. For example,

h = Hex To Blob( "19207D7E" );
Show( h );
i = Hex( h );
Show( i );
h = Char To Blob("~19 ~7E", "ascii~hex")
i = "19207D7E"

Char To Blob(string) creates a blob from a string, converting ~hex codes.
Blob To Char(blob) creates a string with ~hex codes to indicate non-visible and non-ASCII codes.
Work with Character Functions

This section shows how to use some of the more complex character functions that are described in the JSL Functions chapter in the JSL Syntax Reference.

Concat

In the Concat function, expressions yielding names are treated like character strings, but globals that have the name values are evaluated. The following example demonstrates that if you have a stored name value, you need to either use Char before storing it in a global, or NameExpr on the global name.

```plaintext
n = {abc};
c = n[1] || "def";
Show( c );
"abcdef"

m = Expr( mno );
c = m || "xyz";
Show( c );
  Name Unresolved: mno in access or evaluation of 'mno', mno/*###*/

m = Expr( mno );
c = NameExpr( m ) || "xyz";
Show( c );
"mnoxyz"

m = Char( Expr( mno ) );
c = m || "xyz";
Show( c );
"mnoxyz"
```

Concat Items() converts a list of string expressions into a single string, with each item separated by a delimiter. If unspecified, the delimiter is a blank. Its syntax is

```
resultString = Concat Items( {list of strings}, <"delimiter string"> );
```

For example,

```plaintext
a = {"ABC", "DEF", "HIJ"};
result = Concat Items(a, "/" );
returns
"ABC/DEF/HIJ"
```

Alternatively,

```plaintext
result = Concat Items( a );
```
returns

"ABC DEF HIJ"

**Munger**

Munger works many different ways, depending on what you specify for its arguments:

\[
\text{Munger(} \text{string, } \text{offset, } \text{find | length, } <\text{replace}>);\]

<table>
<thead>
<tr>
<th>Find, length, and replace arguments</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you specify a string as the find and specify no replace string, Munger returns the position (after offset) of the first occurrence find string.</td>
<td>Munger( &quot;the quick brown fox&quot;, 1, &quot;quick&quot; ); 5</td>
</tr>
<tr>
<td>If you specify a positive integer as the length and specify no replace string, Munger returns the characters from offset to offset + length.</td>
<td>Munger( &quot;the quick brown fox&quot;, 1, 5 ); &quot;the q&quot;</td>
</tr>
<tr>
<td>If you specify a string as the find and specify a replace string, Munger replaces the first occurrence after offset of text with replace.</td>
<td>Munger( &quot;the quick brown fox&quot;, 1, &quot;quick&quot;, &quot;fast&quot; ); &quot;the fast brown fox&quot;</td>
</tr>
<tr>
<td>If you specify a positive integer as the length and specify a replace string, Munger replaces the characters from offset to offset + length with replace.</td>
<td>Munger( &quot;the quick brown fox&quot;, 1, 5, &quot;fast&quot; ); &quot;fastuick brown fox&quot;</td>
</tr>
<tr>
<td>If you specify a positive integer as the length, and offset + length exceeds the length of text, Munger either returns text from offset to the end or replaces that portion of text with the replace string, if it exists.</td>
<td>Munger( &quot;the quick brown fox&quot;, 5, 25); &quot;quick brown fox&quot; Munger( &quot;the quick brown fox&quot;, 5, 25, &quot;fast&quot; ); &quot;the fast&quot;</td>
</tr>
<tr>
<td>If you specify zero as the length and specify no replace string, Munger returns a blank string.</td>
<td>Munger( &quot;the quick brown fox&quot;, 1, 0 ); &quot;&quot;</td>
</tr>
</tbody>
</table>
Repeat

The Repeat() function makes copies of its first argument into a result. The second (and sometimes a third) argument is the number of repeats, where 1 means a single copy.

If the first argument evaluates to a character value or list, the result is that many copies.

\[
\text{Repeat}( \text{"abc"}, 2 ); \\
\text{"abcabc"}
\]

\[
\text{Repeat}( \{\text{"A"}\}, 2 ); \\
\{\text{"A"}, \text{"A"}\}
\]

\[
\text{Repeat}( \{1, 2, 3\}, 2 ); \\
\{1, 2, 3, 1, 2, 3\}
\]

If the first argument evaluates to a number or matrix, the result is a matrix. The second argument is the number of row repeats, and a third argument can specify the number of column repeats. If only two arguments are specified, the number of column repeats is 1.

\[
\text{Repeat}( [1 2, 3 4], 2, 3 ); \\
[1 2 1 2 1 2, \\
3 4 3 4 3 4, \\
1 2 1 2 1 2, \\
3 4 3 4 3 4]
\]

\[
\text{Repeat}( 9, 2, 3 ); \\
[9 9 9, \\
9 9 9]
\]

The Repeat function is compatible with the function of the same name in the SAS/IML language, but is incompatible with the SAS character DATA step function, which repeats one more time than this function.
Regular Expressions

A regular expression is a specification of a pattern frequently used to clean up or extract pieces of data. You can search for a pattern and replace it with a different string or extract specific parts of the string. Define the pattern in the Regex() or Regex Match() function.

Regex

Regex() searches for a pattern within a source string and returns a string. It simply identifies a pattern in a string or transforms a string into another string.

```
Regex(source, pattern, (<replacementString>, <GLOBALREPLACE>), <format>, <IGNORECASE>);
```

IGNORECASE disregards case. GLOBALREPLACE repeats the match until the entire string is processed. format is a backreference to the matched group. Regex() returns missing if the match fails.

Example of Matching a String

```
bus|car
```

is the regular expression (in quotation marks because it is a string). The expression means match “bus” or “car”.

```
sentence = "I took the bus to work.";
vehicle = Regex( sentence, "bus|car" );
"bus"
```

Examples of Replacing a String

The third optional argument in Regex() is a specification of the result string. The default value, \0, is a backreference to everything that was matched by the regular expression. In the preceding example, the word “bus” is matched in sentence. The default third argument, \0, replaces the entire sentence with “bus”.

A more interesting variation uses parentheses to create additional backreferences.

```
sentence = "I took the bus to work.";
Regex( sentence, ".*(.) bus (.*)", "\1 car \2" );
"I took the car to work."
```

The (.* before and after bus are part of the regular expression. The parentheses create a capturing group. The . matches any character. The * matches zero or more of the previous expression. As a result, the first parenthesis pair matches everything before bus, and the second parenthesis pair matches everything after bus. The third argument, \1 car \2, reassembles the text; it leaves out bus and substitutes car.

See “Backreferences and Capturing Groups” on page 154 for more information.
Example of Global Replacement

GLOBALREPLACE changes the behavior of Regex(). If the match succeeds, the entire source string is returned with substitutions made for each place where the pattern matches. If there are no matches, an unchanged source string is returned.

```python
sentence = "I took the red bus followed by the blue bus to get to work today.";
Regex( sentence, "bus", "car", GLOBALREPLACE);
"I took the red car followed by the blue car to get to work today."
```

You can also use backreferences. This example starts with a different sentence.

```python
sentence = "I took the red bus followed by the blue car to get to work today.";
Regex( sentence, "(\w*) (bus|car)", "bicycle (not \2) that was \1", GLOBALREPLACE);
"I took the bicycle (not bus) that was red followed by the bicycle (not car) that was blue to get to work today."
```

The \w* matches zero or more word characters and becomes backreference 1 because of the parentheses. bus|car becomes backreference 2 because of the parentheses. The third argument, bicycle (not \2) that was \1, describes how to build the substitution text for the part of the source text that was matched.

Notice how the backreferences can be used to swap data positions. This might be useful for swapping the position of first names and last names.

Regex Match

Regex Match() returns an empty list with zero elements if the match fails. If the match succeeds, the first list is the text of the entire match (backreference 0). The second list is the text that matches backreference 1, and so on.

```python
Regex Match(source, pattern, <NULL>, <MATCHCASE>);
```

Unlike Regex(), Regex Match() is case insensitive. Include MATCHCASE for a case-sensitive match. Include NULL if you want to match case but there is no replacement text.

Example of Parsing Name-Value Pairs

The following example parses pairs of names and values.

```python
Regex Match("person=Fred id=77 friend= favorite=tea",
\"(\w+)=(\S*) (\w+)=(\S*) (\w+)=(\S*) (\w+)=(\S*)")"
The \w+ matches one or more word characters. The \S* matches zero or more characters that are not spaces. In the resulting JSL list, the field names (person, id, friend, favorite) and their corresponding values (Fred, 77, '', tea) are separate strings.

If the first argument to Regex Match() is a variable and a third argument specifies the replacement value, the matched text is replaced in the variable.

Comparing Regex and Regex Match

Regex() and Regex Match() match a pattern in a given string but return different results. To transforms your string into another string, use Regex(). To identify the substrings that match specific parts of the pattern, use Regex Match().

This example shows the efficiency of Regex Match() compared to Regex(). The source is a list of six strings. The goal is to extract portions of those six strings into the subject, verb, and object columns of a data table (Figure 6.4).

Figure 6.4 Final Data Table

<table>
<thead>
<tr>
<th></th>
<th>subject</th>
<th>verb</th>
<th>object</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>cat</td>
<td>ate</td>
<td>chicken</td>
</tr>
<tr>
<td>2</td>
<td>dog</td>
<td>chased</td>
<td>cat</td>
</tr>
<tr>
<td>3</td>
<td>ralph</td>
<td>like</td>
<td>mary</td>
</tr>
<tr>
<td>4</td>
<td>girl</td>
<td>pets</td>
<td>dog</td>
</tr>
<tr>
<td>5</td>
<td>cat</td>
<td>chased</td>
<td>dog</td>
</tr>
</tbody>
</table>

source = {"the cat ate the chicken", "the dog chased the cat", "did ralph like mary", "the girl pets the dog", "these words are strange", "the cat was chased by the dog"};

dt = New Table( "English 101", // create the data table
    New Column( "subject", character ),
    New Column( "verb", character ),
    New Column( "object", character )
);

For( i = 1, i <= N Items( source ), i++,
    // iterate through the strings in the list
    matchList = Regex Match( source[i],
        // assign the result of each match to matchList
// scan each string, match zero or more characters
// and one item in each group

If( N Items( matchList ) > 0,
    dt << Add Rows( 1 );
    dt:subject = matchList[2]; // match the first open parenthesis
    dt:verb = matchList[3]; // match the second open parenthesis
    dt:object = matchList[4]; // match the third open parenthesis
);

// If matchList has zero items (string 5), don't add a row
// to the table. Put each matched string in separate
// data table cells.

Regex Match() returns \"the cat was chased by the dog\", \"cat\", \"chased\", \"dog\\" in a single try with each answer in a separate string. Compare this example to a similar one using Regex(), which returns one answer at a time and builds the final string using backreferences.

For( i = 1, i <= N Items( source ), i++,
    s = Regex( source[i],
        ".*?(cat|dog|ralph|girl).*?(ate|chased|like|pets).*?(chicken|cat|mary|dog)
    \", \"\1\" ); // match an item in the first group
    v = Regex( source[i],
        ".*?(cat|dog|ralph|girl).*?(ate|chased|like|pets).*?(chicken|cat|mary|dog)
    \", \"\2\" ); // match an item in the second group
    o = Regex( source[i],
        ".*?(cat|dog|ralph|girl).*?(ate|chased|like|pets).*?(chicken|cat|mary|dog)
    \", \"\3\" ); // match an item in the third group
    If( !Is Missing( s ) & !Is Missing( v ) & !Is Missing( o ),
        dt << Add Rows( 1 );
        dt:subject = s; // return the match for \1
        dt:verb = v; // return the match for \2
        dt:object = o; // return the match for \3
    );
);

Backreferences are discussed in “Backreferences and Capturing Groups” on page 154.

**Special Characters in Regular Expressions**

Special characters are commonly used in regular expressions. The period is a special character that matches one instance of the specified character. It must be escaped with a backslash to be
interpreted as a period. In the following expression, the period is replaced with an exclamation point.

```javascript
Regex( "Bicycling makes traveling to work fun.", ",.\", ",!\", GLOBALREPLACE );
"Bicycling makes traveling to work fun!"
```

Table 6.8 describes the special characters and provides examples.

**Table 6.8 Special Characters in Regular Expressions**

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\</code></td>
<td>Precedes a literal character. <code>&lt;\a&gt;</code> interprets the forward slash literally in the end HTML anchor tag. Precedes an escape sequence. <code>\n</code> matches a newline character.</td>
</tr>
<tr>
<td><code>^</code></td>
<td>Matches the beginning of a string, not including the newline character. <code>^apple</code> matches “apple” at the beginning of a string.</td>
</tr>
<tr>
<td><code>$</code></td>
<td>Matches the end of a string, not including the newline character. <code>apple$</code> matches “apple” at the end of a string.</td>
</tr>
<tr>
<td><code>.</code></td>
<td>Matches any single character including a newline character. <code>app\e</code> matches any single character and then “apple”.</td>
</tr>
<tr>
<td>`</td>
<td>`</td>
</tr>
<tr>
<td><code>?</code></td>
<td>Matches zero or one instance. <code>apple (pie)?</code> matches one or more instances of “pie”.</td>
</tr>
<tr>
<td><code>*</code></td>
<td>Matches zero or more instances.</td>
</tr>
<tr>
<td><code>+</code></td>
<td>Matches one or more instances.</td>
</tr>
<tr>
<td><code>()</code></td>
<td>Encloses a sub-expression. `(apple</td>
</tr>
<tr>
<td><code>[ ]</code></td>
<td>Encloses an expression that matches set of characters. <code>\[\s\]</code> matches a whitespace character or a digit. <code>\[a-z0-9\]</code> matches “a” through “z” and numbers “0” through “9”.</td>
</tr>
</tbody>
</table>
Table 6.8 Special Characters in Regular Expressions  (Continued)

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{ }</td>
<td>Encloses an expression that represents repetition.</td>
</tr>
<tr>
<td>apple{3}</td>
<td>repeats three times.</td>
</tr>
<tr>
<td>apple{3,}</td>
<td>repeats at least three times as many times as possible.</td>
</tr>
<tr>
<td>apple{3, 10}</td>
<td>repeats three times but no more than 10 times.</td>
</tr>
<tr>
<td>?</td>
<td>Append a question mark to indicate repeating as few times as possible. For example, apple{3,}? repeats at least three times as few times as possible.</td>
</tr>
</tbody>
</table>

Escaped Characters in Regular Expressions

The backslash in a regular expression precedes a literal character. You also escape certain letters that represent common character classes, such as \w for a word character or \s for a space. The following example matches word characters (alphanumeric and underscores) and spaces.

```
Regex("Are you there, Alice?, asked Jerry.", \(here|there\)+\(\w+\).+(said|asked)\(s\)(\w+).\); // regular expression
"there, Alice?, asked Jerry."
```

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(here</td>
<td>there).+</td>
</tr>
<tr>
<td>(\w+)</td>
<td>Matches “Alice”.</td>
</tr>
<tr>
<td>.+</td>
<td>Matches “?, “.</td>
</tr>
<tr>
<td>(said</td>
<td>asked)(\s)</td>
</tr>
<tr>
<td>(\w+).</td>
<td>Matches “Jerry” and a period.</td>
</tr>
</tbody>
</table>

Table 6.9 describes the escaped characters supported in JMP. \C, \G, \X, and \z are not supported.

Table 6.9 Escaped Characters

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>single backslash</td>
</tr>
<tr>
<td>\A</td>
<td>start of a string</td>
</tr>
<tr>
<td>\b</td>
<td>word boundary. The zero-length string between \w and \W or \W and \w.</td>
</tr>
</tbody>
</table>
Greedy and Reluctant Regular Expressions

The ?, *, and + operators are greedy by default. They match as many of the preceding character as possible. The ? operator makes them reluctant; ?? matches 0, then 1 if needed; +? matches 1 and then additional characters; *? matches 0 and then additional characters.

The following example starts at the letter n and compares it to the first \d (digits) in the pattern. No digit matches. Because the pattern does not begin with ^ (start of line), the matcher advances to u. The process repeats until the 3 matches the first \d and the 2 matches the second \d.

```javascript
Regex( "number=32.5", "\d\d" );
"32"
```
Change the pattern to use the greedy + (match one or more).

```javascript
Regex( "number=324.5", "\d+" );
"324"
```

The preceding example begins much the same, but as soon as the 3 is found and the \d matches, the + greedily matches the 2 and the 4.

Usually, the greedy behavior makes pattern matching faster because the string is consumed sooner. Sometimes a reluctant behavior is better. Adding the ? after the * or + changes them from greedy to reluctant.

```javascript
Regex( "number=324.5", "\d+?" );
"3"
```

Here, + requires at least one match of a digit character, but ? changes it from “as many as possible” to “as few as possible”. It stopped after the 3 because the pattern was satisfied.

Compare the following results.

Greedy:

```javascript
Regex( "number=324.5", "(\d+)(\d+).", "first=\1 second=\2" );
"first=32 second=4"
```

Reluctant:

```javascript
Regex( "number=324.5", "(\d+?)(\d+?)\.", "first=\1 second=\2" );
"first=3 second=24"
```

In the greedy example above, the matcher greedily matched 3, 2, and 4 for the first \d+. The matcher then had to give back the 4 so that the second \d+ could match something. The reluctant example followed a different path to get a different answer. Initially, the second value was 2, but the pattern could not match the period to the 4, so the second \d+? reluctantly matched the 4 as well.

**Use the Reluctant Match for Speed**

The greedy and reluctant matches usually produce the same result but not always. See the previous section. One reason you might need the reluctant match is for speed. Suppose that you have a million-character string that begins “The quick fox…” and you want to find the word before “fox”. You might write the following expression and expect \1 to contain “quick”.

The (.+) fox

\1 might contain “quick” eventually, after the .+ grabs the million characters to the end of the string and then gives them up, one at a time, until “fox” is found. If there is more than one “fox”, it will be the last fox, not this one. To speed it up and make sure we get the first fox, add the ? operator.

The (.+?) fox
The `?` advances one character at a time to get past “quick” and find the first “fox”. This method is much faster than going too far.

Typically, the `+` or `*` operator is applied to a more restrictive expression such as `\d*` to match a run of digits, and greedy is faster than reluctant.

Aside from the multiple fox possibility, greedy and reluctant eventually get the same answer. Using the right operator speeds up the match. The right one might be greedy, or it might be reluctant. It depends on what is being matched.

The greedy `.*` finds the last fox after backing up.

```java
Regex(
    "The quick fox saw another fox eating grapes",
    "The (.*) fox",
    "\1"
); // "quick fox saw another"
```

The reluctant `.*?` stops on the first fox.

```java
Regex(
    "The quick fox saw another fox eating grapes",
    "The (.*?) fox",
    "\1"
); // "quick"
```

The greedy `.*` has to back up a lot. There is no second fox.

```java
Regex(
    "The quick fox saw another animal eating grapes",
    "The (.*) fox",
    "\1"
); // "quick"
```

The greedy word character match is an even better choice for this problem.

```java
Regex(
    "The quick fox saw another fox eating grapes",
    "The (\w*) fox",
    "\1"
); // "quick"
```
Backreferences and Capturing Groups

A regular expression can consist of patterns grouped in parentheses, also known as capturing groups. In \([a-zA-Z]\)\s\([0-9]\), \([a-zA-Z]\) is the first capturing group; \([0-9]\) is the second capturing group.

Use a backreference to replace the pattern matched by a capturing group. In Perl, these groups are represented by the special variables $1, $2, $3, and so on. ($1 indicates text matched by the first parenthetical group.) In JMP, use a backslash followed by the group number (\1, \2, \3).

The following example includes a third argument that specifies the replacement text and backreferences.

```
Regex(  "Are you there, Alice?, asked Jerry.", // source
    "(here|there).+ (\w+).+(said|asked) (\w+)\.", // regular expression
    "I am \1, \4, replied \2." ); // optional format argument
    "I am there, Jerry, replied Alice."
```

```
"I am \1,  Creates the text “I am”, a space, and then the first matched pattern, “there”.
\4,  Creates the text “Jerry” with the fourth matched pattern (\w+).
replied \2."  Creates the text “replied” and a space. Matches “Alice.” with the second matched pattern (\w+).
```

Lookaround Assertions

Lookaround assertions check for a pattern but do not return that pattern in the results. Lookaheads look forward for a pattern. Lookbehinds look back for a pattern.

Negative Lookahead Example

Negative lookaheads check for the absence of a pattern before a specific pattern. ?! indicates a negative lookahead. The following expression matches a comma not followed by a number or space and replaces the pattern with a comma and space:

```
Regex( "one,two 1,234 cat,dog,duck fish, and chips, to go",
    ",,(?!\d|\s)"", ",", GLOBALREPLACE );
    "one, two 1,234 cat, dog, duck fish, and chips, to go"
```
Positive Lookahead Example

Positive lookaheads check for the presence of a pattern before a specific pattern. `?=` indicates a positive lookahead. The following expression has the same result as the preceding negative lookahead but matches a comma followed by any lowercase character:

```julia
Regex( "one,two 1,234 cat, dog, duck fish, and chips, to go", ",(?=.*[a-z])", ",", GLOBALREPLACE );
"one, two 1,234 cat, dog, duck fish, and chips, to go"
```

Positive Lookbehind Example

In this example, the positive lookbehind regular expression matches the “ssn=” or “salary=” keywords without including the keyword in the matched text. The matched text is the string of characters that consists of zero or more dollar signs, digits, and hyphens.

```julia
data = "name=bill salary=$5 ssn=123-45-6789 age=13,name=mary salary=$6 ssn=987-65-4321 age=14";
redacted = Regex(data, "(?<=(ssn=)|(salary=))[$\d-]*", "###", GLOBALREPLACE);
"name=bill salary=### ssn=### age=13,name=mary salary=### ssn=### age=14"
```

Here is another way to get the same result using a backreference substitution. `((ssn=)|(salary=))` is the capturing group. `\1` is the backreference to that group.

```julia
data = "name=bill salary=$5 ssn=123-45-6789 age=13,name=mary salary=$6 ssn=987-65-4321 age=14";
redacted = Regex(data, "((ssn=)|(salary=))[\$\d-]*", "\1###", GLOBALREPLACE);
"name=bill salary=### ssn=### age=13,name=mary salary=### ssn=### age=14"
```

Backreferences are discussed in “Backreferences and Capturing Groups” on page 154.

---

Pattern Matching

Pattern matching in JSL is a flexible method for searching and manipulating strings.

You define and use pattern variables just like any JMP variable:

```julia
i = 3; // a numeric variable
a = "Ralph"; // a character variable
t = textbox("Madge"); // a display box variable
p = ( "this" | "that" ) + patSpan(" ")
   + ( "car" | "bus" ); // a pattern variable
```

When the above statement executes, `p` is assigned a pattern value. The pattern value can be used either to construct another pattern or to perform a pattern match. The `patSpan` function returns a pattern that matches a span of characters specified in the argument; `patSpan("0123456789")` matches runs of digits.

```julia
p2 = "Take " + p + "."; // using p to build another pattern
If( Pat Match( "Take this bus.", p2 ), // performing a match
Sometime all you need to know is that the pattern matched the source text, as above. Other times, you might want to know what matched; for example, was it a bus or a car?

```javascript
p = ("this" | "that") + Pat Span(" ") + ("car" | "bus") >?
vehicleType; // conditional assignment ONLY if pattern matches
If( Pat Match( "Take this bus.", p ),
    Show( vehicleType ),
    Print( "no match" )
); // do not use vehicleType in the ELSE because it is not set
```

You could pre-load `vehicleType` with a default value if you do not want to check the outcome of the match with an `if`. The `?>` conditional assignment operator has two arguments, the first being a pattern and the second a JSL variable. `?>` constructs a pattern that matches the pattern (first argument) and stores the result of the match in the JSL variable (second argument) after the pattern succeeds. Similarly, `>>` does not wait for the pattern to succeed. As soon (and as often) as the `>>` pattern matches, the assignment is performed.

```javascript
findDelimString = Pat Len( 3 ) >> beginDelim + Pat Arb() >? middlePart +Expr( beginDelim );
testString = "SomeoneSawTheQuickBrownFoxJumpOverTheLazyDog'sBack";
rc = Pat Match( testString, findDelimString, "<<<" || middlePart || ">>>" );
Show( rc, beginDelim, middlePart, testString );
```

The above example shows a third argument in the `patMatch` function: the replacement string. In this case, the replacement is formed from a concatenation (|| operator) of three strings. One of the three strings, `middlePart`, was extracted from the `testString` by `?>` because the replacement cannot occur unless the pattern match succeeds (`rc == 1`).

Look at the pattern assigned to `findDelimString`. It is a concatenation of 3 patterns. The first is a `>>` operator that matches 3 characters and assigns them to `beginDelim`. The second is a `?>` operator that matches an arbitrary number of characters and, when the entire match succeeds, assigns them to `middlePart`. The last is an unevaluated expression, consisting of whatever string is in `beginDelim` at the time the pattern is executing, not at the time the pattern is built. Just like `expr()`, the evaluation of its argument is postponed. That makes the pattern hunt for two identical three letter delimiters of the middle part.

Other pattern functions might be faster and represent the problem that you are trying to solve better than writing a lot of alternatives; for example, "a" | "b" | "c" is the same as `patAny("abc")`. The equivalent example for `patNotAny("abc")` is much harder. Similar to `patSpan` (above), `patBreak("0123456789")` matches up to, but not including, the first number.

Here is a pattern that matches numbers with decimals and exponents and signs. It also matches some degenerate cases with no digits; look at the pattern assigned to `digits`.

```javascript
digits = Pat Span( "0123456789" ) | "";
```
number = (Pat Any( "+-" ) | "") >? signPart + (digits) >? wholePart + ("." +digits | ")") >? fractionPart + (Pat Any( "eEdD" ) + (Pat Any( "+-" ) | ")") + digits | ")") >? exponentPart;

If( Pat Match( "-123.456e-78", number ),
    Show( signPart, wholePart, fractionPart, exponentPart )
);

Parsing Strings in Fixed Fields

Sometimes data is in fixed fields. The patTab, patRTab, patLen, patPos, and patRPos functions make it easy to split out the fields in a fixed field string. PatTab and patRTab work from the left and right end of the string and take a number as their argument. They succeed by matching forward to the specified tab position. For example:

\[ p = \text{patPos}(10) + \text{patTab}(15); \]

PatPos(10) matches the null string if it is in position 10. So at match time, the matcher works its way forward to position 10, then patTab(15) matches text from the current position (10) forward to position 15. This pattern is equivalent to patPos(10)+patLen(5). Another example:

\[ p = \text{patPos}(0) + \text{patRTab}(0); \]

This example matches the entire string, from 0 characters from the start to 0 characters from the end. The patRem() function takes no argument and is shorthand for patRTab(0); it means the remainder of the string. Pattern matching can also be anchored to the beginning of the string like this:

\[ \text{patMatch}( \text{"now is the time"}, \text{patLen}(15) + \text{patRPos}(0), \text{NULL}, \text{ANCHOR} ); \]

The above pattern uses NULL rather than a replacement value, and ANCHOR as an option. Both are uppercase, as shown. NULL means that no replacement is done. ANCHOR means that the match is anchored to the beginning of the string. The default value is UNANCHORED.

Patterns can be built up like this, but this is not recursive:

\[ p = \"a" \mid \"b\"; \quad \text{// matches one character} \]
\[ p = p + p; \quad \text{// two characters} \]
\[ p = p + p; \quad \text{// four characters} \]
\[ \text{Pat Match}( \text{"babb"}, \text{patPos}(0) + p + \text{patRPos}(0) ); \]

A recursive pattern refers to its current definition using expr():

\[ p = \"<" + \text{expr}(p) + \"*" + \text{expr}(p) + \">" \mid \"x\"; \]
\[ \text{Pat Match}( \"<<x<x*x>*>x>"\), \text{patPos}(0) + p + \text{patRPos}(0) ); \]

Remember, expr() is the procrastination operator; when the pattern is assigned to the variable p, expr() delays evaluating its argument (p) until later. In the next statement, patMatch performs the pattern match operation, and each time it encounters expr(), it looks for the
current value of the argument. In this example, the value does not change during the match). So, if \( p \) is defined in terms of itself, how can this possibly work?

\( p \) consists of two alternatives. The right hand choice is easy: a single letter \( x \). The left side is harder: \( <p^*p> \). Each \( p \) could be a single letter \( x \), since that is one of the choices \( p \) could match, or it could be \( <p^*p> \). The last few example have used \( \text{patPos}(0) + \ldots + \text{patRPos}(0) \) to make sure the pattern matches the entire source text. Sometimes this is what you want, and sometimes you would rather the pattern match a subtext. If you are experimenting with these examples by changing the source text, you probably want to match the entire string to easily tell what was matched. The result from \text{Pat Match} is 0 or 1.

This example uses “Left” recursion:

\[
x = \text{Expr}(x) + "a" | "b"; // + binds tighter than |
\]

If the pattern is used in \text{FULLSCAN} mode, it eventually uses up all memory as it expands. By default, the \text{patMatch} function does not use \text{FULLSCAN}, and makes some assumptions that allow the recursion to stop and the match to succeed. The pattern matches either a “b”, or anything the pattern matches followed by an “a”.

\[
rc = \text{Pat Match}( "baaaaa", x );
\]

**Patterns and Case**

Unlike regular expressions, pattern matching is case insensitive. To force case sensitivity, you can add the named argument \text{MATCHCASE} to either \text{Pat Match()} or \text{Regex Match()}. For example:

\[
\text{string} = "abcABC";
\]

\[
\text{result} = \text{Regex Match}( \text{string, Pat Regex("[aBc]+") });
\]

\[
\text{Show}( \text{string, result } );
\]

\[
/* \text{returns string} = "abcABC" \text{result} = \{"abcABC"}\*/
\]

\[
\text{result} = \text{Regex Match}( \text{string, Pat Regex("[cba]+")}, \text{NULL, MATCHCASE } );
\]

\[
\text{Show}( \text{string, result } );
\]

\[
/* \text{returns string} = "abcABC" \text{result} = \{"abc"}\*/
\]
JSL provides these basic data structures that can hold a variety of data in a single variable:

- A list holds a number of other values, including nested lists and expressions.
- A matrix is a row-by-column table of numbers.
- An associative array maps keys to values, which can be almost any other type of data.
Lists

Lists are containers to store items, such as the following:

- numbers
- variables
- character strings
- expressions (for example, assignments or function calls)
- matrices
- nested lists

Create a list in one of the following ways:

- use the `List` function
- use `{ }` curly braces

### Examples

Use the `List()` function or curly braces to create a list that includes numbers and variables:

```plaintext
x = List(1, 2, b);
x = {1, 2, b};
```

A list can contain text strings, nested lists, and function calls:

```
{"Red", "Green", "Blue", {1, "true"}, sqrt( 2 )};
```

You can place a variable into a list and assign it a value at the same time:

```plaintext
x = {a = 1, b = 2};
```

### Evaluate Lists

When you run a script that contains a list, a copy of the list is returned. The items inside the list are not evaluated.

```plaintext
b = 7;
x = {1, 2, b, Sqrt( 3 )};
Show( x );
x = {1, 2, b, Sqrt(3)};
```

To evaluate items in a list, use the `Eval List()` function.

```plaintext
b = 7;
x = {1, 2, b, Sqrt( 3 )};
c = Eval List( x );
{1, 2, 7, 1.73205080756888}
```

When using a list of variables that reference lists, you will need to use an `Eval()` function.
Consider the following example, where you have a variable called `fullMonth` that is a list of 12 items.

```
::fullMonth = {January, February, March, April, May, June, July, August,
              September, October, November, December};
::abbrevMonth = {Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec};
::dow = {Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday};
::levels = {Very Low, Low, Medium Low, Medium, Medium High, High, Very High};
::feel = {Strongly Disagree, Disagree, Neutral, Indifferent, Agree, Strongly
          Agree};
::rating = {Failing, Unacceptable, Very Poor, Poor, Bad, Acceptable, Average,
            Good, Better, Very Good, Excellent, Best};
N Items(::fullMonth); // returns 12 because fullMonth has 12 items.
N Items(::mlist[1]); /* returns this message: "N Items() argument must be a
list" because ::mlist[1] is a variable (fullMonth) and fullMonth is a list.*/
```

When you add the `Eval()` function:

```
N Items( Eval( ::mlist[1] ) );
12 /* returns 12 because::mlist[1] holds ::fullMonth, and evaluating it
returns ::fullMonth's list.*/
```

In a loop, you need the `Eval()` function in the nested loop to evaluate the variable’s contents. For example:

```
::mlist = {::fullMonth, ::abbrevMonth, ::dow, ::levels, ::feel, ::rating};
For( g = 1, g <= N Items( ::mlist ), g++,
    For( i = 1, i <= N Items( ::mlist[g] ), i++,
        Show( ::mlist[g][i] )
    )
);
// returns the message "N Items() argument must be a list."
```

To fix the problem, add the `Eval` function:

```
::mlist = {::fullMonth, ::abbrevMonth, ::dow, ::levels, ::feel, ::rating};
For( g = 1, g <= N Items( ::mlist ), g++,
    For( i = 1, i <= N Items( Eval( ::mlist[g] ) ), i++,
        Show( ::mlist[g][i] )
    )
);
```

### Assignments with Lists

Create a list to assign values to variables.

#### Examples

```
{a, b, c} = {1, 2, 3}; // assigns 1 to a, 2 to b, and 3 to c
{a, b, c}--; // decrements a, b, and c
```
Perform Operations in Lists

In lists, you can perform operations.

```plaintext
a = {{1, 2}, 3, {4, 5}};
b = {{10, 20}, 30, {40, 50}};
c = a + b;
    c = {{11, 22}, 33, {44, 55}}
```

Find the Number of Items in a List

To determine the number of items in a list, use the `N Items( )` function.

```plaintext
x = {1, 2, y, Sqrt(3), {a, b, 3}};
N = N Items( x);
Show( n );
    n = 5;
```

Subscripts

Subscripts extract specified items from a list. Use a list as a subscript to return multiple items from a list.

**Note:** JSL starts counting from 1, so the first element in a list is [1], not [0] as in some other languages.

Examples

List `a` contains four items.

```plaintext
a = {"bob", 4, [1, 2, 3], {x, y, z}};
Show( a[1] );
    a[1] = "bob";
Show( a[{1, 3}] );
    a[{1, 3}] = {"bob", [1, 2, 3]};
a[2] = 5;  // assigns 5 to the second list item
```

You can also use subscripts to select or change items in a list:

```plaintext
Show( a );
    a ={"bob", 5, [1, 2, 3], {x, y, z}};
c = {1, 2, 3};
c[{1, 2}] = {4, 4};
    // c[{1, 2}] = 4 produces the same result
Show( c );
```
\[ c = \{4, 4, 3\}; \]

When you have assignments or functions in a list, you can use a quoted name for the subscript to extract the value.

\[
x = \{\sqrt{4}, \log(3)\};
xx = \{a = 1, b = 3, c = 5\};
\]

\[
x["\sqrt"];
4
xx["b"];
3
\]

The name must be in quotation marks, or else JMP tries to evaluate it and use its value. The following example shows the values of the second item in the list, rather than the value of \( a \) in the list.

\[
a = 2;
Show( xx[a] );
xx[a] = b = 3;
\]

Note the following:

- Multiple left-side subscripts (for example, \( a[i][j] = \text{value} \)) where \( a \) contains a list of things that are subscriptable) are allowed in the following circumstances:
  - Each level except the outermost level must be a list. So, in the example above, \( a \) must be a list but \( a[i] \) can be anything subscriptable.
  - Each subscript except the last must be a number. So, in the example above, \( i \) must be a number, but \( j \) could be a matrix or list of indices.

- Subscripting can be done to any level of nesting, such as the following:
  \[
a[i][j][k][l][m][n] = 99;
\]

\textbf{Note:} To get a value in the matrix of an expression column, use double subscripts, as in \(:\text{Discrim Data Matrix}[][i] \) or \(:\text{Discrim Data Matrix}[\text{row}()][i] \). The value is returned instead of the row number.

\section*{Locate Items in a List}

Use the \texttt{Loc()} function or the \texttt{Contains()} function to find values in a list:

\[
\text{Loc( list, value );}
\text{Contains( list, value );}
\]

\texttt{Loc()} and \texttt{Contains()} return the positions of the values. \texttt{Loc()} returns the results in a matrix, and \texttt{Contains()} returns the results as a number.
Note the following:

- The `Loc` function returns each occurrence of a repeated value. `Contains()` returns only the first occurrence of a repeated value.
- If the value is not found, the `Loc` function returns an empty matrix and `Contains()` returns a zero.
- To assess whether an item is in a list, use `Loc()` and `Contains()` with >0. A returned value of zero means that the item is not in the list. A returned value of 1 means that the item is in the list at least once.

**Note:** For details about matrix manipulation and a description of the equivalent `Loc()` command for matrices, see “Matrices” on page 169.

**Examples**

```plaintext
nameList = {"Katie", "Louise", "Jane", "Jane"};
numList = {2, 4, 6, 8, 8};
```

Search for the value "Katie" in the `nameList`:

```plaintext
Loc( nameList, "Katie" );
[1]
Contains( nameList, "Katie" );
1
```

Search for the value "Erin" in the `nameList`:

```plaintext
Loc( nameList, "Erin" );
[]
Contains( nameList, "Erin" );
0
```

Search for the number 8 in the `numList`:

```plaintext
Loc( numList, 8 );
[4, 5]
Contains( numList, 8 );
4
```

Find out if the number 5 exists in the `numList`:

```plaintext
NRow( Loc( numList, 5 ) ) > 0;
0
Contains( numList, 5 ) > 0;
0
```
List Operators

Table 7.1 describes the list operators and their syntax.

<table>
<thead>
<tr>
<th>Operator and Function</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>As List()</td>
<td>As List(matrix)</td>
<td>Returns the matrix as a list. A matrix with multiple columns is returned as a list of lists, one list per row.</td>
</tr>
<tr>
<td>=</td>
<td>{list} = {list}</td>
<td>If the target of an assignment operator is a list and the value to be assigned is a list, then it assigns item by item. The ultimate values in the left list must be L-values (in other words, names capable of being assigned values).</td>
</tr>
<tr>
<td>+=</td>
<td>{list} += value</td>
<td>Notes:</td>
</tr>
<tr>
<td>-=</td>
<td>{list} -= {list}</td>
<td>• If you want to test equality of lists, use ==, not =.</td>
</tr>
<tr>
<td>*=</td>
<td>...</td>
<td>• JMP does not have a pre-decrement operator. Use the SubtractTo() operator instead ( -= ).</td>
</tr>
<tr>
<td>/=</td>
<td>DivideTo()</td>
<td></td>
</tr>
<tr>
<td>++</td>
<td>Post Increment()</td>
<td></td>
</tr>
<tr>
<td>--</td>
<td>Post Decrement()</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>=</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eval List()</td>
<td>Eval List(list)</td>
<td>Returns a list of the evaluated expressions inside list. See “Evaluate Lists” on page 160.</td>
</tr>
<tr>
<td>Insert Into()</td>
<td>Insert Into(list, x, &lt;i&gt;)</td>
<td>Inserts a new item (x) into the list at the given position (i). If i is not given, the item is added to the end of the list. This function does change the original list.</td>
</tr>
</tbody>
</table>
Table 7.1 List Operators  

<table>
<thead>
<tr>
<th>Operator and Function</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert()</td>
<td>list = Insert(list, x, &lt;i&gt;)</td>
<td>Returns a copy of the \textit{list} with a new item (x) inserted into the \textit{list} at the given position (i). If (i) is not given, the item is added to the end of the list. This function does not change the original list.</td>
</tr>
<tr>
<td>Is List()</td>
<td>Is List(arg)</td>
<td>Returns true (1) if \textit{arg} is a classical list (in other words, one that would result from the construction by \textit{List}\textit{(items)} or {\textit{items}}) and returns false (0) otherwise. An empty list is still a list, so \textit{IsList}{\textunderscore} returns true. If \textit{miss=}., then \textit{IsList}(\textit{miss}) returns false, not missing.</td>
</tr>
<tr>
<td>{ } List</td>
<td>List(a, b, c) {a, b, c}</td>
<td>Constructs a list from a set of items. An item can be any expression, including other lists. Items must be separated by commas. Text should either be enclosed in double quotation marks (&quot; &quot;) or stored in a variable and called as that variable.</td>
</tr>
<tr>
<td>N Items</td>
<td>N Items(list)</td>
<td>Returns the number of elements in the \textit{list} specified. Can be assigned to a variable.</td>
</tr>
<tr>
<td>Remove From()</td>
<td>Remove From(list, &lt;i&gt;, &lt;n&gt;)</td>
<td>Deletes (n) items from the \textit{list}, starting from the indicated position (i). If (n) is omitted, the item at (i) is deleted. If (n) and (i) are omitted, the item at the end is removed. This function does change the original list.</td>
</tr>
<tr>
<td>Remove()</td>
<td>Remove(list, &lt;i&gt;, &lt;n&gt;)</td>
<td>Returns a copy of the \textit{list} with the (n) items deleted, starting from the indicated position (i). If (n) is omitted, the item at (i) is deleted. If (n) and (i) are omitted, the item at the end is removed. This function does not change the original list.</td>
</tr>
</tbody>
</table>
### Table 7.1 List Operators (Continued)

<table>
<thead>
<tr>
<th>Operator and Function</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse Into()</td>
<td>Reverse Into(list)</td>
<td>Reverses the order of the items in the list. This function does change the original list.</td>
</tr>
<tr>
<td>Reverse()</td>
<td>Reverse(list)</td>
<td>Returns a copy of the list with the items in reverse order. This function does not change the original list.</td>
</tr>
<tr>
<td>Shift Into()</td>
<td>Shift Into(list, &lt;n&gt;)</td>
<td>Shifts ( n ) items from the front of the list to the end of the list. If ( n ) is omitted, the first item is moved to the end of the list. This function does change the original list.</td>
</tr>
<tr>
<td>Shift()</td>
<td>Shift(list, &lt;n&gt;)</td>
<td>Returns a copy of the list with ( n ) items shifted from the front of the list to the end of the list. If ( n ) is omitted, the first item is moved to the end of the list. This function does not change the original list.</td>
</tr>
<tr>
<td>Sort Ascending()</td>
<td>Sort Ascending(list)</td>
<td>Returns a copy of the list sorted in ascending order. This function does not change the original list.</td>
</tr>
<tr>
<td>Sort Descending()</td>
<td>Sort Descending(list)</td>
<td>Returns a copy of the list sorted in descending order. This function does not change the original list.</td>
</tr>
<tr>
<td>Sort List Into()</td>
<td>Sort List Into(list)</td>
<td>Sorts the list in ascending order. This function does change the original list.</td>
</tr>
<tr>
<td>Sort List()</td>
<td>Sort List(list)</td>
<td>Returns a copy of the list sorted in ascending order. This function does not change the original list.</td>
</tr>
<tr>
<td>[ ] Subscript()</td>
<td>list[i]</td>
<td>Subscripts for lists extract the ( i )th item from the list. Subscripts can in turn be lists or matrices.</td>
</tr>
<tr>
<td></td>
<td>( x = list[i] )</td>
<td></td>
</tr>
<tr>
<td></td>
<td>( list[i] = value )</td>
<td></td>
</tr>
<tr>
<td></td>
<td>( a[b, c] )</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Subscript(a, b, c)</td>
<td></td>
</tr>
</tbody>
</table>
Iterate through a List

Iterate through a list to do something with each value or look for a particular value. The following script looks at each item in the list. If the item in the list is less than or equal to 10, it is replaced with its square.

```plaintext
x = {2, 12, 8, 5, 18, 25};
n = N Items( x );
For( i = 1, i <= n, i++,
    If( x[i] <= 10,
        x[i] = x[i] ^ 2
    )
);
Show( x );
x = {4, 12, 64, 25, 18, 25};
```

You can use `Loc()` to locate the items in the new list that are equal to 25:

```plaintext
Loc( x, 25 );
[4, 6] // The fourth and sixth items in the list are equal to 25.
```

Concatenate Lists

Join two or more lists into one list with `Concat()` or the `||` operator.

The following example uses `Concat()` to join lists `a` and `b`:

```plaintext
a = {1, 2};
b = {7, 8, 9};
Concat( a, b );
\{1, 2, 7, 8, 9\}
```
The following example joins the same lists using the \(|\|\) operator:
\[
\{1, 2\} \|\| \{7, 8, 9\} \\
\{1, 2, 7, 8, 9\}
\]
Lists of different types can be concatenated (for example, lists that contain character strings and numbers).
\[
d = \{"apples", "bananas"\}; \\
e = \{"oranges", "grapes"\}; \\
f = \{1, 2, 3\}; \\
Concat( d, e, f); \\
\{"apples", "bananas", "oranges", "grapes", 1, 2, 3\}
\]

**Insert a Nested List in an Existing List**

To insert a nested list in an existing list, specify the placement of the list as follows:
\[
list2 = \{\{"a", "b"\}, \{"c", "d"\}\}; \\
list2[3] = \{"apple", "banana"\}; // specify a list as the third item \\
Show( list2 ); \\
list2 = \{\{"a", "b"\}, \{"c", "d"\}, \{"apple", "banana"\}\};
\]
If you do not know the number of items in a list, use \(N\) Items(). In this example, an empty list is inserted at the end of the list.
\[
list1 = \{"a", "b"\}; \\
list1[N Items( list1 ) + 1] = \{}; \\
Show( list1 ); \\
list1 = \{"a", "b", \}\};
\]

**Indexing into a List with Another List**

Indexing into a list with another list is a powerful technique for making scripts fast and small. See “Indexing into a Matrix or List with Another Matrix or List” on page 180 for more information.

**Matrices**

A matrix is a rectangular array of numbers that are arranged in rows and columns. Use matrices to store numbers and perform calculations on those numbers using matrix algebra.

Note the following for this section:
- Matrices are represented with an uppercase bold variable (for example, \(A\)).
- A matrix with one row or one column is a vector (or more specifically, a row vector or a column vector respectively).
For clarity, we represent matrices that are vectors with lowercase bold letters (such as \textbf{x}).

A **scalar** is a numeric value that is not in a matrix.

### Construct Matrices

Note the following when creating matrices:

- Place matrix literals in square brackets. [...]
- Matrix values can contain decimal points, can be positive or negative, and can be in scientific notation.
- Separate items across a column with blank spaces. You can use any number of blank spaces.
- Separate rows with a comma.

For constructing more advanced matrices, see “Special Matrices” on page 186.

### Examples

Create matrix \( \mathbf{A} \) with 3 rows and 2 columns:

\[
\mathbf{A} = \begin{bmatrix}
1 & 2 \\
3 & 4 \\
5 & 6
\end{bmatrix};
\]

\( \mathbf{R} \) is a row vector and \( \mathbf{C} \) is a column vector:

\[
\mathbf{R} = \begin{bmatrix}
10 & 12 & 14
\end{bmatrix};
\]

\[
\mathbf{C} = \begin{bmatrix}
11 \\
13 \\
15
\end{bmatrix};
\]

\( \mathbf{B} \) is a 1-by-1 matrix, or a matrix with one row and one column:

\[
\mathbf{B} = \begin{bmatrix}
20
\end{bmatrix};
\]

\( \mathbf{E} \) is an empty matrix:

\[
\mathbf{E} = \begin{bmatrix}
\end{bmatrix};
\]

The following examples show two ways of creating empty matrices:

\[
\mathbf{J}(0,4);
\]

\[
\begin{bmatrix}
0 & 0 & 0 & 0
\end{bmatrix};
\]

\[
\mathbf{J}(5,0);
\]

\[
\begin{bmatrix}
0 & 0 & 0 & 0 & 0
\end{bmatrix};
\]

Specifying the number of rows and columns in an empty matrix is optional. JMP creates the matrix as necessary. For example, the following script defines an empty matrix, iterates over each row in the data table, and returns the heights and weights in a matrix.

\[
\text{dt} = \text{Open}\left( "$SAMPLE\_DATA/Big\_Class.jmp" \right);
\]

\[
\text{data} = \begin{bmatrix}
\end{bmatrix}(0,2);
\]

\[
\text{For Each Row}\left( \text{data} \right) = \text{Matrix}\left( \{\text{dt:height, dt:weight}\} \right);
\]

\[
\text{Show}\left( \text{data} \right);
\]
data = [59 95, 61 123, 55 74,...]

A script can return an empty matrix. In Big Class.jmp, the following expression looks for rows in which age equals 8, finds none, and returns an empty matrix:

```julia
a = dt << Get Rows Where( age == 8 );
Show( a );
a = [](0,1);
```

**Construct Matrices from Lists**

If you want to convert lists into a matrix, use the `Matrix()` function. A single list is converted into a column vector. Two or more lists are converted into rows.

Create a column vector from a single list:

```julia
A = Matrix( {1, 2, 3} );
[1,2,3]
```

Create a matrix from a list of lists. Each list is a row in the matrix.

```julia
A = Matrix( {{1, 2, 3}, {4, 5, 6}, {7, 8, 9}} );
[1 2 3,
 4 5 6,
 7 8 9]
```

**Construct Matrices from Expressions**

To construct matrices from expressions, use `Matrix()`. Elements must be expressions that resolve to numbers.

```julia
A = Matrix( {4 * 5, 8 ^ 2, Sqrt( 9 )} );
[20, 64, 3]
```

**Subscripts**

Use the subscript operator ([ ]) to pick out elements or submatrices from matrices. The `Subscript()` function is usually written as a bracket notation after the matrix to be subscripted, with arguments for rows and columns.

**Single Element**

The expression `A[i,j]` extracts the element in row `i`, column `j`, returning a scalar number. The equivalent functional form is `Subscript(A, i, j).

```julia
P = [1 2 3, 4 5 6, 7 8 9];
P[2, 3]; // returns 6
Subscript( P, 2, 3 ); // returns 6
```
Assign the value that is in the third row and the first column in the matrix `A` (which is 5) to the variable `test`.

```plaintext
A = [1 2, 3 4, 5 6];
test = A[3, 1];
Show( test );
test = 5;
```

**Matrix or List Subscripts**

To extract a sub-matrix, use matrix or list subscripts. The result is a matrix of the selected rows and columns. The following expressions select the 2nd and 3rd rows with the 2nd and 1st columns.

```plaintext
P = [1 2 3, 4 5 6, 7 8 9];
P[[2 3],[1 3]]; // matrix subscripts
P[{2, 3},{1, 3}]; // list subscripts
```

Both of these methods provide the following output:

```
[4 6,
 7 9]
```

**Single Subscripts**

A single subscript addresses matrices as if all the rows were connected end-to-end in a single row. This makes the double subscript `A[i,j]` the same as the single subscript `A[(i-1)*ncol(A)+j]`.

**Examples**

```plaintext
Q = [2 4 6, 8 10 12, 14 16 18];
Q[8]; // same as Q[3,2]
16
```

The following examples all return the column vector `[10, 14, 18]`:

```plaintext
Q = [2 4 6, 8 10 12, 14 16 18];
Q[[5, 7, 9]];  
Q[[5 7 9]];  
ii = [5 7 9];
Q[ii];
ii = {5, 7, 9};
Q[ii];
Subscript( Q, ii );
```

This script returns the values 1 through 9 from the matrix `P` in order:

```plaintext
P = [1 2 3, 4 5 6, 7 8 9];
For( i = 1, i <= 3, i++,
    For( j = 1, j <= 3, j++,
```
Show( P[i, j] )
);

Delete Rows and Columns

Deleting rows and columns is accomplished by assigning an empty matrix to that row or column.

A[k, 0] = [];  // deletes the kth row
A[0, k] = [];  // deletes the kth column

Select Whole Rows or Columns

A subscript argument of zero selects all rows or columns.

P = [1 2 3, 4 5 6, 7 8 9];
Select column 2:

P[0, 2];
[2, 5, 8]
Select columns 3 and 2:

P[0, [3, 2]];  
[3 2, 6 5, 9 8]
Select row 3:

P[3, 0];
[7 8 9]
Select rows 2 and 3:

P[[2, 3], 0];  
[4 5 6, 7 8 9]
Select all columns and rows (the whole matrix):

P[0, 0];
[1 2 3, 4 5 6, 7 8 9]

Assignment through Subscripts

You can change values in matrices using subscripts. The subscripts can be single indices, matrices or lists of indices, or the zero index representing all rows or columns. The number of selected rows and columns for the insertion must either match the dimension of the inserted argument, or the argument can be inserted repeatedly into the indexed positions.

Examples

Change the value in row 2, column 3 to 99:
$P = \begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9
\end{bmatrix};
$P[2, 3] = 99;$

Show( P );

$P=\begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 99, & 7 & 8 & 9
\end{bmatrix}$

Change the values in four locations:

$P = \begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9
\end{bmatrix};$

$P[[1 2], [2 3]] = \begin{bmatrix}
66 & 77, & 88 & 99
\end{bmatrix};$

Show( P );

$P=\begin{bmatrix}
1 & 66 & 77, & 4 & 88 & 99, & 7 & 8 & 9
\end{bmatrix}$

Change three values in one column:

$P = \begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9
\end{bmatrix};$

$P[0, 2] = \begin{bmatrix}
11, & 22, & 33
\end{bmatrix};$

Show( P );

$P=\begin{bmatrix}
1 & 11 & 3, & 4 & 22 & 6, & 7 & 33 & 9
\end{bmatrix}$

Change three values in one row:

$P = \begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9
\end{bmatrix};$

$P[3, 0] = \begin{bmatrix}
100 & 102 & 104
\end{bmatrix};$

Show( P );

$P=\begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 6, & 100 & 102 & 104
\end{bmatrix}$

Change all the values in one row to the same value:

$P = \begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9
\end{bmatrix};$

$P[2, 0] = 99;$

Show( P );

$P=\begin{bmatrix}
1 & 2 & 3, & 99 & 99 & 99, & 7 & 8 & 9
\end{bmatrix}$

**Operator Assignment**

You can use operator assignments (such as +=) on matrices or subscripts of matrices. For example, the following statement adds 1 to the $i$-$j$th element of the matrix:

$P = \begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9
\end{bmatrix};$

$P[1, 1] += 1;$

Show( P );

$P=\begin{bmatrix}
2 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9
\end{bmatrix};$

$P[1, 1] += 1;$

Show( P );

$P=\begin{bmatrix}
3 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9
\end{bmatrix};$
Ranges of Rows or Columns

If you are working with a range of subscripts, use the `Index()` function `::` to create matrices of ranges.

\[
\begin{align*}
T1 &= 1 :: 3; \quad // \text{creates the vector } [1 2 3] \\
T2 &= 4 :: 6; \quad // \text{creates the vector } [4 5 6] \\
T3 &= 7 :: 9; \quad // \text{creates the vector } [7 8 9] \\
T &= T1 |/ T2 |/ T3; \quad // \text{concatenates the vectors into a single matrix} \\
T[1 :: 3, 2 :: 3]; \quad // \text{refers to rows 1 through 3, columns 2 and 3} \\
&= [2 3, 5 6, 8 9] \\
T[Index( 1, 3 ), Index( 2, 3 )]; \quad // \text{equivalent Index function} \\
&= [2 3, 5 6, 8 9]
\end{align*}
\]

Inquiry Functions

The `NCol()` and `NRow()` functions return the number of columns and rows in a matrix (or data table), respectively:

\[
\begin{align*}
\text{NCol}( [1 2 3, 4 5 6] ); \quad // \text{returns 3 (for 3 columns)} \\
\text{NRow}( [1 2 3, 4 5 6] ); \quad // \text{returns 2 (for 2 rows)}
\end{align*}
\]

To determine whether a value is a matrix, use the `Is Matrix()` function, which returns a 1 if the argument evaluates to a matrix.

\[
\begin{align*}
A &= [20, 64, 3]; \\
B &= \{20, 64, 3\}; \\
\text{Is Matrix}( A ); \quad // \text{returns 1 for yes} \\
\text{Is Matrix}( B ); \quad // \text{returns 0 for no}
\end{align*}
\]

Comparisons, Range Checks, and Logical Operators

JMP’s comparison, range check, and logical operators work with matrices and produce matrices of elementwise Boolean results. You can compare conformable matrices.

\[
\begin{align*}
A < B; \quad // \text{less than} \\
A <= B; \quad // \text{less or equal} \\
A > B; \quad // \text{greater than} \\
A >= B; \quad // \text{greater or equal} \\
A == B; \quad // \text{equal to} \\
A != B; \quad // \text{not equal to} \\
A < B < C; \quad // \text{continued comparison (range check)} \\
A | B; \quad // \text{logical OR} \\
A & B; \quad // \text{logical AND}
\end{align*}
\]

You can use the `Any()` or `All()` operators to summarize matrix comparison results. `Any()` returns a 1 if any element is nonzero. `All()` returns a 1 if all elements are nonzero.

\[
[2 \ 2] == [1 \ 2]; \quad // \text{returns [0 \ 1], therefore:}
\]
Matrices Scripting Guide

```javascript
All( [2 2] == [1 2] ); // returns 0
Any( [2 2] == [1 2] ); // returns 1
```

Min() or Max() return the minimum or maximum element from the matrix or matrices given as arguments.

```javascript
A = [1 2 3, 4 5 6, 7 8 9, 10 11 12];
B = [0 1 2, 2 1 0, 0 1 1, 2 0 0];
Min( A ); // returns 1
Max( A ); // returns 12
Min( A, B ); // returns 0
```

### Numeric Operations

You can perform numeric operations (such as subtraction, addition, and multiplication) on matrices. Most statistical methods are expressed in compact matrix notation and can be implemented in JSL.

For example, the following expression uses matrix multiplication and inversion to illustrate least squares regression:

```
b = (X'X)^{-1}X'\ y
```

Implement this equation through the following JSL expression:

```
b = Inv( X`*X )*X`*y;
```

### Basic Arithmetic

You can perform the following basic arithmetic on matrices:

- addition
- subtraction
- multiplication
- division (multiplying by the inverse)

**Note:** The standard multiply operator is a matrix multiplier, not an elementwise multiplier.

To perform matrix multiplication, use one of the following methods:

- * operator
- Multiply() function
- Matrix Mult() function

To perform matrix division, use one of the following methods:

- / operator
• **Divide()** function

Note the following about matrix multiplication and division:

• Remember that while multiplication or division of scalars is commutative \((ab = ba)\), multiplication or division of matrices is **not** commutative.

• When one of the two elements is a scalar, elementwise multiplication or division is performed.

• To use elementwise multiplication, use :\* or the **EMult()** function.

• To use elementwise division, use :\/, or the equivalent **EDiv()** function.

**Examples**

\[
A = \begin{bmatrix}
1 & 2 & 3, & 4 & 5 & 6, & 7 & 8 & 9, & 10 & 11 & 12
\end{bmatrix};
\]

\[
B = \begin{bmatrix}
0 & 1 & 2, & 2 & 1 & 0, & 0 & 1 & 1, & 2 & 0 & 0
\end{bmatrix};
\]

\[
C = \begin{bmatrix}
1 & 2 & 3 & 4, & 4 & 3 & 2 & 1, & 0 & 1 & 0 & 1
\end{bmatrix};
\]

\[
D = \begin{bmatrix}
0 & 1 & 2, & 2 & 1 & 0, & 1 & 2 & 0
\end{bmatrix};
\]

Matrix addition:

\[
R = A + B;
\]

\[
\begin{bmatrix}
1 & 3 & 5, & 6 & 6 & 6, & 7 & 9 & 10, & 12 & 11 & 12
\end{bmatrix}
\]

Matrix subtraction:

\[
R = A - B;
\]

\[
\begin{bmatrix}
1 & 1 & 1, & 2 & 4 & 6, & 7 & 7 & 8, & 8 & 11 & 12
\end{bmatrix}
\]

Matrix multiplication (inner product of rows of **A** with columns of **C**):

\[
R = A \times C;
\]

\[
\begin{bmatrix}
9 & 11 & 7 & 9, & 24 & 29 & 22 & 27, & 39 & 47 & 37 & 45, & 54 & 65 & 52 & 63
\end{bmatrix}
\]

Matrix division (equivalent to **A**\*Inverse(**D**)):

\[
R = A / D;
\]

\[
\begin{bmatrix}
1.5 & 0.5 & 0, & 3 & 2 & 0, & 4.5 & 3.5 & 0, & 6 & 5 & 0
\end{bmatrix}
\]

Matrix elementwise multiplication:

\[
R = A :* B;
\]
Matrix scalar multiplication:

\[ \begin{bmatrix}
0 & 2 & 6 \\
8 & 5 & 0 \\
0 & 8 & 9 \\
20 & 0 & 0
\end{bmatrix} \]

\[ R = C \times 2; \]
\[ \begin{bmatrix}
2 & 4 & 6 & 8 \\
8 & 6 & 4 & 2 \\
0 & 2 & 0 & 2
\end{bmatrix} \]

Matrix scalar division:

\[ R = C \div 2; \]
\[ \begin{bmatrix}
0.5 & 1 & 1.5 & 2 \\
2 & 1.5 & 1 & 0.5 \\
0 & 0.5 & 0 & 0.5
\end{bmatrix} \]

Matrix elementwise division (division by zero results in missing values):

\[ R = A \div B; \]
\[ \begin{bmatrix}
. & 2 & 1.5 \\
2 & 5 & . \\
. & 8 & 9 \\
5 & . & .
\end{bmatrix} \]

**Numeric (Scalar) Functions on Matrices**

Numeric functions work elementwise on matrices. Most of the pure numeric functions can be applied to matrices, resulting in a matrix of results. You can mix conformable matrix and scalar arguments.

Examples of numeric functions include the following:

- \( \text{Sqrt}(), \text{Root}(), \text{Log}(), \text{Exp}(), ^\text{Power}(), \text{Log10}() \)
- \( \text{Abs}(), \text{Mod}(), \text{Floor}(), \text{Ceiling}(), \text{Round}(), \text{Modulo}() \)
- \( \text{Sine}(), \text{Cosine}(), \text{Tangent}(), \text{ArcSine}(), \) and other trigonometry functions.
- \( \text{Normal Distribution}(), \) and other probability functions.

**Example**

\[
A = \begin{bmatrix}
1 & 2 & 3 & 4 & 5 & 6 & 7 & 8 & 9 & 10 & 11 & 12
\end{bmatrix};
B = \text{Sqrt}( A ); \quad // \text{elementwise square root}
\begin{bmatrix}
1 & 1.414213562373095 & 1.732050807568877 & 2.449489742783178 & 2.645751311064591 & 2.82842712474619 & 3.16227766016838 & 3.3166247903554 & 3.464101615137755
\end{bmatrix}
\]
Concatenation

The Concat() function combines two matrices side by side to form a larger matrix. The number of rows must agree. A double vertical bar (||) is the infix operator, equivalent for horizontal concatenation.

\[
\text{Identity}(2) \ || \ J(2, 3, 4);
\]
\[
\begin{bmatrix}
1 & 0 & 4 & 4 & 4, & 0 & 1 & 4 & 4 & 4
\end{bmatrix}
\]

\[
B = [1, 1];
\]
\[
B \ || \ \text{Concat( Identity(2), J(2, 3, 4) )};
\]
\[
\begin{bmatrix}
1 & 1 & 0 & 4 & 4 & 4, & 1 & 0 & 1 & 4 & 4 & 4
\end{bmatrix}
\]

The VConcat() function stacks two matrices on top of each other to form a larger matrix. The number of columns must agree. A vertical-bar-slash (|/) is the infix operator, equivalent for vertical concatenation.

\[
\text{Identity}(2) \ |/ \ J(3, 2, 1);
\]
// or VConcat( Identity(2), J(3, 2, 1) );
\[
\begin{bmatrix}
1 & 0, & 1 & 1, & 1 & 1
\end{bmatrix}
\]

Both Concat() and VConcat() support concatenating to empty matrices, scalars, and lists.

\[
a = [];
\]
\[
a \ || [1]; \ // \ yields [1]
\]
\[
a \ || \{2\}; \ // \ yields [2]
\]
\[
a \ || [3, 4, 5]; \ // \ yields [3, 4, 5]
\]

There are two in place concatenation operators: ||= and |/=. They are equivalent to the Concat To() and V Concat To() functions, respectively.

- a \ || = b \ is equivalent to a = a \ || \ b
- a \ |/ = b \ is equivalent to a = a \ | /= b

Transpose

The Transpose() function transposes the rows and columns of a matrix. A back-quote (`) is the postfix operator, equivalent to Transpose(). In matrix notation, Transpose() is expressed as the common prime or superscript-T notation (A’ or Aᵀ).

\[
A = [1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12];
\]
\[
A^; 
\]
\[
\begin{bmatrix}
1 & 4 & 7 & 10, \\
2 & 5 & 8 & 11, \\
3 & 6 & 9 & 12
\end{bmatrix}
\]
\[
\text{Transpose}( \ [1, 2, 3, 4] \ );
\]
\[
[1, 3, 2, 4]
\]
Indexing into a Matrix or List with Another Matrix or List

Indexing into a matrix (or a list) with another matrix (or list) is a powerful technique for making scripts fast and small. JMP 13 and later handles one edge case differently.

Consider the following example of using a matrix as an index into a data column.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
tall rows = Loc( :height << Get Values() >= 67 ); // [25, 27, 30, 37, 39, 40] :height[tall rows]; // [68, 69, 67, 68, 68, 70]
N Rows( :height[tall rows] ); // 6
```

The second line is the key. `:height << Get Values()` returns the values of the `height` column as a matrix. The comparison `>= 67` returns a matrix of 0s and 1s corresponding to where the expression is false (0) or true (1). The `Loc()` function returns the locations of the 1s within the previous matrix.

In this case, you get [25, 27, 30, 37, 39, 40] as the row numbers where the `height` column is greater than or equal to 67. That’s pretty handy by itself, but the real power comes from being able to use that matrix as the index into a column or other matrix as in the third and fourth lines.

The alternative to this technique is to write a `For()` loop to iterate through every row explicitly. JMP still loops through the rows in either case, but the looping is much faster if done internally rather than in JSL. And the JSL is more compact without the explicit loop.

You can do the same thing with a matrix variable instead of a data column reference:

```julia
m = :height << Get Values();
tall rows = Loc( m >= 67 ); // [25, 27, 30, 37, 39, 40] m[tall rows]; // [68, 69, 67, 68, 68, 70]
N Rows( m[tall rows] ); // 6
```

Consider the same examples with a different height cutoff (70 instead of 67):

```julia
tall rows = Loc( :height << Get Values() >= 70 ); // [40] :height[tall rows]; // [70]
N Rows( :height[tall rows] ); // 1
```

```julia
m = :height << Get Values();
tall rows = Loc( m >= 70 ); // [40] m[tall rows]; // 70
N Rows( m[tall rows] ); // error
```

Notice that `data[tall rows]` returned 70 instead of [70]. In many cases, a 1x1 matrix and a number are treated the same way, but not always. The `N Rows()` function is one example where it makes a difference. The indexing is too aggressively simplifying the 1x1 matrix into a number.
One work-around is to call Is Matrix() before using N Rows(). An alternative is to concatenate an empty matrix to the result, which creates a matrix whether the source is a number or a matrix:

\[ m = m \left\| \begin{bmatrix} \end{bmatrix} \right. \]

In JMP 13 and later, the 1x1 matrix is maintained so that the result of the index operation is a matrix whenever the index itself is a matrix. The same principle applies to list indexing. Data table column indexing has always followed this principle.

**Matrices and Data Tables**

You can move information between a matrix and a JMP data table. You can use matrix algebra to perform calculations on numbers that are stored in JMP data tables, and you can save the results back to JMP data tables.

**Move Data into a Matrix from a Data Table**

These sections describe how to move data from a data table into a matrix.

**Move All Numeric Values**

The Get As Matrix() function generates a matrix containing all of the numeric values in a data table or column:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
A = dt << Get As Matrix;
[12 59 95,
 12 61 123,
 12 55 74, ...]
```

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
col = Column( "Height" );
A = col << Get As Matrix;
[59, 61, 55, 66, 52, ...]
```

**Move All Numeric Values and Character Columns**

The Get All Columns As Matrix() function returns the values from all columns of the data table in a matrix, including character columns. Character columns are numbered according to the alphanumeric order, starting at 1.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
A = dt << Get All Columns As Matrix;
[21 12 1 59 95,
 28 12 1 61 123, ...]
```

**Move Only Certain Columns**

To get certain columns of a data table, use column list arguments (names or characters).
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
x = dt << Get As Matrix( {"height", "weight"} );

or

x = dt << Get As Matrix( {height, weight} );

[59 95, 61 123, 55 74, ...]

Currently Selected Rows

To get a matrix of the currently selected row numbers in the data table:

dt << Get Selected Rows;

Note: If no rows are selected, the output is an empty matrix.

Find Rows Where

To see a matrix of row numbers where the expression is true:

dt << Get Rows Where( expression );

For example, the following script returns the row numbers where the sex is male (M):

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
A = dt << Get Rows Where( Sex == "M" );
[6, 7, 8, 12, 13, 14, ...]

Move Data into a Data Table from a Matrix

This section describes how to move data from a matrix into a data table.

Move a Column Vector

The Set Values() function copies values from a column vector into an existing data table column:

col << Set Values( x );

col is a reference to the data table column, and x is a column vector.

For example, the following script creates a new column called test and copies the values of vector x into the test column:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "test" );
col = Column( "test" );
x = 1::40;
col << Set Values( x );
Move All Matrix Values

The `Set Matrix()` function copies values from a matrix into an existing data table, making new rows and new columns as needed to store the values of the matrix. The new columns are named `Col1`, `Col2`, and so on.

```plaintext
dt = New Table( "B" );
dt << Set Matrix([1 2 3 4 5, 6 7 8 9 10]);
```

This script creates a new data table called `B` containing two rows and five columns.

To create a new data table from a matrix argument, use the `As Table(matrix)` command. The columns are named `Col1`, `Col2`, and so on. For example, the following script creates a new data table containing the values of `A`:

```plaintext
A = [1 2 3, 4 5 6, 7 8 9, 10 11 12];
dt = As Table( A );
```

Summarize Columns

There are several functions that return a row vector based on summary values for each column.

```plaintext
mymatrix = [11 22, 33 44, 55 66];
V Max( mymatrix ); // returns the maximum of each column
   [55 66]
V Min( mymatrix ); // returns the minimum of each column
   [11 22]
V Mean( mymatrix ); // returns the mean of each column
   [33 44]
V Sum( mymatrix ); // returns the sum of each column
   [99 132]
V Std( mymatrix ); // returns the standard deviations of each column
   [22 22]
```

Matrices and Reports

You can extract matrices of values from reports. First, you need to locate the items that you want to extract. This information is in the tree structure of the report.

Run the following script to create a table of parameter estimates in a Bivariate report:

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( X( height ), Y( weight ), Fit Line );
```

Now, open the tree structure to identify which item contains the parameter estimates:

- Right-click a gray disclosure icon and select `Edit > Show Tree Structure`.

  The parameter estimates are contained in `NumberColBox(13)`. Continue with the script as follows:
colBox = Report( biv )[Number Col Box( 13 )];
beta = colBox << Get As Matrix;
   [-127.145248610915, 3.711354893859555]

Note the following:

- When a variable contains a reference to a table box, Get As Matrix() creates a matrix A that contains the values from all numeric columns in the table:
  
  \[ A = \text{tableBox} \ll \text{Get As Matrix}; \]

- When a variable contains a reference to a numeric column in a report table, Get As Matrix() creates a matrix A as a column vector of values from that column.

  \[ A = \text{colBox} \ll \text{Get As Matrix}; \]

Loc Functions

The Loc(), Loc Nonmissing(), Loc Min(), Loc Max(), and Loc Sorted() functions all return matrices that show positions of certain values in a matrix.

Loc()

The Loc() function creates a matrix of positions that locate where A is true (nonzero and nonmissing).

\[
A = \begin{bmatrix} 0 & 1 & . & 3 & 4 & 0 \end{bmatrix};
B = \begin{bmatrix} 2 & 0 & 0 & 2 & 5 & 6 \end{bmatrix};
\]

The following example returns the indices for the values of A that are nonmissing and nonzero.

\[
I = \text{Loc}( A );
\]

\[
[2, 4, 5]
\]

The following example returns the indices for the values of A that are less than the corresponding values of B. Note that the two matrices must have the same number of rows and columns.

\[
I = \text{Loc}( A < B );
\]

\[
[1, 5, 6]
\]

The following script replaces all values less than 4 in A with 0.

\[
A = \begin{bmatrix} 0 & 1 & 0 & 3 & 4 & 0 \end{bmatrix};
A[\text{Loc}( A < 4 )] = 0;
\text{Show}( A );
\]

\[
A = \begin{bmatrix} 0 & 0 & 0 & 0 & 4 & 0 \end{bmatrix};
\]

The following script returns an empty matrix:

\[
\text{Loc}( \begin{bmatrix} 2 & 3 & 4 & 5 & 6 \end{bmatrix} > 7 );
\]

\[
[ ](0, 1)
\]
Loc Nonmissing()

The Loc Nonmissing() function returns a vector of row numbers in a matrix that do not contain any missing values. For example,

\[ A = [1\ 2\ 3,\ 4\ .\ 6,\ 7\ 8\ .,\ 8\ 7\ 6]; \]
\[ \text{Loc Nonmissing}(A); \]
\[ [1,\ 4] \]

Loc Min() and Loc Max()

The Loc Min() and Loc Max() functions return the position of the first occurrence of the minimum and maximum elements of a matrix. Elements of a matrix are numbered consecutively, starting in the first row, first column, and proceeding left to right.

\[ A = [1\ 2\ 2,\ 2\ 4\ 4,\ 1\ 1\ 1]; \]
\[ B = [6,\ 12,\ 9]; \]
\[ \text{Show}(\ \text{Loc Max}(A)); \]
\[ \text{Show}(\ \text{Loc Min}(B)); \]
\[ \text{Loc Max}(A) = 5; \]
\[ \text{Loc Min}(B) = 1; \]

Loc Sorted()

The Loc Sorted() function is mainly used to identify the interval that a number lies within. The function returns the position of the highest value in \( A \) that is less than or equal to the value in \( B \). The resulting vector contains an item for each element in \( B \).

\[ A = [10\ 20\ 30\ 40]; \]
\[ B = [35]; \]
\[ \text{Loc Sorted}(A, B); \]
\[ [3] \]
\[ A = [10\ 20\ 40]; \]
\[ B = [35\ 5\ 45\ 20]; \]
\[ \text{Loc Sorted}(A, B); \]
\[ [2, \ 1, \ 3, \ 2] \]

Note the following:

- \( A \) must be sorted in ascending order.
- The returned values are always 1 or greater. If the element in \( B \) is smaller than all of the elements in \( A \), then the function returns a value of 1. If the element in \( B \) is greater than all of the elements in \( A \), then the function returns \( n \), where \( n \) is the number of elements in \( A \).
Ranking and Sorting

The Rank() function returns the positions of the numbers in a vector or list, as if the numbers were sorted from lowest to highest.

\[
E = [1 \ -2 \ 3 \ -4 \ 0 \ 5 \ 1 \ 8 \ -7];
R = \text{Rank}(E);
[9, \ 4, \ 2, \ 5, \ 7, \ 1, \ 3, \ 6, \ 8]
\]

If \(E\) were sorted from lowest to highest, the first number would be -7. The position of -7 in \(E\) is 9.

The original matrix \(E\) can then be sorted using the matrix \(R\) as subscripts to \(E\).

\[
\text{sortedE} = E[R];
[-7, \ -4, \ -2, \ 0, \ 1, \ 1, \ 3, \ 5, \ 8]
\]

The Ranking Tie() function returns ranks for the values in a vector or list, with ranks for ties averaged. Similarly, Ranking() returns ranks for the values in a vector or list, but the ties are ranked arbitrarily.

\[
E = [1 \ -2 \ 3 \ -4 \ 0 \ 5 \ 1 \ 8 \ -7];
\text{Ranking Tie}(E);
[5.5, \ 3, \ 7, \ 2, \ 4, \ 8, \ 5.5, \ 9, \ 1]
\]

\[
E = [1 \ -2 \ 3 \ -4 \ 0 \ 5 \ 1 \ 8 \ -7];
\text{Ranking}(E);
[5, \ 3, \ 7, \ 2, \ 4, \ 8, \ 6, \ 9, \ 1]
\]

The Sort Ascending() and Sort Descending() functions sort vectors.

\[
E = [1 \ -2 \ 3 \ -4 \ 0 \ 5 \ 1 \ 8 \ -7];
\text{Sort Ascending}(E);
[-7 \ -4 \ -2 \ 0 \ 1 \ 1 \ 3 \ 5 \ 8]
\]

\[
E = [1 \ -2 \ 3 \ -4 \ 0 \ 5 \ 1 \ 8 \ -7];
\text{Sort Descending}(E);
[8 \ 5 \ 3 \ 1 \ 1 \ 0 \ -2 \ -4 \ -7]
\]

If the argument is not a vector or list, an error message is generated.

Special Matrices

Construct an Identity Matrix

The Identity() function constructs an identity matrix of the dimension that you specify. An identity matrix is a square matrix of zeros except for a diagonal of ones. The only argument specifies the dimension.

\[
\text{Identity}(3);
[1 \ 0 \ 0,
[0 \ 1 \ 0,
[0 \ 0 \ 1]
\]
\]


Construct a Matrix with Specific Values

The \texttt{J()} function constructs a matrix with the number of rows and columns that you specify as the first two arguments, whose elements are all the third argument, for example:

\[
\text{J}( 3, 4, 5 );
\]

\[
\begin{bmatrix}
5 & 5 & 5 & 5 \\
5 & 5 & 5 & 5 \\
5 & 5 & 5 & 5
\end{bmatrix}
\]

\texttt{J}( 3, 4, \texttt{Random Normal()} ); // your results will differ

\[
\begin{bmatrix}
0.407709113182904 & 1.67359154091978 & 1.00412665221308 & 0.240885679837327 \\
-0.557848036549455 & -0.620833861982722 & 0.877166783247633 & 1.50413740148892 \\
-2.09920574748608 & -0.154797501010655 & 0.0463943433032137 & 0.064041826393316
\end{bmatrix}
\]

Create a Diagonal Matrix

The \texttt{Diag()} function creates a diagonal matrix from a square matrix (having an equal number of rows and columns) or a vector. A diagonal matrix is a square matrix whose nondiagonal elements are zero.

\[
D = \begin{bmatrix} 1 & -1 & 1 \end{bmatrix};
\]

\[
\text{Diag}( D );
\]

\[
\begin{bmatrix} 1 & 0 & 0 \\
0 & -1 & 0 \\
0 & 0 & 1
\end{bmatrix}
\]

\texttt{Diag([1, 2, 3, 4]);}

\[
\begin{bmatrix} 1 & 0 & 0 & 0 \\
0 & 2 & 0 & 0 \\
0 & 0 & 3 & 0 \\
0 & 0 & 0 & 4
\end{bmatrix}
\]

\[
A = \begin{bmatrix} 1 & 2 & 3 & 4 \end{bmatrix};
\]

\[
f = [5];
\]

\[
D = \text{Diag}( A, f );
\]

\[
\begin{bmatrix} 1 & 2 & 0 \\
3 & 4 & 0 \\
0 & 0 & 5
\end{bmatrix}
\]

In the third example, at first glance, not all of the nondiagonal elements are zero. Using matrix notation, the matrix can be expressed as follows:

\[
\begin{bmatrix} A & 0 \\
0 & f
\end{bmatrix}
\]

Where \( A \) and \( f \) are the matrices from the example, and \( 0 \) is a column vector of zeros.
Create a Column Vector from Diagonal Elements

The VecDiag() function creates a column vector from the diagonal elements of a matrix.

\[
v = \text{Vec Diag}(
\begin{bmatrix}
1 & 0 & 0 & 1, \\
5 & 3 & 7 & 1, \\
9 & 9 & 8 & 8, \\
1 & 5 & 4 & 3
\end{bmatrix};
\]

Calculate Diagonal Quadratic Forms

The Vec Quadratic() function calculates the hats in regression that go into the standard errors of prediction or the Mahalanobis or T2 statistics for outlier distances. Vec Quadratic(Sym, X) is equivalent to calculating Vec Diag(X*Sym*X'). The first argument is a symmetric matrix, usually an inverse covariance matrix. The second argument is a rectangular matrix with the same number of columns as the symmetric matrix argument.

Return the Sum of Diagonal Elements

The Trace() function returns the sum of the diagonal elements for a square matrix.

\[
D = \begin{bmatrix}
0 & 1 & 2, \\
2 & 1 & 0, \\
1 & 2 & 0
\end{bmatrix};
\]

\[
\text{Trace}( D ); // \text{returns } 1
\]

Generate a Row Vector of Integers

The Index() function generates a row vector of integers from the first argument to the last argument. A double colon :: is the equivalent infix operator.

\[
6::10;
\]

\[
[6 7 8 9 10]
\]

\[
\text{Index}(1, 5);
\]

\[
[1 2 3 4 5]
\]

The optional increment argument changes the default increment of +1.

\[
\text{Index}(0.1, 0.4, 0.1);
\]

\[
[0.1, 0.2, 0.3, 0.4]
\]

The increment can also be negative.

\[
\text{Index}(6, 0, -2);
\]

\[
[6, 4, 2, 0]
\]

The default value of the increment is 1, or -1 if the first argument is higher than the second.

Reshape a Matrix

The Shape() function reshapes an existing matrix across rows to be the specified dimensions. The following example changes the 3x4 matrix a into a 12x1 matrix:

\[
a = \begin{bmatrix}
1 & 1 & 1, \\
2 & 2 & 2, \\
3 & 3 & 3, \\
4 & 4 & 4
\end{bmatrix};
\]
Create Design Matrices

The `Design()` function creates a matrix of design columns for a vector or list. There is one column for each unique value in the vector or list. The design columns have the elements 0 and 1. For example, \( x \) below has values 1, 2, and 3, then the design matrix has a column for 1s, a column for 2s, and a column for 3s. Each row of the matrix has a 1 in the column representing that row’s value. So, the first row (1) has a 1 in the 1s column (the first column) and 0s elsewhere; the second row (2) has a 1 in the 2’s column and 0s elsewhere; and so on.

\[
x = [1, 2, 3, 2, 1];
Design( x );
\[
[1 0 0,
 0 1 0,
 0 0 1,
 0 1 0,
 1 0 0]
\]

A variation is the `Design Nom()` or `Design F()` function, which removes the last column and subtracts it from the others. Therefore, the elements of `Design Nom()` or `Design F()` matrices are 0, 1, and –1. And the `Design Nom()` or `Design F()` matrix has one less column than the vector or list has unique values. This operator makes full-rank versions of design matrices for effects.

\[
x = [1, 2, 3, 2, 1];
Design Nom( x );
\[
[1 0, 0 1, -1 -1, 0 1, 1 0]
\]

Design Nom() is further demonstrated in the “ANOVA Example” on page 201.

To facilitate ordinal factor coding, use the `Design Ord()` function. This function produces a full-rank coding with one less column than the number of unique values in the vector or list. The row for the lowest value in the vector or list is all zeros. Each succeeding value adds an additional 1 to the row of the design matrix.

\[
x = [1, 2, 3, 4, 5, 6];
Design Ord( x );
\[
[0 0 0 0 0,
 1 0 0 0 0,
 1 1 0 0 0,
 1 1 1 0 0,
 1 1 1 1 0,
 1 1 1 1 1]
\]

Design(), Design Nom(), and Design Ord() support a second argument that specifies the levels to be looked up and their order. This feature allows design matrices to be created one row at a time.

- `Design( values, levels )` creates a design matrix of indicator columns.
• DesignNom( values, levels ) creates a full-rank design matrix of indicator columns.

Note the following:
• The values argument can be a single element or a matrix or list of elements.
• The levels argument can be a list or matrix of levels to be looked up.
• The result has the same number of rows as there are elements in the values argument.
• The result always has the same number of columns as there are items in the levels argument. In the case of Design Nom() and Design Ord(), there is one less column than the number of items in the levels argument.
• If a value is not found, the whole row is zero.

Examples

Design( 20, [10 20 30] );
[0 1 0]
Design( 30, [10 20 30] );
[0 0 1]
Design Nom( 20, [10 20 30] );
[0 1]
Design Nom( 30, [10 20 30] );
[-1 -1]
Design Ord( 20, [10 20 30] );
[1 0]
Design( [20, 10, 30, 20], [10 20 30] );
[0 1 0,
  1 0 0,
  0 0 1,
  0 1 0]
Design( {"b", "a", "c", "b"}, {"a", "b", "c"} );
[0 1 0,
  1 0 0,
  0 0 1,
  0 1 0]

Find the Direct Product

The Direct Product() function finds the direct product (or Kronecker product) of two square matrices. The direct product of a m x m matrix and a n x n matrix is the mn x mn matrix whose elements are the products of numbers, one from A and one from B.

G = [1 2, 3 5];
H = [2 3, 5 7];
Direct Product( G, H );
[2 3 4 6,
  5 7 10 14,
  6 9 10 15,
  15 21 25 35]
The \texttt{HDirect Product()} function finds the row-by-row direct product of two matrices with the same number of rows.

\begin{verbatim}
HDirect Product( G, H );
[2 3 4 6, 15 21 25 35]
\end{verbatim}

\texttt{HDirect Product()} is useful for constructing the design matrix columns for interactions.

\begin{verbatim}
XA = Design Nom( A );
XB = Design Nom( B );
XAB = HDirect Product( XA, XB );
X = J( NRow( A ), 1 ) || XA || XB || XAB;
\end{verbatim}

**Inverse Matrices and Linear Systems**

JMP has the following functions for computing inverse matrices: \texttt{Inverse()}, \texttt{GInverse()}, and \texttt{Sweep()}. The \texttt{Solve()} function is used for solving linear systems of equations.

**Inverse or Inv**

The \texttt{Inverse()} function returns the matrix inverse for the square, nonsingular matrix argument. \texttt{Inverse()} can be abbreviated \texttt{Inv}. For a matrix \( A \), the matrix product of \( A \) and \texttt{Inverse}(A) (often denoted \( A(A^{-1}) \)) returns the identity matrix.

\begin{verbatim}
A = [5 6, 7 8];
AInv = Inv( A );
A*A Inv;
[1 0, 0 1]
\end{verbatim}

\begin{verbatim}
A = [1 2, 3 4];
AInv = Inverse( A );
A*AInv;
[1 1.110223025e-16, 0 1]
\end{verbatim}

**Note:** There can be small discrepancies in the results due to floating point limitations, as illustrated in the second example.

**GInverse**

The (Moore-Penrose) generalized inverse of a matrix \( A \) is any matrix \( G \) that satisfies the following conditions:

\begin{verbatim}
AGA=A
GAG=G
(AG)´ = AG
(GA)´ = GA
\end{verbatim}
The `GInverse()` function accepts any matrix, including non-square ones, and uses singular-value decomposition to calculate the Moore-Penrose generalized inverse. The generalized inverse can be useful when inverting a matrix that is not full rank. Consider the following system of equations:

\[
\begin{align*}
    x + 2y + 2z &= 6 \\
    2x + 4y + 4z &= 12 \\
    x + y + z &= 1
\end{align*}
\]

Find the solution to this system using the following script:

```
A = [1  2  2,  2  4  4,  1  1  1];
B = [6, 12, 1];
Show( GInverse( A ) * B );
GInverse(A) * B = [-4, 2.5, 2.5];
```

**Solve**

The `Solve()` function solves a system of linear equations. `Solve()` finds the vector `x` so that \(x = A^{-1}b\) where `A` equals a square, nonsingular matrix and `b` is a vector. The matrix `A` and the vector `b` must have the same number of rows. `Solve(A,b)` is the same as `Inverse(A)*b`.

```
A = [1  -4  2,  3  3  2,  0  4  -1];
b = [1, 2, 1];
x = Solve( A, b );
x = [-16.99999999999999999, 4.999999999999999999, 18.999999999999999999]
A*x;
A*x = [1, 2, 0.9999999999999997]
```

**Note:** There can be small discrepancies in the results due to floating point limitations, as illustrated in the example.

**Sweep**

The `Sweep()` function inverts parts (or *pivots*) of a square matrix. If you sequence through all of the pivots, you are left with the matrix inverse. Normally the matrix must be positive definite (or negative definite) so that the diagonal pivots never go to zero. `Sweep()` does not check whether the matrix is positive definite. If the matrix is *not* positive definite, then it still works, as long as no zero pivot diagonals are encountered. If zero (or near-zero) pivot diagonals are encountered on a full sweep, then the result is a g2 generalized inverse if the zero pivot row and column are zeroed.
About the Sweep Function

Suppose matrix $E$ consists of smaller matrix partitions, $A$, $B$, $C$, and $D$:

$$E = \begin{bmatrix} A & B \\ C & D \end{bmatrix}$$

The syntax for $\text{Sweep()}$ appears as follows:

$$\text{Sweep}(E, [...] );$$

[...] indicates partition $A$.

This produces the matrix result equivalent to the following:

$$\begin{bmatrix} A^{-1} & A^{-1}B \\ -CA^{-1} & D - CA^{-1}B \end{bmatrix}$$

Note the following:

- The submatrix in the $A$ position becomes the inverse.
- The submatrix in the $B$ position becomes the solution to $Ax = B$.
- The submatrix in the $C$ position becomes the solution to $xA = C$.

Use of the Sweep Function

$\text{Sweep()}$ is sequential and reversible:

- $A = \text{Sweep}(A, \{i, j\})$ is the same as $A = \text{Sweep}(\text{Sweep}(A, i), j)$. It is sequential.
- $A = \text{Sweep}(\text{Sweep}(A, i), i)$ restores $A$ to its original values. It is reversible.

If you have a cross-product matrix partitioned as follows:

$$C = \begin{bmatrix} X'X & X'y \\ y'X & y'y \end{bmatrix}$$

Then after sweeping through the indices of $X'X$, the result appears as follows:

$$\begin{bmatrix} (X'X)^{-1} & (X'X)^{-1}X'y \\ -yX(X'X)^{-1} & y'y - y'X(X'X)^{-1}X'y \end{bmatrix}$$

The partitions are recognizable to statisticians as follows:

- the least squares estimates for the model $Y = Xb + e$ in the upper right
- the sum of squared errors in the lower right
• a matrix proportional to the covariance of the estimates in the upper left

The **Sweep** function is useful in computing the partial solutions needed for stepwise regression.

The *index* argument is a vector that lists the rows (or equivalently the columns) on which you want to sweep the matrix. For example, if \( E \) is a 4x4 matrix, to sweep on all four rows to get \( E^{-1} \) requires these commands:

\[
\begin{bmatrix}
5 & 4 & 1 & 1 \\
4 & 5 & 1 & 1 \\
1 & 1 & 4 & 2 \\
1 & 1 & 2 & 4
\end{bmatrix}
\]

\[E = \begin{bmatrix} 5 & 4 & 1 & 1 \\ 4 & 5 & 1 & 1 \\ 1 & 1 & 4 & 2 \\ 1 & 1 & 2 & 4 \end{bmatrix};\]
\[\text{Sweep}( E, [1, 2, 3, 4] );\]
\[
\begin{bmatrix}
0.56 & -0.44 & -0.02 & -0.02 \\
-0.44 & 0.56 & -0.02 & -0.02 \\
-0.02 & -0.02 & 0.34 & -0.16 \\
-0.02 & -0.02 & -0.16 & 0.34
\end{bmatrix}
\]

\[\text{Inverse}( E ); // \text{notice that these results are the same}\]
\[
\begin{bmatrix}
0.56 & -0.44 & -0.02 & -0.02 \\
-0.44 & 0.56 & -0.02 & -0.02 \\
-0.02 & -0.02 & 0.34 & -0.16 \\
-0.02 & -0.02 & -0.16 & 0.34
\end{bmatrix}
\]


**Sweep()** is further demonstrated in the “ANOVA Example” on page 201.

### Determinant

The **Det()** function returns the determinant of a square matrix. The determinant of a 2 \( \times \) 2 matrix is the difference of the diagonal products, as demonstrated below. Determinants for \( n \times n \) matrices are defined recursively as a weighted sum of determinants for \( (n - 1) \times (n - 1) \) matrices. For a matrix to have an inverse, the determinant must be nonzero.

\[
\begin{vmatrix}
1 & 2 \\
3 & 5
\end{vmatrix}
= (1 \cdot 5) - (3 \cdot 2) = -1
\]

\[F = \begin{bmatrix} 1 & 2 \\ 3 & 5 \end{bmatrix};\]
\[\text{Det}( F );\]
\[-1\]

### Decompositions and Normalizations

This section contains functions that calculate eigenvalues and eigenvectors and functions that decompose matrices.
Eigenvalues

The Eigen() function performs eigenvalue decomposition of a symmetric matrix. Eigenvalue decompositions are used in many statistical techniques, most notably in principal components and canonical correlation, where the transformation associated with the largest eigenvalues are transformations that maximize variances.

Eigen() returns a list of matrices. The first matrix in the returned list is a column vector of eigenvalues; the second matrix contains eigenvectors as the columns.

\[ A = \begin{bmatrix} 5 & 4 & 1 & 1 \\ 4 & 5 & 1 & 1 \\ 1 & 1 & 4 & 2 \\ 1 & 1 & 2 & 4 \end{bmatrix}; \]

\[ \text{Eigen}( A ); \]

\{[10, 5, 2, 1][0.632455532033676 - 0.316227766016838 - 2.77555756156289e-16 -0.707106781186547, 0.632455532033676 - 0.316227766016837 -1.66533453693773e-16 0.707106781186548, 0.316227766016838 0.632455532033676 0.707106781186548 0, 0.316227766016837 0.632455532033676 - 0.707106781186547 0]\}

Since the function returns a list of matrices, you might want to assign it to a list of two global variables. That way, the column vector of eigenvalues is assigned to one variable, and the matrix of eigenvectors is assigned to another variable:

\{\text{evals, evecs} = \text{Eigen}( A );\}

For some \( n \times n \) matrix \( A \), eigenvalue decomposition finds all \( \lambda \) (lambda) and vectors \( x \), so that the equation \( Ax = \lambda x \) has a nonzero solution \( x \). The \( \lambda \)'s are called eigenvalues, and the corresponding \( x \) vectors are called eigenvectors. This is equivalent to solving \((A - \lambda I)x = 0\). You can reconstruct \( A \) from eigenvalues and eigenvectors by a statement like the following:

\[ \text{newA} = \text{evecs} * \text{Diag}( \text{evals} ) * \text{evecs}'; \]

\[ \begin{bmatrix} 5.00000000000000000001 & 4 & 1 & 1 \\ 4 & 5 & 1 & 1 \\ 1 & 1 & 4 & 2 \\ 1 & 1 & 2 & 4 \end{bmatrix} \]

Note the following about eigenvalues and eigenvectors:

- The eigenvector matrices are orthonormal, such that the inverse is the transpose: \( E^TE = EE' = I \).
- Eigenvectors are uniquely determined only if the eigenvalues are unique.
- Zero eigenvalues correspond to singular matrices.
- Inverses can be obtained by inverting the eigenvalues and reconstituting with the eigenvectors. Moore-Penrose generalized inverses can be formed by inverting the nonzero eigenvalues and reconstituting. (See “GInverse” on page 191.)

**Note:** You must decide whether a very small eigenvalue is effectively zero.

- The eigenvalue decomposition enables you to view any square-matrix multiplication as the following:
- a rotation (multiplication by an orthonormal matrix)
- a scaling (multiplication by a diagonal matrix)
- a reverse rotation (multiplication by the orthonormal inverse, which is the transpose),
or in notation:

\[ A \ast x = E' \ast \text{Diag}(M) \ast E \ast x; \]

\(E\) rotates, \(\text{Diag}(M)\) scales, and \(E'\) reverse-rotates.

**Cholesky Decomposition**

The Cholesky() function performs Cholesky decomposition. A positive semi-definite matrix \(A\) is re-expressed as the product of a nonsingular, lower-triangular matrix \(L\) and its transpose: \(L \ast L' = A\).

\[
E = \begin{bmatrix}
  5 & 4 & 1 & 1, \\
  4 & 5 & 1 & 1, \\
  1 & 1 & 4 & 2, \\
  1 & 1 & 2 & 4
\end{bmatrix};
\]
\[
L = \text{Cholesky}(E);
\]
\[
\begin{bmatrix}
  2.23606797749979 & 0 & 0 & 0, \\
  1.78854381999832 & 1.341640786499874 & 0 & 0, \\
  0.447213595499958 & 0.149071198499986 & 1.9436506316151 & 0, \\
  0.447213595499958 & 0.149071198499986 & 0.914659120760047 & 1.71498585142509
\end{bmatrix}
\]

To verify the results, enter the following:

\[
L \ast L';
\]

\[
\begin{bmatrix}
  5 & 4 & 1 & 1, \\
  4 & 5 & 1 & 1, \\
  1 & 1 & 4 & 2, \\
  1 & 1 & 2 & 4
\end{bmatrix}
\]

**About Cholesky Decomposition**

Cholesky() is useful for reconstituting expressions into a more manageable form. For example, eigenvalues are available only for symmetric matrices in JMP, so the eigenvalues of the product \(A \ast B\) could not be obtained directly. (Although \(A\) and \(B\) can be symmetric, the product is not symmetric.) However, you can usually rephrase the problem in terms of eigenvalues of \(L' \ast B \ast L\) where \(L\) is the Cholesky root of \(A\), which has the same eigenvalues.

Another use of Cholesky() is in reordering matrices within Trace() expressions. Expressions such as Trace\((A \ast B \ast A')\) might involve huge operations counts if \(A\) has many rows. However, if \(B\) is small and can be factored into \(L'\) by Cholesky, then it can be reformulated to Trace\((A \ast L \ast L' \ast A')\). The resulting matrix is equal to Trace\((L' \ast A \ast A')\). This expression involves a much smaller number of operations, because it consists of only the sum of squares of the \(AL\) elements.

Use the function Chol Update() to update a Cholesky decomposition. If \(L\) is the Cholesky root of a \(n \times n\) matrix \(A\), then after using cholUpdate\((L, C, V)\), \(L\) will be replaced with the Cholesky root of \(A + V \ast C \ast V'\). \(C\) is an \(m \times m\) symmetric matrix and \(V\) is an \(n \times m\) matrix.
Examples

Manually update the Cholesky decomposition, as follows:

```plaintext
exS = [16 1 0 11 -1 12, 1 11 -1 1 -1 1, 0 -1 12 -1 1 0, 11 1 -1 11 -1 9, -1 -1 1 -1 9 -1, 12 1 0 9 -1 12];
exAchol = Cholesky( exS ); // conducts the Cholesky decomposition
exV = [1 1, 0 0, 0 1, 0 0, 0 0, 0 1];
// adds two column vectors to the design matrix
exC = [1 0, 0 -1];
/* The first column vector is added to one of the rows in the design matrix. The second column vector is subtracted from one of the rows in the design matrix. */
exAnew = exS + exV * exC * exV';
exAcholnew = Cholesky( exAnew );
// updates the Cholesky decomposition manually
```

Instead of manual updating, use `Chol Update()` to update the Cholesky decomposition, as follows:

```plaintext
exAcholnew_test = Chol Update( exAchol, exV, exC );
// updates the Cholesky decomposition more efficiently
Show( exAcholnew_test );
exAcholnew_test =
[ 4 0 0 0 0 0,
 0.25 3.30718913883074 0 0 0 0, ...]
// results are the same as the manual process
Show( exAcholnew );
exAcholnew =
[ 4 0 0 0 0 0,
 0.25 3.30718913883074 0 0 0 0, ...]
```

Singular Value Decomposition

The `SVD()` function finds the singular value decomposition of a matrix. That is, for a matrix \( A \), `SVD()` returns a list of three matrices \( U, M, \) and \( V \), so that \( U^* \text{diag}(M) \text{diag}(V)^* = A \).

Note the following:

- When \( A \) is taller than it is wide, \( M \) is more compact, without extra zero diagonals.
- Singular value decomposition re-expresses \( A \) in the form \( U S V^* \), where:
  - \( U \) and \( V \) are matrices that contain orthogonal column vectors (perpendicular, statistically independent vectors)
  - \( S \) is a \( n \times n \) diagonal matrix containing the nonnegative square roots of the eigenvalues of \( A^*A \), the singular values of \( A \).
• Singular value decomposition is the basis of correspondence analysis.

Example

\[
A = \begin{bmatrix}
1 & 2 & 1 & 0 \\
2 & 3 & 0 & 1 \\
1 & 0 & 1 & 5 \\
0 & 1 & 5 & 1
\end{bmatrix};
\]

\{U, M, V\} = \text{SVD}( A );

\text{newA} = U \times \text{Diag}( M ) \times V';

\[
\begin{bmatrix}
1 & 2 & 0.999999999999997 & -2.99456640040496e-15 \\
2 & 3 & -1.17505831453979e-15 & 1 \\
0.999999999999997 & -2.16851276518826e-15 & 0.999999999999999 & 5 \\
2.22586706011274e-15 & 1 & 5 & 0.999999999999997
\end{bmatrix}
\]

Orthonormalization

The \text{Ortho()} function orthogonalizes the columns and then divides the vectors by their magnitudes to normalize them. This function uses the Gram-Schmidt method. The column vectors of orthogonal matrices are unit-length and are mutually perpendicular (their dot products are zero).

\[
B = \text{Ortho}( \begin{bmatrix} 1 & -1 \\ 1 & 0 \\ 0 & 1 \end{bmatrix} );
\]

\[
\begin{bmatrix}
0.408248290463863 & -0.707106781186548 & 0.408248290463863 & 0.707106781186548 \\
-0.816496580927726 & 3.14018491736755e-16
\end{bmatrix}
\]

To verify that these vectors are orthogonal, multiply \( B \) by its transpose, which should yield the identity matrix.

\[
C = B' \times B;
\]

\[
\begin{bmatrix} 1 & -3.119061760824e-16 \\ -3.119061760824e-16 & 1 \end{bmatrix}
\]

By default, vectors are normalized, meaning that they are divided by their magnitudes, which scales them to have length 1. Include the option \text{Scaled(0)} to turn scaling off:

\[
\text{Ortho}( \begin{bmatrix} 1 & -1 \\ 1 & 0 \\ 0 & 1 \end{bmatrix}, \text{Scaled(0)}) ;
\]

\[
\begin{bmatrix}
0.408248290463863 & -0.353553390593274 & 0.408248290463863 & 0.353553390593274 \\
-0.816496580927726 & 1.57009245868377e-16
\end{bmatrix}
\]

To create vectors whose elements sum to zero, include the \text{Centered(1)} option. This option is useful when constructing a matrix of contrasts.

\[
\text{result} = \text{Ortho}( \begin{bmatrix} 1 & -1 \\ 1 & 0 \\ 0 & 1 \end{bmatrix}, \text{Centered(1)} );
\]

\[
\begin{bmatrix}
0.408248290463863 & -0.707106781186548 & 0.408248290463863 & 0.707106781186548 \\
-0.816496580927726 & 3.14018491736755e-16
\end{bmatrix}
\]

To verify that the elements of each column sum to zero, premultiply by a vector of ones to sum the columns.

\[
J(1, 3) \times \text{result};
\]

\[
\begin{bmatrix} 1.11022302462516e-16 & 2.02996189274239e-16 \end{bmatrix}
\]
Orthogonal Polynomials

The `Ortho Poly()` function returns orthogonal polynomials for a vector of indices. The polynomial order is specified as a function argument. Orthogonal polynomials can be useful for fitting polynomial models where some regression coefficients might be highly correlated.

```r
Ortho Poly( [1, 2, 3], 2 );
[-0.707106781186548 0.408248290463862, 0 -0.816496580927726,
 0.707106781186548      0.408248290463864]
```

The polynomial order must be less than the dimension of the vector. Use the `Scaled(1)` option to produce vectors of unit length, as described in “Orthonormalization” on page 198.

QR Decomposition

`QR()` factorization is useful for numerically stable matrix work. `QR()` returns a list of two matrices. Here is an example:

```r
QR( [11 22, 33 44] );
```

Q and R hold the results. For a $m \times n$ matrix, `QR()` creates an orthogonal $m \times m$ matrix $Q$ and an upper triangular $m \times n$ matrix $R$, so that $X = Q^R$.

Update Inverse Matrices

To add or drop one or more rows in an inverse of an $M'M$ matrix, use the `Inv Update(S, X, w)` function. Updating inverse matrices is helpful in drop-1 influence diagnostics and also in candidate design evaluation.

Note the following:

- The first argument, $S$, is the matrix to be updated.
- The second argument, $X$, is the matrix of rows to be added or dropped.
- The third argument, $w$, is either 1 to add or -1 to delete the row or rows.
- Multiple rows can be added or deleted.

Using the `Inv Update(S, X, w)` function is equivalent to calculating the following:

```r
S - w * S * X` * Inv( I + w * X * S * X`) * X * S
```

Where $I$ is an identity matrix and $Inv(A)$ is an inverse matrix of $A$.

Build Your Own Matrix Operators

You can store your own operations in macros. See “Macros” on page 228 in the “Programming Methods” chapter. Similarly, you can create custom matrix operations. For example, you can make your own matrix operation called `Mag()` to find the magnitude of a vector, as follows:

```r
mag = Function( {x},
```
Similarly, you could create an operation called *Normalize* to divide a vector by its magnitude, as follows:

\[
\text{normalize} = \text{Function}(\{x\}, \\
\quad x / \sqrt{x^\top x})
\]

### Statistical Examples

This section contains statistical examples of using matrices.

#### Regression Example

Suppose that you want to implement your own regression calculation, rather than use the facilities built into JMP. Because of the compact matrix notation, it might require only a few lines of code:

\[
\begin{align*}
Y &= [98, 112.5, 84, 102.5, 102.5, 50.5, 90, 77, 112, 150, 128, 133, 85, 112]; \\
X &= [65.3, 69, 56.5, 62.8, 63.5, 51.3, 64.3, 56.3, 66.5, 72, 64.8, 67, 57.5, 66.5]; \\
X &= J(\text{N Row}(X), 1) || X; // put in an intercept column of 1s \\
\beta &= \text{Inv}(X^\top X) \times X^\top Y; // the least square estimates \\
\text{resid} &= Y - X \times \beta; // the residuals, Y - predicted \\
\text{sse} &= \text{resid}^\top \times \text{resid}; // sum of squared errors \\
\text{Show}(\beta, \text{sse});
\end{align*}
\]

This could be expanded into a script that gets its data from a data table, calculates additional results, and shows the results in a report window:

```plaintext
// open the data table
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

// get data into matrices
x = (\text{Column}("Age") \ll \text{Get Values}) || (\text{Column}("Height") \ll \text{Get Values});
X = J(\text{N Row}(x), 1, 1) || x;
\text{y} = \text{Column}("Weight") \ll \text{Get Values};

// regression calculations
\text{xpxi} = \text{Inv}(x^\top x);
\beta = \text{xpxi} \times x^\top \times y; // parameter estimates 
\text{resid} = y - x \times \beta; // residuals 
\text{sse} = \text{resid}^\top \times \text{resid}; // sum of squared errors 
\text{dfe} = \text{N Row}(x) - \text{N Col}(x); // degrees of freedom 
\text{mse} = \text{sse} / \text{dfe}; // mean square error, error variance estimate 
```
// additional calculations on estimates
stdb = Sqrt( Vec Diag( xpxi ) * mse ); // standard errors of estimates
alpha = .05;
qt = Students t Quantile( 1 - alpha / 2, dfe );
betau95 = beta + qt * stdb; // upper 95% confidence limits
betal95 = beta - qt * stdb; // lower 95% confidence limits
tratio = beta ./ stdb; // Student's T ratios
probt = ( 1 - TDistribution( Abs( tratio ), dfe ) ) * 2; // p-values

// present results
New Window( "Big Class Regression",
            Table Box( String Col Box( "Term",{"Intercept", "Age", "Height"} ),
                         Number Col Box( "Estimate", beta ),
                         Number Col Box( "Std Error", stdb ),
                         Number Col Box( "TRatio", tratio ),
                         Number Col Box( "Prob>|t|", probt ),
                         Number Col Box( "Lower95%", betal95 ),
                         Number Col Box( "Upper95%", betau95 ) ) );

ANOVA Example

You can implement your own one-way ANOVA. This example presents a problem involving a
dose and a response measurement. Therefore, this example solves the general linear model, as follows:

\[ Y = a + bX + e \]

Where:

- \( Y \) is a vector of responses
- \( a \) is the intercept term
- \( b \) is a vector of coefficients
- \( X \) is a design matrix for the factor
- \( e \) is an error term

\[
\text{factor} = [1, 2, 3, 1, 2, 3, 1, 2, 3];
\text{y} = [1, 2, 3, 4, 3, 2, 5, 4, 3];
\]

First, build a design matrix for the factor:

\[
\text{Design Nom}( \text{factor} );
[1 0, 0 1, -1 -1, 1 0, 0 1, -1 -1, 1 0, 0 1, -1 -1]
\]

Next, add a column of 1s to the design matrix for the intercept term. You can do this by
concatenating \( J \) and \text{Design Nom}(), as follows:

\[
x = J( 9, 1, 1 ) || \text{Design Nom}( \text{factor} );
\]
Now, to solve the normal equation, you need to construct a matrix $M$ with partitions:

\[
\begin{bmatrix}
X'X & X'y \\ 
y'X & y'y
\end{bmatrix}
\]

You can construct matrix $M$ in one step by concatenating the pieces, as follows:

\[
M = (x' \ast x \mid | x' \ast y ) \\
|/
( y' \ast x \mid | y' \ast y );
\]

\[
[9 0 0 27, \\
0 6 3 2, \\
0 3 6 1, \\
27 2 1 93]
\]

Now, sweep $M$ over all the columns in $X'X$ for the full fit model, and over the first column only for the intercept-only model:

```c
FullFit = Sweep( M, [1, 2, 3] ); // full fit model
InterceptOnly = Sweep( M, [1] ); // model with intercept only
```

Recall that some of the standard ANOVA results are calculated by comparing the results of these two models. This example focuses on the full fit model, which produces this swept matrix:

\[
[0.1111111111111111 0 0 3, \\
0 0.222222222222222222 -0.1111111111111111 0.3333333333333333, \\
0 -0.1111111111111111 0.22222222222222222 0, \\
-3 -0.3333333333333333 0 11.33333333333333]
\]

Examine the model coefficients from the upper right partition of the matrix. The lower left partition is the same, except that the signs are reversed: 3, 0.333, 0. The results can be interpreted as follows:

- The coefficient for the intercept term is 3.
- The coefficient for the first level of the factor is 0.333.
- The coefficient for the second level is 0.
- Because of the use of `Design Nom()`, the coefficient for the third level is the difference, –0.333.
- The lower right partition of the matrix holds the sum of squares, 11.333.
You could modify this into a generalized ANOVA script by replacing some of the explicit values in the script with arguments. These results match those from the Fit Model platform. See Figure 7.1.

**Figure 7.1** ANOVA Report Within Fit Model

![ANOVA Report Within Fit Model](image)

Construct the report in Figure 7.1 as follows:

1. Build a data table (described in the “Data Tables” chapter on page 275):
   ```javascript
   dt = New Table( "Data" );
   dt << New Column( "y", Set Values( [1, 2, 3, 4, 3, 2, 5, 4, 3] ) );
   dt << New Column( "factor", "Nominal", Values( [1, 2, 3, 1, 2, 3, 1, 2, 3] ) );
   
   2. Run a model (described in “Launch the Analysis and Save the Script to a Window” on page 380 in the “Scripting Platforms” chapter):
   ```javascript
   obj = Fit Model(
       Y( :y ),
       Effects( :factor ),
       Personality("Standard Least Squares"),
       Run(
           y << {Plot Actual by Predicted( 0 ), Plot Residual by Predicted( 0 ),
                  Plot Effect Leverage( 0 )}
       )
   );
   
   3. Use JSL techniques for navigating displays (described in “Display Box Object References” on page 426 in the “Display Trees” chapter):
   ```javascript
   ranova = obj << Report;
   ranova[Outline Box( 6 )] << Close( 0 );
   ```
Associative Arrays

An associative array maps unique keys to values that can be non-unique. An associative array is also called a dictionary, a map, a hash map, or a hash table. Keys are placed in quotes. The value associated with a key can be a number, date, matrix, list, and so on.

**Note:** You can use matrices as both keys and values, or lists as both keys and values, but you cannot mix the two. In other words, you cannot use a matrix as a key and a list as a value, or the other way around.

Though associative arrays are not usually ordered, in JMP, keys are returned in alphanumeric order for the purpose of iteration and serialization.

For very large lists, using an associative array instead is more efficient and faster.

Create Associative Arrays

To create an empty associative array, use the `Associative Array()` function or `=>`.

```julia
    cary = Associative Array();
    cary = [ => ];
    [ => ]
```

Keys and values can be any JSL objects. Items can be added and changed with subscripting, as follows:

```julia
    cary = Associative Array();
    cary["state"] = "NC";
    cary["population"] = 116234;
    cary["weather"] = "cloudy";
    cary["population"] += 10;
    cary["weather"] = "sunny";
    cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};
```

Default Values

A default value determines the value of a key that does not exist in an associative array. If you try to access a key that does not exist in an associative array, an error results. If you define a
default value for your associative array, accessing a key that does not exist results in the following:

- adds the key to the associative array
- assigns the default value to the new key
- returns the new key’s (default) value instead of an error

If you construct an associative array from a list of strings without assigning values to the keys, then the keys are assigned values of 1. The default value for the associative array is set to 0.

To set the default value:

```cary = Associative Array();
cary << Set Default Value( "Cary, NC" );```

To determine whether there is a default value set for an associative array, use the `<<Get Default Value` message.

```cary << Get Default Value;
"Cary, NC"
```

If there is no default value, `Empty()` is returned.

Besides the `Set Default Value` message, a default value can be set in the literal constructor using `=>value` without a key.

```counts = ["a" => 10,
  "b" => 3,
  => 0]; // default value of 0
counts["c"] += 1;
Show( counts );
  counts = ["a" => 10, "b" => 3, "c" => 1, => 0];
```

In the first line, the default value is set to 0. In the second line, the key "c" does not exist in `counts`. In the output, the key "c" is created with the default value of 0 and then incremented by 1.

### Associative Array Constructors

Create an empty associative array:

```map = [=>];
map = Associative Array();```

Create an empty associative array with a default value:

```map = [=>0];
map = Associative Array( 0 );```

Create an associative array with specific values:

```map = ["yes" => 0, "no" => 1];```
Create an associative array with specific values with a default value:

```javascript
map = {"yes" => 0, "no" => 1, => 2};
```

Create an associative array from a list that contains two lists of a key-value pair:

```javascript
map = Associative Array( {"yes", 0}, {"no", 1});
```

Create an associative array from a list that contains two lists of a key-value pair with a default value:

```javascript
map = Associative Array( {"yes", 0}, {"no", 1}, 2 );
```

Create an associative array from a list of keys and a list of values:

```javascript
map = Associative Array( {"yes", "no"}, {0, 1} );
```

Create an associative array from a list of keys and a list of values with a default value:

```javascript
map = Associative Array( {"yes", "no"}, {0, 1}, 2 );
```

Create an associative array from two column references. The first column contains the keys and the second contains the values.

```javascript
map = Associative Array( :name, :height );
```

Create an associative array from two column references with a default value:

```javascript
map = Associative Array(:name, :height, .);
```

Create an associative array from a single list of keys or a single column reference of keys with a default value of 0:

```javascript
set = Associative Array( {"yes", "no"} );
set = Associative Array( :name );
```

## Work with Associative Arrays

### Find the Number of Keys

To determine the number of keys that an associative array contains, use the `N Items()` function.

```javascript
cary = Associative Array();
cary["state"] = "NC";
cary["population"] = 116234;
cary["weather"] = "cloudy";
cary["population"] += 10;
cary["weather"] = "sunny";
cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};
N Items( cary );
```
Add and Delete Keys and Values

To add or delete key-value pairs from an associative array, use the following functions:

- **Insert()**
- **Insert Into()**
- **Remove()**
- **Remove From()**

Note the following:

- **Insert()** and **Remove()** return a named copy of the given associative array with the key-value pair added or removed.
- **Insert Into()** and **Remove From()** add or remove the key-value pairs directly from the given associative array.
- **Insert()** and **Insert Into()** take three arguments: the associative array, a key, and a value.
- **Remove()** and **Remove From()** take two arguments: the associative array and a key.
- If you insert a key with no value provided, the key is assigned a value of 1.

Examples

The following examples illustrate **Insert()** and **Insert Into()**:

```plaintext
newcary = Insert( cary, "time zone", "Eastern" );
Show( cary, newcary );

cary = Associative Array({{"high schools", {"Cary", "Green Hope", "Panther Creek"}}, {{"population", 116244}, {{"state", "NC"}, {{"weather", "sunny"}}}});
newcary = Associative Array({{"high schools", {"Cary", "Green Hope", "Panther Creek"}}, {{"population", 116244}, {{"state", "NC"}, {{"time zone", "Eastern"}, {{"weather", "sunny"}}}}});

Insert Into(cary, "county", "Wake");
Show( cary );
```

Note that `aa << Insert` is a message sent to an associative array that does the same thing as the function **Insert Into()**. For example, these two statements are equivalent:

```plaintext
cary << Insert("county", "Wake");
Insert Into( cary, "county", "Wake" );
```

The following examples illustrate **Remove()** and **Remove From()**:

```plaintext
newcary = Remove( cary, "high schools" );
Show( cary, newcary );
cary = Associative Array({{"county", "Wake"}, {{"high schools", {"Cary", "Green Hope", "Panther Creek"}}}, {{"population", 116244}, {{"state", "NC"}, {{"time zone", "Eastern"}, {{"weather", "sunny"}}}}});
```
{"weather", "sunny"});

Remove From( cary, "weather" );
Show( cary);

cary = Associative Array({"high schools", {"Cary", "Green Hope", "Panther Creek"}}, {"population", 116244}, {"state", "NC"});

Note that aa << Remove is a message sent to an associative array that does the same thing as the function Remove From(). For example, these two statements are equivalent:

cary << Remove( "weather" );
Remove From( cary, "weather" );

Find Keys or Values in an Associative Array

To determine whether a certain key is contained within an associative array, use the Contains() function.

cary = Associative Array();
cary["state"] = "NC";
cary["population"] = 116234;
cary["weather"] = "cloudy";
cary["population"] += 10;
cary["weather"] = "sunny";
cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};
Contains(cary, "high schools");
1
Contains(cary, "lakes");
0

To obtain a list of all keys contained in an associative array, use the << Get Keys message.

cary << Get Keys;
{"high schools", "population", "state", "weather"}

To obtain a list of all values contained in an associative array, use the <<Get Values message.

cary << Get Values;
{"Cary", "Green Hope", "Panther Creek"}, 116244, "NC", "sunny"}

If you want to see only the values for certain keys, you can specify them as arguments. The keys must be given as a list.

cary << Get Values("state", "population");
{"NC", 116244}

To see a value for a single key, use the <<Get Value message. Specify only one key and do not place it in a list.

cary << Get Value("weather");
"sunny"
To obtain a list of all key-value pairs in an associative array, use the <<Get Contents message.

```plaintext
cary << Get Contents;
  {{"high schools", {"Cary", "Green Hope", "Panther Creek"}},
   {"population", 116244},
   {"state", "NC"},
   {"weather", "sunny"}}
```

**Note:** Using the <<Get Contents message, the returned list does not include the default value. Keys are listed alphabetically.

### Iterate through an Associative Array

To iterate through an associative array, use the <<First and <<Next messages. <<First returns the first key in the associative array. <<Next(key) returns the key that follows the key that is given as the argument.

The following example removes all key-value pairs from the associative array `cary`, leaving an empty associative array:

```plaintext
currentkey = cary << First;
total = N Items( cary );
For( i = 1, i <= total, i++,
    nextkey = cary << Next( currentkey );
    Remove From( cary, currentkey );
    currentkey = nextkey;
);
Show( cary );
cary = [=>];
```

### Applications for Associative Arrays

You can use associative arrays to quickly and efficiently perform other tasks.

#### Get the Unique Values from a Data Table Column

A key can exist only once in an associative array, so putting a column’s values into one automatically results in the unique values. For example, the Big Class.jmp sample data table contains 40 rows. To see how many unique values are in the column `height`, run this script:

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
unique heights = Associative Array( dt:height );
nitems( unique heights );
17
```

There are only 17 unique values for `height`. You can use those unique values by getting the keys:

```plaintext
unique heights << Get Keys;
```
Note: This is possible because you can use any JMP data type as keys in an associative array, not only strings.

Using an associative array to discover unique values in a column is efficient and fast. The following script takes some time to create a data table with 100,000 rows. Finding the 39 unique values takes very little time.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
nms = dt:name << Get Values;
dtbig = New Table( "Really Big Class",
    New Column( "name",
        Character,
        Set Values( nms[J( 100000, 1, Random Integer( N Items( nms ) ) ] ) )
    );
Wait( 0 );
t1 = Tick Seconds();
Write(
    "\!N# names from Really Big Class = ",
    N Items( Associative Array( dtbig:name ) ),
    ", elapsed time=",
    Tick Seconds() - t1
);
# names from Really Big Class = 39, elapsed time=0.116666666639503
```

Sort a Column’s Values in Lexicographic Order

Because keys are ordered lexicographically, putting the values into an associative array also sorts them. For example, the <<Get Keys message returns the keys (unique values of the names column) in ascending order:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
unique names = Associative Array( dt:name );
unique names << Get Keys;
```

Compare Columns in Two Different Data Tables

Using associative arrays, determining which values in one column are not in another column (or determining which values are in both columns) is fast. For example, given two data tables with information about countries, which countries are in both data tables?
Place the columns of each data table that contain country names into associative arrays:

```javascript
dt1 = Open( "$SAMPLE_DATA/BirthDeathYear.jmp" );
dt2 = Open( "$SAMPLE_DATA/World Demographics.jmp" );
aa1 = Associative Array( dt1:Country );
aa2 = Associative Array( dt2:Territory );
```

Use `N Items()` to see how many countries appear in each data table:

```javascript
N Items(aa1);
23
N Items(aa2);
238
```

Use the `<<Intersect` message to find the common values:

```javascript
aa1 = Associative Array( dt1:Country );
aa1 << Intersect( aa2 );
```

Look at the results:

```javascript
Show(N Items(aa1), aa1 << Get Keys);
N Items(aa1) = 21;
```

This example uses a set operation called intersection. For more examples of using set operations with associative arrays to compare values, see “Associative Arrays in Set Operations” on page 214.

### Associative Arrays in Graph Theory

You can use associative arrays for graph theory data structures, such as the following directed graph example:

```javascript
g = Associative Array();
g[1] = Associative Array({1, 2, 4});
g[2] = Associative Array({1, 3});
g[3] = Associative Array({4, 5});
g[4] = Associative Array({4, 5});
g[5] = Associative Array({1, 2});
```

This is a two-level associative array. The associative array `g` contains five associative arrays (1, 2, 3, 4, and 5). In the containing array `g`, both the keys (1-5) and the values (the arrays that define the map) are important. In the inner associative arrays, the values do not matter. Only the keys are important.

The associative array represents the graph shown in Figure 7.2 as follows:

- node 1 is incident on nodes 1, 2, and 4
• node 2 is incident on nodes 1 and 3
• node 3 is incident on nodes 4 and 5
• node 4 is incident on nodes 4 and 5
• node 5 is incident on nodes 1 and 2

**Figure 7.2** Example of a Directed Graph

The following depth-first search function can be used to traverse this graph, or any other directed graph represented as an associative array:

```plaintext
dfs = Function( {ref, node, visited},
                {chnode, tmp},
                Write( "\Node: ", node, ", ", ref[node] \ Get Keys );
    visited[node] = 1;
    tmp = ref[node];
    chnode = tmp \ first;
    While( !Is Missing( chnode ),
        If( !visited[chnode],
            visited = Recurse( ref, chnode, visited )
        );
        chnode = tmp \ Next( chnode );
    );
    visited;
);
```

Note the following:
• The first argument is the associative array that contains the map structure.
• The second argument is the node that you want to use as the starting point.
• The third argument is a vector that the function uses to keep track of nodes visited.
To see how the preceding example works, add the following expression to the end of the script:

```
dfs( g, 2, J( N Items( g << Get Keys ), 1, 0 ) );
```

The output is as follows:

```
Node 2: {1, 3}
Node 1: {1, 2, 4}
Node 4: {4, 5}
Node 5: {1, 2}
Node 3: {4, 5}
[1, 1, 1, 1, 1]
```

The first five output lines show that starting from node 2, you can reach all the other nodes in the order in which they are listed. Each node also lists the nodes it is incident on (the keys). The value for each key is 1. The final line is a matrix that shows that you can reach each node from 2. If there were nodes that could not be reached from node 2, their values in the matrix would be 0.

Here is how to read the traversal of the nodes:

1. Start at node 2 and go to node 1.
2. From node 1, go to node 4.
3. From node 4, go to node 5.
4. From node 5, go back to node 2, and then to node 3.

**Map Script**

Here is the script that produced the map shown in Figure 7.2.

```
New Window( "Directed Graph",
  Graph Box(   
    Frame Size( 300, 300 ),
    X Scale( -1.5, 1.5 ),
    Y Scale( -1.5, 1.5 ),
    Local( {n = N Items( g ), k = 2 * Pi() / n, r, i, pt, from, to, 
      edge, v, d},
      Fill Color( "green" );
      Pen Size( 3 );
      r = 1 / (n + 2);
      For( i = 1, i <= n, i++,
       pt = Eval List( {Cos( k * i ), Sin( k * i )} );
       edges = g[i];
       For( edge = edges << First, !Is Empty( edge ),
        edge = edges << Next( edge ),
        to = Eval List( {Cos( k * edge ), Sin( k * edge )} );
        If( i == edge,
          Circle( Eval List( 1.2 * pt ), 0.9 * r ), // else
```
\[ v = pt - to; \]
\[ d = \sqrt{\sum(v \cdot v)}; \]
\[ \{\text{from}, \text{to}\} = \text{Eval List}(\]
\[ \{pt \cdot (d - r) / d + \text{to} \cdot r / d, pt \cdot r / d + \text{to} \cdot \]
\[ (d - r) / d\} \]
\[ \}; \]
\[ \text{Arrow(from, to);} \]
\[ \}; \]
\[ \text{Circle(pt, r, "fill");} \]
\[ \text{Text(Center Justified, pt - \{0, 0.05\}, Char(i)}); \]
\[ \}; \]
\[ \}; \]

**Associative Arrays in Set Operations**

You can also use associative arrays to perform set operations. The following examples show how to take a union of two sets, a difference of two sets, and an intersection of two sets.

First, create three sets and view them in the log:

```plaintext
set_y = Associative Array(\{"chair", "person", "relay", "snake", "tripod"\});
set_z = Associative Array(\{"person", "snake"\});
set_w = Associative Array(\{"apple", "orange"\});
// write the sets to the log
Write(\n"!NExample:!N\tset_y = ",
set_y << Get Keys,
"!N\tset_z = ",
set_z << Get Keys,
"!N\tset_w = ",
set_w << Get Keys);
Example:
set_y = \{"chair", "person", "relay", "snake", "tripod"\}
set_z = \{"person", "snake"\}
set_w = \{"apple", "orange"\}
```

**Union Operation**

To find the union of two sets, insert one set into the other:

```plaintext
set_z << Insert(set_w);
Write(\n"!N\tUnion operation (set_w, set_z):,\tset_z = ", set_z << Get Keys);
Union operation (set_w, set_z):
set_z = \{"apple", "orange", "person", "snake"\}
```
Difference Operation

To find the difference of two sets, remove one set from the other:

```
set_y << Remove( set_z );
Write( "\N\NDifference operation (set_z from set_y):\tset_y = ", set_y
<< Get Keys );
Difference operation (set_z from set_y):
set_y = {"chair", "relay", "tripod"}
```

Intersect Operation

To find the intersection of two sets, use the `aa << Intersect` message.

```
set_w << Intersect( set_z );
Write( "\N\NIntersect operation (set_w, set_z):\tset_w = ", set_w << Get
Keys );
Intersect operation (set_w, set_z):
set_w = {"apple", "orange"}
```

Example of Using Set Operations

Given a list of names, which of them are not contained in Big Class.jmp? You can find the answer by taking the difference of the two sets of names.

1. Get the list of names and open the data table:
   ```
names list = {"ROBERT", "JEFF", "CHRIS", "HARRY"};
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
```
2. Put the list of names into an associative array:
   ```
names = Associative Array( names list );
```
3. Perform a difference operation by removing the column values from your list:
   ```
names << Remove( Associative Array( dt:name ) );
```
4. Look at the result:
   ```
Write( "\NWhich of {ROBERT, JEFF, CHRIS, HARRY}, is not in Big Class = ",
names << Get Keys );
Which of {ROBERT, JEFF, CHRIS, HARRY}, is not in Big Class = {"HARRY", "JEFF"}
```
This chapter includes advanced techniques, such as throwing and catching exceptions, encrypting scripts, and using complex expressions.
Lists and Expressions

Stored expressions

An expression is something that can be evaluated. The first section of the chapter, “Rules for Name Resolution” on page 92 in the “JSL Building Blocks” chapter, discussed how JMP evaluates expressions. Now you must consider when JMP evaluates expressions.

JMP tends to evaluate things as soon as it possibly can, and it returns a result. If an expression is on the right side of an assignment, the result is what is assigned. Usually, that is what you want and expect, but sometimes you need to be able to delay evaluation.

Quoting and unquoting expressions

The operators to control when expressions are evaluated are Expr and Eval, which you should think of as the procrastination and eager operators. Expr just copies its argument as an expression, rather than evaluating it. Eval does the opposite: it evaluates its argument, and then takes that result and evaluates it again.

Expr and Eval can be thought of as quoting and unquoting operators, telling JMP when you mean the expression itself, and when you mean the result of evaluating the expression.

The following examples all assume these two assignments:

\[ x = 1; \ y = 20; \]

If you assign the expression \( x+y \) to \( a \), quoting it as an expression with Expr, then whenever \( a \) is evaluated, it evaluates the expression using the current values of \( x \) and \( y \) and returns the result. (Exceptions are the utilities Show, Write, and Print, which do not evaluate expressions for pure name arguments.)

\[
x = 1; \ y = 20; \\
a = \text{Expr}( x + y ); \\
a; \\
21
\]

If you want the expression that is stored in the name, rather than the result of evaluating the expression, use the NameExpr function. See “Retrieve a Stored Expression, Not its Result” on page 220.

\[
x = 1; \ y = 20; \\
\text{Show( NameExpr( a ) );} \\
\text{NameExpr(a) = x + y}
\]

If you assign an extra level of expression-quoting, then when \( a \) is evaluated, it unpacks one layer and the result is the expression \( x+y \).

\[
x = 1; \ y = 20; \\
a = \text{Expr( Expr( x + y ) );}
\]
Scripting Guide Lists and Expressions

Show( a );

\[ a = \text{Expr}(x + y) \]

If you want the value of the expression, then use \texttt{Eval} to unpack all layers:

\[ x = 1; \ y = 20; \]
\[ \text{Show( Eval( a ) );} \]
\[ \texttt{Eval(a)} = 21 \]

You can do this to any level, for example:

\[ x = 1; \ y = 20; \]
\[ a = \text{Expr( Expr( Expr( Expr( x + y ) ) ) )}; \]
\[ b = a; \]
\[ \text{Expr( Expr( x + y ) )} \]
\[ c = \text{Eval( a )}; \]
\[ \text{Expr( x + y )} \]
\[ d = \text{Eval( Eval( a ) );} \]
\[ x+y \]
\[ e = \text{Eval( Eval( Eval( a ) ) );} \]
\[ 21 \]

**Quote an expression as a string**

The JSL \texttt{Quote()} function returns the contents of an expression as a quoted string. Comments and white space in the string are preserved. Syntax coloring is also applied to the output.

The following script is an example:

\[ x = \text{JSL Quote( /* Begin quote. */} \]
\[ \text{For } (i = 1, i <= 5, i++, \]
\[ \text{// Print the value of i.} \]
\[ \text{Print( i );} \]
\[ ); \]
\[ \text{// End expression.} \]
\[ ); \]
\[ \text{Show( x );} \]

In the output, the contents of the JSL \texttt{Quote()} function are enclosed in quotes.

\[ x = " /* Begin quote. */} \]
\[ \text{For } (i = 1, i <= 5, i++, \]
\[ \text{// Print the value of i.} \]
\[ \text{Print(i);} \]
\[ ); \]
\[ \text{// End expression.} \]
\[ "; \]

**Store scripts in global variables**

The main use of \texttt{Expr} is to be able to store scripts (such as macros) in global variables.

\[ \text{dist} = \text{Expr( Distribution( Column( height ) ) );} \]
Now when you want to do the script, just mention the symbol:

    dist;

You could even put it in a loop to do it many times:

    For( i = 0, i < 10, i = i + 1, dist );

You can use Eval() to evaluate an expression explicitly:

    Eval( dist );

Note, however, that in column formulas, Eval() only works if it is outermost in the formula. So, for example,

    Formula( Log( Eval( Column Name( i ) ) ) );

would generate an error. Instead, use:

    Formula( Eval( Substitute( Expr( Log( xxx ) ), Expr( xxx ), Column Name( i ) ) ) );

As another example,

    Formula( Eval( Column Name( i ) ) + 10 );

generates an error, since Eval() is actually under the Add function. Instead, use:

    Formula(Eval(Substitute(Expr(xxx+10), Expr(xxx), column name(i))))

Retrieve a Stored Expression, Not its Result

What if you wanted the symbolic value of a global (such as the expression Distribution(Column(height)) stored in dist above), rather than the evaluation of it (the actual launched platform)? The Name Expr function does this. Name Expr retrieves its argument as an expression without evaluating it, but if the argument is a name, it looks up the name’s expression and uses that, unevaluated.

Expr returns its argument exactly, whereas Name Expr looks up the expression stored in its argument. Name Expr “unpacks” just one layer to get the expression, but does not keep unpacking to get the result.

For example, you would need to use this if you had an expression stored in a name and you wanted to edit the expression:

    popVar = Expr( Summation( i = 1, N Row(), (y[i] - Col Mean( y )) ^ 2 / N Row() ) );

    Summation( i = 1, N Row(), (y[i] - Col Mean( y )) ^ 2 / N Row() )

    unbiasedPopVar = Substitute( Name Expr( popVar ), Expr( Wild()/N Row() ), Expr( (y[i] - Col Mean( y )) ^ 2 / ( N Row() - 1 ) ) );

    Summation( i = 1, N Row(), (y[i] - Col Mean( y )) ^ 2 / ( N Row() - 1 ) )
Compare x, \texttt{Expr(x)}, \texttt{NameExpr(x)}, and \texttt{Eval(x)} after submitting this script:

\begin{verbatim}
  a = 1; b = 2; c = 3;
  x = \texttt{Expr(a + b + c)};
\end{verbatim}

\begin{table}
\centering
\caption{Compare \texttt{Eval}, \texttt{Name Expr}, and \texttt{Expr}}
\begin{tabular}{l|l}
\hline
\textbf{Command and result} & \textbf{Explanation} \\
\hline
\texttt{x;} & Evaluates x to the expression \(a+b+c\), and then evaluates the expression, returning the result, 6 (unpacks all layers). \\
\texttt{6} & \texttt{Eval( x );} & Equivalent to simply calling \(x\). Evaluates \(x\) to the expression \(a+b+c\), and then evaluates the expression, returning the result, 6 (unpacks all layers). \\
\texttt{NameExpr( x );} & Returns the expression that was stored in \(x\), which is \(a+b+c\) (unpacks the outside layer). \\
\texttt{a+b+c} & \texttt{Expr( x );} & Returns the expression \(x\) (packs one layer). \\
\texttt{x} & \texttt{Head( expressionArg )} returns the head of the expression without any arguments. If the expression is an infix, prefix, or postfix special character operator, then it is returned as the functional equivalent. \\
\end{tabular}
\end{table}

JSL also supports functions to access and traverse expressions, all of them either a name or a literal expression as an argument. In the following, \texttt{expressionArg} is either a single name or a compound expression to be taken literally.

\texttt{NArg(expressionArg)} finds the number of arguments in \texttt{expressionArg}.

The \texttt{expressionArg} can be a name holding an expression, an expression evaluated to an expression, or a literal expression quoted by \texttt{Expr()}.  

\texttt{NArg(name)} obtains the expression held in \texttt{name} (it is not evaluated) and returns the number of arguments

\texttt{NArg(expression)} evaluates \texttt{expression} and returns the number of arguments

\texttt{NArg(Expr(expression))} returns the number of arguments to literal expression.

For example, if \texttt{aExpr} = \{\texttt{a+b}, \texttt{c}, \texttt{d}, \texttt{e+f+g}\};

- \texttt{NArg(aExpr)} results in 4.
- \texttt{NArg(Arg(aExpr, 4))} results in 3.
- \texttt{NArg(Expr({1, 2, 3, 4}))} results in 4.

\texttt{Head(expressionArg)} returns the head of the expression without any arguments. If the expression is an infix, prefix, or postfix special character operator, then it is returned as the functional equivalent.

The \texttt{expressionArg} can be a name holding an expression, an expression evaluated to an expression, or a literal expression quoted by \texttt{Expr()}.  

For example, if aExpr = expr(a+b);

- \( r = \text{Head}(\text{aExpr}) \) results in \( \text{Add()} \).
- \( r = \text{Head}(\text{Expr}(\text{sqrt}(r))) \) results in \( \text{Sqrt()} \).
- \( r = \text{Head}(\{1,2,3\}) \) results in \( \{\} \).

\( \text{Arg}(\text{expressionArg}, \text{indexArg}) \) extracts the specified argument of the symbolic expression, resulting in an expression.

For example,
\( \text{Arg}(\text{expressionArg}, i) \) extracts the \( i \)th argument of \( \text{expressionArg} \)

The \( \text{expressionArg} \) can be a name holding an expression, an expression evaluated to an expression, or a literal expression quoted by \( \text{Expr()} \).

- \( \text{Arg}(\text{name}, i) \) obtains the expression held in \( \text{name} \) (it is not evaluated) and finds the \( i \)th argument
- \( \text{Arg}(\text{expression}, i) \) evaluates \( \text{expression} \) and finds the \( i \)th argument
- \( \text{Arg}(\text{Expr}(\text{expression}), i) \) finds the \( i \)th argument of \( \text{expression} \)

As another example, if aExpr = Expr(12+13*sqrt(14-15));

- \( \text{Arg}(\text{aExpr}, 1) \) yields 12
- \( \text{Arg}(\text{aExpr}, 2) \) yields 13*sqrt(14-15)
- \( \text{Arg}(\text{Expr}(\text{aExpr}), 2) \) yields 13*sqrt(14-15)

To extract an argument of an argument inside an expression, you can nest \( \text{Arg} \) commands:

- \( \text{Arg}(\text{Arg}(\text{aExpr}, 2), 1) \) yields the first argument within the second argument of \( \text{aExpr} \), or 13.
- \( \text{Arg}(\text{Arg}(\text{aExpr}, 2), 2) \) yields Sqrt( 14 - 15 )
- \( \text{Arg}(\text{Arg}(\text{Arg}(\text{aExpr}, 2), 2), 1) \) yields 14 - 15
- \( \text{Arg}(\text{Arg}(\text{Arg}(\text{aExpr}, 2), 2), 3) \) yields Empty()

Here is a description of how the last example line unwraps itself:

1. The inner \( \text{Arg} \) statement is evaluated.
   \( \text{Arg}(\text{aExpr}, 2) \)
   \( 13 * \text{Sqrt}( 14 - 15 ) \)
2. Then the next one is evaluated.
   \( \text{Arg}(\text{Arg}(\text{aExpr}, 2), 2) \)
   // this is equivalent to \( \text{Arg}(\text{Expr}(13 * \text{Sqrt}( 14 - 15 )), 2) \)
   \( \text{Sqrt}( 14 - 15 ) \)
3. Finally, the outer \( \text{Arg} \) is evaluated.
   \( \text{Arg}(\text{Arg}(\text{Arg}(\text{aExpr}, 2), 2), 3) \)
Scripting Guide Lists and Expressions

// this is equivalent to Arg (Expr (Sqrt( 14 - 15 ) ), 3)
Empty()

There is only one element to the Sqrt expression, so a request for the third argument yields
Empty(). To access the two arguments inside the Sqrt expression, try this:

Arg(Arg(Arg(aExpr,2),2),1),2);

15

HeadName(expressionArg) returns the name of the head of the expression as a string. If the
expression is an infix, prefix, postfix, or other special character operator, then it is returned as
the functional equivalent.

The expressionArg can be a name holding an expression, an expression evaluated to an
expression, or a literal expression quoted by Expr().

For example, if aExpr = expr(a+b);

• r = HeadName (aExpr) results in "Add".
• r = HeadName (Expr(sqrt(r))) results in "Sqrt".
• r = HeadName ({1,2,3}) results in "List".

In previous versions of JMP, other versions of Arg, Narg, Head, and HeadName were
implemented, called ArgExpr, NArgExpr, HeadExpr, and HeadNameExpr, respectively. These did
the same thing, but did not evaluate their argument. These forms are now deprecated and will
not be documented in future versions.

Making lots of substitutions

Eval Insert is for the situation where you want to make a lot of substitutions, by evaluating
expressions inside a character string. In Perl, this is called interpolation.

With Eval Insert, you specify characters that delimit the start and end of an expression, and
everything in between is evaluated and expanded.

There are two functions, one to return the result, the other to do it in-place.

resultString = EvalInsert( string with embedded
expressions,startDelimiter,endDelimiter )
EvalInsertInto( string l-value with embedded
expressions,startDelimiter,endDelimiter )

The delimiter is optional. The default start delimiter is "^". The default end delimiter is the
start delimiter.

xstring = "def";
r = Eval Insert( "abc^xstring^ghi" ); // results in "abcdefghi">

r = "abc^xstring^ghi"; // in-place evaluation
Eval Insert Into( r ); // r now has "abcdefghi";
// with specified delimiter
r = Eval Insert( "abc%\text{string}%ghi","%" ); // result is "abcdefghi";

// with different start and end delimiters
r = Eval Insert( "abc[\text{string}]ghi","[","]" ); // result is "abcdefghi";

When a numeric value contains locale-specific formatting, include the <<Use Locale(1) option. The following example substitutes a comma for the decimal point based on the computer's locale setting.

Eval Insert( "^1.2^", <<Use Locale(1) );

Evaluate expressions inside lists

Eval List evaluates expressions inside a list and returns a list with the results:

\[
x = \{ 1 + 2, 3 + 4 \};
y = \text{Eval List}( x ); \quad \text{// result in } y \text{ is } \{3,7}\]

Eval List is useful for loading the list of user choices returned by Column Dialog or New Window with the Modal argument.

Evaluate expressions inside expressions

Eval Expr() evaluates only the inner expressions and returns an expression that contains the results of the evaluation. By comparison, Eval evaluates the inner expressions, takes the results, and then evaluates it again.

Suppose that a data table contains a column named X3. Here is an example of using Eval Expr() to evaluate the inner expression first:

\[
x = \text{Expr( Distribution( Column( \text{Expr("X" || Char( i ))) ) ) );}
\]

\[
i = 3;
y = \text{Eval Expr}( x ); \quad \text{// returns Distribution( Column( "X3" ) )}
\]

To evaluate further, you need to either call the result in a subsequent step, or else put Eval() around the Eval Expr(). The following examples create a Distribution report.

// two-step method
\[
x = \text{Expr( Distribution( Column( \text{Expr("X" || Char( i ))) ) ) );}
\]

\[
i = 3;
y = \text{Eval Expr}( x );
y;
\]

// one-step method
\[
x = \text{Expr( Distribution( Column( \text{Expr("X" || Char( i ))) ) ) );}
\]

\[
i = 3;
\text{Eval( Eval Expr( x ) );}
\]
See Table 8.3 on page 226 to learn what would happen if you tried to use `Eval` directly on `x` without first doing `Eval Expr`.

**Parsing Strings into Expressions, and Vice Versa**

Parsing is the syntactic scanning of character strings into language expressions. Suppose that you have read in a valid JSL expression into a character string, and now want to evaluate it. The `Parse` function returns the expression. To evaluate it, use the `Eval` function.

```
x = Parse( "a=1" );  // x now has the expression a=1
Eval( Parse( "a=1" ) );  // a now has the value 1
```

To go in the reverse, use the `Char` function, which converts an expression into a character string. Usually the argument to a `Char` function is an `Expr` function (or a `NameExpr` of a global variable), since `Char` evaluates its argument before deparsing it.

```
y = Char( Expr( a = 1 ) );  // results in y having the character value "a=1"
z = Char( 42 );  // results in "42"
```

The `Char` function allows arguments for field width and decimal places if the argument is a number. The default is 18 for width and 99 for decimal (Best format).

```
Char( 42, 5, 2 );  // results in the character value "42.00"
```

To preserve locale-specific formatting in the numeric value, include the `<<UseLocale(1)` option as shown in the following example:

```
Char( 42, 5, 2, <<UseLocale(1) );  // results in the character value "42,00" in the French locale
```

The reverse of `Char` is not quite as simple. To convert a character string into an expression, you use `Parse`, but to convert a character string into a number value, you use `Num`.

```
Parse( y );
Num( z );
```

<table>
<thead>
<tr>
<th>Table 8.2 Functions to Store or Evaluate Expressions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>Char</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>string = char(number, width, decimal)</td>
</tr>
</tbody>
</table>
### Table 8.3 Operators for Controlling Evaluation

<table>
<thead>
<tr>
<th>Commands and results</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>x; // or Eval(x);</td>
<td>Eval(x) and simply calling x are equivalent.</td>
</tr>
<tr>
<td>Not Found in access or evaluation of 'distribution', Bad Argument( {&quot;X&quot;</td>
<td></td>
</tr>
<tr>
<td>Expr(x); x</td>
<td>Returns the expression x (packs an additional layer).</td>
</tr>
</tbody>
</table>

### Summary

Table 8.3 compares various ways that you can use the evaluation-control operators with x. Assume that a data table contains a column named X3, and x and i have been assigned:

\[
x = \text{Expr( Distribution(Column( Expr("X" || Char( i ) ) ) ) )};
\]

\[
i = 3;
\]
### Table 8.3 Operators for Controlling Evaluation (Continued)

<table>
<thead>
<tr>
<th>Commands and results</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name Expr(x);</td>
<td>Returns the expression stored in x exactly as is: Distribution(Column(Expr(&quot;X&quot;</td>
</tr>
<tr>
<td>y = Eval Expr(x);</td>
<td>Evaluates the inner expression but leaves the outer expression unevaluated, so that y is Distribution(Column(&quot;X3&quot;))</td>
</tr>
<tr>
<td>z = Char(nameexpr(x));</td>
<td>Quotes the entire expression as a text string, adding ! escape characters as needed. Note that Char(x) would first attempt to evaluate x, producing an error and ultimately returning a quoted missing value: &quot;.&quot;</td>
</tr>
<tr>
<td>a = Parse(Char(NameExpr(x)));</td>
<td>Evaluation control taken to its logical extreme. Note that you must break this into at least two steps as shown. Combining it into one giant step produces different results because the Eval Expr layer causes the Parse layer to be copied literally, not executed.</td>
</tr>
</tbody>
</table>

**Eval(EvalExpr(Parse(Char(NameExpr(x)))));**

Distribution(Column(Expr("X" || Char(i))))
Macros

Stored expressions can serve as a macro feature. You can store a generalized action as an expression in a global, and then call that global wherever you need that action to be performed. This example has four macros as the arguments to If:

```plaintext
lastStdzdThickness = expr(
    (thickness[nrow()] - col mean(thickness)) / col std dev(thickness));
continue = expr(...<script to read in more data>...);
log = expr(print("In control at " || char( long date(today()))));
break = expr(...<script to shut down process>...); limitvalue = 1;

if(lastStdzdThickness < limitvalue, log; continue, break);
```

Storing the expression (the script itself, not its evaluation at the moment) with Expr delays its evaluation until the global is actually called. Any variables, data points, or expressions included in that expression are evaluated on the fly when the expression is evaluated. See “Stored expressions” on page 218, for detailed rules for storing expressions and later evaluating them.

Manipulating lists

The following operators manipulate lists. They can also be used to manipulate expressions, as shown in the next section, “Manipulating Expressions” on page 230. A summary of commands with explanations is in Table 8.4 on page 233.

Most of the function have two variants, one that produces a new value, and one that works in-place directly on its arguments. Here are some examples:

```plaintext
A = Remove( A, 3 ); // delete the third item in the list A, storing result in A
Remove From( A, 3 ); // delete the third item in the list A, in place
Show( A ); // A = {2, 3, 2, 1, 2, 1};

onetwo = Insert( {1}, 2 ); // {1,2}
Insert Into( B, {1, 2}, 4 ); // put 1,2 before the current 4th item
Show( B ); // B = {2, 3, 4, 1, 2, 1, 2, 1, 2, 1};

Note: If position is omitted in the Insert Into command, items are placed at the end of the list.

a = Shift( {1,2,3,4}, 1 ); // stores the list {2,3,4,1} in a
Shift Into( a, -1 );
Show( a ); // a = {1, 2, 3, 4};

b = Reverse( a ); // b is now {4,3,2,1}
Reverse Into( a ); // a is now {4,3,2,1}
Show( b ); // b = {2, 3, 4, 1};
```
\[ s = \text{Sort List}(\{1, 4, 2, 5, -7.2, \text{Pi}(), -11, \text{cat}, \text{apple}, \text{cake}\}); \]
\[ \text{Show}( s ); // s = \{-11, -7.2, 1, 2, 4, 5, \text{apple}, \text{cake}, \text{cat}, \text{Pi}()\}; \]

\[ c = \{5, \text{pie}, 2, \text{Pi}(), -2\}; \]
\[ \text{Sort List Into}( c ); \]
\[ \text{Show}( c ); // c = \{-2, 2, 5, \text{Pi}(), \text{pie}\}; \]

**In-place operators**

*In-place operators* are those that operate on lists or expressions directly. They have *From* or *Into* in their names (for example, *Remove From* and *Insert Into*). They do not return a result; you have to show the list to see the result. The first argument for an in-place operator must be an L-value. An *L-value* is an entity such as a global variable whose value can be set.

\[ \text{myList} = \{a, b, c, d\}; \]
\[ \text{Insert Into}( \text{myList}, 2, 3 ); \]
\[ \text{Show}( \text{myList} ); \]
\[ \text{myList} = \{a, b, 2, c, d\} \]

These examples show how to use *Insert Into* and *Remove From* with nested lists:

\[ a = \{\{1, 2, 3\}, \{\text{"A"}, \text{"B"}, \text{"C"}\}\}; \]
\[ \text{Show}( a ); \]
\[ a = \{\{1, 2, 3\}, \{\text{"A"}, \text{"B"}, \text{"C"}\}\} \]

\[ \text{Insert Into}( a[1], 99, 1 ); \]
\[ \text{Show}( a ); \]
\[ a = \{\{99, 1, 2, 3\}, \{\text{"A"}, \text{"B"}, \text{"C"}\}\} \]

\[ \text{Remove From}( a[1], 1 ); \]
\[ \text{Show}( a ); \]
\[ a = \{\{1, 2, 3\}, \{\text{"A"}, \text{"B"}, \text{"C"}\}\} \]

**Not in-place operators**

For the *not-in-place operators*, you must either state the list directly or else quote a name that evaluates to a list. Such operators do not have *From* or *Into* in their names. They *return* manipulated lists or expressions without changing the original list or expression given in the first argument.

\[ \text{myNewList} = \text{Insert}( \{a, b, c, d\}, 2, 3 ); \]
\[ \{a, b, 2, c, d\} \]

\[ \text{oldList} = \{a, b, c, d\}; \]
\[ \text{newList} = \text{Insert}( \text{oldList}, 2, 3 ); \]
\[ \{a, b, 2, c, d\} \]
Substituting

Substitute() and Substitute Into() merit further discussion. Both functions find all matches to a pattern in a list (or expression) and replace them with another expression. Each pattern must be a name. The arguments are evaluated before they are applied, so most of the time you must quote them with an Expr() function.

Substitute( {a,b,c}, Expr( a ), 23); // returns {23,b,c}
Substitute( Expr( Sine( x ) ), Expr( x ), Expr( y ) ); // returns Sine(y)

To delay evaluating an argument, use NameExpr instead of Expr:

a = {quick, brown, fox, jumped, over, lazy, dogs};
b = Substitute( a, Expr( dogs ), Expr( cat ) );
canine = Expr( dogs );
equine = Expr( horse );
c = Substitute( a, Name Expr( canine ), Name Expr( equine ) );
Show( a, b, c );
  a = {quick,brown,fox,jumped,over,lazy,dogs}
  b = {quick,brown,fox,jumped,over,lazy,cat}
  c = {quick,brown,fox,jumped,over,lazy,horse}

Substitute Into does the same work, in place:

Substitute Into( a, Expr( dogs ), Expr( horse ) );

You can list multiple pattern and replacement arguments to do more than one replacement in a single step:

d = Substitute( a, 
  Name Expr( quick ), Name Expr( fast ),
  Name Expr( brown ), Name Expr( black ),
  Name Expr( fox ), Name Expr( wolf )
);
  {fast,black,wolf,jumped,over,lazy,dogs}

Note that substitutions are done repeatedly over multiple instances of the expression pattern. For example:

Substitute( Expr( a + a ), Expr( a ), Expr( aaa ) );
results in:
  aaa + aaa

Manipulating Expressions

The operators for manipulating lists can also operate on most expressions. Be sure to quote the expression with Expr(). For example:

Remove( Expr( A + B + C + D ), 2 ); // results in the expression A + C + D
b = Substitute( Expr( Log( 2 ) ^ 2 / 2 ), 2, 3 ); // results in the expression Log( 3 ) ^ 3 / 3

As with lists, remember that the first argument for in-place operators must be an L-value. An L-value is an entity such as a global variable whose value can be set. In-place operators are those that operate on lists or expressions directly. They have From or Into in their names (for example, Remove From and Insert Into). They do not return a result; you have to show the expression to see the result.

\[
polynomial = \text{Expr}( a \times x ^ 2 + b \times x + c ) ; \\
\text{Insert Into}( \ polynomial, \ \text{Expr}( d \times x ^ 3 ), 1 ); \\
\text{Show}( \ polynomial ); \\
\text{polynomial} = d \times x ^ 3 + a \times x ^ 2 + b \times x + c
\]

For the not-in-place operators, you must either state the expression directly or else quote a name that evaluates to an expression using NameExpr. Such operators do not have From or Into in their names. They return manipulated lists or expressions without changing the original list or expression given in the first argument.

\[
cubic = \text{Insert}( \ \text{Expr}( a \times x ^ 2 + b \times x + c ), \ \text{Expr}( d \times x ^ 3 ), 1 ); \\
d \times x ^ 3 + a \times x ^ 2 + b \times x + c
\]

\[
quadratic = \text{Expr}( a \times x ^ 2 + b \times x + c ); \\
cubic = \text{Insert}( \ \text{NameExpr}( \ \text{quadratic} ), \ \text{Expr}( d \times x ^ 3 ), 1 ); \\
d \times x ^ 3 + a \times x ^ 2 + b \times x + c
\]

**Substituting**

Substituting is extremely powerful; please review the earlier discussion “Substituting” on page 230. Here are a few notes regarding substituting for expressions.

Substitute(pattern,name,replacement) substitutes for names in expressions

NameExpr() looks through the name but copies instead of evaluates:

\[
a = \text{Expr}( \\
\text{Distribution}( \ \text{Column}( x ), \ \text{Normal Quantile Plot} ) ) ; \\
\text{Show}( \ \text{NameExpr}( a ) ); \\
\text{NameExpr}( a ) = \text{Distribution}( \ \text{Column}( x ), \ \text{Normal Quantile Plot} );
\]

Substitute() evaluates all its arguments, so they must be quoted correctly:

\[
b = \text{Substitute}( \ \text{NameExpr}( a ), \ \text{Expr}( x ), \ \text{Expr}( :\text{weight} ) ); \\
\text{Show}( \ \text{NameExpr}( b ) ); \\
\text{NameExpr}( b ) = \text{Distribution}( \ \text{Column}( :\text{weight} ), \ \text{Normal Quantile Plot} );
\]

SubstituteInto() needs an L-value, so the first argument is not quoted:

\[
\text{SubstituteInto}( a, \ \text{Expr}( x ), \ \text{Expr}( :\text{weight} ) ); \\
\text{Show}( \ \text{NameExpr}( a ) );
\]
Name Expr(a) = Distribution(Column(:weight), Normal Quantile Plot);

Substitute() is useful for changing parts of expressions, such as in the following example that tests the Is functions:

data = {1, {1, 2, 3}, [1 2 3], "abc", x, x( y )};
ops = {is number, is list, is matrix, is string, is name, is expr};
m = J( N Items( data ), N Items( ops ), 0 );
test = Expr(
    m[r, c] = _op( data[r] )
);
For( r = 1, r <= N Items( data ), r++,
    For( c = 1, c <= N Items( ops ), c++,
        Eval( Substitute( Name Expr( test ), Expr( _op ), ops[c] ) )
    ));
Show( m );
m =
[1 0 0 0 0 0,
 0 1 0 0 0 1,
 0 0 1 0 0 0,
 0 0 0 1 0 0,
 0 0 0 0 1 1,
 0 0 0 0 0 1];

You can use SubstituteInto() to have JMP solve quadratic equations. The following example solves $4x^2 - 9 = 0$:

/* FIND THE ROOTS FOR THE EQUATION: */
/* a*x^2 + b*x + c = 0 */
// The quadratic formula is $x=\frac{-b \pm \sqrt{b^2 - 4ac}}{2a}$.
// Use a list to store both the + and - results of the +- operation
x = {Expr( (-b + Sqrt( b ^ 2 - 4 * a * c )) / (2 * a) ), Expr( (-b - Sqrt( b ^ 2 - 4 * a * c )) / (2 * a) )};
Substitute Into( x, Expr( a ), 4, Expr( b ), 0, Expr( c ), -9 );
// Plug in the coefficients
Show( x ); // see the result of substitution
Show( Eval Expr( x ) ); // see the solution
x = {Expr(((-0) + Sqrt(0 ^ 2 - 4 * 4 * -9)) / (2 * 4)), Expr(((-0) - Sqrt(0 ^ 2 - 4 * 4 * -9)) / (2 * 4))};
Eval Expr(x) = {1.5, -1.5};

The operators for manipulating lists and expressions are discussed in the previous section, “Manipulating lists” on page 228, and summarized in Table 8.4.
Table 8.4 Functions for Manipulating Lists or Expressions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove</td>
<td>$x = \text{Remove}([\text{list}</td>
<td>\text{expr}])$</td>
</tr>
<tr>
<td></td>
<td>$x = \text{Remove}([\text{list}</td>
<td>\text{expr}], \text{position})$</td>
</tr>
<tr>
<td></td>
<td>$x = \text{Remove}([\text{list}</td>
<td>\text{expr}], {\text{positions}})$</td>
</tr>
<tr>
<td></td>
<td>$x = \text{Remove}([\text{list}</td>
<td>\text{expr}], \text{position}, n)$</td>
</tr>
<tr>
<td>Remove From</td>
<td>Remove From([list</td>
<td>expr], position)</td>
</tr>
<tr>
<td></td>
<td>Remove From([list</td>
<td>expr])</td>
</tr>
<tr>
<td></td>
<td>Remove From([list</td>
<td>expr], position, n)</td>
</tr>
<tr>
<td>Insert</td>
<td>$x = \text{Insert}(\text{list}</td>
<td>\text{expr}, \text{item}, \text{position})$</td>
</tr>
<tr>
<td></td>
<td>$x = \text{Insert}(\text{list}</td>
<td>\text{expr}, \text{item})$</td>
</tr>
<tr>
<td>Insert Into</td>
<td>Insert Into([list</td>
<td>expr], item, position)</td>
</tr>
<tr>
<td></td>
<td>Insert Into([list</td>
<td>expr], item)</td>
</tr>
<tr>
<td>Shift</td>
<td>$x = \text{Shift}([\text{list}</td>
<td>\text{expr}])$</td>
</tr>
<tr>
<td></td>
<td>$x = \text{Shift}([\text{list}</td>
<td>\text{expr}, n])$</td>
</tr>
<tr>
<td>Shift Into</td>
<td>Shift Into([list</td>
<td>expr])</td>
</tr>
<tr>
<td></td>
<td>Shift Into([list</td>
<td>expr], n)</td>
</tr>
<tr>
<td>Reverse</td>
<td>$x = \text{Reverse}([\text{list}</td>
<td>\text{expr}])$</td>
</tr>
</tbody>
</table>
### Table 8.4 Functions for Manipulating Lists or Expressions (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse Into</td>
<td>Reverse Into(list</td>
<td>expr)</td>
</tr>
<tr>
<td>Sort List</td>
<td>x=Sort List(list</td>
<td>expr)</td>
</tr>
<tr>
<td>Sort List Into</td>
<td>Sort List Into(list</td>
<td>expr)</td>
</tr>
<tr>
<td>Sort Ascending</td>
<td>Sort Ascending(list</td>
<td>matrix)</td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Sort Descending(list</td>
<td>matrix)</td>
</tr>
<tr>
<td>Loc Sorted</td>
<td>Loc Sorted(A, B)</td>
<td>Creates a matrix of subscript positions where the values in matrix A match the values in matrix B. A must be a matrix sorted in ascending order.</td>
</tr>
<tr>
<td>Substitute</td>
<td>R = Substitute(list</td>
<td>exp r, Expr(pattern), Expr(replacement), ...)</td>
</tr>
<tr>
<td>Substitute Into</td>
<td>Substitute Into(list</td>
<td>expr, Expr(pattern), Expr(replacement), ...)</td>
</tr>
</tbody>
</table>
**Advanced Scoping and Namespaces**

Scripts that are used in production environments need to use more advanced scoping techniques to avoid collisions between scripts. JMP provides three progressively more advanced techniques:

- The *Names Default To Here()* function. If you have simple scripting needs, this single command might be sufficient. See “Names Default To Here” on page 235.
- Scopes that are pre-defined by JMP. See “Scoped Names” on page 238.
- Namespaces that you can create for your scripts. See “Namespaces” on page 241.

**Names Default To Here**

If you write production scripts, you need to insulate the script from the current user environment. Otherwise, the variables that you use might interact with variables used by the user and by other scripts. The way to do this is to keep your names in a local environment, which you can do by setting an execution mode with the statement:

```
Names Default To Here( 1 );
```

Unqualified names in a script with the *Names Default To Here* mode turned on are private to that script. However, the names persist as long as the script persists, or as long as objects created by or holding the script are still active. We recommend that all production scripts start with *Names Default To Here*(1) unless there is a specific reason not to do so. When the script uses an unqualified name in this mode, that name is resolved in the local namespace.

To refer to global variables, scope the name specifically as a global variable (for example, `::global_name`). To refer to columns in a data table, scope with name specifically as a data table column (for example, `:column_name`).

**Note:** *Names Default To Here*( 1 ) defines a mode for a particular script. It is not a global function. One script can have this mode turned on, while another script can have it turned off. The default setting is off.

In JMP 8 and earlier, the only method to the insulate scripts was to use lengthy names that were less likely to collide with names in other scripts. Using *Names Default To Here*(1) makes this technique unnecessary.

*Local()* creates local scopes only in specific contexts within a script and cannot enclose a longer script with interacting functions, while *Names Default To Here*(1) creates a local scope for an entire script.

If you have simple scripting needs, *Names Default To Here*(1) might be sufficient.
Handling Unqualified Named Variable References

The `Names Default To Here()` function determines how unqualified named variable references are resolved. Explicitly scoping a variable using `here:var_name` always works, whether `Names Default To Here()` is on or off. See “Scoped Names” on page 238 for details about here and other scopes.

Enabling the `Names Default To Here` mode associates a scope called `Here` with an executing script. The `Here` scope contains all of the unqualified named variables that are created when they are the target of an assignment (as an L-value). In JMP 8 and earlier, these variables normally would have been placed in the `Global` scope. Using a `Here` scope keeps variables in multiple executing scripts separate from each other, avoiding name collisions and simplifying the scripting and management of variable name collisions. You can still share information using the `Global` scope.

Names Default To Here and Global Variables

Run this example script one line at a time to see how the `Names Default To Here()` function changes the resolution of variable names.

Example Script

```javascript
a = 1;
Names Default To Here( 1 );
a = 5;
Show( global:a, a, here:a );
    global:a = 1;
    a = 5;
    here:a = 5;
```

1. Run the first line to create a global variable named `a` that holds the value 1.
2. Run the second line to turn on the `Names Default To Here` mode.
3. Run the third line to create a new variable named `a` in the local space that holds the value 5. This line does not change the value assigned to the global variable `a`.
4. Run the fourth line to see how scoped and unscoped variables are resolved.

The unqualified `a` is resolved to `here:a`. If `Names Default To Here()` were not on, `a` would be resolved to the global variable named `a`.

Note that if you use `::a` instead of `global:a` in the `Show()` function, your output is a little different:

```javascript
Show(::a, a, here:a);
    a = 1;
    a = 5;
    here:a = 5;
```
Example of Using the Names Default To Here() Function

You have two scripts with the following definitions, and Names Default To Here() is turned off (the default condition) in both scripts.

Note: Both scripts must be in separate script windows for this example.

```plaintext
1. Run Script 1. The result is as follows:
   a = 1

2. Run Script 2. The result is as follows:
   a = 3

3. Run only the `Show( a );` line in Script 1. The result is as follows:
   a = 3

The log shows a = 3 because variable a is global, and was last modified by Script 2. This is the default behavior in JMP 9 and later, and it is the only possible behavior in JMP 8 and earlier.

4. Now turn on Names Default To Here() in both scripts.
   Names Default To Here(1);

Note: Names Default To Here() is local to a particular script. It is not a global setting.

5. Run Script 1. The result is as follows:
   a = 1

6. Run Script 2. The result is as follows:
   a = 3

7. Run only the `Show( a );` line in Script 1. The result is as follows:
   a = 1

The log shows a = 1, because a copy of variable a is maintained for each script.

Note: Problems using this function are generally due to the mixing of unqualified and qualified references to global variables. Always explicitly scoping a name prevents accessing an unintended variable.
Scoped Names

Specify where a name is to be resolved by using a scope in the form `scope:name` where `scope` indicates how to resolve the name. For example, `here:name` indicates that the name should be resolved locally. Using the `Names Default To Here` mode, `here:name` is equivalent to `name`. The scope instructs how to look up the name.

The syntax is to use the colon scope operator:

```
scope:name
```

There are several types of scopes:

- **Scope can be a resolution rule.** For example, `here:x` means that `x` should be resolved to a name that is local to the script. `Global:x` means that `x` should be resolved to a global name.
- **Scope can be a namespace reference variable.** For example, `ref:a` means that `a` should be resolved within the namespace that `ref` refers to.
- **Scope can be a data table reference to look up names as column names.** For example, `dt:height` means that `height` should be resolved as a column in the data table that `dt` references.
- **Scope can be the name of a namespace that you created.** For example, `myNamespace:b` where `myNamespace` is a namespace that you created. "myNamespace":b is equivalent. See “Namespaces” on page 241.

Examples of Scoping Column Formulas

The following examples demonstrate how to scope columns that contain formulas. In both scripts, `x` is a global variable, local variable, and column name.

In the first script, the column name `x` is unscoped. the formula in the second column multiplies the value in column `x` by 100. In this case, The result is a column with the values 100, 200, and 300.

```
::x = 5;
New Table( "Test",
    New Column( "x", Values( [1, 2, 3] ) ),
    New Column( "y", Formula( 100 * x ) ),
);
```

In the following script, the formula in column `y` assigns 500 to `x` and then adds 50 to `x`. Each cell in the column contains the value 550.

```
::x = 5;
New Table( "Test",
    New Column( "x", Values( [1, 2, 3] ) ),
    New Column( "y", Formula( Local( {x = 500}, x + 50 ) ) ),
);
Predefined Scopes

JMP provides predefined that cannot be removed or replaced. Each of these scopes has specific roles, depending on its associated object.

Table 8.5 Predefined Scopes

<table>
<thead>
<tr>
<th>Scope</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Global names are shared throughout the JMP environment.</td>
</tr>
<tr>
<td>Here</td>
<td>Scope of the executing script.</td>
</tr>
<tr>
<td>Builtin</td>
<td>JMP built-in functions. For example, Builtin:Sqrt(). These names are shared throughout the JMP environment. If you over-ride a JSL function with a custom function, you can still access the built-in JSL function by using this scope.</td>
</tr>
<tr>
<td>Local</td>
<td>Nearest local scope. Can be nested within the user-defined functions, Local and Parameter.</td>
</tr>
<tr>
<td>Local Here</td>
<td>Provides a namespace block inside Names Default to Here(1). Local( {Default Local}, ) does not always work due to the lifetime of the local block, but Local Here() is persistent across the call.</td>
</tr>
<tr>
<td>Window</td>
<td>Scope of the containing user-defined window. (Rare.)</td>
</tr>
<tr>
<td>Platform</td>
<td>Scope of the current platform. (Rare.)</td>
</tr>
<tr>
<td>Box</td>
<td>Scope of the containing context box. A context box is nested within a user-defined window. (Rare.)</td>
</tr>
</tbody>
</table>

Example of Using the Window Scope

This example uses the Window scope to pass information during execution. Explicitly scoping the variables x and y to this window ensures that JMP does not try to scope x and y in other contexts, such as a data table. The variables x and y are created and used solely inside the Window environment. The Window scope is similar to using Local(), but more useful because Local() is limited in the places that it can be used.

```plaintext
New Window( "Example",
          window:gx = 20;
          window:gy = 50;
          Graph Box( Frame Size( 200, 200 ),
                     Handle(
                     window:gx,
                     window:gy,
```
Example of Using the Here Scope

This example uses the Here scope to pass information between windows that are created by the same script. Scoping a variable using Here: is not dependent on turning Names Default To Here() on. The Here: scope is always available.

This script produces two windows and uses two different scopes.

The Launcher window asks the user for two values. Those two values are passed to the Output window, which uses them to graph a function. The Launcher window scopes aBox and bBox to the window: essentially, those two variables (pointers to Number Edit Boxes) exist only in the Launcher window and are not available to the Output window. The values from those two boxes are then copied into variables that are scoped to Here, and so are available to both windows that are produced by this script.

```vbg
launchWin = New Window( "Launcher", <<Modal,
  V List Box(
    Lineup Box( N Col( 2 ), Spacing( 10 ),
      Text Box( "a" ),
      window:aBox = Number Edit Box( 50 ),
      Text Box( "b" ),
      window:bBox = Number Edit Box( 20 ),
    ),
  ),
  Function( {x, y},
    window:gx = x;
    window:gy = y;
  );
  Circle( {0, 0}, Sqrt( window:gx * window:gx + window:gy * window:gy ) );
);
Lineup Box( N Col( 2 ), Spacing( 20 ),
    Button Box( "OK",
        // copy values before window goes away
        here:a = window:aBox << Get;
        here:b = window:bBox << Get;
    ),
    Button Box( "Cancel", Throw( 1 ) )
),
);

New Window( "Output",
    Graph Box( Y Function( here:a + here:b * Sin( x / 30 ), x ) )
);

Figure 8.2 Launcher and Output

Namespaces

A namespace is a collection of unique names and corresponding values. You can store references to namespaces in variables. Namespace names are global, because JMP has only one namespace map. Namespace references are variables like any other variable that references an object, so they must be unique within their scope or namespace. The members of a namespace are referenced with the : scoping operator, such as my_namespace:x to refer to the object that is named x within the namespace called my_namespace. See “User-Defined Namespace Functions” on page 241 for details about creating and managing your own namespaces. Namespaces are especially useful for avoiding name collisions between different scripts.

User-Defined Namespace Functions

Create your own namespaces to hold related sets of variables and function definitions. There are several functions that you can use to manage namespaces.
New Namespace

\[
\text{nsref} = \text{New Namespace}( \text{"nsname"}, \{ \text{name} = \text{expr}, \ldots \} );
\]

Creates a new namespace called \text{nsname} (a string expression) and returns a reference to the namespace. All arguments are optional.

\text{Nsname} is the name of the namespace in the internal global list of namespace names. \text{Nsname} can be used as the prefix in a scoped variable. The function returns a reference to the namespace, and can also be used as the prefix in a scoped variable reference. If \text{nsname} is absent, the namespace is anonymous and is given a unique name created by JMP. \text{Show Namespace}() shows all namespaces and their names, whether assigned or anonymous.

**Important:** If you already have a namespace named \text{nsname}, it is replaced. This behavior means that while you are developing your script, you can make your changes and re-run the script without having to clear or delete your namespace. To avoid unintentional replacement, you can either use anonymous namespaces, or test to see whether a particular namespace already exists:

\[
\text{If( !Namespace Exists( "nsname" ), New Namespace( "nsname" ) );}
\]

A list of named expressions is optional. The names are JMP variables that exist only within the namespace.

**Note:** The named expressions must be a comma-separated list. Separating the expressions with semi-colons causes the list to be ignored.

These namespaces must be uniquely named to prevent collisions in situations where multiple user-defined namespaces are being used. Using anonymous namespace names prevents collisions.

Namespace

\[
\text{nsref} = \text{Namespace}( \text{"nsname" | nsref});
\]

Returns a namespace reference. The argument might be either of the following:

- a quoted string that contains a namespace
- a reference to a namespace

**Note:** \text{Namespace}() returns a reference to a namespace that already exists. It does not create a new namespace.

Is Namespace

\[
b = \text{Is Namespace}( \text{nsref} );
\]
Returns 1 (true) if \texttt{nsref} is a namespace or 0 (false) otherwise.

**As Scoped**

\begin{verbatim}
    b = As Scoped( "nsname", var_name);
    nsname::var_name;
\end{verbatim}

As \texttt{Scoped()} is the function form of a scoped reference. The function returns a reference to the specified variable in the specified scope.

**Namespace Exists**

\begin{verbatim}
    b = Namespace Exists( "nsname" );
\end{verbatim}

Returns 1 (true) if \texttt{nsname} exists in the list of global namespaces, or 0 (false) otherwise.

**Show Namespaces**

\begin{verbatim}
    Show Namespaces();
\end{verbatim}

Shows the contents of all namespaces contained in the list of global namespaces. Namespaces are not visible unless a reference is made to one, using either the \texttt{New Namespace} or \texttt{Namespace} functions.

**Namespace Messages**

In addition to the namespace management functions, a namespace also supports a set of messages to access and manipulate its contents.

Note that these messages, as with all message, must be sent to a scriptable object. A namespace name is not a defined scriptable object and cannot be used in a Send operation. However, you can use the name of a namespace in variable references. For example, \texttt{nsmane::var} is equivalent to \texttt{nsref::var}.

Table 8.6 defines the messages that are supported by user-defined namespace references.

**Table 8.6** Namespace Messages

<table>
<thead>
<tr>
<th>Namespace Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{ns &amp;&amp; Contains( &quot;var_name&quot; );}</td>
<td>Returns 1 or 0, depending on whether \texttt{var_name} exists within the namespace.</td>
</tr>
<tr>
<td>\texttt{ns &amp;&amp; Delete;}</td>
<td>Removes this namespace from the internal global list. To delete variables in the namespace, use \texttt{&amp;&amp;Remove}. See the entry for \texttt{&amp;&amp;Remove} in this table.</td>
</tr>
</tbody>
</table>
### Table 8.6 Namespace Messages (Continued)

<table>
<thead>
<tr>
<th>Namespace Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ns &lt;&lt; First;</code></td>
<td>Returns a quoted string that contains the first variable name used within the namespace.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Get Contents;</code></td>
<td>Returns a list of key-value pairs, which are each enclosed in a list. Each key is a quoted string that contains a variable name, and each value is the unevaluated expression that the variable contains.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Get Keys;</code></td>
<td>Returns a list of variable names.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Get Name;</code></td>
<td>Returns the name of this namespace.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Get Value( &quot;var_name&quot; );</code></td>
<td>Returns the unevaluated expression that <code>var_name</code> contains in this namespace.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Get Values;</code></td>
<td>Returns a list of unevaluated expressions that each variable in this namespace contains.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Get Values( { &quot;var_name1&quot;, &quot;var_name2&quot;, ... } );</code></td>
<td>Returns a list of unevaluated expressions that each variable in this namespace specified in the list argument contains. If a requested variable name is not found, an error is returned.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Insert( &quot;var_name&quot;, expr );</code></td>
<td>Inserts into this namespace a variable named <code>var_name</code> that holds the expression <code>expr</code>.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Lock;</code></td>
<td>Locks all variables in the namespace and prevents variables from being added or removed. <code>&lt;&lt;Unlock</code> unlocks all of the namespace’s variables.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Unlock;</code></td>
<td></td>
</tr>
<tr>
<td><code>ns &lt;&lt; Lock( &lt;&quot;var_name&quot;, ...&gt; );</code></td>
<td>Locks the specified variables in this namespace. If no variables are specified, all variables are either locked or unlocked.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Unlock( &lt;&quot;var_name&quot;, ...&gt; );</code></td>
<td></td>
</tr>
<tr>
<td><code>n = ns &lt;&lt; N Items;</code></td>
<td>Returns the number of variables contained in this namespace.</td>
</tr>
<tr>
<td><code>next k = ns &lt;&lt; Next( &quot;var_name&quot; );</code></td>
<td>Returns the name of the variable that follows the specified variable.</td>
</tr>
<tr>
<td><code>ns &lt;&lt; Remove( &quot;var_name&quot;, ... );</code></td>
<td>Removes the specified variable or list of variables.</td>
</tr>
</tbody>
</table>
Using Namespace References

The following are all equivalent references to a variable that is named \( b \) in the namespace that is named \( \text{nsname} \) that has a reference \( \text{nsref} \):

\[
\begin{align*}
\text{nsref}:b \\
\text{nsname}:b \\
"\text{nsname}".b \\
\text{nsref}["b"] \\
\text{nsref}<<\text{Get Value}("b") \quad // \text{used as an r-value}
\end{align*}
\]

Namespaces and Included Scripts

An included script runs in the namespace of the parent script. If the included script has its own namespace definitions, you need to do one of the following:

- manage the namespace names to avoid name collisions
- use anonymous names created by the `New Namespace` function

In either case, you still need to manage variable references to namespaces.

There is also an option for the `Include` function (`New Context`) that creates a namespace that the included script runs in. This namespaces is an anonymous namespace and it is independent from the parent script's namespace. For example,

\[
\text{Include("file.js1", <<New Context)};
\]

This anonymous namespace can be referenced using `Here`.

See “Includes” on page 256 for more information about the `Include` function.

Examples of User-Defined Namespaces

Creating and Using a Basic Namespace with Expressions

This example shows creating an anonymous namespace and using functions and variables within it.

\[
\begin{align*}
\text{new_emp} & = \text{New Namespace}( \\
& \{ \text{name_string} = "\text{Hello, *NAME*!}" , \\
& \text{print_greeting} = \text{Function}( \{ a \} , \\
& \quad \text{Print}( \text{Substitute}( \text{new_emp} : \text{name_string}, "\*\text{NAME}\*", \text{Char}( a )) ) \\
& \}) \\
& )
\end{align*}
\]

Note that you must use the fully qualified name for variables defined within the namespace.

\[
\text{new_emp} : \text{print_greeting}(6);
\]

"Hello, 6!"
Complex Number Operations

This example creates a namespace that contains functions to support using two-element lists to represent complex numbers, and then locks the namespace.

```plaintext
If( !Namespace Exists( "complex" ),
    New Namespace('complex')
);
complex:makec = Function( {a, b},
    Eval List( {a, b} )
);
complex:addc = Function( {a, b}, a + b );
complex:subtractc = Function( {a, b}, a - b );
complex:multiplyc = Function( {a, b},
);
complex:dividc = Function( {a, b},
    d = b[1] ^ 2 + b[2] ^ 2;
    Eval List(
    );
);
complex:charc = Function( {a},
    Char( a[1] ) || "+" || Char( a[2] ) || "i"
);
));
Namespace( "complex" ) << Lock;

Here are examples using functions that are within the above user-defined namespace.

c1 = complex:makec( 3, 4 );
c2 = complex:makec( 5, 6 );
cadd = complex:addc( c1, c2 ); // returns {8, 10}
csum = complex:subtractc( c1, c2 ); // returns {-2, -2}
cmul = complex:multiplyc( c1, c2 ); // returns {-9, 38}
cdiv = complex:dividc( c1, c2 ); // returns {14.6065573770492, 19.7049180327869}
Show( complex:charc( c1 ) ); // returns complex:char(c1) = "3+4i"
cml = complex:makec( [1, 2, 3], [4, 5, 6] ); // returns {[[1, 2, 3], [4, 5, 6]]
```
Referencing Namespaces and Scopes

There are a number of factors in resolving a named variable reference. Table 8.7 describes the named variable references that are resolved for specific situations.

<table>
<thead>
<tr>
<th>Form</th>
<th>Reference Type</th>
<th>Reference Rule</th>
<th>Creation Rule</th>
</tr>
</thead>
</table>
| a    | Unqualified    | If the *Names Default To Here* mode is on, JMP looks for the variable in these locations:  
- Local namespace
- Here namespace
- current data table  
If the *Names Default To Here* mode is off, JMP looks for the variable in these locations:  
- Local namespace
- Here namespace
- Global namespace
- current data table  
• If the *Names Default To Here* mode is on, then JMP creates the variable in the Local namespace or in the Here namespace.  
• If the *Names Default To Here* mode is off, then JMP creates the variable in the Local namespace or in the Global namespace. |

| :a   | Current data table | JMP looks for the variable in the current data table. | (Not applicable) |
| :a   | Global           | JMP looks for the variable in the Global namespace. | JMP creates the variable in the Global namespace. |
| ns:a dt:a Here:aa "name":a expr:a | Qualified | JMP looks for the variable in the specified namespace. If the variable is not found, an error results. | JMP creates the variable in the specified namespace. Any previous values are replaced. |
| ns["a"] ns[expr] | Subscript | JMP looks for the variable in the specified namespace. If the variable is not found, an error results. | JMP creates the variable in the specified namespace. Any previous values are replaced. |
Table 8.7 Namespace References\(^a\) *(Continued)*

<table>
<thead>
<tr>
<th>Form</th>
<th>Reference Type</th>
<th>Reference Rule</th>
<th>Creation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform:a</td>
<td>Qualified</td>
<td>JMP looks for the variable in the encapsulating platform.</td>
<td>JMP creates the variable in the encapsulating platform.</td>
</tr>
<tr>
<td>Local:a</td>
<td>Qualified</td>
<td>JMP looks for the variable within any nested local function, up to and including a function call boundary. See “Example of Local:a” on page 249.</td>
<td>JMP creates the variable in the innermost nested local function or function call boundary.</td>
</tr>
<tr>
<td>Window:a</td>
<td>Qualified</td>
<td>JMP looks for the variable in the encapsulating New Window window namespace.</td>
<td>JMP creates the variable in the encapsulating New Window window namespace.</td>
</tr>
<tr>
<td>Box:a</td>
<td>Qualified</td>
<td>JMP looks for the variable in the encapsulating Context Box namespace contained in a New Window window.</td>
<td>JMP creates the variable in the encapsulating Context Box namespace contained in a New Window window.</td>
</tr>
</tbody>
</table>

\(^a\) These forms existed in JMP 8. In JMP 9 and later, a, :a, and ::a have the same meaning with the Names Default To Here mode turned off.

\(^b\) If the current point of execution is in a user-defined function, or a Local or Parameter JSL function body, then the Local namespace is used.
Example of Local:a

<table>
<thead>
<tr>
<th>Sample Script</th>
<th>Log Output</th>
</tr>
</thead>
</table>
| Delete Symbols(); Local( {d1l1 = 12}, local:f1f1 = Function( {fa1, fa2}, {fl1 = 99}, local:fa12 = fa1 + fa2; Local( {d2l1 = 56}, local:1212 = 78; Show( fa12 ); Show( fl1 ); Try( Show( d1l1 ), Write( '!n!'n***Error=" || Char( exception_msg ) || '!n"' )); Show Symbols(); ); local:fa12; ); f1f1( 2, 3 ); | fa12 = 5; fl1 = 99; ***Error="Name Unresolved: d1l1"(1, 2, "d1l1", d1l1/*###*/); d2l1 = 56; l2l2 = 78; \n***Error="Name Unresolved: d1l1"(1, 2, "d1l1", d1l1/*###*/); 2 Local \nfa1 = 2; fa12 = 5; fa2 = 3; fl1 = 99; 4 Local \nd1l1 = 12; 1 Local exception_msg = {"Name Unresolved: d1l1"(1, 2, "d1l1", d1l1/*###*/)}; 1 Global | 5 \n
Resolving Named Variable References

When variables are referenced within a JMP script, JMP resolves the storage location of the variable using a specific set of rules. If the variable is referenced by a qualified name, then the
resolution is based on the specific qualification specification. If the variable is referenced by an unqualified name, the situation is a bit more complex. JMP looks through a hierarchy of scopes representing the point of execution with the executing script. This section describes the rules that are used to resolve named variable references.

By default, variable name resolution in JMP 9 and later worked the same way as in JMP 8 and earlier, allowing your current JSL scripts to be executed unchanged. For JMP 9 and later, the difference between qualified and unqualified variable named references is important to understand.

**Qualified Named References**

A qualified named reference uses the \( : \) and \( :: \) operators to provide specific information about where a referenced variable resides, or where it is created. Examples of qualified named references include the following:

- \( :\text{var} \)
- \( ::\text{globalvar} \)
- \( \text{datatable}:\text{var} \)
- \( \text{nsref}:\text{var} \)
- \( "\text{nsname}":\text{var} \)

**Unqualified Named References**

An unqualified named reference provides no explicit information to completely identify where a variable resides or where it is created. No scoping operator \( (: \) or \( :: \) \) is specified in the reference. To change the behavior of JMP when resolving unqualified named variable references, use the \texttt{Names Default To Here(1)} function. For more details about variable name resolution, see the “Rules for Name Resolution” on page 92 in the “JSL Building Blocks” chapter.

**Rules for Resolving Variable References**

To resolve variable references, JMP uses the following rules (in the order indicated):

1. If the variable is followed by a pair of parentheses \( ( ) \), look it up as a function.
2. If the variable is prefixed by \( : \) scope operator or an explicit data table reference, look it up as a data table column or table variable.
3. If the variable is prefixed by \( :: \) scope operator, look it up as a global variable.
4. If the variable is an explicit scope reference (such as \texttt{group:vowel}) , look it up in the user-defined \texttt{group} namespace.
5. If the variable is in a \texttt{Local} or \texttt{Parameter} function, look it up as a local variable. If it is nested, repeat until a function call boundary is found.
6. If the variable is in a user-defined function, look it up as a function argument or local variable.
7. Look the variable up in the current scope and its parent scope. Repeat until the Here scope is encountered.

8. Look the variable up as a variable in the Here scope.

9. Look the variable up as a global variable.

10. If Names Default to Here(1) is at the top of the script, stop looking. The scope is local.

11. Look the variable up as a data table column or table variable.

12. Look the variable up as an operator or a platform launch name (for example, Distribution, Bivariate, Chart, and so on).

13. When the name cannot be found:
   - If the name is used in a reference, print and error to the log.
   - If the name is used as the target of an assignment (as an L-value), test the following:
     - If the variable is preceded by :: scope operator, create and use a global variable.
     - If the variable is an explicit scope reference, create and use the variable in the specified namespace or scope.
     - If Names Default to Here(0) is at the top of the script, create a global variable.
     - If Names Default to Here(1) is at the top of the script, create a Here namespace variable.

**Best Practices for Advanced Scripting**

- **Minimize Polluting the Global Namespace and Prevent Scripts from Interacting**
  
  Always start your script with this line:
  ```
  Names Default To Here(1);
  ```

- **Share Variables Across Scripts**
  
  Use named namespaces. Namespace names are placed in the global scope.

- **Use Anonymous Namespaces**
  
  Using namespace references to anonymous namespaces avoids possible conflicts with other namespaces.

**Advanced Programming Concepts**

This section covers some more advanced programming techniques that can be useful for developing complex scripts.

- “Throwing and Catching Exceptions” on page 252
Throwing and Catching Exceptions

A script can stop itself by executing the `Throw()` function. If you want to escape from part of a script when it is in an error condition, you can enclose it in a `Try()` expression.

Try takes two expression arguments. It starts by evaluating the first expression, and if or when the first expression throws an exception by evaluating `Throw`, it does the following:

1. Immediately stops evaluating that first expression.
2. Returns nothing
3. Evaluates the second expression.

`Throw` does not require an argument but has two types of optional arguments. If you include a character-valued expression as an argument, throwing stores that string in a global named `exception_msg`; this is illustrated in the first example below.

Examples

For example, you can use `Try()` and `Throw()` to escape from deep inside `For` loops.

```plaintext
a = [1 2 3, 4 5 ., 7 8 9];
b = a;
nr = N Row( a );
nc = N Col( a );
// a[2, 3] = 2; // uncomment this line to see the "Missing b" outcome

Try(
    sum = 0;
    For( i = 1, i <= nr, i++,
        For( j = 1, j <= nc, j++,
            za = a[i, j];
            If( Is Missing( za ),
                Throw( "Missing a" )
            );
            zb = b[j, i];
            If( Is Missing( zb ),
                Throw( "Missing b" )
            );
            sum += za * zb;
        )
    )
)
```
You can also use Try and Throw to catch an exception that JMP itself throws:

```julia
Try(
  dt = Open( "Mydata.jmp" ); // a file that cannot be opened
  Summarize( a = by( age ), c = count, meanHt = Mean( Height ) );
  Show( a, c, meanHt );
  Print( "This script does not work without the data set" );
  Throw();
);
```

You do not have to use Try to make use of Throw. In this example, Throw is not caught by Try but still stops a script that cannot proceed:

```julia
dt = New Table(); // to get an empty data table
If( N Row( dt ) == 0,
  Throw( "!Empty Data Table" )
);
```

### Functions

JSL also has a function called Function to extend the macro concept with a local context arguments. Suppose that you want to create a function that takes the square root but tolerates negative arguments, returning zero rather than errors. You first specify the local arguments in a list with braces {} and then state the expression directly. You do not need to enclose the expression in Expr because Function stores it as an expression implicitly.

```julia
myRoot = Function( {x},
  If( x > 0, Sqrt( x ), 0 )
);
a = myRoot( 4 ); // result is a is 2
b = myRoot( -1 ); // result is b is 0
```

Functions are stored in globals, the same as values. This means that you cannot have both a root function and a root value. It also means that you can redefine a function anytime except when you are inside the function itself.

When a function is called, its arguments are evaluated and given to the local variables specified in the list forming the first argument. Then the body of the function, the second argument, is evaluated.
The values of the arguments are for the temporary use of the function. When the function is exited, the values are discarded. The only value returned is the return value. If you want to return several values, then return a list instead of a single value.

In defined functions, the stored function is not accessible directly, even by the Name Expr command. If you need to access the function expression in your script, you have to create the function within an expr() clause. For example,

```plaintext
makeFunction = Expr(
    myRoot = Function( {x},
        If( x > 0, Sqrt( x ), 0 )
    );
    d = Substitute( Name Expr( MakeFunction ), Expr( x ), Expr( y ) );
    Show( d );
    makeFunction;
)
```

### Optional Arguments

You can create optional arguments. For example:

```plaintext
f1 = Function( {x, y, z}); // all arguments are required
f2 = Function( {x, y=2, z=4}); // x is required, y and z are optional
```

Note the following:

- To make a argument optional, give it a default value in the function's definition (x=1 rather than just x).
- Optional arguments always must follow a required argument. For example, this is not allowed:
  
  ```plaintext
  Function( {x = 1, y}, ... )
  ```
  
  It will work when defined, but you will always have to pass in a value for x and y, because the default value will never be used.
- When you call the function, you cannot skip optional arguments. In this example, you have to supply a value for y to supply a value for z when you call the function:

```plaintext
ex = Function( {x, y = 2, z = 3},
    Return( x + y + z )
);
ex( 1, 4 ); // passes in 1 for x and 4 for y; z will be 3. returns 8.
```

### Local Symbols

You can declare variables as local to a function so that they do not affect the global symbol space. This is particularly useful for recursive functions, which need to keep separate the values of the local variables at each level of function call evaluation.
As shown above, a function definition looks as follows:

```javascript
functionName=Function({arg1, ...}, body);
```

You can also have the function definition default all the unscoped names to be local.

```javascript
functionName=Function({arg1, ...}, {Default Local}, body);
```

The use of Default Local localizes all the names that:

- Are not scoped as globals (for example, ::name)
- Are not scoped as data table column names (for example, :name)
- Occur without parentheses after them (for example, are not of the form name(...))

For example, the following function sums three numbers.

```javascript
add3 = Function( {a, b, c},
                 {temp},
                 temp = a + b;
                 temp + c;
                 );
X = add3( 1, 5, 9 );
15
```

The following function does the same thing, automatically finding locals.

```javascript
add3 = Function( {a, b, c},
                 {Default Local},
                 temp = a + b;
                 temp + c;
                 );
X = add3( 1, 5, 9 );
15
```

In both cases, the variable `temp` is not a global, or, if it is already a global, remains untouched by evaluating the functions.

**Note:** If you use an expression initially as local, then use it as a global, JSL changes the context. However, an expression used globally stays resolved globally regardless of its future use.

Using Default Local() in user-defined functions can cause some confusion because it is context-sensitive. That is, the same function may behave differently in different contexts, depending on whether same-named outer variables are in scope. The user should enumerate each and every variable they wish to be local. This reduces the confusion and the potential incorrect use of outer scope variable values.
Recursion

The `Recurse()` function makes a recursive call of the defining function. For example, you can make a function to calculate factorials. A factorial is the product of a number, the number minus 1, the number minus 2, and so on, down to 1.

```javascript
myfactorial = Function( {a},
    If( a == 1,
        1,
        a * Recurse( a - 1 )
    )
);
myfactorial( 5 );
120
```

You can define recursive calculations without using `Recurse()`. For example, you could replace `Recurse()` by `myfactorial`, and the script would still work. However, `Recurse()` offers these advantages:

- It avoids name conflicts when a local variable has the same name as the function.
- You can recurse even if the function itself has not been named (for example, assigned to a global variable, such as `myfactorial` above).

Includes

The `Include()` function opens a script file, parses the script in it, and executes the JSL in the specified file.

```javascript
Include( "pathname" );
```

For example,

```javascript
Include( "$SAMPLE_SCRIPTS/myStartupScript.jsl" );
```

There is an option to obtain the parsed expression from the file, rather than evaluating the file.

```javascript
Include( "pathname", <<Parse Only );
```

Another named option creates a namespace that the included script runs in. This namespace is an anonymous namespace and it is independent from the parent script’s namespace.

```javascript
Include( "file.jsl", <<New Context );
```

See “Advanced Scoping and Namespaces” on page 235 for information about using namespaces with your scripts.

Note the following about included files:

- JMP files aside from JSL cannot be used.
- Other recognized file types, such as image files, SAS data sets, and Microsoft Excel files cannot be used.
- Unrecognized file types are treated as a JSL file.
- Files with the .txt extension are treated as a JSL file. A text file that contains data can be included, however an error will appear since this is not valid JSL.

**Loading and Saving Text Files**

The `Load Text File()` and `Save Text File()` commands allow manipulation of text files from JSL. Note that the paths in the following code are strings.

```javascript
text = Load Text File( "path" );
Save Text File( "path", text );
```

You can load a text file from a Web site:

```javascript
Load Text File( "URL", <blob> );
```

The URL is a quoted string that contains the URL for the text file. The text file is returned as a string. If you add the optional named argument `blob`, a blob is returned instead.

**File and Directory Operations**

`Pick Directory()` and `Pick File()` enable the user to select a file or directory when the script is run. To get a list of files in a directory, use `Files In Directory()`.

**Select a Directory or File**

You can prompt the user to select a directory using the `Pick Directory()` function. The command displays a platform-specific window in which the user selects a folder. On Windows, the optional prompt string appears at the top of the Browse for Folder window. You can also specify the path for an initial directory that appears, and specify whether files should appear in the Pick Directory window.

```javascript
path = Pick Directory( "Select a directory." );
```

To let the user select a file, use the `Pick File()` function:

```javascript
path = Pick File( <"prompt message">, <"initial directory"> <{filter list}>, <first filter>, <save flag>, <"default file">, <multiple>);  
```

The "prompt message" is used as the window title. The "initial directory" defines which folder initially appears. If a directory is defined as an empty string, the default directory is used.
You can also define the `{filter list}` used for the `Open()` window, forcing it to show only certain file types. This list must use the following syntax:

```
"Label1|suffix1;suffix2;suffix3", "Label2|suffix4;suffix5"
```

Each quoted string adds an entry to the **File name** list in the `Open()` window. `Label` defines the text that is displayed for each menu option. The following list of suffixes defines the file types that are displayed if its corresponding label is selected. Note the use of "*" to list all files in the window.

```lisp
path = Pick File(
    "Select JMP File", // prompt message
    "$SAMPLE_DATA", // initial directory
    {"JMP Files|jmp;jsl;jrn", "All Files|*"}, // file filter list
    1, // initially selected item
    0, // doesn't prompt the user to save the file
    "Analgesics.jmp" // file that is selected by default
);
```

**Tip:** All arguments are optional, however, they are also positional. This means that you can leave out arguments only at the end of the script. Use empty strings for the arguments that you want to omit from the beginning of the script.

The script below does not set the default directory or the default file:

```lisp
path = Pick File(
    "Select JMP File",
    "", // no default directory
    {"JMP Files|jmp;jsl;jrn", "All Files|*"},
    1,
    0,
    "" // no default file
);
```

The `<first filter>` argument sets the default selection where `n` is the index for the list item. In the script above, the `<first filter>` is the first item in the list: "JMP Files|jmp;jsl;jrn".

If `<Save Flag>` is false, the `Multiple` argument can be added to allow the user to select multiple files using the one window:

```lisp
path = Pick File(
    "Select JMP File",
    "",
    {"JMP Files|jmp;jsl;jrn", "All Files|*"},
    1,
    0,
    "" // no default file
);
```

The `<first filter>` argument sets the default selection where `n` is the index for the list item. In the script above, the `<first filter>` is the first item in the list: "JMP Files|jmp;jsl;jrn".

If `<Save Flag>` is false, the `Multiple` argument can be added to allow the user to select multiple files using the one window:
Note: The buffer size in the computer’s physical memory affects the number of files the user can open. The smaller the buffer, the fewer files can be opened.

Get a List of Filenames

To obtain a list of filenames in a specific directory, use the Files In Directory command.

```julia
names = Files In Directory( path, <recursive> );
```

Both filenames and subdirectory names are returned as shown in the following example:

```julia
names = Files In Directory( "$SAMPLE_DATA" );
{ "2D Gaussian Process Example.jmp", "Abrasion.jmp", ... "Design Experiment", "Detergent.jmp", ... }
```

Notice that the files within the Design Experiment subdirectory are not included. And only files in the root $SAMPLE_DATA directory are listed.

To return a list of all file names, add the optional recursive argument to Files In Directory:

```julia
names = Files In Directory( "$SAMPLE_DATA", recursive );
{ "2D Gaussian Process Example.jmp", "Abrasion.jmp", ... "Design Experiment/2x3x4 Factorial.jmp", "Design Experiment/Borehole Factors.jmp", ... }
```

To get the full pathnames, recurse the directories and concatenate the file paths and file names. The following example loops through each file in the $SAMPLE_DATA directory and subdirectories. The file path is concatenated to each file name.

```julia
names = Files In Directory( "$SAMPLE_DATA", recursive );
For( i = 1, i <= N Items( names ), i++,
    names[i] = Convert File Path( "$SAMPLE_DATA" || names[i] );
);
```

```julia
{"/C:/Program Files/SAS/JMP/13/Samples/Data/2D Gaussian Process Example.jmp",
"/C:/Program Files/SAS/JMP/13/Samples/Data/Abrasion.jmp", ... }
```

The Files in Directory command accepts native and POSIX paths, as well as paths using path variables. See “Path Variables” on page 121 in the “Types of Data” chapter for details on working with paths.

Scripting BY Groups

By group arguments are supported for these functions: ColMean(), ColStdDev(), ColNumber(), ColNMissing(), ColMinimum(), ColMaximum().
Any number of BY arguments can be specified, and you can use expressions for the BY arguments. BY arguments must be used in a column formula, or in the context of ForEachRow(). The first argument can also be a general numeric expression.

Here is an example:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "Mean of height by sex", Numeric, Formula( Col Mean( :height, :sex ) ) );

dt << New Column( "Minimum of height by sex and age", Numeric, Formula( Col Minimum( :height, :sex, :age ) ) );

dt << Distribution( Continuous Distribution( Column( :height ) ), By( :sex ) );

dt << Tabulate( Show Control Panel( 0 ), Add Table( Column Table( Analysis Columns( :height ), Statistics( Mean, N, Std Dev, Min, Max, N Missing ) ), Row Table( Grouping Columns( :age, :sex ) ) ) );
```

---

**Encrypt and Decrypt Scripts**

To add a basic level of protection to scripts, you can encrypt it so only someone who knows the password can view it; you can also require a password to run it. This is useful in situations when you want to implement controlled sharing of a script.

**To encrypt a script:**

1. Open the script that you want to encrypt.
2. Select **Edit > Encrypt Script.**
3. Enter a decrypt password so that the user needs a password to view the script.
4. (Optional) Enter a run password to require the user to enter a password before running the encrypted script.
Note: The passwords must consist of single-byte characters; using a text Input Method Editor (IME) does not work.

5. Click OK.

6. If you entered only a decrypt password, click Yes to confirm that you do not want to assign a run password.

The encrypted script opens in a new window. For example:

```javascript
//e6.0.2
S@FTQ;VGMUTF?J<;LS;B<=IRLXCU=BV;@NS<TW;LR<ZFOP=JJS>NNDA@T<V><DZA>SU@MG;LR<ZFO
P=JJS>NNDA@T<V><DZA>SU@MG;LR<ZFOP=JJS>NNDA@T<V><DZA>SU@MG;LR<ZFO=JJS>NNDA
@T<HNIZ;WDN?RMJ;FR<KYAXTEPPF?;XFJJOP=ROQBIAGXOYNNZ>PLIF>Sw>L>ACL<KGP;=QTC
EG??U<PUXLV?TRBO?J>QGWTJCFJA@BNHWLVORNNQYPIKL<IM<>JX>@G?LJ>;=;RBODH@PTKK@S
IUE;IJOR<TUTRMTGSYRSVGOR<XK<F=IwQYE=LVZFP;AUHA?YJLL;EIT?ZJZC; *
```

7. Save the encrypted script.

To decrypt a JSL script:

1. Open the encrypted script in JMP.
2. Select Edit > Decrypt Script.
3. Enter the decrypt password and click OK.

The decrypted script opens in a new window.

To run an encrypted JSL script:

Note: You must know which data table the script runs on before running an encrypted script. If you do not know the name of the data table, you must decrypt the script before running it.

1. Open the encrypted script in JMP.
2. Select Edit > Run Script.
3. Enter the run password and click OK.

The script runs:

- If the script references a data table, you are prompted to open the data table, and then the script runs.
- If the script requires an empty data table, you must create the table and then run the encrypted script.

Note that entering the run password runs the script, but does not show the script: you must supply the decrypt password to actually view the script.
Encryption and Global Variables

Encryption alone does not hide global variables and their values. A `Show Globals()` command displays them normally. If you want to hide global variables in an encrypted script, you can give them special names.

Any global variable whose name begins with two underscore characters (`__`) is hidden, and `Show Globals()` displays neither its name nor its value. For example:

```plaintext
myvar = 2;
__myvar = 5;
Show Symbols();
//Globals
myvar = 2;
//2 Global (1 Hidden)
```

This strategy works whether your script is encrypted or not.

Encrypting Scripts in Data Tables

You can also encrypt a script that is saved to a data table using the JSL `Encrypted()` or `Include( Char to Blob() )` functions.

- `JSL Encrypted()` is more straightforward, because it involves one function. You can include comments inside the encrypted script.
- `Include( Char to Blob() )` lets you include comments, but not inside the script.

**Note:** Column formulas in encrypted scripts are not encrypted. To encrypt them, include them in the JSL `Encrypted()` function.

Follow these steps to encrypt a data table script:

1. Place the script in a script window.
   You cannot directly encrypt a script that is already saved to a data table.
2. In the script window, select **Edit > Encrypt**.
3. Enter a decrypt password.
4. (Optional) Enter a run password to require the user to enter a password before running the script.
5. If you entered only a decrypt password, click **Yes** to confirm that you do not want to assign a run password.
   The encrypted script opens in a new script window.
6. Copy the entire encrypted script.
7. Create a new data table script or open an existing script.
8. In the script portion of the window, type one of the following functions:
   
   JSL Encrypted(""");
   
   Include(Char to Blob(""));

9. Paste the encrypted script inside the quotation marks in the function.

10. Click OK.

**Figure 8.3 Example of an Encrypted Data Table Script**

JSL Encrypted{
   ""/=-0.2
   ""//
   >SUJG;LR:<FR05-J58N<NDAYT<V<J2A
   \SUJG;LR:<FR05-J58N<NDAYT<V<J2A
   ;" 

Additional Numeric Operators

JSL also offers several categories of operations that do not make much sense in the context of the formula editor: matrix operations and numeric derivatives of functions. Algebraic derivatives are also available.

The basic arithmetic operators can also be used with matrix arguments for matrix-wise addition, subtraction, and so on. Matrices also have a few special operators for elementwise multiplication and division, concatenation, and indexing. See the chapter “Matrices” on page 169 in the “Data Structures” chapter, for details.

Derivatives

JSL has three internal operators (not all available in the calculator) for taking derivatives.

Derivative takes the first derivative of an expression with respect to names you specify in the second argument. A single name might be entered as this second argument; or multiple values can be specified in a list, in other words, surrounded by braces.

**Note:** Derivative is also available as an editing command inside the formula editor (calculator), located on the drop-down list in the top center of the formula editor (above the keypad). To use it, highlight a single variable in the expression (to designate which variable the derivative should be taken with respect to), then select the Derivative command from the menu. The whole formula is replaced by its derivative with respect to the highlighted name.
In scripts, the easiest way to use the function is with a single name. In this example, we first show the mathematical notation and then the JSL equivalent.

\[ f(x) = x^3 \], the first derivative is \( f'(x) \) or \( \frac{d}{dx}x^3 = 3x^2 \).

```javascript
result = Derivative( x ^ 3, x);
Show( result );
result = 3 * x ^ 2
```

If you want an efficient expression to take the derivative with respect to several variables, then the variables are specified in a list. The result is a list containing a threaded version of the original expression, followed by expressions for the derivatives. The expression is threaded by inserting assignments to temporary variables of expressions that are needed in several places for the derivatives.

Here is an example involving an expression involving three variables. Listing all three variables returns the first derivatives with respect to each. The result is a list with the original expression and then the derivatives in the order requested. However, note here that JMP creates a temporary variable \( T#1 \) for storing the subexpression \( x^2 \), and then uses that subexpression subsequently to save calculations.

```javascript
result2 = Derivative( 3 * y * x ^ 2 + z ^ 3, {x, y, z});
Show( result2 );
result2 = {3 * y * (T#1 = x ^ 2) + z ^ 3, 6 * x * y, 3 * T#1, 3 * z ^ 2}
```

To take second derivatives, specify the variable as a third argument. Both the second and third arguments must be lists. JMP returns a list with the original expression, the first derivative(s), and then the second derivative(s) in the order requested.

```javascript
second = Derivative( 3 * y * x ^ 2, {x}, {x});
Show( second );
second = {3 * y * x ^ 2, 6 * x * y, 6 * y}

second = Derivative( 3 * y * x ^ 2, {y}, {y});
Show( second );
second = {3 * y * (T#1 = x ^ 2), 3 * T#1, 0}

second = Derivative( 3 * y * x ^ 2, {y}, {x});
Show( second );
second = {3 * y * (T#2 = x ^ 2), 3 * T#2, 6 * x}
```

Num Deriv() takes the first numeric derivative of an operator or function with respect to the value of the first argument by calculating the function at that value and at that value plus a small delta (\( \Delta \)) and dividing the difference by the delta. Num Deriv2() computes the second numeric derivative in a similar fashion. These are used internally for nonlinear modeling but are not frequently useful in JSL. Note that these functions do not differentiate using a variable, but only with respect to arguments to a function. In order to differentiate with respect to \( x \),
you have to make \( x \) one of the immediate arguments, not a symbol buried deep into the expression.

Suppose to differentiate \( y = 3x^2 \) at the value of \( x = 3 \). The incorrect way would be to submit the following script:

\[
\begin{align*}
x &= 3; \\
n &= \text{Num Deriv}( 3 \times x^2 );
\end{align*}
\]

The correct way is to make \( x \) an argument in the function.

\[
\begin{align*}
x &= 3; \\
f &= \text{Function}( \{ x \}, 3 \times x^2 ); \\
n &= \text{Num Deriv}( f( x ), 1 ); \\
&= 18.000029999854
\end{align*}
\]

Consider both the mathematical notation and the JSL equivalent for another example:

For \( f(x) = x^2 \), it calculates \( \frac{d}{dx} x^2 = \frac{(x+\Delta)^2 - x^2}{\Delta} \). At \( x_0 = 3 \), \( \frac{d}{dx} x^2 = 6.00001 \).

\[
\begin{align*}
x &= 3; \\
y &= \text{Num Deriv}( x^2 ); \quad \text{// or equivalently: } y = \text{Num Deriv}( 3^2 ); \\
&= 6.0000099999513
\end{align*}
\]

And here are a few more examples:

\[
\begin{align*}
x &= \text{Num Deriv}( \sqrt{ 7 } ); \quad \text{// returns 0.188982168980445} \\
y &= \text{Num Deriv}( \text{Normal Distribution}( 1 ) ); \quad \text{// returns 0.241969514669371} \\
z &= \text{Num Deriv2}( \text{Normal Distribution}( 1 ) ); \quad \text{// returns -0.241969777547979}
\end{align*}
\]

**Table 8.8** Derivative functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Derivative</td>
<td>\text{Derivative}(expr, {name, ...})</td>
<td>Returns the derivative of the ( \text{expr} ) with respect to ( \text{name} ). Note that the second argument can be specified in a list with braces { } or simply as a variable if there is only one. Give two lists of names to take second derivatives.</td>
</tr>
<tr>
<td>NumDeriv</td>
<td>\text{NumDeriv}(expr)</td>
<td>Returns the first numeric derivative of the ( \text{expr} ) with respect to the first argument in the expression.</td>
</tr>
<tr>
<td>NumDeriv2</td>
<td>\text{NumDeriv2}(expr)</td>
<td>Returns the second numeric derivative of the ( \text{expr} ) with respect to the first argument in the expression.</td>
</tr>
</tbody>
</table>
**Algebraic Manipulations**

JSL provides a way of algebraically unwinding an expression (essentially, solving for a variable). It is accomplished through the `Invert Expr()` function.

\[ \text{Invert Expr(} \text{expression, name, } y \text{)} \]

where

- **expression** is the expression to be inverted, or the name of a global containing the expression
- **name** is the name inside expression to unwind the expression around
- **y** is what the expression was originally equal to

For example,

\[ \text{Invert Expr( } \text{Sqrt( } \log( x ) \text{ )}, x, y \text{ );} \]

is wound around the name x (which should appear in the expression only once), and results in

\[ \text{Exp( } y^2 \text{ )} \]

It is performed exactly as you would when doing the algebra by hand.

\[ y = \text{Sqrt( } \log( x ) \text{ )}; \]
\[ y^2 = \log( x ); \]
\[ \text{Exp( } y^2 \text{ ) } = x; \]

`Invert Expr` supports most basic operations that are invertible, and makes assumptions as necessary, such as assuming you are interested only in the positive roots, and that the trigonometric functions are in invertible areas so that the inverse functions are legal.

F, Beta, Chi-square, t, Gamma, and Weibull distributions are supported for the first arguments in their Distribution and Quantile functions. If it encounters an expression that it cannot convert, `Invert Expr()` returns `Empty()`.

JSL provides a `Simplify Expr` command that takes a messy, complex formula and tries to simplify it using various algebraic rules. To use it, submit

\[ \text{result } = \text{Simplify Expr(expr(expression));} \]

or

\[ \text{result } = \text{Simplify Expr(nameExpr(global));} \]

For example,

\[ \text{Simplify Expr( } \text{Expr( } 2 * 3 * a + b * (a + 3 - c) - a * b \text{ )}); \]

results in

\[ 6a + 3b + -1b*c \]
Simplify Expr() also unwinds nested If expressions. For example:

```plaintext
r = Simplify Expr( Expr( If( cond1, result1, If( cond2, result2, If( cond3, result3, resultElse ) ) ) ) );
```

results in

```plaintext
If(cond1, result1, cond2, result2, cond3, result3, resultElse);
```

**Maximize and Minimize**

The Maximize() and Minimize() functions find the factor values that optimize an expression. The expression is assumed to be a continuous function of the factor values.

The form of the call is as follows:

```plaintext
result = Maximize(objectiveExpression, {list of factor names}, <<option(value))
result = Minimize(objectiveExpression, {list of factor names}, <<option(value))
```

- `objectiveExpression` is the expression whose value is to be optimized, and can either be the expression itself, or the name of a global containing a stored expression.
- `{list of factor names}` is an expression yielding a list of names involved in `objectiveExpression`.

The name can be followed by limits that bound the permitted values, for example `name(lowerBound,upperBound)`. If you want to limit the values on one side, make the other side a missing value, for example:

```plaintext
{beta} // unconstrained
{beta (0,1)} // constrained between 0 and 1
{beta (.1,1)} // upper limit of 1
{beta (0,.)} or {beta (0)} // lower limit of 0
```

Factor values can be either numbers or matrices.

Options available, shown with their default value, include:

```plaintext
<< Tolerance(.00000001) // convergence criterion
<< Max Iter( 250) // maximum number of iterations
<< Limits() //
```

Initial values are assumed to be already supplied the factor values before calling the function. These functions are not expected to find global optima for functions that have multiple local optima; they are useful only for taking an initial value and moving it to either a local or global optimum.
The return value is currently the value of the objective function, if the optimization was successful, or Empty() if not.

Least Squares Example

The following example uses Minimize to find the least squares estimates of this exponential model, with data taken from the Nonlinear Example/US Population.jmp sample data table.

\[
\begin{align*}
b0 &= 3.9; \\
b1 &= 0.022; \\
sseExpr &= Expr( \\
    Sum((yy - (b0 * Exp(b1 * (xx - 1790)))) ^ 2) \\
); \\
sse &= Minimize(sseExpr, {b0, b1}, <<Tolerance(.00001)); \\
Show(b0, b1, sse); \\
b0 &= 13.9991388055261; \\
b1 &= 0.0147104409355048; \\
sse &= 1862.14141218875;
\end{align*}
\]

Scheduling Actions

A Schedule() function lets you set up a script to be executed some number of seconds later.

\[
\text{Schedule}(15, \text{Print("hello")});
\]

Figure 8.4 JMP Scheduler

A Scheduler window shows the time until the next event and has buttons for restarting (Go) or stopping (Stop) the schedule. Its pop-up menu has a command Show Schedule, which echoes the current schedule to the log. For example, if you checked the schedule several times during the “hello” example, you would see something like this:

\[
\begin{align*}
\text{Scheduled at 11.55000000000018 : Print("hello")} \\
\text{Scheduled at 4.716666666666697 : Print("hello")} \\
\text{Scheduled at 3.08333333333485 : Print("hello")}
\end{align*}
\]
The script might also be a name referring to a stored expression. For example, try submitting this script, which calls itself:

```plaintext
quickieScript = Expr(
    Show( "Hi there" );
    Schedule( 15, quickieScript );
);
quickieScript;
```

This script should show the string “Hi there” in a log window after 15 seconds, and reschedule itself for another 15 seconds, continuing until the Stop button is clicked.

More typically, in a production setting you might want to set up a schedule like this:

```plaintext
FifteenMinuteCheck = Expr(
    Show( "Checking data" );
    Open( "my file", options... );
    distribution( Column( column1 ), capability( spec limits ) );
    Schedule( 15 * 60, FifteenMinuteCheck );
);
FifteenMinuteCheck;
```

`Schedule()` initiates an event queue, but once it has the event queued, JMP proceeds with the next statement in the script. For example, the following has results that might surprise you:

```plaintext
Schedule( 3, Print( "one" ) );
Print( "two" );
"two"
"one"
```

If you want the script to wait until the scheduled events are finished before proceeding, one solution would be to use `Wait()` with a suitable pause. Another is to embed the subsequent actions into the schedule queue. `Schedule()` accepts a series of arguments to queue many events in sequence. Each event is a separate call to the schedule. Each event time is an absolute time relative to “now” (or the instant that `Go` is clicked). Therefore, the following sequence finishes in five seconds, not in twelve:

```plaintext
Schedule( 3, Print( "hello" ) );
Schedule( 4, Print( ", world" ) );
Schedule( 5, Print( "--bye" ) );
```

To cancel all events in a schedule queue, use `Clear Schedule`.

```plaintext
scheduler[1] << Clear Schedule();
```

**Note:** It is not possible to create multiple threads using `Schedule`. 
Table 8.9 Schedule commands

<table>
<thead>
<tr>
<th>Message</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>sc=Schedule(n, script)</td>
<td>Queues an event to run the script after ( n ) seconds.</td>
</tr>
<tr>
<td>Clear Schedule</td>
<td>sc&lt;&lt;Clear Schedule()</td>
<td>Cancels all events in a schedule queue.</td>
</tr>
</tbody>
</table>

**Functions that Communicate with Users**

Show(), Print(), and Write() put messages in the log window. Speak(), Caption(), Beep(), and StatusMsg() provide ways to say something to a viewer. Mail() can send an e-mail alert to a process operator.

JMP’s scripting language has methods for constructing dialog boxes to ask for data column choices and other types of information. See “Modal Windows” on page 502 in the “Display Trees” chapter.

**Tip:** To preserve locale-specific numeric formatting in Show(), Print(), or Write() output, include <<Use Locale(1).

**Writing to the Log**

**Show**

Show() displays the items that you specify in the log. Notice that when you show variables, the resulting message is the variable name, an equal sign, and its current value.

```plaintext
X = 1;
A = "Hello, World";
Show( X, A, "foo" );
```

**Print**

Print() sends the message that you specify to the log. Print() is the same as Show() except that it prints only the value of each variable without the variable name and an equal sign.

```plaintext
X = 1;
A = "Hello, World";
Print( X, A, "foo" );
```
### Write

Write() sends the message that you specify to the log. Write() is the same as Print() except that it suppresses the quotation marks around the text string, and it does not start on a new line unless you include a return character yourself with the \!N escape sequence.

```javascript
// Use Write() to send messages to the log
Write( "Here is a message." );

// Use Write() to concatenate text
Write( myText || " Do not forget to buy milk." );
Write( "\!NAnd bread." );
```

The sequence \!N inserts the line breaking characters that are appropriate for the host environment. For an explanation of the three line breaking escape sequences, see “Double Quotes” on page 82 in the “JSL Building Blocks” chapter.

### Send information to the User

#### Beep

Beep() causes the user’s computer to make an alert sound.

#### Speak

Speak() reads text aloud. On Macintosh, Speak() has one Boolean option, Wait(), to specify whether JMP should wait for speaking to finish before proceeding with the next step. The default is not to wait, and you need to issue Wait(1) each time. For example, here is a script certain to drive anybody crazy. With Wait(1), you probably want to interrupt execution before too long. If you change it to Wait(0), the iterations proceed faster than the speaking possibly can and the result sounds strange. On Windows, you can use a Wait(n) command to accomplish the same effect.

```javascript
For( i = 99, i > 0, i--, 
    Speak( 
        Wait( 1 ),
        Char( i ) || " bottles of beer on the wall, " || Char( i ) || " bottles of beer; " ||
        "If one of those bottles should happen to fall, " || Char( i - 1 ) || " bottles of beer on the wall." 
    )
);```
A more practical example has JMP announce the time every sixty seconds:

```javascript
script = Expr(
    tod = Mod( Today(), In Days( 1 ) );
    hr = Floor( tod / In Hours( 1 ) );
    min = Floor( Mod( tod, In Hours( 1 ) ) / 60 );
    timeText = "time, " || Char( hr ) || " " || Char( min );
    text = Long Date( Today() ) || ", " || timeText;
    Speak( text );
    Show( text );
    Schedule( 60, script );    // seconds before next script
);
```

You might use a similar technique to have JMP alert an operator that a process has gone out of control.

### Caption

Caption() brings up a small window with a message to the viewer. Captions are a way to annotate demonstrations without adding superfluous objects to results windows. The first argument is an optional `{h,v}` screen location given in pixels from the upper left; the second argument is the text for the window. If the location argument is omitted, windows appear in the upper left corner.

You can include pauses in the playback by including the named argument `Delayed` and a time in seconds. Such a setting causes that caption and all subsequent caption windows to be delayed by that number of seconds, until a different `Delayed` setting is issued in a `Caption` statement. Use `Delayed(0)` to stop delaying altogether.

Specify the font type, font size, text color, or background color with the following arguments:

```javascript
Font( font );
Font Size( size );
Text Color("color");
Back Color("color");
```

The Spoken option causes captions to be read aloud by the operating system’s speech system (if available). Spoken takes a Boolean argument, and the current setting (on or off) remains in effect until switched by another `Caption` statement that includes a Spoken setting.

This script turns speaking on and leaves it on until the last caption. In the first caption, the font type, color, and background color is specified. Run the script and notice that the font and color settings apply only to the first caption.

```javascript
Caption(
    {10, 30},
    "A Tour of the JMP Analyses",
    Font( "Arial Black" ),
    Font Size( 20 ),
    Text Color("Blue"),
    Back Color("White"),
    Spoken(1)
);  // delays all subsequent captions
```
Font Size( 16 ),
Text Color( "blue" ),
Back Color( "yellow" ),
Spoken( 1 ),
Delayed( 5 )
);
Caption( "Open a data table." );
bigClass = Open( "$SAMPLE_DATA/Big Class.jmp" );
Caption( "A data table consists of rows and columns of data." );
Caption( "The rows are numbered and the columns are named." );
Caption( {250, 50}, "The data itself is in the grid on the right" );
Caption(
   {5, 30},
   Spoken( 0 ),
   "A panel along the left side shows columns and other attributes." );

Each new Caption hides the previous one. In other words, there is only one caption window available at a time. To close a caption without displaying a new one, use the named argument Remove.

Caption( remove );

StatusMsg

This command sends a message to the status bar.

StatusMsg( "string" );

Mail

Mail() sends an e-mail message to a user. For example, a process control manager might include a test alert script in a control chart to trigger an e-mail warning to her pager:

Mail(
   "JaneDoe@company.com",
   "out of control",
   "Process 12A out of control at " || Format( Today(), "d/m/y h:m:s" )
);

Mail() can also send an attachment with the e-mail. An optional fourth argument specifies the attachment. The attachment is transferred in binary format after its existence on the disk is verified. For example, to attach the Big Class.jmp data table, submit

Mail(
   "JohnDoe@company.com",
   "Interesting Data Set",
   "Have a look at this class data.",
   "$SAMPLE_DATA\Big Class.jmp" );
Note: On Macintosh, `Mail()` works on Mountain Lion and later operating systems. On
Mountain Lion, you must enter the e-mail address and subject in the e-mail due to operating
system limitations. Click the **Send message** button to send the e-mail.
Before you can work with a data table or with objects in a data table, you must first open the data table and assign a reference to it. In this book, \textit{dt} represents a reference to a data table object.

To manipulate an object in JSL, you send a message to the reference that represents the object, asking the object to perform one of its tasks. Messages are commands that can be understood only in context by a particular type of object. For example, messages for data table objects include Save, New Column, Sort, and so on. Most of these messages would not make sense for another object, such as a platform object.

In this chapter, you can learn the following:

- How to assign a reference to a data table
- How to send messages to the reference, resulting in specific actions
- About the different types of messages that data table objects can understand

Most of this chapter focuses on the different types of messages that you can send to data table objects, such as data tables, columns, rows, and values.

\textbf{Tip:} This chapter contains most, but not all of the JSL commands that you can use with data tables. For an exhaustive list, see the JMP Scripting Index. Select Help > Scripting Index. Select \textbf{Objects} from the menu, and then select \textbf{Data Table}. 
Tip: Keep the log window open to see the output of each script that you run. Select View > Log to open the Log window. See “Working with the Log” on page 61 in the “Scripting Tools” chapter.

The typical way to work with values in a data table is to follow these steps:

1. Set up the data table whose values you want to access as the current data table. Or, if you already have a data table reference, you can simply use that reference.
2. Specify the row or rows whose values you want to access and specify the column name that contains the values that you want to access.

The following example opens the Big Class.jmp sample data table (making it the current data table), and then specifies row 2 in the weight column. A value of 123 is returned in the log, which is the weight for Louise in row 2.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt:weight[2];
123
```

If the data table that you want to work with is already open, proceed using one of the following examples:

```
dt = Data Table( "My Table" ); // the open table named My Table
dt = Current Data Table(); // the table in the active window
dt = Data Table( 3 ); // the third open table
```

Once you have an open data table with a reference, you can send it messages using either the << operator or the Send function. The following example illustrates both methods:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Save();
Send( dt, Save() );
```

Note the following about messages:

- You can send messages to any data table object (a data table, column, row, and so on).
- Messages sent to data table objects always have the same pattern:
  `Reference << Message( Arguments );`
- Usually, creating a reference and sending many messages to the reference is the easiest approach. However, you can also use the direct route instead of using a reference if you have only one message to send. The following example saves the current data table:
  `Current Data Table() << Save();`
• You can stack up a series of messages in one statement. Commands are evaluated from left
to right, and each returns a reference to the affected object. The following example creates
a new data table called My Table, adds two columns to it, and prompts you to save it:

```
dt = New Table( "My Table" );
dt << New Column( "Column 1" ) << New Column( "Column 2" ) << Save( "" );
```

In this example, each message returns a reference to the data table (dt).

• If you specify too few arguments for a message, JMP presents a window to get the
necessary information from you. JMP often presents windows when your script is
incomplete, a behavior that you can use to your advantage when writing scripts that need
to query users for their choices.

• Some messages come in pairs; one to “set” or assign each attribute, and one to “get” or
query the current setting of each attribute.

Why are Some Commands Sent to Objects and Others Used Directly?

New Table and Open are commands to create objects that do not exist yet. Once created, you
send them messages requesting changes. To close such objects, you must close the objects’
container, because the objects cannot delete themselves.

The following example creates a table and assigns the data table reference to the dt variable.
New Column messages are sent to the data table reference. To delete one of those columns, the
Delete Columns message is sent to the data table reference, not to the column itself.

```
dt = New Table( "Airline Data" );
dt << New Column( "Date" );
dt << New Column( "Airline" );
dt << Delete Columns( "Date" );
```

How Can I See All of the Messages that Can be Sent to a Data Table Object?

To see all of the messages that can be sent to a data table object, refer to the Scripting Index:

1. Select Help > Scripting Index.
2. Select All Categories from the list.
3. Select Data Table in the list.

You can also use the Show Properties() command. This is a good approach if you want to
print or copy the list of messages. The Show Properties() command lists the messages that
you can send to a data table in the Log window. Show Properties() is a command that takes
any scriptable object (such as a data table or column) as its argument. To show properties for a
data table:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Show Properties( dt );
```

The resulting message list is hierarchical.
[Subtable] refers to a set of JMP menu commands. For example, the Tables subtable represents the JMP Tables menu, and the indented messages in this subtable correspond to commands in the Tables menu. Many messages include a short description.

Messages labeled as [Action] all result in some action being taken. Some messages are available for [Scripting Only]. Some messages take a Boolean argument, labeled as [Boolean].

The platforms in the Analyze and Graph menus appear in the properties list because you can send a platform name as a message to a data table. This launches the platform for the data table through the usual launch window. For more information about writing platform-specific scripts, see the “Scripting Platforms” chapter on page 379.

```
dt << Distribution( Y( height ) );
```

Note: In addition to data tables, Show Properties also works with platforms and display boxes.

The JMP Scripting Index provides more information about these properties. You can also run and modify sample scripts from the Scripting Index. Select Help > Scripting Index and search for the property in the Objects list.

---

**Basic Data Table Scripting**

Before you can work with data table objects, you must open or create a data table, and assign a reference to the data table. This section covers the basic actions that you can perform on a data table, such as naming, saving, resizing, and so on.

**Open a Data Table**

Use the Open() function to open a data table.

- To simply open a data table without returning a reference to it:
  ```
  Open( "$SAMPLE_DATA/Big Class.jmp" ); // open the data table
  ```

- To open a data table and retain a reference to it:
  ```
  dt = Open( "$SAMPLE_DATA/Big Class.jmp" ); // open and store a reference
  ```

The path to the data table can be a quoted literal path (absolute or relative) or an unquoted expression that yields a pathname. Relative paths are interpreted relative to the location of the .jsl file (for a saved script). For unsaved scripts, the path is relative to your primary partition (Windows) or your <username>/Documents folder (Macintosh).

```
Open( "../../My Data/Repairs.jmp" ); // relative path on Windows and Macintosh
Open( "::My Data:Repairs.jmp" ); // relative path on Macintosh
Open( "C:/My Data/Repairs.jmp" ); // absolute path
```
JMP provides shortcuts (path variables) to directories or files. Instead of entering the entire path to the directory or file, you include a path variable in the Open() expression. For example, JMP sample scripts typically use the $SAMPLE_DATA path variable to open files in the Samples/Data folder. For details about path variables, see “Path Variables” on page 121 in the “Types of Data” chapter.

If you do not want to specify the entire path every time you open a data table, define a filepath string and concatenate the path with the filename:

```plaintext
myPath = "C:/My Data/Store25/Maintenance/Expenses/";
Open( myPath || "Repairs.jmp" );
```

Upon opening a data table, JMP stores the data table in memory. This means that if a script attempts to open a data table that is already open, the opened version appears. JMP does not read the version that is saved on your computer.

**Test for an Open Data Table**

In a script that depends on an opened data table, you can test to see whether the table is open using Is Empty() or Is Scriptable(). In the following example, the script performs a Bivariate analysis on Big Class.jmp and then closes the data table. Before proceeding to the Oneway analysis later in the script, Is Scriptable() tests for the open data table. If 1 (true) is returned, the table opens, and the script continues.

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
obj = dt << Bivariate( Y( :height ), X( :age ), Fit Line );
Close( dt );
If( Not( Is Scriptable( dt ) ),
   dt = Open( "$SAMPLE_DATA/Big Class.jmp" ),
);
obj = dt << Oneway( Y( :height ), X( :age ), Means( 1 ), Mean Diamonds( 1 ) );
```

You might want to see if the data table is open and then close it to discard any changes before running another script on the data table. To test for and close Big Class.jmp, run the following script:

```plaintext
Try( Close( Data Table( "Big Class" ) ) );
```

**Prompt Users to Open a Data Table**

You can use an If() expression to prompt a user to open a data table, if no open data table is found. And if they do not select a table, the script should end. The following script shows an example:

```plaintext
dt = Current Data Table();
If( Is Empty( dt ),
   Try( dt = Open(), Throw( "No data table found" ) )
);
```
The user is prompted to open a data table. If the user clicks Cancel instead of opening a data table, an error appears in the log.

**Show Only Specific Columns**

To open a data table and show only a specific set of columns, identify those columns in the `Open()` expression. This is particularly helpful with a large data table in which only a few columns are necessary.

The following example opens `Big Class.jmp` and includes only the `age`, `height`, and `weight` columns.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp", Select Columns( "age", "height", "weight" ) );
```

You can also specify the columns to leave out of the open data table:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp", Ignore Columns( "name", "sex" ) );
```

**Create a New Data Table**

You can start a new data table, or start a new data table and store its reference in a global variable. In either case, specify the table name as an argument.

```julia
New Table( "My Table" );
```

or

```julia
dt = New Table( "My Table" );
```

The following sections describe the optional arguments for the `New Table()` function.

**Private, Invisible, and Visible**

The optional visibility argument specifies whether the new data table is shown. `visibility( "invisible" )` hides the data table from view; it appears only in the JMP Home Window and the Window menu. `visibility( "private" )` avoids opening the data table. `visibility( "visible" )` shows the data table. "visible" is the default value.

```julia
New Table( "My Table", visibility( "private" ) );
```

Making a table private can prevent memory problems when a script opens and closes many tables. Private data tables have no physical window, so less memory is required than with invisible tables.

**Note:** The advantages of using private data tables is based on the size of the data in the table. If the data table has only five columns and 20 rows, the savings for a private data table is substantial. However, for a table with 100 columns and 1,000,000 rows, using a private data table is not helpful because the data requires a lot of memory.
Actions

An optional argument that can define the new table. For example, the following script creates a new data table named *Little Class*. It adds three rows and two named columns as well as entering values for each cell in the table:

```javascript
dt = New Table( "Little Class",
    Add Rows( 3 ),
    New Column( "name",
        Character,
        "Nominal",
        Set Values( {"KATIE", "LOUISE", "JANE"} )
    ),
    New Column( "height",
        "Continuous",
        Set Values( [59, 61, 55] )
    )
);
```

Import Data

Upon importing, JMP converts file types such as text files and Microsoft Excel files to the data table format. On Windows, JMP relies on three-letter filename extensions to identify the type of file and how to interpret its contents. Here are some examples of filename extensions identified by JMP:

```javascript
Open( "$SAMPLE_IMPORT_DATA/Bigclass.xlsx" ); // Microsoft Excel file
Open( "$SAMPLE_IMPORT_DATA/Bigclass.txt" ); // text file
Open( "$SAMPLE_IMPORT_DATA/Carpoll.xpt" ); // SAS transport file
```

On Macintosh, JMP relies on the Macintosh Type and Creator codes (if present) and secondarily on three-letter filename extensions. Be sure to add the file extension before importing the file on Macintosh.

- Type and Creator codes are invisible data that enable the Finder to display a file with the correct icon corresponding to the application that created it.
- Files with generic icons should have the filename extensions (as with files created on other operating system).

```javascript
Open( "$SAMPLE_IMPORT_DATA/Bigclass.txt", text );
```

Additional supported formats include .csv, .jsl, .dat, .tsv, and .jrn.

For more detailed information about import options, refer to the JSL Functions chapter in the *JSL Syntax Reference*. 
Import Data from a Text File

The Import Settings in the Text Data Files preferences determine how text files are imported. For example, column names begin on line one and data begin on line two by default. To use different settings, specify the import settings as Open() options in your script.

The default Import Settings and your custom import settings are saved in the data table Source script, so you can reimport the data using the same settings. However, the default Import Settings are optional in the script.

The following Open() options are available:

 CharSet("option")
   // "Best Guess", "utf-8", "utf-16", "us-ascii", "windows-1252",
   "x-max-roman", "x-mac-japanese", "shift-jis", "euc-jp", "utf-16be",
   "gb2312"
 Number of Columns(Number)
 Columns(colName=colType(colWidth),... )
   // colType is Character|Numeric
   // colWidth is an integer specifying the width of the column
 Treat Empty Columns as Numeric(Boolean)
 Scan Whole File(Boolean)
 End Of Field(Tab|Space|Comma|Semicolon|Other|None)
 EOF Other("char")
 End Of Line(CRLF|CR|LF|Semicolon|Other)
 EOL Other("Char")
 Strip Quotes|Strip Enclosing Quotes(Boolean)
 Labels | Table Contains Column Headers(Boolean)
 Year Rule | Two digit year rule ("Decade Start")
 Column Names Start | Column Names are on line(Number)
 Data Starts | Data Starts on Line(Number)
 Lines to Read(Number)
 Use Apostrophe as Quotation Mark
 CompressNumericColumns(Boolean)
 CompressCharacterColumns(Boolean)
 CompressAllowListCheck(Boolean)

The following script opens a text file of comma-delimited text, which includes no column names. The script defines the column names and the column widths.

 Open(
   "$SAMPLE_IMPORT_DATA/EOF_comma.txt",
   End Of Field( comma ),
   Labels( 0 ),
   Columns(
      name = Character( 12 ),
      age = Numeric( 5 ),
      sex = Character( 5 ),
   ),
)


Here is an example of opening a text file in which the field separator is a space:

```javascript
Open(
    "$SAMPLE_IMPORT_DATA/EOF_space.txt",
    Labels( 0 ),
    End of Field( Space )
);
```

To set the import options interactively, include the `Text Wizard` argument. A preview of the text file opens in the text import window.

```javascript
Open( "$SAMPLE_IMPORT_DATA/EOF_space.txt", "Text Wizard" );
```

The following sections describe each argument in more detail. For more detailed information about import options, refer to the JSL Functions chapter in the *JSL Syntax Reference*.

**Number of Columns**

Specifies the number of columns in the source file. This option is important if data is not clearly delimited.

**Columns**

Identifies column names, column types, and column widths with a `Columns` argument as shown in the preceding examples.

If you specify settings for a column other than the first column in the file, you must also specify settings for all the columns that precede it. Suppose that you want to open a text file that has four columns (`name`, `sex`, and `age`, and `ID`, in that order). `age` is a numeric column, and the width should be 5. You must also set the `name` and `sex` column types and widths, and list them in the same order:

```javascript
Columns(
    name = Character( 15 ),
    sex = Character( 5 ),
    age = Numeric( 5 )
);
```

You are not required to provide settings for any columns that follow the one that you want to set (in this example, `ID`).

After the data is imported, you use the modeling type for a column. See “Set or Get Data and Modeling Types” on page 331.
Note: Most of the following arguments are defined in the JMP preferences. To override the preference, include the corresponding argument described below in your import scripts.

Treat Empty Columns as Numeric
Imports columns of missing data as numeric rather than character data. A period, Unicode dot, NaN, or a blank string are possible missing value indicators. This is a Boolean value. The default value is false.

Scan Whole File
Specifies how long JMP scans the file to determine data types for the columns. This is a Boolean value. The default value is true; the entire file is scanned until the data type is determined. To import large files, consider setting the value to false, which scans the file for five seconds.

Strip Quotes | Strip Enclosing Quotes
Specifies whether to include or remove the double quotation marks (" ) that surround string values. This is a Boolean value. The default value is true.

For example, suppose that the field delimiter is a space:

- John Doe is interpreted as two separate strings (John and Doe).
- "John Doe" is interpreted as a single string. Most programs (including JMP) read a quotation mark and ignore other field delimiters until the second quotation occurs.
- If you include Strip Quotes(1), "John Doe" is interpreted as John Doe (one string without quotation marks).

Note that many word processors have a “smart quotation marks” feature that automatically converts double quotation marks (" ) into left and right curled quotation marks (“ ”). Smart quotation marks are interpreted literally as characters when the text file is imported, even when JMP strips double quotation marks.

End of Line (CR | LF | CRLF | Semicolon | Other)
Specifies the character or characters that separate rows. The choices are as follows:

- CR for carriage returns (typical for text files created on Macintosh OS up to version 9)
- LF for linefeeds (typical for UNIX and Macintosh OS X text files)
- CRLF for both a carriage return followed by a linefeed (typical for Windows text files).

All three characters are line delimiters by default.
Use the Other option to use an additional character for the row separator, which you must specify in the EOLOther argument. JMP interprets either this character or the default character as a row separator.

**End of Field (Tab | Space | Spaces | Comma | Semicolon | Other | None)**

Specifies the character or characters used to separate fields. Note the following:

- The default field delimiter is Tab.
- Use the Other option to use a different character for the field separator, which you must specify in the EOFOther argument.
- The Space option uses a single space as a delimiter.
- The Spaces option uses two or more spaces.

**EOFOther, EOLOther**

Specifies the character or characters used to separate fields or rows. For example, EOLOther("*") indicates that an asterisk separates rows in the text file.

**Labels | Table Contains Column Headers**

Indicates whether the first line of the text file contains column names. This is a Boolean value. The default value is true.

**Year Rule | Two Digit Year Rule**

Specifies how to import two-digit year values. If the earliest date is 1979, specify "1970". If the earliest date is 2001, specify "20xx".

**Column Names Start | Column Names Are on Line**

Specifies the starting line for column names. The following example specifies that the column names in the text file start on line three.

```julia
Open("$SAMPLE_IMPORT_DATA/Animals_line3.txt",
       Columns(
           Column( "species", Character, "Nominal" ),
           Column( "subject", Numeric, "Continuous", Format( "Best", 10 ) ),
           Column( "miles", Numeric, "Continuous", Format( "Best", 10 ) ),
           Column( "season", Character, "Nominal" )
       ),
       Column Names Start( 3 )
     );
```
Data Starts | Data Starts on Line

Specifies the starting line for data.

The following example specifies that the data in the text file start on line five.

```plaintext
Open(
"$SAMPLE_IMPORT_DATA/Bigclass_L.txt",
Columns(
  Column( "name", Character, "Nominal" ),
  Column( "age", Numeric, "Continuous", Format( "Best", 10 ) ),
  Column( "sex", Character, "Nominal" ),
  Column( "height", Numeric, "Continuous", Format( "Best", 10 ) ),
  Column( "weight", Numeric, "Continuous", Format( "Best", 10 ) )
),
Data Starts( 5 )
);
```

Lines to Read

Specifies the number of lines to include in the data table. JMP starts counting after column names are read.

The following example includes only the first 10 lines in the data table.

```plaintext
Open(
"$SAMPLE_IMPORT_DATA/Bigclass_L.txt",
Columns(
  Column( "name", Character, "Nominal" ),
  Column( "age", Numeric, "Continuous", Format( "Best", 10 ) ),
  Column( "sex", Character, "Nominal" ),
  Column( "height", Numeric, "Continuous", Format( "Best", 10 ) ),
  Column( "weight", Numeric, "Continuous", Format( "Best", 10 ) )
),
Lines To Read( 10 )
);
```

Use Apostrophe as Quotation Mark

For data that are enclosed in apostrophes, this option treats apostrophes as quotation marks and omits them. For example, ’2010’ is imported as 2. This is a Boolean value. The default value is false.

This option is not recommended unless your data comes from a nonstandard source that places apostrophes around data fields rather than quotation marks.
Import Data from a Microsoft Excel File

When you open a Microsoft Excel workbook in JMP, the file is converted to a data table. JMP supports .xls, .xlsm, and .xlsx formats. See the Import Your Data chapter in the Using JMP book for details about Microsoft Excel support.

In the JMP preferences, settings in the General group can help determine how worksheets are imported:

- **Excel Open Method** specifies how a Microsoft Excel file should be opened by default, when using a non-specific open statement.
  - **Use Excel Wizard** opens the Excel Import Wizard to import the file. This is the default setting.
  - **Open All Sheets** opens all worksheets in the Microsoft Excel file.
  - **Select Individual Worksheets** prompts users to select one or more worksheets when they open the file.

- **Use Excel Labels as Headings** determines whether text in the first row of the worksheet is converted to column headings in the data table.

  By default, JMP takes the best guess. If names have been defined for all cells in the first row, the text in those cells is converted to column heading. Otherwise, columns are named Column 1, Column 2, and so on.

To override a preference, include the corresponding argument described below in your JSL scripts.

**Open a Workbook in the Excel Import Wizard**

The Excel Import Wizard shows a preview of the data and lets you modify the settings before importing the data. Specify "Excel Wizard" as the argument.

```
Open( "$SAMPLE_IMPORT_DATA/Team Results.xlsx", "Excel Wizard" );
```

**Notes:**

- The Excel Open Method preference applies when you run the Open() expression with no argument and select another open method using the down arrow on the Open button.
- When you click a custom button to open a workbook, the Excel Open Method preference applies. To force the worksheet to open directly, specify the Excel Open Method in your script:

```
Preference( Excel Open Method( "Open All Sheets" ) );
```
Import Specific Worksheets

Suppose that you want to import data from specific worksheets in your workbook. Specify those worksheets using the **Worksheets** argument. In the following example, the worksheet named *small* is imported into JMP.

```
Open( "C:\My Data\cars.xlsx", Worksheets( "small" ) );
```

Or specify the number of the worksheet, the third worksheet in the following example:

```
Open( "C:\My Data\cars.xlsx", Worksheets("3") );
```

Import multiple or all worksheets by including the worksheet names in a list:

```
Open( "C:\My Data\cars.xlsx", Worksheets( {"small", "medium", "large"} ) );
```

Import SAS Data Sets

Open a SAS file as a data table without connecting to a SAS server.

```
sasxpt = Open( "$SAMPLE_IMPORT_DATA/carpoll.xpt" );
```

To convert the labels to column headings, include the **Use Labels for Var Names** argument.

```
sasdbf = Open( "$SAMPLE_IMPORT_DATA/Bigclass.sas7bdat", Use Labels for Var Names( 1 ) );
```

.xpt and .stx file formats are also supported.

On Windows, you can also open SAS data sets from a SAS server. See “Connect to a SAS Metadata Server” on page 635 in the “Extending JMP” chapter for details.

Import Web Pages and Remote Files

You can import data from websites or from other computers. The data might be a JMP data table, a table defined in a web page, or another file type that JMP supports.

**Open or Import Data from a Website**

In the `Open()` command, specify the quoted URL to open a file from a website. You can open JMP data tables or other supported file types this way.

```
Open( "http://company1.com/Repairs.jmp" );
Open( "http://company1.com/My Data.txt", text); // specify text on Macintosh
```

**Import a Web Page**

A web page can include data in tabular format. Import the table as a JMP data table as follows:

```
Open( "http://company1.com", HTML Table( n ) );
```
identifies which table you want to import. For example, to import the fourth table on the page, specify HTML Table(4). If you omit the value, only the first table on the page is imported.

JMP attempts to preserve the table header defined in a <th> HTML tag. The table header is converted to column headings in the data table. If the <th> tag is wrong or missing, use ColumnNames(n) to specify the nth row. By default, DataStarts(n) will be the next row, or you can specify the DataStarts row.

**Import a File from a Shared Computer**

JMP can import files stored on a shared computer, such as another computer or a network drive. The file path can be absolute or relative. The following examples show how to open files from a shared computer named Data. If you plan to share the script, it’s safer to use a relative path to the computer, not a path to the mapped drive.

```
Open( "\\Data\Repairs.jmp" );
Open( "\\Data\My Data.txt" );
```

**Import HDF5 Files**

Hierarchical Data Format, Version 5 (HDF5) is a portable file format for storing data. An HDF5 file consists of groups and datasets. When you import the file, JMP opens a group to present the names of the inner datasets.

JMP handles only tables with numeric (integer, float, double) and string types, and compound files with three or fewer dimensions that contain only simple types.

You can import up to 1,000,000 columns and an unbounded number of rows.

The syntax is as follows:

```
Open( "filename.h5", {"list_of", "dataset_names"});
```

Errors are written to the log when invalid data set names are passed.

**Import ESRI Shapefiles**

An ESRI shapefile is a geospatial vector data format used to create maps. JMP imports shapefiles as data tables. A .shp shapefile consists of coordinates for each shape. A .dbf shapefile includes values that refer to regions. To create maps in JMP, you modify the structure of the data and save the files with specific suffixes.

The following example imports a .shp file and saves it with the -XY suffix.

```
dt = Open( "$SAMPLE_IMPORT_DATA/Parishes.shp",
:X << Format( "Longitude DDD", 14, 4 );
:Y << Format( "Latitude DDD", 14, 4 ));
dt << Save( "c:/Parishes-XY.jmp" );
```
Save the .dbf file with the -Name suffix.

```javascript
   dt = Open( "$SAMPLE_IMPORT_DATA/Parishes.dbf" );
   dt << Save( "c:/Parishes-Name.jmp" );
```

Restructuring the data requires several steps, including adding a Map Role column property to names in the -Name.jmp file. For details, see the Create Maps chapter in the Essential Graphing book.

**Import a Password-Protected Microsoft Excel 2007 File**

JMP does not support importing password-protected .xlsx files. Import password-protected Excel 2007 .xls files by including the Password argument.

```javascript
   Open( "Housing.xls", Password( "helloworld" ) );
```

**Note:** Password-protected Excel version 2010 and 2013 .xlsx files are not supported even if you save the file as .xls.

**Import a Database**

Open Database() opens a database using Open Database Connectivity (ODBC) and extracts data into a JMP data table. See the “Database Access” on page 629 in the “Extending JMP” chapter for more information.

JMP also converts DataBase Files (.dbf) files to data table format.

```javascript
   sasdbf = Open( "$SAMPLE_IMPORT_DATA/Bigclass.dbf",
                  Use Labels for Var Names( 1 )
   );
```

**Set the Current Data Table**

**Tip:** Be careful about assuming that the data table that you want is the current data table, even if you set it to be earlier in your script, because interim actions could change that.

A data table becomes the current data table in the following instances:

- When you open it, as follows:
  ```javascript
  dt1 = Open( "$SAMPLE_DATA/Big Class.jmp" );
  ```
- When you create a new table, as follows:
  ```javascript
  dt2 = New Table( "Cities" );
  ```

To switch to another open data table, specify the name of the data table in Current Data Table():

```javascript
   dt1 = Open( "$SAMPLE_DATA/Big Class.jmp" );
```
dt2 = New Table( "Cities" );
Current Data Table( dt1 ); // makes Big Class.jmp the current data table

Current Data Table() can also take a scriptable object reference as an argument. The following expression would make the data table in use by the second Bivariate object the current data table:

Current Data Table( Bivariate[2] );

For more information about using references to analysis platform objects, see “Send Messages to a Platform” on page 383 in the “Scripting Platforms” chapter.

**Name a Data Table**

Assign a name to a data table by sending it the Set Name message. The argument is a filename in quotation marks, or something that evaluates to a filename.

```javascript
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Set Name( "New Big Class.jmp" );
```

```
s = "New Big Class";
dt << Set Name( s );
```

To retrieve the name, send a Get Name message to the data table:

```javascript
dt << Get Name();
"New Big Class"
```

**Save a Data Table**

To save a data table, send a Save message to the data table. Here are some examples:

```javascript
dt << Save(); // save using the current name
dt << Save( "Newest Big Class.jmp" ) // save as a new file
dt << Save( "c:/My Data/New Big Class.jmp" ); // save as a new file
dt << Save( "My Table", JMP( 5 ) ); // save as JMP 5 table
dt << Save(""); // prompt to select the directory and save in the desired format
dt << Save( "Big Class.xls" ); // save as a Microsoft Excel file
Generate Excel Workbook( "c:\MyData\data.xlsx", {"Abrasion", "Big Class"}, {"Abrasive", "Class"} ); // save several data table as a workbook
```

**Note:** If you specify the filename with no path and have not set the default directory, the file is saved on your primary partition (Windows) or in your `<username>/Documents` folder (Macintosh). For details about setting the default directory, see “Relative Paths” on page 125 in the “Types of Data” chapter.
On Windows, saving with a .txt extension exports according to the Text Export preferences. On Macintosh, add Text as a second argument to the Save function, as follows:

\[
\text{dt} \leftarrow \text{Save( "New Big Class.txt", Text );}
\]

If you plan to set the name of a data table and later send the Save message, you can just specify the name in a Save message.

\[
\begin{align*}
\text{dt} & \leftarrow \text{Set Name( "New Big Class.jmp" );} \\
\text{dt} & \leftarrow \text{Save();}
\end{align*}
\]

works the same as

\[
\text{dt} \leftarrow \text{Save( "New Big Class.jmp" );}
\]

Including Save and the pathname is also an alternative to using Save As along with the pathname.

**Revert to a Saved Data Table**

To return to the most recently saved data table, send a Revert message to the data table.

\[
\text{dt} \leftarrow \text{Revert();}
\]

**Hide a Data Table**

There are two ways to hide a data table if the user does not need to see the table: by opening it as invisible or private.

**Invisible Data Tables**

An invisible data table is hidden from view but linked to analyses that you run on it. Open a data table as an invisible file as follows:

\[
\text{dt} \leftarrow \text{Open( "$SAMPLE_DATA/Big Class.jmp", "invisible" );}
\]

Here is an example of creating an invisible table, called Abc, that has ten rows. One column is named X.

\[
\text{dt} \leftarrow \text{New Table( "Abc", "invisible", New Column("X" ), Add Rows( 10 ) );}
\]

To find out if an open data table is invisible, pass the Boolean Has Data View message to the data table object. The following expression returns 0 (false) if the data table is invisible:

\[
\text{dt} \leftarrow \text{Has Data View();}
\]

After you are finished with an invisible data table, do not forget to close it with the Close() function. Otherwise, the data table remains in memory until you quit JMP.
Showing an Invisible Data Table

The `Show Window()` function shows an invisible data table.

```javascript
  dt = Open( "$SAMPLE_DATA/Big Class.jmp", "invisible" );
  dt << Show Window( 1 );
```

The user has the option of opening the table from the JMP interface. On Windows, an invisible data table appears in the Window List on the Home Window and the `Window > Unhide` menu. On Macintosh, the data table appears in the JMP Home window and the `Window > Hidden` menu.

Private Data Tables

Completely hide the data table from view by including the `private` argument:

```javascript
  dt = Open( "$SAMPLE_DATA/Big Class.jmp", "private" );
```

Making a table private can prevent memory problems when a script opens and closes many tables. Private data tables have no physical window, so less memory is required than with invisible tables.

As with invisible tables, analyses that are run on a private data table are linked to the table. To avoid losing a private data table, you must assign it a reference as shown in the preceding example. Otherwise, JMP immediately removes the private data table from memory. Additional uses of the table later in the script generate errors.

**Note:** The advantages of using private data tables is based on the size of the data in the table. If the data table has only five columns and 20 rows, the savings for a private data table is substantial. However, for a table with 100 columns and 1,000,000 rows, using a private data table is not helpful because the data requires a lot of memory.

Print a Data Table

Print a data table by sending it a `Print Window` message. JMP uses your computer’s default printer settings.

```javascript
  dt << Print Window();
```

This message also applies to other display boxes.

Resize a Data Table

```javascript
  dt << Maximize Display
```
forces the data table to re-measure all of its columns and zoom to the best-sized window.
**Close a Data Table**

To close a data table, use a `Close` command with the data table’s reference as the argument. Data tables with unsaved changes are saved automatically, including any linked tables. Reports and graphs generated from the data tables are also closed.

To save and close the data table:

```julia
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
    Close( dt );
```

To close the data table without saving changes:

```julia
    Close( dt, No Save );
```

To save a copy with a new name and then close the original version:

```julia
    Close( dt, Save("c:/My File.jmp") );
```

You can also close all data tables at once and either save or discard changes:

```julia
    Close All( Data Tables );
    Close All( Data Tables, No Save );
```

To close all private or invisible data tables, specify the appropriate argument:

```julia
    Close All( Data Tables, private );
    Close All( Data Tables, invisible );
```

**Tip:** `Close All()` also works with journals and layouts. Specify “Journals” or “Layouts” in the argument.

---

**Set and Get a Data Table**

To specify the data table in a display box, for example, in `New Data Box()`, use `Set Data Table()` and `Get Data Table()` to set and return a data table.

The following example uses the `Big Class.jmp` and `Cities.jmp` sample data tables. The sample data tables are opened invisibly. In a new window, a new data box is created containing `Big Class.jmp`. After waiting 1 second, the data box contents change to display `cities.jmp`.

```julia
dtC = Open( "SAMPLE_DATA/Cities.jmp", "invisible" );
dtA = Open( "SAMPLE_DATA/Big Class.jmp", "invisible" );
nw = New Window( "My Table", H List Box( dtBox = dtA << New Data Box() ) );
Wait( 1.0 );
dtBox << Set Data Table( Data Table( "Cities.jmp" ) );
```
Perform Actions on All Open Data Tables

If you want to perform an action on all of the data tables that are currently open, use N Table() to get a list of references to each one:

```julia
data_table_1 = Open( "$SAMPLE_DATA/Cities.jmp" );
data_table_2 = Open( "$SAMPLE_DATA/Big Class.jmp" );
openDTs = List();
For( i = 1, i <= N Table(), i++,
    Insert Into( openDTs, Data Table( i ) );
);
```

openDTs now is a list of references to all open data tables. You can send messages to any one by using openDTs(n). You can use a for loop to send messages to all of the open data tables. This loop adds a new column named My Column to each open data table.

```julia
For( i = 1, i <= N Items( openDTs ), i++,
    openDTs[i] << New Column( "My Column" );
);
```

If you just want a list of table names and not references, use the Get Name message:

```julia
For( i = 1, i <= N Table(), i++,
    Insert Into( openDTs, Data Table( i ) << Get Name() );
);
```

You can then use the list of table names to put the names of all of the open data tables in a list box (window) so that the user can choose and perform tables operations. Or, you can write the names out to a file.

Create Journals and Layouts

Journals consist of JMP graphs and reports, graphics, text, and links to items such as web pages and files. They make it easy to reuse content in presentations and import into other documents.

Layouts enable you to combine several reports or rearrange report elements before saving them in one layout file.

The basic syntax for journals and layouts appears as follows:

```julia
data << Journal;
data << Layout;
```

You can also create a new journal window and immediately add to it within the New Window() command. The following examples create an empty untitled journal and layout:

```julia
New Window( <<  Journal);
New Window( <<  Layout);
```
The following examples create an empty journal and layout named “Sales”:

```plaintext
New Window( "Sales", << Journal );
New Window( "Sales", << Layout );
```

Here is an example of creating a journal named “Test Buttons” that contains two buttons.

```plaintext
New Window( "Test Buttons", << Journal,
            Button Box( "Test One", New Window( "Hi there1", << Modal ) ),
            Button Box( "Test Two", New Window( "Hi there2", << Modal ) )
 );
```

**Capturing Journals**

There is an optional argument in the journal and journal window commands. This argument captures (or freezes) the current display. That is, it converts the display tree with just a picture.

The four options for arguments are as follows:

- Makes a bitmap “snapshot” of the display when it is sent to the journal, rather than sending a clone of the more editable display box structure to the journal. By freezing the display into a bitmap, references to variables from scripts in graphs are less problematic.
  ```plaintext
  << Journal("Freeze All");
  ```

- Similar to Freeze All but only within areas of a report called pictures.
  ```plaintext
  << Journal("Freeze Pictures");
  ```

- Similar to Freeze Pictures but only within frame boxes (which are within pictures).
  ```plaintext
  << Journal("Freeze Frames");
  ```

- Similar to Freeze Frames but only for the frame boxes that have scripts to draw something on them.
  ```plaintext
  << Journal("Freeze Frames with Scripts");
  ```

**Current Journal**

`Current Journal()` returns a reference to the display box at the top of the current journal display window. If no journal is open, one is created. There are no arguments.

You can add to the journal using the Append command. The following example adds a text box to the bottom of the current journal:

```plaintext
Current Journal() << Append( Text Box( "Hello World" ) );
```

You can also find items in an existing journal by enclosing the search specification in square brackets. Suppose that the current journal includes the string “Parameter Estimates”. The following script appends a text box to the bottom of that journal:

```plaintext
Current Journal()["Parameter Estimates"] << Append( Text Box( "Asterisks show items significant at 0.05" ) );
```
Advanced Data Table Scripting

This section covers more advanced actions that you can perform on a data table, which includes collecting summary statistics, subsetting, sorting, concatenating, and so on.

Store Summary Statistics in Global Variables

The `Summarize` command collects summary statistics for a data table and stores them in global variables. The `Summarize` command is different from the `Summary` command, which also calculates summary statistics, but presents them in a new data table.

The first argument is an optional data table reference. Include it if more than one data table might be open.

```r
dt1 = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt2 = Open( "$SAMPLE_DATA/Animals.jmp" );
Summarize( dt1,
    exg = By( :sex ),
    exm = Mean( :height )
);
Show( exg );
Show( exm );
```

Named arguments include the following: `Count`, `Sum`, `Mean`, `Min`, `Max`, `StdDev`, `First`, `Corr`, and `Quantile`. These statistics can be calculated only for numeric columns. Each argument takes a data column argument.

Note the following:

- If a `name=By(groupvar)` statement is included, then a list of subgroup statistics is assigned to each `name`.
- `Count` does not require a column argument, but it is often useful to specify a column to count the number of nonmissing values.
- `Quantile` also takes a second argument for specifying which quantile, such as 0.1 for the 10th percentile.

**Note:** Excluded rows are excluded from `Summarize` calculations. If all data are excluded, `Summarize` returns lists of missing values. If all data have been deleted (there are no rows), `Summarize` returns empty lists.

The following example uses the Big Class sample data table:

```r
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Summarize(
    a = By( :age ),
    c = Count,
```
Because the script included a By group, the results are a list and six matrices:

\[
\begin{align*}
\text{a} &= \{"12", "13", "14", "15", "16", "17"\} \\
\text{c} &= [8, 7, 12, 7, 3, 3] \\
\text{sumHt} &= [465, 422, 770, 452, 193, 200] \\
\text{meanHt} &= [58.125, 60.28571428571428, 64.16666666666667, 64.57142857142857, 64.33333333333333, 66.66666666666667] \\
\text{minHt} &= [51, 56, 61, 62, 60, 62] \\
\text{maxHt} &= [66, 65, 69, 67, 68, 70] \\
\text{sdHt} &= [5.083235752381126, 3.039423504234876, 2.367712103711172, 1.988059594776032, 4.041451884327343, 4.163331998932229] \\
\text{q10Ht} &= [51, 56, 61.3, 62, 60, 62]
\end{align*}
\]

You can format the results using TableBox.

```
New Window( "Summary Results",
  Table Box(
    String Col Box( "Age", a ),
    Number Col Box( "Count", c ),
    Number Col Box( "Sum", sumHt ),
    Number Col Box( "Mean", meanHt ),
    Number Col Box( "Min", minHt ),
    Number Col Box( "Max", maxHt ),
    Number Col Box( "SD", sdHt ),
    Number Col Box( "Q10", q10Ht )
  ));
```

**Figure 9.1** Results from Summarize

<table>
<thead>
<tr>
<th>Age</th>
<th>Count</th>
<th>Sum</th>
<th>Mean</th>
<th>Min</th>
<th>Max</th>
<th>SD</th>
<th>Q10</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>8</td>
<td>465</td>
<td>58.125</td>
<td>51</td>
<td>66</td>
<td>5.0832</td>
<td>51</td>
</tr>
<tr>
<td>13</td>
<td>7</td>
<td>422</td>
<td>60.286</td>
<td>56</td>
<td>65</td>
<td>3.0394</td>
<td>56</td>
</tr>
<tr>
<td>14</td>
<td>12</td>
<td>770</td>
<td>64.167</td>
<td>61</td>
<td>69</td>
<td>2.3677</td>
<td>61</td>
</tr>
<tr>
<td>15</td>
<td>7</td>
<td>452</td>
<td>64.571</td>
<td>62</td>
<td>67</td>
<td>1.9880</td>
<td>62</td>
</tr>
<tr>
<td>16</td>
<td>3</td>
<td>193</td>
<td>64.333</td>
<td>60</td>
<td>68</td>
<td>4.0415</td>
<td>60</td>
</tr>
<tr>
<td>17</td>
<td>3</td>
<td>200</td>
<td>68.667</td>
<td>62</td>
<td>70</td>
<td>4.1833</td>
<td>62</td>
</tr>
</tbody>
</table>

You can add totals to the window, as follows:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Summarize(
```

a = By( :age ),
c = Count,
sumHt = Sum( :height ),
meanHt = Mean( :height ),
minHt = Min( :height ),
maxHt = Max( :height ),
sdHt = Std Dev( :height ),
q10Ht = Quantile( :height, .10 )
);

Summarize(
  tc = Count,
  tsumHt = Sum( :height ),
  tmeanHt = Mean( :height ),
  tminHt = Min( :height ),
  tmaxHt = Max( :height ),
  tsdHt = Std Dev( :height ),
  tq10Ht = Quantile( :height, .10 )
);

Insert Into( a, "Total" );
c = c |/ tc;
sumHt = sumHt |/ tsumHt;
meanHt = meanHt |/ tmeanHt;
minHt = minHt |/ tminHt;
maxHt = maxHt |/ tmaxHt;
sdHt = sdHt |/ tsdHt;
q10Ht = q10Ht |/ tq10Ht;

New Window( "Summary Results",
  Table Box(
    String Col Box( "Age", a ),
    Number Col Box( "Count", c ),
    Number Col Box( "Sum", sumHt ),
    Number Col Box( "Mean", meanHt ),
    Number Col Box( "Min", minHt ),
    Number Col Box( "Max", maxHt ),
    Number Col Box( "SD", sdHt ),
    Number Col Box( "Q10", q10Ht )
  )
);
Figure 9.2 Summarize with Total

<table>
<thead>
<tr>
<th>Age</th>
<th>Count</th>
<th>Sum</th>
<th>Mean</th>
<th>Min</th>
<th>Max</th>
<th>SD</th>
<th>Q10</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>8</td>
<td>465</td>
<td>58.125</td>
<td>51</td>
<td>68</td>
<td>5.08324</td>
<td>51</td>
</tr>
<tr>
<td>13</td>
<td>7</td>
<td>422</td>
<td>60.0957</td>
<td>56</td>
<td>65</td>
<td>3.03942</td>
<td>56</td>
</tr>
<tr>
<td>14</td>
<td>12</td>
<td>770</td>
<td>64.1867</td>
<td>81</td>
<td>92</td>
<td>2.38771</td>
<td>81.3</td>
</tr>
<tr>
<td>15</td>
<td>7</td>
<td>452</td>
<td>64.514</td>
<td>82</td>
<td>67</td>
<td>1.90806</td>
<td>62</td>
</tr>
<tr>
<td>16</td>
<td>3</td>
<td>193</td>
<td>64.3333</td>
<td>80</td>
<td>80</td>
<td>4.04145</td>
<td>60</td>
</tr>
<tr>
<td>17</td>
<td>3</td>
<td>200</td>
<td>66.6667</td>
<td>82</td>
<td>70</td>
<td>4.18333</td>
<td>62</td>
</tr>
<tr>
<td>Total</td>
<td>40</td>
<td>2502</td>
<td>62.55</td>
<td>51</td>
<td>70</td>
<td>4.24204</td>
<td>56.2</td>
</tr>
</tbody>
</table>

If you do not specify a By group, the result in each name is a single value, as follows:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Summarize( // a = By( :age ),
c = Count,
    sumHt = Sum( :height ),
    meanHt = Mean( :height ),
    minHt = Min( :height ),
    maxHt = Max( :height ),
    sdHt = Std Dev( :height ),
    q10Ht = Quantile( :height, .10 )
);
Show( c, sumHt, meanHt, minHt, maxHt, sdHt, q10Ht );
c = 40;
sumHt = 2502;
meanHt = 62.55;
minHt = 51;
maxHt = 70;
sdHt = 4.2423384937192;
q10Ht = 56.2;
```

Summarize supports multiple By groups. For example, in Big Class.jmp, proceed as follows:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Summarize( g = By( :age, :sex ), c = Count() );
Show( g, c );
c = [5,3,3,4,5,7,2,5,2,1,1,2]
```

If you specify a By group, the results are always matrices. Otherwise, the results are scalars.

### Create a Table of Summary Statistics

The Summary command creates a new table of summary statistics according to the grouping columns that you specify. Do not confuse Summary with Summarize, which collects summary statistics for a data table and stores them in global variables. See “Store Summary Statistics in Global Variables” on page 297 for details.

```julia
summDt = dt << Summary(
```
Group( groupingColumns ),
Subgroup( subGroupColumn ),
Statistic( columns ),// where statistic is Mean, Min, Max, Std Dev, and so on.
Output Table Name( newName );

The following example creates a new table with columns for the mean of height and weight by age, and the maximum height and minimum weight by age:

```
   dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
   summDt = dt << Summary(
      Group( :age ),
      Mean( :height, :weight ), Max( :height ), Min( :weight ),
      Output Table Name( "Height-Weight Chart" ) );
```

**Tip:** Output Table Name can take a quoted string or a variable that is a string.

By default, a summary table is linked to the original data table. If you want to produce a summary that is not linked to the original data table, add this option to your Summary message:

```
   summDt = dt << Summary( Group( :age ), Mean( :height ),
      Link to Original Data Table( 0 )
 );
```

You can choose to add marginal statistics for grouping variables to the output columns of your data table. JMP also adds a row to the end of the data table that summarizes each level of the first grouping variable. To add marginal statistics, add this option to your Summary message:

```
   summDt = dt << Summary( Group( :age ), Mean( :height ),
      Include marginal statistics
 );
```

You can specify the format of the statistics column name using statistics column name format(). The column name can be in one of these formats:

- stat(column)
- column
- stat of column
- column stat

For example, add an option like this to your Summary message:

```
   summDt = dt << Summary( Group( :age ), Mean( :height ),
      statistics column name format("stat of column")
 );
```
Subset a Data Table

Subset() creates a new data table from rows that you specify. If you specify no rows, Subset uses the selected rows. If no rows are selected or specified, it uses all rows. If no columns are specified, it uses all columns. And if Subset has no arguments, the Subset window appears.

```
dt << Subset(
   Columns( columns ),
   Rows( row matrix ),
   Linked,
   Output Table Name( "name" ),
   Copy Formula( 1 or 0 ),
   Sampling rate( n ),
   Suppress Formula Evaluation( 1 or 0 ));
```

**Note:** For more arguments, see the Scripting Index in the Help menu.

For example, using Big Class.jmp, to select the columns for all rows in which the age is 12:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
For Each Row( Selected( Row State() ) = (:age == 12) );
subdt = dt << Subset( Output Table Name( "Subset" ) );
```

To select three columns and all rows, run this script:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
subDt1 = dt << Subset(
   Columns( :name, :age, :height ),
   Output Table Name( "Big Class 2" )
);
```

To select specified rows of two columns and link the two data tables, run this script:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
subDt2 = dt << Subset(
   Columns( :name, :weight ),
   Rows( [2, 4, 6, 8] ),
   Linked
);
```

To select the columns for all rows in which the age is 12, run this script:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Select Where( :age == 12 );
dt << Subset( ( Selected Rows ), Output Table Name( "Subset" ) );
```
Subset Data Using the Data Filter

The Data Filter provides a variety of ways to identify subsets of data. Using Data Filter commands and options, you can select complex subsets of data, hide these subsets in plots, or exclude them from analyses.

The basic syntax appears as follows:

```plaintext
dt << Data Filter( <local>, <invisible>, <Add Filter (...)> , <Mode>, <Show Window( 0 | 1 )> , <No Outline Box( 0 | 1 )> );
```

Options for Data Filter include the following:

- Add Filter, Animation, Auto Clear, Clear, Close, Columns, Conditional, Data Table Window, Delete, Delete All, Display, Get Filtered Rows, Location, Match, Mode, Report, Save and Restore Current Row States, Set Select, Set Show, Set Include, Show Column Selector, Show Subset, Use Floating Window

For more arguments, see the Scripting Index in the Help menu.

You can send an empty Data Filter message to a data table, and the initial Data Filter window appears, showing the Add Filter Columns panel that lists all the variables in the data table.

Mode takes three arguments, all of which are optional: Select(bool), Show(bool), Include(bool). These arguments turn on or off the corresponding options. The default value for Select is true (1). The default value for Show and Include is false (0).

Add Filter() adds rows and builds the WHERE clauses that describe a subset of the data table. The basic syntax appears as follows:

```plaintext
Add Filter( Columns( col, ... ), Where( ... ), ... )
```

To add columns to the data filter, list the columns names separated by commas. Note that this is not a list data structure.

You can define one or more WHERE clauses to specify the filtered columns, as follows:

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
df = dt << Data Filter( Mode( Show( 1 ) ), Add Filter( Columns( :age, :sex, :height ), Where( :age == {13, 14, 15} ), Where( :sex == "M" ), Where( :height >= 50 & :height <= 65 ) ) );
```
This script selects 13, 14, and 15-year-old males with a height greater than or equal to 50 and less than or equal to 65. In this filtered data, you can instead select the excluded ages by adding the Invert Selection message to the preceding script.

\[
\text{df} \leftarrow (\text{Filter Column( :age )} \leftarrow \text{Invert Selection} )
\]

In this example, ages other than 13, 14, and 15 in the filtered data are selected.

You can also use Add Filter() to select matching strings from columns with the Multiple Response property or Multiple Response modeling type.

\[
\text{dt} = \text{Open( "SAMPLE_DATA/Consumer Preferences.jmp" )};
\]
\[
\text{df} = \text{dt} \leftarrow \text{Data Filter(}
\]
\[
\text{Location(} \{437, 194\} )
\]
\[
\text{Add Filter(}
\]
\[
\text{Columns( :Brush Delimited ),}
\]
\[
\text{Match None( Where( :Brush Delimited == \{"Before Sleep", "Wake"\} ) ),}
\]
\[
\text{Display( :Brush Delimited, Size( 121, 70 ), Check Box Display )}
\]
\[
\text{)}
\]

This script selects rows with values in the Brush Delimited column that do not match either of the specified values ("Before Sleep", "Wake"). Other available scripting options include Match Any, Match All, Match Exactly, and Match Only. See The Column Info Window chapter in the Using JMP book for details about the Multiple Response property and the Multiple Response modeling type.

You can also send messages to an existing Data Filter object:

\[
\text{Clear(), Display( ... ), Animate(), Mode(), ...}
\]

Clear takes no arguments and clears the data filter.

To prevent the data filter from appearing when the script is run, set Show Window to 0 as follows:

\[
\text{obj} = (\text{dt} \leftarrow \text{Data Filter( Show Window( 0 ) )})
\]

To specify which values to exclude, use the != operator. The following example excludes ages 16 and 17 from the filtered values.

\[
\text{dt} = \text{Open( "SAMPLE_DATA/Big Class.jmp" )};
\]
\[
\text{df} = \text{dt} \leftarrow \text{Data Filter(}
\]
\[
\text{Add Filter( Columns( :age, :sex ) ),}
\]
\[
\text{Match( Columns( :age, :sex ),}
\]
\[
\text{Where( :sex = "M" ), Where( :age != \{16, 17\} )}
\]
\[
\text{)}
\]
**Define the Context of a Data Filter**

A data filter lets you interactively select complex subsets of data, hide the subsets in plots, or exclude them from analyses. Your selections affect all analyses of the data table.

Another option is to filter data from specific platforms or display boxes. Create a local data filter inside the `Data Filter Context Box()` function. This defines the context as the current platform or display box rather than the data table.

The following example creates a local data filter for a Graph Box. See Figure 9.4 for the output.

```javascript
New Window( "Marker Seg Example",
    Data Filter Context Box(
        V List Box(
            dt << Data Filter( Local ),
            g = Graph Box(
                Frame Size( 300, 240 ),
                X Scale( Min( xx ) - 5, Max( xx ) + 5 ),
                Y Scale( Min( yy ) - 5, Max( yy ) + 5 ),
                Marker Seg( xx, yy, Row States( dt, rows ) )
            )
        )
    )
);
```

**Tip:** The preceding script is part of a larger script that first builds the arrays required for a marker seg. To experiment with this script, open the Local Data Filter for Custom Graph.jsl sample script.
A context box can also contain several graphs with one local filter. The filtering then applies to both graphs. The following script creates two bubble plots and one data filter in one context box. See Figure 9.4 for the output.

```javascript
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
New Window( "Shared Local Filter",
  Data Filter Context Box(
    H List Box(
      dt << Data Filter( Local ),
      Platform(
        dt,
        Bubble Plot( X( :weight ), Y( :height ), Sizes( :age ) )
      ),
      Platform(
        dt,
        Bubble Plot( X( :weight ), Y( :age ), Sizes( :height ) )
      )
    )
  )
);

Tip: To experiment with this script, open the Local Data Filter Shared.jsl sample script.
Data filters can be hierarchical. One script might generate a data filter and a local data filter. The outer data filter for the data table determines which data is available for the local data filter. To illustrate this point, the following script produces both types of data filters as shown in Figure 9.5.

**Tip:** The following script is part of a larger script that first builds the arrays required for a marker seg. See the Local Data Filter for Custom Graph.jsl sample script for code that builds those arrays.

```julia
dt << Data Filter(
    Add Filter( Columns( :height ), Where( :height >= 55 & :height <= 65 ) )
);
New Window( "Marker Seg Example",
    Data Filter Context Box(
        V List Box(
            dt << Data Filter( Local ),
            g = Graph Box(
                Frame Size( 300, 240 ),
                X Scale( Min( xx ) - 5, Max( xx ) + 5 ),
                Y Scale( Min( yy ) - 5, Max( yy ) + 5 ),
                Marker Seg( xx, yy, Row States( dt, rows ) )
            )
        )
    )
);
Heights greater than or equal to 55 and less than or equal to 65 are initially filtered. Then the user can work with the local data filter to filter columns on the graph.
Sort a Data Table

Sort() rearranges the rows of a table according to the values of one or more columns, either replacing the current table or creating a new table with the results. Specify ascending or descending sort for each By column.

```
dt << Sort(  
    "Private", "Invisible", Replace table, By( columns ), Order( Descending | Ascending ) );
```

The following example creates a new data table based on Big Class.jmp that sorts the data in descending order by age and by name:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
sortedDt = dt << Sort(  
    By( :age, :name ),  
    Order( Descending, Ascending ) ,
);```
output table name( "Sorted age name" )

You can also use an associative array to sort values in a column. The associative array gives you a quick look at unique values in a column. For details, see “Sort a Column’s Values in Lexicographic Order” on page 210 in the “Data Structures” chapter.

Stack Values in a Data Table

Stack() combines values from several columns into one column.

```
dt << Stack(
    Columns ( columns ), // the columns to stack together
    Source Label Column ( "name" ), // to identify source columns
    Stacked Data Column ( "name" ), // name for the new stacked column
    Keep ( columns ), // the columns to keep in the data table
    Drop ( columns ), // the columns to drop in the data table
    Output Table ( "name" ), // name for the new data table
    Columns( columns ) ); // specify which columns to include in the stacked table
```

For example, the following script stacks the weight and height columns in Big Class.jmp:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Stack(
    Columns( :weight, :height ),
    Source Label Column( "ID" ),
    Stacked Data Column( "y" ),
    Name( "Non-stacked columns" )( Keep( :age, :sex ) ),
    Output Table( "Stacked Table" )
);
```

The Columns(columns) argument can take a list of columns, or an expression that evaluates to a list.

Split Values in a Stacked Data Table

Split breaks a stacked column into several columns.

```
dt << Split(
    Split( columns ),
    // the column to split (required)

    Split by( column ),
    // the column to split by (required)

    Group(column),
    // split data within groups
```
<Private>|<Invisible>,
// resulting table is private or invisible

Remaining Columns( Keep All | Drop All | Select( columns ) ),
/* specify what to do with the remaining columns in the resulting table
(Keep All by default) */

<Copy formula( 0|1 )>,
/* include column formulas from the source table in the resulting table
(default is 1, true) */

<Suppress formula evaluation( 0|1 )>,
// stop any copied formulas from being evaluated (default is 1, true)

Sort by Column Property( "Value Ordering" {"string", "string"} | "Row Order Levels" ),
/* sorts the order of resulting columns by the specified
property (must be specified on the Split by column) */

Output Table( "name" ));
// generate the output to the table name specified

The following example reverses the previous example for Stack(), returning essentially the
original table, except that the height and weight columns now appear in alphabetic order:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Stack(
    Columns( :weight, :height ),
    Source Label Column( "ID" ),
    Stacked Data Column( "Y" ),
    Name( "Non-stacked columns" )( Keep( :age, :sex ) ),
    Output Table( "Stacked Table" )
);
dt2 = Data Table( "Stacked Table" );
dt2 << Split(
    Split( Y ),
    ColID( ID ),
    Output Table( "Split" )
);

**Transpose a Data Table**

Transpose creates a new data table by flipping a data table on its side, interchanging rows for
columns and columns for rows. If you specify no rows, Transpose() uses the selected rows. If
no rows are selected, it uses all rows.

dt << Transpose(
    "private", "invisible",
columns( columns ),
Rows( row matrix ),
By ( column ),
Label column name( "name" ),
Output Table( "name" )
);

dt << Transpose(
Columns( columns ),
Rows( row matrix ),
Output Table Name( "name" ) );

The following example transposes the height and weight columns in the Big Class.jmp sample data table:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
tranDt = dt << Transpose( Columns( :height, :weight ),
Output Table Name( "Transposed Columns" ) );

Note: The simple transpose command dt << Transpose brings up the Transpose window. If you do not want the window to appear, invoke the transpose as dt << Transpose(no option).

Vertically Concatenate Data Tables

Concatenate, also known as a vertical join, combines rows of several data tables top to bottom.

dt << Concatenate( DataTableReferences,...,Keep Formulas,
Output Table Name( "name" ) );

For example, if you have subsetted tables for males and females, you can put them back together using Concatenate:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Select Where( :sex == "M" );
m = dt << Subset( Output Table Name( "M" ) );
dt << Invert Row Selection;
f = dt << Subset( Output Table Name( "F" ) );
both = m << Concatenate( f, Output Table Name( "Both" ) );

Or, instead of creating a new table containing all the concatenated data, you can append all the data to the current data table:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Select Where( :sex == "M" );
m = dt << Subset( Output Table Name( "M" ) );
dt << Invert Row Selection;
f = dt << Subset( Output Table Name( "F" ) );
both = dt << Concatenate( m, f, "Append to First Table" );

**Horizontally Concatenate Data Tables**

Join, also known as horizontal join or concatenate, combines data tables side to side.

```julia
f = dt << Subset( Output Table Name( "F" ) );
both = dt << Concatenate( m, f, "Append to First Table" );
```

To try this, first break Big Class.jmp into two parts:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
part1 = dt << Subset( 
    Columns( :name, :age, :height ),
    Output Table Name( "Big Class 1" )
);
part2 = dt << Subset( 
    Columns( :name, :sex, :weight ),
    Output Table Name( "Big Class 2" )
);
```

To make it a realistic experiment, rearrange the rows in part 2:

```julia
part2 << Sort( By( :name ), Output Table Name( "Sorted_Big Class" ) );
```

Now you have a data set in two separate chunks, and the rows are not in the same order, but you can join them together by matching on the column that the two chunks have in common.

```julia
part1 << Join(
    With( sortedPart2 ),
```
By Matching Columns( :name == :name ),
    Preserve Main Table Order();
    Output Table Name( "Joined Parts" );
);

The resulting table has two copies of the name variable, one from each part, and you can inspect these to see how Join worked. Notice that you now have four Robert rows, because each part had two Robert rows (there were two Roberts in the original table) and Join formed all possible combinations.

**Tip:** To maintain the order of the original data table in the joined table (instead of sorting by the matching columns), include `Preserve Main Table Order()`. This function speeds up the joining process.

See the JSL Messages chapter in the *JSL Syntax Reference* for details about the Join arguments.

**Virtually Join Data Tables**

Virtual Join links a main data table to one or more auxiliary data tables. The feature enables the main data table to access data from the auxiliary data tables without physically joining the tables. See the Reshape Data chapter in the *Using JMP* book for details.

The following example shows how to virtually join data tables and create distributions from the joined data:

```julia
dt1 = Open( "$SAMPLE_DATA/Pizza Profiles.jmp" );
dt1:ID << Set Property( "Link ID", 1 );
    // add Link ID and turn it on

dt2 = Open( "$SAMPLE_DATA/Pizza Responses.jmp" );
dt2:Choice1 << Set Property( "Link Reference", Reference Table(  
"$SAMPLE_DATA/Pizza Profiles.jmp" ) );
dt2:Choice2 << Set Property( "Link Reference", Reference Table(  
"$SAMPLE_DATA/Pizza Profiles.jmp" ) );
dt2:Choice << Set Property( "Link Reference", Reference Table(  
"$SAMPLE_DATA/Pizza Profiles.jmp" ) );
    // add Link Reference to the Choice1, Choice2, and Choice columns

obj = dt2 << Distribution( // create a distribution of Crust[Choice1]  
    Weight( :Subject ),
    Nominal Distribution(  
        Column(  
            Referenced Column(  
                "Crust[Choice1]",
                Reference( Column( :Choice1 ), Reference( Column( :Crust ) ) )
            )
        )
    )
);```
Nominal Distribution( Column( :Choice1 ) )
);

Replace Data in Data Tables

Note: Merge Update() is an alias for Update().

Update() replaces data in one table with data from a second table.

```
dt << Update( // message to first table
    With( dataTable ), // the other data table
    By Row Number, // default join type; alternative is
    // By Matching Columns(col1==col2)
    Ignore Missing, // optional, does not replace values with missing values
);
```

To try this, make a subset of Big Class.jmp, as follows:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
NewHt = dt << Subset( Columns( :name, :height), Output Table Name( "hts" ) );
```

Next, add 0-6 inches to each student’s height:

```
diff = Random Uniform( 0, 6 );
For Each Row( NewHt, :height = :height + diff );
```

Finally, update the heights of students in Big Class.jmp with the new heights from the subset table:

```
dt << Update(     
    With( NewHt ),
    By Matching Columns( :name == :name),
);
```

Controlling the Columns Added to an Updated Table

Your updated table might contain more columns than your original table. You can select which columns are included in your updated table using the option Add Column from Update Table().

To add no additional columns:

```
Data Table( "table" ) << Update(     
    With( Data Table( "update data" ) ),
    Match Columns( :ID = :ID ),
    Add Columns from Update Table( None )
);
```
To add some columns:

```plaintext
Data Table( "table" ) << Update(
    With( Data Table( "update data" ) ),
    Match Columns( :ID = :ID ),
    Add Columns from Update table( :col1, :col2, :col3 )
);
```

### Create a Table Using Tabulate

Tabulate constructs tables of descriptive statistics. The tables are built from grouping columns, analysis columns, and statistics keywords. The following example creates a table containing the standard deviation and mean for the height and weight of male and female students:

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Tabulate( // message to data table
    Add Table( // start a new table
        Column Table( Grouping Columns( :sex ) ), // group using the column sex
        Row Table( // add rows to the table
            Analysis Columns( :height, :weight ), // use the height and weight columns for the analysis
            Statistics( Std Dev, Mean ) // show the standard deviation and mean
        ));
)
```

You can apply a transformation to a column in the Tabulate table and set the format of the column at the same time. Use the `Transform Column()` function inside `Analysis Column()`. For example, the following script applies the Log transformation to `height` and sets the column format for the Mean and % of Total columns.

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Tabulate(
    Set Format(
        Mean( :height( 10, 1 ),
            Analysis Column( Transform Column( "Log[height]",
                Formula( Log( :height ) )
            ),
                Format( 10, "Best" )
        ),
        Name( "% of Total" ) (:height( 12, 2 ),
            Analysis Column( Transform Column( "Log[height]",
        )));
```
Data Tables

Chapter 9
Advanced Data Table Scripting

Formula( Log( :height ) )
),
Format( 12, 2 )
),
Add Table(
  Column Table(
    Analysis Columns(
      :height,
      Transform Column(
        "Log[height]",
        Formula( Log( :height ) )
      )
    ),
    Statistics( Mean, Name( "% of Total" ) )
  ),
  Row Table( Grouping Columns( :sex )
  )
);

Note: You can also change the width of columns and perform additional operations within Tabulate. For details, see the JMP Scripting Index.

Find Missing Data Patterns

If your data table contains missing data, you might want to see whether there is a pattern that the missing data creates.

dt << Missing Data Pattern( // message to data table
  Columns( :miss ), // find missing data in this column
  Output Table( "Missing Data Pattern" ) // name the output table
);

Compare Data Tables

JMP can compare two open data tables and report the differences between data, scripts, table variables, column names, column properties, and column attributes. To compare data tables using JSL:

obj = dt << Compare Data Tables( Compare With( Data Table ("Data Table Name") );

For example, to compare the data tables Students1.jmp and Students2.jmp, proceed as follows:

dt = Open( "$SAMPLE_DATA/Students1.jmp" );
dt2 = Open( "$SAMPLE_DATA/Students2.jmp" );
Chapter 9
Scripting Guide
Data Tables
Advanced Data Table Scripting

317

obj = dt << Compare Data Tables( Compare With( Data Table( "Students2" ) ) );

To view the difference summary matrix for the comparison results, use the following function:

mtx = ( obj << Get Difference Summary Matrix );

The resulting matrix appears in the log window:

[-1 1 2 2,
 -1 2 4 3,
 -1 1 7 4,
 1 3 8 4,
 1 1 10 9,
 0 1 11 11,
 -1 1 14 14,
 -1 1 16 15,
 1 1 18 16,
 -1 1 19 18,
 0 1 22 20,
 0 1 26 24,
 1 1 29 27,
 1 1 34 33]

In the comparison summary matrix in the example, the first column represents the action performed on a column: -1 for a Delete, 0 for a Replace, and 1 for an Add. The second column represents the number of rows affected by the action. The third and fourth columns represent the row numbers affected in the two data tables in their respective order (Students1.jmp, Students2.jmp).

Create a Summary Table

A Summary table includes summary statistics for a data table, such as the mean, median, standard deviation, minimum value, and maximum value. By default, the summary table is linked to its source table. When you select rows in the summary table, the corresponding rows are highlighted in its source table.

```
dt << Summary( <private>, <invisible>, <Group( column )>, <Weight( column )>, <Freq( column )>, <N>, <Mean( column )>, <Std Dev( column )>, <Min( column )>, <Max( column )>);
```

Include columns for any statistic listed in the Summary launch window.

The following example creates a summary table from the Fitness.jmp sample data table. The N Rows column, which specifies the number of rows for each level, is included in the Summary table by default. This script creates a column of the mean for Runtime by Sex.

```
dt = Open( "$SAMPLE_DATA/Fitness.jmp" );
dt << Summary( 
    Group( :Sex ),
    Mean( :Runtime ),
);
```
You can override the preselected Freq or Weight columns in the data table by specifying the Freq or Weight columns in the script. To omit the preselected Freq or Weight, use the keyword "none".

```
dt = Open( "$SAMPLE_DATA/Fitness.jmp" );
dt << Summary(  
    Group( :Sex ),
    Mean( :Runtime ),
    Weight( "none" )
  );
```

To unlink the Summary table, include `Link to Original Data Table( 0 )` in the script.

```
dt = Open( "$SAMPLE_DATA/Fitness.jmp" );
dt << Summary(  
    Group( :Sex ),
    Mean( :Runtime ),
    Link to Original Data Table( 0 )
  );
```

### Subscribe to a Data Table

If you want to receive a message when a data table changes, use the `Subscribe` message. For example, you might want a message sent to the log when columns are added or deleted.

The basic syntax is as follows:

```
dt << Subscribe( "name"("<"client">"), On Delete Columns | On Add Columns | On Add Rows | On Delete Rows | On Rename Column | On Close | On Save | On Rename( function ) );
```

The first argument is a name for the subscription (or “client”), so that it can also be removed. The application can also subscribe as a client to the data table (for example, most built-in platforms such as Distribution). If a data table has clients when the data table is closed, the user is warned that there are applications open that might need the data table.

Each subscription remains in effect until you unsubscribe. Unsubscribe as follows:

```
dt << Unsubscribe("keyname", On Delete Columns | On Add Columns | On Add Rows  
   | On Delete Rows | On Close | On Save | On Rename( function ) | All);
```

The following example sends messages to the log when a row is added or deleted:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
delRowsFn = Function( {a, b, rows},
    dtname = ( a << Get Name());
    Print( dtname );
    Print( b );
    Print Matrix( rows );
```

```
addRowsFn = Function( {a, b, insert},
    dtname = ( a << Get Name() );
    Print( dtname );
    Print( b );
    Print( insert );
);
    dt << Subscribe( "Test Delete", onDeleteRows( delRowsFn, 3 ) );
    dt << Subscribe( "Test Add", onAddRows( addRowsFn, 3 ) );

Empty Application Names

If Subscribe is called with an empty application name, JMP generates a unique name that is returned to the caller. In the following example, appname2 is subscribed to the data table as a client.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
appname1 = dt << Subscribe( "", On Close( Print( "Closing Data Table" ) ) );
appname2 = dt << Subscribe( ""( "client" ),
    On Close(
        Function( {dtab},
            dtname = ( dtab << Get Name() );
            Print( dtname );
        )
    )
);
    dt << Unsubscribe( appname1, On Close );
dt << Run Script( "Distribution" )

Move Data Between Matrices and Data Tables

For information about moving information between a matrix and a data table, see “Matrices and Data Tables” on page 181 in the “Data Structures” chapter.

Columns

This section covers actions that you can perform on columns in a data table, such as creating, grouping, setting and getting attributes and properties, and so on.
Note: JMP can display math symbols and Greek letters (controlled in Preferences in the Font category). This means that if you save a column (such as T square limits), the column name could either be “T Square Limits” (no special characters) or “T² Limits” (with special characters). Any reference using the column name must match the name exactly, or it fails.

Send Messages to Data Column Objects

Just as you send data table messages to a data table reference, you can send column messages to a reference to a data column object. The Column function returns a data column reference. Its argument is either a name in quotation marks, something that evaluates to a name in quotation marks, or a number.

```
Column( "age" );       // a reference to the age column
col = Column( 2 );     // assign a reference to the second column
:Name( "Profits ($M)" ) // evaluate to the name in quotation marks
```

This book uses `col` to represent data column references. To see the messages that you can send to data column objects, refer to the Scripting Index (Help > Objects > Data Tables > Column Scripting). Alternatively, you can use the Show Properties() command, as follows:

```
Show Properties( col );
```

Note: With column references, you must include a subscript to refer to the individual data values. Without a subscript, the reference is to the column object as a whole.

Once you have stored a data column reference in a global variable, to modify columns, you send messages to the data column reference.

Sending messages to columns is comparable to sending messages to data tables. Either state the object, a double-angle operator <<, and then the message with its arguments in parentheses, or use the SendQ function with the object and then the message. In some cases the messages themselves need no arguments, so the trailing parentheses are optional.

```
col << message( arg, arg2, ... );
Send( col, message(arg, arg2, ... ) );
```

As with data tables and other types of objects, you can stack or list messages, as follows:

```
col << message << message2 << ...
col << {message, message2, ...};
```

Tip: To delete a column, you must send the message to a data table reference, because objects cannot delete themselves, only their containers can delete them.
Access Cell Values through Column References

Always use a subscript on a column reference to access the values in the cells of columns. Without a subscript, the reference is to the column object as a whole.

\[
\begin{align*}
  x &= \text{col}[i\text{row}] \quad // \text{specific row} \\
  x &= \text{col[]} \quad // \text{current row} \\
  \text{col}[i\text{row}] &= 2; \quad // \text{as an l-value for assignment} \\
  \text{dt} &\ll \text{Select Where( col[]<14 );} \quad // \text{in a WHERE clause}
\end{align*}
\]

Access Cell Values that have Value Labels

If the column whose values you want to access has a Value Label property, you might want to access the value label (formatted value) instead of the actual data value. To do this, use the formatted option. Consider the following example:

\[
\begin{align*}
  \text{dt} &= \text{Open( "$\text{SAMPLE\_DATA}\backslash\text{Big Class.jmp}" );} \\
  \text{dt} &\ll \text{Run Script( "Set Age Value Labels" );} \\
  x &= \text{Column( dt, "age", formatted )}[1]; \\
      &\quad \text{Show( } x \text{ );} \\
  y &= \text{Column( dt, "age" )}[1]; \\
      &\quad \text{Show( } y \text{ );}
\end{align*}
\]

The log shows the formatted value for \( x \), which is twelve, and the actual data value for \( y \), which is 12.

Create Columns

To add a new column to a data table, send a New Column message to a data table reference. The first argument, the column’s name, is required. Either enclose the name in quotation marks or specify an expression evaluating to the name.

\[
\begin{align*}
  \text{dt} &= \text{Open( "MyData.jmp" );} \\
  \text{dt} &\ll \text{New Column( "wafer" );}
\end{align*}
\]

or

\[
\begin{align*}
  a &= \text{"wafer";} \\
  \text{dt} &\ll \text{New Column( } a \text{ );}
\end{align*}
\]

If the table already includes a column by the same name, a sequential numeric value is appended to the new column name (wafer, wafer 2, wafer 3, and so on).

Unless otherwise specified, columns are numeric, continuous, and 10 characters wide.

- Data type (numeric, character, or row state)
- Analysis type (continuous, nominal, or ordinal)
- Column width (only for numeric columns)
- Numeric format
The following example creates a new column whose data type is numeric, analysis type is continuous, width is set to 5, and numeric format is set to Best:

```javascript
dt << New Column( "wafer", Numeric, "Continuous", Format( "Best", 5 ) );
```

The following example creates a character column and automatically assigns the nominal analysis type.

```javascript
dt << New Column( "Last Name", Character );
```

You can also add formulas and other script messages appropriate to the column.

```javascript
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
dt << New Column( "Ratio", Numeric, "Continuous", Formula( :height/:weight ) );
dt << New Column( "myMarkers", Row State, Set Formula( Marker State( age - 12 ) ) );
```

If you plan to work with specific columns later (for example, grouping or changing data types), create a column reference, as follows:

```javascript
myCol = dt << New Column( "Birth Date" );
```

### Fill a Column with Data

To fill the column with data, use `Values` or its equivalent, `Set Values`. Include the value for each cell in a list.

The following example adds a new column called Last Name to a new data table. Three values are added: Smith, Jones, and Anderson.

```javascript
dt = New Table( "My Data" );
dt << New Column( "Last Name", Character, Values( {"Smith", "Jones", "Anderson"} ) );
```

The column can also be filled with numeric values. The following example adds a new column called Row Number to a new data table. The function `N Row` returns the number of rows in the table, and numeric values populate all of the rows in the column, beginning with 1.

```javascript
dt = New Table( "My Data" );
dt << New Column( "Row Number", Numeric, Values( 1 :: N Row() ), Format( "Best", 5 ) );
```

To add a column of random numbers, insert a formula along with the random function.

```javascript
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
dt << New Column( "Random", Numeric, Formula( Random Uniform() ) );
```
Another option is to add a constant numeric value to each cell. In the following example, the number 5 is added to each cell.

```julia
dt << New Column( "Number" );
:Number << Set Each Value( 5 );
```

New Column() can also be used as a built-in function, in other words, without the << (Send) command applied to the data table reference. When used in this way, the column is added to the current data table.

```julia
dt << New Column( "Address" ); // command is sent to the data table reference
```

### Add Several Columns at Once

The Add Multiple Columns message creates several columns at once. Arguments include the column name prefix, the number of columns, where to insert them (Before First, After Last, or After(col)), and the data type (Numeric, Row State, or Character(width)). An additional argument, field width, is optional for a numeric column.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Add Multiple Columns( "beginning", 2, Before First, Row State );
// add two row state columns named "beginning <n>" before the first column

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Add Multiple Columns( "middle", 3, After( :height ), Numeric );
// add three numeric columns named "middle <n>" after the height column

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Add Multiple Columns( "end", 4, After Last, Character( 4 ) );
// add four character columns named "end <n>" after the last column
```

The column name is a prefix. If multiple columns with the same name are added, a sequential number is appended to each column name (beginning 1, beginning 2, and so on).

### Group Columns

You can group columns by sending the data table the Group Columns message, which takes a list of columns to group as an argument. For example, the following code opens the Big Class.jmp sample data table and groups the age and sex columns.

```julia
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
dt << Group Columns( {:age, :sex} );
"age etc."
You can also send a column name followed by the number of columns to include in the group. The group includes the first column named and the \( n-1 \) columns that follow it. This line is equivalent to the line above, which groups age and sex:

```
dt << Group Columns( :age, 2 );
```

The group name is based on the first column specified in the argument. So in the preceding example, the group is automatically named age etc. To customize the name, include the group name as the first argument.

```
dt << Group Columns( "My group", :age, 2 );
```

To ungroup grouped columns, use the Ungroup Columns message, which takes a list of columns in a group as an argument. For example, the following line ungroups the two columns grouped in the previous example.

```
dt << Ungroup Columns( {:age, :sex} );
```

Note the following about grouping and ungrouping columns:

- Both messages take a single list as an argument. The list must be enclosed in braces.
- You cannot create more than one group in a single message (for example, by giving the Group Columns message two lists of columns). Instead, you must send the data table two separate Group Columns messages.
- The Ungroup Columns message takes a list of columns to ungroup, not the name of a group of columns. You can remove a partial list of columns from a group. For example, this line creates a group of four columns:

```
dt << Group Columns( {:age, :sex, :height, :weight} );
```

And this line removes two of the columns, while leaving the other two in the group:

```
dt << Ungroup Columns( {:age, :sex} );
```

Notice that the grouped columns are now height and weight, but the group name still contains age. Once a group is created, its name does not change, even if you remove the first column that was originally grouped.

### Get Column Groups or Names

To get column groups or names, use Get Column Group or Get Column Groups Names. The first part of this example creates two sets of grouped columns as shown in the previous section. Get Column Group() returns the column names in the specific group. Get Column Groups Names() returns the names of the column groups.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Group Columns( {:age, :sex} );
"age etc."
dt << Group Columns( {:weight, :height} );
"height etc."
dt << Get Column Group( "age etc." );
```
{:age, :sex}
dt << Get Columns Groups Names();
{"age etc.", "height etc."}

Select a Column Group

To select or deselect a column group, use the following messages:

dt << Select Column Group("name"); // select the columns in the group
dt << Deselect Column Group("name"); // deselect the columns in the group

The following example groups columns X and Y and groups columns Ozone through Lead, and then selects those columns in the data table:

dt = Open("$SAMPLE_DATA/Cities.jmp");
dt << Group Columns("xy", {:X, :Y});
dt << Group Columns("pollutants",
  :Ozone :: :Lead);
dt << Select Column Group("xy", "pollutants");

Rename a Column Group

To rename a column group, use the following message:

dt << Rename Column Group("name", "toname");

The following example renames the column group from xy to coordinates:

dt = Open("$SAMPLE_DATA/Cities.jmp");
dt << Group Columns("xy", {:X, :Y});
dt << Group Columns("pollutants",
  :Ozone :: :Lead);
Wait(3);
dt << Rename Column Group("xy", "coordinates");

Move a Column Group

To move a column group, use the following message:

dt << Move Column Group(To First | To Last | After (col) "name")

The following example moves the columns in the pollutants group to the end:

dt = Open("$SAMPLE_DATA/Cities.jmp");
dt << Group Columns("xy", {:X, :Y});
dt << Group Columns("pollutants",}
:Ozone :: :Lead
);
dt << Move Column Group( To Last, "pollutants" );

**Select Columns**

To select a column, use the Set Selected message.

    col << Set Selected( 1 );

For example, to select all continuous variables in the Big Class.jmp sample data table, use the following script:

    dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
    cc = dt << Get Column Names( "Continuous" );
    ncols = N Items( cc );
    For( i = 1, i <= ncols, i++,
        cc[i] << Set Selected( 1 )
    );

**Get Selected Columns**

To get a list of currently selected columns, use the Get Selected Columns message.

    dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
    :age << Set Selected( 1 );
    :sex << Set Selected( 1 );
    dt << Get Selected Columns();
    {:age, :sex}

Return the list of selected columns as a string using the "string" argument:

    dt << Get Selected Columns( "string" );
    {"age", "sex", "height"}

Once you know what columns are selected, you can then write a script that acts upon these columns. Or your script can iteratively select columns and act upon them one at a time.

To actually select the columns before getting the columns, send the Set Selected message to a column. For more information, see “Column Attributes” on page 329.

**Go To Column**

To select and move to a specific column, use the Go To message.

    dt << Go To( column name | column number );

For data tables with many columns, you can use this message to scroll the data table all the way to the left, so that the first column comes into view and is selected:

    dt = Open( "$SAMPLE_DATA/Tiretread.jmp" );
    dt << Go To( 1 );
Rearrange and Move Columns

These messages enable you to rearrange columns in a data table:

\[
\begin{align*}
  dt << \text{Reorder By Name;} & \quad // \text{alphanumeric order} \\
  dt << \text{Reverse Order;} & \quad // \text{reverse current order} \\
  dt << \text{Reorder By Data Type;} & \quad // \text{row state, character, and then numeric} \\
  dt << \text{Reorder By Modeling Type;} & \quad // \text{continuous, ordinal, nominal} \\
  dt << \text{Original Order;} & \quad // \text{saved order}
\end{align*}
\]

These commands move the currently selected columns to the indicated destination point.

\[
\begin{align*}
  dt << \text{Move Selected Columns( To First );} \\
  dt << \text{Move Selected Columns( To Last );} \\
  dt << \text{Move Selected Columns( After( "name" ) );}
\end{align*}
\]

You can also move columns without first selecting them in the data table by using the following syntax.

\[
\begin{align*}
  dt << \text{Move Selected Columns( \{"name"\}, To First );} \\
  dt << \text{Move Selected Columns( \{"name"\}, To Last );} \\
  dt << \text{Move Selected Columns( \{"name"\}, After( "name" ) );}
\end{align*}
\]

Add a Column Switcher

Use JSL to add a Column Switcher panel to a report window. The Column Switcher lets you quickly analyze different variables without having to re-create your analysis.

\[
\begin{align*}
  \text{obj << Column Switcher(<default_col>(<col1>, <col2>, ...);} \\
  \text{  // add a Column Switcher to the report} \\

  \text{obj << Remove Column Switcher();} \\
  \text{  // remove the Column Switcher from a report}
\end{align*}
\]

For example, add the Column Switcher to a Contingency report for the Car Poll.jmp data as follows:

\[
\begin{align*}
  \text{dt = Open("$SAMPLE_DATA/C\text{ar Poll.jmp}" );} \\
  \text{obj = Contingency(} \\
  \text{  Y( :size ),} \\
  \text{  X( :marital status )} \\
  \text{ });} \\
  \text{ColumnSwitcherObject = obj <<} \\
  \text{  Column Switcher(} \\
  \text{    :marital status,} \\
  \text{    { :sex, :country, :marital status} } \\
  \text{ );} \\
  \text{ColumnSwitcherObject << Set Size( 200 );} \\
  \text{  // number of pixels for the switcher width}
\end{align*}
\]
Columns Scripting Guide

ColumnSwitcherObject << Set NLines( 6 );
// number of columns to display in the switcher

For more details about the Column Switcher, see the JMP Reports chapter in the Using JMP book.

Compress Selected Columns

To minimize the size of a large data table, use the Compress Selected Columns message. Each column is compressed into the most compact form.

```
dt << Compress Selected Columns( {column name, column name} );
```

For example, compress the age, sex, height, and weight columns in Big Class.jmp as follows:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Compress Selected Columns( {:age, :sex, :height, :weight} );
```

For more information about this feature, see the Enter and Edit Data chapter in the Using JMP book.

Delete Columns

To delete columns, send a Delete Columns message and specify which column or columns to delete. To delete more than one column, list the columns as multiple arguments or as a list.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Delete Columns( "weight" );
dt << Delete Columns( "weight", "age", "sex" );
dt << Delete Columns( {"weight", "age", "sex"} );
```

Without an argument, Delete Columns deletes columns that were previously selected. See “Column Attributes” on page 329 for more information.

Obtain Column Names

Column Name(n) returns the name of the n-th column.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Column Name( 2 );
age
```

The returned value is a name value, not a quoted string. What this means is you can use it anywhere you would normally use the actual name in a script. For example, you could subscript it:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
```
If you want the name as a text string, quote it with `Char`:

```
Char( Column Name( 2 ) );
"age"
```

To retrieve a list of the names of all columns in a data table, submit `Get Column Names`:

```
dt << Get Column Names( argument );
```

where the optional `argument` controls the output of the `Get Column Names` function, as follows:

- Specify `Numeric`, `Character`, or `Row State` to include only those column data types.
- Specify "Continuous", "Ordinal", or "Nominal" to include only those modeling types.
- Specify `String` to return a list of strings rather than column names.

For example, if you want to get numeric and continuous columns in the `Big Class.jmp` sample data table, proceed as follows:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
names = dt << Get Column Names( Numeric, "Continuous" )
{height, weight}
```

### Column Attributes

Use a collection of message pairs for data table columns to control all of the various attributes or characteristics of a column, including its name, data, states, and metadata. The messages come in pairs, one to “set” or assign each attribute and one to “get” or query the current setting of each attribute.

For example, you can hide, exclude, label, and turn on or off the scroll lock for a column through scripting. The value is Boolean; enter a one to turn the column attribute on, and a zero to turn it off.

In the following examples, the `name` column is unhidden, unexcluded, labeled, and locked from horizontal scrolling.

```
Column( "name" ) << Hide( 0 );
Column( "name" ) << Exclude( 0 );
Column( "name" ) << Label( 1 );
Column( "name" ) << Set Scroll Locked( 1 );
```
Note: All the messages to set various arguments (for example, Set Name, Set Values, Set Formula) start with Set. The word Set is optional for all messages except Set Name (recall that Name is already used for something else, the command that lets you use unusual characters in a name). Use whichever form you prefer or find easier to remember. The corresponding messages to retrieve the current value of an argument (for example, Get Formula) are the same, except that they start with Get instead of Set, and the word Get is not optional.

To deselect all selected columns, send a Clear Column Selection message to the data table object.

\[
\text{dt} << \text{Clear Column Selection};
\]

**Set or Get a Column Name**

Set Name lets you name or rename a column, and Get Name returns the name for a column. The following example changes the name of the second column from age to ratio. It then returns the current column name to the log.

\[
\text{dt} = \text{Open( "SAMPLE_DATA/Big Class.jmp" );}
\text{col} = \text{Column( 2 );}
\text{col} << \text{Set Name( "ratio" );}
\text{col} << \text{Get Name;}
"ratio"
\]

**Set or Get Column Values**

Similarly, Set Values sets values for a column. If the variable is character, the argument should be a list. If the variable is numeric, the argument should be a matrix (vector). If the number of values is greater than the current number of rows, the necessary rows are added to the data table. Get Values returns the values in list or matrix form. Get As Matrix is similar to Get Values but returns values in the numeric columns.

\[
\text{col} << \text{Set Values( myMatrix ); // for a numeric variable}
\text{col} << \text{Set Values( myList ); // for a character variable}
\text{col} << \text{Get Values; // returns a matrix, or list if character}
\text{col} << \text{Get Matrix(<list of column names>|<list of column numbers>|<column range>); // returns the specified columns as a matrix}
\]

The following example returns a list and a matrix of values:

\[
\text{dt} = \text{Open( "SAMPLE_DATA/Big Class.jmp" );}
\text{Column( "name" )} \text{<< Values( \{Fred, Wilma, Fred, Ethel, Fred, Lamont\};}
\text{myList = :name \text{<< Get Values;}}
\text{/* returns \{"Fred", "Wilma", "Fred", "Ethel", "Fred", "Lamont", "JAMES", "ROBERT", "BARBARA", ...\}*/}
\text{Column( "age" )} \text{<< Values( [28, 27, 51, 48, 60, 30];}
\text{myVector = :age \text{<< Get Values;}}
\]
// returns [28, 27, 51, ... ]
myMatrix = :weight << Get as Matrix;
// returns [95, 123, 74, ... ]

Set or Get Value Labels

**Note:** For complete details about value labels, see The Column Info Window chapter in the *Using JMP* book.

Value labels provide a method of displaying a descriptive label for abbreviated data. For example, you might have a column of 0 and 1 values, where 0 represents a male and 1 represents a female. The value label "male" for 0 and "female" for 1 are more readable.

You can specify value labels in any one of the following three ways. Using the Big Class.jmp sample data table, assume that M maps to Male, and F maps to Female.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
:sex << Value Labels( {"F", "M"}, {"Female", "Male"} ); // use two lists
:sex << Value Labels( {"F", "Female", "M", "Male"} ); // use a list of pairs
:sex << Value Labels( {"F" = "Female", "M" = "Male"} ); // use a list of assignments
```

You can activate value labels by sending `Use Value Labels` as a message to the column.

```
:sex << Use Value Labels( 1 );
```

To revert back to showing the column’s actual values, proceed as follows:

```
:sex << Use Value Labels( 0 );
```

The same message can be used for the data table to turn value labels on and off for all columns.

```
dt << Use Value Labels( 1 );
```

Set or Get Data and Modeling Types

You can set or get the data type of a column using JSL. The choices are character, numeric, and row state. The following example adds a new column that has a character data type to the Big Class.jmp sample data table.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "New" );
Column( "New" ) << Data Type( Character );
Column( "New" ) << Get Data Type;
"Character"
```

To set or get the modeling type of a column:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
col = New Column( "New" );
```
You can specify the format of a column when changing its data type as follows:

```julia
col << Modeling Type( "Continuous" );
col << Get Modeling Type;
"Ordinal"
```

Set or Get Formats

The Format message controls numeric and date/time formatting. The first argument is a quoted string from the list of format choices shown in the Column Info window. Subsequent arguments depend on the format choice. You can also set the field width by itself.

```julia
col << Format( "Best", 5 ); // width is 5
col << Format( "Fixed Dec", 9, 3 ); // width is 9, with 3 decimal places
col << Format( "PValue", 6 );
col << Format( "d/m/y", 10 );
col << Set Field Width( 30 );
```

For date formats, the Format message sets how dates appear in a data table column. To set the format that you use for entering data, or for displaying the current cell when you have it selected for entry or editing, use the Input Format message.

```julia
col << Format( "d/m/y", 10 ); // display the date in day-month-year order
col << Input Format( "m/d/y" ); // enter the date in month-day-year order
```

For more information about date/time formatting choices, see “Date-Time Functions and Formats” on page 126 in the “Types of Data” chapter.

Note: Do not confuse the Format message for columns with the Format function for converting numeric values to strings according to the format specified (typically used for date/time notation as described in “Date-Time Functions and Formats” on page 126 in the “Types of Data” chapter). Sending a message to an object has a very different effect from using a function that might happen to have the same name.

To get the current format of a column, submit a Get Format message, as follows:

```julia
col << Get Format;
```

Set, Get, or Evaluate a Formula

The following examples show how to set, get, and evaluate a formula:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
col = New Column( "Ratio" ); // create column and stores its reference
col << Set Formula( :height/:weight ); // set the formula
```
col << Eval Formula; // evaluate the formula
col << Get Formula; // return the expression :height/:weight

To use the values from columns in scripts, be sure to add commands to evaluate the formula. Formula evaluation timing can differ between different versions of JMP. Note the following:

- When formulas are added, they are scheduled to be evaluated in a background task. This can be a problem for scripts if they depend on the column having the values while the script is running.
- To force a single column to evaluate, you can send an Eval Formula command to the column. You can do this inside the command to create the column, right after the Formula clause:

  ```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "Ratio",
        Numeric,
        Formula( :height / :weight ),
        Eval Formula
    );
```

  where Formula() is an alias for Set Formula().

However, it is best to wait until you are finished adding a set of formulas, and then use the command Run Formulas to evaluate all of the formulas in their proper order, as follows:

  ```julia
dt << Run Formulas;
```

- The Run Formulas command is preferable to the Eval Formula command, because while it is evaluating the formulas, Eval Formula does not suppress the background task from evaluating them again. The formula dependency system background task takes great care to evaluate the formulas in the right order, and RunFormulas simply calls this task until all the formulas are finished evaluating.
- If you use random numbers and use the Random Reset(seed) feature to make a replicable sequence, then you have another reason to use Run Formulas, in order to avoid a second evaluation in the background.

### Set and Get Range and List Checks

You can manipulate list and range check properties using JSL. The following examples use the Big Class.jmp sample data table.

Set and clear the list check property in the sex column:

  ```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Column( "sex" ) << List Check( {"M", "F"} ); // set the property
Column( "sex" ) << List Check(); // clear the property
```

Range checks require the specification of a range using the syntax in Table 9.1.
The following example specifies that the values in the age column must be greater than zero and less than 120:

\[
\text{Column( "age" ) << Range Check( LTLT( 0, 120 ) );}
\]

All of the operators can be preceded by Not and one of them can be missing. The following example specifies that the values in the age column should be greater than or equal to 12:

\[
\text{Column( "age" ) << Range Check( not( LT( 12 ) ) );}
\]

To clear a range check state, submit an empty \texttt{Range Check()}, as follows:

\[
\text{Column( "age" ) << Range Check();}
\]

To retrieve the list or range check assigned to a column, send a \texttt{Get List Check} or \texttt{Get Range Check} message to the column:

\[
\begin{align*}
\text{Column( "sex" ) << Get List Check; } & \\
\text{Column( "age" ) << Get Range Check; } &
\end{align*}
\]

Here is an example of \texttt{Get Range Check} for the \texttt{age} column in \texttt{Big Class.jmp}:

\[
\begin{align*}
dt = \text{Open( "$SAMPLE_DATA/Big Class.jmp" );} \\
\text{Column( "age" ) << Range Check( LTLT( 0, 120 ) );} \\
\text{Column( "age" ) << Get Range Check;} \\
\text{Range Check( LTLT( 0, 120 ) )}
\end{align*}
\]

Note that you can also use \texttt{Set Property}, \texttt{Get Property}, and \texttt{Delete Property} to set, retrieve, and remove list checks and range checks. See “Column Properties” on page 335 for more information.

\textbf{Note:} Operations sent through JSL that involve range check columns show any warnings in the log rather than in interactive windows.

\textbf{Get a Column Script}

\texttt{Get Script} returns a script to create the column.

\[
\begin{align*}
dt = \text{Open( "$SAMPLE_DATA/Big Class.jmp" );} \\
\text{New Column( "Ratio", Set Formula( :height/ :weight) );}
\end{align*}
\]
Column( "Ratio" ) << Get Script;
  New Column( "Ratio",
    Numeric,
    "Continuous",
    Format( "Best", 10 ),
    Formula( :height / :weight )
  )

Preselect Roles

To preselect a role on a column, use the Preselect Role message. Choices include No Role, X, Y, Weight, and Freq. The Get Role message returns the current setting.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
col = New Column( "New" );
col << Preselect Role( X );
col << Get Role;

Lock a Column

To lock or unlock a column, use Lock or Set Lock with a Boolean argument. Get Lock returns the current setting.

col << Lock( 1 ); // lock
col << Set Lock( 0 ); // unlock
col << Get Lock; // show current state

Column Properties

Tip: JSL choices for properties are the same as those in the Column Properties menu in the Column Info window. The arguments for each property correspond to the settings in the Column Info window. An easy way to learn the syntax is to establish the property that you want in the Column Info window first, and then use Get Property to view the JSL.

Data columns have numerous optional metadata attributes that can be set, queried, or cleared using the messages Get Property, Set Property, and Delete Property.

col << Set Property( "propertyName", {argument list} );
col << Get Property( "propertyName" );
col << Delete Property( "propertyName" );

The name of the property in question is always the first argument for Set Property, and what is expected for subsequent arguments depends on which property you set:

- Get Property and Delete Property always take a single argument, which is the name of the property.
• **Get Property** returns the property’s settings. **Delete Property** completely removes the property from the column.

• To get a list of all column property names for a column, specify the column and then use **Get Properties List**.

If you want to set several properties, you need to send several separate **Set Property** messages. You can stack several messages in a single JSL statement if you want.

    col << Set Property( "Axis", {Min(50), Max(180)} ) << Set Property( "Notes", "to get proportions" );

To get a property’s value, send a **Get Property** message whose argument is the name of the property that you want:

    Column( "ratio" ) << Get Property( "axis" ); // return axis settings

To set columns as label columns:

    dt << Set Label Columns( col1, col2, col3 );

To clear all label columns:

    dt << Set Label Columns();

The same syntax works for **Set Scroll Lock Columns** and **Scroll Lock**.

### Setting Column Properties with Variables

When writing JSL to script a column property, it is important to understand that the column is a repository for all column properties. The column stores the column property with the values supplied without evaluation or validation of the supplied arguments. In order to add column properties that contains variables using JSL code, the script must convert any variables to their actual values.

One way to do this is to use expressions. In the following example, the **Eval Expr** function evaluates and replaces any variable wrapped in the **Expr** function with its value. The outer **Eval** function evaluates the entire statement after the replacement has occurred.

    dt = Open( "$SAMPLE_DATA\Big Class.jmp" ); // open a sample data table
    lLimit = 55;
    uLimit = 70;
    tLimit = 62.5;
    // assign desired spec limits

    Eval(
        Eval Expr(
            :height << Set Property( // store the limits in the Spec Limits column property
                // store the limits in the Spec Limits column property
        )
    )
}}

}
“Spec Limits”,
{LSL( Expr( lLimit ) ), USL( Expr( uLimit ) ), Target( Expr( tLimit )
 ),
Show Limits( 0 )}
);

Setting and Getting Column Properties

Table 9.2 shows examples for setting and getting popular column properties. See The Column Info Window chapter in Using JMP for more information about each property.

Table 9.2 Properties for Data Table Columns

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example Using Arguments</th>
</tr>
</thead>
</table>
| Notes                | Stores notes about a column. Is a quoted text string. | col<<Set Property( "Notes", "Extracted from Fisher iris data" );
                                                                                 | col<<Get Property( "Notes" );                         |
| List Check List Check| Prescribes the possible values that can be entered in a column. | col<<Set Property( List Check, {"F","M"} );         |
                                                                                  | col<<Get Property( "List Check" );                  |
|                      |                                                  | col<<Delete Property( "List Check" );               |
| Missing Value Codes  | Specifies column values that should be treated as missing. | col<<Set Property( "Missing Value Codes", {0, 1} ); |
| Value Labels         | Specifies labels to be displayed in place of the values. | col<<Value Labels( {0 = "Male", 1 = "Female"} );     |
|                      |                                                  | Use Boolean values to turn value labels on or off:   |
|                      |                                                  | col<<Use Value Labels( 1 );                         |
| Value Ordering       | Specifies the order in which you want the data to appear in reports. | col<<Set Property( "Value Ordering", {"Spring", "Summer", "Fall", "Winter"} ); |
### Table 9.2 Properties for Data Table Columns (Continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example Using Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value Colors and Color Gradient</strong></td>
<td>Specifies colors for either categorical or continuous data, respectively.</td>
<td>Specify the color by assigning a JMP number to each value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col &lt;&lt; Set Property( &quot;Value Colors&quot;, {&quot;Female&quot; = 3, &quot;Male&quot; = 5} );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify a color theme:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col &lt;&lt; Set Property( &quot;Value Colors&quot;, Color Theme( &quot;White to Blue&quot; ) );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you omit the color theme, JMP uses the color theme preferences.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify the gradient and the range and midpoint for Value Gradient:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col &lt;&lt; Set Property( &quot;Color Gradient&quot;, {&quot;White to Blue&quot;, Range( {18, 60, 25} )})</code></td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td>Most platforms use this (if it exists) when constructing axes. Mostly Boolean.</td>
<td><code>col &lt;&lt; Set Property( &quot;Axis&quot;, {Min(50), Max(180), Inc(0), Minor Ticks(10), Show Major Ticks(1), Show Minor Ticks(1), Show Major Grid(0), Show Labels(1), Scale(Linear)} );</code></td>
</tr>
<tr>
<td><strong>Units</strong></td>
<td>Provided for custom uses. Specify the units of measure.</td>
<td><code>col &lt;&lt; Set Property( &quot;units&quot;, &quot;grams&quot; );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col &lt;&lt; Get Property( &quot;units&quot; );</code></td>
</tr>
<tr>
<td><strong>Coding</strong></td>
<td>Used for DOE and fitting. List with low and high values.</td>
<td><code>col &lt;&lt; Set Property( &quot;Coding&quot;, {59, 172} );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col &lt;&lt; Get Property( &quot;Coding&quot; );</code></td>
</tr>
<tr>
<td><strong>Mixture</strong></td>
<td>Used for DOE, fitting, and profiling. Specifies the Mixture column properties in a list.</td>
<td><code>col &lt;&lt; Set Property( &quot;Mixture&quot;, {0.2, 0.8, 1, L PseudoComponent Coding} );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col &lt;&lt; Get Property( &quot;Mixture&quot; );</code></td>
</tr>
<tr>
<td><strong>Row Order Levels</strong></td>
<td>Specify to sort levels by their occurrence in the data instead of by value.</td>
<td><code>col &lt;&lt; Set Property( &quot;Row Order Levels&quot;, 1 );</code></td>
</tr>
<tr>
<td><strong>Spec Limits</strong></td>
<td>Used for capability analysis and variability charts.</td>
<td><code>col &lt;&lt; Set Property( &quot;Spec Limits&quot;, {LSL(-1), USL(1), Target(0)} );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col &lt;&lt; Get Property( &quot;Spec Limits&quot; );</code></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Example Using Arguments</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Control Limits</td>
<td>Used for control charts.</td>
<td><code>col&lt;&lt;Set Property( &quot;Control Limits&quot;, {XBar(Avg(44), LCL(29), UCL(69))} );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col&lt;&lt;Get Property( &quot;Control Limits&quot; );</code></td>
</tr>
<tr>
<td>Response Limits</td>
<td>Set in DOE and used in desirability profiling.</td>
<td><code>col&lt;&lt;Set Property( &quot;Response Limits&quot;, {Goal(&quot;Match Target&quot;), Lower(1,1), Middle(2,2), Upper(3,3)} );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col&lt;&lt;Get Property(&quot;Response Limits&quot;);</code></td>
</tr>
<tr>
<td></td>
<td>Choices for Goal are Maximize, Match Target, Minimize, None. Other arguments take numeric value and desirability arguments.</td>
<td></td>
</tr>
<tr>
<td>Design Role</td>
<td>Used for DOE. Specify a single role.</td>
<td><code>col&lt;&lt;Set Property( &quot;Design Role&quot;, &quot;Covariate&quot; );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col&lt;&lt;Get Property( &quot;Design Role&quot; );</code></td>
</tr>
<tr>
<td></td>
<td>Choices for role are Continuous, Discrete Numeric, Categorical, Blocking, Covariate, Mixture, Constant, Uncontrolled, Random Block, Signal, and Noise.</td>
<td></td>
</tr>
<tr>
<td>Factor Changes</td>
<td>Sets the difficulty of changing a factor (Easy, Hard, or Very Hard).</td>
<td><code>col&lt;&lt;Set Property( &quot;Factor Changes&quot;, Hard) ;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col&lt;&lt;Get Property( &quot;Factor Changes&quot; );</code></td>
</tr>
<tr>
<td>Sigma</td>
<td>Used for control charts. Specify known sigma value.</td>
<td><code>col&lt;&lt;Set Property( &quot;Sigma&quot;,1.332 );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col&lt;&lt;Get Property( &quot;Sigma&quot; );</code></td>
</tr>
<tr>
<td></td>
<td>Each type of chart uses a different sigma calculation.</td>
<td></td>
</tr>
<tr>
<td>Distribution</td>
<td>Set the distribution type to fit to the column.</td>
<td><code>col&lt;&lt;Set Property( &quot;Distribution&quot;, Distribution( GLog ) );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col&lt;&lt;Get Property( &quot;Distribution&quot; );</code></td>
</tr>
<tr>
<td>Time Frequency</td>
<td>Set the type of time frequency.</td>
<td><code>col&lt;&lt;Set Property( &quot;Time Frequency&quot;, Time Frequency( &quot;Annual&quot; ) );</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>col&lt;&lt;Get Property( &quot;Time Frequency&quot; );</code></td>
</tr>
</tbody>
</table>
Table 9.2 Properties for Data Table Columns *(Continued)*

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example Using Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map Role</td>
<td>Set how the column is used to connect map shape data with name data. Specify the role and other information as necessary.</td>
<td><code>col&lt;&lt;Set Property( &quot;Map Role&quot;, Map Role(Shape Name Use( &quot;filepath to data table&quot;, &quot;column name&quot; ) ) );</code>&lt;br&gt;<code>col&lt;&lt;Get Property( &quot;Map Role&quot; );</code></td>
</tr>
<tr>
<td>Supercategories</td>
<td>Groups specific categories into one category. Supported only in the Categorical platform.</td>
<td><code>col&lt;&lt;Set Property( &quot;Supercategories&quot;, {Group( &quot;Genders&quot;, {&quot;F&quot;, &quot;M&quot;} )} );</code>&lt;br&gt;<code>col&lt;&lt;Get Property( &quot;Supercategories&quot; );</code></td>
</tr>
<tr>
<td>Multiple Response</td>
<td>Specifies the character that separates the responses within a cell.</td>
<td><code>col&lt;&lt;Set Property( &quot;Multiple Response&quot;, Multiple Response( Separator( &quot;&quot;,&quot;&quot; ) ) );</code>&lt;br&gt;<code>col&lt;&lt;Get Property( &quot;Multiple Response&quot; );</code></td>
</tr>
<tr>
<td>Profit Matrix</td>
<td>Assigns weights that define a decision model. Specify a list that contains the weights in a matrix and categories in another list. In the matrix, each row contains weights that reflect the profit for predicting the category indicated by the column of the matrix. Caution: The matrix argument is the transpose of the profit matrix as displayed in the Column Properties window.</td>
<td><code>col&lt;&lt;Set Property( &quot;Profit Matrix&quot;, {{5 -1, -1 4, -2 -2}, {&quot;M&quot;, &quot;F&quot;, &quot;Others&quot;}} );</code>&lt;br&gt;<code>col&lt;&lt;Get Property( &quot;Profit Matrix&quot; );</code></td>
</tr>
<tr>
<td>Expression Role</td>
<td>Applies to columns that contain expressions. Specifies whether the expression should be interpreted as a Picture, a Matrix, or an Expression.</td>
<td><code>col&lt;&lt;Set Property( &quot;Expression Role&quot;, Expression Role( &quot;Picture&quot;, MaxSize(640, 480 ), StretchToMaxSize( 1 ), PreserveAspectRatio( 1 ), Frame( 0 ) ) )</code></td>
</tr>
</tbody>
</table>


Rows

This section describes the messages for adding and manipulating the rows in a data table. Row messages are directed to a data table reference, and most act on the currently selected rows. A number of row messages might not be practical in scripting (for example, Move Rows).

Add Rows

To add rows, send an Add Rows message and specify how many rows. You can also specify after which row to insert the new rows. The arguments can either be numbers or expressions that evaluate to numbers.

```javascript
dt << Add Rows( 3 ); // add 3 rows to bottom of data table
dt << Add Rows( 3, 10 ); /* add 3 rows after the 10th row, moving the 11th and lower rows farther down */
```

A variation of Add Rows lets you specify an argument yielding a list of assignments. Assignments can be separated with commas or semicolons.

```javascript
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Add Rows(
    {:name = "Peter", :age = 14, :sex = "M", :height = 61, :weight = 124}
);
dt = New Table( "Cities" );
dt << New Column( "xx", Numeric );
```

You can send several arguments yielding lists, or even a list of lists. The following script creates a data table with Add Rows commands of each variety:

```javascript
dt = New Table( "Cities" );
dt << New Column( "xx", Numeric );
```
Data Tables

Chapter 9

Rows

Scripting Guide

```
dt << New Column( "cc", Character, width( 12 ) );

dt << Add Rows( {xx = 12, cc = "Chicago"} ); // single list
dt << Add Rows( {xx = 13, cc = "New York"}, {xx = 14, cc = "Newark"} );
// several lists
dt << Add Rows( 
   {xx = 15, cc = "San Francisco"}, {xx = Sqrt( 256 ), cc = "Oakland"} 
); // list of lists

a = {xx = 20, cc = "Miami"};
dt << Add Rows( a ); // evaluate as single list

b={{xx = 17, cc = "San Antonio"},{xx = 18, cc = "Houston"}, {xx = 19, cc = "Dallas"}};
dt << Add Rows( b ); // evaluate as list of lists
```

Further details for rows can be specified with messages described under “Row States and Operators” on page 352.

Delete Rows

To delete rows, send a Delete Rows message and specify which row or rows to delete. To delete more than one row, give a list or matrix as the rownum argument, or combine Delete Rows with other commands such as For. The rownum argument can be a number, list of numbers, range of numbers, matrix, or an expression that yields one of these. Without an argument, Delete Rows deletes the currently selected rows. With neither an argument nor rows selected, Delete Rows does nothing.

```
dt << Delete Rows( 10 ); // delete row 10
dt << Delete Rows( {11, 12, 13} ); // delete rows 11-13
myList = {11, 12, 13};
dt << Delete Rows( myList ); // delete rows 11-13
dt << Delete Rows( 1 :: 20 ); // delete first 20 rows
dt << Delete Rows( [1 2 3] ); // delete first 3 rows
```

For example, the following script opens Big Class.jmp and deletes row 10:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Selected( Row State( 10 ) ) = 1; // select row 10
dt << Delete Rows; // delete row 10
```

You can list duplicate rows, and you can list rows in any order with no consequence.

Here is a general way to remove the bottom x rows of a data table of any size. The following example removes five rows from the bottom of the data table:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
x = 5;
```
n = N Row( dt );
For( i = n, i > n - x, i--, 
   dt << Delete Rows( i )
);

NRow counts the rows in the table. For more details, see “Iterate a Script on Each Row” on page 350.

Select Rows

Select All Rows selects (or highlights) all of the rows in a data table.

   dt << Select All Rows;

If all rows are selected, you can deselect them all by using Invert Row Selection. This command reverses the selection state for each row, so that any selected rows are deselected, and any deselected rows are selected.

   dt << Invert Row Selection;

Note: With the exception of Invert Row Selection, whose result depends on the current selection, any new selection message starts over with a new selection. If you already have certain rows selected and you then send a new message to select rows, all rows are first deselected.

To select a specific row, use Go To Row:

   dt << Go To Row( 9 );

To select specific rows in a data table based on their row number, use the Select Rows command. The argument to the command is a list of row numbers. For example, to select rows 1, 3, 5, and 7 of a data table, proceed as follows:

   dt << Select Rows( {1, 3, 5, 7} );

To select a range of rows, specify one of the following messages:

   dt << Select Rows( Index( 7, 10 ) );
   dt << Select Where( Any( Row() == Index( 7, 10 ) ) );

Both of these examples select rows seven through 10 in the current data table.

To select rows according to data values, use Select Where, specifying a logical test inside the parentheses.

Tip: For a description of the functions and operators that you can use within a Select Where message, see “Operators” on page 85 in the “JSL Building Blocks” chapter.
For example, using the Big Class.jmp sample data table, select the rows where the students’ age is greater than 13:

```julia
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
dt << Select Where( :age > 13 );
```

Or, select the rows where the students’ ages are less than 14:

```julia
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
col = Column( dt, 2 );
dt << Select Where( col[] < 14 );
```

The following example selects the rows where the student’s ages are less than 15 and the sex is “F”:

```julia
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
dt << Select Where( :age < 15 & :sex == "F" );
```

To select a row without deselecting a previously selected row, combine `<< Select Where` with `<< Select Where` and the `Current Selection("extend")` argument. This is an alternative to using an OR statement.

```julia
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
dt << Select Where( :age == 14 );
dt << Select Where( :sex == "F", Current Selection( "extend" ) );
```

To select rows that are currently excluded, hidden, or labeled:

```julia
dt << Select Excluded;
dt << Select Hidden;
dt << Select Labeled;
```

To select rows that are not excluded, hidden, or labeled, stack a select message and an invert selection message together in the same statement, or send the two messages sequentially:

```julia
dt << Select Hidden << Invert Row Selection;
dt << Select Hidden;
dt << Invert Row Selection;
```

To refer to a specific cell, assign a subscript to the cell’s row number. In the following example, the subscript [1] is used with the `weight` column. The formula then calculates the ratio between each height and the first value in the `weight` column.

```julia
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
New Column( "ratio", Formula( height / weight[1] ) );
```

To obtain a random selection, use this syntax:

```julia
dt << Select Randomly( number )
dt << Select Randomly( probability )
```

These commands use a conditional probability to obtain the exact count requested.
The row menu command Select Matching Cells is also implemented in JSL.

```julia
dt << Select Matching Cells;
// select matching cells in the current data table
dt << Select All Matching Cells;
// select matching cells in all open data tables.
```

For more complicated selections, or to store selections permanently as row state data, see “Row States and Operators” on page 352.

**Resolving Column References When Using Select Where**

When you use column references to refer to column names in a Where statement, the column references need to be evaluated so they can be resolved to the proper data table. For example, in the following script, the parameters to the X(Xcol) and Y(Ycol) column references are linked to the data table in `dt`. However, the execution of the platform is associated with the Where subset data table. The script produces an error.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Ycol = Column( dt, "weight" ); // column reference to weight
Xcol = Column( dt, "height" ); // column reference to height
dt << Bivariate( Y( Ycol ), X( Xcol ), Fit Line(), Where( :sex == "F" ) );
```

To evaluate the column names to the correct data table, use an `Eval()` expression or refer to the column names directly.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Bivariate( Y( Eval( Ycol ) ), // or Y( :weight )
                X( Eval( Xcol ) ), // or X( :height )
                Fit Line(),
                Where( :sex == "F" )
             );
```

**Find Rows**

Get Rows returns a matrix of rows that match the specified condition. The following example select rows in which the age is greater than or equal to 16:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Get Rows Where( :age >= 16 );
[35, 36, 37, 38, 39, 40]
```

Get Selected Rows returns a matrix of the currently selected rows. The following example selects rows 1, 3, 5, and 7 and then returns the row numbers in a matrix:

```julia
dt << Select Rows( {1, 3, 5, 7} );
dt << Get Selected Rows;
[1, 3, 5, 7]
Data Tables

Chapter 9
Rows

Find Selected Rows

Next Selected and Previous Selected scroll the data table window up or down so that the next selected row that is not already in view moves into view. The table wraps, so Next Selected jumps from the bottom-most selected row to the top-most, and vice versa for Previous Selected.

\[
\text{dt} \leftarrow \text{Next Selected;}
\]

\[
\text{dt} \leftarrow \text{Previous Selected;}
\]

Clear Selected Rows

To cancel a selection, leaving no rows selected, use Clear Select, as follows:

\[
\text{dt} \leftarrow \text{Clear Select;}
\]

Move Rows

These commands move the currently selected rows to the indicated destination point.

\[
\text{dt} \leftarrow \text{Move Rows( At Start );}
\]

\[
\text{dt} \leftarrow \text{Move Rows( At End );}
\]

\[
\text{dt} \leftarrow \text{Move Rows( After( \text{rowNumber} ) );}
\]

Assign Colors and Markers to Rows

You can use the Colors and Markers messages to assign (or change) colors and markers used for rows. These settings mostly affect graphs produced from the data table. Both messages expect numeric arguments to choose which color or marker to use. For details about how numbers correspond to colors and markers, see “Colors and Markers” on page 362.

\[
\text{dt} \leftarrow \text{Colors( 3 );} \quad \text{// set selected rows to red}
\]

\[
\text{dt} \leftarrow \text{Markers( 2 );} \quad \text{// pick the X marker for selected rows}
\]

As with other row messages, you can stack selection and other messages together, as follows:

\[
\text{dt} = \text{Open( "$SAMPLE_DATA\Big Class.jmp" );}
\]

\[
\text{dt} \leftarrow \text{Select Where( :age == 13 );} \quad \text{// select the youngest subjects}
\]

\[
\text{dt} \leftarrow \text{Colors( 8 ) << Markers( 8 );} \quad \text{// and use purple open circles for them}
\]

Color by Column sets colors according to the values of a column that you specify, and Marker by Column works similarly:

\[
\text{dt} = \text{Open( "$SAMPLE_DATA\Big Class.jmp" );}
\]

\[
\text{dt} \leftarrow \text{Color by Column( :age );}
\]

\[
\text{dt} \leftarrow \text{Marker by Column( :age );}
\]
Additional, named arguments are as follows:

- **Continuous Scale** *(Color by Column only)*  Assigns colors in a chromatic sequential fashion based on the values in the highlighted column.
- **Reverse Scale**  Reverses the color scheme in use.
- **Make Window with Legend**  Creates a separate window with a legend.
- **Excluded Rows**  Applies the row states to excluded columns.
- **Marker Theme**  Specifies the marker type.
- **Color Theme**  Specifies the color theme.

## Color Cells

You can color individual cells in the data grid. For example, this line uses the row state color to color the cells:

```
dt << Color Rows by Row State;
```

You can also specify a color theme for either categorical or continuous columns:

```
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
:height << Set Property(
   "Color Gradient",
   {"White to Blue", Range( 40, 80 )}
);
:height << Color Cell By Value( 1 ); // turn on the cell coloring
:age << Set Property(
   "Value Colors", // assign the value colors
   {12 = Red, 13 = Yellow, 14 = Green, 15 = Blue, 16 = Magenta, 17 = Gray}
);
:age << Color Cell By Value( 0 ); // turn off the cell coloring
```

You can also color specific cells. The following example sets rows 1, 5, 8 of the “name” column to red:

```
:name << Color Cells( red, {1, 5, 8} );
```

To remove the color from specific cells, set the color to black. The following example removes the color for row 1 of the “name” column.

```
:name << Color Cells( black, {1} );
```
You can color cells based on specific values. The following example colors the cells in the `height` column. All cells containing a value greater than 60 are blue. All cells containing a value equal to or less than 60 are purple.

```javascript
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
For( i = 1, i <= N Row( dt ), i++,
    If( Column( dt, "height" )[i] > 60,
        Column( dt, "height" ) << Color Cells( 5, {i} ),
        Column( dt, "height" ) << Color Cells( 8, {i} )
    )
);
```

**Note:** The first argument for `Color Cells` represents the color value. The second argument contains the row numbers.

### Hide, Exclude, and Label Rows

**Note:** For more information about hiding, excluding, and labeling rows using row state operators, see “Row States and Operators” on page 352.

Use the `Hide`, `Exclude`, and `Label` messages to hide, exclude, and label rows. These messages are toggles, meaning that to turn the messages on you send them once, and to turn them off you send the message a second time. They also accept Boolean arguments to explicitly turn them off and on.

For example, to hide all rows in `Big Class` where age is greater than 13, you could do the following:

```javascript
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Select Where( :age > 13 );
dt << Hide( 1 );
```

Messages to the same object can be stacked together in a single statement, so you could simplify the preceding script.

```javascript
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Select Where( :age > 13 ) << Hide( 1 );
```

### Iterate on Rows in a Table

In addition to built-in programming operators for iterating, JSL provides operators for iterating through data table rows, groups, or conditional selections of rows.

Generally, an expression is executed on the current row of the data table only. Some exceptions are the expressions inside formula columns, `Summarize` and the pre-evaluated statistics operators, and any use of data table columns by analysis platforms.
Set the Current Row

Note: The current row for scripting is not related to rows being selected (or highlighted) in the data table or to the current cursor position in the data table window. The current row for scripting is defined to be zero (no row) by default.

You can set the current row for a script using For Each Row or Row() = X.

    Row() = 3; ... 
    For Each Row( ... );

For Each Row executes the script once for each row of the current data table. Note that Row()=1 only lasts for the duration of the script, then Row() reverts to its default value, which is zero. This means that submitting a script all at once can produce different results than submitting a script a few lines at a time.

Throughout this chapter, examples without an explicit current row should be assumed to take place within a context that establishes a current row. For more information, see “What is the Current Row?” on page 349.

What is the Current Row?

By default, the current row number is 0. The first row in a table is row 1, so row 0 is essentially not a row. In other words, by default, an operation is done on no rows. Unless you take action to set a current row or to specify some set of rows, you get missing values due to the lack of data. For example, a column name returns the value of that column on the current row. Scope the column name with the prefix : operator to avoid ambiguity (to force the name to be interpreted as a column name).

    :sex; // returns ""
    :age; // returns .

Scoping names prevents you from getting a result that might look reasonable for the whole data table but is actually based on only one row. It also protects you from accidentally overwriting data values when making assignments to ambiguous names under most circumstances. You can have even more complete protection by using the prefix or infix : operator to refer specifically to a data column and the prefix :: operator to refer specifically to a global script variable. For more information, see “Advanced Scoping and Namespaces” on page 235 in the “Programming Methods” chapter.

You can use the Row() operator to get or set the current row number. Row() is an example of an L-value expression in JSL: an operator that returns its value unless you place it before an assignment operator (=, +=, and so on.) to set its value.

    Row(); // returns the number of the current row (0 by default)
    x = Row(); // store the current row number in x
    Row() = 7; // make the 7th row current
Row() = 7; :age; // make the 7th row current and returns 12

Note that the current row setting only lasts for the portion of a script that you select and submit. After the script executes, the current row setting resets to the default (row 0, or no row). Therefore, a script submitted all at once can produce different results from the same script submitted a few lines at a time.

How Many Rows and Columns?

The N Rows and N Cols operators return the rows and columns in a data table.

N Rows( dt ); // number of rows
N Cols( dt ); // number of columns

N Rows and N Cols also count the number of rows in matrices. Note that NRow and NCol are synonyms. See the “Inquiry Functions” on page 175 in the “Data Structures” chapter for details.

Iterate a Script on Each Row

To iterate a script on each row of the current data table, put For Each Row around the script.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
For Each Row( If( :age > 15, Show( :age ) ) );

To specify the open data table, include a data table reference as the first argument.

dt1 = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt2 = Open( "$SAMPLE_DATA/San Francisco Crime.jmp" );
For Each Row( dt1, If( :age > 15, Show( :age ) ) );

You can use For Each Row to set row states instead of creating a new formula column in the data table. The scripts below are similar, except that the first one creates a row state column, and the For Each Row script simply sets the row state without creating a column.

New Column( "My Row State", Row State, Formula( Color State( :age - 9 ) ) );
For Each Row( Color of( Row State() ) = :age - 9 );

To iterate a script on each row that meets a specified condition, combine For Each Row and If, as follows:

For Each Row( Marker of( Row State() ) = If( :sex == "F", 2, 6 ) );

You can use Break and Continue to control the execution of a For Each Row loop. For more information, see “Break and Continue” on page 104 in the “JSL Building Blocks” chapter.
Return Row Values

Dif and Lag are special operators that can be useful for statistical computations, particularly when working with time series or cumulative data.

- Lag returns the value of a column \( n \) rows before the current row.
- Dif returns the difference between the value in the current row and the value \( n \) rows previous.

The following lines are equivalent:

```r
dt << New Column( "htDelta" );
For Each Row( :htDelta = :height - Lag( :height, 1 ) );
For Each Row( :htDelta = Dif( :height, 1 ) );
```

Add Sequence Data

Sequence() corresponds to the Sequence function in the Formula Editor and is used to fill the cells in a data table column. It takes four arguments and the last two are optional:

```r
Sequence( from, to, stepsize, repeat );
```

From and to are not optional. They specify the range of values to place into the cells. If from = 4 and to = 8, the cells are filled with the values 4, 5, 6, 7, 8, 4, ...

Stepsize is optional. If you do not specify a stepsize, the default value is 1. Stepsize increments the values in the range. If stepsize = 2 with the above from and to values, the cells are filled with the values 4, 6, 8, 4, 6, ...

Repeat is optional. If you do not specify a Repeat, the default value is 1. Repeat specifies how many times each value is repeated before incrementing to the next value. If repeat = 3 with the above from, to, and stepsize values, the cells are filled with the values 4, 4, 4, 6, 6, 6, 8, 8, 8, 4, .... If you specify a Repeat value, you must also specify a Stepsize value.

The sequence is always repeated until each cell in the column is filled.

```r
dt = New Table( "Sequence Example" ); // create a new data table
dt << New Column( "Count to Five" ); // add two columns
dt << New Column( "Count to Seventeen by Fours" );
dt << Add Rows( 50 ); // add fifty rows

For Each Row (  
  Column( 1 )[ ] = Sequence( 1, 5 );
  Column( 2 )[ ] = Sequence( 1, 17, 4, 2 );
);
/* fill the first column with the data sequence 1, 2, 3, 4, 5, ...
fill the second column with the data sequence 1, 1, 5, 5, 9, 9, 13, 13, 17, 17, ... */
```
Because `Sequence()` is a formula function, you can also set a column's formula to use `Sequence()` to fill the column. The following example creates a new column named `Formula Sequence` and adds a formula to it. The formula is a sequence that fills the column with values between 25 and 29, incremented by 1, and repeated twice (25, 25, 26, 26, 27, 27, 28, 28, 29, 29, 25, ...).

```julia
dt = New Table( "Formula Sequence Example" );
dt << New Column( "Formula Sequence", Formula( Sequence( 25, 29, 1, 2 ) ) );
```

The following are more examples of `Sequence()` results:

- `Sequence(1,5)` produces 1,2,3,4,5,1,2,3,4,5,1, ...
- `Sequence(1,5,1,2)` produces 1,1,2,2,3,3,4,4,5,5,1,1, ...
- `Sequence(10,50,10)` produces 10,20,30,40,50,10, ...
- `10*Sequence(1,5,1)` also produces 10,20,30,40,50,10, ...
- `Sequence(1,6,2)` produces: 1,3,5,1,3,5, ... The limit is never reached exactly.

**Note:** If you want a matrix of values, then use the `Index` function, not `Sequence`.

### Row States and Operators

There is a special data element type called a row state that stores various attributes in the data table. Row states can indicate the following:

- Whether a row is selected, excluded, hidden, or labeled
- Which marker type, color, shade, and hue to use for graphs

In JSL, you can use row state operators to manipulate row states.

### About Row States

Row states change how JMP works with your data. Table 9.3 explains each row state. Remember that you can use several row states at once to get the combination of effects that you want.

#### Table 9.3  Row States

<table>
<thead>
<tr>
<th>Row states</th>
<th>How they affect results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excluded</td>
<td>If rows are excluded, JMP omits them from calculations for statistical analyses (text reports and charts). Results are the same as if the data was not entered. However, points are still included in plots. (To omit points from plots, use <code>Hide</code>. To omit points from all results, use both <code>Exclude</code> and <code>Hide</code>.)</td>
</tr>
</tbody>
</table>
### Table 9.3 Row States (Continued)

<table>
<thead>
<tr>
<th>Row states</th>
<th>How they affect results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hidden</td>
<td>If rows are hidden, JMP does not show them in plots. However, the rows are still included in text reports and charts. (To omit points from reports and charts, use Exclude. To omit points from all results, use both Exclude and Hide.)</td>
</tr>
<tr>
<td>Labeled</td>
<td>If rows are labeled, JMP places row number labels, or the values from a designated Label column, on points in scatterplots.</td>
</tr>
<tr>
<td>Color</td>
<td>If rows have colors, JMP uses those colors to distinguish the points in scatterplots.</td>
</tr>
<tr>
<td>Marker</td>
<td>If rows have markers, JMP uses those markers to distinguish the points in scatterplots.</td>
</tr>
<tr>
<td>Selected</td>
<td>If rows are selected, JMP highlights the corresponding points and bars in plots and charts.</td>
</tr>
</tbody>
</table>
### About Row State Operators

When you give a row state operator a number as its argument (or an expression that evaluates to a number), the operator interprets that number as an index to its possible values.

Table 9.4 shows a comparison chart of the different row state operators, so that you can see which operators convert row states to numbers and numbers to row states. It also includes the numbers that you can use with each operator.

#### Table 9.4 Row State Operators

<table>
<thead>
<tr>
<th>Numbers</th>
<th>Convert from numbers to row states</th>
<th>Row states</th>
<th>Convert from row states to numbers</th>
<th>Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 or 0</td>
<td>Excluded State(n)</td>
<td>Excluded</td>
<td>Excluded(rowstate)</td>
<td>1 or 0</td>
</tr>
<tr>
<td>0 to 31</td>
<td>Marker State(n)</td>
<td>Marker</td>
<td>Marker Of(rowstate)</td>
<td>0 to 31</td>
</tr>
<tr>
<td>1 or 0</td>
<td>Hidden State(n)</td>
<td>Hidden</td>
<td>Hidden(rowstate)</td>
<td>1 or 0</td>
</tr>
<tr>
<td>1 or 0</td>
<td>Labeled State(n)</td>
<td>Labeled</td>
<td>Labeled(rowstate)</td>
<td>1 or 0</td>
</tr>
<tr>
<td>1 or 0</td>
<td>Selected State(n)</td>
<td>Selected</td>
<td>Selected(rowstate)</td>
<td>1 or 0</td>
</tr>
</tbody>
</table>
**Assign Row States**

To assign a row state using JSL, use `Select Where` to indicate which rows are affected, and then specify which row state to assign to the rows. In the following example, marker type 5 (a triangle) is assigned to rows in which `sex` is "F".

```javascript
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Select Where( :sex == "F" ) << Markers( 5 );
```

You can also use a formula to assign row states. Here is how you would do it in the data table:

1. Create a row state column.

### Table 9.4 Row State Operators (Continued)

<table>
<thead>
<tr>
<th>Numbers</th>
<th>Convert from numbers to row states</th>
<th>Row states</th>
<th>Convert from row states to numbers</th>
<th>Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 84</td>
<td>Color State($n$)</td>
<td>Color</td>
<td>Color Of(rowstate)</td>
<td>0 to 84</td>
</tr>
<tr>
<td>(0–15 basics,</td>
<td></td>
<td></td>
<td></td>
<td>(0–15</td>
</tr>
<tr>
<td>16–31 dark,</td>
<td></td>
<td></td>
<td></td>
<td>16–31</td>
</tr>
<tr>
<td>32–47 light,</td>
<td></td>
<td></td>
<td></td>
<td>32–47</td>
</tr>
<tr>
<td>48–63 very</td>
<td></td>
<td></td>
<td></td>
<td>48–63</td>
</tr>
<tr>
<td>dark, 64–79</td>
<td></td>
<td></td>
<td></td>
<td>64–79</td>
</tr>
<tr>
<td>very light, 80–84 grays)</td>
<td></td>
<td></td>
<td></td>
<td>80–84</td>
</tr>
</tbody>
</table>

| 0–11          | Hue State($n$)                     | Hue        |                                    |         |
| (rainbow order) |                                    |            |                                    |         |

| -2 to 2       | Shade State($n$)                   | Shade      |                                    |         |
| (dark to light) |                                    |            |                                    |         |
2. Add a formula to the column that assigns a marker to each row in which sex is “F”.

3. In the Column panel, right-click the star next to the row state column and select **Copy to Row States**.

The JSL equivalent would be something like this:

```javascript
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "Row State",
    Row State,
    Set Formula( If( :sex == "F", Marker State( 4 ) ) )
);  
Column( "Row State" ) << Copy To Row States();
```

**Store Row State Information**

A row state column is a dedicated column that stores row state information, but does not put the information into effect. You can then use For Each Row to put the row state column into effect. For more information about row state columns, see The Column Info Window chapter in the Using JMP book.

The following example creates a row state column then puts the row states into effect:

1. Submit this line to start a new data table:
   ```javascript
dt = New Table( "Row State Testing" );
```
2. Submit these lines to add row states to a column and add ten rows:
   ```javascript
dt << New Column( "Row State Data", Row State, Set Formula( Color State( Row() ) ) ) ;
dt << Add Rows( 10 );
```
3. Submit this line to put the row states into effect:
   ```javascript
   For Each Row( Row State() = :Row State Data );
   ```

**Figure 9.6** Table with No Row States (left) and Table with Row States (right)
This action replaces any row states in effect with the row state combination from the row state column. For details about how to change selected attributes of a row state without changing or canceling others, see “Set One Characteristic and Cancel Others” on page 360.

Set or Get Row States

From JSL, you can set or get row states directly using the Row State operator. You can set or get the state for row \( n \) with Row State\( (n) \). If you do not supply an argument, you set or get the current row. To work with all rows, either use a For Each Row loop or work with formula columns.

To set a row state, place the row state expression on the left of an assignment (L-value):

\[
\text{Row State}(1) = \text{Color State}(3); // make row 1 red
\]

\[
\text{Row}() = 8; \text{Row State}() = \text{Color State}(3); // make the 8th row red
\]

\[
\text{For Each Row} ( \text{Row State}() = \text{Color State}(3)); // make each row red
\]

To specify the data table, include a data table reference as the first argument:

\[
\text{dt1} = \text{Open}("\$SAMPLE\_DATA/Big Class.jmp");
\]

\[
\text{dt2} = \text{Open}("\$SAMPLE\_DATA/San Francisco Crime.jmp");
\]

\[
\text{Row State} ( \text{dt1, 1}) = \text{Color State}(3); // make row 1 red;
\]

To get a row state, place the row state expression on the right side of an assignment:

\[
x = \text{Row State}(5); // put the row state of row 5 into x
\]

\[
x = \text{Row State}(); // row state of current row
\]

Notes on Setting Row States

Be careful whether you set every aspect of Row State() or just one aspect of it, such as Color Of( Row State() ). To see how this works, first color and mark all the rows:

\[
\text{dt1} = \text{Open}("\$SAMPLE\_DATA/Big Class.jmp");
\]

\[
\text{For Each Row} ( \\
\quad \text{Row State}() = \text{Combine States}(\text{Color State}(\text{Row}()), \text{Marker State}(\text{Row}())));
\]

And now observe the difference between setting one attribute of a row state:

\[
\text{Color Of}(\text{Row State}(1)) = 3; // make row 1 red without changing marker
\]

And setting every aspect of a row state to a single state:

\[
\text{Row State}(1) = \text{Color State}(5); // make row 1 blue and removes its marker
\]

To copy all the current row row states into a row state column:

\[
\text{New Column}("\text{rscol}", \text{Set Formula}(\text{Row State}()));
\]

\[
\text{For Each Row}( \text{rscol} = \text{Row State}());
\]

\[
\text{Column "rscol" changed to type Row State to match formula.}
\]
To copy several but not all of the current row states into a row state column, use a script like the following (commenting out or omitting any states that you do not want):

```plaintext
New Column( "rscol2",
Set Formula(
    Combine States( 
        Color State( Color Of() ),
        Excluded State( Excluded() ),
        Hidden State( Hidden() ),
        Labeled State( Labeled() ),
        Marker State( Marker Of() ),
        Selected State( Selected() )
    )
)
);
```

To set a component of a row state:

```plaintext
Color Of( Row State( i ) ) = 3; // change color to red for row i
Selected( Row State( i ) ) = 1; // select the ith row state and set to 1
```

You can see from the example above that some of the operators convert numbers into states, and others convert states into numbers. Here are some helpful hints for remembering which are which:

**Number-to-state operators have the word “State”** Operators that take number arguments and either return states or accept state assignments all have the word “State” in their names: Row State, As Row State, Color State, Combine States, Excluded State, Hidden State, Hue State, Labeled State, Marker State, Selected State, Shade State.

**State-to-number operators are one word or have the word “Of”** Operators that take row state arguments (and assume that the argument Row State() if none is given) and operators that return or are set to numbers are either one word, or their second word is “Of”: Color Of, Excluded, Hidden, Labeled, Marker Of, Selected.

Table 9.4 on page 354 is a helpful comparison chart for these operators.

The following lines are equivalent to their interactive commands:

```plaintext
Copy From Row States
Add From Row States
Copy To Row States
Add To Row States
```

**Examples of Getting Row States**

For example, create the following table containing row states:

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
```
dt << New Column( "Row State Data", Row State, Set Formula( Color State( Row() ) ) );

dt << Add Rows( 10 );
For Each Row( Row State() = :Row State Data );

To get row states, submit the following lines:

Row State( 1 ); // returns row state for row 1
Color State(1)
Row() = 8; Row State(); // returns row state for current (8th) row
Color State(8)
For Each Row( Print( Row State() ) ); // returns the row states for each row
Color State(1)
Color State(2)
Color State(3)
...

To get a row state and store it in a global, place Row State() on the right side of an assignment. Add the following lines to the preceding script:

::x = Row State( 1 ); // put the row state of row 1 in x, a global
Row() = 8; ::x = Row State(); // put the row state of the 8th row in x
Show( x ); // returns x = Color State( 8 )
dt << New Column( "rscol", Row State );
For Each Row( :rscol = Row State() );
// puts row states in rscol (a row state column)

To get a component of a row state, place the row state expression on the right side of an assignment and also use one of the L-value operators:

x = Selected( Row State() ); // selection index of current row selected

**Get and Set Multiple Characteristics at Once**

You can get or set many characteristics at once by combining state settings inside Combine States. You can also get or set each characteristic one at a time, the ultimate row state being the accumulation of characteristics. The following example sets green Y markers for males, but hides them in plots for now. It also sets red X markers for females but shows them in plots.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
For Each Row(
  If( sex == "M",
    /* then */ Row State() = Combine States( Color State( 4 ), Marker State( 6 ), Hidden State( 1 ) ),
    /* else */ Row State() = Combine States( Color State( 3 ), Marker State( 2 ), Hidden State( 0 ) ) ) );

Get the row state for one row, such as the 6th:

Row State( 6 );
Combine States( Hidden State(1), Color State(4), Marker State(6))
Notice that JMP returns a Combine State combination. This is because a row state datum is not just the state of one characteristic, such as color, but the cumulative state of all the characteristics that have been set: exclusion, hiding, labeling, selection, markers, colors, hues, and shades. A list of such characteristics is called a row state combination.

Just as there can be many row state characteristics in effect, a row state column can have multiple characteristic row states as its values.

**Set One Characteristic and Cancel Others**

In addition to the overall Row State operator for getting or setting all the characteristics of a row state, there are separate operators to get or set one characteristic at a time preemptively. That is, to give a row one characteristic, canceling any other characteristics that might be in effect. The operators that set one characteristic and cancel others are as follows: Color State, Combine States, Excluded State, Hidden State, Hue State, Labeled State, Marker State, Selected State, Shade State.

For example, to make row 4 be hidden only:

```
Row State( 4 ) = Hidden State( 1 );
```

**Set or Get One Characteristic at a Time**

A row state is not just one characteristic, but many. To work with just one characteristic at a time, use one of the L-value operators with Row State on either side of the equal sign. The side of the equal sign depends on whether you want to get or set a characteristic. There is an L-value operator for each of the following characteristics: Color Of, Excluded, Hidden, Labeled, Marker Of, Selected.

This example hides row 4 without affecting any other characteristics:

```
Hidden( Row State( 4 ) ) = 1
```

This example stores the color of row 3 without getting any other characteristics:

```
::color = Color Of( Row State( 3 ) );
```

**Identify Row State Changes**

The MakeRowStateHandler message (sent to a data table object) obtains a callback when the row states change. For example,

```
f = Function( {X}, Show( x ) );
obj = dt << Make Row State Handler( f );
```

Then when you select a group of rows, the row numbers of any row whose row state changed are sent to the log. For example:

```
x:[3, 4, 28, 40, 41]
```
When a group is highlighted, it might call the handler twice, once for rows whose selection is cleared, then again for the new selection.

**Exclude, Hide, Label, and Select**

This section discusses conditions that have Boolean states (either on or off). These conditions include: excluding, hiding, labeling, and selecting rows.

- **Excluded** gets or sets an excluded index. The index is 1 for true or 0 for false, indicating whether each row is excluded.
- **Hidden** gets or sets a hidden index, which is 1 for hidden or 0 for not hidden.
- **Labeled** gets or sets a labeled index, which is 1 for labeled or 0 for not labeled.
- **Selected** gets or sets a selected index, which is 1 for selected or 0 for not selected.

The following examples illustrate these conditions:

```julia
Excluded( Row State() ); // returns 1 if current row is excluded, 0 if not
Hidden(); // returns 1 if current row is hidden, 0 if not
Labeled( Row State() ); // returns 1 if current row is labeled, 0 if not
Selected(); // returns 1 if current row is selected, 0 if not

Excluded( Row State() ) = 1; // exclude current row
Hidden() = 0; // unhide current row
Labeled( Row State() ) = 1; // label current row
Selected() = 0; // deselect current row
```

Remember that these functions assume the argument `Row State()` if none is given.

**Excluded State, Hidden State, Labeled State, and Selected State** do the reverse; they get or set a row state condition as true or false according to the argument. Nonzero values set the row state to true, and zero values set it to false. Missing values result in no change of state.

```julia
Row State() = Excluded State( 1 ); // change current row state to excluded
Row State() = Hidden State( 0 ); // change current row state to not hidden
Row State() = Labeled State( 1 ); // change current row state to labeled
Row State() = Selected State( 0 ); // change current row state to not selected
```

Notice that the first two expressions above replace the row state with just the exclusion or just the unhiding, so that any preexisting row state characteristics are lost. More commonly, you would issue the state commands for all of the characteristics that you want inside a Combine States. The following example changes the current row to hidden and a green square marker:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Row State() = Combine States(
    Color State( 4 ),
    Marker State( 3 ),
    Hidden State( 1 ) );
```
Another common way to use a `State` command would be in a row state data column whose values could be added to the row state (for cumulative characteristics). The following example excludes each odd numbered row:

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "myExcl",
    Row State,
    Set Formula( Excluded State( Modulo( Row(), 2 ) ) )
);
For Each Row( Row State() = Combine States( :myExcl, Row State() ) );
```

**Colors and Markers**

This section discusses conditions that have many choices. These conditions include: coloring, adding markers, different hues, or different shades to rows.

`Color Of()` returns or sets the color index. The color index is a number from the JMP color map that corresponds to the row state, or a missing value if there is no assigned color.

```plaintext
Color Of( Row State() ); // returns color index for current row
Color Of() = 4; // set current row to Color 4
```

Similarly, `Marker Of()` returns or sets the marker index. The marker index is a number from the JMP marker map that corresponds to the active marker, or a missing value if there is no assigned marker.

```plaintext
Marker Of(); // returns marker index for current row
Marker Of( Row State() ) = 4; // set current row to Marker 4
```

Both `Color Of()` and `Marker Of()` accept any row state expression or column or `Row State()` as arguments. They also assume the argument `Row State()` if none is given (some examples are shown with, and some without).

`Color State()` and `Marker State()` are similar to `Color Of()` and `Marker Of()`, except they work in the opposite direction. Where the `-Of` functions turn actual states into indices, the `-State` functions turn indices into states.

```plaintext
Row State() = Color State( 4 ); // change current row to green
Row State() = Marker State( 4 ); // change current row to the diamond marker
```

Notice that the last two commands replace the row state with just the color or just the marker, so that any preexisting row state characteristics are lost. More commonly you would issue the `-State` commands for all the characteristics that you want inside a `Combine States()`. The following example puts a green square marker in the current row and hides the row:

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Row State() = Combine States(
    Color State( 4 ),
    Marker State( 3 ),
    Hidden State( 1 ) );
```
The following script shows the standard JMP markers, which are numbered 0–31. Indices outside the range 0–31 have undefined behavior.

```plaintext
New Window( "Markers",
    Graph Box(
        FrameSize( 300, 300 ),
        Y Scale( -1, 16 ),
        X Scale( 0, 7 ),
        For(
            i = 0;
            jj = 15;;
            i < 16;
            jj >= 0;;
            i++;
            jj--; // 16 rows, 2 columns
            Marker Size( 3 );
            Marker( i, {1, jj + .2} ); // markers 0-15
            Marker( i + 16, {4, jj + .2} ); // markers 16-31
            Text( {1.5, jj}, "marker ", i ); // marker labels 0-15
            Text( {4.5, jj}, "marker ", i + 16 ); // marker labels 16-31
        )
    )
);
```

**Figure 9.7** JMP Markers

<table>
<thead>
<tr>
<th>15</th>
<th>10</th>
<th>5</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
</tr>
</tbody>
</table>

**Tip:** For more details about this script, see the “Display Trees” chapter on page 419.

Note the following about colors:
- JMP colors are numbered 0 through 84.
• The first 16 named colors are the basic colors. See the script below.
• Numbers higher than 16 are darker or lighter shades of the basic colors.
• Indices outside the range 0–84 have undefined behavior.
• For more information about using JMP colors, see “Specify Colors” on page 554 in the “Scripting Graphs” chapter.

The following script illustrates the standard JMP colors:

```plaintext
Text Color( 0 );
New Window( "Colors",
  Graph Box(
    FrameSize( 640, 400 ),
    Y Scale( -1, 17 ),
    X Scale( -3, 12 ),
    k = 0;
    For( jj = 1, jj <= 12, jj += 2,
      l = 15;
      For( i = 0, i <= 15 & k < 85, i++,
        thiscolor = Color To RGB( k );
        Fill Color( k );
        thisfill = 1;
        If( thiscolor == {1, 1, 1},
          Pen Color( 0 );
          thisfill = 0;

          Pen Color( k )
        );
        Rect( jj, l + .5, jj + .5, l, thisfill );
        Text( {jj - 1, l}, "color ", k );
        k++;
        l--;,
      );
    jj = -2;
    For( i = 0;
      l = 15;, i <= 15 & l >= 0,
      i++; l--;,
      Text( {jj, l}, color[i + 1] )
    );
  ));
);```


If you prefer to use RGB values, each color should be a list with percentages for each color in red, green, blue order. For example, the following percentages produce a teal color:

```
Pen Color( {.38,.84,.67} ); // a lovely teal
```

Hue and Shade Example

Hue State and Shade State together are an alternative to Color State for choosing colors. You cannot select black, white, or the shades of gray when you use Hue State. For these, you must use Shade State alone, or Color State.

The following script demonstrates how hue and shade values relate to colors:

```
New Window( "Hues and Shades",
  Graph Box(  
    FrameSize( 600, 300 ),
    Y Scale( -3, 3 ),
    X Scale( -2, 12 ),
    k = 0;
    For( h = 0, h < 12, h++,
      For( s = -2, s < 3, s++,
        myMk = Combine States( Hue State( h ), Shade State( s ), Marker State( 15 ) );
        Marker Size( 3 );
        Marker( myMk, {h, s} );
      )
    )
  )
```

Figure 9.8 JMP Colors
There are no -Of operators for Hue and Shade. Color Of returns the equivalent Color State index for a color row state that has been set with Hue State or Shade State. For example, the following example gives rows 4 and 5 the same dark red marker:

```plaintext
Row State( 4 ) = Combine States( Hue State( 0 ), Shade State( -1 ), Marker State( 12 ) );
Row State( 5 ) = Combine States( Color State( Color Of( Row State( 4 ) ) ), Marker State( Marker Of( Row State( 4 ) ) ) );
```

**Row State and Matrices Example**

In the following example, row state values are prepared ahead and passed to the Marker routine, along with matrices of coordinates.

```plaintext
dt = New Table( "Artificial CP and CA data",
    Add Rows( 26 ),
    ...)
```
```julia
New Column( "cover_cp",
    Numeric,
    "Continuous",
    Formula( Random Uniform() / 100 + 0.94 )
),
New Column( "cover_ca",
    Numeric,
    "Continuous",
    Formula( Random Uniform() * 0.04 + 0.94 )
),
New Column( "p", Numeric, "Continuous", Formula( Random Uniform() ) )
);
dt << Run Formulas;
greenMark = Combine States( Marker State( 2 ), Color State( 4 ) );
redDiamond = Combine States( Marker State( 3 ), Color State( 3 ) );
New Window( "CP and CA Comparisons",
    Graph Box(
        Title( "CP and CA Comparison" ),
        FrameSize( 400, 350 ),
        X Scale( 0, 1 ),
        Y Scale( 0.94, 1 ),
        For Each Row(
            Marker( greenMark, {p, cover_cp} );
            Marker( redDiamond, {p, cover_ca} );
        )
    )
);
```

**Figure 9.10** Example of Row States Values and Matrices
The Numbers behind Row States

This section is an optional topic for advanced users who are interested in working with row states through their internal numeric codes.

A row state is a collection of six attributes that all rows in a data table have. These six attributes are packed into a single number internally. You can see row states’ internal coding if you want. Simply copy row states to a column, and then change the column’s type to numeric to see the numbers that JMP uses.

It is also possible to assign row states through their internal numeric codes using the As Row State() operator, which simply converts integers to their equivalent row states. For example, to assign row states according to the row number, you could do:

   For Each Row( Row State() = As Row State( Row() ) );

In addition, the Set Row States() command enables you to submit a matrix of codes that assign the row states all at once. The matrix should have dimension (number of rows) by 1, and contain one entry for each row. The entries are the row state codes corresponding to the row’s desired state.

Such row states are unlikely to be of any use, however. For practical applications, understanding how numbers are related to row states is important. Briefly, for some row state \( r \), such as the row state of the third row as shown here, the row state code is computed by this formula:

\[
\begin{align*}
\text{r} &= \text{Row State}(3); \quad \text{// row state for row 3} \\
\text{rscode} &= 1 \times \text{Selected}(\text{r}) + \text{// 1 selects the row} \\
& \quad 2 \times \text{Excluded}(\text{r}) + \text{// 2 excludes the row} \\
& \quad 4 \times \text{Hidden}(\text{r}) + \text{// 4 hides the row} \\
& \quad 8 \times \text{Labeled}(\text{r}) + \text{// 8 labels the row} \\
& \quad 16 \times \text{Marker Of}(\text{r}) + \text{// 16 sets the marker} \\
& \quad 256 \times \text{Color Of}(\text{r}); \quad \text{// 256 sets the color}
\end{align*}
\]

Example

This example takes advantage of this method to develop a compact formula that distinguishes females and males with Xs and Ys, while excluding females from calculations, hiding males from plots, and assigning different colors for each age.

Recall that the logical == operator is an equality test that returns 1 for true and 0 for false.

   dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
   For Each Row( 
      Row State() = As Row State(
         ( :sex == "F" ) * 2 + // exclude F
         ( :sex == "M" ) * 4 + // hide M
         ( :sex == "F" ) * 2 * 16 + // set marker 2 for F
         ( :sex == "M" ) * 6 * 16 + // set marker 6 for M
   );
Accessing Data Values

The typical way to work with values in a data table is to follow these steps:

1. Set up the data table whose values you want to access as the current data table. Or, if you already have a data table reference, you can simply use that reference. See “Set the Current Data Table” on page 290.

2. Specify the row or rows whose values you want to access and specify the column name that contains the values that you want to access. See “Set or Get Values by Column Name” on page 369.

The following example opens the Big Class.jmp sample data table (making it the current data table), and then specifies row 2 in the weight column. A value of 123 is returned in the log, which is the weight for Louise in row 2.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt:weight[2];
123
```

Set or Get Values by Column Name

The easiest way to refer to a column is by its name. If you have a global variable and a column with the same name, to prevent ambiguity, scope the column name with the : prefix operator.

To set the value of a cell in the current row, provide the column name and the new value.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Row() = 5; // select row 5
dt:age = 19; // set the age in row 5 to 19
dt:name = "Sam"; // set the name in row 5 to Sam
```

To set the value of a cell in row 10, specify the row number in a subscript.

```
dt:age[10] = 20; // set the value of age in row 10 to 20
```

An empty subscript refers to the current row, so :age[] is the same as :age.

To get the value of a cell in row 16, specify the column name.

```
Row() = 16; // select row 16
myGlobal = :age; // store the age as a variable
:age; // returns 14, the age in row 16
Show( :age ); // returns age = 14;
```
To get the value of a cell in a specific row, include the column name and row number. Both of the following examples return 13, the value of age in row 12 of Big Class.jmp:

```plaintext
:age[12];
myGlobal = :age[12];
```

To get a value in a data column reference, use `Column()` and `As Column()` to get the value in a data column reference. For more information, see “Access Cell Values through Column References” on page 321.

**Notes:**

- If you do not specify the row number, the current row is selected.
- An empty subscript, such as `:age[ ]`, refers to the current row.
- Be careful that you are subscripting to a table row that exists. The default row number is zero, so statements like `:name` that refer to row zero generate an Invalid Row Number error.

**Additional Ways to Access Data Values**

There are other ways to specify a data table, row, and column. You can specify all three items in one expression by using an infix operator and a subscript, as follows:

```plaintext
dt:age[2] = 12; // table, column, and row
```

If you want to target multiple rows, you can use subscripts with a list or matrix of row numbers.

```plaintext
age[i] = 3;
age[{3, 12, 32}] = 14;
list = age[{3, 12, 32}]; // results in a list
vector = age[1 :: 20]; // results in a matrix
dt[1,1] = dt[2,1] // in Big Class.jmp, “KATIE” (row 1, column 1) is now “LOUSIE” (from row 2, column 1)
dt[0,{height}] = dt[0,{weight}]; // everybody's height is their weight
dt[1,{height,weight}] = dt[2,4::5]; // row 1 height and weight is from Louise
dt[[5 3 1], 0] = .; // set rows 5, 3, and 1 to missing. Using out-of-order subscripts makes more sense if the right hand side is a matrix or a data table with subscripts.
```

**Note about Changing Values**

Whenever you change values in a data table, messages are sent to the displays to keep them up-to-date. However, if you have thousands of changes in a script, this increases the time it takes to complete the updates.
In order to speed up changes, use `Begin Data Update` before the changes to block these update messages. Use `End Data Update` after the changes have been completed to release the messages and update the displays.

```julia
dt << Begin Data Update;
...<many changes>...
dt << End Data Update;
```

Be sure to always send the `End Data Update` message, otherwise the display is not updated until forced to do so in some other way.

**Note:** `Begin Data Update` does not affect the data refresh due to some other table manipulations. For example, when you delete or add columns, the data table is updated and then the data update begins.

---

### Add Metadata to a Data Table

Data tables store observation data, or measurements of various variables on a specific set of subjects. However, JMP data tables can also store *metadata*, or data about the data. Metadata includes the following:

- **Table variables** (store text strings, such as notes)
- **Properties** (store expressions, such as scripts)
- **Scripts**
- **Formulas**

#### Table Variables

Table variables are for storing a single text string value, such as “Notes”. To understand how variables work, first get its existing value by sending a `Get Table Variable` message:

```julia
dt = Open( "$SAMPLE_DATA/Solubility.jmp" );
dt << Get Table Variable( "Notes" );
"Chemical compounds were measured for solubility in different solvents. This table shows the log of the partition coefficient (logP) of 72 organic solutes in 6 aqueous/nonpolar systems."
```

Now change the existing value of the string using `Set Table Variable` or `New Table Variable`, and then use `Get Table Variable` again to check that the string has been updated:

```julia
dt << Set Table Variable( "Notes", "Solubility of chemical compounds" );
```

or

```julia
dt << New Table Variable( "Notes", "Solubility of chemical compounds" );
dt << Get Table Variable( "Notes" );
```
"Solubility of chemical compounds"

The following example adds two new table variables to a data table:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
myvar = "This is my version of the JMP Big Class sample data."

dt << Set Table Variable( "key1", myvar );
dt << Set Table Variable( "key2", myvar );
```

Notice that setting the value creates a new variable only if one by the given name does not already exist. If you add two table variables with the same name, only one variable is created.

**Table Scripts**

You can add a new script, run a script, or get a script using JSL.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Script( "Bivariate", Bivariate( Y( weight ), X( height ) ) );
dt << Get Script( "Bivariate" );
// returns Bivariate(Y(weight),X(height))
dt << Set Property( "Bivariate", Bivariate( Y( weight ), X( height ), Fit Line ) );
dt << Run Script( "Bivariate" )
```

The following example creates a new script and then runs the script:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Script("New Script",
   Distribution( Column( :Height, :Weight ),
                  By( :sex ) ),
   );
dt << Run Script( "Distribution" );
```

Suppose you want a text representation of a data table, perhaps to e-mail to a colleague or to use as part of a script. You can obtain a script that reconstructs the information in a data table with `Get Script`. The following example opens Big Class.jmp and prints the data, table variables, column properties to the log. A portion of the output is shown here:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Get Script;
New Table( "Big Class",
   Add Rows( 40 ),
   New Script(
      ["en" => "Distribution",...],
      Distribution(
         Continuous Distribution( Column( :weight ) ),
         Nominal Distribution( Column( :age ) )
      ),
   ),
```

Automatically Run a Script upon Opening a Data Table

The table script named On Open or OnOpen can be automatically run when the data table opens. Users are prompted to run the script by default. Their choice is remembered each time they open the data table in the current JMP session.

To create an On Open script, perform one of the following actions:

- Create the script using the Save Script > To Data Table option, and then double-click the property name and change the name to On Open.
- Store the script using a New Script message.

In this example, you create an OnOpen script in Big Class.jmp.

```
dt = Open("$SAMPLE_DATA/Big Class.jmp");
dt << New Script(
    "OnOpen", // create the script
    sortedDt = dt << Sort( By( :name ), Output Table Name( "Sorted Big Class" ) ) // sort the data and put it in a new data table
);
```

The JMP preference called Evaluate OnOpen Scripts determines when the script runs. By default, the user is prompted to run the script. You can set the preference to always run the On Open script or to prevent it from running:

```
Preference( Evaluate OnOpen Scripts( "always" ) );
Preference( Evaluate OnOpen Scripts( "never" ) );
Preference( Evaluate OnOpen Scripts( "prompt" ) ); // default setting
```

On Open scripts that execute other programs are never run. As a safety precaution, you might consider suppressing automatic execution when opening data tables that you receive from others.

**Note:** When you create a new data table in a script and include the On Open() function, On Open() is called before the data table is created, not after.

Formulas

The message Suppress Formula Eval takes a Boolean argument to specify whether formula evaluation should be suppressed or not. You might want to suppress evaluation if you plan to make numerous changes to the data table and do not want to wait for formula updates between steps.

```
dt << Suppress Formula Eval( 1 );
dt << Suppress Formula Eval( 0 );
```
To accomplish the same effect for all data tables, use the `Suppress Formula Eval` command to turn off formulas globally. This is the same as the message above, except that you do not send it to a data table object.

```
Suppress Formula Eval(1); // make formulas static globally
Suppress Formula Eval(0); // make formulas dynamic globally
```

Note that formulas are not evaluated when they are installed in the column. Even when you force evaluation, they end up being evaluated again in the background. This can be a problem for scripts if they depend on the column having the values while the script is running. If you need a mechanism to control evaluation, use the `EvalFormula` command or the `Run Formulas` command.

To force a single column to evaluate, send an `Eval Formula` command to the column. You can even do this inside the command to create the column, after the formula clause, as follows:

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "Ratio",
    Numeric,
    Formula( :height / :weight ),
    Eval Formula
 );
```

`dt << Run Formulas` performs all pending formula evaluations, including evaluations that are pending as a result of evaluating other formulas. This function is useful when you have a whole series of columns to run.

**Tip:** This method is preferred over `EvalFormula`. Although `EvalFormula` evaluates the formulas, it does not suppress the background task from evaluating them again. The background task takes great care to evaluate the formulas in the right order.

If you send the `Run Formulas` command to a data column, the evaluation is done at the time of the command, but it does not suppress the scheduled evaluations that are pending. Therefore, formulas might end up being evaluated twice if you also send the command to the data table and the data column. Being evaluated twice might be desirable for formulas that have random function in them, or it might be undesirable if they depend on randomization seeds being set. If you use random numbers and use the `Random Reset(seed)` feature to make a replicable sequence, then use the `Run Formulas` command, because it avoids a second evaluation.

**Note:** All platforms send a `Run Formulas` command to the data table to assure that all formulas have finished evaluating before analyses start.

### Set Values without a Formula

`col << Set Each Value(expression)` evaluates the expression for each row of the data table and assigns the result to the column. It does not store the expression as a formula.
Delete Metadata

You can delete table variables, table properties (such as a script), and formulas from the data
table, using the following commands:

```
dt << Delete Table Variable( name );
dt << Delete Table Property( name );
col << Delete Formula;
col << Delete Property( name );
col << Delete Column Property( name );
```

Calculations

This section discusses functions for pre-evaluated columnwise and rowwise statistics and
shows how JSL expressions work behind the scenes in the JMP formula calculator.

Pre-Evaluated Statistics

The following functions are special, pre-evaluated functions: Col Maximum, Col Mean, Col
Minimum, Col N Missing, Col Number, Col Quantile, CV (Coefficient of Variation), Col
Standardize, Col Std Dev, Col Sum, Maximum, Mean, Minimum, NMissing, Number, Std Dev, and
Sum.

**Note:** Statistics are also computed with Summarize (“Store Summary Statistics in Global
Variables” on page 297). Although the named arguments to Summarize have the same names
as these pre-evaluated statistic functions, they are *not* calling the pre-evaluated statistic
functions. The resemblance is purely coincidental.

All the statistics are *pre-evaluated*. That is, JMP calculates them once over the rows or columns
specified and thereafter uses the results as constants. Because they are computed once and
then used over and over again, they are more efficient to use in calculations than the
equivalent formula-calculated results.

When JMP encounters a pre-evaluated function in a script, it immediately evaluates the
function and then uses the result as a constant thereafter. Therefore, pre-evaluated functions
enable you to use columnwise results for rowwise calculations. For example, if you use Col
Mean inside a column formula, it first evaluates the mean for the column specified and then
uses that result as a constant in evaluating the rest of the formula on each row. A formula
might standardize a column using its pre-evaluated mean and standard deviation:

```
( Height-Col Mean( Height ) ) / Col Std Dev( Height )
```
For the Big Class.jmp data, \texttt{Col Mean(Height)} is 62.55 and \texttt{Col Std Dev(Height)} is 4.24. So for each row, the formula above would subtract 62.55 from that row’s height value and then divide by 4.24.

\textbf{Note:} Pre-evaluated functions disregard the excluded row state, meaning that any excluded rows are included in calculations. For summary statistics that obey row exclusion, use the Distribution platform.

\textbf{Columnwise Functions}

The functions whose names begin with “\texttt{Col}” all work \textit{columnwise}, or down the values in the specified column, and return a single number. For example, \texttt{Col Mean(height)} finds the mean of the values in all the rows of the column height and returns it as a scalar result. Some examples include the following:

\begin{align*}
\text{Average Student Height} &= \texttt{Col Mean( height )}; \\
\text{Height Sigma} &= \texttt{Col Std Dev( height )};
\end{align*}

With the \texttt{Col} functions, column properties such as Missing Value Codes assign data values that produce incorrect calculations. Suppose that the Missing Value Codes column property is assigned to the \texttt{x1} column to treat “999” as a missing value. Another column includes a formula that calculates the mean. To use the value “999” instead of a missing value to calculate the mean, refer to \texttt{Col Stored Value()} in the formula:

\begin{align*}
\text{Mean( Col Stored Value( :x1 ), :x2, :x3 )}
\end{align*}

\textbf{Rowwise Functions}

The functions \textit{without} “\texttt{Col}” listed below work \textit{rowwise} across the values in the variables specified and return a column result. For example, \texttt{Mean(height, weight)} finds the mean of the height and weight for the current row of the data table. The rowwise statistics are valid only when used in an appropriate data table row context. The following are some possibilities:

```julia
dt = \texttt{Open( "$SAMPLE\_DATA/Big Class.jmp" );}
Row() = 7;
::scalar = \texttt{Mean( height, weight )};
// scalar result for row 7 assigned to JSL global variable

dt << \texttt{New Column( "Scaled Ht-Wt Ratio",}
   \texttt{Formula( Mean( height, weight ) / age ) )};
// formula column created in data table

\texttt{vector = J( 1, 40 ); // create a 1x40 matrix to hold results}
\texttt{For Each Row( vector[Row()] = Mean( height, weight ) ); // fill the vector}
```
Rowwise functions can also take vector (column matrix) or list arguments, as follows:

\[
\begin{align*}
\text{myMu} &= \text{Mean}( \begin{bmatrix} 1 & 2 & 3 & 4 \end{bmatrix} ); \\
\text{mySigma} &= \text{Std Dev( \{ 1, 2, 3 \} )};
\end{align*}
\]

**Calculator Formulas**

You can store formulas in columns that are automatically evaluated to create the values in the cells of the column. If you open the formula, you get a calculator interface to edit the formula structurally. However, the formula is implemented with JSL, and you can obtain the text JSL form of any expression in the calculator by double-clicking it. The text can be edited, and when it is de-focused, it is compiled back into the structural form.

*Note:* There is no difference between a formula column created through the calculator window and one created directly through JSL with commands such as `New Column(..., Formula(...))` or `Col << Formula(...)`. 
If you run the same analysis frequently, you can script it to automate the process. Anyone can then run the script, ensuring the same results every time. To get started, perform your analysis interactively as you normally would with JMP, and then save a script that re-creates that analysis. You can modify the script to further customize it.

**Figure 10.1** Typical Workflow for Scripting Platforms

1. Perform an interactive analysis
2. Save the script for the analysis
3. Add a platform object reference
4. Send messages to the platform object

This chapter is about scripting platforms, not reports. Platform object references and report object references receive different types of JSL messages. Platforms can run tests, draw plots, and so on. Reports can copy pictures, select display boxes, or close outline nodes. To learn about scripting reports, see the section “Navigate JMP Reports” on page 420 in the “Display Trees” chapter.

**Tip:** For additional scripting help, see the JMP Scripting Index (Help > Scripting Index) and the JSL Syntax Reference.
Example of Scripting a Platform

If you are not familiar with JSL, it can be helpful to start by interactively performing your analysis in JMP, and then saving the analysis to a script. JMP creates the script for you, and you can then add to it or modify it as desired, by creating a platform object and sending it messages.

Overview

This example takes you through these steps:
1. “Launch the Analysis and Save the Script to a Window”
2. “Add a Platform Reference Object and Send Messages”
3. “Add a Data Table Reference and Save the Script”

Launch the Analysis and Save the Script to a Window

1. Select Help > Sample Data Library and open Big Class.jmp.
   This fictional data set contains the names, ages, sex, heights, and weights for 40 students.
2. Select Analyze > Fit Y by X.
4. Select age and click X, Factor.
5. Click OK.
   A Oneway plot of students’ height by age appears.
6. Click the Oneway Analysis red triangle and select the following options:
   - Means/Anova
   - Compare Means > Each Pair, Student’s t
7. Click the Oneway Analysis red triangle and select Save Script > To Script Window.

The resulting script appears as follows:

```jsl
Oneway(
    Y( :height ),
    X( :age ),
    Each Pair( 1 ),
    Means( 1 ),
    Mean Diamonds( 1 ),
    Comparison Circles( 1 )
);
```

Notice the following:
- The script begins with a call to the Oneway() function, which returns a Oneway object.
The parentheses after the Oneway() function contain arguments that tell the Oneway function how to make the object.

- The first two arguments, Y and X, are required at launch.
- The next four arguments are optional: Each Pair, Means, Mean Diamonds, and Comparison Circles.
- When you selected the Each Pair, Student’s t option, the Each Pair and Comparison Circles features were turned on.
- When you selected the Means/Anova option, the Means and Mean Diamonds features were turned on.

The scripting equivalent of turning an option on or off is the Boolean argument 0 (off) or 1 (on).

Add a Platform Reference Object and Send Messages

1. (Optional) Right-click in the script and select Show Embedded Log. Output that appears in the log is now easily visible below the script.

2. Choose a JSL variable to remember the Oneway platform object.

   In this example, use the name oneObj:

   ```
   oneObj = Oneway(
     Y( :height ),
     X( :age ),
     Each Pair( 1 ),
     Means( 1 ),
     Mean Diamonds( 1 ),
     Comparison Circles( 1 )
   );
   ```

   This gives you a way to address the platform object and send messages to it.

3. Click Run Script.

   This creates the Oneway object and sets the variable oneObj. Now, send a message to tell the platform to turn on the Unequal Variances report.

4. At the end of the script, add the following line: oneObj << Unequal Variances(1), as shown here:

   ```
   oneObj = Oneway(
     Y( :height ),
     X( :age ),
     Each Pair( 1 ),
     Means( 1 ),
     Mean Diamonds( 1 ),
     Comparison Circles( 1 )
   );
   ```
oneObj << Unequal Variances(1);

5. Highlight the Unequal Variances line of JSL and click Run Script.

**Tip:** You can also hold down the Ctrl key and click R to run a highlighted line of JSL.

At the bottom of the report window, the Tests That the Variances Are Equal report now appears. Now, suppose that you want to see only that report (and the graph), and you want to close the other reports.

6. Add the following lines to the script:
   ```javascript
   rep = Report( oneObj );
   rep["Oneway Anova"] << Close( 1 );
   rep["Means Comparisons"] << Close( 1 );
   ```

   The `Report()` function returns the report object for the Oneway platform, and stores a reference to the report in the JSL variable called `rep`. You can send messages or perform actions on the report object, such as closing specific report outlines.

7. Highlight these last 3 lines of the script and click Run Script.

   In the report window, the Oneway Anova and the Means Comparisons reports are now closed. Only the initial graph and the Tests that the Variances are Equal report (which includes the Welch’s Test report) appear.

   If you close the Big Class jmp sample data table at this point and then try to run the script, you are prompted to open a data table. A best practice is to precede the call to the Oneway platform with an `Open()` function to open the associated data table each time the script is run.

**Add a Data Table Reference and Save the Script**

1. Add the following line as the first line in the script:
   ```javascript
   dt = Open("$SAMPLE_DATA/Big Class.jmp");
   ```

   If the data table is not open when the script is run, this line opens the associated data table.

   Your finished script should look like this:

   ```javascript
   dt = Open("$SAMPLE_DATA/Big Class.jmp");
   oneObj = Oneway(
     Y(:height),
     X(:age),
     Each Pair(1),
     Means(1),
     Mean Diamonds(1),
     Comparison Circles(1)
   );
   oneObj << Unequal Variances(1);
   rep = Report(oneObj);
   rep["Oneway Anova"] << Close(1);
   ```
rep["Means Comparisons"] << Close( 1 );

Once you complete your script, save it for future access.

2. From the script window, select **File > Save As**. Enter a name for your script and save it to any directory.

---

**Send Messages to a Platform**

Before you can send messages to a platform, you need to create a platform object that you can send the messages to. Use the Send operator (<<).

The following line keeps a reference to a Oneway platform in the JSL variable called `oneObj`:

```
oneObj = Oneway( Y( height ), X( age ) );
```

Then, add the Send operator to send the platform object a message. In this example, the message is to turn on the Unequal Variances report:

```
oneObj << Unequal Variances( 1 );
```

To see which messages can be sent to a specific object, do one of the following:

- **Use the autocomplete shortcut.** On a new line, enter the object name, then the Send operator (>>,) and press Ctrl and space (Windows) or Ctrl and Option and space (Macintosh). The following example shows the messages that you can send to the platform object `oneObj` on Windows:

  ```
oneObj >> (Ctrl+space)
  ```

  A list of messages appears. Click one to insert it.

- **Use the Show Properties () function.** Specify the object in the parenthesis. The following example shows the messages that you can send to the platform object `oneObj`:

  ```
  Show Properties (oneObj)
  ```

  A list of messages appears in the log.

---

**Conventions for Messages and Arguments**

- For most messages, omitting the argument for a Boolean command enables the option. For example, all of these messages create a test for unequal variances:

  ```
  Tip: The first two approaches are recommended.

  oneObj << Unequal Variances;
  oneObj << Unequal Variances( 1 );
  oneObj << Unequal Variances( "true" );
  oneObj << Unequal Variances( "yes" );
  oneObj << Unequal Variances( "present" );
  ```
oneObj << Unequal Variances( "on" );

**Note:** For row state messages, omitting the argument toggles the option: if the option is off, the message turns it on, and if the option is on, the message turns it off. You can also use the "toggle", "switch", or "flip" keyword, as in r << Excluded( "toggle" ).

- When the name of the JMP option contains several options separated by a comma or slash (such as the Means/Anova option or the T Square, T² option) you can use any one of the menu names. Or, you can use the full menu name, including the comma or slash, if you use it within the Name() function. For example, any of these messages create a Means/Anova test:

  oneObj << Means( 1 )
  oneObj << Anova( 1 )
  oneObj << Name( "Means/Anova" )( 1 )

- When an option appears under a menu in JMP, the corresponding script message is the option itself without the parent menu. For example, in the Oneway red triangle menu, the Nonparametric menu has multiple options under it, including Wilcoxon Test. Simply use Wilcoxon Test as a function or message in a script:

  oneObj = Oneway( Y( height ), X( age ), Wilcoxon Test( 1 ));
  oneObj << Wilcoxon Test( 1 );

- When a menu in JMP contains values rather than options, in the script, specify the parent menu and the value as an argument. For example, in the Oneway red triangle menu, the Set Alpha Level menu has values, such as 0.10, 0.05, 0.01, and Other. To specify 0.01 in a script, add a line like the following:

  oneObj << SetAlphaLevel(0.01);

**Send Multiple Messages**

To send several messages, just add more << operators or more Send arguments:

```plaintext
dist << Quantiles( 1 ) << Moments( 1 ) << More Moments( 1 ) << Horizontal Layout( 1 );
Send( dist, Quantiles( 1 ), Moments( 1 ), More Moments( 1 ), Horizontal Layout(1));
```

Because << is an eliding operator, it combines arguments and works differently than if its arguments were grouped. You can stack multiple messages with extra << symbols to perform them all in order, from left to right.

Another way to stack messages is to send a list of messages:

```plaintext
dist << {Quantiles( 1 ), Moments( 1 ), More Moments( 1 ), Horizontal Layout( 1 )};
```
These approaches work well assuming that no value is returned as a result of one of your messages. However, if your goal is to send a message to the result of another message, add grouping parenthesis. The second line shows the wrong way to do it; the third line shows how to do it correctly:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
// the following line is incorrect, and sends the Fit Mean message to the original data table object
bv = dt << Run Script( "Bivariate" ) << Fit Mean( 1 );
// the following line is correct, and sends the Fit Mean message to the resulting Bivariate object/report
bv2 = ( dt << Run Script( "Bivariate" ) ) << Fit Mean( 1 );
```

### Find Messages for Objects

Some messages apply to all platform objects, and others are specific to certain platforms. Once you have created a platform object, find out what messages you can send to the object, using any of the following approaches:

- Use the Scripting Index in JMP:
  1. Select Help > Scripting Index.
  2. Enter the object type that you are interested in.
  3. Click the correct object in the resulting list. Messages for the object appear in the Items list.

- Once you have created a platform object, use the `Show Properties( obj )` function. Replace `obj` with your named platform object. A list and brief description of all the messages the object can receive appears in the Log. To understand more about the Show Properties output, see “Interpret the Show Properties List” on page 386.

  **Tip:** The `Show Properties()` function also works with data tables and display boxes. See “How Can I See All of the Messages that Can be Sent to a Data Table Object?” on page 277 in the “Data Tables” chapter and “The `<<` Operator” on page 430 in the “Display Trees” chapter.

- Examine the platform in JMP launch windows and report windows. Most options that you find there have JSL equivalents with the same names and arguments.
### Interpret the Show Properties List

Show Properties lists the messages that can be sent to a scriptable object, such as a data table, an analysis platform, or a display, producing a text report in the log. Each type of message is categorized and appears in brackets, and can be any of the following:

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Action]</td>
<td>Correspond to options in the JMP interface.</td>
<td>Redo Analysis [Action] (Rerun this same analysis in a new window. The analysis will be different if the data has changed.)</td>
</tr>
<tr>
<td>[Action Choice]</td>
<td>List specific choices for their arguments.</td>
<td>Fit Polynomial [Action Choice] {2, quadratic, 3, cubic, 4, quartic, 5, 6}</td>
</tr>
<tr>
<td>[Enum]</td>
<td></td>
<td>Draw [Enum] {Filled, Outlined, Filled and Outlined}</td>
</tr>
<tr>
<td>[Boolean]</td>
<td>Turn options on or off. Arguments are usually 1 or 0. If a message is specified without an argument, sending the message changes it to the opposite state. [Default On] indicates that the option is on by default.</td>
<td>Show Points [Boolean] [Default On]</td>
</tr>
<tr>
<td>[Subtable]</td>
<td>List options within submenus. You use the option itself, not the parent item.</td>
<td>Script [Subtable] Reorder Analysis [Action] (Rerun this same analysis in a new window. The analysis will be different if the data has changed.)</td>
</tr>
</tbody>
</table>
Specify Which Columns to Analyze

If you created your script interactively, you already specified columns in the launch window, so there is no need to specify them again. However, when creating a script from scratch, you normally want to specify the columns to analyze. For example, the following line launches the Distribution platform and specifies the height and weight columns as the Y variables:

```julia
Distribution( Y( height, weight ));
```

Create Column References

Creating a column reference enables you to access and send messages to the column. If you store each column reference in a JSL variable, you can use the variables instead of column names in the Y and X roles and elsewhere in the script.

For example, using Big Class.jmp, the following lines create Ycol as a column reference for weight, and Xcol as a column reference for height. The last line sends a message to Xcol to get the data type.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Ycol = Column( "weight" );
Xcol = Column( "height" );
Xcol << Get Data Type;
```

In the log, “Numeric” is output for the data type of the Xcol (height column).
Specify Multiple Column Names at Once

If you have a lot of column names, instead of listing each one individually, you can use lists as column arguments. The following example gets the column names from a list and runs a Distribution on each column in the list.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Distribution( Y( 1::N Col( dt ) ) );
```

**Tip:** If you do not know the column names when you are writing the script, use column indices, as done in this example.

Enable Users to Specify Columns

Instead of specifying analysis columns yourself, you can enable a user to specify them, but you can still control what happens after they do so. In this case, use an empty specification. The following example runs the Distribution launch window:

```
Distribution();
```

In this scenario, the Distribution launch window appears and the user can choose the columns to analyze. After the user selects the columns and clicks OK, the script continues to work, showing the output that you have specified.

Specify a By Variable

In many JMP platforms, you can specify columns as By variables. To do this in a script, include a By() function in the platform command, listing each column as an argument.

The following example uses the Big Class.jmp data table, which contains the names, ages, sex, heights, and weights for 40 students. Create a bivariate report of weight by height, using sex as a By variable, and adding a variety of fits.

Create the Bivariate Report Using a By Variable

2. Add the following lines:
   ```
   dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
   biv = dt << Bivariate( Y( weight ), X( height ), By( sex ));
   ```
   The first line opens the Big Class.jmp sample data table. The second line creates a platform object called biv that runs a bivariate report of weight and height by sex.
3. Click Run Script.

The report window shows two graphs, one where sex is F and one where sex is M.
Send Messages to the Entire Platform or to a Single By Level

1. If you do not have the log showing, turn it on. Right-click in the script and select **Show Embedded Log**.

2. Add this line to the script:
   
   ```
   Show(biv);
   ```

3. Highlight the `Show(biv)` line and click **Run Script**.

   In the log, rather than returning a single reference to a platform, `Bivariate[]`, the platform object returns a list of references: `biv = {Bivariate[], Bivariate[]}`. The two references correspond to the two levels (F and M) of the By variable, sex.

   You can direct messages to each By level individually or to all By levels.

4. Send a message to all By levels to add a linear regression fit. Add this line to the script:
   
   ```
   biv << Fit Line;
   ```

5. Highlight the line you just created and click **Run Script**.

   In the report window, a linear regression line is added to both graphs, with the corresponding Linear Fit reports.

6. Send a message to only the F level, adding a cubic polynomial fit. Add this line to the script:
   
   ```
   biv[1] << Fit Polynomial(3);
   ```

   **Tip:** The number for each By level corresponds to their order in the report window, which is usually alphanumeric. If the By column contains a Value Ordering column property, that ordering is followed.

7. Highlight the line you just created and click **Run Script**.

   In the report window, a polynomial fit line is added to the F graph, with the corresponding Polynomial Fit reports.

8. Send a message only to the M level, adding a quartic polynomial fit. Add this line to the script:
   
   ```
   biv[2] << Fit Polynomial(4);
   ```

9. Highlight the line you just created and click **Run Script**.

   In the report window, a quartic fit line is added to the M graph, with the corresponding Polynomial Fit reports.
If you specify more than one column in the `By()` function, graphs appear for each subgroup of each `By` variable. In this example, `By( sex, age )` would produce graphs for females age 12, females age 13, and so on, up to age 17. It would also produce graphs for males age 12 up to age 17.

**Extract Results from a Report**

The following example shows how to launch a platform with `By` groups and extract results (in this case, variances) from each group:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
```
onew = dt << Oneway( x( :age ), y( :height ), by( :sex ), anova );
// onew is the JSL variable holding a list of platforms
r = onew << Report;
// r is a list of reports
nBy = N Items( r );
// nBy is the number of reports generated
vc = J( nBy, 1, 0 );
// vc is an array of as many rows as reports, one column, all set to zero
For( i = 1, i <= nBy, i++,
// for each report, do the following:
   vc[i] = r[i]
// vc[i] is the variance of the ith report
   [Outline Box( "Analysis of Variance" ),
   // look for this outline and
   Column Box( "Sum of Squares" )][2]
);
// this column and get the second value
Show( vc );
// debugging, look in log to see this value
Summarize( byValues = By( :sex ) );
// byValues becomes a list of the values in the sex column
New Table( "Variances" )
// makes a new table with two rows (M.F) and two columns
<< New Column( "Sex",
   character,
   width( 8 ),
   values( byValues )
// creates a new column called Sex
) << New Column( "Variance", Numeric, "Continuous", Values( vc ) );
// creates a new column called Variance

---

**Filter by Value or Column**

You can use a Where clause to filter by a specific value or column. If you are adding a Where clause to a script that contains column references, you must first resolve the references. For example, the following lines use the Name Expr() function on the Ycol and Xcol references and add a Where clause to limit the analysis to females:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Ycol = Column( "weight" );
Xcol = Column( "height" );
biv2 = dt << Bivariate( Y( Name Expr( Ycol ) ),
   X( Name Expr( Xcol ) ),
   Fit Line( ),
   Where( :sex == "female" ) );
Where( :sex == "F" )
);

When the platform script selects a subset of the data (females), the column references are now correctly resolved to the original data table.

Enable User Input

When you send an Action() function to a platform, it evaluates an expression. For example, use Action messages when you want the launch window to appear. A user chooses columns in the launch window and the script continues running after the user runs the analysis.

The following example launches four platforms: Distribution, Bivariate, Oneway, and Contingency. The launch window for each platform appears, and the user chooses the analysis columns and clicks OK. The report window for each analysis appears, and then the next platform launch window comes up, until all platforms have been launched.

    dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
    dt << Distribution( Action( doit ) );
    doit = Expr(
        New Window( "Bivariate", Bivariate( Action( doit2 ) ) )
    );
    doit2 = Expr(
        New Window( "Oneway", Oneway( Action( doit3 ) ) )
    );
    doit3 = Expr(
        New Window( "Contingency", Contingency( Action( doit4 ) ) )
    );
    doit4 = Expr();

Execute Embedded Red Triangle Options

In addition to the red triangle menu at the top of a report, some report windows contain embedded red triangle menus. These appear when you select an option that has sub-options, such as profilers. To execute options in embedded red triangle menus, use the Get Scriptable Object message. The following example creates a Life Distribution report then turns off the Confidence Intervals option in the Hazard Profiler red triangle menu:

    dt = Open( "$SAMPLE_DATA/Reliability/Fan.jmp" );
    obj = dt << Life Distribution(
        Y( :Time ),
        Censor( :Censor ),
        << Fit Lognormal
    );
    // runs a Life Distribution report with a lognormal distribution
haz_prof = ( report( obj )[ "Hazard Profiler" ] << Get Scriptable Object);
// gets a reference to the Hazard Profiler red triangle menu
haz_prof << Confidence Intervals( 0 );
// turns off confidence intervals in the Hazard Profiler

**Make Platforms Invisible**

In certain circumstances, you might want to make the platform analysis invisible. This means that no platform windows appear, and the platform runs in the background.

If you are doing a simulation or bootstrap analysis in your script, the script might call a platform hundreds or thousands of times. Perhaps you just want to pull one or two results out of each platform report. The following example performs a simulation and then creates a table of results and shows them in a Distribution report:

```plaintext
dt = As Table( (0 :: 10)`, << Column Names( {"X"} ) );
// create X variable
Random Reset( 12345 );
// set initial random seed to get reproducible results
dt << New Column( "Y",
    "Continuous",
    "Numeric",
    Set Formula( :X * 2 + 1 + Random Normal() )
);
// Y values have a random component
res = [];
// define results matrix (empty to start)
For( i = 1, i <= 100, i++,
    // loop through simulation runs
    bv = dt << Bivariate( Y( :Y ), X( :X ), Fit Line( 1 ), << Invisible );
    res |/= (Report( bv )["Parameter Estimates"]
            Number Col Box( "Estimate" )) << Get as Matrix);
    // concatenate the results to the bottom of the results matrix
    bv << Close Window;
    // close the window (even though it's invisible)
dt:Y << Eval Formula;
    // generate new Y values
);
dtres = As Table( res, << Column Names( {"Intercept", "Slope"} ) );
// create table of results
dtres << Distribution( Y( :Intercept, :Slope ) );
// show results in Distribution
```

If you want to run an analysis as an intermediate step in your script, and do not need the user to see the analysis, hide it with the invisible option. In this case, you might want to show only specific results from the report, which you can output to a journal or to the log.
• The following example runs the Distribution platform as invisible, and outputs only the CDF plot to a new journal:

\[
\begin{align*}
dt & = \text{Open( "SAMPLE_DATA/Big Class.jmp" )}; \\
dist & = dt \ll \text{Distribution( Y( :height ), CDF Plot( 1 ), invisible );} \\
& \quad \text{Report( dist )["CDF Plot"] \ll Journal; } \\
& \quad \text{dist} \ll \text{Close Window; }
\end{align*}
\]

• The following example extracts the $F$-Ratio from an invisible Bivariate report, and outputs it to the log:

\[
\begin{align*}
dt & = \text{Open( "SAMPLE_DATA/Big Class.jmp" )}; \\
biv & = dt \ll \text{Bivariate( x( :height ), y( :weight ), invisible );} \\
biv & \ll \text{Fit Line; } \\
r & = biv \ll \text{Report; } \\
fratio & = r[\text{ColumnBox( "F Ratio" )}][1]; \\
r & \ll \text{Close Window; } \\
\text{Show}( \text{fratio} ); \\
\text{fratio} & = 1.15609545178219;
\end{align*}
\]

**Tip:** Invisible windows use resources that must be manually freed. Be sure to close the invisible window when the script is done with it.

You can also use the invisible option on the options in the Tables menu, such as Subset, Sort, Stack, and so on. The following example makes the Subset operation invisible:

\[
\begin{align*}
dt & = \text{Open( "SAMPLE_DATA/Big Class.jmp" )}; \\
dt & \ll \text{Select Where( :age == 14 );} \\
subDt & = dt \ll \text{Subset( invisible );} \\
subDt & \ll \text{Bivariate( x( :height ), y( :weight ), Fit Line );}
\end{align*}
\]

Note that the preceding line could also be handled using a \texttt{WHERE} clause:

\[
\begin{align*}
\text{subDt} & \ll \text{Bivariate( x( :height ),y( :weight ), Where( :age == 14 ), Fit Line );}
\end{align*}
\]

---

**Specify Report Titles**

You can specify the title (shown in the title bar of a platform’s report) by adding the \texttt{title} command to the launch request. The following example replaces the standard bivariate report’s title with a user-specified one (My Title).

\[
\begin{align*}
dt & = \text{Open( "SAMPLE_DATA/Big Class.jmp" )}; \\
dt & \ll \text{Bivariate( x( :height ), y( :weight ), Title( "My Title" ) );}
\end{align*}
\]
Chapter 10
Scripting Platforms

Common Messages for Platform Windows

For a list of common messages that you can send to most platforms, see the JSL Messages chapter in the JSL Syntax Reference.

Scripting Considerations by Platform

This section explains specific considerations when scripting the following platforms:

- “Categorical” on page 395
- “Control Charts” on page 396
- “Distribution” on page 399
- “DOE” on page 399
- “Fit Model” on page 401
- “Neural and Neural Net” on page 406
- “Partial Least Squares and PLS” on page 406
- “Process Capability” on page 406
- “Scatterplot 3D” on page 407

Categorical

The Free Text option in Categorical displays a Text Explorer report. Scripts that call the Free Text option in Categorical should be updated to use the Text Explorer platform.

Scripting for Supercategories

When ratings are involved in a data set (for example, a five point scale), you might want to know the percent of the responses in the top two or another subset of ratings. You can define a group of ratings in the data using the supercategories scripting option (instead of the column property).

The following example creates a new column called Floss Delimited 2, and adds a supercategory called Sleep Related, which contains two values: Before Sleep and Wake.

```javascript
dt = Open( "$SAMPLE_DATA/Consumer Preferences.jmp" );
dt << New Column( "Floss Delimited 2",
    Character,
    Set Property(
        "Supercategories",
        {Group( "Sleep Related", {"Before Sleep","Wake"} )}
    ), ...);
```
In the data table, under the Columns panel at left, scroll down to the new Floss Delimited 2 column. Click the column property indicator ⋆ and select Supercategories. You can see the new Sleep Related supercategory with its two values.

Supercategories can also be specified in a Categorical launch command, where the properties are listed inside parentheses after the column name:

```julia
dt = Open( "$SAMPLE_DATA/Consumer Preferences.jmp" );
dt << Categorical(  
    Supercategories(  
    :Floss Delimited(  
    {Group( "Sleep Related", {"Before Sleep," , "Wake,"} )}  
    )  
    ),  
    Multiple Response( :Floss Delimited )  
    );
```

In the Categorical report, notice that the Sleep Related category has 203 cases. If you had run the Categorical platform without creating this supercategory, Before Sleep and Wake would appear as separate categories with 143 and 60 cases, respectively.

For more information about supercategories, see the Categorical chapter in the Consumer Research book.

### Control Charts

Using JSL, you can create control charts, customize tests, run alarm scripts, and more.

#### Customize Tests in Control Chart Builder

You can design custom tests and select or deselect multiple tests at once using the Customize Tests function. You specify the description, desired number, and label. This option is available only for Variables and Attribute chart types.

The following example creates a custom test called Test 1 and turns it on.

```julia
dt = Open( "$SAMPLE_DATA/Quality Control/Diameter.jmp" );
dt << Control Chart Builder(  
    Variables( Subgroup( :DAY ), Y( :DIAMETER ) ),  
    Customize Tests( Test 1( 2, "1" ) ), // description, test number, label  
    Chart( Position( 1 ), Warnings( Test 1( 1 ) ) ), // turn Test 1 on  
    Chart( Position( 2 ) )  
    );
```
Run Alarm Scripts

An alarm script alerts you when the data fail one or more tests. As an Alarm Script is invoked, the following variables are available, both in the issued script and in subsequent JSL scripts:

- qc_col is the name of the column
- qc_test is the test that failed
- qc_sample is the sample number
- qc_firstRow is the first row in the sample
- qc_lastRow is the last row in the sample

Example 1: Automatically Writing to a Log

One way to generate automatic alarms is to make a script and store it with the data table as a Data Table property named QC Alarm Script.

**Note:** This script is not supported in Control Chart Builder at this time.

The following example automatically writes a message to the log whenever a test fails:

```
dt = Open( "$SAMPLE_DATA/Quality Control/Coating.jmp" );
obj = dt << Control Chart(
    Sample Size( :Sample ),
    KSigma( 3 ),
    Chart Col( :Weight, XBar, R ),
    Alarm Script(
        Write( "Out of Control for test ",
            qc_test,
            " in column ",
            qc_col,
            " in sample ",
            qc_sample
        )
    )
);
obj << Test 1( 1 );
```

Example 2: Running a Chart with Spoken Tests

You can create a control chart with tests that are spoken aloud using the Speak function. Try the following example:

```
dt = Open( "$SAMPLE_DATA/Quality Control/Coating.jmp" );
dt << Control Chart(
    Alarm Script( 
        Speak( "Out of Control for test ",
            qc_test,
            " in column ",
            qc_col,
            " in sample ",
            qc_sample
        )
    )
);
```
Scripting Platforms
Chapter 10
Scripting Considerations by Platform

```
Speak(
    Match( QC_Test,
        1, "One point beyond Zone A",
        QC_Test, 2,
        "Nine points in a row in zone C or beyond", QC_Test,
        5,
        "Two out of three points in a row in Zone A or beyond"
    ),
)
),
Sample Size( :Sample ),
Ksigma( 3 ),
Chart Col( :Weight, Xbar( Test 1( 1 ), Test 2( 1 ), Test 5( 1 ) ), R )
);
```

You can have either of these scripts use any of the JSL alert commands, such as Speak, Write, or Mail.

**Set Phase Limits**

A phase is a group of consecutive observations in the data table. For example, phases might correspond to time periods during which a new process is brought into production and then put through successive changes. Phases generate, for each level of the specified Phase variable, a new sigma, set of limits, zones, and resulting tests.

The following example illustrates setting the limits for the different phases of Diameter.jmp:

```
dt = Open( "$SAMPLE_DATA/Quality Control/Diameter.jmp" );
dt << Control Chart(
    Phase( :Phase ),
    Sample Size( :DAY ),
    KSigma( 3 ),
    Chart Col( :DIAMETER, XBar( Phase Level( "1", Sigma( .29 ), Avg( 4.3 ), LCL( 3.99 ), UCL( 4.72 ) ), Phase Level( "2", Sigma( .21 ), Avg( 4.29 ) ),
```
LCL( 4 ),
  UCL( 4.5 )
);
)
),
R( Phase Level( "1" ), Phase Level( "2" ) )
);

Distribution

You can set specification limits using the Spec Limits column property or using the Spec Limits() function in JSL:

dt = Open( "$SAMPLE_DATA/Cities.jmp" );
dt << Distribution(
  Column( :OZONE ),
  Fit Distribution( Weibull(
    Spec Limits( LSL( 0.075 ), Target( 0.15 ), USL( 0.25 ) )
  )
)
);

To set specification limits for K Sigma, use the Set Spec Limits for KSigma message. By default, the argument is two-sided. To make it one-sided, specify sided=1.

dt = Open( "$SAMPLE_DATA/Cities.jmp" );
obj = Distribution( Column( :CO ) );
obj << Fit Distribution( LogNormal( Set Spec Limits for KSigma( 3 ) )
);

DOE

Tip: For a complete list of DOE scripting options, select Help > Scripting Index, select Objects from the menu, and search for DOE.

To reproduce your DOE work, most DOE platforms provide these approaches:

• In the red triangle menu for the DOE window, the Save Script to Script Window option provides a script that reproduces the work that you have entered. This option is not available for the Nonlinear Design and Taguchi Array platforms.

• In the output design tables created by most DOE platforms, a script called DOE Dialog reproduces the work in the DOE window that created the design table. This script also contains the random seed (and number of starts or column starts, where appropriate) that enables you to reproduce your design exactly.
For many DOE platforms, the design table that is created also contains one or more scripts that you can run to conduct an appropriate analysis. These scripts are prefilled with the appropriate settings for your design.

**The Random Seed**

In constructing designs using the DOE platform, JMP uses a random seed to control certain actions that have a random component. A random seed can control the following:

- simulating responses using the Simulate Responses option
- randomizing Run Order for design construction
- selecting a starting design for designs based on random starts

To reproduce a design or simulated responses using a script, you need to specify the random seed that generated them. For designs using random starts, set a random seed in the script before making the design. To control simulated responses or run order, set a random seed in the script before making the design table.

The following example creates a Custom Design, sets the random seed, and makes the design:

```julia
DOE(
    Custom Design,
    Add Factor( Continuous, -1, 1, "X1", 0 ),
    Add Factor( Continuous, -1, 1, "X2", 0 ),
    Set Random Seed( 34067086 ),
    Make Design
);
```

**Reproduce a Custom Design or a Main Effects Screening Design**

Custom designs and main effects screening designs (constructed in the Screening Design platform) are generated by allocating a maximum number of seconds (Design Search Time) spent searching for a design. The default setting for Design Search Time is based on the complexity of the design. Even when two custom or main effects screening designs are constructed using the same random seed, the designs might not be identical because of different machine processing capabilities.

When you save the script for either of these designs using the Save Script to Script Window option, or when the DOE Dialog script is saved to the data table, the script specifies the Random Seed and the Number of Starts. The Number of Starts is the number of random starts used during the Design Search Time. The combination of the Set Random Seed and the Number of Starts options enables you to reproduce the design.
Note: If you write your own script, be aware that the order in which you specify options in your script can affect your results. For example, you should specify the design options before you make the design. In particular, if your design is constructed using a random seed, set it before you make the design.

Global Variables

Here are some global variables used to initiate or tune search algorithms.

Starting Design  Enables you to specify a starting design. The following example replaces the random starting design with a specified matrix:

        DOE Starting Design = matrix;

If a starting design is supplied, the Custom Design platform has only one start using this design.

K Exchange Value  The coordinate exchange algorithm considers every row of factor settings for possible replacement in every iteration. You can limit the number of rows considered for exchange in an iteration so that only a small number of most likely rows is considered. The following example tells the algorithm to consider only the three most likely rows for exchange in each iteration:

        DOE K Exchange Value = 3;

Bayes Diagonal  Defines a vector that is added to the diagonal elements of the $X'X$ matrix. This new matrix is used in finding the $D$-optimal design. The following example adds the elements of vector to the diagonal elements of the $X'X$ matrix:

        Bayes Diagonal = vector:

Fit Model

When scripting the Fit Model platform, here are a few general tips for controlling the behavior of the launch window:

- To keep the launch window open and fit the model at the same time, do one of the following (they are equivalent):
  - Include the Run Model message in your script.
  - Include both the Run message and the Keep Dialog Open(1) message.
- To run the model without showing the launch window, include the Run message in your script.

Model Scripts in the Data Table

When a data table contains a Model script and you launch Fit Model interactively, the Fit Model launch window is pre-populated according to the roles assigned by the table script.
Fit Group

If you want to fit different models and see a shared Profiler so that you can compare the models, use the Fit Group function. You can fit models such as least squares, nonlinear, neural, Gaussian processing, and mixed, in the same window with a shared Profiler. The following example creates both a Standard Least Squares model and a Gaussian Process model.

```julia
dt = Open( "$SAMPLE_DATA/Tiretread.jmp" );
```

In the report, click the Fit Group red triangle and select **Profiler**. Scroll down to the Prediction Profiler. You can see the ABRASION row for the SLS model, and the HARDNESS row for the Gaussian Process model appearing in the same profiler.

Effects

Effects in the model can be more than just a list of columns, and can have a specialized syntax:

```julia
Effect( list of effects, list of effect macros, or both lists );
```
An effect can be a column name, a crossing of several column names with asterisk (*) notation, or nested columns specified with subscript bracket ([ ]) notation. Additional effect options can appear after an ampersand (&) character. Here are some examples:

- A, // a column name alone is a main effect
- A*B, // a crossed effect, interaction, or polynomial
- A[B], // nested
- A*B[C D], // crossed and nested
- effect&Random, // a random effect
- effect&LogVariance, // a variance model term
- effect&RS, // a response surface term
- effect&Mixture, // for an effect participating in a mixture
- effect&Excluded, // for an effect that with no model arguments
- effect&Knotted, // for a knotted spline effect

Effect macros are:

- Factorial( columns ), // for a full factorial design
- Factorial2( columns ), // for up to 2nd-degree interactions only
- Polynomial( columns ), // for a 2nd-degree polynomial only

Responses and Effects for MANOVA

To address an individual response function analysis, use a subscripted Response:

```
manovaObj << ( Response[ 1 ] << {response options} );
manovaObj << ( Response[ "Contrast" ] << {response options} );
```

Each response function supports the Custom Test message:

```
Custom Test( matrix, <Power Analysis( ... )>, <Label( "..." )> )
```

where each row of the matrix specifies coefficients for all the arguments in the model.

To address an individual Effect test, use subscripted Effect with a name or number:

```
manovaObj << ( Response[1] << ( Effect["Whole Model"] << {effect options} ) );
manovaObj << ( Response[1] << ( Effect[i] << {effect options} ) );
```

The effects are numbered as follows:

- 0 for the intercept
- 1, 2, and so on, for regular effects
- \(n+1\) for the “Whole Model” test, where \(n\) is the number of effects not including the intercept

Each effect in each response function supports the following messages, where each row of the matrix has coefficients for all the levels in the effect:

```
Test Details( 1 ),
Centroid Plot( 1 ),
```
Save Canonical Scores,
Contrast( matrix, <Power Analysis(...) > );

For example, the following JSL script adds test details for an effect to the report window:

```jsl
dt = Open( "$SAMPLE_DATA/Dogs.jmp" );
manObj = dt << Fit Model(
    Y( logHist0, logHist1, logHist3, logHist5 ),
    Effects( dep1, drug, drug * dep1 ),
    Personality( "MANOVA" ),
    Run Model
);
manObj << Response Function( "Contrast" );
manObj << (Response["Contrast"] << (Effect["Whole Model"] <<
    Test Details( 1 )));
// send the Test Details message to the Whole Model outline under Contrast in
// the report window
manObj << (Response[1] << (Effect[3] << Test Details( 1 )));
// send the Test Details message to response 1 (Contrast) and effect 3 (drug*dep1)
```

**Send Function**

**Tip:** Recall that the `<<` operator is equivalent to the `Send()` function.

When you have multiple responses, you can send messages to a specific response column’s fit. Use the following JSL (where `responseName` is the specific response):

```jsl
fitObj << ( responseName << {options, ...});
```

The second `Send()` function finds the named response and sends the list of messages to it.

**Note:** If you send the messages directly to the `fitObj` with a single `Send()` function, the messages are sent to all responses.

In the following script, the last line sends a message to the AICc report for the ABRASION response:

```jsl
dt = Open( "$SAMPLE_DATA/Tiretread.jmp" );
fitObj = dt << Fit Model(
    Y( :ABRASION, :MODULUS, :ELONG, :HARDNESS ),
    Effects(
        :SILICA & RS,
        :SILANE & RS,
        :SULFUR & RS,
        :SILICA * :SILICA,
        :SILANE * :SILICA,
        :SILANE * :SILANE,
```
 Scripting Considerations by Platform 

405

Standard Least Squares

For Standard Least Squares models that contain only fixed effects and more than one Y response, you can choose to fit the models for the Y responses together or separately. If some of the rows have missing values, the following apply:

- In a script, the Y responses are fit together by default. The model fits each Y using only those rows that are nonmissing for all of the Y variables. For example, a row that includes one or more missing Y values is excluded from the model. You can explicitly include Run( "Fit Together" ) in a script to get the same result.

- If you include the Run( "Fit Separately" ) option, the model fits each Y using all rows that are nonmissing for that particular Y. For example, a row that includes one or more missing Y values is included in the model.

The following script fits the Y responses together:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Fit Model(
    Y( :height, :weight ),
    Effects( :sex ),
    Personality( "Standard Least Squares" ),
    Emphasis( "Minimal Report" ),
    Run // or Run( "Fit Together" )
);
```

The following script fits the Y responses separately:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Fit Model(
    Y( :height, :weight ),
    Effects( :sex ),
    Personality( "Standard Least Squares" ),
    Emphasis( "Minimal Report" ),
    Run( "Fit Separately" )
)
```
When running the model in JMP, the user is prompted to select fitting the responses separately or together. The Fit Model launch window contains a Fit Separately option, which is deselected by default. For details about how missing Y values are handled, see the Standard Least Squares chapter in *Fitting Linear Models*.

**Note:** In models that contain a random effect, Y values are fit separately by default.

### Neural and Neural Net

The Neural platform replaces the Neural Net platform. Scripts that use Neural Net are deprecated and might not work in the future. It is recommended to use the Neural platform for new scripts and update any old scripts using Neural Net to Neural.

### Partial Least Squares and PLS

The Partial Least Squares (PLS) platform has replaced the PLS platform. Scripts that use PLS might not work in the future. It is recommended to use the Partial Least Squares platform for new scripts and update any old scripts using PLS to Partial Least Squares.

### Process Capability

The Process Capability platform has replaced the Capability platform. Scripts that use Capability might not work in the future. It is recommended to use the Process Capability platform for new scripts and update any old scripts using Capability to Process Capability.

### Specification Limits in JSL Scripts

Specification limits can be read from JSL scripts, column properties, or from a specification limits data table. As an example of reading in specification limits from JSL, consider the following example:

```julia
dt = Open( "$SAMPLE_DATA/Cities.jmp" );
dt << Process Capability(
    Process Variables( :OZONE, :CO, :SO2, :NO ),
    Spec Limits(
        OZONE( LSL( 0.075 ), Target( 0.15 ), USL( 0.25 ) ),
        CO( LSL( 5 ), Target( 7 ), USL( 12 ) ),
        SO2( LSL( 0.01 ), Target( 0.04 ), USL( 0.09 ) ),
        NO( LSL( 0.01 ), Target( 0.025 ), USL( 0.04 ) )
    )
);
```
Using a Limits Data Table and JSL

There is no extra syntax needed to differentiate between the two table types (wide and tall) when they are read using JSL. This example is based on the CitySpecLimits.jmp sample data table. It places the specification limits data table inside an Import Spec Limits() expression.

```julia
dt = Open( "$SAMPLE_DATA/Cities.jmp" );
dt << Process Capability(
   Process Variables( :OZONE, :CO, :SO2, :NO ),
   Spec Limits(
      Import Spec Limits("$SAMPLE_DATA/CitySpecLimits.jmp"
   )));
```

Scatterplot 3D

If your machine supports acceleration, and you want to display the 3-D scatterplot faster, you can turn on the Use Hardware Acceleration option, or in JSL, specify the `Scene3DHardwareAcceleration` global variable. A value of 1 turns it on, and a value of zero turns it off.

```julia
dt = Open( "$SAMPLE_DATA/Solubility.jmp" );
Scene3DHardwareAcceleration = 1;
dt << Scatterplot 3D(
   Y( :Name( "1-Octanol" ), :Ether, :Chloroform, :Benzene, :Carbon Tetrachloride, :Hexane )
);
```

Explorer Outliers

The Explore Outliers platform provides options to identify, explore, and manage outliers in your univariate or multivariate data.

In the Probe.jmp sample data table, several columns contain outlier values of 9999. Many industries use nines as a missing value code. The following example selects VDP_PCOLL, VDP_PINNBASE, and VDP_PINPBASE, the columns with the highest number of 9s, and adds the Missing Value Codes column property to the columns. The script then rescans the columns and removes these columns from the report.

```julia
dt = Open( "$SAMPLE_DATA/Probe.jmp" );
obj = Explore Outliers(
   Y( :VDP_M1, :VDP_M2, :VDP_NBASE, :VDP_NEMIT, :VDP_NENBNI, outer: 1)
);
```
Some messages and arguments that can be sent to a platform object are scripting-only. This means that these options do not have corresponding options in JMP launch windows or reports. However, note that scripting-only options can appear as Preferences.

This section describes scripting-only messages and arguments for specific platforms.

**Tip:** For more details about any of these messages or arguments, and for specific examples, go to the Scripting Index (Help > Scripting Index).

### Bivariate

The *Fit Where* message for Bivariate objects fits a curve to a single level of a categorical variable.

```julia
biv_object << Fit Where( WHERE_clause );
```

### Choice

When estimating the parameters in the Choice platform, you can set the acceptable criterion for convergence using this JSL function:

```julia
Convergence Criterion( fraction );
```
Clustering

The following messages for a hierarchical cluster object are available only in JSL:

- `hier_cluster_object << Get Column Names`
  // return the column names in cluster order (for two-way clustering)
- `hier_cluster_object << Get Clusters`
  // return a vector of cluster numbers
- `hier_cluster_object << GetDisplayOrder`
  // return a vector of the display position for each row in the cluster, with missing values for undisplayed rows
- `hier_cluster_object << GetColumnDisplayOrder`
  // return a vector of the display position for each column (for two-way clustering)
- `hier_cluster_object << Get Distance Matrix`
  // return the distance matrix used for hierarchical clustering

KMeans Clustering

The following message for a KMeans cluster object is available only in JSL:

`kmeans_cluster_object << Get Statistics`
// return the mean and standard deviation for each variable within each cluster

Control Chart

The following argument for the `Control Chart()` function is available only in JSL:

`Use Excluded Points on MR( Boolean )`
// include points that are excluded in the moving range calculations

Cumulative Damage

The following message for a Cumulative Damage object is available only in JSL:

`cumulative_damage_object << Get Results`
// return a list of the model fit results

Custom Profiler

The following messages for Custom Profiler objects are available only in JSL:

`profiler_object << Get Objective`
// return the current value of the objective function
profiler_object << Objective Formula
// return the formula for the objective function
profiler_object << Get Objective Formula
// return the formula for the objective function as an expression

**Distribution**

The following JSL message for a Distribution object is available only in JSL:

```
dist_object << ( Fit Handle[n] << ...);
```

// create an array of handles to the fitted distributions, so you can send commands to specific distributions

The following argument for the Fit Distribution() function is equivalent to the Make into Data Table option on the right-click menu for the Parameter Estimates table:

```
dt = Open( "$SAMPLE_DATA/Cities.jmp" );
obj = Distribution( Column( :CO ) );
obj << Fit Distribution( LogNormal( Make Parms Table ) );
```

**Fit Life by X**

The following messages for a Fit Life by X object are available only in JSL:

- `fit_life_object << Set Scriptables( ... );`
  // set scriptable options within the profilers in different sections of the output
- `fit_life_object << Get Results`
  // return the estimates, standard errors, covariance matrix, and convergence results for each distribution fit

**Fit Model**

The following section describes scripting-only messages for MANOVA, Generalized Linear Models, Nominal and Ordinal Logistic, and Standard Least Squares.

**MANOVA**

The following message for a Fit MANOVA object is available only in JSL:

```
fit_model_object << ( Response[1] << (Effect[1] << ... ) );
```

Where the third message could be one of the following:

- Test Details // show or hide the test details for an individual effect.
- Centroid Plot // show or hide the centroid plot for an individual effect.
Save Canonical Scores // save the canonical scores for an individual effect.
Contrast // run a customized F test contrasting different levels for an effect
in the model.

The following example saves canonical scores for the first response and effect pair, which in
this data, is LogHist0 and drug:

```
dt = Open( "SAMPLE_DATA/Dogs.jmp" );
obj = dt << Fit Model(
    Y( :LogHist0, :LogHist1, :LogHist3, :LogHist5 ),
    Effects( :drug, :dep1, :drug * :dep1 ),
    Personality( "Manova" ),
    Run( Response Function( Sum ) )
);
obj << (Response[1] << (Effect[1] << Save Canonical Scores) );
```

Generalized Linear Models

The following message for a Fit GLM object is available only in JSL:

```
Parametric Formula()
// save the parametric formula to a new column in the current data table
```

Nominal and Ordinal Logistic

The following messages for Fit Nominal Logistic and Fit Ordinal Logistic objects are available
only in JSL:

```
- fit_model_object << Get SAS Data Step
  // create a SAS DATA step to score the data
- fit_model_object << Get MM SAS Data Step
  // create SAS code that you can register in the SAS Model Manager
```

Standard Least Squares

The following JSL messages return the requested item from the fitted model, such as variance
components, p-values, parameter estimates, and so on:

```
fit_model_object << Get Variance Components( );
fit_model_object << Get Effect Names( );
fit_model_object << Get Effect PValues( );
fit_model_object << Get Estimates( );
fit_model_object << Get Parameter Names( );
fit_model_object << Get Random Effect Names( );
fit_model_object << Get Std Errors( );
fit_model_object << Get X Matrix( );
fit_model_object << Get XPX Inverse( );
fit_model_object << Get Y Matrix( );
```
The following message for Standard Least Squares objects is available only in JSL:

```julia
obj << Get SQL prediction expression;
```

The following example saves prediction formulas as SQL expressions and outputs them to the log:

```julia
dt = Open( "$SAMPLE_DATA/Tiretread.jmp" );
obj = dt << Fit Model(
    Y( :ABRASION, :HARDNESS ),
    Effects( :SILICA, :SILANE, :SULFUR ),
    Personality( "Standard Least Squares" ),
    Run
);
code = obj << Get SQL Prediction Expression;
```

**Fit Parametric Survival**

The following JSL messages return the requested item from the fitted model, such as parameter names, parameter estimates, standard error, and so on:

```julia
survival_object << Get Parameter Names
survival_object << Get Estimates
survival_object << Get Std Errors
survival_object << Get Effect Names
survival_object << Get Effect PValues
```

**Life Distribution**

The following JSL messages prevent a specified plot from appearing in the report, or return the requested item from the fitted model, such as results, estimates, or formulas.

```julia
life_dist_object << Suppress Plot(plot_name)
life_dist_object << Get Results
life_dist_object << Get Estimates
life_dist_object << Get Formula
```

**Multivariate**

The following message for a Multivariate object is available only in JSL:

```julia
multivariate_object << Create SAS Job( );
// create SAS PROC Mixed code to run similar estimation methods using SAS
```
Neural

Note: The Neural platform replaces the Neural Net platform. Scripts that use Neural Net are deprecated and might not work in the future. It is recommended to use the Neural platform for new scripts and update any old scripts using Neural Net to Neural.

The following message for Neural objects is available only in JSL:

```
neural_object << Get NBoost
// return the number of models used for boosting
```

The following JSL messages for Neural Fit objects return the requested item from the fitted model, such as entropy RSquare, generalized RSquare, misclassification rates, and so on:

```
neural_object << ( Fit[n] << Get RSquare Training )
neural_object << ( Fit[n] << Get RSquare Validation )
neural_object << ( Fit[n] << Get RSquare Test )
neural_object << ( Fit[n] << Get Gen RSquare Training )
neural_object << ( Fit[n] << Get Gen RSquare Validation )
neural_object << ( Fit[n] << Get Gen RSquare Test )
neural_object << ( Fit[n] << Get Misclassification Rate Training )
neural_object << ( Fit[n] << Get Misclassification Rate Validation )
neural_object << ( Fit[n] << Get Misclassification Rate Test )
neural_object << ( Fit[n] << Get Average Log Error Training )
neural_object << ( Fit[n] << Get Average Log Error Validation )
neural_object << ( Fit[n] << Get Average Log Error Test )
neural_object << ( Fit[n] << Get RMS Error Training )
neural_object << ( Fit[n] << Get RMS Error Validation )
neural_object << ( Fit[n] << Get RMS Error Test )
neural_object << ( Fit[n] << Get Average Absolute Error Training )
neural_object << ( Fit[n] << Get Average Absolute Error Validation )
neural_object << ( Fit[n] << Get Average Absolute Error Test )
neural_object << ( Fit[n] << Get ROC Area Training )
neural_object << ( Fit[n] << Get ROC Area Validation )
neural_object << ( Fit[n] << Get ROC Area Test )
neural_object << ( Fit[n] << Get Confusion Matrix Training) 
neural_object << ( Fit[n] << Get Confusion Matrix Validation) 
neural_object << ( Fit[n] << Get Confusion Matrix Test) 
neural_object << ( Fit[n] << Get Confusion Rates Training) 
neural_object << ( Fit[n] << Get Confusion Rates Validation) 
neural_object << ( Fit[n] << Get Confusion Rates Test) 
neural_object << ( Fit[n] << Get Seconds)
```
Pareto Plot

The following message for a Pareto Plot object is available only in JSL:

```julia
No Plot( Boolean );
// close the outline for the Pareto plot
```

Partition

The following JSL messages for Partition objects return the requested item from the fitted model, such as entropy RSquare, generalized RSquare, misclassification rates:

```julia
partition_object << Get RSquare Training
partition_object << Get RSquare Validation
partition_object << Get RSquare Test
partition_object << Get Gen RSquare Training
partition_object << Get Gen RSquare Validation
partition_object << Get Gen RSquare Test
partition_object << Get Misclassification Rate Training
partition_object << Get Misclassification Rate Validation
partition_object << Get Misclassification Rate Test
partition_object << Get ROC Area Training
partition_object << Get ROC Area Validation
partition_object << Get ROC Area Test
partition_object << Get Average Log Error Training
partition_object << Get Average Log Error Validation
partition_object << Get Average Log Error Test
partition_object << Get RMS Error Training
partition_object << Get RMS Error Validation
partition_object << Get RMS Error Test
partition_object << Get Average Absolute Error Training
partition_object << Get Average Absolute Error Validation
partition_object << Get Average Absolute Error Test
partition_object << Get Seconds
partition_object << Get SAS Data Step
partition_object << Get Tolerant SAS Data Step
partition_object << Get MM SAS Data Step
partition_object << Get MM Tolerant SAS Data Step
```

Surface Plot

The following messages for a Surface Plot object can also be controlled in JMP, but might not have corresponding options in the red triangle menu:

```julia
– surface_plot_object << Mode( "Isosurface" | "Sheet" )
```
// Isosurface uses three independent variables as the X, Y, and Z axis and simultaneously plots the surfaces for the dependent variables on the plot. Sheet has one Z response that is dependent upon two independent X, Y variables.

- `surface_plot_object << Set Z Axis( col, Current Value( n ) )`
  // set the Z axis by referencing the column
- `surface_plot_object << Set Variable Axis( col, Current Value( n ) )`
  // set the independent variable axes by referencing each individual column
- `surface_plot_object << Response( ... )`
  // identify up to four response columns for plotting overlaid points
- `surface_plot_object << Formula( ... )`
  // assign formulas to columns in the sheets in a specified order

**Text Explorer**

The following JSL messages for a Text Explorer object are available only in JSL:

- `text_explorer_object << Minimum Frequency for Phrase( n )`
  // specifies minimum number of occurrences a phrase must have to be included in the phrase list
- `text_explorer_object << Save Indicators for Most Frequent Words( ... )`
  // alias for Save Document Term Matrix()
- `text_explorer_object << Save Word Table( ... )`
  // alias for Save Term Table()
- `text_explorer_object << Score Words by Column( ... )`
  // alias for Save Terms by Column()
- `text_explorer_object << Set Regex( ... )`
  // replaces default regular expressions used in Regex tokenizing
- `text_explorer_object << Save Regex Column( string )`
  // creates a new column with tokenized results
- `text_explorer_object << Add Delimiters( string )`
  // adds user-defined delimiter characters, specified in a single string
- `text_explorer_object << Set Delimiters( string )`
  // replaces default delimiter characters, specified in a single string
- `text_explorer_object << Add Stop Words( list )`
- `text_explorer_object << Add Phrases(list)`
- `text_explorer_object << Add Stem Exceptions(list)`
- `text_explorer_object << Add Stem Overrides(list)`
  // adds a list of words that are always allowed to be stemmed
- `text_explorer_object << Add Stop Word Exceptions(list)`
  // adds a list of words to remove from the list of stop words
- `text_explorer_object << Add Phrase Exceptions(list)`
  // adds a list of phrases to remove from the list of specified phrases
- `text_explorer_object << Add Recodes(list)`
  // adds a list of pairs of words to recode
- `text_explorer_object << Add Recode Exceptions(list)`
  // adds a list of recoded text strings to remove
- `text_explorer_object << Terms Alphabetical(Boolean)`
- `text_explorer_object << Phrases Alphabetical(Boolean)`
- `text_explorer_object << Cloud Width(pixels)`
  // sets the width of the word cloud in pixels

**Time Series**

The following arguments for the `Time Series()` function are available only in JSL:

- `Autocorrelation Lags(n)`
  // set the launch option for the maximum number of periods between points used in computing autocorrelations
- `Forecast Periods(n)`
  // set the launch option for the number of steps ahead in the forecasting report

The following JSL messages for a Time Series object are available only in JSL:

- `time_series_object << Maximum Iterations(n)`
  // reset the maximum number of iterations for future optimizations used in ARIMA model fitting
- `time_series_object << Get Models`
  // return a list of model results named by model description
- `time_series_object << Get Model Specs`
  // return a list of model results named by model specification
Variability

The following message for a Variability Chart object is available only in JSL:

```
variability_object << Show Box Plot Whisker Bars( Boolean );
```
After you learn the basics of scripting, you’re ready to learn how to manipulate JMP reports, create new JMP windows, and interact with windows. This chapter focuses on the following topics:

- navigating JMP displays to manipulate items in report windows
- accessing built-in windows
- creating display trees to build new windows with custom results
- understanding modal windows
- converting deprecated Dialog() scripts to New Window() scripts
Navigate JMP Reports

Reports in JMP are built in a hierarchical manner by nesting and concatenating different types of rectangular boxes called display boxes. This section introduces JMP reports and then discusses how to navigate reports, extract data from them, and customize them.

Table 11.1 shows three common display boxes in generated JMP reports.

**Table 11.1** Common Display Boxes in JMP Reports

- **Outline Boxes** create an outline hierarchy.

- **Picture Boxes** combine axes, frames, and labels to make graphs.

- **Table Boxes** are special H List Boxes whose elements are string and number columns.

The hierarchical (or parent-child) relationships between display boxes help determine the sizing. The outermost display box is the parent; the inner display boxes are children. When a report is displayed, the parent display box detects the size of the last child box (the leaf) and then detects the size of the next child from the bottom up. The size is detected for each box on the way back up the tree. Then the positioning of the boxes takes places from the top down so that the boxes can be shown in a tidy arrangement.
The hierarchical (or parent-child) relationships between display boxes form a tree of display boxes, called the display tree. For (parent) boxes that contain other (child) boxes, the parent box’s size is determined by the sizes of its child boxes rather than some fixed size, which keeps the whole display adaptive. Similarly, positions of boxes are determined by positions of the boxes before them rather than using fixed positions. In tree terminology, the sizing is bottom-up and the positioning is top-down.

**Compatibility Warning**

JMP platforms are generally stable from release to release. However, sometimes there are compelling reasons to change the structure of reports in major releases. When this happens, old scripts can fail due to the new structure. You need to update the old scripts. It is wise to be resourceful to code scripts in a way to minimize dependencies on the structure.

**Examples of Common Display Boxes**

Figure 11.1 shows a Bivariate report that consists of several common display boxes.
Run the following script to create the report:

```plaintext
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( Y( :weight ), X( :height ), Fit Line() );
```

**View the Display Tree**

The Show Tree Structure window enables you to examine the structure of a report’s display tree in an outline format. View the structure to see how display boxes are arranged in the display box tree.

To view the structure, follow these steps:

1. Run the following script:
Chapter 11
Display Trees

Scripting Guide Navigate JMP Reports

```javascript
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate(
    Y( :weight ),
    X( :height ),
    Fit Mean( {Line Color( {57, 177, 67} )} )
);

2. Right-click the top disclosure icon and select **Edit > Show Tree Structure**.

**Figure 11.2** Top Disclosure Icon

![Top Disclosure Icon](image)

The Show Tree Structure window appears, which shows the display box structure of the report as nested outline boxes. Each outline box corresponds to a display box in the original report.

3. Click the Bivariate graph. In Figure 11.3, the frame box that contains the graph is highlighted.
You can also obtain the tree structure through a script. Send the Show Tree Structure() message to any report. Or, send the message to a piece of the report (any display box object) to see the tree structure for just that part of the report.

The flat JMP tree structure provides a flat view of the display box tree rather than an outline view. To view the classic structure, hold down the Shift key before you right-click the disclosure icon and then select Edit > Show Tree Structure. Note the following differences between the newer and classic tree structure views:

- The classic tree structure is not linked to the original report; you cannot highlight specific portions of the tree.
- Siblings appear to the left or right of each other in the classic tree structure. In the newer tree structure, siblings are above or below each other.
Show Display Box Properties

You can edit the display box properties such as color and position in the Show Tree Structure window. This feature provides an easy way to format reports before you save them to a script. In the Show Tree Structure window, select Show Properties from the red triangle menu and click the node that you want to edit.

In Figure 11.5, the Summary of Fit statistics were selected below the graph. The Background Color and Text Color were then changed in the Properties. These changes are preserved when you save the report as a script or journal the report.
Display Box Object References

When you launch a platform, the results are in two places: a visible report, made of display boxes, and an invisible object, called a platform, that accepts commands (or messages).

One of the messages that you can send a platform is the `Report` message. The `Report` message retrieves the display box that holds the report.

The red triangle menu at the top of the report is connected to the platform object and is the way you interactively send messages to the platform.

To fit the mean in the Bivariate platform, assign a reference to the Bivariate platform.

```
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( // biv references the analysis layer
    X( height ),
    Y( weight ),
    Fit Mean,
    Fit Polynomial( 4 )
);
```

To get a reference to the display box that represents the view of the platform, use the `Report` message. For example, add this expression to the preceding script:

```
rbiv = biv << Report; // rbiv references the report layer
```
Now you can manipulate the display boxes in the report layer as described in the following sections.

**Learning What You Can Do with a Display Box**

The following example creates a Bivariate report and stores its reference in the `rbiv` report object. It then puts the `rbiv` report object in a frame box and assigns the `fbx` variable.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( // biv references the analysis layer
    Y( :weight ),
    X( :height ),
    Fit Mean( {Line Color( {57, 177, 67} )} )
);
rbiv = biv << Report; // assign rbiv to the report layer
fbx = rbiv[Frame Box( 1 )];
```

After `fbx` has been defined, you can send it a message.

```julia
fbx << Set Background Color( blue ); // colors the frame box in blue
```

The `Set Background Color` message works the same as right-clicking in the graph and selecting `Background Color > Blue`.

To find out which messages you can send to a frame box, select **Help > Scripting Index** and search the Display Box list for “frame box” (Figure 11.6).

**Figure 11.6 Scripting Index Display Box List**

Running the `Show Properties()` function is an alternative to using the Scripting Index. The messages for the specified display box are printed to the log.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( Y( :weight ), X( :height ) );
Show Properties( biv );
   Show Points [Boolean] [Default On]
   Histogram Borders [Boolean]
   Fit Mean [Action](Fits a flat line at the mean.)
```

...
Many messages are the same as items in the context menu for a given object. The next section, “Construct Custom Windows” on page 438, discusses messages for common display boxes in more detail.

Create a Reference By Subscripting

Use the subscript operator to navigate to a specific display box in the report. The best practice is to refer to the display box with an index number. The following expression identifies the second outline box in the display tree:

\[
\text{var} = \text{Outline Box}[2];
\]

Another way to navigate a report is to search for a text string. The following expression identifies the report that has the specified text string:

\[
\text{var} = \text{report}[\text{text}];
\]

This expression finds the display box in \textit{rpt} that has the title \textit{text}. Note that \textit{text} must be the complete title, not just a substring of the title. The "\textit{text}" argument can also be any expression that evaluates to a text string. This approach is less reliable than referring to the display box with a subscript because the string in a report can easily change.

Typically, you want to assign the identified part of the report to a variable so that you can send messages to it easily. For example, to find the Analysis of Variance outline box in the Bivariate report, use this expression:

\[
\text{var} = \text{rbiv}["Analysis of Variance"];\]

The sections below describe other methods for using a subscript operator to locate display boxes.

Wildcard String

You can use a wildcard character (such as “?”) with a substring to match the rest of the outline title. The wildcard character “?” represents places in the search string where you want to match any sequence of any characters. The following script searches for a string that ends with “Mean”, finds “Fit Mean”, and then opens the Fit Mean outline:

\[
\text{dt} = \text{Open( "SAMPLE\_DATA/Big Class.jmp" );}
\text{biv} = \text{dt} << \text{Bivariate(}
\begin{align*}
&\text{Y( :weight ),} \\
&\text{X( :height ),} \\
&\text{Fit Mean( \{Line Color( \{57, 177, 67\} )\} ),} \\
&\text{Fit Polynomial( 4 )}
\end{align*}
\);
\text{rbiv} = \text{biv} << \text{Report; // return a reference to the Bivariate report}
\text{out1} = \text{rbiv}["? Mean"]; // find "Fit Mean" in the Bivariate report
\text{out1} << \text{Close( 0 ); // open the Fit Mean outline}
\]
Box Type and Wildcard String

Another method for locating display boxes is to include the display box and wildcard search string in the substring operator.

\[
\text{var} = \text{rbiv[Display Box( "?text" )]};
\]

This expression finds the outline box that contains the specified text string in the \text{rbiv} report. The \text{out1} variable assigns a reference to the outline box.

\[
\text{out1} = \text{rbiv[Outline Box( "? Mean" )]};
\]

Box Type and Index Number

Another method for locating display boxes uses the \text{boxType} and an index number, \(n\).

\[
\text{rpt[Display Box( n )]};
\]

The expression above finds the \(n\)th of the specified display box of the type \text{boxType}. For example, this expression finds the first outline box in the \text{rbiv} report and assigns it to the \text{out1} variable:

\[
\text{out1} = \text{rbiv[Picture Box( 1 )]};
\]

Tip: To determine the index number of a display box, view the tree structure as described in “Nesting and Precedence” on page 431.

Nested Display Boxes

To reference a display box that appears several layers down in a report, use this format:

\[
\text{var} = \text{rpt[arg1][arg2][arg3][\ldots]};
\]

The expression above matches the last argument to a display box that is \text{contained by} the next to last argument’s outline node, which is in turn contained by the argument before the next to last, and so on. In other words, it is a way of digging down into the hierarchy of an outline tree to identify a nested display box.

If you want to identify an item nested several layers down in an outline box, use a subscript with more than one argument of any of the above types. After locating the first item, JMP looks \text{inside} that item for the next, and so on.

\[
\text{rpt[arg1][arg2][arg3]} \quad // \text{finds the first item then the next starting after that location, and so on}
\]

\[
\text{rpt[arg1, arg2, arg3]} \quad // \text{different syntax, same result}
\]

Note that you can string together subscripts that have text or index numbers. The expression below finds the “Parameter Estimate” inside the outline node “Polynomial Fit Degree=4” and selects the third display box in the first table of the outline node.

\[
\text{out} = \text{rbiv["Polynomial Fit Degree=4"]}["Parameter Estimates"][1][3] \quad << \text{Select};
\]
“Example of Creating a Report” on page 436 shows how to extract parameter estimates from the report.

Send Messages to Display Boxes

The display reference can be used to send messages to the display elements using the Send or << operator. For example, if out2 is a reference to an outline node, you can ask the node to close itself if it is open:

```plaintext
out2 << Close(); // close the outline node
```

Close() toggles an outline node back and forth between closed and open states, just like selecting items in the red triangle menu. You can include a Boolean argument (1 or 0) for “close or leave closed” or “open or leave open.”

```plaintext
rbiv["Fit Mean"] << Close; // toggle open and closed
rbiv["Fit Mean"] << Close( 1 ); // close or leave closed
rbiv["Fit Mean"] << Close( 0 ); // open or leave open
```

Tip: The Report Invalid Display Box Messages option in the General preferences helps you identify invalid display box messages.

- The preference is off by default. When a display box receives an invalid message, JMP ignores those errors and continues executing the script.
- When this preference is on, an error appears in the log.

This option can be useful during script development but can cause unwanted log messages for existing scripts.

The << Operator

You can send messages to display boxes using the send (<<) operator. The operator makes it clear when the script is evaluating child arguments and optional arguments. It also helps make it clearer which argument is an option and which is a script to run inside the graph.

Here is an example of sending a Graph Box a message:

```plaintext
win = New Window( "Messages",
    gb = Graph Box(
        Frame Size( 400, 400 ),
        X Scale( 0, 25 ),
        Y Scale( 0, 25 )
    )
);
    gb << Background Color( "red" );
```
Nesting and Precedence

When you stack (or nest) messages, each message is evaluated left to right.

- The following expression sends `message1` to `box`, then `message2` to `box`, then `message3` to `box`. Note that any of the messages can change `box` before the next message is sent.
  ```julia
  box << message1 << message2 << message3;
  ```
- The following expression sends `message1` to `box` and gets the result. `Message2` is sent to that result, and `message3` is sent to the result of `message2`.
  ```julia
  ( (box << message1) << message2) << message3
  ```
- The result of `message3` is assigned to the variable `x`.
  ```julia
  x = box << message1 << message2 << message3;
  ```

Here is an example of using nested messages:

```julia
win = New Window( "Messages", gb = Graph Box() );
sz = gb << Background Color( "red" )
// message 1 sets the background color
<<Save Picture( "$DOCUMENTS/red.png", "png" )
// message 2 saves the graph box as a PNG file
<<Background Color( "white" )
// message 3 sets the graph box background color to white
<<Get Size();
// message 4 returns the graph box size and prints it to the log
```

If you nest several messages, you might want to use parentheses to group the messages to be sure your script does what you want it to.

Customize Reports with the Send to Report and Dispatch Functions

The `Send To Report()` and `Dispatch()` functions provide a way for JMP to record display box modifications inside an analysis script in a self-contained way. For example, arguments within the two functions open and close outline nodes, resize graphics frames, or customize the colors in a graphics frame. You can also specify the arguments in separate JSL statements.

- `Send To Report()` contains a list of options that change the display tree.
- `Dispatch()` contains four arguments that change the display tree:
  - The first argument is a list of outline nodes that need to be traversed to find the desired part of the display tree.
• The second and third arguments work together. The second argument is the name of a
display element, and the third argument is the display element’s type. These two
arguments specify which particular part of the display tree is to be customized.

• The fourth argument is a list of options.

For example, open Big Class.jmp and run the attached Bivariate script. This generates a report
with a fitted line. Open the Lack of Fit outline node, and close the Analysis of Variance outline
node. Select **Save Script > To Script Window**. The following script appears in the script editor
window:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate(
    Y( :weight ),
    X( :height ),
    Fit Line(),
    SendToReport(
        Dispatch(
            {"Linear Fit"},
            "Lack Of Fit",
            OutlineBox,
            {Close( 0 )} ),
            Dispatch(
                {"Linear Fit"},
                "Analysis of Variance",
                OutlineBox,
                {Close( 1 )}
            )
        )
    );
```

The **Send To Report()** function contains two **Dispatch()** functions that customize the default
report.

• The first argument finds an outline node named “Linear Fit”.
• The second and third arguments finds an outline box named “Lack of Fit” below the
  “Linear Fit” outline.
• The fourth argument is the argument to send to this outline box. In this case, the message
  is **Close(0)**, in other words, open the node.

**Note:** If there are several outline nodes with identical names, subscripts are assigned to them.
For example, if you have a Bivariate analysis with two quadratic fits (resulting in identical
titles), when you dispatch a command to the second fit, the subscript [2] is added to the
duplicated title.
The best way to deal with `Send to Report()` and `Dispatch()` is to first create a customized report interactively. Save the report as a script and then examine the script that JMP generates. Remember: the best JSL writer is JMP itself.

**Create a Journal**

Creating a journal enables you to capture the contents of a JMP window at a fixed moment in time. Suppose that a JMP window contains a graph and selected check boxes. The journal shows the graph and the check boxes that were selected when you created the journal.

The following examples show what you can do with a journal.

Suppose that you start with a Bivariate report.

```julia
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( Y( weight ), X( height ) );
rbiv = biv << Report;
```

Journal the results:

```julia
rbiv << Journal Window;
```

Save the journal to a file:

```julia
rbiv << Save Journal( "DOCUMENTS/test.jrn" );
```

Note that the above example uses Macintosh pathname conventions. On Windows, you can use forward slashes (which are appropriate for all platforms) or backslashes (which are appropriate only for Windows).

When using a By variable in a script, the result is a list of references to the analysis results for each By group. In order to journal all By member parts of the report, you need to use parent messages to get to the top of the report.

For example, the following script creates a Bivariate report with a By group and then journals the entire report:

```julia
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate(
    Y( weight ),
    X( height ),
    By( sex )
);
( ( Report( biv[1] ) << Parent ) << Parent ) << Save Journal( "test.jrn" );
```
Using Common Messages

The following sections describe how to use common messages to update a numeric column, update a string column, wrap text, create bullet points, and blink a display box.

Update a Numeric Column

To update a numeric column in a display box table, use the Set Values message.

```julia
win = New Window( "Numeric Column",
    num = Number Col Box( "Values", [9, 10, 11] )
);    num << Set Values( [1, 2, 3] );
```

The matrix argument specifies the new numbers for the table.

Update a String Column

To update a string column in a display box table, use the Set Values message.

```julia
win = New Window( "String Column",
    str = String Col Box( "Values", {"a", "b", "c"} )
);    str << Set Values( {"A", "B", "C"} );
```

The list argument specifies the new strings for the table.

Wrap Text

Generally, JMP automatically wraps text within Text Box(). However, the default wrap point can be overridden with a Set Wrap (n) message. The following script wraps the text at 200 pixels.

```julia
win = New Window( "Set Wrap",
    tb = Text Box( "Place your cursor over a data point for more information." )
);    tb << Set Wrap( 200 );
```

Include Bullet Points in Text Boxes

You can add bullet points using the Bullet Point( 1 ) message.

```julia
win = New Window( "Bullet List",
    text1 = Text Box( "Place your cursor over a data point for more information." ),
    text2 = Text Box( "Circle your cursor over a statistic for more information." )
);
text1 << Bullet Point( 1 );
text2 << Bullet Point( 1 );

Sending the Bullet Point( 1 ) message to a text box places a bullet in front of the text and indents subsequent lines within that text box.

You can also send the Bullet Point( 1 ) message inline as shown in the following example:

text1 = Text Box( "Place your cursor over a data point for more information." ), << Bullet Point( 1 ),

Blink a Selected Display Box

You can use Select, Reshow, and Deselect to blink the selection highlight on a display box. As previously described, you can string together several << clauses to send an object several messages in a row. The results read left to right; for example, here Select is done first, then Reshow, then Deselect, then the other Reshow.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( 
  Y( :weight ),
  X( :height ),
  Fit Mean( )
);
rbiv = biv << Report;
// assign the bivariate analysis layer to rbiv

out2 = rbiv[Outline Box( "? Mean" )];
out2 << Close( 0 ); // open the outline box
// find outline box with the specified string in the
// rbiv report and assigns it to the out2 variable

scbx = rbiv[String Col Box( 1 )];
// find the first string col box in rbiv and
// assign the scbx variable

Wait( .25 ); // wait .25 seconds
For( i = 0, i < 20, i++,
  // set i to 0, iterate through the loop 20 times
  scbx << Select << Reshow << Deselect << Reshow
  // select the string col box and reshow it,
  // deselect it and reshow it
);
Example of Creating a Report

Here is a script to build a report from start to finish. First, open a data table.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
```

Now launch a Bivariate platform and assign it to the platform reference `biv`.

```julia
biv = dt << Bivariate( Y( weight ), X( height ) ); // a reference to the platform
```

To find out what you can do with the Bivariate platform, search for Bivariate in the Objects list of the Help > Scripting Index. Here are a few options:

```julia
biv << Fit Spline( 1000000 ) << Fit Mean;
biv << Fit Polynomial( 4, RGBColor( 1, 0.5, 0 ) ); // degree 4, orange curve
biv << ( Curve[1] << Line Color( red ) ); // first curve is red
```

Assign `rbiv` to the report layer:

```julia
rbiv = biv << Report;
```

Next, get the frame box to a comfortable size and scroll up to the top to see the graph.

```julia
rbiv[Frame Box( 1 )] << Size Window( 500, 700 );
biv << Scroll Window( {0, 0} );
```

Now get to work on the report. First, you need to create a reference, and then see what you can do with it.

```julia
rbiv = biv << Report; // a reference to the report
Show Properties( rbiv ); // show the properties of the report
```

The log lists the messages to use with reports. Using `Show Properties()` is an alternative to the Scripting Index.

```julia
Close [Boolean]
GetOpen [Action] [Scripting Only]
SetOpen [Boolean] [Scripting Only]
```

Open the Fit Mean node of the outline:

```julia
rbiv["Fit Mean"] << Close( 0 );
```

`Close()` is a Boolean function (true or false), and passing 0 indicates that the outline is not closed.

Practice selecting some results (submit each line alone to see its result):

```julia
rbiv["Summary of Fit"] << Select;
rbiv["Parameter Estimates"] << Select;
rbiv["Analysis of Variance"] << Select;
rbiv["Polynomial Fit Degree=2", "Parameter ?", Column Box( "Estimate" )] << Select; // dig down in the outline tree
To get the second Analysis of Variance item, you would do this:

```plaintext
rbiv["Polynomial Fit Degree=2", "Analysis of Variance"] << Select;
```

Now change the format of the Estimate column in the 4-degree polynomial Parameter Estimates report.

```plaintext
pe = rbiv["Polynomial Fit Degree=4", "Parameter ?"];
estts = pe[Number Col Box( "Estimate" )];
estts << Set Format( 12, 6 );
```

The first argument to `Set Format` sets the column width by the number of characters to display. The second argument sets how many decimal places are shown in the table.

**Figure 11.7 Applying Changes to a Report**

![Parameter Estimates Table](attachment:image.png)

You can even get a single number out of the table. For example, the estimate for the cubic term:

```plaintext
terms = pe[String Col Box( "Term" )]; // find the Term column
estimate = .; // in case there is no cubic term
Try(
    For( i = 1, i < 10, i++,
        If( Contains( terms << Get( i ), "^3" ),
            // get(i) goes off the end of the table handled by Try
            estimate = estts << Get( i );
            Break();
        )
    )
);Show( estimate );
0.070394822744608
```

You use a `For()` loop to count down to the row for the term that you want. The second argument to `For()` is a condition; as long as the condition tests true, looping continues. Here the test is “when the string in the Terms column is not "^3" and we have not reached the tenth
row.” As soon as the string does match, looping stops and i’s value is the number for the matching row. You then use i as a subscript to the Get message on the Estimates column.

You can also get values from boxes as a matrix, which you can then use for further computations or write to a data table. The following example also shows how to make a data table:

```julia
myVector = rbiv[Table Box( 4 )][Number Col Box( "Sum of Squares" )] << Get as Matrix;
// get the values in the Sum of Squares column as a matrix

dt << New Column( "Sum of Squares", Values( myVector ) );
// create a new column in Big Class.jmp named "Sum of Squares"
// insert the values of myVector in the column

rbiv[Table Box( 4 )] << Make Data Table( "ANOVA table" );
// put the values of the fourth table box into a new data table
```

Now adjust the scales on the axes.

```julia
rbiv[Axis Box( 1 )] << Min( 70 ) << Max( 170 ); // set the Y axis
rbiv[Axis Box( 2 )] << Min( 50 ) << Max( 70 );  // set X axis
```

Copy the graph at the top of the report. Note that you need to select the picture box that contains the graph; selecting just the graph would leave its axes behind.

```julia
rbiv[Picture Box( 1 )] << Copy Picture;
```

---

### Construct Custom Windows

You can use constructor functions to create objects and construct your own displays. For example, you might prompt the user for information, create custom reports, create custom launch windows, or add check box and radio button items to a window.

Start with a `New Window()`, including a title in quotes, and then construct display boxes inside the window. Make a reference to the new window by assigning it a variable so that you can send messages to it. When display objects are created or referred to by JSL, they are freely shared references until they are copied into another display box or until you close the window and they disappear. When you plug a display object into another display tree, JMP makes a copy of it that the new box owns.

All the display box constructors end in “Box”. There are similar objects that live inside graphics frames called display segs (segments such as markers and lines). Display seg objects all end in “Seg”.

---

Display Trees
Construct Custom Windows
Example of Creating a Graph Box

The following example creates a new window that contains a graph box:

```plaintext
win = New Window( "Simple Earth Map",
    gb = Graph Box(
        X Scale( -180, -60 ),
        Y Scale( 20, 80 ), // end of graph box parameters
        <<Background Map( Images( "Simple Earth" ) ) // beginning of script
        )
    );
```

The parameters set the x-axis and y-axis scale and the frame size. The `Background Map` message then shows the map. Note that the parameters for `Graph Box()`, `X Scale` and `Y Scale`, come first. After the first comma, the script begins. If you put the script in the middle of the parameters in a `New Window()` function, the script might run but not produce the results you expect. Scripts are also easier for the users to read if the parameters are at the top of the new window.

Extract Values from a Window

After the user selects options in a window, you can extract those selections from the window using the `Return Result` message, `Get` message, or `Get Selected` message.

Extract Values: Method One

To have a `New Window()` script automatically return the results after the user clicks OK, include the `Return Result` message after the `Modal` message.

```plaintext
win = New Window( "Set a Value",
    <<Modal,
    <<Return Result,
    Text Box( "Set this value" ),
    variablebox = Number Edit Box( 42 ),
    Button Box( "OK" ),
    Button Box( "Cancel" )
    );

Write( win["variablebox"] ); // create a subscript to the variablebox variable
33 // the user typed "33" in the number edit box
```

Extract Values: Method Two

Include the `Get` message to return 1 for a selected checkbox and 0 for a deselected checkbox. To view the selection, add a `Show()` expression at the end of the script.

```plaintext
win = New Window( "V List Box",
    <<Modal,
    ```
V List Box(
    kb1 = Check Box( "a" ),
    kb2 = Check Box( "b" ),
    kb3 = Check Box( "c" )
),
Button Box( "OK",
    val1 = kb1 << Get; // get the value of the first check box
    val2 = kb2 << Get;
    val3 = kb3 << Get;
)
); Show( val1, val2, val3 ); // return variables after window closes
val1 = 1; // first and second checkboxes are selected
val2 = 1;
val3 = 0; // third checkbox is not selected

Extract Values: Method Three

Include the Get Selected message to return the selected column names and then insert the columns in a Bivariate plot.

Note: Method two and method three of extracting values are alternate examples of the same method. The method, in both examples, uses a JSL callback from one of the controls in the dialog. The JSL callback captures a value from a display box in the dialog into a global variable that will be available after the dialog closes. In method two, the JSL callback is on a button box. In method three, the JSL callback is on a list box.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
xvar = .;
yvar = .;
win = New Window( "Return Values",
    <<Modal,
    <<On Validate(
        // require the user to select two variables before clicking OK
        Show( xvar, yvar );
        If( Is Missing( xvar ) | Is Missing( yvar ),
            0, // if xvar or yvar are missing, do nothing when OK is clicked
            1
        );
    ),
    Text Box( " Select two numeric columns. " ),
    H List Box(
        Text Box( " X, Factor " ),
        x = Col List Box( dt, // data table reference
            all, // display all columns from the data table
xvar = (x << Get Selected)[1];
// get the name of the selected column before the window closes
Show( xvar );
},
Text Box( "Y, Response" ),
y = Col List Box(
dt,
all,
yvar = (y << Get Selected)[1];
Show( yvar );
)
);
xcol = Column( dt, xvar ); // get the columns
ycol = Column( dt, yvar );

dt << Bivariate( Y( ycol ), X( xcol ) ); // create a Bivariate plot

Constructors for New Windows

JSL supports both modal and non-modal windows.

- Modal windows must be closed before other windows can be used: clicking outside the modal window produces an error sound, and almost all script execution stops until the user closes the modal window.
- JMP reports and platform launch windows are examples of non-modal windows. Many non-modal windows can be open at once and you can switch between them freely. The Transparency dialog in a graph is an example of a modal window. After the Transparency dialog is opened, you must close it before continuing.

This section describes common display boxes that you can construct in a window. There are many other display boxes (such as axis boxes) in JMP that cannot be constructed. Display boxes that cannot be constructed are used by platforms in JMP. Even though they can’t be constructed in JSL, they still have functions and messages that can be used from JSL.

Tip: In the Scripting Index (Help > Scripting Index), display boxes that cannot be constructed are marked by 🟥. Display boxes that you can construct are marked by 🟢.

Notes:

- The Dialog() function, which creates modal windows, is deprecated and will not work at all in future versions of JMP. Use either New Window() with the Modal message or Column Dialog() for column selection. See “Construct a Column Dialog” on page 504 and “Convert Deprecated Dialog to New Window” on page 511 for more information.
• In JMP, the following display boxes support only one direct child box: Border Box(), Center Box(), If Box(), Mouse Box(), Scroll Box(), and Sheet Panel Box(). To make a border box that appears to have multiple children, use a V List Box() or H List Box() as the only child and put multiple children in the V List Box() or H List Box().

**Container Display Boxes**

Container display boxes enclose child display boxes.

**Border Box**

Border Box() adds space around the displaybox argument.

```
Border Box (Left( pix ), Right( pix ), Top( pix ), Bottom( pix ),
            Sides( int ), display box args);
```

Left, Right, Top, and Bottom add space around the displaybox argument. Sides draws a border around the box, as described in Table 11.2. Additional effects can also be applied to the borders using Sides, as described in Table 11.2. To add both an effect and a border, add the two numbers.

For example, the following example produces a text box with a border at the top and bottom (Draw Border value of 5) colored blue, the default color (Effect value of 16):

```
win = New Window( "Borders",
    bb = Border Box( Sides( 5 ), // top and bottom border
                    Text Box( "Hello World!" )
            );
    bb << Set Color( "red" ); // set the border color to red
```

The `bb` variable is assigned to the border box so that the color can be set on the last line.

**Note:** Border boxes support only one display box argument. To make a border box that appears to have multiple children, use a V List Box() or H List Box() as the only child and put multiple children in the V List Box() or H List Box().

In the `Sides()` function, add the following values to get the borders that you want. For example, “5” draws a top and a bottom border.

1: top
2: left
4: bottom
8: right

Border Box() provides the additional effects described in Table 11.2.
Col List Box() returns a display box that shows a list of current data table columns.

\[
\text{Col List Box( <Data Table( <name> ), <all>|<character>|<numeric>,}
\]
\[
<Width( n )>, <Max Selected( n )>, <NLines( n )>, <Max Items( n )>, <Min Items( n )>, <On Change( expression )>, <script> );
\]

All specifies that all columns in the current data table should be included, or you can include only character or numeric columns. Width is measured in pixels. Max Selected is the maximum number of items that might be selected in the list box. NLines is the number of lines displayed in the box. Max Items is the maximum number of items displayed in col list box. Min Items is the minimum number of items displayed in the col list box. On Change is the script that runs when the selection changes.

You can send a Get Items message to a col list box to retrieve a list of all columns selected. Here is an example script showing Get Items in use. See the Scripting Index in the Help menu for other messages and examples.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
win = New Window( "Get Items Demonstration",
H List Box(
    chooseme =
    Col List Box( "All", width( 100 ), NLines( 6 ) ),
    // Col List Box shows all columns, 100 pixels wide with 6 lines
    Line Up Box( N Col( 1 ), Spacing( 2 ),
    // line up box arranges button boxes in 1 column
    // with 2 pixels of space around the boxes
    Button Box( "Add Column >>",
    listcols << Append( chooseme << Get Selected );
```
// append the selected column to previously selected columns
Chosen Columns = listcols << Get Items;
// get a list of selected columns from the col list box

Button Box( "<< Remove Column",
    listcols << Remove Selected; // remove the selected column
    Chosen Columns = listcols << Get Items; // get the selected column
),

listcols = Col List Box( width( 100 ), NLines( 6 ) ),
// create another col list box with no columns inside

Text Box( " " ),

stuff = Global Box( Chosen Columns )
// at the bottom of the h list box,
// show which columns Get Items returned

);

The All argument for Col List Box() includes all data table columns in the display box. Because all columns are required, you cannot remove selected rows using Remove Selected or Remove All. Instead, create an empty column list box and append all columns. Then the columns that you select can be removed.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
colNames = dt << Get Column Names; // get a list of column names

New Window( "Example",
    myBox = Col List Box( width( 200 ), nlines( 10 ) ) );
    myBox << Append( colNames );
    // create Col List Box with all the column names from the data table

    myBox << Set Selected( 3 ); // select one or all of the entries in myBox
    myBox << Remove Selected(); // remove selected entries in myBox

Col Span Box

Col Span Box() creates spanned columns headers inside a table box. The top column header spans two child column headers.

    Col Span Box( "title", display box args);

In the following script, the Confidence Limits header spans the Upper limits and Lower limits columns below it.

    win = New Window( "Col Span Box",
                      <<Modal,
                      Col Span Box( "Confidence Limits", "Upper limits  Lower limits" ));
Table Box(
  Col Span Box(
    "Confidence Limits",
    neb = Number Col Edit Box( "Upper limits", [0, 0] ),
    Number Col Edit Box( "Lower limits", [0, 0] )
  )
);

**H List Box and V List Box**

H List Box() aligns boxes horizontally.

H List Box( <Align( center|bottom )>, display box args, ...);

Align specifies center or bottom alignment of the contents in the display box. The contents are top aligned by default.

The following script aligns the check boxes horizontally:

```plaintext
win = New Window( "H List Box",
  <<Modal,
  H List Box(
    kb1 = Check Box( "a" ),
    kb2 = Check Box( "b" ),
    kb3 = Check Box( "c" )
  ),
);
```

V List Box() aligns boxes vertically.

V List Box( <Align( center|right )>, display box args, ...);

Align specifies right or center alignment of the contents in the display box. The contents are center aligned by default.

```plaintext
win = New Window( "V List Box",
  Text Box( "Select your favorite fruit." ),
  V List Box(
    Check Box( "apple" ),
    Check Box( "banana" ),
    Check Box( "orange" )
  ),
);
```

The default maximum width is 180 pixels. Set the width to 0 to size the box to its contents.

```plaintext
listA = {"a", "b", "c",
  "This is a very, very long name like Mary Ann Johnston."};
New Window( "Example",
  V List Box( listBoxA = List Box( listA, width( 0 ) ) )
);
If Box

If Box() creates a display box whose contents are conditionally displayed.

    If Box( 0|1, display box args );

The Boolean argument 1 displays the display boxes inside the if box. 0 does not display them.

The following script creates a splitter box with three scroll boxes. The second scroll box is enclosed in If Box(). Because If Box() is set to 1, the second scroll box appears in the window.

    win = New Window( "If Box",
        H Splitter Box(
            Size( 500, 250 ),
            Scroll Box(),
            If Box( 1, Scroll Box() ), // if box sets the scroll box to show
            Scroll Box()
        )
    );

When you set an if box to be hidden, then anything within that if box disappears from the report window. In the tree structure view, the hidden display box is no longer numbered.

Hide the if box in this example, and the second scroll box is no longer numbered in the tree structure view. Scroll Box(3) becomes Scroll Box(2). Change the argument for If Box in this script from 1 to 0 and then send the win Show Tree Structure() message to see the structure view.

**Note:** If boxes support only one display box argument.

H Splitter Box and V Splitter Box

H Splitter Box() and V Splitter Box() create a display box that arranges the display boxes provided by the arguments in a horizontal or vertical layout (or panel). The splitter enables the user to interactively resize the panel.

    H Splitter Box( <Size( h,v )>, display box args, <arguments> );
    V Splitter Box( <Size( h,v )>, display box args, <arguments> );

Size( h, v ) specifies the size of the splitter box in pixels. Inner display boxes are proportionately sized according to the width and height of the splitter box. For a list of arguments, see the Scripting Index in the JMP Help menu.

The following example puts a Bivariate and Oneway graph inside a V List Box(), which is inside the H Splitter Box(). Splitter boxes are especially useful when the content is set to auto-stretching as shown in the example.

    dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
    win = New Window( "H Splitter Box",
        H Splitter Box(<Size(500, 250)),
            Bivariate( Y( :Weight ), X( :Height ) ),
            Oneway( Y( :Weight ), X( :Height ) )
        );
H Splitter Box( // put the V List Box in an H Splitter Box
    Size( 600, 900 ),
    V List Box( // put a Bivariate and Oneway graph in a V List Box
        biv = dt << Bivariate(
            Y( :weight ),
            X( :height ),
            Fit Line(), Line Style( Dotted )
        ),
        one = Oneway(
            Y( :height ),
            X( :sex ),
            Name( "Means/Anova" )( 1 ),
            Mean Diamonds( 1 )
        )
    ),
)
(biv << Report)[FrameBox( 1 )] << Set Auto Stretching( 1, 1 );
(one << Report)[FrameBox( 1 )] << Set Auto Stretching( 1, 1 );
// make a reference to the report layers
// set the x and y axes on the frame boxes to auto stretch
// when the user drags the splitter

Line Up Box

Line Up Box() shows the display box arguments in n columns. You can specify optional spacing, in pixels, for the space between columns.

Line Up Box( NCol( n ), <Spacing( pixels )>, display box args, ... );

Spacing specifies the number of pixels around the box.

In the following example, the Distribution reports are lined up in six columns:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
win = New Window( "Line Up Box",
    Line Up Box( NCol( 6 ), // line up the Distributions in 6 columns
        dist = Distribution(
            Continuous Distribution( Column( :height ) ),
            By( :age )
        )
    );
Outline Box

Outline Box() creates a display box to hold other display boxes and show them in an outline view.

Outline Box("title", display box args, ... );

In the following example, each outline contains a Distribution:

dt = Open( "SAMPLE_DATA/Big Class.jmp" );
win = New Window( "Outline Box",
    obj1 = Outline Box( "Age and Weight",
        Distribution( Column( :age, :weight ) ),
    ),
    obj2 = Outline Box( "Weight and Height",
        Distribution( Column( :weight, :height ) )
    )
);

To close an outline by default, send the Close( 1 ) message to the outline object.

obj2 << Close( 1 );

The first argument for an outline box is the title. You can specify the title in the script, or the title can be based on another component, such as the value of a slider box. In the following example, as the user adjusts the slider, the title of the outline box is updated:

sliderValue = .6;
win = New Window( "Outline Box",
    Panel Box( "Slider Box",
        tb = Outline Box( "Value: " || Char( sliderValue ) ),
        sb = Slider Box(
            0,
            1,
            sliderValue,
        tb << Set Title( "Value: " || Char( sliderValue ) )
    )
);

To make your own red triangle menu within an outline box, send the Set Menu Script message to the outline box reference. The following example also uses the Set Submenu message to create nested menu items.

win = New Window( "Red Triangle Menu Items",
    ob = Outline Box( "Outline Box" )
);
    ob << Set Menu Script(
        "B4", Print( "B4" ), "B5", Print( "B5" ), "B6", Print( "B6" )},
    )
);
Scripting Guide

Construct Custom Windows

Chapter 11

Display Trees

Print( "B3" ), "C", Print( "C" )

ob << Set Submenu( 1, 2 ); // menu A with 2 items in submenu A1 and A2
ob << Set Submenu( 4, 3 ); // menu B with 3 items in submenu B1, B2, and B3

Panel Box

Panel Box() encloses the displaybox argument in a labeled border.

Panel Box("title", display box args );

In the following example, the panel box appears around the edge of the Distribution launch window:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
win = New Window( "Panel Box",
    H List Box( Panel Box( "My Distribution", Distribution() ) )
);

Display Element Boxes

Graph Box

Graph Box() constructs a display box that contains a frame box and axes.

Graph Box( "title", <X Scale( low, high ), <Y Scale( low, high )>, <Frame Size( h, v )>, <XName( "name" )>, <YName( "name" )>, <SuppressAxes>, script );

X Scale() and Y Scale() specify the lower and upper limits of the x and y axes. Frame Size() specifies the size of the frame around the graph. XName and YName specify the name of the x and y axes.

The following example creates a simple graph:

win = New Window( "Graph Box",
    Graph Box(  
        Frame Size( 300, 300 ),
        Marker( Marker State( 3 ), [11 44 77], [75 25 50] );
        Pen Color( "Blue" );
        Line( [10 30 70], [88 22 44] );
    )
);

To remove tick marks, add two arguments to the axes.

win = New Window( "Graph Box",
    Graph Box(  
        Frame Size( 300, 300 ),
        xaxis( // remove tick marks from the x axis
            Show Major Ticks( false )
        )
    )
);
Show Minor Ticks( false ),
Show Labels( false )
),
yaxis( // remove tick marks from the y axis
Show Major Ticks( false ),
Show Minor Ticks( false ),
Show Labels( false )
),
Marker( Marker State( 3 ), [11 44 77], [75 25 50] );
Pen Color( "Blue" );
Line( [10 30 70], [88 22 44] );
);

JMP provides a robust set of features to make your graphs interactive (such as dragging objects or capturing mouse clicks). The “Scripting Graphs” chapter on page 523 describes graph box options in detail.

**H Sheet Box and V Sheet Box**

Sheet Box() lets you create a grid of plots. H Sheet Box() and V Sheet Box() contain display boxes and arrange them in columns and rows.

```
H Sheet Box( <<Hold( report ), display box args );
V Sheet Box( <<Hold( report ), display box args );
```

The general approach is to first consider which display boxes you want and in which arrangement. Create either an H or V Sheet Box and send it a Hold message for each graph to specify which element the sheet box should hold. Finally, create interior H or V Sheet Boxes and tell each one which graph the sheet box should hold.

Here is an example of creating a sheet with four plots: a Bivariate plot, a Distribution, a Treemap, and a Bubble Plot.

First, open the data table and create a new window.

```
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
nw = New Window( "Sheet Box Example" );
```

Use a V Sheet Box to organize the window into two columns.

```
V Sheet Box( 
```

Send the V Sheet Box() four Hold messages, one for each graph. The order matters.

```
<<Hold(
   dt << Bivariate( // graph 1
      Y( :weight ),
      X( :height ),
      Fit Line()
   )

   dt << Distribution( // graph 2
      Y( :weight ),
      X( :height )
   )
```

```
   .
```

   dt << Treemap( // graph 3
      .
      .

   dt << Bubble Plot( // graph 4
      .
      .
```

);
Finally, add two \texttt{H Sheet Box}es to the \texttt{V Sheet Box} and tell each one which graph it should hold. Each \texttt{H Sheet Box} holds two side-by-side graphs. They are held by a \texttt{V Sheet Box}, so the \texttt{H Sheet Box}es are displayed vertically.

\begin{verbatim}
\texttt{H Sheet Box(}
  \texttt{Sheet Part(}
    \texttt{""},
  \texttt{Excerpt Box( 1, \{Picture Box( 1 )\} // excerpt box 1}
  \texttt{)},
  \texttt{Sheet Part(}
    \texttt{"Distribution of height"},
    \texttt{Excerpt Box( 2, \{Picture Box( 1 )\} // excerpt box 2}
  \texttt{)},
\texttt{)},
\texttt{H Sheet Box(}
  \texttt{Sheet Part(}
    \texttt{""},
  \texttt{Excerpt Box( 3, \{Picture Box( 1 )\} // excerpt box 3}
  \texttt{)},
\texttt{)}
\end{verbatim}

\texttt{Sheet Part} displays a previously defined graph, held by \texttt{Excerpt Box}. The first argument is the number of the graph, determined by the order in which you defined the graphs. The first \texttt{H Sheet Box} contains the Bivariate graph on the left and the Distribution on the right. \texttt{\{Picture Box( 1 )\}} designates which picture box from the report to display. Typically, use 1, the first picture box in the report.
Sheet Part(
    "My Title Here",
    Excerpt Box( 4, {Picture Box( 1 )} ) // excerpt box 4
)
)
);

The Sheet Part() title is required. If you include an empty string as the title, the sheet part’s title is the default report title, for example, “Bivariate Fit of weight By height”.

Journal Box

The Journal Box() constructs a display box from instructions that are stored in a journal.

    box = Journal Box("journal text");

where "journal text" is text that has been extracted from a journal file.

Since journal text has lots of rules about which boxes can be with other boxes, we recommend that you get journal text by highlighting an area of the report, selecting Edit > Journal, and save it as a journal. Open the journal in a text editor, and then paste it into your script as the Journal Box() argument.

We highly recommend that you use the "\[ ... \]" quoting mechanism so that you do not have to escape double quotes within the journal text. This excerpt shows how to escape the journal text:

    win = New Window( "Mosaic Plot",
        Journal Box(  
            "\[ // beginning of quoting mechanism
            ...display box arguments...
            ]\"
        ) // end of quoting mechanism
    );

Another way to get journal text is to send the Get Journal message to a display box. For example, run the following script and copy the journal text from the log into the Journal Box() function:

    dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
    biv = dt << Bivariate( y( :weight ), x( :height ) );
    rbiv = biv << Report;
    Print( rbiv << Get Journal ); // prints the journal to the log

Picture Object

JSL has a Picture Object, which stores pictures of JMP output or formulas. You can take a picture of anything in a display box or create a picture of a text formula as it would look in the Formula Editor.
To create picture data, send a Get Picture message to a display box.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( y( :weight ), x( :height ) );
rbiv = biv << Report;
rbiv << Get Picture;
```

The Expr As Picture() function evaluates its argument and creates a picture of the expression, using the same formatting mechanism as the Formula Editor. If you have a literal expression as the argument, remember to enclose it in Expr() so that JMP just takes a picture of the result. The expression then is not evaluated.

```julia
win = New Window( "Formula",
    Expr As Picture( Expr( a + b * c + r / d + Exp( x ) ) )
);
```

After you have the picture, there are two ways of using it:

- Add the picture to a new display tree using a display box constructor.
- Write the picture to a file using Save Picture().

```julia
picture << Save Picture( "path", type );
```

where type can be EMF (Windows), PICT (Macintosh), JPEG or JPG, GIF, or PNG.

On Windows, the Windows Specific preferences determine the resolution (or DPI), or you can run this expression:

```julia
Pref( Save Image DPI(<number>));
```

On Macintosh, the operating system determines the DPI.

### Input Selector Display Boxes

Input selector display boxes enable users to enter information and interact with the display box. The display box script includes a script that runs when the user interacts with the display box. See “Set Function and Set Script” on page 483 for details about writing the scripts.

#### Button Box

Button Box() draws a button that contains text.

```julia
Button Box("text", <script>);
```

The following example creates a new window with an OK button and a Cancel button:

```julia
win = New Window( "Set the Value",
    <<Modal,
    Text Box( "Set this value" ),
    variablebox = Number Edit Box( 42 ),
    Button Box( "OK" ),
    Button Box( "Cancel" ) );
```
Note that modal window must have at least one button. If you omit the `Button Box()` from your script, an OK button is automatically included.

You can add a tooltip for a button by sending a `Set Tip` message to it. The following script creates a button named “Submit”. A tooltip that contains “Send my information.” appears when you place your cursor over the button.

```
Button Box( "Submit", << Set Tip( "Send my information." ) );
```

You can also send the message `Open Next Outline` as a script command, which causes the next outline box to open. If you are sending more than one message to the button box, this must be the first command listed. When the user clicks the next button in this example, the second outline box opens.

```
win = New Window( "Open Next Outline",
    Outline Box( "First",
        ex = Button Box( "Next", ex << Open Next Outline )
    ),
    Outline Box( "Second", Text Box( "Last" ), << Close )
);
```

Using the `Set Menu Items` message, you can create a button that contains a menu:

```
win = New Window( "Set and Get Menu Choice",
    bb = Button Box( "Select a dessert",
        // get menu choices when button is clicked
        choice = bb << Get Menu Choice;
        Show( choice );
    )
);
bb << Set Menu Items( {"fruit", "no thank you", "-", "chocolate bar", "ice cream"} );
```

The "-" in the preceding script creates a menu separator. The separator counts as an item in the list. If you select `chocolate bar` from the menu, 4 is returned, not 3.

**Note:** Line-break characters are ignored in button boxes.

### Check Box

`Check Box()` constructs a display box to show one or more check boxes. Any number of the check box items can be selected simultaneously.

```
Check Box ({"item 1", "item 2", ..., <script>});
```

The following example shows how to get the user’s selection by sending the `Get Selected` message to the check box. Each selection is printed to the log.

```
win = New Window( "Check Box",
    cb = Check Box(
```
Chapter 11
Scripting Guide

Display Trees
Construct Custom Windows

455

{"apple", "banana", "orange"},
scb = cb << Get Selected();
Show( scb );
)
);
scb = {"banana", "orange"};

Combo Box
Combo Box() creates a drop-down list.
Combo Box( {"item 1", "item 2", ...}, <script> );

“item1” and “item2” are strings in the drop-down list.
The Editable argument allows the user to enter text in the combo box. The following example
creates a new window and an editable combo box with the list items “one”, “two”, and
“three”. The script prints the selected item name and index number to the log.
win = New Window( "Combo Box",
cb = Combo Box(
{"One", "Two", "Three"},
Editable,
selection = cb << GetSelected();
Print( "Selected: " || selection );
Print( "Index: " || Char( cb << Get() ) );
)
);

Note that closing the window for an editable combo box can produce unexpected results. On
Windows, the Print() script runs after you select an item from the list or enter the item name.
On Macintosh, the Print() script runs after you select an item from the list or enter the item
name and then press Return.
For cross-platform compatibility, include !Is Empty to test for an existing combo box before
running the script.
win = New Window( "Combo Box",
cb = Combo Box(
{"One", "Two", "Three"},
Editable,
If( !Is Empty( cb ),
selection = cb << GetSelected();
Print( "Selected: " || selection );
Print( "Index: " || Char( cb << Get() ) );
)
)
);


Global Box

Global Box shows the name and current value of a JSL global variable.

```javascript
Global Box( name );
```

The user can assign a new value to the global variable by editing the value directly in the window and pressing Enter or Return to commit the change. Global boxes automatically update the displayed value of a variable when the variable changes.

```javascript
ex = Sqrt( 4 );
win = New Window( "Global", Global Box( ex ) );
```

The preceding script creates a new window named “Global” that displays the following result:

```
ex=2
```

The following example shows the value of the myGlobal variable on the graph:

```javascript
myGlobal = 6;
win = New Window( "Global Box",
V List Box(
    gr = Graph Box(
        Frame Size( 300, 300 ),
        X Scale( 0, 10 ),
        Y Scale( 0, 10 ),
        Y Function( x, x ),
        Text( {5, 5}, "My global is ", myGlobal )
    ),
    Global Box( myGlobal ) // value of myGlobal
)
);
```

**Note:** When using Global Box, every time the variable is changed it remeasures, reshow, and updates the window which, depending on the number of Global Box objects, can affect the refresh rate of the window. JMP recommends avoiding numerous global boxes in deliverable scripts. Global boxes can be replaced with text boxes that the script can manually update when necessary.

List Box

List Box() creates a display box that shows a list box of items that can be selected.

```javascript
List Box( {"item 1", "item 2", ...}, <Width( n )>, <MaxSelected( n )>, <NLines( n )>, <script>);
```

Item names are case sensitive by default. Width is measured in pixels. MaxSelected is the maximum number of items that might be selected in the list box. NLines is the number of lines to display in the box, with a default value of 3.
Add items to a list box by either using Append or Insert:

```javascript
win = New Window( "test", lb = List Box( {"a", "e"} ) );
lb << Append( {"f", "g"} ); // result is a, e, f, g
lb << Insert( {"b", "c", "a", "d"}, 1 ); // result is a, b, c, d, e, f, g
```

Append always adds the list to the end of the list box. Insert adds the list after the position specified.

You can have two mutually exclusive list boxes, so that the item you select in one box is deselected when you select an item in the other box. Send the Clear Selection message to deselect the item.

```javascript
win = New Window( "Each Box Clears the Other Box", 
a = List Box( 
   {"broccoli", "pepper", "spinach"},
   <<Set Script( window:lb << Clear Selection )
 ),
lb = List Box( 
   {"avocado", "pumpkin", "tomato"},
   <<Set Script( window:la << Clear Selection )
 )
);
```

A list box can also contain an image. In the following example, an image from the user’s computer appears in the “first” list item. The JMP nominal icon appears in the “second” list item.

```javascript
win = New Window( "List Box with Image", 
List Box( 
   {["first", "$SAMPLE_IMAGES/pi.gif"], {["second", "nominal"]},
   width( 200 ),
 ),
);
```

**Mouse Box**

Mouse Box() creates a box that can make JSL callbacks for dragging and dropping, marking, or clicking and tracking mouse actions.

```javascript
Mouse Box( display box args, messages );
```

The following example is from the DragDrop.jsl sample script in the Samples/Scripts folder. One list box contains “a”, “b”, and “c”. The other list box contains “d”, “e”, “f”. You can drag a letter from one list box to the other list box.

**Note:** Mouse boxes support only one display box argument.

```javascript
win = New Window( "Mouse Box", 
```
Mouse Box( // first sibling
   TextBox( "drag from here" ),
   <<setDragText( "hello" ),
   <<setTooltip( "source" ),
   <<setDragEnable( 1 ),
   <<setDragBegin( // decide if a drag is allowed
      Function( {this, clickpt},
         )
   ),
   <<setDragEnd( // clean up after a drag finishes or cancels
      Function( {this, clickpt, how},
         // how indicates whether to move, copy, ignore
         If( 
            how != "ignore" & !IsEmpty( this << getDestBox ) & this
            /* the getDestBox check makes sure the destination of the 
               drag-and-drop was my sibling and not some other program */
            <<getDestBox == this << sib,
            (this << child) << setText(
               "Done!" // "move" would suggest clearing the source
            )
         )
      )
   ),
   Mouse Box( // second sibling
      TextBox( "drag to here" ),
      <<setTooltip( "destination" ),
      <<setDropEnable( 1 ),
      /* decide if dropping is allowed, before the drop.
      The getSourceBox check: make sure that the source of the 
      drag-and-drop is my sibling and not some other program */
      <<setDropTrack(
         Function( {this, clickpt},
            If( !IsEmpty( this << getSourceBox ) & this == (this <<
               getSourceBox) << sib,
               1, /*else*/ 0
            )
         )
      ),
      <<setDropCommit( // accept the drop
         Function( {this, clickpt, text},
            (this << child) << setText( text )
         )
      )
   )
);
Number Col Edit Box

Number Col Edit Box() creates a display box that shows editable numbers in a column. The numeric entries can be in list or matrix form.

```
Number Col Edit Box("title", numbers);
```

The following script creates number edit boxes in which the user enters values. The Return Result message extracts the values.

```
x = y = z = 0;
win = New Window( "Number Col Edit Box",
    <<Modal,
    <<Return Result,
    Table Box(
        neb = Number Col Edit Box( "values", {x, y, z} )
    )
); {neb = {2, 4, 6}, Button( 1 )}
```

Number Edit Box

Number Edit Box() creates an editable number box that initially contains the value argument.

```
Number Edit Box( value );
```

The following script shows an editable box that initially contains the number “42”. The number that the user types is printed to the log.

```
win = New Window( "Set a Value in Number Edit Box",
    <<Modal,
    <<Return Result,
    Text Box( "Set this value" ),
    variablebox = Number Edit Box( 42 ),
    Button Box( "OK" ),
    Button Box( "Cancel" )
); Write( win["variablebox"] );
// create a subscript to the variablebox variable
33 // the user typed "33" in the number edit box
```

Popup Box

Popup Box() creates a red triangle menu that contains menu item commands.

```
Popup Box( {"command1", script1, "command2", script2, ...} );
```

The following example stores a command list in a variable and then uses Popup Box() to display the items:

```
List = {
    "command1", Print( "command1" ),
```
Display Trees
Chapter 11
Construct Custom Windows Scripting Guide

Figure 11.8 Red Triangle Menu

Note that you can disable and re-enable the menu using the Enable( Boolean ) message. An argument of 1 turns the menu on, and an argument of 0 turns the menu off. Using the previous example, assign the popup box to a variable and then send messages to it:

```script
win = New Window( "Example",
    Text Box( "Popup Test" ),
    Popup Box( List );
);

mymenu = Popup Box( commandList );

mymenu << Enable( 0 ); // disabled menu
```

You can also add a popup menu to an outline box. See “Outline Box” on page 448 for an example.

Radio Box

Radio Box() creates a list of radio buttons.

```script
Radio Box({"item 1", "item 2", ...}, <script>);
```

Only one item in the radio box can be selected at any time.
The following script creates “A”, “B”, and “C” radio buttons and selects the second box.

```
win = New Window( "Radio Box",
    V List Box(
        rb = Radio Box( {"A", "B", "C"}, <<Set( 2 )>,
    ));

"New Window Example" on page 511 also provides an example of creating radio boxes.

**Slider Box**

Slider Box() creates a slider control for picking any value for the variable, within the
minimum and maximum range that you specify.

```
Slider Box( min, max, global variable, script, <<Set Width( n )>, <<Rescale
Slider( min, max )>);
```

Set Width specifies the width of the slider box. Rescale Slider specifies the minimum and
maximum values.

When the slider is moved, the value given by the current position of the slider is assigned to
the global variable. Thus, Slider Box() is another way to parameterize a graph.

```
ex = .5;
win = New Window( "Slider Box",
    tb = Text Box( "Value: " || Char( ex ) ),
    sb = Slider Box(
        0,
        1,
        ex,
        tb << Set Text( "Value: " || Char( ex ) )
    ));
    sb << Set Width( 100 ) << Rescale Slider( 0, .8 );
```

The following script creates multiple slider boxes without using a unique global variable to
hold the current value for each one:

```
sb1 = Slider Box( 1, 10 );
sb2 = Slider Box( -10, 10 );
// create a slider box with only the min and max value
sb1 << Set Function( // set the script or the function
    Function( {this},
        {},
        Show( this << Get, sb2 << Get )
    ));
    sb2 << Set Script( Show( sb2 << Get, sb1 << Get ) );
New Window( "Values", sb1, sb2 ); // place the slider boxes in a window

As you move the slider, the value is printed to the log.

See “Example of Slider Boxes and Range Slider Boxes” on page 471 for another example of slider boxes.

Spacer Box

Spacer Box() creates space between display boxes.

Spacer Box(<size(horizontal_pixels,vertical_pixels)>, <color(color)>)

The following script places a 450 pixel wide and 15 pixel tall blue spacer box between the two outline boxes.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
win = New Window( "Spacer Box",
    V List Box(
        Outline Box( "Bivariate",
            biv = dt << Run Script( "Bivariate" ),
            Spacer Box( Size( 450, 15 ), Color( { .53, .80, .98} ), )
            // Color string consists of percentages of RGB values
        ),
        Outline Box( "Distribution",
            V List Box( dist = dt << Run Script( "Distribution" ), )
        )
    )
);
String Col Edit Box

String Col Edit Box() creates a column named title in a table containing the string items listed. The string boxes are editable.

String Col Edit Box( "title", {strings} );

The following script creates a column of editable text boxes, preceded by the title “Names”:

```plaintext
a = b = c = "";
win = New Window( "String Col Edit Box",
<<Modal,
```
Display Trees

Chapter 11
Construct Custom Windows

<<Return Result,
Table Box(
    seb =
        String Col Edit Box(  
            "Names",
            {a, b, c}
        )
    );
    {seb = {"apple", "orange", "banana"}, Button( 1 )}

Tab Box and Tab Page Box

Tab Page Box() organizes the title and contents of the page in one display box. When Tab Page Box() is inside Tab Box(), a tabbed window with multiple tabbed pages appears.

Tab Box( Tab Page Box( "page title 1", [options], contents of page 1), Tab Page Box( "page title 2", [options], contents of page 2), ...);

The following script creates three tab boxes:

win = New Window( "Tab Box",
    Tab Box(
        Tab Page Box( 
            "First page",
            Text Box( "first line of first page" ),
            Text Box( "second line of first page"
        ),
        Tab Page Box( 
            "Second page",
            Text Box( "first line of second page" ),
            Text Box( "second line of second page"
        ),
        Tab Page Box( 
            "Third page",
            Text Box( "first line of third page" ),
            Text Box( "second line of third page"
        )
    )
    );

Figure 11.10 Tab Boxes
You can specify which tab should be selected by sending the Set Selected( n ) message, where n is the tab number, to the tab box object.

The Set Style message lets you select the visual appearance of the tab box. The default value is tab. Other options include the following:

- combo creates a combo box.
- outline creates an outline node.
- vertical spread displays the tab title vertically.
- horizontal spread displays the tab title horizontally.
- minimize size bases the tab style on the width of the tab title. In the following example, the first tab title is fairly long:

```plaintext
win = New Window( "Tab Box",
    tb = Tab Box(
        Tab Page Box(
            "First page of my tab box",
            Text Box( "first line of first page" ),
            Text Box( "second line of first page" )
        ),
        Tab Page Box(
            "Second page",
            Text Box( "first line of second page" ),
            Text Box( "second line of second page" )
        ),
        Tab Page Box(
            "Third page",
            Text Box( "first line of third page" ),
            Text Box( "second line of third page" )
        )
    )
);
    tb << Set Style( "minimize size" );
```

Minimizing the size of the tab box converts the tab box into a combo box. Figure 11.11 compares the default and minimized tab boxes.

**Figure 11.11** Default Tab Box (Left) and Minimized Tab Box (Right)

For Tab Page Box() examples, see “Examples of Creating a Dashboard from Two Reports” on page 490.
Tips:

- The `Set Style` message works for both bare words and quoted words. However, you cannot assign the style to a variable and then pass the variable as the argument.

- You can combine `Tab Box()` with `Splitter Box()` to create docked tabs, which can be dragged to drop zones in a window to create a different layout. See “Examples of Creating a Dashboard from Two Reports” on page 490 for details.

- To delete a tab, you can either send `Delete(index)` to the tab box, or you can send `Delete Box()` to a tab page box. Note that the entire display box (all tabs) is deleted, not just a single tab.

- Use the `Visibility("Collapsed")` message to hide a tab.

- Use the `Set Overflow Enabled(1)` message to show a “~” symbol to the right of a tab list when the list is not wide enough for all titles.

- When `Tab Page Box()` is created or dragged outside a `Tab Box()`, it is a stand-alone container. The title appears in a shaded box at the top of the page, similar to the title in `Sheet Part()`; the title does not appear in an interactive tab.

- See “Writing Tab Box and Tab Page Box Scripts” on page 521 for details about the differences between `Tab Box()` and `Tab Page Box()`.

- In Bubble Plot and Graph Builder scripts, set the `Fit to Window` message to "On" to resize the window when you resize the graph in `Tab Box()`.

**Text Box**

`Text Box()` creates a non-editable text box. Text boxes are frequently used as labels of other controls.

```text
Text Box( "text" );
```

You can format the text with HTML tags. For example, the following script formats text in bold:

```text
win = New Window( "Formatted Text",
    Text Box( "This is <b>bold</b> text.",
    <<Markup) );
```

Make sure you close nested tags correctly as shown here:

```
"This is <b><i><u>bold italic</u></i></b> text."
```

**Note:** Rotated text boxes support `Markup` text except for larger text boxes with multiple lines, multiple formats or justifications applied.
Text Edit Box

Text Edit Box() creates an editable text box.

Text Edit Box ( "text" );

You can add a script to a text edit box by sending it a script message. This is usually most convenient at the time the box is created. Simply add the script message as the last argument.

The following example prints “Changed” in the log each time the text edit box is changed:

```plaintext
win = New Window( "Text Edit Box",
    Text Edit Box( "Change Me", <<Script( Print( "Changed" ) ) )
);
```

Assign a reference to the text edit box object to access its contents. The following example prints the value of the text edit box to the log each time the box changes:

```plaintext
win = New Window( "Text Edit Box",
    teb = Text Edit Box( "Change Me",
        <<Script( Print( teb << Get Text ) )
    )
);
```

Text edit boxes are empty. However, you can specify placeholder text as a visual cue for the user to enter a value in the box. The placeholder text is only a hint and does not affect the value of the text field.

The following example produces the text edit box shown in Figure 11.12. The Hint() function returns "mm/dd/yyyy" and formats it as light gray text.

```plaintext
win = New Window( "Text Edit Box",
    Text Edit Box( "Current Date" ),
    Text Edit Box( "", Hint( "mm/dd/yyyy" ) )
);
```

**Figure 11.12** Text Edit Box with Placeholder Text

If you need to use a text edit box for your user to enter passwords, you can apply a style to the text edit box to replace all characters entered with an asterisk. For example, the following example creates a text edit box whose value is the string “a”. When a user types a new string into the text edit box, each character is displayed as an asterisk, and the message “Changed!” is printed to the log.

```plaintext
win = New Window( "Text Edit Box",
    teb = Text Edit Box( "a",
        Password Style( 1 ),
    ),
);
Set Script( Print( "Changed!" ) )
);

You can also send a text edit box a message to either use password style or to stop using password style.

q << Password Style( 1 ); // set the text edit box to password style
q << Password Style( 0 ); // set the text edit box to standard style

Filtering Display Boxes

Data Filter Source Box() and Data Filter Context Box() work together to filter data in multiple graphs. Data Filter Source Box() defines which graph is the “source” of the selection filter. When data are selected in the source graph, graphs in the common Data Filter Context Box() are updated.

Data Filter Context Box

Data Filter Context Box() creates a display box that enables you to filter data in multiple graphs. The function determines the number of graphs that the filter applies to, for example, all graphs in a report.

Data Filter Context Box( display box args );

In the following example, the H List Box() that contains the graphs is wrapped in Data Filter Context Box(). After you run the script, select values in the filter to see both graphs update.

dt = Open( "$SAMPLE_DATA/Hollywood Movies.jmp" );
win = New Window( "Shared Local Filter",
   Data Filter Context Box( // enclose the h list box that contains distribution and graph builder
      H List Box(
         dt << Data Filter( Local ), // add the local data filter
dt << Distribution(
            Weight( :Profitability ),
            Nominal Distribution( Column( :Lead Studio Name ) ),
            Nominal Distribution( Column( :Genre ) ),
            Histograms Only
         ),
         dt << Graph Builder(
            Variables( x( :Genre ),
                  Y( :Domestic Gross ),
                  Y( :Foreign Gross, Position( 1 ) )
            ),
            Show Control Panel( 0 ),
         )
      )
   ));
Elements(
  Bar(
    X,
    Y( 1 ),
    Y( 2 ),
    Legend( 2 ),
    Bar Style( "Side by side" ),
    Summary Statistic( "Mean" )
  ),
  Frequencies( 0 ),
)
);

Data Filter Source Box

Data Filter Source Box() and Data Filter Context Box() work together to filter data in multiple graphs. Data Filter Source Box() defines which graph is the “source” of the selection filter. When data are selected in the source graph, graphs in the common Data Filter Context Box() are updated.

Data Filter Source Box( display box args );

The following script lets you select data in Distribution graphs, and only that data is shown in the Graph Builder graph:

dt = Open( "$SAMPLE_DATA/Hollywood Movies.jmp" );
win = New Window( "Shared Local Filter",
  Data Filter Context Box(
    // enclose data filter source box and the graph builder platform
    H List Box(
      Data Filter Source Box(
        dt << Distribution( // use distribution as the source graph
          Weight( :Profitability ),
          Nominal Distribution( Column( :Lead Studio Name ) ),
          Nominal Distribution( Column( :Genre ) ),
          Histograms Only
        ),
        dt << Graph Builder(
          Variables(
            X( :Genre ),
            Y( :Domestic Gross ),
            Y( :Foreign Gross, Position( 1 ) )
          ),
          Show Control Panel( 0 ),
        )
      )
    )
  )
);
Elements(
  Bar(
    X,
    Y( 1 ),
    Y( 2 ),
    Legend( 2 ),
    Bar Style( "Side by side" ),
    Summary Statistic( "Mean" )
  ),
  Frequencies( 0 ),
)
);

Examples of Combined Display Boxes

The following example generates a sample of many controls illustrated in the previous sections.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
win = New Window( "Window Controls",
  Line Up Box( N Col( 2 ), Spacing( 3 ),
    Panel Box( "Panel Box",
      Check Box( {"Check Box 1", "Check Box 2"} ),
      Radio Box( {"Radio Box 1", "Radio Box 2"} ),
      Combo Box( {"Combo Box"} ),
      Button Box( "Button Box" ),
      List Box( {"List Box 1", "List Box 2"} )
    ),
    Col List Box( "all" )
  )
);

Figure 11.13  Example of Many Interactive Display Elements
Example of Slider Boxes and Range Slider Boxes

The following example combines a graph with two sliders and a button by gluing the graph box, two horizontal boxes, and a button together in a vertical list box:

```plaintext
// Slider LogNormal
lU = 1;
lS = 2;
win = New Window( "LogNormal Density",
    V List Box(
        gr = Graph Box( // define the arguments and script for the graph box
            Frame Size( 500, 300 ),
            X Scale( 0.01, 3 ),
            Y Scale( 0, 4 ),
            XAxis( Show Major Grid ),
            YAxis( Show Major Grid ),
            Y Function(
                Exp( -(Log( x ) - Log( lU )) ^ 2 / (2 * lS ^ 2) ) / (lS * x * Sqrt( 2 * Pi() )),
                x
            );
            Text( {1, .5}, "u= ", lU, " s= ", lS );
            // display the specified text at 1 on the x axis
            // and .5 on the y axis
        ),
        H List Box( Slider Box( 0, 4, lU, gr << Reshow ), Text Box( "Low" ) ),
            // define the minimum and maximum range
            // insert the value of lU and updates the display as the slider moves
        H List Box( Slider Box( 0, 4, lS, gr << Reshow ),
            Text Box( "High" )
        ),
        Button Box( "Reshow", gr << Reshow )
    )
); 
Show( gr );
gr << Reshow; // update the display of the Graph Box
```
The following script uses a `Range Slider Box()` instead of a `Slider Box()` to perform the same function:

```plaintext
lLow = 1;
lHigh = 2;
win = New Window( "Range Slider",
    V List Box(
        gr = Graph Box(
            Frame Size( 500, 300 ),
            X Scale( 0.01, 4 ),
            Y Scale( 0, 4 ),
            XAxis( "Show Major Grid" ),
            YAxis( "Show Major Grid" ),
            X Function( lLow, x ),
            X Function( lHigh, x );
            Text( {1, .5}, "Low= ", lLow, " High= ", lHigh );
        ),
        V List Box(
            Text Box( "Low and High" ),
            sb = Range Slider Box( 0, 4, lLow, lHigh, gr << Reshow )
        )
    ),
    Button Box( "Reshow",
        lLow = 1;
        lHigh = 2;
        gr << Reshow;
        sb << Reshow;
    )
)
```
The script below is similar but uses `Global Box()` as an editable text box instead of two `Slider Box()` controls:

```plaintext
// Global LogNormal
lU = 1;
lS = 2;
win = New Window( "LogNormal Density",
  V List Box(  
    gr = Graph Box( // define the arguments and script for the Graph Box  
      Frame Size( 500, 300 ),  
      X Scale( 0.01, 3 ),  
      Y Scale( 0, 4 ),  
      XAxis( "Show Major Grid" ),  
      YAxis( "Show Major Grid" ),  
      Y Function(  
        Exp( -(Log( x ) - Log( lU ))^2 / (2 * lS^2) ) / (lS * x *  
          Sqrt( 2 * Pi() ) ),  
        x  
      );  
    Text( {1, 1}, "u=", lU, " s=", lS, " or type new values below" );  
    // display the specified text at 1 on the x and y axes  
  ),  
  H List Box( Global Box( lU ) ),  
  // display the lU variable value in the first H List Box
  )
```

Figure 11.15 Example of Using Range Slider Box
\begin{verbatim}
H List Box( Global Box( lS ) )
// display the lS variable value in the second H List Box
);
\end{verbatim}

**Figure 11.16** Example of Using a Global Box Instead of Sliders

The example under “Drag Functions” on page 570 in the “Scripting Graphs” chapter, shows another use of Button Box.

**Example of a Calendar and Date Selector**

You can create a calendar or date selector using Calendar Box() and Number Edit Box().

**Calendar Box**

With Calendar Box(), you can select dates from a calendar and input the year. The following example creates a calendar with October 5, 1989 initially selected. You can select any date 60 days before or 60 days after October 5, 1989.

```r
win = New Window( "Calendar Box", cal = Calendar Box() );
date = Date MDY( 10, 5, 1989 );
cal << Date( date );
cal << Show Time( 0 ); // omit the time

cal << Min Date( Date Increment(date, "Day", -60, "start" ) );
// earliest date that can be selected is 60 days before 10/5/1989
// "start" truncates the value so the time is not included

cal << Max Date( Date Increment(date, "Day", 60, "start" ) );
```
// latest date that can be selected is 60 days after 10/5/1989

cal << Set Function( Function( {this}, Print( Abbrev Date(this << Get Date()) ) ) );
// print the abbreviated date to the log

Figure 11.17 Creating a Calendar

Number Edit Box

With Number Edit Box(), you can enter a date in the box or click the calendar button to select the date from a calendar.

The following example shows how to create an interactive calendar using Number Edit Box(). The user enters a date in the box or clicks the calendar to select a date from the calendar. The number appears in a text box below the number edit box. "10/05/1989" is initially selected.

f = Function( {this}, // callback
textbox << Set Text( Format( this << Get, "m/d/y" ) ) // get the date );
win = New Window( "Date Selector",
numbox = Number Edit Box( 0, 20, << Set Function( f ) ),
textbox = Text Box( "" ) // specified date );
numbox << Set Format(
Format( "m/d/y", 12 )
// date format and number of characters displayed );
umbox << Set( Date MDY( 10, 5, 1989 ) ); // default date and format

Figure 11.18 Creating a Date Selector
Note that a callback is assigned to the f variable. In the callback, this refers to the number edit box, the box that calls the function later. Referring to this prevents the need for using the numbox variable within the callback. The Get message is sent to the this argument to get the specified date.

**Example of Constructing a Summary Results Report**

The following example uses the Summarize() function to collect summary statistics on the Height column of Big Class.jmp and then uses display box constructors to show the results in a nicely formatted window.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
Summarize(
    a = by( age ),
    c = count,
    sumHt = Sum( Height ),
    meanHt = Mean( Height ),
    minHt = Min( Height ),
    maxHt = Max( Height )
);
win = New Window( "Summary Results",
    Table Box(
        String Col Box( "Age", a ),
        Number Col Box( "Count", c ),
        Number Col Box( "Sum", sumHt ),
        Number Col Box( "Mean", meanHt ),
        Number Col Box( "Min", minHt ),
        Number Col Box( "Max", maxHt )
    )
);
```

This produces the summary results shown in Figure 11.19.

**Figure 11.19 Producing a Customized Summary Report**

<table>
<thead>
<tr>
<th>Age</th>
<th>Count</th>
<th>Sum</th>
<th>Mean</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>8</td>
<td>485</td>
<td>58.125</td>
<td>51</td>
<td>66</td>
</tr>
<tr>
<td>13</td>
<td>7</td>
<td>422</td>
<td>60.2057</td>
<td>56</td>
<td>65</td>
</tr>
<tr>
<td>14</td>
<td>12</td>
<td>770</td>
<td>64.1667</td>
<td>61</td>
<td>69</td>
</tr>
<tr>
<td>15</td>
<td>7</td>
<td>452</td>
<td>64.5714</td>
<td>62</td>
<td>67</td>
</tr>
<tr>
<td>16</td>
<td>3</td>
<td>193</td>
<td>64.3333</td>
<td>60</td>
<td>68</td>
</tr>
<tr>
<td>17</td>
<td>3</td>
<td>200</td>
<td>68.6667</td>
<td>62</td>
<td>70</td>
</tr>
</tbody>
</table>

You can use the usual commands for display boxes. The following script saves the report as a Microsoft PowerPoint presentation.

```julia
Show Properties( win );
win << Save Presentation( "$DOCUMENTS/Summary.pptx" );
```
Interact with a Closing Window

A user can close a window by clicking the OK or Cancel button or by clicking the red Close button in the top corner of the window. A message can also be sent to close the window. On Validate and On Close expressions determine what happens you interact with the window.

- **On Validate** evaluates its expression *when the OK button is clicked*. The expression is not evaluated for any other button click or action. If the expression evaluates as true, the window closes. If the expression evaluates as false, the window is not closed. The script for an OK button runs when you click the button, no matter what the On Validate expression does.

- **On Close** evaluates its expression *right before the window closes*. The On Close return value is like the On Validate return value and can prevent the window from closing. However, the best practice for On Close is to always return 1 so that you do not accidentally create a window that cannot be closed.

If the window closes, On Close is evaluated. On Close is not evaluated if the On Validate expression returns false, because the window is not closed.

**Notes:**

- On Close works for modal or non-modal windows. On Validate works only for modal windows.

- Do not use On Close for validation because it does not distinguish between OK and Cancel. Use On Close to clean up resources (such as invisible data tables) because it always runs when the window closes.

- Do not use On Validate to clean up resources. Use On Close instead or in addition to On Validate, because On Validate does not run for the Cancel button or red Close button.

**On Close() Example**

Suppose that a non-modal window is a report window, and the resource that needs cleaning up is an invisible data table. The On Close script closes the data table. This is good because the user might not know that the data table is open and has no easy way to close it.

```r
dt = New Table( "Untitled", << Invisible,
    New Column( "x", Set Values( [1, 2, 3, 4] ) ),
    New Column( "y", Set Values( [4, 2, 3, 1] ) )
);

dt << Bivariate(
    y( dt:y ), x( dt:x ), <<On Close( Close( dt, "nosave" ) )
);
```

Before the script is run, no data tables are open. The Untitled invisible table is created and displayed in the Home Window and in the Data Tables list above the script. Then the graph is created. After you close the report window, the invisible table is closed by On Close.
On Validate() Example

Suppose that a modal window contains a question that the user must answer before closing the window. The following example shows how to validate the input when the user closes the window.

```plaintext
win = New Window( "Validate Example", 
  <<Modal, 
  <<Return Result, 
  <<On Validate( 
    If( (!Is Missing( variablebox << Get ) & 40 <= variablebox << Get <= 50), 
      Return( 1 ), // else the user did not enter the correct answer 
      tb << Set Text( 
        Match( Random Integer( 1, 3 ), 
          1, "Are you sure?", 
          2, "Guess again.", 
          3, "Please read the question." 
        ) 
      ); 
      Return( 0 ); 
    ) ), 
  Text Box( "I'm thinking of a number between 40 and 50. What's your guess?" ), 
  variablebox = Number Edit Box( . ), 
  H List Box( Button Box( "OK" ), Button Box( "Cancel" ) ), 
  tb = Text Box( "" ) 
); 

New Window( "Modal Window", 
  <<Modal, 
  Text Box( 
    If( 
      win["Button"] == -1, "Try again when you feel better.", 
      // user clicked Cancel or the red Close button 
      win["variablebox"] == 42, "Good job.", // user entered 42 
      "Take the test again." // user did not enter 42 and clicked OK 
    ) 
  ) 
); 
```

Update an Existing Display

Sometimes, you do not know how many display boxes will appear in a future report. For example, you might write a generic script that analyzes and reports on one or more variables.
You do not know how many display boxes are needed, because the number of variables can change from one run of the script to the next.

The following sections describe how to add and delete display boxes from a report using Append(), Prepend(), Delete(), and Sib Append().

### Append

Use the Append message to add a display box to the bottom of an existing display. In the script, construct a single, empty box, then append boxes to it for each variable in the analysis. You can also use the Append message to modify an existing display with custom information or organization.

The following code example assumes that there is a list of effect names in the variable effectsList, and that each one corresponds to a column in a matrix varprop. In other words, effectsList[1] is the label for varprop[0,1]; effectsList[2] is the label for varprop[0,2]; and so on.

```plaintext
varprop = [0 1 2, 3 4 5, 6 7 8];
effectsList = {"one", "two", "three"};
```

First, an empty Outline Box containing an H List Box is created. The interior empty container is given the name hb:

```plaintext
win = New Window( "H List Box Example",
    Outline Box( "Variance Proportions", hb = H List Box() )
);
```

Then, a for loop steps through the effectsList and adds a Number Col Box for each element of effectsList:

```plaintext
For( i = 1, i <= N Items( effectsList ), i++,
    Eval(
        Substitute(
            Expr(
                hb << Append(
                    Number Col Box( effectsList[i], varprop[0, i] )
                ),
                Expr( i ), i
            )
        )
    );
```

Sib Append() is similar to Append() but makes the display box a sibling of the last child display box. For an example that compares Append() to Sib Append(), see Figure 11.21.
Prepend

The Prepend message works just like Append but adds the item at the beginning of the display box rather than at the end. If the display box is one of several that do not allow appending, then Prepend delegates the command to a child display box that can accept the command. It is fine to apply it to the top of the tree.

For example, the following example creates a Bivariate report with a button box at the top.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( Y( height ), X( weight ), Fit Line );
(biv << Report)(Outline Box( 1 )) << Prepend(
    // select the first outline box in the biv report layer
    // send the Prepend message to the first outline box
    Button Box( "Click here for curve", biv << Fit Polynomial( 2 ) )
    // prepend a button box that fits a quadratic curve
);
```

Click the **Click here for curve** button to add a quadratic curve to the graph.

You can accomplish the same thing by appending the button to the top of the tree:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( Y( height ), X( weight ), Fit Line );
biv << Report << Prepend( // send the prepend message to the report
    Button Box( "Click here for curve", biv << Fit Polynomial( 2 ) )
    // prepends the button box to the top of the report
);
```

Delete

The Delete message removes the specified display box and all its children from the report. This is useful with the Append and Prepend messages for building completely dynamic displays. In the example below, a text box is replaced with another text box. In this case, the script could have used Set Text, but many display boxes cannot change their content.

```julia
win = New Window( "X",
    list = V List Box(
        t1 = Text Box( "t1" ),
        t2 = Text Box( "t2" )
    )
);
t1 << Delete;
list << Append( t1 = Text Box( "t1new" ) );
```

**Note:** Avoid deleting display boxes from a JMP platform. Send the Hide( 1 ) message or the Visibility( "Hidden" ) message to the display box that you want to hide.
Sib Append

You can use the Sib Append message to add a display box immediately after an existing display box. Figure 11.20 shows two picture box trees. Picture Box(1) holds the Bivariate scatterplot. Picture Box(2) holds the Fit Mean menu, determined by seeing the green line and the Fit Mean text box.

Suppose you wanted to insert a text box in between these two boxes. We want to append a sibling to Picture Box(1), so we send it the Sib Append message:

```javascript
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate(
    Y( :weight ),
    X( :height ),
    Fit Mean( {Line Color( {57, 177, 67} )} ) );
Report( biv )[Picture Box(1)] << Sib Append( Text Box( "Hello There" ) ); /* the report function takes the biv object and returns a report object. append the text box immediately after the first picture box */
```
Figure 11.20  Appending a Sibling Text Box

Note: In Figure 11.20, the appended sibling text box appears below the first picture box in the Show Tree Structure View window. In the classic Show Tree Structure View window, siblings appeared next to each other in the display tree. See “View the Display Tree” on page 422 for details.

Figure 11.21 shows the difference between and Append() and Sib Append(). Append() makes the display box a child of the parent display box. Sib Append() makes the display box a sibling of the last display box.
Figure 11.21 Append (Left) and Sib Append (Right)

Note: If the parent display box is not a V List Box(), Sib Append() wraps that display box in V List Box().

Set Function and Set Script

You can use the Set Script message to have a display box control (for example, a button box or combo box) run a script when it is clicked with the mouse.

```plaintext
win = New Window( "Set Script Example", 
ex = Button Box( "Press me" )
);
ex << Set Script( Print( "Pressed" ) );
```

The preceding script prints the following text to the log when the button box is clicked:

"Pressed"

Alternatively, you can use the Set Function message to have a display box control run a specific function where the first argument is the specific display box. Set Function enables you to build more object-oriented scripts and to create a larger system.

```plaintext
win = New Window( "Set Function Example", 
Button Box( "Press me", 
<< Set Function( 
  Function( 
    {this},
    // functions specified with Set Function get 'this' display box 
    this << Set Button Name( "Thanks" )
  )
 )
);
```

The preceding script creates a button box with the name “Press me”. When the button is clicked, the function called by Set Function changes the name to “Thanks”.

```plaintext
```
If you have multiple buttons that can be serviced by the same script, `Set Function` is much simpler than `Set Script` because it tells you which button was pressed. In this example, both check boxes use the script that begins on the first line.

```plaintext
f = Function( {this, idx}, // idx just changed
    Write(
        /* <<Get Items returns a list of all items; indexing that list with idx
           is the name of the item that is changing
           <<Get returns the new value of that item */
        "\n changing item= " || (this << Get Items())[idx] || " to " || Char( this << Get( idx ) ) ||
        "\n new selection= " || Char( this << Get Selected ) || "\n"
    );
);
New Window( "Example",
    H List Box( // 'f' is the 'named' function, used twice
        V List Box( Text Box( "Column 1" ), Check Box( {"a", "b"}, <<Set Function( f ) ) ),
            Spacer Box( size( 50, 50 ) ),
        V List Box( Text Box( "Column 2" ), Check Box( {"c", "d"}, <<Set Function( f ) )
    )
);
)
```

In the following example of `Set Function`, the same function is used to create the buttons.

```plaintext
New Window( "Cash Box",
    V List Box(
        H Center Box( TB = Text Box() ), // TB will show total of coins
        LB = Lineup Box( N Col( 3 ) ), // LB will hold buttons, added below
        H Center Box( // CLEAR button will reset the total
            Button Box( "CLEAR",
                total = 0;
                TB << Set Text( Char( total ) );
            )
        )
    )
);
coins = {1, 5, 10, 25, 50, 100}; // coins is a list of the button labels
total = 0;
For( iButton = 1, iButton <= N Items( coins ), iButton++,
    LB << Append( Button Box( Char( coins[iButton] ) ), Set Function( buttonFunction ) )
); /* loop creates the buttons and shows that the same function
       is used for each */
buttonFunction = Function( {this},
```
total = total + Num( this << Get Button Name );
TB << Set Text( Char( total ) );
);
// The function called for any button, except CLEAR, uses the button's
// name to determine what to do. Rather than using the button's name,
// you might want to use a sibling display box by this<<sib or perhaps
// (this<<parent)<<child to find the first sibling of this button.

Notes:

• The Set Script and Set Function messages work for button boxes, calendar boxes, check
boxes, combo boxes, list boxes, popup boxes, radio boxes, range slider boxes, slider boxes,
and spin boxes.
• You cannot use both Set Script and Set Function at the same time. Use Set Function if
you need to reference a specific display box object.

Get and Set Selected Values of Display Elements That Return Lists

You can use the Set Selected(Item Number, <State>, <Run Script(0|1)>)) message to
pre-select an item. You can use this message separately to a saved display box reference, or
you can specify it inline as a list box << message.

To retrieve the selected value, use the Get Selected message, which returns the value of the
selected item. The Get Selected Indices message returns the index number of the selected
item.

antennaList = {"Dish","Helical","Polarizing","Radiant Array"};

win = New Window( "Test List", // method 1: display box reference
listObj = List Box(
    antennaList,
    Print(
        "iList",
        listObj << Get Selected,
        listObj << Get Selected Indices
    )
)
);
listObj << Set Selected( 2, 1 );

win = New Window( "Test List", // method 2: inline
listObj = List Box(
    antennaList,
    <<Set Selected( 2, 1 ),
    Print(
        "iList",
        listObj << Get Selected,
Both of these scripts print the following text to the log:

```
"iList"
{"Helical"}
{2}
```

In the preceding examples, the Print expression is executed when the Set Selected message is completed. To prevent the script from running, include Run Script(0) as the last argument. Run Script(0|1) controls whether a display box on-change script runs after a Set or Set Selected message.

```plaintext
antennaList = {"Dish","Helical","Polarizing","Radiant Array"};
win = New Window( "Test List",
listObj = List Box(
    antennaList,
    Print(
        "iList",
        listObj << Get Selected,
        listObj << Get Selected Indices
    )
));
listObj << Set Selected( 2, 1, Run Script(0) );
```

With Run Script(1), the script is executed when the Set message is completed, even if the value is unchanged. (The script does not run again if the user selects the same value.) With Run Script(0), the script does not run.

On most interactive display boxes, the script does not run on most interactive display boxes if you leave out Run Script(). However, on List Box(), the script runs by default, which is consistent with previous behavior.

### Send Messages to Constructed Displays

When you assign a constructed display to a name, that name becomes a reference to the window, which in turn owns the display boxes inside it. Using subscripts, you can then send messages to the display boxes inside the window.

For example, the following script creates an interactive sine wave graph. The script automates the interaction by sending messages to the frame box inside the window. Note the frame box assignment to tf in the middle of the script).

```plaintext
amplitude = 1;
freq = 1;
```
phase = 0;
win = New Window( "Wiggle Wave",
    Graph Box(
        Frame Size( 500, 300 ),
        X Scale( -5, 5 ),
        Y Scale( -5, 5 ),
        Y Function( amplitude * Sine( x / freq + phase ), x );
    Handle(
        phase,
        amplitude,
        /* current values of phase and amplitude position the square handle. 
        script begins after the last comma after amplitude */
        phase = x;
        amplitude = y;
        /* x and y have been set to the handle's position 
        but the handle doesn't move unless the values specified 
        in the first two arguments are updated */
    );
    Handle( freq, .5, freq = x );
    // Handle works similarly except that the y value is .5
    Text( // display a text string in the graph
        {3, 4},
        "amplitude: ",
        Round( amplitude, 4 ), // display the current value
        {3, 3.5},
        "frequency: ",
        Round( freq, 4 ), // display the current value
        {3, 3},
        "phase: ",
        Round( phase, 4 ) // display the current value
    );
); tf = win[Frame Box( 1 )]; // get the frame box (the graph)
For( amplitude = -4, amplitude < 4, amplitude += .1, // animate the amplitude
    tf << Reshow // force the graph to update
); amplitude = 1; // use for loops for more complex movement
freq = 1;
phase = 0;
For( i = 0, i < 1000, i++,
    amplitude += (Random Uniform() - .5);
    amplitude = If(
        amplitude > 4, 4,
        amplitude < -4, -4,
        amplitude
    );
);
Construct Display Boxes That Contain Platforms

Another type of display that you might want to construct is your own combination of results from the analysis platforms in JMP. Write the platform script inside a display box and assemble the display boxes into a window. For ease in routing messages to it later, assign the whole script to a reference.

The following example creates several graphs and reports in one window:

```julia
; freq += (Random Uniform() - .5) / 20;
phase += (Random Uniform() - .5) / 10;
tf << Reshow;
Wait( .05 );
);
```

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
win = New Window( "Platform Example",
    Outline Box( "Analyses of height in Big Class.jmp",
        H List Box(
            cc = Control Chart(
                Chart Col( Height, "Individual Measurement", "Moving Range" ),
                K Sigma( 3 )
            ),
            dist = Distribution( Columns( Height ) )
        )
    )
);
```
Now you can work with the window by sending messages to the reference `csp`. This is a display box reference, whose capabilities are similar to those of a `Report` for a platform. You can use multiple-argument subscripting to locate specific items within the outline tree:

```
csp["Control ?", "moving range ?"] << Close;
csp["Dist?", "quantiles"] << Close;
```

Notice that the preceding script not only assigned the whole window to a reference (`csp`) but also assigned the platform launch scripts to names (`cc` and `dist`) within their display boxes. This makes it easy to route messages to the platforms. You could, in turn, get the reports for these and have yet another way to manipulate display boxes. The following are equivalent messages that reopen the nodes:

```
rcc = cc << Report;
rdist = dist << Report;
rcc["moving range ?"] << Close;
rdist["quantiles"] << Close;
```
You can send messages directly to the platform references themselves. Find out your options by searching for “Distribution” and “Control Chart” in the JMP Scripting Index. For example, Control Chart provides a message called Needle that creates a needle chart. Distribution provides a message called Normal Quantile Plot.

To execute these options from JSL, send them as messages to the platform references:

```julia
cc << Needle;
dist << Normal Quantile Plot;
```

**Figure 11.23 Changing a Custom Report**

A dashboard is a visual tool that lets you run and present reports on a regular basis. You can show reports, data filters, selection filters, data tables, and graphics on a dashboard. The content shown on the dashboard is updated when you open the dashboard.

In the report window, reports appear in tab page boxes. You reposition reports by clicking the tab title and dragging the tab page to a highlighted drop zone. The highlighted drop zones

**Examples of Creating a Dashboard from Two Reports**

A dashboard is a visual tool that lets you run and present reports on a regular basis. You can show reports, data filters, selection filters, data tables, and graphics on a dashboard. The content shown on the dashboard is updated when you open the dashboard.

In the report window, reports appear in tab page boxes. You reposition reports by clicking the tab title and dragging the tab page to a highlighted drop zone. The highlighted drop zones
indicate how to arrange reports horizontally, vertically, or in tabs. If a valid drop zone is not selected, the box returns to its original location.

In JMP, you create dashboards in Dashboard Builder. See the Extend JMP chapter in Using JMP for details. This section shows how to write scripts to create dashboards.

**Dashboard with One Row of Reports**

This example shows how to write a script that creates a dashboard with two reports in a row:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
New Window( "My Dashboard",
  H Splitter Box( // place reports in a splitter box
    Size( 700, 400 ),
    Tab Page Box( // place report in a tab page box
      "Bivariate Fit of weight by height",
      dt << Bivariate( // Bivariate report
        Y( :weight ),
        X( :height ),
        Fit Line,
        Report View( "Summary" ) // show only the graph
      ),
      <<Moveable( 1 ) // make the report moveable
    ),
    Tab Page Box( // place report in a tab page box
      "Oneway Analysis of height by sex",
      dt << Oneway( // Oneway report
        Y( :height ),
        X( :sex ),
        Means( 1 ),
        Mean Diamonds( 1 ),
        Report View( "Summary" )
      ),
      <<Moveable( 1 )
    ),
    // each tab box can be dragged to a different location
    // required for moveable display boxes */
    <<Dockable( 1 )
  )
)
```


Figure 11.24 Dashboard with Two Reports

![Dashboard with Two Reports]

Note: For dockable and moveable tabs that contain a single platform, the top-level outline box is subsumed into the tab title. This means that the red triangle options now appear in the title bar of the tabs.

Dashboard with Tabs

The following script creates a dashboard that places each report on a tab:

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
New Window( "My Dashboard",
    Tab Box( // place reports in a tab box
        Tab Page Box( // place report in a tab page box
            "Bivariate Fit of weight by height",
            dt << Bivariate( // Bivariate report
                Y( :weight ),
                X( :height ),
                Fit Line,
                Report View( "Summary" ) // show only the graph
            ),
            <<Moveable( 1 ), // make the report moveable
            <<Closeable( 1 ) // make the report closeable
        ),
        Tab Page Box(
            "Oneway Analysis of height by sex",
            dt << Oneway( // Oneway report
                Y( :height ),
                X( :sex ),
                Means( 1 ),
            )
        )
    )
)
```
Mean Diamonds(1),
Report View("Summary")
),
<<Moveable(1),
<<Closeable(1)
),
<<Dockable(1),
/* each tab box can be dragged to a different location required for moveable display boxes */
<<Set Overflow Enabled(0) // both tab pages appear
);

Figure 11.25 Dashboard with Tabs

In a dashboard with several tabs, the window widens to show all tabbed reports. You might want to show only the first report and then let the user select the other tabbed reports from a list. Change Set Overflow Enabled(0) near the end of the script to Set Overflow Enabled(1). Figure 11.26 shows the result.
How to Dock Tabs in Tab Boxes

A docking layout is a collection of `Tab Page Box()` objects and docking containers that enable reports to be rearranged. In the report window, you drag a docked tab to a highlighted drop zone to create a new layout. Figure 11.24 shows two docked reports. In Figure 11.27, the Distribution report was dragged to the highlighted drop zone to display the reports in one column.
You combine `Tab Box()` with `Splitter Box()` to create docked tabs. Tab boxes and splitter boxes must directly contain other docking containers or the tab pages that define the content. Note the stacked boxes from a portion of the preceding example:

```plaintext
    H Splitter Box( // place reports in a splitter box
        Size( 700, 400 ),
        Tab Page Box( // place report in a tab page box
```
The following expressions specify that the tab box and splitter box are docking containers, within which tab pages can be docked:

```
Tab Box << Set Dockable();
Splitter Box << Set Dockable();
```

In the report window, you reposition tab pages by clicking the tab title and dragging the tab page to a highlighted drop zone. The highlighted drop zones indicate how to arrange reports horizontally, vertically, or in tabs. If a valid drop zone is not selected, the box returns to its original location.

**Closing Tabs**

The following expression creates a close button to the right of the report title on a closeable tab page:

```
Tab Page Box << Set Closeable();
```

Clicking the close button deletes the tab and its contents. Parent containers might also be removed if they are no longer necessary (for example, if there are no more tabs in a tab box or only a single child in a splitter box).

Use the `Tab Page Box << Set Close()` message to run a JSL script when the close button is clicked. A return value of “1” indicates that the tab is closed. A return value of “0” indicates that closing the tab is not allowed at that time. Closing the tab might not be allowed as the result of a user prompt or based on the state of the program.

**Controlling Wide Tabs**

When a docking layout includes tab page boxes, you may place many pages in a single `Tab Box()` container. In this case, the titles may become wider than the actual content or wider than desired in the overall display. The `Tab Box << Set Overflow Enabled( 0|1 )` message specifies that the tab titles should not cause the tab box to grow wider. If the titles do not all fit, a pop-up button appears in the upper right corner of the tab box to select tabs that are in the “overflow list”. See Figure 11.26 on page 494 for an example.

### Example of Creating a Cluster Platform Launch Window

The following example creates a simplified replica of the Cluster platform launch window, which then launches the platform with the given arguments.

*Note:* Some functions (Recall and Help) are not implemented in the script, so an alert window is shown when the Recall and Help button are clicked. In addition, switching from Hierarchical to K-Means clustering does not change anything, unlike the real Cluster launch window.

```javascript
dt = Open( "$SAMPLE_DATA/Birth Death.jmp" );
```
nc = N Col( dt ); // number of columns in the window
lbWidth = 130; // width of the window
// define the method list
notImplemented = Expr(
   win = New Window( "Feature Not Implemented Yet", <<Modal, Button Box( "OK" )
 );
)
clusterDlg = New Window( "Clustering", // create the window
   <<Modal,
   Border Box( Left( 3 ), Top( 2 ),
      V List Box( Text Box( "Finding points that are close, have similar values" ),
         H List Box( V List Box( Panel Box( "Select Columns",
            colListData = Col List Box( All,
               width( lbWidth ),
               NLines( Min( nc, 10 ) )
        )
    ),
    Panel Box( "Options",
        V List Box( comboObj = Combo Box( {"Hierarchical", "K-Means"},
               <<Set( 1 )
        ),
          Panel Box( "Method",
             methodObj = Radio Box( methodList, <<Set( 3 )
        ),
          checkObj = Check Box( {"Standardize Data"}, <<Set( 1, 1 )
        )
    )
  )
),
  Panel Box( "Cast Selected Columns into Roles",
      Line Up Box( N Col( 2 ), Spacing( 3 ),
         Button Box( "Y, Columns",
            colListY << Append( colListData << GetSelected )
        ),
        colListY = Col List Box( width( lbWidth ),
               NLines( 5 ),
               "numeric"
    ),
    Button Box( "Ordering",}
colListO << Append( colListData << GetSelected )
),
collistO = Col List Box( width( lbWidth ), NLlines( 1 ), "numeric" ),
Button Box( "Label",
collistL << Append( colListData << GetSelected ) ),
collistL = Col List Box( width( lbWidth ), NLlines( 1 ) ),
Button Box( "By",
collistB << Append( colListData << GetSelected ) ),
collistB = Col List Box( width( lbWidth ), NLlines( 1 ) )
),
Panel Box( "Action",
Line Up Box( N Col( 1 ) ),
Button Box( "OK",
If( (comboObj << Get) == 1,
Hierarchical Cluster(
  Y( Eval( collistY << GetItems ) ),
  Order( Eval( collistO << GetItems ) ),
  Label( Eval( collistL << GetItems ) ),
  By( Eval( collistB << GetItems ) ),
  Method( methodList[methodObj << Get] ),
  Standardize( checkObj << Get( 1 ) )
),
KMeansCluster( Y( collistY << GetItems ) )
);
clusterDlg << Close Window;
),
Button Box( "Cancel", clusterDlg << Close Window ),
Text Box( " " ),
Button Box( "Remove",
collistY << RemoveSelected;
collistO << RemoveSelected;
collistL << RemoveSelected;
collistB << RemoveSelected;
),
Button Box( "Recall", notImplemented ),
Button Box( "Help", notImplemented )
)
Example of Constructing a Custom Platform

An example in “Manipulating Expressions” on page 230 in the “Programming Methods” chapter, showed how to use the Substitute Into() function to input coefficients for a quadratic polynomial into the quadratic formula and then use the formula to calculate the roots of the polynomial. That example required specifying the coefficients as arguments to Substitute Into().

The section “Construct a Column Dialog” on page 504 shows an example to collect coefficients from the user using a modal dialog box.

This section further develops the example into a complete customized platform that first displays a dialog box to ask for coefficients, finds the roots, and then displays the results along with a graph in a custom window.

```plaintext
myCoeffs = New Window( "Find the roots for the equation",
// create a window to collect coefficients from the user
<<Modal,
H List Box(
    a = Number Edit Box( 1 ),
    Text Box( "*x^2 + " ),
    b = Number Edit Box( 2 ),
    Text Box( "*x + " ),
    c = Number Edit Box( 1 ),
    Text Box( " = 0" )
),
Button Box( "OK", 
```
a = a << Get;
b = b << Get;
c = c << Get;
    Show( a, b, c );
),
    Button Box( "Cancel" )
);

x = {Expr(
    (-b + Sqrt( b ^ 2 - 4 * a * c )) / (2 * a)
), Expr(
    (-b - Sqrt( b ^ 2 - 4 * a * c )) / (2 * a)
)};
/* calculate the results: The quadratic formula is
    x=(-b + - sqrt(b^2 - 4ac))/2a. Plug the coefficients into
the quadratic formula */
xx = Eval Expr( x );
// store the solution list
results = Expr(
/* test whether real roots were found and make an appropriate display
    if yes (for example, with the window's defaults), show roots and a graph */
    xmin = xx[1] - 5;
xmax = xx[2] + 5;
ymin = -20;
ymax = 20;
win = New Window( "The roots of a quadratic function",
    V List Box(
        Text Box( "The real roots for the equation " ),
        Text Box( " " || Expr( po ) || " = 0 " ),
        H List Box( Text Box( "are x=" ), Text Box( xxx ) ),
        Text Box( " " ), // to get a blank line
        Graph Box(
            Frame Size( 200, 200 ),
            X Scale( xmin, xmax ),
            Y Scale( ymin, ymax ),
            Line Style( 2 ),
            H Line( 0 ),
            Line Style( 0 ),
            Y Function( polynomial, x ),
            Line Style( 3 ),
            Pen Color( 3 ),
            V Line( xx[1] ),
            V Line( xx[2] ),
            Marker Size( 2 ),
            Marker( 0, {xx[1], 0}, {xx[2], 0} )
    )
);
error = Expr
/* if no (for example, with a=3, b=4, c=5), put up an error
window with a helpful graph */
win = New Window( "Error",
V List Box(
    Text Box( " " ),
    Text Box( " Polynomial " || po || " has no real roots. " ),
    Text Box( " " ),
    Text Box( "Examine a graph of the function to get an idea why." ),
    Graph Box(
        Frame Size( 200, 200 ),
        X Scale( -20, 20 ),
        Y Scale( -20, 20 ),
        Line Style( 2 ),
        H Line( 0 ),
        Line Style( 0 ),
        Y Function( polynomial, x )
    )
)
)
);
polynomial = Expr( a * x ^ 2 + b * x + c );
// either way, the script needs to have some strings ready
// rewrite the polynomial with the coefficients specified
po = Char( Eval Expr( polynomial ) );
// store this instance of the polynomial as a string:

xxx = Char( Eval Expr( x ) );
//Store the solution list as a string

error,
    results
);

When you run the preceding script, you first see a window like this:

**Figure 11.29** A Custom Platform Launch Window
Clicking **OK**, displays a results window (Figure 11.30, left), with either the roots or an error message. Rerun the script, input 5, 4, and 5 respectively and click **OK**. Note that JMP displays an error message (Figure 11.30, right).

**Figure 11.30** The Custom Platform’s Report

![Graphs showing real roots and polynomial roots](image)

**Modal Windows**

*Modal* means that the user must interact with the window immediately. Clicking outside the window produces an error sound. Script execution stops until the user responds to the window.

JMP provides two types of modal window functions:

- New Window() with the *Modal* message. This creates a new window in which you arrange other display boxes.
- Column Dialog() constructs a window for column role assignments as found in many launch windows. The specialized constructors for Column Dialog() mean that you have less flexibility than with New Window(). However, Column Dialog() lets you easily create a launch window.

**Construct a Modal Window**

When you submit a script with a modal window, JMP draws the window, waits for the user to make choices and click **OK**, and then stores a list of the variables with their values. Any attempt to click outside the window produces an error sound, and script execution is suspended until the user clicks **OK** or **Cancel**.

The Column Dialog() function is specifically intended to prompt users to choose columns from the current (topmost) data table. Windows created by Column Dialog() are also modal windows.
A few tips for using modal windows in scripts:

1. Put all the modal windows near the beginning of the script, if possible. This way, all the user interaction can be accomplished at once, and then users can leave JMP to finish its work unattended.

2. Make sure your modal windows give the user enough information. Do not just present a number field. Tell users how the number is used. If there are limits for valid responses, say so.

A very simple modal window might request a value for one variable:

```julia
win = New Window( "Set a Value",
    <<Modal,
        Text Box( "Set this value" ),
        variablebox = Number Edit Box( 42 ),
        Button Box( "OK" ),
        Button Box( "Cancel" )
    );
```

Notice that the argument to `Number Edit Box()` is the default value, 42.

**Figure 11.31** Sample Modal Display Box

If you click **OK**, the window closes and `{Button(1)}` is returned. To get the value entered in the box, use the `Return Result` message and a subscript into the window. Note that the deprecated `Dialog()` returns the list of variable assignments the same way.

```julia
win = New Window( "Set a Value",
    <<Modal,
        <<Return Result,
            Text Box( "Set this value" ),
            variablebox = Number Edit Box( 42 ),
            Button Box( "OK" ),
            Button Box( "Cancel" )
    );

Write( win["variablebox"] );
// create a subscript to the variablebox variable
```

In this example, the user typed 33 in the number edit box. That value is stored in `win`.

If you click **Cancel**, the window closes, it returns `{Button(-1)}`, and the script continues.
To detect whether the user clicked Cancel, add the following expression:

```julia
If( win["Button"] == 1,
    Print( win["variablebox"] );
, Print("Canceled")
);
```

**Note:** Modal windows require at least one button for dismissing the window. You can use **OK**, **Yes**, **No**, or **Cancel** to label modal window buttons. If you do not include at least one of these buttons in a modal window, JMP adds an **OK** button.

### Construct a Column Dialog

`Column Dialog()`, a variant of the deprecated `Dialog()` function, lets you prompt for column selections from the current data table or contextual data table. The **OK**, **Cancel**, and **Remove** buttons and the list of columns to choose from the data table are added automatically.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dlg = Column Dialog(
    Col ID = Col List( "X, Treatment", Max Col( 1 ) ),
    Group = Col List( "Group Factors" ),
    Split = Col List( "Y, Response" ),
    w = Col List( "Weight" ),
    H List( "Alpha", alpha = Edit Number( .05 ) )
);
```

**Figure 11.32** Column Dialog

The following example returns a list similar to this one, depending on the user’s choices:

```
{Col ID = {}, Group = {}, Split = {}, w = {}, alpha = 0.05, Button( -1 )}
```
For each destination list, a Col List clause must be a direct argument of Column Dialog() (not nested inside some other argument). An optional MaxCol(n) argument restricts the number of data columns that can be chosen to n. The resulting list contains the “name” list that is enclosed in parentheses. Lists are always returned, although they can sometimes be empty lists. You can include as many as twelve Col List clauses.

Other items permitted in the deprecated Dialog() are permitted in Column Dialog() and have the same functionality. You can specify the minimum and maximum number of columns that are allowed in a column dialog box with the MinCol and MaxCol arguments.

You can also specify the modeling type of the columns that are allowed to be selected (Ordinal, Nominal or Continuous). You can set the width of the list using Select List Width(pixels) argument. To set the width of the column list, use Width(pixels) inside the Col List() function.

The following example generates a column dialog box that only allows the selection of exactly one numeric column:

```java
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
rt_dlg = Column Dialog(
   cv = Col List( "Response To Test", MaxCol( 1 ), MinCol( 1 ), DataType( "Numeric" ) )
);
```

Figure 11.33  Restricting Selection of Columns

The Data Type choices are Numeric, Character, and RowState.

In addition, use the Columns specification to pre-fill some column selections. For example, the following script assigns height to the X role and weight and age to the Y role:

```java
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dlg = Column Dialog(
   xCols = Col List( "X, Factors", Columns( :height ) ),
   yCols = Col List( "Y, Response", Columns( :weight, :age ) )
);
```

Comparison of Column Dialog and New Window

New Window() and Column Dialog() enable you to construct a launch window that has a column selector. Use Column Dialog() to construct a simple launch window. Several items are
added automatically to column dialogs: the Remove and Cancel buttons, the list of columns, and an OK button (if no buttons are explicitly defined).

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dlg = Column Dialog(  
x = ColList( "X" ),  
y = ColList( "Y" )
);
```

New Window() is more flexible because of numerous optional arguments. In the following example, the user must select two columns before clicking the OK button. A Bivariate graph is then created. Validating the user’s selections is not possible in Column Dialog().

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
xvar = .;
yvar = .;
win = New Window( "Example of Returning Values",  
<<Modal,  
<<On Validate(  
// require the user to select two variables before clicking OK  
Show( xvar, yvar );  
If( Is Missing( xvar ) | Is Missing( yvar ),  
// if xvar or yvar are missing do nothing when OK is clicked  
0,  
1  
);  
),  
Text Box( " Select two numeric columns. " ),  
H List Box(  
Text Box( " X, Factor " ),  
x = Col List Box(    
dt, // data table reference    
all, // display all columns from the data table    
xvar = (x << Get Selected)[1];    
// get the name of the selected column before the window closes    
Show( xvar );  
),  
Text Box( "Y, Response" ),  
y = Col List Box(    
dt,    
all,    
yvar = (y << Get Selected)[1];    
Show( yvar );  
)  
);  
If (win["Button"] == 1, // if the user clicks OK...```
xcol = Column( dt, xvar ); // get the columns
ycol = Column( dt, yvar );
dt << Bivariate( Y( ycol ), X( xcol ) ); // create a Bivariate plot;

Constructors for Column Dialogs

Constructors such as **Edit Number()** and **Check Box()** can be used in column dialogs, which construct launch windows with a column selector. The following example shows a typical column dialog with an **Edit Number()** box:

```javascript
    dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
    Column Dialog(
        ex x = ColList( "X", Max Col( 1 ) ),
        HList( "Alpha",
            ex = Edit Number( .05 ) )
    );
```

Table 11.3 describes the column dialog constructors. Note the following:

- A column dialog automatically includes the list of columns in the data table.
- An OK button is automatically included if no buttons are defined.
- A column dialog also automatically includes OK, Cancel, and Remove buttons.

**Table 11.3** Column Dialog Constructors

<table>
<thead>
<tr>
<th>Constructor</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button</td>
<td>Button( &quot;OK&quot; ), Button( &quot;Cancel&quot; )</td>
<td>Draws an OK or a Cancel button. If OK is clicked, Button(1) is returned. If Cancel is clicked, Button(-1) is returned.</td>
</tr>
<tr>
<td>Check Box</td>
<td>var=Check Box( &quot;Text after box&quot;, &lt;1/0&gt; ) var( CheckBox( &quot;Text after box&quot;, &lt;1/0&gt; ) )</td>
<td>When OK is clicked, a selected check box assigns 1 to the variable. A check box that is not selected assigns 0 to the variable. Add an optional 1 for the check box to be selected (on), or 0 for it to be not selected (off) when the window first appears. The default value is 0 (off). Use var( Check Box( ... ) ) for Column Dialog().</td>
</tr>
</tbody>
</table>
Table 11.3 Column Dialog Constructors (Continued)

<table>
<thead>
<tr>
<th>Constructor</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Col List</td>
<td>( \text{var} = \text{Col List} \left( \text{&quot;role&quot;}, &lt;\text{MaxCol}( n )&gt;, &lt;\text{Datatype}( type )&gt; \right) )</td>
<td>Creates a selection destination with a \textit{role} button; the user’s choices are returned in a list item of the form ( \text{var} = {\text{choice 1, choice 2, ..., choice n}} ). You can specify the minimum and maximum number of columns using \text{MaxCol}( n ) or \text{MinCol}( n ). You can specify the required data type of the column using \text{Datatype}(type). The choices for type are Numeric, Character, or Rowstate.</td>
</tr>
<tr>
<td>Combo Box</td>
<td>( \text{var} = \text{Combo Box}( \text{&quot;choice1&quot;}, \text{&quot;choice2&quot;}, \ldots ) ) ( \text{var}( \text{ComboBox}( \text{&quot;choice1&quot;}, \text{&quot;choice2&quot;}, \ldots ) ) )</td>
<td>Produces a menu with the choices listed. The first choice is the default. Choices evaluate to quoted text strings. Choices can also be inside a list. Use \text{var}( \text{ComboBox}( \ldots ) ) for Column Dialog().</td>
</tr>
<tr>
<td>Edit Number</td>
<td>( \text{var} = \text{Edit Number}( \text{number} ) ) ( \text{var}( \text{Edit Number}( \text{number} ) ) )</td>
<td>Produces an edit field for a number with \textit{number} as the default value. When OK is clicked, the number entered in the field is assigned to the variable. Use \text{var}( \text{Edit Number}( \ldots ) ) for Column Dialog().</td>
</tr>
<tr>
<td>Edit Text</td>
<td>( \text{var} = \text{Edit Text}( \text{&quot;string&quot;}, &lt;\text{width}(x)&gt; ) ) ( \text{var}( \text{Edit Text}( \text{&quot;string&quot;}, &lt;\text{width}(x)&gt; ) ) )</td>
<td>Produces an edit field for a string with \textit{string} as the default value. You can also specify the minimum width of the box in pixels. The default width is 72 pixels. When OK is clicked, the text entered in the field is assigned to the variable. Use \text{var}( \text{Edit Text}( \ldots ) ) for Column Dialog().</td>
</tr>
<tr>
<td>HList</td>
<td>( \text{HList}( \text{item, item, ... } ) )</td>
<td>Top aligns and spaces the \textit{items} in a horizontal row. Placing a pair of \texttt{VLists} within an \texttt{HList} produces a top aligned, spaced pair of columns.</td>
</tr>
</tbody>
</table>
Even the script editor window is a display tree in JMP, which means you can write a JSL script to write and save another JSL script.

There is no `New Script()` function. Instead, to open a new script window, you use the `New Window()` function and then send it a message to tell it that it’s a script window:

```javascript
win = New Window( "title", <<Script, "Initial Contents" );
```

The last argument is optional. If you include a string, the new script window contains that string.

---

**Table 11.3 Column Dialog Constructors (Continued)**

<table>
<thead>
<tr>
<th>Constructor</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Up Box</td>
<td><code>Line Up Box( n, item_11, item_12, ..., item_In, ..., item_nn )</code></td>
<td>Lines up the <code>items</code> listed in <code>n</code> columns, where <code>item_ij</code> is the <code>jth</code> item of the <code>ith</code> row.</td>
</tr>
<tr>
<td>List Box</td>
<td><code>var=List Box( {&quot;item&quot;, &quot;item&quot;, ..., item}, width(50), max selected(2), NLines(6) )</code></td>
<td>Creates a display box that contains a list of items.</td>
</tr>
</tbody>
</table>
| Radio Buttons   | `var=Radio Buttons( "choice1", "choice2", ... )`                     | Produces a vertical, left-justified list of radio buttons with the choices specified. The first choice is the default. When OK is clicked, the button that is selected is assigned to the variable. Choices must evaluate to quoted text strings. Use `var( Radio Buttons( ... )` for `Column Dialog()`.
| string          | "string"                                                               | Draws text in the window. For example, can include a labeling string before an Edit Number field. All strings must be quoted. |
| VList           | `VList( item, item, ... )`                                            | Left aligns and spaces the `items` in a vertical column. Placing a pair of `HLists` within a `VList` produces a left-aligned, spaced pair of rows. |
In the New Window() example above, win is a reference to the display box that is the entire window. To write to a script window, you first need to get a reference to the part of the display box that you can write to, which is called a Script Box():

```
ed = win[Script Box( 1 )];
```

Using the reference ed, you can add text, remove text, and get the text that is already there.

```
ed << Get Text();
"Initial Contents"
```

Use the Set Text message to set all the text in the script window. The following message clears all text in the Script Window and then adds aaa=3; followed by a return:

```
ed << Set Text( "aaa=3;\n" );
```

Use the Append message to add additional text to the end of the script window.

```
ed << Append Text( "bbb=1/10;" );
ed << Append Text( "\nccc=4/100;" );
```

Use the Get Line Text message to get the text at the line of a specified line number. Use the Set Line Text message to replace a specified line of text with new text.

```
ed << Get Line Text( 2 );
ed << Set Line Text( 2, "bbb = 0.1;" );
```

Use the Get Line Count message to get the total number of lines in the script. The Get Lines message returns a list of each line in the script as a string.

```
ed << Get Line Count();
ed << Get Lines();
```

Use the Reformat message to automatically format a script for easier reading.

```
ed << Reformat();
```

Use the Save Text File message to save the script to a text file with a .jsl extension.

```
Save Text File( 
   "$DOCUMENTS/Example.txt",
   "The quick brown fox"
);
```

To run an entire script in a script window, use the Run message.

```
ed << Run();
```

To close the script window, send the window the Close Window message, just like you can do with any JMP window.

```
win << Close Window( nosave );
```
Convert Deprecated Dialog to New Window

Dialog() is deprecated and has been replaced with New Window() and the Modal message. Scripts based on Dialog() will not run in the future.

The following sections illustrate how to rewrite Dialog() scripts as New Window() scripts.

Comparison of New Window and the Deprecated Dialog

The following two examples produce identical windows using the preferred New Window() with the Modal argument and the deprecated Dialog() function. New Window() provides more display options and better control over the content and functions of the window.

New Window Example

The following example creates a window with multiple vertical and horizontal list boxes:

```plaintext
win = New Window( "New Window Example",
                  <<Modal,
                  <<ReturnResult, // ensures that you get the same result as with Dialog
                  V List Box(
                     V List Box( "Radio Frequency Embolism Projection" ),
                     Line Up Box(
                        NCol( 2 ),
                        Text Box( "Lower Spec Limit" ),
                        lsl_box = Number Edit Box( 230 ),
                        Text Box( "Upper Spec Limit" ),
                        usl_box = Number Edit Box( 340 ),
                        Text Box( "Threshold" ),
                        threshold_box = Number Edit Box( 275 )
                     ),
                     H List Box(
                        Panel Box( "Type of Radio",
                                   rb_box1 = Radio Box( {"RCA", "Matsushita", "Zenith", "Sony"} ) ),
                        Panel Box( "Type of Antenna",
                                   rb_box2 = Radio Box( {"Dish", "Helical", "Polarizing", "Radiant Array"} ) )
                     ),
                     cb_box1 = Check Box( "Emission Synchronization" ),
                     Text Box( "Title for plot" ),
                     title_box = Text Edit Box( "My projection" ),
                     H List Box( Text Box( "Quality" ),
                      cb_box2 = Combo Box( {"Fealty", "Loyalty", "Piety", "Obsequiousness"} )
                  )
```
Example of Deprecated Dialog

Compare the previous New Window() example to this example of the deprecated Dialog().

dlg = Dialog(
    Title( "Dialog Example" ),
    H List(  
        V List(  
            "Radio Frequency Embolism Projection",
            Lineup( 2,  
                "Lower Spec Limit", lsl = Edit Number( 230 ),
                "Upper Spec Limit", usl = Edit Number( 340 ),
                "Threshold", threshold = Edit Number( 275 )  
            ),
        ),  
    ),  
    V List(  
        "Type of Radio",
        type = Radio Buttons( "RCA", "Matsushita", "Zenith", "Sony" )  
    ),  
    V List(  
        "Type of Antenna",
        antenna = Radio Buttons( "Digital", "Analog" )  
    ),
    V List(  
        "Synchronizer",
        synch = Edit Box( "Ongoing" )  
    ),
    V List(  
        "Title",
        title = Edit Box( "default" )  
    ),
    V List(  
        "Quality",
        quality = Edit Box( "Medium" )  
    ),
    Button Box( "OK",
        lsl = lsl_box << Get;
        usl = usl_box << Get;
        threshold = threshold_box << Get;
        radio_type = rb_box1 << Get;
        antenna = rb_box2 << Get;
        synch = cb_box1 << Get;
        title = title_box << Get Text;
        quality = cb_box2 << Get;
    ),
    Button Box( "Cancel" )
)

If(win["Button"] == 1,
    // if the user clicks OK, show the selections in the log
    Show( "OK", lsl, usl, threshold, radio_type, antenna, synch, title, quality);
    Show( "Canceled" ); // if the user clicked Cancel, print "Canceled"
);
antenna = Radio Buttons( "Dish", "Helical", "Polarizing", "Radiant Array" )

),
synch = Check Box( "Emission Synchronization", 0 ),
"Title for plot",
title = Edit Text( "My projection" ),
H List(
   "Quality",
   quality = Combo Box( "Fealty", "Loyalty", "Piety", "Obsequiousness"
)
),
V List( Button( "OK" ), Button( "Cancel" )
)
);
If( dlg["Button"] == 1,
   Show(
      "OK",
      dlg["ls"],
      dlg["usl"],
      dlg["threshold"],
      dlg["type"],
      dlg["antenna"],
      dlg["synch"],
      dlg["title"],
      dlg["quality"]
   ),
   Show( "Canceled" )
);

Figure 11.34 Results from New Window (left) and the Deprecated Dialog (right)
Note: Use Return Result to get the same result in New Window() as with the deprecated Dialog(). See “Construct a Modal Window” on page 502 for an example.

Differences Between New Window and the Deprecated Dialog

This section shows the differences between display boxes in New Window() and the deprecated Dialog() scripts. Table 11.4 summarizes those differences. Details are in the sections that follow the table.

<table>
<thead>
<tr>
<th>Box Type</th>
<th>New Window</th>
<th>Deprecated Dialog</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Strings and Lists”</td>
<td>win = New Window( &quot;Combo Box&quot;, &lt;&lt;Modal, &lt;&lt;ReturnResult, cb = Combo Box( {&quot;True&quot;, &quot;False&quot;} ), )</td>
<td>Dialog( Title( &quot;Combo Box&quot; ), cb = Combo Box( &quot;True&quot;, &quot;False&quot; ), )</td>
</tr>
<tr>
<td>“List Boxes and Check Boxes”</td>
<td>win = New Window( &quot;H List Box&quot;, &lt;&lt;Modal, &lt;&lt;ReturnResult, H List Box( kb1 = Check Box( &quot;a&quot; ), kb2 = Check Box( &quot;b&quot; ), kb3 = Check Box( &quot;c&quot; ) ), )</td>
<td>dlg = Dialog( Title( &quot;H List&quot; ), H List( kb1 = Check Box( &quot;a&quot;, 0 ), kb2 = Check Box( &quot;b&quot;, 0 ), kb3 = Check Box( &quot;c&quot;, 0 ) ), )</td>
</tr>
<tr>
<td>“Line Up Items”</td>
<td>win = New Window( &quot;Line Up Box&quot;, &lt;&lt;Modal, &lt;&lt;ReturnResult, V List Box( Line Up Box(NCol(2), Text Box(&quot;Set this value&quot;), var1=Number Edit Box(42), Text Box(&quot;Set another value&quot;), var2=Number Edit Box(86), ), ), H List Box( Button Box( &quot;OK&quot; ), Button Box( &quot;Cancel&quot; ) ) ), // returns: {Button( 1 )}</td>
<td>dlg = Dialog( V List( Line Up(2, &quot;Set this value&quot;, variable=Edit Number(42), &quot;Set another value&quot;, var2=Edit Number(86)), H List(Button(&quot;OK&quot;), Button(&quot;Cancel&quot;)))); // returns: {variable = 42, var2 = 86, Button(1)}</td>
</tr>
</tbody>
</table>
Table 11.4 Display Boxes in New Window and Deprecated Dialog Scripts (Continued)

<table>
<thead>
<tr>
<th>Box Type</th>
<th>New Window</th>
<th>Deprecated Dialog</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Radio Boxes”</td>
<td>win = New Window( &quot;Radio Box&quot;, &lt;&lt;Modal, &lt;&lt;ReturnResult, Panel Box( &quot;Select&quot;, rbox = Radio Box( {&quot;a&quot;, &quot;b&quot;, &quot;c&quot;} ) ) )</td>
<td>dl = Dialog( Title(&quot;Radio Buttons&quot;), rb = Radio Buttons( {&quot;a&quot;, &quot;b&quot;, &quot;c&quot;} ) )</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Text Edit Boxes” on page 518 for the complete example.</td>
</tr>
<tr>
<td>“Text Edit Boxes”</td>
<td>win = New Window( &quot;Text Edit Box&quot;, &lt;&lt;Modal, &lt;&lt;ReturnResult, V List Box( Text Box( &quot;Strings&quot; ), str1 = Text Edit Box( &quot;The&quot; ), str2 = Text Edit Box( &quot;quick&quot; ) ) )</td>
<td>dl = Dialog( Title( &quot;Edit Text&quot; ), V List( &quot;Strings&quot;, str1 = Edit Text( &quot;The&quot; ), str2 = Edit Text( &quot;quick&quot; ) ) )</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Text Edit Boxes” on page 518 for complete examples.</td>
</tr>
<tr>
<td>“Number Edit Boxes”</td>
<td>win = New Window( &quot;Number Edit Box&quot;, &lt;&lt;Modal, &lt;&lt;ReturnResult, V List Box( Text Box(&quot;Random Numbers&quot;), num1 = Number Edit Box( Random Uniform() ), num2 = Number Edit Box( Random Uniform() * 10 ), ...);</td>
<td>dl = Dialog( Title( &quot;Edit Number&quot; ), V List( &quot;Random Numbers&quot;, num1 = Edit Number( Random Uniform() ), num2 = Edit Number( Random Uniform() * 10 ), ...);</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Number Edit Boxes” on page 519 for complete examples.</td>
</tr>
</tbody>
</table>

Strings and Lists

A major difference between the New Window() and the deprecated Dialog() functions is how you specify lists and strings as arguments. In New Window(), the items must be placed in a list.
In the deprecated `Dialog()`, items are generally separated by commas. For example, compare the following two instances of a combo box.

```julia
win = New Window( "Combo Box", // modal New Window
   <<Modal,
   <<Return Result,
   cb = Combo Box( {"True", "False"} ), // items are in a bracketed list
);

Dialog( Title( "Combo Box" ), // modal Dialog
   cb = Combo Box( "True", "False" ), // items are separated by commas
);
```

**Note:** The script does not explicitly define the OK button. For modal windows, JMP automatically adds the OK button. Explicitly define each additional button.

Additionally, the deprecated `Dialog()` could include " " to indicate empty text. `New Window()` requires that empty text appear in a Text Box (" ").

### List Boxes and Check Boxes

In `New Window()`, boxes are horizontally aligned with `H List Box()` and vertically aligned with `V List Box()`. In the deprecated `Dialog()`, you use `H List` and `V List` instead.

**Note:** Boxes are vertically aligned by default if `H List Box()` or `V List Box()` are omitted.

The following example creates a window with three horizontal check boxes and an OK button:

```julia
win = New Window( "H List Box",
   <<Modal,
   <<Return Result,
   H List Box(
      kb1 = Check Box( "a" ),
      kb2 = Check Box( "b" ),
      kb3 = Check Box( "c" )
   ),
);
```

Here is the same window created with the deprecated `Dialog()` and an `H List()`:

```julia
dlg = Dialog( Title( "H List" ),
   H List(
      kb1 = Check Box( "a", 0 ),
      kb2 = Check Box( "b", 0 ),
      kb3 = Check Box( "c", 0 )
   ),
);
```
Line Up Items

In `New Window()`, use `Line Up Box()` to arrange items in the number of columns that you specify. In the deprecated `Dialog()`, you used `Line Up`.

The following example arranges the text boxes in one column and the number edit boxes in another column:

```script
win = New Window( "Line Up Box",
    <<Modal,
    <<Return Result,
    V List Box(
        Lineup Box( N Col( 2 ),
            Text Box( "Set this value" ),
            var1 = Number Edit Box( 42 ),
            Text Box( "Set another value" ),
            var2 = Number Edit Box( 86 ),
        ),
    ),
    H List Box( Button Box( "OK" ), Button Box( "Cancel" ) )
);
```

Clicking `OK` returns the following result in the log window:

```
List( 3 elements ) assigned.
```

**Figure 11.35** Default Dialog Arrangements for Windows (left) and Macintosh (right)

Here's the same window created with the deprecated `Dialog()` and `Line Up`:

```script
dlg = Dialog(
    V List(
        Line Up( 2,
            "Set this value", variable = Edit Number( 42 ),
            "Set another value", var2 = Edit Number( 86 )
        ),
        H List( Button( "OK" ), Button( "Cancel" ) )
    );
```

Clicking `OK` returns the following result in the log window:

```
{variable = 42, var2 = 86, Button(1)}
```
Note: JMP does exert some control over OK and Cancel button positions to ensure that dialog boxes are consistent with what the operating system expects. In certain cases, JMP needs to override your `H List Box()`, `V List Box()`, and `Line Up Box()` settings for `Button( "OK" )` and `Button( "Cancel" )`. Do not be alarmed if the result is slightly different from what you expect.

Radio Boxes

Another difference between `New Window()` and the deprecated `Dialog()` is the usage of `Radio Box`.

In `New Window()`, you must define the `Panel Box()` container for `Radio Box()` if you want the radio buttons in a box.

```julia
win = New Window( "Radio Box",
    <<Modal,
    <<Return Result,
    Panel Box( "Select",
        rbox = Radio Box( {"a", "b", "c"} )
    )
);
```

In the deprecated `Dialog()`, the `Radio Buttons()` automatically appear in a panel box.

```julia
dlg = Dialog( Title( "Radio Buttons" ),
    rb = Radio Buttons( {"a", "b", "c"} ),
);
```

Text Edit Boxes

In `New Window()`, use `Text Edit Box()` to create editable boxes that contain specified strings.

In the deprecated `Dialog()`, you used `Edit Text()`.

```julia
win = New Window( "Text Edit Box",
    <<Modal,
    <<Return Result,
    V List Box(    
        Text Box( "Strings" ),
        str1 = Text Edit Box( "The" ),
        str2 = Text Edit Box( "quick" ),
        str3 = Text Edit Box( "brown" ),
        str4 = Text Edit Box( "fox" ),
        str5 = Text Edit Box( "jumps" ),
        str6 = Text Edit Box( "over" ),
        str7 = Text Edit Box( "the" ),
        str8 = Text Edit Box( "lazy" ),
        str9 = Text Edit Box( "dog" )
    )
);
```
Here is the same window created with the deprecated `Dialog()` and `Edit Text()`:

```scilab
dlg = Dialog(
    Title( "Edit Text" ),
    V List(
        "Strings",
        str1 = Edit Text( "The" ),
        str2 = Edit Text( "quick" ),
        str3 = Edit Text( "brown" ),
        str4 = Edit Text( "fox" ),
        str5 = Edit Text( "jumps" ),
        str6 = Edit Text( "over" ),
        str7 = Edit Text( "the" ),
        str8 = Edit Text( "lazy" ),
        str9 = Edit Text( "dog" )
    )
);

Alternatively, use `String Col Edit Box()` to create editable boxes within a table structure that contains specified strings. For example, the following script creates a window named "String Col Box". The window contains a column (labeled "Strings") of editable boxes, each of which contains the specified string:

```scilab
win = New Window( "String Col Edit Box",
    <<Modal,
    <<Return Result,
    steb = String Col Edit Box( "Strings",
        {"The", "quick", "brown", "fox", "jumps", "over", "the", "lazy", "dog"}
    )
);
```

**Note:** In the preceding example, the `String Col Edit Box()` assigns only two elements to the list. The `New Window()` and deprecated `Dialog()` examples for `Text Edit Box()` assign 10 elements to the list.

### Number Edit Boxes

In `New Window()`, use `Number Edit Box()` to create editable boxes that contain the specified numbers. In the deprecated `Dialog()`, you used `Edit Number()`.

```scilab
win = New Window( "Number Edit Box",
    <<Modal,
    <<ReturnResult,
    V List Box(
        Text Box( "Random Numbers" ),
        num1 = Number Edit Box( Random Uniform() )
    )
);
Here is the same window created with the deprecated `Dialog()` and `Edit Number()`:

```plaintext
dlg = Dialog(
    Title( "Edit Number" ),
    V List(
        "Random Numbers",
        num1 = Edit Number( Random Uniform() ),
        num2 = Edit Number( Random Uniform() * 10 ),
        num3 = Edit Number( Random Uniform() * 100 ),
        num4 = Edit Number( Random Uniform() * 1000 )
    ),
);
```

Another method for creating the same window uses `Number Col Edit Box()` to create editable boxes within in a table structure that contains specified numbers. For example, the following script creates a window named “Number Col Edit Box”. The window contains a column (labeled “Random Numbers”) of editable boxes, each of which shows the specified type of random number:

```plaintext
win = New Window( "Number Col Edit Box",
    <<Modal,
    <<ReturnResult,
    nceb = Number Col Edit Box(
        "Random Numbers",
        {num1 = Random Uniform(), num2 = Random Uniform() * 10, num3 = Random Uniform() * 100, num4 = Random Uniform() * 1000}
    ),
);
```

**Note:** In the preceding example, the `Number Col Edit Box()` assigns only two elements to the list. The `New Window()` and deprecated `Dialog()` examples for `Text Edit Box()` assign five elements to the list.

## Optional Scripts in New Window

One of the benefits of using `New Window()` is the ability to add optional scripts to display boxes. In the deprecated `Dialog()`, the following combo box could not include an optional script. If you wanted an action associated with any of the display box controls, you had to place a script as the control’s last argument. For example:

```plaintext
win = New Window( "Combo Box",
```
<<Modal,
<<ReturnResult,
comboObj = Combo Box(
    {"True", "False"},
    << Set( 1 ),
    Print( comboObj << Get )
);

When the user selects a different value, the selected item number (1 or 2 in this case, because there are two items in the combo box) is printed to the log.

Technical Details

Writing Tab Box and Tab Page Box Scripts

Tab Page Box() organizes the title and contents of the page in one display box. When Tab Page Box() is inside Tab Box(), a tabbed window with multiple tabbed pages appears. “Tab Box and Tab Page Box” on page 464 provides more information.

In previous versions of JMP, display boxes such as V List Box() contained tab contents. Consider the following script:

```julia
win = New Window( "Tab Box",
    tb = Tab Box(
        "First page", // name of the tab
        V List Box( // tab contents
            Text Box( "first line of first page" ),
            Text Box( "second line of first page" )
        ),
        "Second page", // name of the tab
        V List Box( // tab contents
            Text Box( "first line of second page" ),
            Text Box( "second line of second page" )
        )
    )
);
```

Beginning with JMP 13, we recommend that Tab Box() contain a Tab Page Box() for each tab. The preceding example is rewritten as follows:

```julia
win = New Window( "Tab Box",
    tb = Tab Box(
        Tab Page Box( // tab contents
            "First page of my tab box", // name of the tab
            Text Box( "first line of first page" )
        )
    )
);
When a tab page box is created or dragged outside a tab box, the tab page box is a stand-alone container. The title appears in a shaded box at the top of the page, similar to the title in Sheet Part(); the title does not appear in an interactive tab. “Dashboard with One Row of Reports” on page 491 provides an example.

**Tab Box and Tab Page Box Messages**

Some messages previously used for Tab Box() are deprecated. Their counterparts are compatible with Tab Page Box().

**Table 11.5 Deprecated Tab Box() Messages**

<table>
<thead>
<tr>
<th>Deprecated Tab Box Message</th>
<th>Current Tab Page Box Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Title and Set Title</td>
<td>Get Title and Title</td>
</tr>
<tr>
<td>Get Tip and Set Tip</td>
<td>Get Tip and Tip</td>
</tr>
<tr>
<td>Get Icon and Set Icon</td>
<td>Get Icon and Icon</td>
</tr>
<tr>
<td>Get Closeable and Set Closeable</td>
<td>Get Closeable and Closeable</td>
</tr>
</tbody>
</table>

See “Tab Box and Tab Page Box” on page 464 for more information about the two display boxes.
The JSL script for a graph contains expressions that create shapes and lines, apply fill patterns, assign background colors, and so on. You can also right-click a graph and select Customize to add the same expressions.

This chapter describes how to edit graphs interactively, create graphs, and create background maps. For information about scripting three-dimensional graphs, see the chapter “Three-Dimensional Scenes” on page 575.
Adding Scripts to Graphs

If you right-click on a graphics frame, you can enter or paste JSL commands. The script usually contains drawing commands that run in the context of the graphics frame. The context of the graphics frame includes the data range of the axes and the order that the data and scripts are drawn in.

The following example shows how to add a script to a graph:

1. Select Help > Sample Data Library and open Big Class.jmp.
2. Select Analyze > Fit Y by X.
3. Choose Weight for Y and Height for X, and then click OK.
4. Right-click inside the graph and select Customize.

Figure 12.1 Customizing the Graph Options

5. Click the Add button to add a new graphics script.
6. Type the following text and click OK.
   ```javascript
   Text( {55, 160}, "Hello World" );
   ```

Now the graph has a text element at the graph’s x-coordinate 55 and y-coordinate 160.
By default, graphics scripts appear on top of the data.

For example, add a new script in the Customize Graph window:

```
Fill Color( "Green" ); Rect( 57, 175, 65, 110, 1 );
```

A solid green rectangle appears. The list of scripts shows the order in which each script is drawn, so the first item on the list is drawn first. If you want the rectangle behind everything, move the rectangle script above the text script: select the rectangle script and click the up button $\uparrow$. If you want the rectangle on top of everything, select the rectangle script and click the down button $\downarrow$. You can arrange all the scripts in a graph into the drawing order that you prefer. Any new script is initially added directly after the item in the list that is selected.

**Tip:** To use a script that references a column name, use `Column( colname )` or a colon (`:colname`) to scope it properly.

**Hint:** To see the JSL for the above actions, select `Save Script > To Script Window` from the red triangle menu.

### Specify the Order of Graphical Elements

You can also add graphics elements using JSL instead of doing so interactively:

```
Frame Box <<Add Graphics Script(<("Back"|"Front") | <n>>, <"description">, script)
```

When you add graphical elements using JSL, they are drawn on top of whatever is already in the graph.

The optional `order` argument specifies in what order to draw the graphics element. `Order` can be the keyword `Back` or `Front` or an integer that specifies the drawing order for a number of graphics elements. For example, if you add an oval to a scatterplot, the oval is drawn on top of...
the markers. The keyword Back or 2 cause the oval to be drawn in the background. Front or 1 means the object is drawn first.

The optional Description argument is a string that appears in the Customize Graph window next to the graphics script.

To specify the drawing order for a number of graphics elements, use an integer for the order argument to determine where each is drawn in relation to the others. The following script first adds a blue oval and then a red oval in front of the blue oval. Both ovals are behind the points.

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
op = dt << Bivariate(
  X( :height ),
  Y( :weight ),
); Report( op )[Frame Box( 1 )] << Add Graphics Script(
  1, // draw the blue oval in the foreground
  Description( "Blue Oval" ),
  Fill Color( "Blue" );
  Oval( 60, 140, 65, 90, 1 );
);

Report( op )[Frame Box( 1 )] << Add Graphics Script(
  2, // draw the red oval in the background
  Description( "Red Oval" ),
  Fill Color( "Red" );
  Oval( 50, 120, 65, 100, 1 );
);
```

Figure 12.3 Specifying the Drawing Order
Copy and Paste Frame Contents or Settings

You can copy and paste the contents or the settings of a frame with these JSL commands:

\[
\text{obj << Copy Frame Contents} \quad \text{// contents such as a graph or line of fit} \\
\text{obj << Paste Frame Contents} \\
\text{obj << Copy Frame Settings} \quad \text{// settings such as background color} \\
\text{obj << Paste Frame Settings}
\]

The following example creates two Bivariate graphs, adds a line of fit to the first graph, and then copies and pastes the line to the second graph.

\[
\text{dt = Open( "SAMPLE\_DATA/Big Class.jmp" );} \\
\text{biv = dt << Bivariate( y( :weight ), x( :height ) );} \\
\text{rbiv1 = biv << Report; \quad \text{// create a report object}} \\
\text{rbiv2 = rbiv1 << Clone Box; \quad \text{// create a copy of the Bivariate graph}}
\]

\[
\text{rbiv1 << Append( rbiv2 );} \\
\text{// place the cloned box below the Bivariate graph} \\
\text{// to create a second Bivariate graph}
\]

\[
\text{framebox1 = rbiv1[Frame Box( 1 )]; \quad \text{// assign references to the reports' frame boxes}} \\
\text{framebox2 = rbiv2[Frame Box( 1 )];} \\
\text{biv << Fit Line; \quad \text{// fit a line to the first Bivariate graph}}
\]

\[
\text{framebox1 << Copy Frame Contents;} \\
\text{// copy the frame contents from framebox1}
\]

\[
\text{framebox2 << Paste Frame Contents;} \\
\text{// paste the frame contents to framebox2}
\]
The following example creates two Bivariate graphs, sets the background of the first graph to blue, and then copies and pastes the blue background setting to the second graph:

```julia
dt = Open( "SAMPLE_DATA/Big Class.jmp" );

biv1 = dt << Bivariate( y( :weight ), x( :height ) );
// create the first Bivariate graph
rbiv1 = biv1 << Report; // create a report object
rbiv2 = rbiv1 << Clone Box; // create a copy of the Bivariate graph

rbiv1 << Append( rbiv2 );
// place the cloned box below the Bivariate graph
// to create a second Bivariate graph

framebox1 = rbiv1[Frame Box( 1 )]; // assign a reference to the reports' frame boxes
framebox2 = rbiv2[Frame Box( 1 )];

framebox1 << Background Color( "Blue" );
// assign the background color to framebox1
```
Figure 12.5 Copying and Pasting the Background

Copy and Paste Histograms

The following example shows how to create two histograms and copy the second histogram into the first histogram. A platform will not save a pasted-in segment, so you’ll need to run a script like this to reproduce the graph.

```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dist = dt << Distribution(  
   SendToByGroup( {:sex == "F"} ),  
   Nominal Distribution( Column( :age ) ),  
   Histograms Only,  
   By( :sex ),  
   SendToByGroup(  
      framebox1 << Copy Frame Settings;  
      framebox2 << Paste Frame Settings;  
      // copy the frame settings from framebox1  
      // paste the frame settings to framebox2  
   )  
);```
{:sex == "M"},
SendToReport(
    Dispatch(
        {"Distributions sex=M", "age"},
        "Distrib Nom Hist",
        FrameBox,
        {DispatchSeg(
            Hist Seg( 1 ),
            Fill Color( "Light Yellow" ),
            // set the histogram color for males

        )
        )
    )
);

For( i = 2, i <= N Items( dist ), i++,
    Report( dist[i] )[FrameBox( 1 )] << Copy Frame Contents;
    // copy the the second histogram into the first histogram
    Report( dist[1] )[FrameBox( 1 )] << Paste Frame Contents;
);

New Window( "Distribution", Outline Box( "age", Report( dist[1] )[Picture Box( 1 )] ) );

**Figure 12.6** Pasted Histogram

**Interactively Copy and Paste Frame Contents and Settings**

To interactively copy and paste the frame settings, right-click the graph and select **Edit > Copy Frame Settings**. Right-click the frame to which you want to paste the settings and select **Edit > Paste Frame Settings**.
To interactively copy and paste the frame contents, right-click the graph and select **Edit > Copy Frame Contents**. Right-click the frame to which you want to paste the contents and select **Edit > Paste Frame Contents**.

### Create New Graphs from Scratch

Graphics scripts are set up inside the `Graph Box()` command within a `New Window()` command.

```plaintext
New Window("title", <arguments>, Graph Box( named arguments,..., script));
```

The following arguments are named arguments for `Graph Box()`:

- `Frame Size( horizontal, vertical )`, // size in pixels
- `X Scale( xmin, xmax )`, `Y Scale( ymin, ymax )`, // range of x and y axes
- `X Name( "x" )`, `Y Name( "y" )`, // names for x and y axes
- `Suppress Axes` // omit the axes

For example, `Graph Box()` accepts named arguments as shown in the following example, which creates a graph with a red background.

```plaintext
win = New Window( "Named arguments",
    Graph Box(
        Frame Size( 300, 300 ), // construct the graph box
        X Scale( 0, 190 ), // set the x-axis increments
        Y Scale( 0, 190 ), // set the y-axis increments
        X Name( "height" ),
        Y Name( "weight" ),
        <<Background Color( "Red" ) // sets the background color
    ));
```
Alternatively, you can use the send \<< operator to send commands to the Graph Box instead of using the named arguments. This example also creates a graph with a red background.

```plaintext
win = New Window( "Messages",
  Graph Box(
    \<<Frame Size( 300, 300 ),
    \<<XAxis( 0, 190 ),
    \<<YAxis( 0, 190 ),
    \<<Background Color( "Red" )
  )
);
```

**Customize Graphs**

You can also make changes to graphs in a script. For example, create a window with a graph, get a reference to the report, and then set the frame box size.

```plaintext
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( Y( :weight ), X( :height ), Fit Line );
rbiv = biv << Report;
rbiv[Frame Box( 1 )] << Frame Size( 400, 400 );
```

To see a list of possible messages for any given display box object, select Help > Scripting Index and select Display Boxes from the list. Running the Show Properties() command is an
alternative to using the Scripting Index. For example, here is a partial list of messages that you can send to an axis:

```julia
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
biv = dt << Bivariate( Y( :weight ), X( :height ), Fit Line );
riv = biv << Report;
Show Properties( riv[Axis Box( 1 )] );
   Axis Settings [Action](Bring up the Axis window to change various settings.)
   Revert Axis [Action](Restore the settings that this axis had originally.)
   Add Axis Label [Action]
   Remove Axis Label [Action]
...
```

The following expressions change the font of both axis labels (weight and height in the example above) to 12-point, italic Arial Black:

```julia
riv[Text Edit Box( 1 )] << Set Font( "Arial Black", 12, Italic );
riv[Text Edit Box( 2 )] << Set Font( "Arial Black", 12, Italic );
or
riv[Text Edit Box( 1 )] << Set Font( "Arial Black" );
riv[Text Edit Box( 1 )] << Set Font Style( "Italic" );
riv[Text Edit Box( 1 )] << Set Font Size( 12 );
riv[Text Edit Box( 2 )] << Set Font( "Arial Black" );
riv[Text Edit Box( 2 )] << Set Font Style( "Italic" );
riv[Text Edit Box( 2 )] << Set Font Size( 12 );
```

The default font specified in the Preferences is applied if the font is not installed on the computer.

---

**Graph Elements**

You can use the following commands inside `Graph Box()` statements. This chapter focuses on the JSL that is specific to graphing, but you can also use general script commands such as `For` and `While`. Note that general script commands such as `For` and `While` are not appropriate inside platforms or `New Window()` functions.

**Plot Functions**

A `Y Function()` function is used to draw smooth functions. The first argument is the expression to be plotted. The second argument is the name of the X variable in the expression.

```julia
win = New Window( "Sine Function",
   Graph Box(   Frame Size( 200, 100 ),
               X Scale( -10, 10 ),
               Y Scale( -1, 1 ),
```
X Name( "x" ),
Y Name( "Sine(x)" ),
Y Function( Sine( x ), x ) );

Figure 12.8 Sine Wave

You can use For to overlap several sine waves:

win = New Window( "Overlapping Sine Waves",
Graph Box(
    Frame Size( 200, 100 ),
    X Scale( -10, 10 ),
    Y Scale( -1, 1 ),
    For( i = 1, i <= 4, i += .1,
        Y Function( Sine( x / i ), x )
    )
);)

Figure 12.9 Overlapping Sine Waves

Similarly, X Function() is for drawing a graph where the symbol is varied on the Y variable.

win = New Window( "Overlapping Sine Waves",
Graph Box(
    Frame Size( 100, 200 ),
    X Scale( -1, 1 ),
    Y Scale( -10, 10 ),
    For( i = 1, i <= 4, i += .2,
        X Function( Sine( y / i ), y )
    )
);)
Figure 12.10 Overlapping Sine Waves along the X-Axis

An XY Function() draws a smooth curve using a pair of formulas (parametric equations) that depend on a third variable. The third variable’s value is incremented from a minimum value to a maximum value to generate the X-Y pairs.

```
win = New Window("Spiral",
    Graph Box(
        Pen Color( "red" ); // red line color
        xCenter = 50; // location of the center of the curve on the x axis
        yCenter = 50; // location of the center of the curve on the y axis
        minAngle = 0;
        maxAngle = Pi() * 2 * 20;
        XY Function(
            xCenter + ((ta / 3) * Cos( ta )),
            yCenter + ((ta / 3) * Sin( ta )),
            ta,
            Min( minAngle ),
            Max( maxAngle ),
            Inc( Pi() / 100 )
        )
    ));
```

In this example, Sin() and Cos() use ta as an argument (rotates) and as a factor (expands). (Sin() and Cos() use radians, not degrees.)
Figure 12.11  Spiral Parametric Plot

Contour Function() is an analogous way to represent a three-dimensional function in a two-dimensional space. The final argument specifies the value(s) for the contour line(s). The argument can be a value, an indexed range of values using ::, or a matrix of values.

```plaintext
win = New Window( "Bird's eye view of the egg carton function", 
    Graph Box( 
        Frame Size( 300, 300 ),
        X Scale( -10, 10 ),
        Y Scale( -10, 10 ),
        Pen Color( "black" );
        Pen Size( 2 );
        Contour Function( Sine( y ) + Cosine( x ), x, y, (0 :: 20) / 5 );
        Pen Color( "red" );
        Pen Size( 1 );
        Contour Function( Sine( y ) + Cosine( x ), x, y, (-20 :: 0) / 5 );
    )
);
```
Normal Contour() draws normal probability contours for \( k \) populations and two variables. The first argument is a scalar probability or a matrix of probability values for the contours. Subsequent arguments are matrices to specify means, standard deviations, and correlations. The mean and standard deviation matrices have dimension \( k \times 2 \). The correlation matrix should be \( k \times 1 \), where the first row pertains to the first contour, the second row to the second contour, and so on. The first column is for \( x \) and the second column for \( y \). Consider the following example:

\[
\text{Normal Contour}(
\begin{array}{c}
\text{prob1,}
\text{prob2,}
\text{prob3, ...],}
\text{xmean1 ymean1,}
\text{xmean2 ymean2,}
\text{xmean3 ymean3, ...],}
\text{xsd1 ysd1,}
\text{xsd2 ysd2,}
\text{xsd3 ysd3, ...],}
\text{xcorr1,}
\text{xcorr2,}
\text{xcorr3, ...]);
\end{array}
\]

The following script draws contours at probabilities 0.1, 0.5, 0.7, and 0.99 for two populations and two variables. The first population has \( x \) mean 0 and \( y \) mean 1, with standard deviation 0.3 along the \( x \) axis and 0.6 along the \( y \)-axis, and with correlation 0.5. The second has \( x \) mean 4 and \( y \) mean 6, with standard deviation 0.8 along the \( x \) axis and 0.4 along the \( y \)-axis, and with correlation 0.9.

\[
\text{win = New Window( "Normal Contours",}
\text{Graph Box(}
\text{\ldots})
\text{))}
\]
X Scale( -5, 10 ),
Y Scale( -5, 10 ),
Normal Contour( [.1, .5, .7, .99], [0 1 4 6], [.3 .6, .8 .4], [.5, .9] )
);

Figure 12.13 Normal Contour Function

Normal Contour() is a general way to accomplish effects such as Bivariate’s density ellipses. The Bivariate script in the Football.jmp sample data creates an example.

Gradient Function

Gradient Function() fills a set of rectangles on a grid according to a color determined by the expression value as it crosses a range corresponding to a range of colors.

Gradient Function( expression, xname, yname, [zlow, zhight], ZColor( [colorLow, colorHigh] ), <XGrid( min, max, incr )>, <YGrid( min, max, incr )>, <Transparency( t )>);

To implement Gradient Function(), use the following syntax:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>expression</td>
<td>the expression to be contoured, which is a function in terms of the two variables that follow</td>
</tr>
<tr>
<td>xname, yname,</td>
<td>the two variable names used in the expression</td>
</tr>
<tr>
<td>[zlow, zhight]</td>
<td>the low and high expression values the gradient is scaled between</td>
</tr>
<tr>
<td>ZColor([colorLow, colorHigh])</td>
<td>the colors that correspond to the low value and the high value</td>
</tr>
</tbody>
</table>
The `ZColor()` values must be numeric codes rather than names. You can use the color menu indices (such as 0=black, 1=grey, 2=white, 3=red, 4=green, and 5=blue) found in “Specify Colors” on page 554.

The following example uses `Gradient Function()` to create two animated graphs.

```plaintext
phase = 0.7;
win = New Window( "Gradient Function",
  a = Graph(
    Frame Size( 400, 400 ),
    X Scale( -5, 5 ),
    Y Scale( -5, 5 ),
    Gradient Function(
      phase * Sine( x ) * Sine( y ) + (1 - phase) * Cosine( x ) * Cosine( y ),
      x,
      y,
      [-1 1],
      zcolor( [0, 2] )
    ),
  )
);
b = a[FrameBox( 1 )];
For( i = 1, i <= 5, i++,
  For( phase = 0, phase < 1, phase += 0.05,
    b << Reshow;
    Wait( 0.01 );
  );
  For( phase = 1, phase > 0, phase -= 0.05,
    b << Reshow;
    Wait( 0.01 );
  );
);
```

optional specification for the grid of values

```plaintext
<XGrid(min, max, incr),>
<YGrid(min, max, incr)> );
```
Get the Properties of a Graphics Frame

Several functions are useful for getting properties of an existing graphics frame:

- **H Size**  Returns the horizontal size of the graphics frame in pixels.
- **V Size**  Returns the vertical size of the graphics frame in pixels.
- **X Origin**  Returns the x-value for the left edge of the graphics frame.
- **X Range**  Returns the distance from the left to right edges of a display box.
- **Y Origin**  Returns the y-value for the bottom edge of the graphics frame.
- **Y Range**  Returns the distance from the bottom to top edges of a display box.

In the following expressions, the first line calculates the right edge. The second line calculates the top edge.

```plaintext
Oval(
    ...,
    rightEdge = X Origin() + X Range();
    topEdge = Y Origin() + Y Range();
);
```

Add a Legend

To add a legend to a graph, send the `Row Legend` message to the frame box. In the `Row Legend` message, specify which column you want to base the legend on and whether the legend affects colors and markers.
For example, using Big Class.jmp, submit the following JSL to turn on a legend based on the age column. Set both colors and markers by values in the age column.

```julia
dt = Open( "$SAMPLEDATA/Big Class.jmp" );
biv = dt << Bivariate( y( :height ), x( :weight ) );
rbiv = biv << Report;
framebox = rbiv[Frame Box( 1 )];
framebox << Row Legend( "age", Color( 1 ), Marker( 1 ) );
// make a legend with the "age" title
// display colors and markers in the legend
```

The Color() and Marker() arguments are optional. Colors are on and markers are off by default.

To use a continuous scale if your variable is nominal or ordinal, you can use a continuous color theme with the Continuous Scale( 1 ).

```julia
dt = Open( "$SAMPLEDATA/Big Class.jmp" );
biv = dt << Bivariate( y( :weight ), x( :height ) );
rbiv = biv << Report;
framebox = rbiv[Frame Box( 1 )];
framebox << Row Legend( "age", Color( 1 ), Continuous Scale( 1 ) );
```

To interactively add a legend, right-click the graph, select Row Legend, and change the column settings.

---

**Add Lines, Arrows, Points, Shapes, and Text**

**Draw Lines**

Line() draws lines between points.

```julia
win = New Window( "Five-Point Star",

  Graph Box( 
    Frame Size( 300, 300 ),
    X Scale( -1.1, 1.1 ),
    Y Scale( -1.1, 1.1 ),
    Line( 
      {Cos( 1 * Pi() / 10 ), Sin( 1 * Pi() / 10 )},
      {Cos( 9 * Pi() / 10 ), Sin( 9 * Pi() / 10 )},
      {Cos( 17 * Pi() / 10 ), Sin( 17 * Pi() / 10 )},
      {Cos( 5 * Pi() / 10 ), Sin( 5 * Pi() / 10 )},
      {Cos( 13 * Pi() / 10 ), Sin( 13 * Pi() / 10 )},
      {Cos( 1 * Pi() / 10 ), Sin( 1 * Pi() / 10 )}
    )
  )
);
```
You can either specify the points in two-item lists as demonstrated above or as matrices of $x$ and then $y$ coordinates. Matrices are flattened by rows. You can use either row or column vectors, as long as you have the same number of elements in each matrix. The following expressions have the same effect:

```
Line( {1,2}, {3,0}, {2,4} ); // several {x,y} lists
Line( [1 3 2],[2 0 4] ); // row vectors
Line( [1,3,2], [2,0,4] ); // column vectors
Line( [1 3 2], [2,0,4] ); // one of each
```

The star example could also be drawn this way. Note that the script must include the full `Matrix( {...} )` notation rather than `[ ]` shorthand because the entries are expressions. The following example uses the `Matrix()` function.

```
win = New Window( "Five-Point Star",
    Graph Box( 
        Frame Size( 300, 300 ),
        X Scale( -1.1, 1.1 ),
        Y Scale( -1.1, 1.1 ),
        Line( 
            Matrix(
                { // the x coordinates
                Cos( 1 * Pi() / 10 ), Cos( 9 * Pi() / 10 ), Cos( 17 * Pi() / 10 ),
                Cos( 5 * Pi() / 10 ), Cos( 13 * Pi() / 10 ), Cos( 1 * Pi() / 10 )
            ),
            Matrix(
                { // the y coordinates
                Sin( 1 * Pi() / 10 ), Sin( 9 * Pi() / 10 ), Sin( 17 * Pi() / 10 ),
                Sin( 5 * Pi() / 10 ), Sin( 13 * Pi() / 10 ), Sin( 1 * Pi() / 10 )
            }
        )
    )
);```
HLine() draws a horizontal line across the graph at the $y$-value that you specify. Similarly, VLine() draws a vertical line down the graph at the $x$-value that you specify. Both functions support drawing multiple lines by using a matrix of values in the $y$ argument. See “Mousetrap()” on page 568 for details.

**Draw Arrows**

Arrow() draws an arrow from the first point to the second point. The default arrowhead is scaled to 1 plus the square root of the length of the arrow. To set the length of the arrowhead, add an optional first argument, specifying the length of the arrowhead in pixels. The following example draws simple arrows.

```plaintext
win = New Window( "Arrowheads",
    Graph Box( 
        Pen Size( 4 );
        Arrow( 20, [10 30 90], [88 22 44] );
        // matrix 1 defines an arrow from 10, 88 to 
        // 30, 22 (the y coordinates)
        // matrix 2 defines an arrow that starts at the end of line 1
        // and ends at 90, 44 (the x coordinates)
    )
);```

The following example draws arrows in a circular pattern.

```plaintext
win = New Window( "Hurricane",
    Graph Box( 
        Frame Size( 100, 100 ),
        X Scale( -100, 100 ),
        Y Scale( -100, 100 ),
        For( r = 35, r < 100, r += 20,
            ainc = 2 * Pi() * 3 / r;
            For( a = 0, a < 2 * Pi(), a += ainc,
                x = r * Cosine( a );
                y = r * Sine( a );
                aa = a + ainc * 45 / r;
                rr = r - r / 6;
                x2 = rr * Cosine( aa );
                y2 = rr * Sine( aa );
                Arrow( {x, y}, {x2, y2} );
                // list 1 defines the coordinates for the first arrow
                // list 2 defines the coordinates for the second arrow
            )
        )
    )
);```
Figure 12.16 Drawing Arrows

The following example compares drawing with a specified length (19 pixels) and drawing with the default arrow head size.

```
win = New Window( "Arrowheads", 
    Graph Box( 
        Frame Size( 300, 300 ),
        X Scale( 0, 100 ),
        Y Scale( 0, 220 ),
        x = 10;
        y1 = 10;
        y2 = y1 + 10;
        For( i = 1, i < 10, i++,
            Pen Color( "Red" );
            Arrow( {x, y1}, {x, y2} );
            y2 += 10;
            y1 += 100;
            y2 += 100;
            Pen Color( "Blue" );
            Arrow( 20, {x, y1}, {x, y2} );
            x += 10;
            y1 -= 100;
            y2 -= 100;
            Text Color( "Red" );
            Text( {10, 80}, "Without Length Arg" );
            Text Color( "Blue" );
            Text( {10, 200}, "With Length Arg" );
        )
    )
);```
As with \texttt{Line()}, you can either specify the points in two-item lists as demonstrated above or as matrices of $x$ and then $y$ coordinates.

**Draw Markers**

\texttt{Marker()} draws a marker of the type that you specify (1–15) in the first argument at the point that you specify in the second argument. \texttt{Marker Size()} scales markers from 0 to 6 (dot to XXXL). To set markers to the size that is specified in the Preferences, use a value of -1.

```plaintext
ymax = 20;
win = New Window( "Markers",  
    Graph Box(  
        Frame Size( 300, 400 ),  
        X Scale( -2, ymax - 5 ),  
        Y Scale( -2, ymax + 3 ),  
        For( j = 1, j < 7, j++,  
            Marker Size( j );  
            For( i = 0, i < (ymax + 1), i++,  
                Marker( i, \{ j * 2, i \} );  
                Text( \{0, i\}, i );  
                Text( \{ j * 2, ymax + 2 \}, j );  
            )
        )
    )
);```
You can also include a row state argument before, after, or instead of the marker ID argument. By using `Combine States()`, you can set multiple row states inside `Marker()`. Try substituting each of the following lines in the preceding script:

```plaintext
Marker( i, Color State( i ), {j * 2, i} );
Marker( Color State( i ), i, {j * 2, i} );
Marker(
    Combine States( Color State( i ), Marker State( i ), Hidden State( i ) ),
    {j * 2, i}
);
```

As with `Line()` and `Arrow()`, you can also specify points as matrices of x and then y coordinates.

### Draw Pies and Arcs

`Pie()` and `Arc()` draw wedges and arc segments. The first four arguments are `x1, y1, x2,` and `y2`, the coordinates of the rectangle to inscribe. The last two arguments are the starting and ending angle in degrees, where 0 degrees is 12 o'clock and the arc or slice is drawn clockwise from start to finish.

```plaintext
win = New Window( "Pies and Arcs",
    Graph Box(
        Frame Size( 400, 400 ),
        X Scale( 0, 9 ),
        Y Scale( 0, 9 ),
    
```
Fill Color( "Black" ), // top left
Pie( 1.1, 7.9, 3.9, 5.1, 45, 270 ),
Text( Erased, {1.75, 6}, "1,8,4,5,45,270" ),
Arc( 1, 8, 4, 5, 280, 35 ),
Fill Color( "Red" ), // top right
Pie( 7.9, 7.9, 5.1, 5.1, 270, 360 ),
Text( Erased, {5.75, 6}, "8,8,5,5,270,360" ),
Arc( 8, 8, 5, 5, 370, 260 ),
Fill Color( "BlueCyan" ), // bottom left
Pie( 1.1, 1.1, 3.9, 3.9, 50, 360 ),
Text( Erased, {1.75, 2}, "1,1,4,4,50,360" ),
Arc( 1, 1, 4, 4, 370, 40 ),
Fill Color( "Purple" ), // bottom right
Pie( 7.9, 1.1, 5.1, 3.9, 270, 45 ),
Text( Erased, {5.75, 2}, "8,1,5,4,270,45" ),
Arc( 8, 1, 5, 4, 55, 260 )
);

Figure 12.19 Drawing Pies and Arcs
Draw Regular Shapes: Circles, Rectangles, and Ovals

Circles

Circle() draws a circle with the center point and radius given. Subsequent arguments specify additional radii.

```plaintext
win = New Window( "Circles",
    Graph Box( Frame Size( 200, 200 ),
        Circle( {50, 50}, 10, 12, 25 )
    )
);
```

Circle() also has a final optional argument, "fill". This string indicates that all circles defined in the function are filled with the current fill color. If "fill" is omitted, the circle is empty.

Figure 12.20 Drawing Circles

Note that a circle is always a circle, even if you resize the graph to a different aspect ratio. If you want your circle to change aspect ratios (in other words, cease being a circle) when the graph is resized, use an oval instead.

If you do not want your circle to resize if the graph is resized, specify the radius in pixels instead:

```plaintext
win = New Window( "Circles",
    Graph Box( Frame Size( 200, 200 ),
        Circle( {50, 50}, Pixel Radius( 10 ), Pixel Radius( 12 ), Pixel Radius( 25 )
    )
);
```

Rectangles

Rect() draws a rectangle from the diagonal coordinates you specify. The coordinates can be specified either as four arguments in order (left, top, right, bottom), or as a pair of lists ([left, top], [right, bottom]).

```
win = New Window( "Rectangles",
    Graph Box(
        Frame Size( 200, 200 ),
        Pen Color( 1 );
        Rect( 0, 40, 60, 0 );
        Pen Color( 3 );
        Rect( 10, 60, 70, 10 );
        Pen Color( 4 );
        Rect( 50, 90, 90, 50 );
        Pen Color( 5 );
        Rect( 0, 80, 70, 70 );
    )
);
```

Rect() has an optional fifth argument, fill. Specify 0 to get an unfilled rectangle and 1 to get a filled rectangle. The default value for fill is 0. The rectangle is filled with the current fill color.

Any negative fill argument produces an unfilled frame inset by one pixel:

```
win = New Window( "Framed Rectangle",
    Graph Box( Frame Size( 200, 200 ), Rect( 0, 40, 60, 0, -1 ) )
);
```

Ovals

Oval() draws an oval inside the rectangle given by its x1, y1, x2, and y2 arguments:

```
win = New Window( "Ovals",
    Graph Box( Frame Size( 200, 200 ),
        Pen Color( 1 );
        Oval( 0, 40, 60, 0 );
        Pen Color( 3 );
        Oval( 10, 60, 70, 10 );
        Pen Color( 4 );
        Oval( 50, 90, 90, 50 );
        Pen Color( 5 );
        Oval( 0, 80, 70, 70 );
    )
);
```
Oval() also has an optional fifth argument, fill. Specify 0 to get an unfilled rectangle and 1 to get a filled oval. The default value for fill is 0. The oval is filled with the current fill color.

Figure 12.21 shows rectangles and ovals, drawn both filled and unfilled. Notice that filled rectangles do not have outlines. Ovals do have outlines. If you want a filled rectangle with an outline, you must draw the filled rectangle and then draw an unfilled rectangle with the same coordinates.

Figure 12.21 Rectangles and Ovals, Unfilled and Filled

Draw Irregular Shapes: Polygons and Contours

Polygons

Polygon() works similarly to Line(). They both connect points, but Polygon() returns to the first point to close the polygon and filling the resulting area. You can specify the points as individual points in two-item lists (as shown in “Draw Markers” on page 545) or as matrices of x and then y coordinates. Matrices are flattened by rows, so you can use either row or column vectors, as long as you have the same number of elements in each matrix. First set up the matrices of points and then call them inside Polygon().

gCoordX = [25, 23.75, 22.5, 21.25, 21.25, 22.5, 23.75, 25.625, 27.5, 18.75, 12.5, 6.25, 2.5,
1.25, -1.25, 3.125, 6.25, 12.5, 18.75, 25, 29.375, 34.375, 37.5, 38.75, 40.625, 42.5, 43.125, 42.5, 41.25, 38.75, 43.75, 50, 56.25, 60.625, 63.75, 65.625, 62.5, 56.25, 50, 45, 37.5, 32.5, 28.75, 27.5, 26.25, 25.625, 25];
gCoordY = [-2, 2, 5, 10, 15, 20, 25, 30, 33, 34, 35, 37.5, 40, 41, 43.5, 41, 40, 39, 40, 42, 45, 50, 55, 60, 64, 60, 55, 50, 47, 42, 43.5, 43, 42, 40, 38, 36, 37, 37, 36, 35, 30, 25, 20, 15, 10, 5, 2];
win = New Window( "The JMP Man",
    Graph Box(  
        Frame Size( 300, 300 ),  
        X Scale( -10, 80 ),  
        Y Scale( -10, 80 ),  
        Pen Color( "Black" );  
        Fill Color( "Blue" );  
        Polygon( gCoordX, gCoordY );  
        Fill Color( "Black" );  
        Circle( {18, 58}, 9, "FILL" );
    )
);

Figure 12.22 Drawing a Polygon

A related command, In Polygon(), tells whether a given point falls inside the specified polygon. This code checks some points from the JMP man pictured in Figure 12.22:

    In Polygon( 0,60, Gcoordx,Gcoordy );  // return 0
    In Polygon( 30,38, Gcoordx,Gcoordy );  // return 1
You can add `In Polygon()` to the JMP man script. Run the following script, and then click various locations in the picture and watch the log window. “In” and “out” are printed to the log when you click the body.

```javascript
var gCoordX = [25, 23.75, 22.5, 21.25, 21.25, 22.5, 23.75, 25.625, 27.5, 18.75,
              12.5, 6.25, 2.5, 1.25, -1.25, 3.125, 6.25, 12.5, 18.75, 25, 29.375, 34.375,
              37.5, 38.75, 40.625, 42.5, 43.125, 42.5, 41.25, 38.75, 43.75, 50, 56.25,
              60.625, 63.75, 65.625, 62.5, 56.25, 50, 45, 37.5, 32.5, 28.75, 27.5, 26.25,
              25.625, 25];
var gCoordY = [-2, 2, 5, 10, 15, 20, 25, 30, 33, 34, 35, 37.5, 40, 41, 43.5, 41,
              40, 39, 40, 42, 45, 50, 55, 60, 64, 60, 55, 50, 47, 42, 43.5, 43, 42, 40,
              38, 36, 37, 36, 35, 30, 25, 20, 15, 10, 5, 2];
var win = New Window( "The JMP Man",
  Graph Box(
    Frame Size( 300, 300 ),
    X Scale( -10, 80 ),
    Y Scale( -10, 80 ),
    Pen Color( "Black" );
    Fill Color( "Black" );
    Polygon( gCoordX, gCoordY );
    Mousetrap(
      {}
      Print( If( In Polygon( x, y, gCoordX, gCoordY ), "in", "out" ) )
    )
  ));
```

### Contours

`Contour()` draws contour lines using a grid of coordinates.

```javascript
Contour( xVector, yVector, zGridMatrix, zContour, <zColors> );
```

Suppose that you have an \( n \) by \( m \) matrix \( z\text{GridMatrix} \) of values on some surface (defined across the \( n \) values of \( x\text{Vector} \) by the \( m \) values of \( y\text{Vector} \)). \( \text{Contour()} \) draws the contour lines that are defined by the values in \( z\text{Contour} \) in the colors defined by \( z\text{Colors} \). Here is an example:

```javascript
x = (-10 :: 10) / 5;
y = (-12 :: 12) / 5;
grid = J( 21, 25, 0 );
z = [-.75, -.5, -.25, 0, .25, .5, .75];
zcolor = [3, 4, 5, 6, 7, 8, 9];
For( i = 1, i <= 21, i++,
  For( j = 1, j <= 25, j++,
    grid[i, j] = Sin( (x[i]) ^ 2 + (y[j]) ^ 2 )
  )
);
Show( grid );
win = New Window( "Hat",
    Graph Box(
        X Scale( -2, 2 ),
        Y Scale( -2.4, 2.4 ),
        Contour( x, y, grid, z, zcolor )
    )
);

Figure 12.23 Drawing Contour Lines

Add Text

You can use Text() to draw text at a given location.

    Text( <properties>, ( {x, y}|{left, bottom, right, top} ), "text" );

The point and text can be in any order and repeated. You can precede the point and text with an optional first argument: Center Justified, Right Justified, Erased, Boxed, Counterclockwise, or Clockwise. Erased is for removing whatever would otherwise obscure the text in a graph. It paints a background-colored rectangle behind the text.

In the following example, notice how the erased text appears inside a white box over the green Rect().

    mytext = New Window( "Adding Text",
        Graph Box(
            Frame Size( 200, 200 ),
            Y Scale( 0, 15 ),
            X Scale( 0, 10 ),
            Text Size( 9 );
            Text Color( "blue" );
            Text( {5, 1}, "Left Justified" );
            Text( Center Justified, {5, 2}, "Center Justified" );
            Text( Right Justified, {5, 3}, "Right Justified" );
    );
Fill Color( 4 );
Rect( 5, 8, 9, 5, 1 );
Text( Erased, {6, 6}, "Erased" );
Text( Boxed, {6, 10}, "Boxed" );
Text( Clockwise, {4, 10}, "Clockwise" );
Text( Counterclockwise, {3, 5}, "Counterclockwise" );
)
);

Figure 12.24 Drawing Text in a Graph Box

There is a variant of the Text() function that draws a string inside the rectangle that is specified by four coordinates. The syntax is as follows:

Text( {left, top, right, bottom}, string);

Specify Colors

Five commands control colors.

- Fill Color() for solid areas
- Pen Color() for lines and points
- Back Color() for the background of text (similar to the box around the erased text in Figure 12.24)
- Background Color() for the graph’s background color
- Font Color() for added text

Fill colors overwrite pen colors for drawn shapes. You do not get both, as in some drawing packages. To get both a fill and a pen line, draw two shapes, one with fill and one without. You can select a color with a single numeric argument, a color name in quotation marks, or an RGB value. The standard colors are specified with numbers 0–15 (both 0 and 15 are black) or by their names (Table 12.1).
### Table 12.1 Standard JMP Colors

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Black</td>
</tr>
<tr>
<td>1</td>
<td>Gray</td>
</tr>
<tr>
<td>2</td>
<td>White</td>
</tr>
<tr>
<td>3</td>
<td>Red</td>
</tr>
<tr>
<td>4</td>
<td>Green</td>
</tr>
<tr>
<td>5</td>
<td>Blue</td>
</tr>
<tr>
<td>6</td>
<td>Orange</td>
</tr>
<tr>
<td>7</td>
<td>BlueGreen</td>
</tr>
<tr>
<td>8</td>
<td>Purple</td>
</tr>
<tr>
<td>9</td>
<td>Yellow</td>
</tr>
<tr>
<td>10</td>
<td>Cyan</td>
</tr>
<tr>
<td>11</td>
<td>Magenta</td>
</tr>
<tr>
<td>12</td>
<td>YellowGreen</td>
</tr>
<tr>
<td>13</td>
<td>BlueCyan</td>
</tr>
<tr>
<td>14</td>
<td>Fuchsia</td>
</tr>
</tbody>
</table>

The following script creates a graph that shows all JMP colors:

```javascript
ymax = 15;
win = New Window( "The JMP Colors",
    Graph Box(
        Frame Size( 300, 300 ),
        X Scale( 0, ymax ),
        Y Scale( 0, ymax + 2 ),
        For( i = 0, i < ymax, i++,
            If( colors[i + 1] == "White",
                Fill Color( 65 );
                Rect( 0, i + 1 + .5, 15, i + 1 - .5, 1 );
            );
            Pen Color( colors[i + 1] );
            Text Color( colors[i + 1] );
        )
    )
);
```
Larger numbers cycle through shading variations of the same color sequence. A script demonstrating this appears under “Colors and Markers” on page 362 in the “Data Tables” chapter. Values outside the range 0–84 are not accepted.

**Table 12.2** How Numbers Map to Colors

<table>
<thead>
<tr>
<th>Number</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>16–31</td>
<td>dark shades</td>
</tr>
<tr>
<td>32–47</td>
<td>light shades</td>
</tr>
<tr>
<td>48–63</td>
<td>very dark shades</td>
</tr>
<tr>
<td>64–79</td>
<td>very light shades</td>
</tr>
<tr>
<td>80–84</td>
<td>shades of gray, light to dark</td>
</tr>
</tbody>
</table>

If you prefer to use RGB values, create a list with the fraction for each color in red, green, and blue order.

```plaintext
Pen Color( {0.38, .84, .67} ); // teal
```

RGB Color() and Color to RGB() convert color values between JMP color numbers and the red-green-blue system. The following example finds the RGB values for JMP color 3 (red):

```plaintext
Color to RGB( 3 );
{0.941176470588235, 0.196078431372549, 0.274509803921569}
```

Likewise, HLS Color() and Color to HLS() convert color values between JMP color numbers and the hue-lightness-saturation system.

```plaintext
win = New Window( "Color Wheel",
  Graph( 
    Frame Size( 200, 200 ),
    For( hue = 0, hue < 360, hue += 30,
      y = 50 - 40 * Cos( hue * 2 * Pi() / 360 );
      x = 50 + 40 * Sin( hue * 2 * Pi() / 360 );
      Fill Color( HLS Color( hue / 360, 0.5, 1 ) );
      Oval( x - 10, y - 10, x + 10, y + 10, 1 );
    )
  )
)
```
Finally, `Heat Color()` returns the JMP color that corresponds to a value in any color theme that is supported by Cell Plot, Treemap, and so on. The syntax is:

```plaintext
Heat Color( n, <<"theme" )
```

The theme message is optional, and the default value is "Blue to Gray to Red". You can specify any color theme, including custom color themes. You can also create and use an anonymous color theme as shown in the following examples:

```plaintext
Heat Color( z, <<{""}, {{1, 1, 0}, {0, 0, 1}} } );
Heat Color( z, <<{""}, {blue, green, yellow} } );
```

### Specify Transparency

In a graphics environment (like a Frame Box), use the `Transparency` function to set the level of transparency. The argument, alpha, can be any number between zero and one. The value 0 means clear and drawing has no effect. The value 1 means completely opaque and is the usual drawing mode. Intermediate values build semi-transparent color layers on top of what has already been drawn below it. The following example script illustrates transparency with rectangles.

```plaintext
win = New Window( "Transparency",
    Graph Box(
        Frame Size( 200, 200 ),
        Pen Color( "gray" );
        Fill Color( "gray" );
        Transparency( 0.25 );
        Rect( 0, 40, 60, 0, 1 );

        Pen Color( "red" );
        Fill Color( "red" );
        Transparency( 0.5 );
        Rect( 10, 60, 70, 10, 1 );

        Pen Color( "green" );
        Fill Color( "green" );
        Transparency( 0.75 );
        Rect( 50, 90, 90, 50, 1 );

        Pen Color( "blue" );
        Fill Color( "blue" );
        Transparency( 1 );
        Rect( 0, 80, 70, 70, 1 );
    )
)
```

);
Add Fill Patterns

Fill Pattern() sets the pattern for filled areas.

Matrix Example

Specify a mask (a matrix of values between 0 and 1) or an image. Each value in the matrix creates a pixel.

```
win = New Window( "Example", 
    Graph Box( 
        Fill Pattern( 
            [1 0.5 0 0, 0.5 0 0 1, 0 0 1 0.5, 0 1 0.5 0] 
        ); 
        Polygon( [10 30 90], [88 22 44] );
    )
);
```

Named Pattern Example

Specify a name in quotation marks that corresponds to a pattern shown in Table 12.3.

```
win = New Window( "Named Pattern Example", 
    Graph Box( 
        Fill Pattern( "vertical light" ); 
        Polygon( [10 30 90], [88 22 44] );
    )
);
```

Graphic Example

Specify an image in quotation marks. If the image is not installed on the viewer’s computer, question marks appear in the shape.

```
win = New Window( "Graphic Example", 
    Graph Box( 
        Fill Pattern( "vertical light" ); 
        Polygon( [10 30 90], [88 22 44] );
    )
);
Graph Box(
    Fill Pattern( Open( "$SAMPLE_IMAGES/pi.gif", "gif" ) );
    Polygon( [10 30 90], [88 22 44] );
);

Table 12.3  Fill Patterns

<table>
<thead>
<tr>
<th>Pattern Name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>left slant light</td>
<td><img src="image1.png" alt="Pattern" /></td>
</tr>
<tr>
<td>right slant light</td>
<td><img src="image2.png" alt="Pattern" /></td>
</tr>
<tr>
<td>vertical light</td>
<td><img src="image3.png" alt="Pattern" /></td>
</tr>
<tr>
<td>horizontal light</td>
<td><img src="image4.png" alt="Pattern" /></td>
</tr>
<tr>
<td>grid light</td>
<td><img src="image5.png" alt="Pattern" /></td>
</tr>
<tr>
<td>hatch light</td>
<td><img src="image6.png" alt="Pattern" /></td>
</tr>
<tr>
<td>h wave light</td>
<td><img src="image7.png" alt="Pattern" /></td>
</tr>
<tr>
<td>v wave light</td>
<td><img src="image8.png" alt="Pattern" /></td>
</tr>
<tr>
<td>hollow circle</td>
<td><img src="image9.png" alt="Pattern" /></td>
</tr>
<tr>
<td>left slant medium</td>
<td><img src="image10.png" alt="Pattern" /></td>
</tr>
<tr>
<td>right slant medium</td>
<td><img src="image11.png" alt="Pattern" /></td>
</tr>
<tr>
<td>vertical medium</td>
<td><img src="image12.png" alt="Pattern" /></td>
</tr>
<tr>
<td>horizontal medium</td>
<td><img src="image13.png" alt="Pattern" /></td>
</tr>
</tbody>
</table>
Table 12.3 Fill Patterns (Continued)

<table>
<thead>
<tr>
<th>Pattern Name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>grid medium</td>
<td><img src="image" alt="grid medium" /></td>
</tr>
<tr>
<td>hatch medium</td>
<td><img src="image" alt="hatch medium" /></td>
</tr>
<tr>
<td>h wave medium</td>
<td><img src="image" alt="h wave medium" /></td>
</tr>
<tr>
<td>v wave medium</td>
<td><img src="image" alt="v wave medium" /></td>
</tr>
<tr>
<td>filled circle</td>
<td><img src="image" alt="filled circle" /></td>
</tr>
<tr>
<td>left slant heavy</td>
<td><img src="image" alt="left slant heavy" /></td>
</tr>
<tr>
<td>right slant heavy</td>
<td><img src="image" alt="right slant heavy" /></td>
</tr>
<tr>
<td>vertical heavy</td>
<td><img src="image" alt="vertical heavy" /></td>
</tr>
<tr>
<td>horizontal heavy</td>
<td><img src="image" alt="horizontal heavy" /></td>
</tr>
<tr>
<td>grid heavy</td>
<td><img src="image" alt="grid heavy" /></td>
</tr>
<tr>
<td>hatch heavy</td>
<td><img src="image" alt="hatch heavy" /></td>
</tr>
<tr>
<td>h wave heavy</td>
<td><img src="image" alt="h wave heavy" /></td>
</tr>
<tr>
<td>v wave heavy</td>
<td><img src="image" alt="v wave heavy" /></td>
</tr>
<tr>
<td>diamond</td>
<td><img src="image" alt="diamond" /></td>
</tr>
<tr>
<td>left slant heavy b</td>
<td><img src="image" alt="left slant heavy b" /></td>
</tr>
</tbody>
</table>
## Table 12.3 Fill Patterns (Continued)

<table>
<thead>
<tr>
<th>Pattern Name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>right slant heavy b</td>
<td><img src="image1" alt="Pattern" /></td>
</tr>
<tr>
<td>random</td>
<td><img src="image2" alt="Pattern" /></td>
</tr>
<tr>
<td>square</td>
<td><img src="image3" alt="Pattern" /></td>
</tr>
<tr>
<td>square offset</td>
<td><img src="image4" alt="Pattern" /></td>
</tr>
<tr>
<td>wide</td>
<td><img src="image5" alt="Pattern" /></td>
</tr>
<tr>
<td>tall</td>
<td><img src="image6" alt="Pattern" /></td>
</tr>
<tr>
<td>checkerboard</td>
<td><img src="image7" alt="Pattern" /></td>
</tr>
<tr>
<td>grid dots</td>
<td><img src="image8" alt="Pattern" /></td>
</tr>
<tr>
<td>triangle up</td>
<td><img src="image9" alt="Pattern" /></td>
</tr>
<tr>
<td>triangle down</td>
<td><img src="image10" alt="Pattern" /></td>
</tr>
<tr>
<td>triangle left</td>
<td><img src="image11" alt="Pattern" /></td>
</tr>
<tr>
<td>triangle right</td>
<td><img src="image12" alt="Pattern" /></td>
</tr>
<tr>
<td>weave light</td>
<td><img src="image13" alt="Pattern" /></td>
</tr>
<tr>
<td>weave heavy</td>
<td><img src="image14" alt="Pattern" /></td>
</tr>
<tr>
<td>honeycomb</td>
<td><img src="image15" alt="Pattern" /></td>
</tr>
</tbody>
</table>
Specify Line Types

You can also control Line Style() by number (0–4) or name (Solid, Dotted, Dashed, DashDot, DashDotDot). Figure 12.26 shows the numerical values for each line type.

```
linestyles = {"Solid", "Dotted", "Dashed", "DashDot", "DashDotDot"};
win = New Window( "Line Styles",
    Graph Box(
        Frame Size( 200, 200 ),
        X Scale( -1, 5 ),
        Y Scale( -1, 5 ),
        For( i = 0, i < 5, i++,
            Line Style( i );
            H Line( i );
            Text( {0, i + .1}, i );
            Text( {1, i + .1}, linestyles[i + 1] );
        )
    ));
```

Figure 12.26  Line Styles

To control the thickness of lines, set a Pen Size and specify the line width in pixels. The default is 1 for single-pixel lines. For printing, think of Pen Size as a multiplier for the default line width, which varies according to your printing device.

```
win = New Window( "Pen Size",
    Graph Box(
        Pen Size( 2 ); // double-width lines
        Line( [10 30 90], [88 22 44] );
    ));
```
Draw with Pixels

You can also draw using pixel coordinates. First, set the Pixel Origin() in terms of graph coordinates, and then use Pixel Move To() or Pixel Line To() in pixel coordinates relative to that origin. The main use for Pixel() functions is for drawing custom markers that do not vary with the size or scale of the graph. You can store a marker in a script and then call it within any graph. This example uses Function() to store pixel commands in a script with its own arguments, x and y.

```plaintext
ballotBox = Function( {x, y},
    Pixel Origin( x, y );
    Pixel Move To( -5, -5 );
    Pixel Line To( -5, 5 );
    Pixel Line To( 5, -5 );
    Pixel Line To( -5, -5 );
    Pixel Line To( 5, 5 );
    Pixel Line To( -5, 5 );
    Pixel Move To( 5, 5 );
    Pixel Line To( 5, -5 );
);
win = New Window( "Custom Markers",
    Graph Box( 
        Frame Size( 200, 200 ),
        ballotBox( 10, 10 );
        ballotBox( 15, 90 );
        ballotBox( 20, 50 );
        ballotBox( 80, 50 );
        ballotBox( 60, 70 );
    )
);
```

Figure 12.27  Drawing Custom Markers
Interactive Graphs

Handle() and Mousetrap() are functions for making interactive graphs that respond to clicking and dragging. Handle() lets you parametrize a graph by adding a handle-marker that can be dragged around with the mouse, executing the graph’s script at each new location. Mousetrap() is similar, but it takes its arguments from the coordinates of a click without dragging a handle. The main difference is that Handle() only catches mousedowns at the handle-marker’s location, but Mousetrap() catches mousedowns at any location.

Another approach is to place buttons or slider controls outside the graph with Button Box(), Slider Box(), or Global Box().

Handle()

Handle() places a marker at the coordinates given by the initial values of the first two arguments and draws the graph using the initial values of the arguments. You can then click and drag the marker to move the handle to a new location. The first script is executed at eachmousedown to update the graph dynamically, according to the new coordinates of the handle. The second script (optional, and not used here) is executed at each mouseup, similarly; see the example for “Mousetrap()” on page 568.

```javascript
// Normal Density
mu = 0;
sigma = 1;
rsqrt2pi = 1 / Sqrt( 2 * Pi() );
win = New Window( "Normal Density", 
   Graph Box( 
      Frame Size( 500, 300 ),
      X Scale( -3, 3 ),
      Y Scale( 0, 1 ),
      Y Function( Normal Density( (x - mu) / sigma ) / sigma, x );
      Handle( 
         mu,
         rsqrt2pi / sigma,
         mu = x;
         sigma = rsqrt2pi / y;
      );
      Text( {1, .7}, "mu ", mu, {1, .65}, "sigma ", sigma );
   )
);
```

Run demoPlotProb.jsl in the JMP Samples/Scripts folder to see Beta Density, Gamma Density, Weibull Density, and LogNormal Density graphs. The output for Normal Density is shown in Figure 12.28. Because we cannot show you the picture in motion, be sure to run this script yourself.
Figure 12.28  Normal Density Example for Handle()

To avoid errors, be sure to set the initial values of the handle’s coordinates, as in the first line of this example.

If you want to use some function of a handle’s coordinates, such as in the normal density example, you should adjust the arguments for Handle(). Otherwise, the handle marker would run away from the mouse.

```
    Y Function( a * x ^ b );
    Handle( a, b, a = 2 * x, b = y );
```

Suppose you drag the marker from its initial location to (3,4). The argument `a` is set to 6 and `b` to 4; the graph is redrawn as \( Y = 6x^4 \); and the handle is now drawn at (6,4), several units away from the mouse. To compensate, you would adjust the first argument to handle, for example.

```
    Handle( a / 2, b, a = 2 * x; b=y );
```

To generalize, suppose you define the Handle() arguments as functions of the handle’s \((x, y)\) coordinates. For example, \( a = f(x) \) and \( b = g(y) \). If \( f(x) = x \) and \( g(y) = y \), then you would specify simply \( a, b \) as the first two arguments. If not, you would solve \( a = f(x) \) for \( x \) and solve \( b = g(y) \) for \( y \) to get the appropriate arguments.

You can use other functions to constrain Handle(). For example, here is an interactive graph to demonstrate power functions that uses Round() to prevent bad exponents and to keep the intercepts simple.

```
a = 3;
b = 2;
win = New Window( "Intercepts and Powers",
    Graph Box( Frame Size( 200, 200 ),
    X Scale( -10, 10 ),
    Y Scale( -10, 10 ),
```

The code continues with the interactive graph details.
Y Function( Round( b ) + x ^ (Round( a )), x );
Handle(
    a,
    b,
    a = x;
    b = y;
);
Text( {a, b}, " Move me" );
Text( {-9, 9}, "y=", Round( b ), " + x^", Round( a ) );
);

Figure 12.29 Intercepts and Powers for Handle() 

Handle() and For() can be nested for complex graphs.

a = 5;
b = 5;
win = New Window( "Powers",
    Graph Box(
        Frame Size( 200, 200 ),
        X Scale( -10, 10 ),
        Y Scale( -10, 10 ),
        For( i = 0, i < 1.5, i += .2,
            Pen Color( 1 + 10 * i );
            Text Color( 1 + 10 * i );
            Y Function( i * x ^ Round( a ), x );
            Handle(
                a,
                b,
                a = x;
                b = y;
            );
            h = 9 - 10 * i;
            Text( {-9, h}, b, "*ix^", Round( a ), ", i=" , i );
        )
    )
);
Figure 12.30 Nested Handle() and For()

You can use more than one handle in a graph:

```plaintext
amplitude = 1;
freq = 1;
phase = 0;
win = New Window( "Sine Wave",
    Graph Box( 
        Frame Size( 500, 300 ),
        X Scale( -5, 5 ),
        Y Scale( -5, 5 ),
        Y Function( amplitude * Sine( x / freq + phase ), x );
        Handle( // first handle
            freq,
            amplitude,
            freq = x;
            amplitude = y;
        );
        Handle( phase, .5, phase = x ); // second handle
        Text( 
            {3, 4},
            "amplitude: ",
            Round( amplitude, 4 ),
            {3, 3.5},
            "frequency: ",
            Round( freq, 4 ),
            {3, 3},
            "phase: ",
            Round( phase, 4 )
        );
    )
);```

Mousetrap()

Mousetrap() takes arguments for a graph from the coordinates of a mouse click. The first script is executed after eachmousedown and the second script after each mouseup to update the graph dynamically, according to the new coordinates of the handle. As with Handle, it is important to set the initial values for the Mousetrap's coordinates. If you include both Mousetrap() and Handle() in a graph, put the Handle() before the Mousetrap(). Then Handle() has a chance to catch clicks before a Mousetrap() does.

This example uses both Mousetrap() and Handle() to draw a three-dimensional function centered on the Mousetrap() coordinates, where the single contour line takes its value from a Handle().

```plaintext
x0 = 0;
y0 = 0;
z0 = 0;
win = New Window( "Viewing a 3-D Function in Flatland",
  Graph Box(
    Frame Size( 300, 300 ),
    X Scale( -5, 5 ),
    Y Scale( -5, 5 ),
    Contour Function(
      Exp( -(x - x0) ^ 2 ) * Exp( -(y - y0) ^ 2 ) * (x - x0),
      x,
      y,
      z0 / 10
    ),
    Handle( -4.5, z0, z0 = Round( y * 10 ) / 10 );
    // get the z-cut values from a handle
    V Line( -4.5 ),
  )
);```

Figure 12.31 Two Handles
Text Size(9);
Text(
    Counterclockwise,
    {-4.6, -4},
    "Drag to set the z-value for contour cut: z = " || Char( z0 / 10 )
);
Marker Size(2);
Marker(2, {x0, y0});
Mousetrap( // set the origin to the click-point
    x0 = x;
    y0 = y;
);
Text(
    {-4.25, -4.9},
    "Click any location to set the function's centerpoint."
);
)

Note: Instead of setting x0 to x and y0 to y in the Mousetrap() expression, you might want to use Function( {xx, yy}, Show( xx, yy ); x0 = xx; y0 = yy ); xx and yy are formal parameters to the function. They come from arguments that the mousetrap passed when the user clicked on the graph. The Function( {xx, yy}...) alternative makes the xx and yy names explicit, and makes it clear the you can name them anything, not just x, y.

Figure 12.32  Mousetrap() and Handle()

You might use Mousetrap() to collect points in a data table, such as for visually interpolating points in a graph. The following example illustrates a script that could be adapted and added to a data plot (such as a scatterplot from Fit Y by X) for that purpose. After you run the script and click in the graph, the point at which you click is recorded in the data table.
dt = New Table( "dat1" );
New Column( "xx", Numeric );
New Column( "yy", Numeric );
x = 0;
y = 0;
Add Point = Expr(
    dt << Add Rows( 1 );
    Row() = N Row();
    :xx = x;
    :yy = y;
);
win = New Window( "Add Points",
    Graph Box(
        Frame Size( 500, 300 ),
        X Scale( -5, 5 ),
        Y Scale( -5, 5 ),
        For Each Row( Marker( {xx, yy} ) );
        Mousetrap( {}, Add Point );
    )
);

Notice that the first script argument is empty. At mousedown, nothing happens. The second script, add point, is executed at mouseup to add a data point. If you click, drag, and release, then the point that is added to your data set is the point where you let go of the mouse button; it is not the point where you pressed down the mouse button.

Drag Functions

There are five Drag() functions to perform similar functions to Handle() and Mousetrap() but with more than one point at a time. For \( n \) coordinates in matrices listed as the first two arguments:

- Drag Marker() draws \( n \) markers.
- Drag Line() draws a connected line with \( n \) vertices and \( n - 1 \) segments.
- Drag Rect() draw a filled rectangle using the first two coordinates, ignoring any further coordinates.
- Drag Polygon() draws a filled polygon with \( n \) vertices.
- Drag Text() draws a text item at the coordinates. Or if there is a list of text items, it draws the \( i \)th list item at the \( i \)th \((x,y)\) coordinate. If there are fewer list items than coordinate pairs, the last item is repeated for remaining points.

The syntax for these commands:

    Drag Marker( xMatrix, yMatrix, dragScript, mouseupScript );
    Drag Line( xMatrix, yMatrix, dragScript, mouseupScript );
Drag Rect( xMatrix, yMatrix, dragScript, mouseupScript );
Drag Polygon( xMatrix, yMatrix, dragScript, mouseupScript );
Drag Text( xMatrix, yMatrix, "text", dragScript, mouseupScript );

They all must have L-value arguments for the coordinates. The coordinates are literal matrices
or names of matrix values that are modified if you click a vertex and drag it to a new position.
The script arguments are optional and behave the same as with Handle(). However, there is
no x nor y that is modified as in Handle().

The Drag() operators are ways to display data that the user can adjust and then capture
the adjusted values. Consider the earlier script to draw the JMP man. Drag Polygon() makes it
possible to draw an editable JMP man; using a matching Drag Marker() statement makes the
vertices more visible. And, similar to the Mousetrap() example, you can save the new
coordinates to a data table. Notice how : and :: operators avoid ambiguity among matrices
and data table columns with the same names.

You could just as easily put storepoints in the fourth argument of Drag Polygon() or Drag
Marker(), but that would create a data table after each drag. You probably just want a single
data table when you are finished. Regardless, the values in gCoordX and gCoordY update with
each drag.

::i = 1;
storepoints = Expr(
  mydt = New Table( "My coordinates" || Char( i ) );
i++;
  New Column( "GCoordX", Numeric );
  New Column( "GCoordY", Numeric );
  mydt << Add Rows( N Row( GcoordX ) );
  :GCoordX << Values( ::GcoordX );
  :GCoordY << Values( ::GcoordY );
);

::GcoordX = [25, 23.75, 22.5, 21.25, 21.25, 22.5, 23.75, 25.625, 27.5, 18.75,
  12.5, 6.25, 2.5, 1.25, -1.25, 3.125, 6.25, 12.5, 18.75, 25, 29.375, 34.375,
  37.5, 38.75, 40.625, 42.5, 43.125, 42.5, 41.25, 38.75, 43.75, 50, 56.25,
  60.625, 63.75, 65.625, 62.5, 56.25, 50, 45, 37.5, 32.5, 28.75, 27.5, 26.25,
  25.625, 25];
::GcoordY = [-2, 2, 5, 10, 15, 20, 25, 30, 33, 34, 35, 37.5, 40, 41, 43.5, 41,
  40, 39, 40, 42, 45, 50, 55, 60, 64, 60, 55, 50, 47, 42, 43.5, 43, 42, 40,
  38, 36, 37, 36, 35, 30, 25, 20, 15, 10, 5, 2];
win = New Window( "Redraw the JMP Man!",
  V List Box( 
    Graph Box(
      Frame Size( 300, 300 ),
      X Scale( -10, 80 ),
      Y Scale( -10, 80 ),
      Fill Color( "blue" )
    )
  )
);
Drag Polygon( GcoordX, GCoordY );
Pen Color( "gray" );
Drag Marker( GcoordX, GCoordY );
Fill Color( {0, 0, 0} );
Circle( {18, 58}, 9, "FILL" );
),
Button Box( "Store current vertices in a new data table", storepoints )
);
Create Background Maps

Background maps can be scripted in JSL. You can write a script that creates a graph and then turns on the background map in the script.

There are two types of background maps: Images() and Boundaries(). Each of these takes a parameter, which is the name of the map to use. The name is one of the maps listed in the window.

- For Images(), the choices are Simple Earth, Detailed Earth, NASA, Street Map Service, and Web Map Service. If you use Web Map Service, then there are two additional parameters: the WMS URL and the layer supported by the WMS server.
- For Boundaries(), the choices vary since boundaries can be user-defined. A typical choice is World.

The following example uses the Simple Earth as an image and World as a boundary:

```javascript
dt = Open( "$SAMPLE_DATA/Air Traffic.jmp" );
dt << Graph Builder(
    Size( 1101, 603 ),
    Show Control Panel( 0 ),
    Variables( X( :Longitude ), Y( :Latitude ) ),
    Elements( Points( X, Y, Legend( 8 ) ) ),
    SendToReport(
        Dispatch(
            {},
            "Graph Builder",
            Frame Box,
            {Background Map( Images( "Simple Earth" ), Boundaries( "World" ) ),
             Grid Line Order( 3 ), Reference Line Order( 4 )}
        )
    );
```

Figure 12.34 shows an excerpt from the map:

**Figure 12.34** JSL Scripting Example

To change the script to use a WMS server, the command would look like this:

```js
```

To see which layers are available on a WMS server, install the WMS Explorer Add-In. Download the add-in from the JMP File Exchange at [https://community.jmp.com/docs/DOC-6095](https://community.jmp.com/docs/DOC-6095). Note that some WMS servers are not reliable. If the server is down, or if the user does not have an Internet connection, the WMS map does not appear.

**Tips:**

- To see the syntax for the JSL script, add a background map through the user interface. Then from the red triangle menu, select **Save Script > To Script Window** to see the script that is generated.
- To specify image and boundary names in the JSL script, use the names shown in the Set Background Map window. (Right-click a map and select **Graph > Background Map**).
- Look at sample data to find examples of background map scripts. Select **Help > Sample Data Library** and open Napoleons March.jmp, Pollutants Map.jmp, or San Francisco Crime.jmp. Right-click the map table script and select **Edit** to see the **Background Map()** function.
JSL includes commands for scripting three-dimensional scenes derived from OpenGL. Although not a complete OpenGL® implementation, JSL’s 3-D scene commands enable complex, interactive plots to be constructed and viewed. The Surface Plot platform in JMP is built using JSL scene commands.

Figure 13.1 Sample Three-Dimensional Shapes
About JSL 3-D Scenes

JMP’s 3-D scene language is built on top of the OpenGL API, extending, replacing, and leaving out various parts of the OpenGL API, and as such is not an implementation that is certified or licensed by Silicon Graphics, Inc. under the OpenGL API.

This chapter documents JMP’s JSL commands for creating 3-D scenes but is not a tutorial on OpenGL programming. If you are not familiar with OpenGL programming, you might want supplemental material. If you are familiar with OpenGL programming, you still need to read this chapter because some items are nonstandard.

JMP ships with sample files in the Scene3D subfolder of Sample Scripts to get you started and give you some ideas. Some of the example scripts are similar to some of the examples in this chapter; some are almost complete applications.

The Web site http://opengl.org is a good jumping off point for information, as is your favorite search engine.

JMP’s Scene 3-D language does some work for you that the OpenGL API requires you to do for yourself. JMP makes text easy, gives you a built-in arcball controller, and makes sure the matrix operations that belong on the model view stack and projection stack go on their respective stacks. JMP uses its own display list manager so your scenes can be journaled and played back later, and provides a pick mechanism that calls back to your JSL code to tell you what object in your scene is under the mouse, with almost no extra effort on your part. At this time, JMP does not provide access to some features, like texturing.

JSL 3-D Scene Boxes

These commands are necessary to set up and configure a 3-D scene.

Like all displays in JMP (detailed in the “Display Trees” chapter on page 419), 3-D scenes must be placed in a display box (in this case, a Scene Box). This box is then placed in a window. Therefore, a simple 3-D scene script has the following form.

```jscript
myScene = Scene Box(300, 300); // create a 300 by 300 pixel scene box
...(commands to set up the scene)...
New Window("3-D Scene", myScene); // draw the scene in a window
...(commands that manipulate the scene)
```

The scene can be sent messages that construct elements in the scene. Typical messages alter the viewer’s vantage point, construct physical elements in the scene itself, or manipulate lights and textures. These messages are maintained in a display list and are manipulated in one of two ways:

- They are sent as messages to the scene, which immediately adds them to the scene’s internal display list.
• They are sent as messages to a display list stored in a global variable, which is called by the scene’s display list later.

Figure 13.2 Constructing Scenes

For example of commands sent to the scene’s display list directly, consider the following small script. Each of the commands is explained in detail later in the chapter.

```javascript
scene = Scene Box(400, 400); // make a scene box.
New Window( "Example 1", scene ); // put the scene in a window.
scene << Perspective( 45, 3, 7 ); // define the camera
scene << Translate( 0.0, 0.0, -4.5 ); // move to (0,0,-4.5) to draw
scene << Color( 1, 0, 0 ); // set the RGB color of the text
scene << Text( center, baseline, 0.2, "Hello, World." ); // add text
scene << Update; // update the scene
```

The first two lines create a scene and place it in a window. The Perspective command defines the viewing angle and field depth. By sending it as a message to the scene, it is immediately added to the scene’s display list. Since the “Hello World” text is to be drawn at the origin (0, 0, 0), the Translate command is added to the display list to move the camera back a bit so that the origin is in the field of vision. The color is set to red with the Color command, the text is drawn, and the Update command causes the scene to be rendered (in other words, causes the display list that contains the commands to be drawn.)
Equivalently, the commands to construct the display can be accumulated in a display list stored in a global variable, which is then sent to the scene all at once. To define a global variable as a display list, assign it using the `Scene Display List` function. For example, to use the global `greeting` as a display list, issue the command

```
greeting = Scene Display List();
```

Display commands can then be sent as messages to `greeting`. An equivalent “Hello World” example using a display list follows.

```
greeting = Scene Display List();
greeting << Color( 1, 0, 0 ); // set the RGB color of the text
greeting << Text( center, baseline, 0.2, "Hello, World." ); // add text

// draw the window and send it the stored display list
scene = Scene Box( 400, 400 ); // make a scene box
New Window( "Example 1", scene ); // put the scene in a window
scene << Perspective( 45, 3, 7 ); // define the camera
scene << Translate( 0.0, 0.0, -4.5 ); // move to (0,0,-4.5) to draw
scene << Call List( greeting ); // send the display list to the scene
scene << Update; // update the scene
```

Note which commands were separated into the display list, and which were applied to the scene directly. Those that manipulate the camera (Translate and Rotate) are applied to the scene. Those that define the object (Color and Text) were relegated to the display list. This is done so that the display list can be called many times to replicate the object at different positions.
Setting the Viewing Space

3-D scenes can be rendered in two ways. Orthographic projections place the elements in a box, where coordinates are not changed to accommodate the perspective of the viewer. Perspective projections modify the display to simulate the position of the elements in relation to the position of the viewer. For example, two parallel lines (like railroad tracks) stay parallel in orthographic projections, but seem to connect at a distance in perspective projections.

Figure 13.4 Parallel Lines in an Orthographic Projection (left) and a Perspective Projection (right)

As another example, imagine looking at a tube edge-on (like a telescope). In an orthographic projection, the tube would appear as a thin circle. In a perspective projection, the circle would have a thickness; the hole at the far end of the tube would appear smaller than the close hole, and the interior of the tube is visible.

Therefore, the viewable space of an orthographic projection is a rectangular shape, while that of a perspective projection is the frustum of a pyramid (that is, a pyramid whose top has been sliced off).
In general, perspective projections give a more realistic view of the world, since it mimics the way an eye or a camera sees. Orthographic projections are important when it is essential to preserve dimensions, such as an architectural CAD program.

**Setting Up a Perspective Scene**

To set up a perspective scene in JSL, send the `Perspective` command to a display list.

```plaintext
Perspective (angle, near, far)
```

where `angle` is the viewing angle, `near` is the distance to the near plane, and `far` is the distance to the far plane, as illustrated in the drawing above. A couple of things need to be remembered when defining the viewing space.

- Items outside the viewing space (for example, closer than the `near` plane or farther than the `far` plane) are not drawn. They are clipped off.
- The ratio of `far` to `near` needs to be small so that the rendering engine can effectively determine which items should be drawn “on top of” other items, simulating closeness of items. The `near` argument must be greater than zero.

The “Hello World” example contains the line

```plaintext
scene << Perspective( 45, 3, 7 ); // define the camera
```
This defines a 45 degree viewing angle, with a near plane 3 units from the viewer and a far plane 7 units from the viewer.

The viewing angle functions in the same way as a wide angle or telephoto lens on a camera. Small viewing angles zoom into a drawing, while wide angles zoom out. In other words, a small viewing angle maps the screen space onto a small portion of the scene, resulting in apparently larger scene elements. A large viewing angle maps the screen space onto a large portion of the scene, resulting in apparently small screen elements. The size of scene elements can therefore be manipulated using the \textit{angle} argument of the \texttt{Perspective} function. The picture here shows the hello world script with perspective angles of 45 and 90 degrees.

\textbf{Figure 13.6} Changing the Perspective

```
Hello, World.

scene << Perspective( 45, 3, 7 );
```

```
Hello, World.

scene << Perspective( 90, 3, 7 );
```

As an alternative to the \texttt{Perspective} command, you can define the actual viewing frustum with the \texttt{Frustum} command.

\texttt{Frustum(left, right, bottom, top, near, far);} 

The frustum’s viewing volume is defined by (\texttt{left, bottom, near}) and (\texttt{right, top, near}) which specify the (x, y, z) coordinates of the lower left and upper right corners of the near clipping plane; \texttt{near} and \texttt{far} give the distances from the viewpoint to the near and far clipping planes.

\textbf{Setting up an Orthographic Scene}

Orthographic scenes are specified in ways similar to perspective scenes. Issue the command

\texttt{Ortho(left, right, bottom, top, near, far)}

which specifies the four corners of the near plane, the distance to the near plane, and the distance to the far plane.
If you are dealing with a simple 2-D environment, you can set up a two-dimensional orthographic scene with the command

\[ \text{Ortho2D (left, right, bottom, top)} \]

which specifies the corners of the two-dimensional view.

---

**Changing the View**

One of the advantages of creating a 3-D scene is the ease that they can be viewed from different angles and positions. The \text{Translate} and \text{Rotate} commands let you set the position from which you view the scene.

In addition, you can use the \text{ArcBall} command to enable the user to change the viewing angle interactively.

**The Translate Command**

You have actually seen the \text{Translate} command in earlier sample scripts. It sets the position from which the scene is viewed. The arguments give the amount to move from the current position in the \( x \), \( y \), and \( z \) direction.

\[ \text{Translate (x, y, z)} \]

For example,

\[ \text{Translate( 0.0, 0.0, -2 )}; \]

moves the origin two units in the negative \( z \) direction.

Initially, the origin and camera were at the same place. Now, the camera can see the origin because the camera faces down the negative \( z \)-axis.

**The Rotate Command**

The \text{Rotate} command is used to modify the viewing angle of a scene. It has the following format.

\[ \text{Rotate (degrees, xAxis, yAxis, zAxis)} \]

This rotates by degrees around the axis described by the vector \((xAxis, yAxis, zAxis)\). For example, to rotate a model 90 degrees about the \( x \)-axis, use \text{Rotate( 90, 1, 0, 0 )}.

You can also specify the three axis values in a matrix. For example, \text{Rotate( 90, [1, 0, 0] )}.

**Note:** The \text{Rotate} command uses degrees, in contrast to JMP’s trigonometric functions, which use radians.
Translate and Rotate are also used to position objects with respect to each other. The first Translate or Rotate can be thought of as positioning everything that follows with respect to the camera. Subsequent Translate and Rotate commands are used to position objects, such as spheres, cylinders, disks, and display lists in Call List and ArcBall commands. For example, suppose you have a display list named table and another named chair. Your scene might look like this:

Figure 13.7 Using Translate and Rotate

```plaintext
scene << Perspective(...);        Set up scene
scene << Clear;

scene << Perspective(...);        Draw table
scene << Clear;

scene << Perspective;            Position and draw first chair
scene << Rotate(...)
scene << Translate(...);
scene << Rotate(...)
scene << Call List (chair);

scene << Perspective;            Position and draw second chair
scene << Rotate(...)
scene << Translate(...);
scene << Rotate(...)
scene << Call List (chair);
```

The following example uses the Rotate command inside a For loop to continuously change the viewing angle of a scene. It draws a cylinder that swings around a central point. This central point is shown by a small sphere.

```plaintext
scene = Scene Box( 600, 600 ); // make a scene box...holds an OpenGL scene.

New Window( "Example 1", scene ); // put the scene in a window

For( i = 1, i < 360, i++,
    scene << Clear;

    scene << Perspective( 45, 1, 10 );
    // the lens is 45 degrees, near is 1 units from the camera, far is 10.
    scene << Translate( 0.0, 0.0, -2 );

    scene << Rotate( i, 1, 0, 0 );
    scene << Rotate( i * 3, 0, 1, 0 );
    scene << Rotate( i * 3 / 2, 0, 0, 1 );
    scene << Color( 0, 1, 0 ); // green for cylinder
    scene << Cylinder( 0.5, 0.5, 0.5, 40, 10 );
    scene << Color( 0, 0, 0 ); // black for sphere
    scene << Sphere( 0.01, 10, 5 );
    scene << Update;
    Wait( 0.01 );
);```
Figure 13.8 Rotating a Cylinder

Note the use of the Update command at the end of the scene messages. This command tells JMP to make the displayed screen agree with the current state of the display list. It is important to clear the list at the beginning (so the list does not contain the old angles as well as the current) and update the scene after each change.

The Look At Command

The Look At command is an alternative way to set the camera view.

\[
\text{Look At( eyeX, eyeY, eyeZ, centerX, centerY, centerZ, upX, upY, upZ )}
\]

The Look At command puts the camera at the eye coordinates and points it toward the center coordinates. The up vector describes how the camera is rotated on its line of sight. Because the model is typically constructed at the origin, a JMP scene should have either a Look At or a Translate command near its beginning to move the camera away from the origin.

First, clear the scene box of any commands from the previous frame.

\[
\text{scene \texttt{\textless\textless} Clear;}
\]

Then use one of these projections:

\[
\text{scene \text{\texttt{\textless\textless} Perspective( 45, 2, 10 );}}
\]
Three-Dimensional Scenes

Changing the View

Chapter 13
Scripting Guide

scene << Frustum( -.5, .5, -.5, .5, 1, 10 );
scene << Ortho( -2, 2, -2, 2, 1, 10 );
scene << Ortho2d( -2, 2, -2, 2 );

Note: If you use the ortho2d projection, you should not also set the camera position using either Translate or Look At.

Finally, use either Translate or Look At to set the camera position:

scene << Translate(0.0, 0.0, -4.5);
/* the camera faces down the negative Z axis. move it back so 0,0,0 is in view. */
scene << Look At( /*eye*/ 3,3,3, /*center*/ 0,0,0, /*up*/ 1,0,0 );
/*this is much easier. */

Once the scene and camera position are set, add your model.

The ArcBall

Sometimes you want a scene to rotate based on the movements of the mouse. The Surface Plot platform in JMP is an example of a 3-D scene that rotates based on mouse movements.

An ArcBall creates a sphere around the 3-D scene and enables the user to click on the sphere’s surface and drag it around, thus causing the scene to rotate.

Use an ArcBall instead of a Call List command to place the scene in an ArcBall. Scenes that are attached to an ArcBall automatically respond to clicks and drags of the mouse. Custom programming is not needed. However, rotations made in the arcball are not saved.
(Technically, the ArcBall is surrounded by an implicit Push Matrix and Pop Matrix block, so the movements are gone after it returns. See “Using the Matrix Stack” on page 599 for details of pushing and popping.)

For example, examine the script from “Primitives Example” on page 589. Change the single line

    scene << CallList(shape); // send the display list to the scene
so that it reads

    scene << ArcBall(shape,2); // send the display list to an arcball

This displays the script with an associated arcball with diameter 2. When you run the script and the window appears, right-click and select Show ArcBall > Always from the menu that appears.

Note: ArcBall comes from an article by Shoemake (1994) found in Graphics Gems IV, published by Academic Press.
This sets the display so that the ArcBall is always showing. Click and drag on the ArcBall to rotate the scene. The popup menu with Background Color, Use Hardware Acceleration, and Show ArcBall is always available, whether the scene is displayed through a platform, in a journal, or through JSL.

**Note:** The ArcBall does not have to be showing to react to mouse commands. It is shown here for display purposes only.

You can also set the display state of the ArcBall in JSL using the `Show Arcball` command.

```jscript
scene << Show Arcball(state)
```

where `state` is `During Drag`, `Always`, or `Never`.

**Figure 13.9** Showing the Arc Ball

---

### Graphics Primitives

All scenes in JSL are built with a small number of graphics primitives. These fundamental elements function as the building blocks for complicated scenes.

Every graphics primitive involves specifying vertices. In some cases, the vertices are simply drawn as points. In others, the vertices are connected to form polygons. To draw a primitive, you must specify the type of primitive and the coordinates and properties of the vertices involved. In JSL, this specification is accomplished through the `Begin` and `End` statements.

```jscript
scene << Begin(primitive type);
...(commands specifying vertices and their properties)...
scene << End();
```

To specify the coordinates of the vertices, use the `vertex` command.

```jscript
scene << Begin(primitive type);
scene << Vertex(x, y, z);
```
The options for `primitive type` are the following. In these examples, assume that \( v_0, v_1, \) and so on, have been specified between a `Begin` and `End` pair, similar to the following.

```c
scene<<Begin(primitive type);
scene<<Vertex(x_0,y_0,z_0)//specify vertex \( v_0 \)
scene<<Vertex(x_1,y_1,z_1)//specify vertex \( v_1 \)
...
scene<<Vertex(x_n,y_n,z_n)//specify vertex \( v_n \)
scene<<End();
```

### Table 13.1 Primitive Types

<table>
<thead>
<tr>
<th><code>primitive type</code></th>
<th>Description</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>POINTS</td>
<td>Draws a point at each of the vertices.</td>
<td><img src="image1.png" alt="Points" /></td>
</tr>
<tr>
<td>LINES</td>
<td>Draws a series of (unconnected) line segments. Segments are drawn between ( v_0 ) and ( v_1 ), between ( v_2 ) and ( v_3 ), and so on. If ( n ) is odd, the last vertex is ignored.</td>
<td><img src="image2.png" alt="Lines" /></td>
</tr>
<tr>
<td>POLYGON</td>
<td>Draws a polygon using the points ( v_0,\ldots, v_n ) as vertices. Three vertices must exist, or nothing is drawn. In addition, the polygon specified must not intersect itself and must be convex. If the vertices do not satisfy these conditions, the results are unpredictable.</td>
<td><img src="image3.png" alt="Polygon" /></td>
</tr>
<tr>
<td>TRIANGLES</td>
<td>Draws a series of (disconnected) triangles using vertices ( v_0, v_1, v_2 ), then ( v_3, v_4, v_5 ), and so on. If the number of vertices is not an exact multiple of 3, the final one or two vertices are ignored.</td>
<td><img src="image4.png" alt="Triangles" /></td>
</tr>
</tbody>
</table>
### Table 13.1 Primitive Types (Continued)

<table>
<thead>
<tr>
<th>Primitive Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>LINE_STRIP</code></td>
<td>Draws a line segment from ( v_0 ) to ( v_1 ), then from ( v_1 ) to ( v_2 ), and so on. Therefore, ( n ) vertices specify ( n-1 ) line segments. Nothing is drawn unless there is more than one vertex. There are no restrictions on the vertices describing a line strip; the lines can intersect arbitrarily.</td>
</tr>
<tr>
<td><code>LINE_LOOP</code></td>
<td>Same as <code>LINE_STRIP</code>, except that a final line segment is drawn from the last vertex to the first, completing a loop.</td>
</tr>
<tr>
<td><code>QUADS</code></td>
<td>Draws a series of quadrilaterals (four-sided polygons) using vertices ( v_0, v_1, v_2, v_3 ), then ( v_4, v_5, v_6, v_7 ), and so on. If the number of vertices is not a multiple of 4, the final one, two, or three vertices are ignored.</td>
</tr>
<tr>
<td><code>QUAD_STRIP</code></td>
<td>Draws a series of quadrilaterals (four-sided polygons) beginning with ( v_0, v_1, v_3, v_2 ), then ( v_2, v_3, v_5, v_4 ), then ( v_4, v_5, v_7, v_6 ), and so on. The number of vertices must be at least 4 before anything is drawn, and if odd, the final vertex is ignored.</td>
</tr>
<tr>
<td><code>TRIANGLE_STRIP</code></td>
<td>Draws a series of triangles (three-sided polygons) using vertices ( v_0, v_1, v_2 ), then ( v_2, v_1, v_3 ) (note the order), then ( v_2, v_3, v_4 ), and so on. The ordering is to ensure that the triangles are all drawn with the same orientation so that the strip can correctly form part of a surface. There must be at least three vertices for anything to be drawn.</td>
</tr>
</tbody>
</table>
The following short example illustrates the use of a graphics primitive.

```plaintext
shape = Scene Display List();    // create a display list and send it commands
shape << Color( 1, 0, 0 );      // set the RGB color of the text
shape << Begin( POLYGON );
shape << Vertex( 0, 0, 0 );
shape << Vertex( 0, 3, 0 );
shape << Vertex( 3, 3, 0 );
shape << Vertex( 5, 2, 0 );
shape << Vertex( 4, 0, 0 );
shape << Vertex( 2, -1, 0 );
shape << End();

// draw the window and send it the stored display list
scene = Scene Box( 400, 400 );  // make a scene box.
New Window( "Primitive", scene ); // put the scene in a window.
scene << Perspective( 90, 3, 7 ); // define the camera
scene << Translate( 0.0, 0.0, -5 ); // move to (0,0,-5) to draw
scene << Call List( shape );    // send the display list to the scene
scene << Update;    // update the scene
```

The first section of the script creates a display list named `shape`. Inside this display list, a polygon is defined using six vertices.

The second section of the script creates a scene box and a new window. It then uses the `Call List` message to put the list in the display.

Note that all the z-coordinates are zero, which makes sure the polygon lies in a plane. Polygons that do not lie in a plane can cause unpredictable results.

Experiment with the line

```plaintext
shape <<Begin(POLYGON);  
```
by changing it to some of the other primitive types. For example, changing it to

```
shape <<Begin(TRIANGLES);
```

results in a different picture.

Figure 13.10 Polygon (left) and Triangles (right)

Controlling the Appearance of Primitives

JSL has several commands that let you tailor-make the appearance of primitive drawing objects. You can also specify the widths of lines and their stippling pattern (that is, whether they are dashed, dotted, and so on.)

Size and Width

To set the point size of rendered objects, use the `Point Size` command.

```
Point Size (n)
```

where `n` is the number of pixels. Note that this might not be the actual number of pixels rendered, depending on other settings such as anti-aliasing and your hardware configuration.

Set the line width using the `Line Width` command

```
Line Width(n)
```

where `n` is the number of pixels. The argument `n` must be larger than zero and is, by default, one.

Stippling Pattern

To make stippled lines, use the `Line Stipple` command.

```
Line Stipple(factor, pattern)
```

`Factor` is a stretching factor. `Pattern` is a 16-bit integer that turns pixels on or off. Use `Enable(LINE_STIPPLE)` to turn the effect on.
To construct a line stippling pattern, write a 16-bit binary number that represents the stippling pattern that you desire. Note that the pattern should read from right to left, so your representation might seem backward to the way it is rendered. Convert the binary number to an integer and use this as the \textit{pattern} argument.

For example, imagine you want the dotted line pattern 0000000011111111. This is equal to 255 in decimal notation, so use the command \texttt{Line Stipple(1, 255)}.

The \textit{factor} argument expands each binary digit to two digits. In the example above, \texttt{Line Stipple(2, 255)} would result in 00000000000000001111111111111111.

For example, the following script draws three lines, each of different widths (the \texttt{Line Width} commands) and stippling patterns.

```plaintext
scene = Scene Box( 200, 200 ); // make a scene box...holds an OpenGL scene.
New Window("Stipples", scene ); // put the scene in a window.
scene << Ortho( -2, 2, -2, 2, -1, 1 );
scene << Color( 0, 0, 0 ); // set the RGB color of the text
scene << Enable( LINE_STIPPLE );
scene << Line Width( 2 );
scene << Line Stipple( 1, 255 );

scene << Begin( LINES );
scene << Vertex( -2, -1, 0 );
scene << Vertex( 2, -1, 0 );
scene << End();

scene << Line Width( 4 );
scene << Line Stipple( 1, 32767 );

scene << Begin( LINES );
scene << Vertex( -2, 0, 0 );
scene << Vertex( 2, 0, 0 );
scene << End();

scene << Line Width( 6 );
scene << Line Stipple( 3, 51 );

scene << Begin( LINES );
scene << Vertex( -2, 1, 0 );
scene << Vertex( 2, 1, 0 );
scene << End();
scene << Update;
```
Note: Stipple patterns “crawl” on rotating models because they are in screen pixels, not model units, and lines in the model change length on the screen even though nothing changes in model units.

Fill Pattern

Polygons are rendered with both a front and a back, and the drawing mode of each side is customizable. This enables the user to see the difference between the back and front of the polygon.

To set the drawing mode of a polygon, use the Polygon Mode command.

\[
\text{Polygon Mode (face, mode)}
\]

where \textit{face} can be FRONT, BACK, or FRONT_AND_BACK, and \textit{mode} can be POINT, LINE, or FILL.

For example, the following script creates a display list that defines a triangle. This display list is used three times in conjunction with Translate, Rotate, and Color commands to draw triangles in three positions. In addition, the Polygon Mode command changes the drawing mode of each triangle. Note there is no explicit call to the FILL mode, since it is the default.
The following table dissects the script, showing how the Translate and Rotate commands accumulate to manipulate a single display list.

**Table 13.2 Translate and Rotate Commands**

<table>
<thead>
<tr>
<th>Code from above script</th>
<th>comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>shape = Scene Display List();</td>
<td>Creates a display list</td>
</tr>
<tr>
<td>shape &lt;&lt; Begin(TRIANGLES); shape &lt;&lt; Vertex(0, 0, 0); shape &lt;&lt; Vertex(-1, 2, 0); shape &lt;&lt; Vertex(1, 2, 0); shape &lt;&lt; End();</td>
<td>Creates a display list named shape that holds vertices for the triangles. All the z vertices are zero since this is a two dimensional scene</td>
</tr>
<tr>
<td>scene = Scene Box( 200, 200 ); New Window( &quot;Fill Modes&quot;, scene ); scene &lt;&lt; Ortho2d(-2,2,-2,2);</td>
<td>Put the scene in a display box, and create a new window.</td>
</tr>
<tr>
<td>scene &lt;&lt; Color(1,0,0); scene &lt;&lt; Call List(shape); scene &lt;&lt; Update; // update the scene to see the triangle</td>
<td>Draw the first triangle in red.</td>
</tr>
</tbody>
</table>
Table 13.2 Translate and Rotate Commands  *(Continued)*

<table>
<thead>
<tr>
<th>Code from above script</th>
<th>comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>scene &lt;&lt; Rotate (90, 0, 0, 1);</td>
<td>Draw the second triangle in teal. Note that we first rotate the triangle.</td>
</tr>
<tr>
<td>scene &lt;&lt; Translate (-0.5, 0, 0);</td>
<td></td>
</tr>
<tr>
<td>scene &lt;&lt; Color(0, 0.5, 0.5);</td>
<td>And then translate it.</td>
</tr>
<tr>
<td>scene &lt;&lt; Polygon Mode(FRONT_AND_BACK, LINE);</td>
<td></td>
</tr>
<tr>
<td>scene &lt;&lt; Call List(shape);</td>
<td></td>
</tr>
<tr>
<td>scene &lt;&lt; Update;</td>
<td></td>
</tr>
<tr>
<td>// update the scene to see the triangle</td>
<td></td>
</tr>
</tbody>
</table>
Some developers use the fill mode in concert with the line mode to draw a filled polygon with a differently colored border. However, due to the way the figures are rendered, they sometimes do not line up correctly. The Polygon Offset command is used to correct for this so-called “stitching” problem.

**Polygon Offset (factor, units)**

To enable offsetting, use `Enable(POLYGON_OFFSET_FILL)`, `Enable(POLYGON_OFFSET_LINE)`, or `Enable(POLYGON_OFFSET_POINT)`, depending on the desired mode. The actual offset values are calculated as \( m \times (\text{factor}) + r \times (\text{units}) \), where \( m \) is the maximum depth slope of the polygon and \( r \) is the smallest value guaranteed to produce a resolvable difference in window coordinate depth values. Start with `Polygon Offset(1,1)` if you need this.

An example of Polygon Offset is in the Surface Plot platform, when a surface and a mesh are displayed on top of each other, or a surface and contours displayed on top of each other. In either case, the surface would interfere with the lines if the lines were not moved closer or the surface moved farther from the viewer.

---

**Table 13.2 Translate and Rotate Commands (Continued)**

<table>
<thead>
<tr>
<th>Code from above script</th>
<th>comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>scene &lt;&lt; Rotate(90, 0, 0, 1); scene &lt;&lt; Translate(-0.5, -1, 0); scene &lt;&lt; Color(0, 0, 0); scene &lt;&lt; Point Size(5); // large points so they are visible scene &lt;&lt; Polygon Mode(FRONT_AND_BACK, POINT); scene &lt;&lt; Call List(shape); scene &lt;&lt; Update; // update the scene to see the triangle</td>
<td>Draw the third triangle as black points. First rotate. And then translate to get the final picture.</td>
</tr>
</tbody>
</table>
Other uses of Begin and End

Although vertices are typically specified between begin and end statements, there are other commands that are valid. These commands are discussed in other sections of this chapter.

- **Vertex** adds a vertex to the list
- **Color** changes the current color
- **Normal** sets the normal vector coordinates
- **Edge Flag** controls drawing of edges
- **Material** sets material properties
- **Eval Coord** and **Eval Point** generate coordinates
- **Call List** executes a display list.

Drawing Spheres, Cylinders, and Disks

There are several pre-defined commands that allow for quick rendering of spheres, cylinders, and disks. The advantage of these commands is not only their ease-of-use, but that they have special lighting properties (their “normals”) built in.

Construction

The following commands are used to construct cylinders, disks, partial disks, and spheres.

**Cylinders**

\[ \text{Cylinder( baseRadius, topRadius, height, slices, stacks )} \]

*baseRadius* is the radius of the cylinder’s base. Similarly, *topRadius* is the radius of the top. *height* is the height of the cylinder.

*Slices* can be 10 for a reasonably accurate cylindrical shape. Using QuadricNormals(Smooth) helps the appearance.

*Stacks* sets the number of vertices available for lighting reflections. Use a larger value for *Stacks* for accurate “hot-spots”.

**Disks**

The following command draws a paper-thin disk with an *innerRadius* hole in the middle.

\[ \text{Disk( innerRadius, outerRadius, slices, loops )} \]
Like Cylinder, slices controls the accuracy of the curve and loops makes more vertices (for lighting accuracy).

Partial Disk( innerRadius, outerRadius, slices, loops, startAngle, sweepAngle )

The Partial Disk command works like Disk, but with a slice of the disk removed. Specify the part of the disk that is showing using startAngle and sweepAngle.

Spheres

The following command draws a sphere with the specified radius.

Sphere( radius, slices, stacks )

The slices can be thought of as longitudes and stacks as latitudes. About 10 of each make a nicely drawn sphere.

Lighting

It is not necessary to make specific calculations of normal vectors (as is the case for customized surfaces) for spheres, disks, and cylinders. However, you can use the following commands to tailor the automatic lighting.

Quadric Normals(mode) tells what type of normal should be automatically generated. The argument mode can be None, Flat, or Smooth. Flat makes faceted surfaces. Smooth makes the normals at each vertex be the average of the adjacent polygons.

Quadric Orientation(mode) determines which way the normals point. The argument mode can be Inside or Outside.

Quadric Draw Style(mode) specifies the drawing mode. The argument mode can be Fill, Line, Silhouette, or Point.

JMP uses the values that you set for Quadric Normals, Quadric Orientation, and Quadric Draw Style for subsequently generated cylinders, disks, and spheres.

Figure 13.13 Draw Styles
Note: Other OpenGL documentation refers to quadric objects. JMP has only one, and always uses it.

Drawing Text

As shown in the “Hello World” example above, text is added to a scene using the Text command.

\[
\text{Text( horz, vert, size, string, <billboard>)}
\]

- \text{horz} can be Left, Center, or Right justification.
- \text{vert} can be Top, Middle, Baseline, or Bottom justification.
- \text{size} represents the height of a capital letter M in model coordinates.
- \text{string} is the text to draw.
- \text{billboard} is an optional argument that causes the text to rotate with the model. Text with this option always faces the viewer.

The font is always the JMP Text font. You can change the text font from the preferences menu, but because of the way JMP caches fonts for scenes, changes might not take effect until JMP is restarted.

Note: Text is not part of the standard OpenGL definition.

Using Text with Rotate and Translate

The following example uses the text command in conjunction with the Translate and Rotate commands.

```plaintext
scene = Scene Box( 600, 600 ); // make a scene box...holds an OpenGL scene
New Window( "Example 2", scene ); // put the scene in a window
scene << Perspective( 45, 3, 7 );
// the "lens" is 45 degrees, near is 3 units from the camera, far is 7
scene << Translate( 0.0, 0.0, -4.5 );
// move the world so 0,0,0 is visible in the camera
scene << Rotate( 30, 0, 1, 0 );
// rotate the first text about the Y (vertical on screen) axis
scene << Color( 1, 0, 0 ); // pure red
scene << Text( "center", "baseline", .2, "First Red String" );
scene << Translate( 0.0, 0.0, -2.0 );
// the next string is even farther away from the camera
scene << Rotate( 30, 0, 1, 0 );
// rotate the second text about the Y (vertical on screen) axis
scene << Color( 0, 1, 0 ); // pure green
```
scene << Text( "center", "baseline", .2, "Second Green very long string" );
scene << Update;
// update the displaybox in the window using the current display list

Figure 13.14 Rotating and Translating Text Strings

Note the green string is extending backwards beyond the far clipping plane. Change the 7 to 10 in the Perspective command to see the complete string.

Using the Matrix Stack

JMP 3-D scenes use a matrix stack to keep track of the current transform. The stack is initialized to the identity matrix, and each time a translate, rotate, or scale command is given, the top matrix on the stack is changed.

Note: Unlike many OpenGL implementations, JMP does not use a transposed matrix.

The JSL example below uses Push Matrix and Pop Matrix to position pieces of the toy top and then return to the origin. This is faster than using the Translate command a second time in reverse.

Figure 13.15 Drawing With a Matrix Stack

toyTop = Scene Display List();
toyTop << Push Matrix;
toyTop << Translate( 0, 0, .1 );
toyTop << Color( 1, 0, 0 ); // red
toyTop << Cylinder( 1, .2, .2, 25, 5 );
    // baseRadius, topRadius, height, slices, stacks
toyTop << Pop Matrix;
toyTop << Push Matrix;
toyTop << Translate( 0, 0, -.1 );
toyTop << Rotate( 180, 1, 0, 0 );
toyTop << Color( 0, 1, 0 ); // green
toyTop << Cylinder( 1, .2, .2, 25, 5 );
toyTop << Pop Matrix;

toyTop << Color( 0, 0, 1 ); // blue
toyTop << Sphere( .5, 30, 30 ); // radius, slices, stacks

toyTop << Color( 1, 1, 0 ); // yellow
toyTop << Partial Disk( 1, 1.2, 25, 2, 0, 270 );
    // innerRadius, outerRadius, slices, rings, startAngle, sweepAngle

toyTop << Push Matrix;
toyTop << Translate( 0, 0, -.1 );
toyTop << Color( 1, 0, 1 ); // magenta
toyTop << Cylinder( 1, 1, .2, 25, 3 );
    // baseRadius, topRadius, height, slices, stacks
toyTop << Pop Matrix;

toyTop << Push Matrix;
toyTop << Rotate( 90, 1, 0, 0 );
toyTop << Translate( 0, .5, 0 );
toyTop << Color( 0, 1, 1 ); // cyan
toyTop << Text( "center", "baseline", .2, "Toy Top" );
toyTop << Pop Matrix;

scene = Scene Box( 600, 600 ); // make a scene box...holds an OpenGL scene

New Window( "Example 3", scene ); // put the scene in a window
scene << Perspective( 45, 3, 7 );
scene << Translate( 0.0, 0.0, -4.5 );
scene << Rotate( -85, 1, 0, 0 );
scene << Rotate( 65, 0, 0, 1 );
scene << Call List( toyTop );

scene << Update; // update the display box
There are some cases where you want to replace the current matrix on the stack. For these cases, use the *Load Matrix* command.

```
Load Matrix(m)
```

where *m* is a 4x4 JMP matrix that is loaded onto the current matrix stack.

Similar is the *Mult Matrix* command

```
Mult Matrix(m)
```

When the *Mult Matrix* command is issued, the matrix on the top of the current matrix stack is multiplied by *m*.

The following matrices perform some simple commands.

**Translation:**
```
[1 0 0 x
 0 1 0 y
 0 0 1 z
 0 0 0 1]
```

In the following rotation matrices, *c* = cos(angle) and *s* = sin(angle).

**Rotation about *x*-axis:**
```
[1 0 0 0
 0 c -s 0
 0 -s c 0
 0 0 0 1]
```

**Rotation about *y*-axis:**
```
[c 0 s 0
 0 1 0 0
 -s 0 c 0
 0 0 0 1]
```

**Rotation about *z*-axis:**
```
[c -s 0 0
 s c 0 0
 0 0 1 0
 0 0 0 1]
```

For example, here are two equivalent (except for the translation being opposite) ways to translate and rotate a display list.

```
// first way uses matrix
gl << Push Matrix;
xr = Identity( 4 ); // rotate this one, cos needs radians, not degrees
xt = Identity( 4 ); // translate this one left by .75
xt[1, 4] = -.75;
xr[1, 4] = .75;
```
\[
\begin{align*}
x_r[2, 2] &= \cos(3.14159 \times a / 180); \\
x_r[2, 3] &= -\sin(3.14159 \times a / 180); \\
x_r[3, 2] &= \sin(3.14159 \times a / 180); \\
x_r[3, 3] &= \cos(3.14159 \times a / 180); \\
y_r &= \text{Identity}(4); \\
y_r[1, 1] &= \cos(3.14159 \times a / 180); \\
y_r[1, 3] &= \sin(3.14159 \times a / 180); \\
y_r[3, 1] &= -\sin(3.14159 \times a / 180); \\
y_r[3, 3] &= \cos(3.14159 \times a / 180); \\
z_r &= \text{Identity}(4); \\
z_r[1, 1] &= \cos(3.14159 \times a / 180); \\
z_r[1, 2] &= -\sin(3.14159 \times a / 180); \\
z_r[2, 1] &= \sin(3.14159 \times a / 180); \\
z_r[2, 2] &= \cos(3.14159 \times a / 180); \\
gl &<< \text{Mult Matrix}(x_t \times x_r \times y_r \times z_r); \\
&// \text{order of multiplication matters with matrices} \\
gl &<< \text{Arcball}(dl, 1); \\
gl &<< \text{Pop Matrix}; \\
\end{align*}
\]

// second way uses functions
\begin{align*}
&<< \text{Push Matrix}; \\
&<< \text{Translate}(0.75, 0, 0); // \text{translate this one right by .75} \\
&<< \text{Rotate}(a, 1, 0, 0); // \text{rotate this one in degrees} \\
&<< \text{Rotate}(a, 0, 1, 0); // \text{order of operations also matters here} \\
&<< \text{Rotate}(a, 0, 0, 1); \\
&<< \text{Arcball}(dl, 1); \\
&<< \text{Pop Matrix}; \\
\end{align*}

It is not possible to read back the current transform matrix, because the matrix only exists while the display list is drawing, not while your JSL script is creating it. If you must know its content, create it in JSL and use \texttt{Load Matrix} to put it on the stack.

**Lighting and Normals**

The following methods enable you to add lighting, materials, and normal vectors to your shapes. Using these methods, models can appear shiny or light-absorbing.

**Creating Light Sources**

Light sources are specifications of a color, position, and direction. JSL allows for up to eight lights (numbered 0 to 7) defined by the \texttt{Light} command, where \(n\) is the number of the light.

\[
\text{Light}(n, \text{argument}, \text{value}, \ldots, \text{value})
\]
**Note:** To turn each light on, issue an `Enable (Lighting)` and an `Enable (light n)` command, where `n` is the light number. Then, move the light to a position in the scene with a `Light(n, POSITION, x, y, z)` command.

The value of *argument* can be any one of those shown in Table 13.3. The table shows default values for each argument.

**Table 13.3** Light Arguments and Default Values

<table>
<thead>
<tr>
<th>Argument</th>
<th>Default Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMBIENT</td>
<td>(0, 0, 0, 1)</td>
<td>Ambient RGBA intensity</td>
</tr>
<tr>
<td>DIFFUSE</td>
<td>(1, 1, 1, 1)</td>
<td>diffuse RGBA intensity</td>
</tr>
<tr>
<td>SPECULAR</td>
<td>(1, 1, 1, 1)</td>
<td>specular RGBA intensity</td>
</tr>
<tr>
<td>POSITION</td>
<td>(0, 0, 1, 0)</td>
<td>((x, y, z, w)) position</td>
</tr>
<tr>
<td>SPOT_DIRECTION</td>
<td>(0, 0, -1)</td>
<td>((x, y, z)) direction of spotlight</td>
</tr>
<tr>
<td>SPOT_EXPONENT</td>
<td>0</td>
<td>spotlight exponent</td>
</tr>
<tr>
<td>SPOT_CUTOFF</td>
<td>180</td>
<td>spotlight cutoff angle</td>
</tr>
<tr>
<td>CONSTANT_ATTENUATION</td>
<td>1</td>
<td>constant attenuation factor</td>
</tr>
<tr>
<td>LINEAR_ATTENUATION</td>
<td>0</td>
<td>linear attenuation factor</td>
</tr>
<tr>
<td>QUADRATIC_ATTENUATION</td>
<td>0</td>
<td>quadratic attenuation factor</td>
</tr>
</tbody>
</table>

**Note:** The default values for DIFFUSE and SPECULAR in this table only apply to Light 0. For other lights, the default value is \((0, 0, 0, 1)\) for both arguments.

The first three arguments (AMBIENT, DIFFUSE, and SPECULAR) are used to color the light. DIFFUSE is the argument that is most closely associated with the physical color of the light. AMBIENT refers to the property of the light when it functions as a background light. SPECULAR alters the way a light is reflected off a surface.

Specify the position of the light using the POSITION argument. Nonzero values of the fourth \((w)\) coordinate position the light in homogenous object coordinates.

Light in the real-world decreases in intensity as distance from the light increases. Since a directional light is infinitely far away, it does not make sense to attenuate its intensity as a
function of distance. However, JSL attenuates a light source by multiplying the contribution of the source by an attenuation factor

\[
\text{attenuation factor} = \frac{1}{c + ld + qd^2}
\]

where \( c = \text{CONSTANT\_ATTENUATION}, l = \text{LINEAR\_ATTENUATION}, \) and \( q = \text{QUADRATIC\_ATTENUATION}. \)

To create a spotlight, limit the shape of the light to a cone. Use the SPOT_CUTOFF argument to define the side of the cone, as shown in the following illustration.

**Figure 13.16 Spotlight**

![Spotlight Diagram]

In addition to the cutoff angle, you can control the intensity and direction of the light distribution in the cone. SPOT_DIRECTION specifies the direction for the spotlight to point; SPOT_EXPONENT influences how concentrated the light is.

**Lighting Models**

Lighting models are specified with the Light Model command.

```
Light Model( argument, value,...,value )
```

Light models specify three attributes of lights.

- The global ambient light intensity
- Whether the viewpoint is local or is an infinite distance away
- Whether lighting calculations should be performed differently for the front and back faces of objects.

**Table 13.3** on page 603 shows the three valid arguments for the Light Model command.
Normal Vectors

Normal vectors point in a direction perpendicular to a surface. For a plane, all normals are the same. For a more complicated surface, normals are more complicated. JSL enables you to specify the normal vector for each vertex. These normals specify the orientation of the surface in space, necessary for lighting calculations. Accurate normals assure accurate lighting.

The normal vector is of length 1 and is perpendicular to the vertex. Typically, a vertex is shared between several polygons and a smooth shaded effect is desired, so the perpendicular at the vertex is calculated as a (possibly weighted) average of the polygon’s normals. It is important to calculate the “outward” normal for polygons unless two-sided shading is enabled because only the outer face of the polygon is illuminated. With a scaled polygon, the normal’s length is not 1 after scaling, and the lighting is wrong.

Normal vectors are set at the same time the surface is constructed, and are specified with the Normal command. Use the Enable(NORMALIZE) command to have the normals re-normalized to 1 each time the scene is drawn.

### Shading Model

The shading model of a polygon is set using the Shade Model command.

\[
\text{Shade Model } (\text{mode})
\]

where \text{mode} can be \text{SMOOTH} (the default) or \text{FLAT}. SMOOTH shading interpolates the colors of the primitive from one vertex to the next. FLAT mode duplicates the color of one vertex across the entire primitive.

The following script changes the color at each of a triangle’s vertices. The FILL shade model interpolates the color of the interior automatically.

```
scene = Scene Box( 200, 200 ); // make a scene box...holds an OpenGL scene.
New Window( "Shade Model", scene ); // put the scene in a window
scene <<= Clear;
```

### Table 13.4 Light Model Arguments and Default Values

<table>
<thead>
<tr>
<th>Argument</th>
<th>Default Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIGHT_MODEL_AMBIENT</td>
<td>(0.2, 0.2, 0.2, 1)</td>
<td>Ambient RGBA intensity of the entire scene</td>
</tr>
<tr>
<td>LIGHT_MODEL_LOCAL_VIEWER</td>
<td>0 (false)</td>
<td>how specular reflection angles are computed</td>
</tr>
<tr>
<td>LIGHT_MODEL_TWO_SIDE</td>
<td>0 (false)</td>
<td>nonzero values imply two-sided lighting</td>
</tr>
</tbody>
</table>
Material Properties

To set the material properties of a surface, use the `Material` command.

```
Material( face, argument, value,...value )
```

`face` can be `Front`, `Back`, or `Front_and_back`. (Note that the material properties can be set separately for the front and back faces of a polygon.)

Table 13.5 shows the arguments and default values for `Material` arguments.

**Table 13.5 Material Arguments and Default Values**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Default Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMBIENT</td>
<td>(0.2, 0.2, 0.2, 1.0)</td>
<td>Ambient color of material</td>
</tr>
<tr>
<td>DIFFUSE</td>
<td>(0.8, 0.8, 0.8, 1.0)</td>
<td>Diffuse color of material</td>
</tr>
<tr>
<td>AMBIENT_AND_DIFFUSE</td>
<td></td>
<td>Both AMBIENT and DIFFUSE</td>
</tr>
</tbody>
</table>
Table 13.5 Material Arguments and Default Values (Continued)

<table>
<thead>
<tr>
<th>Argument</th>
<th>Default Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPECULAR</td>
<td>(0.0, 0.0, 0.0, 1.0)</td>
<td>Specular color of material</td>
</tr>
<tr>
<td>SHININESS</td>
<td>0</td>
<td>Specular exponent that can range from 0 to 128.</td>
</tr>
<tr>
<td>EMISSION</td>
<td>(0, 0, 0, 1)</td>
<td>Emissive color of material</td>
</tr>
</tbody>
</table>

**Alpha Blending**

The `BlendFunc` command allows for alpha blending. To use it, send a `BlendFunc` message to a scene, for example:

```javascript
scene << BlendFunc(SRC_ALPHA, ONE_MINUS_SRC_ALPHA)
```

`SRC_ALPHA` and `ONE_MINUS_SRC_ALPHA` are OpenGL constants that tell `BlendFunc` to use alpha to blend against the existing display buffer. Disabling z-buffer testing or rendering primitives from back to front might be needed for some applications. By default, the z-buffer tests prevent anything from drawing behind a transparent polygon after it is drawn.

Complete details of all the constants available to `BlendFunc` (many of which are not useful to the JSL programmer) are available in the OpenGL documentation at opengl.org.

**Fog**

Fog enables figures to fade into the distance, making for more realistic models. All types of geometric figures can be fogged. To turn fog on, enable the `FOG` argument.

```
Enable (FOG)
```

**Example**

The following example uses several of the concepts presented in this section, including lighting, fog, and normalization. It draws a spinning cylinder that is affected by two lights.

```javascript
scene = Scene Box( 300, 300 ); // make a scene box
New Window( "Cylinder", scene ); // put the scene in a window

For( i = 1, i < 360, i++,

    scene << Clear;
    // the lens is 45 degrees, near is 3 units from the camera, far is 7.
    scene << Perspective( 50, 1, 10 );
```
```plaintext
scene << Translate( 0.0, 0.0, -2 );
// move the world so 0,0,0 is visible in the camera

scene << Enable( Lighting );
scene << Enable( Light0 );
scene << Enable( Light1 );
scene << Light( Light0, POSITION, 1, 1, 1, 1 ); // near viewer
scene << Light( Light0, DIFFUSE, 1, 0, 0, 1 ); // red light

scene << Light( Light1, POSITION, -1, -1, -1, 1 ); // behind object
scene << Light( Light1, DIFFUSE, .5, .5, 1, 1 ); // blue-gray light

scene << Enable( Fog );
scene << Enable( NORMALIZE );

scene << Rotate( i, 1, 0, 0 );
scene << Rotate( i * 3, 0, 1, 0 );
scene << Rotate( i * 3 / 2, 0, 0, 1 );
scene << Cylinder( 0.5, 0.5, 0.5, 40, 10 );
scene << Update;
Wait( 0.01 );
```

**Figure 13.18** Fog
Bézier Curves

A complete discussion of Bézier curves is beyond the scope of this book. JSL has several commands for defining and drawing curves and their associated meshes.

Figure 13.19 Bézier Curve

One-Dimensional Evaluators

To define a one-dimensional map, use the `Map1` command.

\[
\text{Map1}(\text{target}, \ u1, \ u2, \ stride, \ order, \ matrix)
\]

The `target` argument defines what the control points represent. Values of the `target` argument are shown in Table 13.6. Note that you must use the `Enable` command to enable the argument.

Table 13.6 Map1 Target Arguments and Default Values

<table>
<thead>
<tr>
<th>target Argument</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP1_VERTEX_3</td>
<td>((x, y, z)) vertex coordinates</td>
</tr>
<tr>
<td>MAP1_VERTEX_4</td>
<td>((x, y, z, w)) vertex coordinates</td>
</tr>
<tr>
<td>MAP1_INDEX</td>
<td>color index</td>
</tr>
<tr>
<td>MAP1_COLOR_4</td>
<td>R, G, B, A</td>
</tr>
<tr>
<td>MAP1_NORMAL</td>
<td>normal coordinates</td>
</tr>
<tr>
<td>MAP1_TEXTURE_COORD_1</td>
<td>(s) texture coordinates</td>
</tr>
<tr>
<td>MAP1_TEXTURE_COORD_2</td>
<td>(s, t) texture coordinates</td>
</tr>
<tr>
<td>MAP1_TEXTURE_COORD_3</td>
<td>(s, t, r) texture coordinates</td>
</tr>
<tr>
<td>MAP1_TEXTURE_COORD_4</td>
<td>(s, t, r, q) texture coordinates</td>
</tr>
</tbody>
</table>
The second two arguments (u1 and u2) define the range for the map. The \textit{stride} value is the number of values in each block of storage (in other words, the offset between the beginning of one control point and the beginning of the next control point). The \textit{order} should equal the degree of the curve plus one. The \textit{matrix} holds the control points.

For example, \texttt{Map1(MAP1_VERTEX_3, 0, 1, 3, 4, <4x3 matrix>)} is typical for setting the two end points and two control points to define a Bézier line.

You use the \texttt{MapGrid1} and \texttt{EvalMesh1} commands to define and apply an evenly spaced mesh.

\begin{verbatim}
MapGrid1(\textit{un}, \textit{u1}, \textit{u2})
\end{verbatim}

sets up the mesh with \textit{un} divisions spanning the range \textit{u1} to \textit{u2}. Code is simplified by using the range 0 to 1.

\begin{verbatim}
EvalMesh1(\textit{mode}, \textit{i1}, \textit{i2})
\end{verbatim}

actually generates the mesh from \textit{i1} to \textit{i2}. The \textit{mode} can be either \texttt{POINT} or \texttt{LINE}. The \texttt{EvalMesh1} command makes its own \texttt{Begin} and \texttt{End} clause.

The following example script demonstrates a one-dimensional outlier. A random set of control points draws a smooth curve. Only the first and last points are on the curve. Using \texttt{NPOINTS=4} results in a cubic Bézier spline.

\begin{verbatim}
boxwide = 500;
boxhigh = 400;

gridsize = 100; // bigger for finer divisions

NPOINTS = 4;
/* We suggest you use only values between 2 and 8 (inclusively). Numbers beyond these might be interpreted differently, depending on implementation. This value is the degree+1 of the fitted curve */

points = J( NPOINTS, 3, 0 );
// create an array of x,y,z triples
For( \textit{x} = 1, \textit{x} <= NPOINTS, \textit{x}++,
points[\textit{x}, 1] = (\textit{x} - 1) / (NPOINTS - 1) - .5;
// x from -.5 to +.5
points[\textit{x}, 2] = Random Uniform() - .5;
// y is random in same range
points[\textit{x}, 3] = 0;
// z is always zero, which causes the curve to stay in a plane
);

spline = Scene Box( boxwide, boxhigh );

spline << Ortho( -.6, .6, -.6, .6, -2, 2 );
// data from -.5 to .5 in x and y; this is a little larger
\end{verbatim}
spline << Enable(MAP1_VERTEX_3);
spline << MapGrid1(gridsize, 0, 1);
spline << Color(.2, .2, 1); // blue curve

spline << Map1(MAP1_VERTEX_3, 0, 1, 3, NPOINTS, points);
spline << Line Width(2); // not-so-skinny curve
spline << EvalMesh1(LINE, 0, gridsize); // also try LINE, POINT

spline << Color(.2, 1, .2);
spline << Point Size(4); // big fat green points

// show the points and label them
For(i = 1, i <= NPOINTS, i++,
    spline << Begin("POINTS");
    spline << Vertex(points[i, 1], points[i, 2], points[i, 3]);
    spline << End;
    spline << Push Matrix;
    spline << Translate(points[i, 1], points[i, 2], points[i, 3]);
    spline << Text(center, bottom, .05, Char(i));
    spline << Pop Matrix;
);

New Window("Spline", spline);

http://www.tinaja.com/glib/bezconn.pdf offers an explanation of connecting cubic segments so that both the slope and the rate of change match at the connection point. This example does not illustrate doing so; there is only one segment here.

Two-Dimensional Evaluators

Two-dimensional evaluators follow their one dimensional counterparts, and are used in a similar way.

\[
\text{Map2} \left( \text{target, u1, u2, ustride, vorder, v1, v2, vstride, vorder, matrix} \right)
\]
\[
\text{Eval Coord2} \left( u, v \right)
\]

Values for the \textit{target} argument are the same as those shown in Table 13.6 on page 609 with \textit{Map1} replaced with \textit{Map2} appropriately. The \textit{u1, u2, v1, and v2} values specify the range of the two-dimensional mesh.

For example, \textit{Map}2(MAP2_VERTEX_3, 0, 1, 3, 4, 0, 1, 12, 4, <16x3 matrix>) is typical for setting the 16 points that define a Bézier surface.

Use the \textit{MapGrid2} and \textit{EvalMesh2} commands to define and apply an evenly spaced mesh.

\[
\text{MapGrid2} \left( un, u1, u2, vn, v1, v2 \right)
\]
sets up the mesh with \(un\) and \(vn\) divisions spanning the range \(u1\) to \(u2\) and \(v1\) to \(v2\). Code is simplified by using ranges that span 0 to 1.

\[
\text{EvalMesh2}(\text{mode, } i1, i2, j1, j2)
\]

actually generates the mesh from \(i1\) to \(i2\) and \(j1\) to \(j2\). The \textit{mode} can be POINT, LINE, or FILL. The \texttt{EvalMesh2} command makes its own Begin and End clause.

### Using the Mouse

Mouse activity is supported through two feedback functions. The Patch Editor.jsl sample script uses these functions to support the dragging and dropping of points. Part of that script, the call-back function for mouse activity, is explained below. To run the script, open PatchEditor.jsl in the Scene3D folder inside the JMP Sample Scripts folder.

```javascript
topClick2d = Function( {x, y, m, k},
    dragfunc( x, boxhigh - y, m, 1, 2 );
    1;
);
frontClick2d = Function( {x, y, m, k},
    dragfunc( x, boxhigh - y, m, 1, 3 );
    1;
);
rightClick2d = Function( {x, y, m, k},
    dragfunc( x, boxhigh - y, m, 2, 3 );
    1;
);

Click3d = Function( {x, y, m, k, hitlist},
    If( m == 1,
        If( N Items( hitlist ) > 0,
            CurrentPoint = hitlist[1][3], /* first matrix in the list is the closest; 3rd element of matrix is ID*/
            CurrentPoint = 0
        );
        makePatch();
    );
    0; /* only cares about initial mouse down. return 1 if drag, release is needed, but then arcball does not happen. */
);

/* after one of the 3 Click2d functions figures out which axis of the model is represented by the screen X, Y, pass in to this common code */
dragfunc = Function( {x, y, m, ix, iy}, /* ix, iy are the index of the X, Y, or Z part of the coord in the points matrix */
    If( CurrentPoint > 0,
    
```
points[CurrentPoint, ix] = (x / boxwide) * (orthoright - ortholeft) + ortholeft;
points[CurrentPoint, iy] = (y / boxhigh) * (orthotop - orthobottom) + orthobottom;
makepatch();
}
);

When a 2-D function is called, the arguments are X, Y, M, K.

- X and Y are the coordinates of the mouse.
- M shows the state of the mouse and button. M=0 says that the mouse button is up. M=1 says that the button was just pressed. M=2 says that the button is down and the mouse is moving. M=3 says that the button was just released.
- K is related to the keys Shift, Alt, and control. K=1 for the Shift key, K=2 for the Control (command) key, and K=3 for the Alt (Option) key.

The 3-D function is called similarly. The arguments are X, Y, M, K, hitlist, where hitlist is a list of matrices

[[znear, zfar, id1, id2, id3, ...]]

znear, zfar is the Z distance from the camera of the near and far edge of the object. The matrices are sorted from near to far by the midpoint of znear, zfar. The ids in the list are the pushname, loadname, and popname values you just put in the display list.

The drag functions use a return value to tell if mouse processing should continue. That is the trailing “1” you see in the functions. Anything else stops the mouse tracking. This is needed because the 2-D and 3-D functions do not run in parallel. You might want the 2-D to return 0 and the 3-D to return 1 so the tracking would happen in 3-D rather than 2-D.

### Pick Commands

This SceneBox callback gets the 2-D mouse coordinates, and then uses Pick to determine the “named” object under the mouse. For example, hitlist is a 5x5 pixel pick box around x, y; up to 1000 items returned, but just the leaf names. The format of the return is determined by the last argument (1 returns a simple array, 0 returns a sorted (by depth) list of arrays).

```javascript
Track2d=function({x, y, m, k},
hitlist = theSceneBox<<pick( x, y, 5, 5, 1000, 1 );
if ( nrow(hitlist) > 0, // something IS in the pick box
... hitlist[1..n] // are names that you put in the display list
);
```

Contrast this with a call back Track3d function, where the pick rectangle is always 1x1 and picking only happens when the mouse moves. This is almost always what you want, but
points are difficult to pick because the 1x1 pick area is the same small size as the point. This function lets you pick without a mouse move.

The Track3d function always provides a depth-sorted list of arrays; each array can describe multiple names in a hierarchy (pushname and popname construct a hierarchy of objects). The sorting can be very slow when thousands of objects are selected. The final argument (1, above) controls whether the pick function replaces the sorted list of arrays with a simple array. The simple array contains only the “leaf” names, not higher level names.

Arguments

Arguments enable you to specify special modes and settings. To enable an argument, use the Enable(\textit{argument}) command. To disable an argument, use the Disable(\textit{argument}) command. Available arguments are shown in Table 13.7.

| Arguments                   | ALFA_TEST       | AUTO_NORMAL    | BLEND          | CLIP\_PLANE0    | CLIP\_PLANE1    | CLIP\_PLANE2    | CLIP\_PLANE3    | CLIP\_PLANE4    | CLIP\_PLANE5    | COLOR\_LOGIC\_OP | COLOR\_MATERIAL | CULL\_FACE     | DEPTH\_TEST    | DITHER        | FOG           | LIGHT0     | LIGHT1     | LIGHT2     | LIGHT3     | LIGHT4     |
|-----------------------------|----------------|----------------|----------------|----------------|----------------|----------------|----------------|----------------|----------------|----------------|----------------|---------------|---------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|-------------|
This chapter discusses scripting features that are particularly useful for production settings, such as the following:

- a Datafeed for capturing real-time data from a laboratory instrument
- using SAS, MATLAB, or R through JMP Scripting Language (JSL)
- using JMP with Microsoft Excel
- connecting to databases
- controlling JMP externally by OLE automation
- parsing XML

Some general JSL commands that might be of particular interest for use in a production setting include Caption, Speak, Print, Write, and Mail. These commands are described in “Functions that Communicate with Users” on page 270 in the “Programming Methods” chapter.
Real-Time Data Capture

A Datafeed is a real-time method to read data continuously, such as from a laboratory measurement device connected to a serial port. A Datafeed object sets up a concurrent thread with a queue for input lines that arrive in real time and are processed with background events. You set up scripts to interpret the lines and push the data to data tables, or do whatever else your process requires.

For example, submit this to get records from com1: and list them in the log.

```javascript
feed = Open Datafeed(
    Connect( Port("com1:" ), Baud( 9600 ), DataBits( 7 ) ),
    Set Script( Print( feed << GetLine ) )
);
```

**Figure 14.1** A Datafeed Window Shows the Status and Offers Controls

Create a Datafeed Object

To create a DataFeed object, use the `Open DataFeed` command with arguments specifying details about the connection:

```javascript
feed = Open DataFeed( options );
```

No arguments are required. You can simply create the Datafeed object and then send messages to it. Messages might include connecting to a port or setting up a script to process the data coming in. However, you would typically set up the basic operation of the data feed in the `Open DataFeed` command and subsequently send messages as needed to manage the data feed. Any of the options below work both as options inside `Open DataFeed` or as messages sent to a Datafeed object.

It’s a good idea to store a reference to the object in a global variable, such as `feed` above, so that you can easily send messages to the object. You can store a reference to an existing object by using a subscript; for example, to store a reference to the second data feed created:

```javascript
feed2 = Data Feed[2];
```

Datafeed Options

(Windows only) To connect to a live data source, use `Connect( )` and specify details for the port. Each setting takes only one argument; in this syntax summary the symbol `|` between argument choices means “or.” The `Port` specification is needed if you want to connect,
otherwise the object still works, but is not connected to a data feed. The last three items, DTR_DSR, RTS_CTS, and XON_XOFF, are Boolean to specify which control characters are sent back and forth to indicate when the Datafeed is ready to get data. Typically, you would turn on at most one of them.

```julia
feed = Open Datafeed(
    Connect(  
        Port( "com1:" | "com2:" | "lpt1:" | ... ),  
        Baud( 9600 | 4800 | ... ),  
        Data Bits( 8 | 7 ),  
        Parity( None | Odd | Even ),  
        Stop Bits( 1 | 0 | 2 ),  
        DTR_DSR( 0 | 1 ), // Data Terminal Ready  
        RTS_CTS( 0 | 1 ), // Request To Send | Clear To Send  
        XON_XOFF( 1 | 0 ) // Transmitter On | Transmitter Off
    )
);
```

This command creates a scriptable data feed object and stores a reference to it in the global variable `feed`. The `Connect` argument starts up a thread to watch a communications port and collect lines. The thread collects characters until it has a line, and then appends it to the line queue and schedules an event to call the script.

**Note:** For Datafeed purposes, a line of data is a single value (a datum). A line is not to be confused with a data table row, which can contain values for many variables on a subject.

Set Script attaches a script to the Datafeed object. This script is triggered by the On DataFeed handler whenever a line of data arrives. The argument for Set Script() is simply the script to run, or a global containing a script.

```julia
feed = Open Datafeed( Set Script( myScript ) );  
feed = Open Datafeed( Set Script( Print( feed << Get Line ) ) );
```

A Datafeed script typically uses `Get Line` to get a copy of one line and then does something with that line. Often it parses the line for data and adds it to some data table.

## Read in Real-Time Data

The term *live data feed* describes the way an external data source sends information via a physical or a logical communication link to another device. You can connect JMP to a live data feed through the serial port of your Windows computer to read a stream of incoming data in real time. Remember the following:

- The data feed must come through a standard nine-pin serial port. Data cannot be read through a USB port unless there is a driver that can simulate a serial port
• You need to know the exact baud rate, parity, stop bits, and data bits for the attached device.

Once you obtain the numbers for your device, enter them into the `Open Datafeed()` command in the script below. (The 4800, even, 2, and 7 in the script below are examples, so replace them with your information). Then connect the data feed to your computer and open and run the script:

```julia
streamScript = Expr(
    line = feed << Get Line;
    Show( line );
    len = Length( line );
    Show( len );
    If( Length( line ) >= 1,
        Show( "Hi" );
        Show( line );
        field = Substr( line, 5, 8 );
        Show( field );
        x = Num( field );
        Show( x );
        If( !Is Missing( x ),
            dt << Add Row( {:Column1 = x} );
            Show( x );
        );
    );
);
feed = Open Datafeed(
    Baud Rate( 4800 ),
    parity( even ),
    Stop bits( 2 ),
    Data bits( 7 )
);
feed << Set Script( streamScript );
feed << Connect;
```

To ensure harmony between the communications settings for JMP and the instrument reading data from an external source, select `File > Preferences > Communications`. Refer to the documentation for your instrument to find the appropriate settings.

### Manage a Datafeed with Messages

A Datafeed object responds to several messages, including `Connect` and `Set Script`. These are detailed above as arguments for `Open Datafeed`. They can also be sent as messages to a Datafeed object that already exists:

```julia
feed << Connect( port("com1:"), baud( 4800 ), databits( 7 ), parity( odd ), stopbits( 2 ) );
```
feed << Set Script( myScript );

The following messages could also be used as arguments to On Data Feed. However, it would be more common to send them as messages to a Datafeed object that is already present.

You can send lines to a Datafeed from a script. This is a quick way to test a Datafeed. Include a text argument or a global that stores text:

```julia
feed << Queue Line( "14" );
feed << Queue Line( myValue );
```

Here is a test script to queue five lines of data:

```julia
feed << Queue Line( "11" );
feed << Queue Line( "22" );
feed << Queue Line( "33" );
feed << Queue Line( "44" );
feed << Queue Line( "55" );
```

**Figure 14.2** Datafeed: 5 Lines Queued

To get the first line currently waiting in the queue, use a Get Line (singular) message. When you get a line, it is removed from the queue. Five lines were queued with the test script above, and Get Line returns the first line and removes it from the queue:

```julia
feed << Get Line
"11"
```

**Figure 14.3** Datafeed: 4 Lines Queued

To empty all lines from the queue into a list, use Get Lines (plural). This returns the next four lines from the test script in list `{ }` format.

```julia
myList = feed << GetLines;
{ "22", "33", "44", "55" }
```
To stop and later restart the processing of queued lines, either click the **Stop** and **Restart** buttons in the Datafeed window, or send the equivalent messages:

```
feed << Stop;
feed << Restart;
```

To close the Datafeed and its window:

```
feed << Close;
```

To disconnect from the live data source:

```
feed << Disconnect
```

### Examples of Datafeed

#### Reading Data

Here is a typical Datafeed script. It expects to find a string 3 characters long starting in column 11. If it does, it uses it as a number and then adds a row to the data table in the column “thickness.”

```julia
feed = Open Datafeed( );
myScript = Expr(
    line = feed << Get Line;
    If( Length( line ) >= 14,
        x = Num( Substr( line, 11, 3 ));
        If( !Is Missing( x ),
            dt << Add Row( {thickness = x} )
        );
    );
);
```

Assign the script to the data feed object by using **Set Script**:

```
feed << Set Script( myScript );
```

#### Set Up a Live Control Chart

Here is a sample script that sets up a new data table and starts a control chart based on the data feed.

```
dt = New Table( "Gap Width" ); // make a data table with one column
```
dc = dt << New Column( "gap", Numeric, Best );

// set up control chart properties
dt << Set Property(
	"Control Limits",
	{XBar( Avg( 20 ), LCL( 19.8 ), UCL( 20.2 ) )}
);
dt << Set Property( "Sigma", 0.1 );

// make the data feed
feed = Open Datafeed();
feedScript = Expr(
    line = feed << Get Line;
    z = Num( line );
    Show( line, z ); // if logging or debugging
    If( !Is Missing( z ),
        dt << Add Row( {:gap = z} )
    );
);
feed << Set Script( feedScript );

// start the control chart
Control Chart( Sample Size( 5 ),
    K Sigma( 3 ),
    Chart Col( gap,
        XBar( Connect Points( 1 ),
            Show Points( 1 ),
            Show Center Line( 1 ),
            Show Control Limits( 1 )
        ),
        R( Connect Points( 1 ),
            Show Points( 1 ),
            Show Center Line( 1 ),
            Show Control Limits( 1 )
        )
    )
);

/* Either start the feed from the device or test-feed some data to see it work (comment out one of the lines):
feed << Connect( Port( "com1:" ), Baud( 9600 ) );*/
For( i = 1, i < 20, i++,
feed << Queue Line( Char( 20 + Random Uniform() * .1 ) )
);

Store the Script in a Data Table

You can further automate the production setting by placing a Datafeed script such as the one above in an On Open data table property. A property with this name is run automatically each time the table is opened (unless you set a preference to suppress execution). If you save such a data table as a Template, opening the template runs the Datafeed script and saves data to a new data table file.

Table 14.1 DataFeed Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Data Feed</td>
<td>feed = Open Datafeed( commands )</td>
<td>Creates a data feed object. Any of the following can be used as commands inside Open DataFeed or sent as messages to an existing data feed object. Data Feed is a synonym.</td>
</tr>
<tr>
<td>Data Feed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Script</td>
<td>feed &lt;&lt; Set Script( script )</td>
<td>Assigns the script that is run each time a line of data is received.</td>
</tr>
<tr>
<td>Get Line</td>
<td>feed &lt;&lt; Get Line</td>
<td>Returns and removes one line from the Datafeed queue.</td>
</tr>
<tr>
<td>Get Lines</td>
<td>feed &lt;&lt; Get Lines</td>
<td>Returns as a list and removes all lines from the Datafeed queue.</td>
</tr>
<tr>
<td>Queue Line</td>
<td>feed &lt;&lt; Queue Line( string )</td>
<td>Sends one line to the end of the Datafeed queue.</td>
</tr>
<tr>
<td>Stop</td>
<td>feed &lt;&lt; Stop</td>
<td>Stops processing queued lines.</td>
</tr>
<tr>
<td>Restart</td>
<td>feed &lt;&lt; Restart</td>
<td>Restarts processing queued lines.</td>
</tr>
<tr>
<td>Close</td>
<td>feed &lt;&lt; Close</td>
<td>Closes the Datafeed object and its window.</td>
</tr>
</tbody>
</table>
Table 14.1 DataFeed Messages (Continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Syntax</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect</td>
<td>feed &lt;&lt; Connect(</td>
<td>(Windows only) Sets up port settings for the</td>
</tr>
<tr>
<td></td>
<td>Port( &quot;com1:&quot;</td>
<td>&quot;lpt1:&quot;</td>
</tr>
<tr>
<td></td>
<td>Baud( 9600</td>
<td>4800</td>
</tr>
<tr>
<td></td>
<td>Data Bits( 8</td>
<td>7 ),</td>
</tr>
<tr>
<td></td>
<td>Parity( None</td>
<td>Odd</td>
</tr>
<tr>
<td></td>
<td>Stop Bits( 1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>DTR_DSR( 0</td>
<td>1 ),</td>
</tr>
<tr>
<td></td>
<td>RTS_CTS( 0</td>
<td>1 ),</td>
</tr>
<tr>
<td></td>
<td>XON_XOFF( 1</td>
<td>0 )</td>
</tr>
<tr>
<td>Disconnect</td>
<td>feed &lt;&lt; Disconnect</td>
<td>(Windows only) Disconnects the device from the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Datafeed queue but leaves the Datafeed object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>active.</td>
</tr>
</tbody>
</table>

Dynamic Link Libraries (DLLs)

Note: 64-bit JMP cannot load 32-bit DLLs, and 32-bit JMP cannot load 64-bit DLLs. If you have a 32-bit DLL that you have used successfully in the past, but you are now using 64-bit JMP, you must recompile your DLL for 64-bit to be able to load it.

You can extend JMP functionality by using JMP Scripting Language (JSL) to load a DLL and call functions exported by that DLL. There is one JSL command and six messages that implement this functionality.

dll_obj = Load DLL("path" <, AutoDeclare(Boolean | Quiet | Verbose) |Quiet | Verbose > )

Load DLL() loads the DLL in the specified path. Use the AutoDeclare(Quiet) argument to suppress log window messaging.

Use the Declare Function message to define it and then call it.

dll_obj <<Declare Function("name", Convention(named_argument),
                        Alias("string"), Arg(type, "string"), Returns(type), other_named_arguments)
The *Alias* defines an alternate name that you can use in JSL. For example, if you declared *Alias*("MsgBox") for a function that is named "Message Box" in the DLL, then you would call it as follows:

```julia
result = dll_obj <<MsgBox(...) 
```

The named arguments for *Convention* are as follows:

- STDCALL or PASCAL
- CDECL

The type argument for both *Arg* and *Returns* can be one of the following:

<table>
<thead>
<tr>
<th>Type</th>
<th>Int8</th>
<th>UInt8</th>
<th>Int16</th>
<th>UInt16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Int32</td>
<td>UINT32</td>
<td>Int64</td>
<td>UINT64</td>
<td></td>
</tr>
<tr>
<td>Float</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AnsiString</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UnicodeString</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Struct</td>
<td>IntPtr</td>
<td>UIntPtr</td>
<td>ObjPtr</td>
<td></td>
</tr>
</tbody>
</table>

See the JSL Messages chapter in the *JSL Syntax Reference* for the *Declare Function* message arguments.

Finally, use the *UnLoadDLL* message to unload the DLL:

```julia
dll_obj << UnLoadDLL
```

**Example**

Suppose that you want the script to load a Windows 32-bit DLL or a 64-bit DLL based on the user’s computer. This example tests for the Windows operating system and then the computer processor’s bit level.

```julia
If( Host is( Windows ),
   If( 
      Host is( Bits64 ),
      // Load the 64-bit DLL.
      dll_obj = Load DLL( "c:\Windows\System32\user32.dll" ),
      // Load the 32-bit DLL.
      dll_obj = Load DLL( "c:\Windows\SysWOW64\user32.dll" ),
      // If neither DLL is found, stop execution.
      Throw
   );
   dll_obj << DeclareFunction( "MessageBoxW", 
      Convention( STDCALL ), 
      Alias( "MsgBox" ),
```
Scripting Guide Dynamic Link Libraries (DLLs)

```plaintext
Arg( IntPtr, "hWnd" ),
Arg( UnicodeString, "message" ),
Arg( UnicodeString, "caption" ),
Arg( UInt32, "uType" ),
Returns( Int32 )
);
result = dll_obj << MsgBox(
  0,
  "Here is a message from JMP."
  "Call DLL",
  321
);
Show( result );
);
dll_obj << UnLoadDLL

Other DLL Messages

The Show Functions message sends any functions that have been declared using Declare Function to the log:

dll_obj << Show Functions;

If you are writing your own DLL, you can create functions in it using JSL. The Get Declaration JSL message sends any JSL functions in your DLL to the log:

dll_obj << Get Declaration JSL;

For Simple DLL Functions

If your DLL contains functions that are very simple, the Call DLL message declares the specified function with the specified signature, as shown in Table 14.3.

dll_obj << Call DLL(function_name, signature, arguments)

<table>
<thead>
<tr>
<th>Signature</th>
<th>Argument is of Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>“v”</td>
<td>void</td>
</tr>
<tr>
<td>“c”</td>
<td>string</td>
</tr>
<tr>
<td>“n”</td>
<td>int</td>
</tr>
</tbody>
</table>

Then, the function is called, passing in the argument.

Example

dll_obj = Load DLL( "$DOCUMENTS\MyDLL.dll" );
// Load the DLL, given the specified path
dll_obj << CallDLL( "MyExportedFcn", "n", 654 );
dll_obj << UnLoadDLL();
/* Call the function inside the DLL named MyExportedFcn.
This function takes one numeric as input and in this case,
the value of the input argument is to be 654. */

Effectively, what these two lines accomplish is to call MyExportedFcn, passing 654 as input to
the function. Conceptually, it is as if the JSL script executed MyExportedFcn(654);

Using Sockets in JSL

Another tool that can be useful in establishing a live Datafeed is JSL Sockets. You can create
two types of sockets using JSL:

Stream  Stream sockets create a reliable connection between JMP and another computer. The
other computer might be running JMP, or it might be a vending machine, data collector,
printer, or other device that is capable of socket communication. Some devices implement
their interface as an HTTP web server.

Datagram  Datagram sockets create a less reliable connection between JMP and another
computer. Datagrams are connectionless and information might arrive multiple times, not
at all, and out of order. A datagram connection does not include all the overhead of a
stream connection that does guarantee reliability. Because datagrams are connectionless,
the destination address must be supplied each time (and for the same socket that can be
different each time).

Once a socket is created, it can do two things: wait for a connection from another socket, or
make a connection to another socket. Here is a simple example program that makes a
connection to another computer’s web server to get some data:

    tCall = Socket( );
    tCall << Connect( "www.jmp.com", "80" );
    tCall << Send( Char To Blob( "GET / HTTP/1.0~0d~0a~0d~0a", "ASCII~HEX" ) );
    tMessage = tCall << Recv( 1000 );
    text = Blob To Char( tMessage[3] );
    Show( text );
    tCall << Close( );

The first line creates a socket and gives it a reference name (tCall). By default, a stream socket
is created. You can designate the type of socket to create with an optional argument:
socket(STREAM) or socket(DGRAM).

The second line connects the tCall socket to port 80 (which is generally the HTTP port) of the
JMP website.
The third line sends a GET request to the JMP web server; this message tells the JMP web server to send the JMP home page back. The / that follows the word GET should be the path to the page to be opened. A / opens the root page.

The fourth line receives up to 1000 bytes from the JMP web server and stores a list of information in `tMessage`. Each socket call returns a list. The first element of the list is the name of the call, and the second is a text message, which might be `ok` or a longer diagnostic message. Additional elements, if present, are specific to the call. In this case, the third element in the list is the data received.

The fifth line converts the binary information received into a character string. `tMessage[3]` is the third item in the list returned by `Recv`; it is the data from the JMP web server.

The sixth line displays the data in the log.

The last line closes the socket. The web server has already closed the far end, so this socket either needs reconnecting or proper disposal (`close`).

The JMP Samples/Scripts folder contains several examples of scripts using sockets.

### Socket-Related Commands

Before creating and using a socket, you might need to retrieve information about the end that you want to connect to. `GetAddrInfo()` and `GetNameInfo()` each takes an address argument and an optional port argument and returns a list of information. For example:

```julia
Print( Get Addr Info( "www.sas.com" ));
Print( Get Addr Info( "www.sas.com", "80" ));
Print( Get Name Info( "149.173.5.120" ));
  {"Get Addr Info", "ok", {"PF_INET", "SOCK_0", "IPPROTO_0", "149.173.5.120", "0"}}
  {"Get Addr Info", "ok", {"PF_INET", "SOCK_0", "IPPROTO_0", "149.173.5.120", "80"}}
  {"Get Name Info", "ok", {"PF_INET", "SOCK_0", "IPPROTO_0", "www.sas.com", "0"}}
```

Sometimes there can be more than one answer. In that case, the sublist might be repeated one or more times. These functions can be quite slow; you probably should not try to build a data table of every website name with it. For IPV6 compatibility, you should generally use names like “www.sas.com” rather than the numerical form of an address.
Messages for Sockets

Once you have created a socket with `Socket()`, there are many messages that you can send to it.

- **connect**: Connects to a listening socket. Returns a list: `{"connect", "ok"}` if the connection was successful; or an error if not (for example, `{"connect", "CONNREFUSED: The attempt to connect was forcefully rejected. "}`).

- **close**: Closes the connection when you are finished with it. Returns a list (for example, `{"Close", "ok"}`).

- **send**: Sends a STREAM message to the other end of the socket.

- **sendto**: Sends a DGRAM message to the other end of the socket.

- **recv**: Receives a STREAM message. The data comes back in a list, along with some other information. `Recv` takes a required numeric argument that specifies the number of bytes to accept.

- **recvfrom**: Receives a DGRAM message.

- **ioctl**: Controls the socket’s blocking behavior. By default, JMP sockets block if no data is available; the socket does not return control to the JSL program until data is available. This makes scripts easy to write, but not particularly robust if the remote end of the connection fails to supply the data. A socket that is set for non-blocking behavior always returns immediately, either with an `ok` return code and some data, or with a "WOULDBLOCK: ..." return code, which means if it were a blocking socket, it would have to wait (block progress of the next JSL statement) until data became available.

  **Important**: Background operations that use a JSL callback avoid this issue; a socket used in a background `recv`, `recvfrom`, or `accept` is set to non-blocking and is polled during `wait` statements and when JMP is otherwise idle.

  `Ioctl` returns a list. For example, `{"ioctl", "ok"}`, or `{"ioctl", "NOTCONN: The socket is not connected. "}` if the socket has not been bound (see `bind`, below) or connected already.

- **bind**: Tells the server socket what address the client socket listens on. `Bind` associates a port on the local machine with the socket. This is required before a socket can `Listen`. (See below). `Bind` is not usually used on sockets that connect; the operating system selects an unused port for you. `Bind` is needed for a server because anyone that wants to connect to the server needs to know what port is being used. A common port is `80`, the HTTP port. `Bind` returns a list. For example, `{"bind", "ok"}`, or `{"bind", "ADDRNOTAVAIL: The specified address is not available from the local machine. "}` if you try binding to a name that is not on your machine. Another socket can connect to this socket if it knows your machine name and the number.

- **listen**: Tells the server socket to listen for connections. A listening socket is listening for connections from other sockets. You need only to put the socket into listen mode once.
Accept (see below) is used to accept a connection from another socket. Listen returns a list. For example, {"listen", "ok"}, or {"listen", "INVAL: The socket is (or is not, depending on context) already bound to an address. or, Listen was not invoked prior to accept. or, Invalid host address. or, The socket has not been bound with Bind."} if your bind call did not succeed.

**accept** tells the server socket to accept a connection and return a new connected socket. Accept returns a list stating what happened, and if successful, a new socket that is connected to the socket at the other end. For example, the returned list might be {"Accept", "ok", "localhost", \(\text{socket}()\)}. In this case localhost is the name of the machine that just connected, and the fourth argument is a socket that you can use to send or recv a message.

**getpeername** asks about the other end of a connection. GetPeerName returns a list with information about the other end's socket: {"getpeername", "ok", "127.0.0.1", "4087"}. If this is a server socket, you can discover the address and port of the client that connected. If this is a client socket, you re-discover the name and port of the server that you used in the connect request.

**getsockname** asks about this end of a connection. GetSockName returns a list with information about this socket: {"getsockname", "ok", "localhost", "httpd"}. If this is a client socket, you can discover the port the operating system assigned. If this is a server socket, you already know this information from a bind you already made.

---

**Database Access**

JMP supports ODBC access to SQL databases through JSL with the **Open Database** command.

```julia
dt = Open Database("Connect Dialog" | "DSN=...", // data source
                   "sqlStatement" | "dataTableName" | "SQLFILE=...", // SQL statement
                   Invisible, //Optional keyword to hide the table upon importing it
                   "outputTableName" // new table name
                   );
```

**Note:** Database table names that contain the characters $# -/%()&|;? are not supported.

The first argument is a quoted connection string to specify the data source. It should be either of the following:

- **"Connect Dialog"** to display the ODBC connection dialog box
- **"DSN="** and then the data source name and any other information needed to connect to the data source.
For example:

"DSN=dBASE Files;DBQ=C:/Program Files/SAS/JMP/13/Samples/Import Data;"

The second argument is a double-quoted string that can be one of the following:

1. An SQL statement to execute. For example, the second argument might be a SELECT statement in a quoted string like the following:

"SELECT AGE, SEX, WEIGHT FROM BIGCLASS"

2. The name of a data table. In this case, the effect is an SQL "SELECT * FROM" statement for the data table indicated. For example, Open Database would in effect execute the statement "SELECT * FROM BIGCLASS" if you specify this for the second argument:

"BIGCLASS"

3. "SQLFILE=" and a path to a text file containing an SQL statement to be executed. For example, with the following argument, JMP would attempt to open the file mySQLFile.txt from the C:\ directory and then execute the SQL statement in the file.

"SQLFILE=C:\mySQLFile.txt"

The optional Invisible argument creates a hidden data table. Hidden data tables remain in memory until they are explicitly closed, reducing the amount of memory that is available to JMP. To close the hidden data table, call Close(dt), where dt is the data table reference.

The optional outputTableName argument is optional and specifies the name of the output table to be created, if any. Note that Open Database does not always return a data table. The return value might be null. Whether it returns a data table depends on the type of SQL statement executed. For example, a SELECT statement would return a data table, but a DROP TABLE statement would not.

To save a table back to a database through JSL, send the data table reference a Save Database( ) message:

```
dt << Save Database("connectInfo", "TableName");
```

The first argument works the same way as it does in Open Database. Note that some databases do not allow you to save a table over one that already exists. If you want to replace a table in a database, use a DROP TABLE SQL statement in an Open Database command:

```
Open Database( "connectinfo", "DROP TABLE TableName" );
```

The following script opens a database with an SQL query, saves it back to the database under a new name, and then deletes the new table.

```
dt = Open Database("Connect Dialog",
    "SELECT age, sex, weight FROM \!"Bigclass\!"",
    "My Big Class"
);
dt << Save Database("Connect Dialog", "MY_BIG_CLASS");
```
Open Database( "Connect Dialog", "DROP TABLE BIGCLASS.MY_BIG_CLASS" );

**Note:** When you import data from an ODBC database, a table variable is added that can contain user ID and password information. To prevent this from happening, set the following preference: pref(ODBC Hide Connection String(1)); or go to File > Preferences > Tables and select the **ODBC Hide Connection String** option. See the JMP Preferences chapter in the *Using JMP* book for details.

### Creating a Database Connection and Executing SQL

You can use the following functions to handle more complex database operations:

- Create Database Connection( "Connection String With Password" );
- Execute SQL( db, "SQL statement", <invisible>, <"New Table Title"> );
- Close Database Connection( db );

Using these three functions, you can open a connection, call Execute SQL several times, and then close the connection. Create Database Connection returns a handle for use in Execute SQL and Close Database Connection.

Depending on the SQL submitted, a table might or might not be returned. A SELECT statement typically returns a JMP table. INSERT INTO would not return a table, because it is modifying one in the database.

**Example**

Open a connection to your database:

```javascript
dbc = Create Database Connection(  
    "DSN=dBASE Files;DBQ=$SAMPLE_IMPORT_DATA/;"
);
```

Execute one or more SQL statements using this connection:

```javascript
dt = Execute SQL(  
    "SELECT HEIGHT, WEIGHT FROM Bigclass",  
    "NewTable"
);
```

When you are finished, close your connection.

```javascript
Close Database Connection( dbc );
```

### Writing a SQL Query

The Query() function enables you to manipulate JMP data tables using SQL statements. The SQL statement is the only required argument to Query(). However, most interesting SQL
statements refer to one or more data tables. Any data table that the SQL statement refers to must be passed in using a table reference argument.

A table reference argument can be a data table reference (dt in the following example):

```plaintext
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
result = Query( dt, "SELECT * FROM 'Big Class' WHERE age > 14;" );
```

The SQL statement in the preceding example includes the name of the JMP data table. If the data table path is long, you might want to use an alias for the data table in the SQL statement. To use an alias, pass the table reference as a Table() argument:

```plaintext
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
result = Query( Table( dt, "t1" ), "SELECT * FROM t1 WHERE age > 14;" );
```

Using Table() to alias your data tables also enables you to write SQL statements for multiple queries with tables that have different names without rewriting the statements.

**Private and Hidden Data Tables**

If you want the data table that is produced by Query() to be either private or hidden, you can pass either Private or Invisible as arguments to Query().

```plaintext
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
result = Query( dt, invisible, "SELECT * FROM 'Big Class' WHERE age > 14;" );
```

**Returning a Single Value**

The Query() function normally returns the result of the query as a JMP data table. However, sometimes you might write a SQL query that returns a single value; you would rather have Query() return that value instead of placing the value in a JMP data table. You can do that by passing the Scalar argument.

```plaintext
dt = Open( "SAMPLE_DATA/Big Class.jmp" );
result = Query( 
  Table( dt, "t1" ), 
  Scalar, 
  "SELECT AVG(height) FROM t1 WHERE age > 14;"
 );
```

The preceding query returns 65, the average height of students older than 14.
Working with SAS

Make a SAS DATA Step

Sending Make SAS Data Step to a data table returns the text for a SAS DATA Step that can re-create the data table in SAS. For example,

```sas
dt << Make SAS Data Step
```

prints a DATA Step to the log that can be used in the SAS Program Editor.

Sending Make SAS Data Step Window produces this code in a window with a .SAS suffix, so that it can be easily sent to SAS.

Create SAS DATA Step Code for Formula Columns

Sending Get SAS Data Step for Formula Columns to a data table includes column formulas in the SAS data step code. Here is an example that outputs the formula for the Ratio column:

```sas
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "Ratio", Formula( :height / :weight ));
dt << Get SAS Data Step for Formula Columns;
```

This script output the following code to the log:

```sas
/*%PRODUCER: JMP - DataTable Formulas */
/*%TARGET: Ratio */
/*%INPUT: height */
/*%INPUT: weight */
/*%OUTPUT: Ratio */
/* Code to score Ratio */
Ratio =height/weight
drop ;
```

To get formulas for all columns, omit the column names as shown here:

```sas
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << Get SAS Data Step for Formula Columns;
```

You can also include column formulas in scoring code for SAS Model Manager. Send Get MM SAS Data Step for Formula Columns to the data table.

```sas
dt = Open( "$SAMPLE_DATA/Tiretread.jmp" );
dt << Get MM SAS Data Step for Formula Columns;
```

The results of this script are also shown in the log.

As with Get SAS Data Step for Formula Columns, specifying column names is optional.
SAS Variable Names

SAS Open For Var Names( ) opens a SAS data set only to obtain the names of its variables, returning those names as a list of strings.

The rules for SAS variable names are more strict than those of JMP. The SAS Name function converts JMP variable names to SAS variable names, changing special characters and blanks to underscores, and various other transformations to produce a valid SAS name.

\[
\text{result} = \text{SAS Name(name);} \\
\text{result} = \text{SAS Name({list of names});}
\]

If the argument is a list of names, the result is a blank-separated character string of names. For example,

\[
\text{SAS Name({"x 1", "x 2"})}
\]

produces

\[
"x_1 x_2"
\]

Get the Values of SAS Macro Variables

JMP provides several methods for querying SAS macro variables.

To show the systime value:

\[
systime = \text{sas} \ll \text{Get Macro Var("SYSTIME");} \\
\text{show(systime);} \\
\]

To show the defined SAS macro variables:

\[
\text{macro_names} = \text{sas} \ll \text{Get Macro Var Names();} \\
\text{show(macro_names);} \\
\]

To iterate through the SAS macro variables and print out the values:

\[
\text{macro_names} = \text{sas} \ll \text{Get Macro Var Names();} \\
\text{For( i = 1, i <= N Items(macro_names), i++,} \\
\text{macro_value} = \text{sas} \ll \text{Get Macro Var(macro_names[i]);} \\
\text{output} = \text{macro_names[i]} \ | \ " \ | \ \text{Char(macro_value);} \\
\text{\text{Show(output);}} \\
\]

To submit SAS code that defines “test” as a SAS macro variable and then gets the value from SAS:

\[
\text{sas} \ll \text{Submit("%let test = 1;" );} \\
\text{test} = \text{sas} \ll \text{Get Macro Var("test");} \\
\text{Show(test);} \\
\]
All macro variable values will evaluate to numbers, if possible, otherwise they will be characters.

**Connect to a SAS Metadata Server**

You can connect to a SAS server and work directly with SAS data sets. Making connections and interacting with SAS data sets is scriptable through JSL. For more information, see the Import Your Data chapter in the *Using JMP* book.

**Make the Connection**

First, use the `Meta Connect()` command to connect to a SAS metadata server:

```javascript
connected = Meta Connect( "MyMetadataServer", port );
```

To specify the SAS version for the metadata server, use the `SASVersion` named argument:

```javascript
connected = Meta Connect( "MyMetadataServer", port, SASVersion("9.4") );
```

If you supply only the machine name (for example, myserver.mycompany.com) and the port, you are prompted to provide the authentication domain, your user name, and your password. You can also specify all that in JSL:

```javascript
connected = Meta Connect( "MyMetadataServer", port, "authdomain", "user name", "password" );
```

When you are finished using the SAS metadata server, use `Meta Disconnect()` to disconnect the connection. No arguments are necessary; the command closes the current metadata server connection.

You can see the repositories that are available on a metadata server and set the one that you want to use:

```javascript
Meta Get Repositories();
{"Foundation"}
Meta Set Repository( "Foundation" );
```

Note that if there is only one repository available, it is selected automatically and you do not need to explicitly set it.

Once your repository is set, you can view the servers that are available:

```javascript
mylist = Meta Get Servers();
{"SASMain", "Schroedl", "SASMain_ja", "SASMain_zh", "SASMain_ko", "SASMain_fr", "SASMain_de", "SASMain_Unicode"}
```

Next, set your SAS connection. You can also use this command to connect directly to a local or remote server instead of using a metadata server.

```javascript
conn = SAS Connect( "SASMain" );
```
Now you can send Disconnect and Connect messages to the `conn` object to close and open the SAS connection.

```sas
    conn << Disconnect();
    conn << Connect();
```

This is an example of using an object and messages with SAS server connections. You might have also connected to SAS servers using global functions. If so, the Disconnect and Connect messages do not affect those global connections. However, if there is no active global connection, that global connection is set to the connection opened by the object.

**Automatically Connect SAS Libraries**

When you connect to a SAS server, use `Connect Libraries` to automatically connect metadata-defined libraries.

```sas
    conn = SAS Connect( "SASMain", Connect Libraries( 1 ) );
```

All metadata-defined libraries are connected, which can slow down your connection.

To connect specific libraries later, use the SAS `Connect Libref` function or `Connect Libref` message to a SAS server object.

**View SAS Libraries**

After you connect to a SAS server, use the SAS `Get Lib Ref()` command to view the libraries on that server:

```sas
    librefs = SAS Get Lib Refs();
```

If the library containing the data that you want is not assigned, assign it:

```sas
    librefs = SAS Assign Lib Refs( "MyLib", "$DOCUMENTS\data" );
```

**Open SAS Data Sets**

First, assign a SAS library reference:

```sas
    SAS Assign Lib Refs( "MyLib", "$DOCUMENTS" );
```

The first argument is any name that you want to use to refer to the library reference. The second is the path on the server where the data sets are located.

Next, get the list of data sets in the selected library:

```sas
    datasets = SAS Get Data Sets( "MyLib" );
    ```
Now you can open a data set:

```julia
dt = SAS Import Data( "MyLib", "PURCHASES" );
```

or

```julia
dt = SAS Import Data( librefs[1], datasets[12] );
```

or

```julia
dt = SAS Import Data( "MyLib.PURCHASES" );
```

Now you can get information about any SAS data set in that library. For example, you can get a list of variables:

```julia
bookvars = SAS Get Var Names( "MyLib.PURCHASES" );
{
"purchaseyear", "purchasemonth", "purchaseday", "bookid", "catid",
"pubid", "price", "cost"
}
```

With that information, you can choose to import only part of the data set by specifying the variables to import.

```julia
dt = SAS Import Data( librefs[1], datasets[12], columns( bookvars[1], bookvars[2], bookvars[4] ) );
```

**Save SAS Data Sets**

To save a JMP data table or an imported SAS Data Set, use the `SAS Export Data()` command:

```julia
SAS Export Data( dt, librefs[1], datasets[4], ReplaceExisting );
```

**Run a Stored Process**

To get a reference to a stored process:

```julia
stp = Meta Get Stored Process( "Samples/Stored Processes/Sample: Hello World" );
```

There is no way to acquire a list of stored processes through JSL; you must know the path to the stored process that you want to run.

To run it, send the stored process a message:

```julia
stp << Run();
```

**Submit SAS Code from JMP**

You can also directly submit SAS code and get back SAS results. For example:

```julia
SAS Submit( "proc print data=sashelp.class; run;" );
```
Two optional arguments control whether you see the output and the SAS log in JMP:

```
SAS Submit( "SAS Code" <,No Output Window(True|False)> <,Get SAS
Log(True|False)> );
```

You can also see the SAS Log at any time using the command

```
SAS Get Log();
```

SAS Get Log() returns the contents, which can be placed in a JSL variable and used like any JSL string.

### Preferences

To get the current SAS version preference, use:

```
Get SAS Version Preference();
```

To set the current SAS version preference, use:

```
Preference( SAS Integration Settings( SASVersion( "9.4" ) ) );
```

### Sample Scripts

The JMP Samples/Scripts/SAS Integration folder contains sample scripts. To run the stored process scripts successfully, the stored processes need to be placed on your SAS Metadata Server. The stored processes can be found in the `sampleStoredProcesses.spk` file, also in this folder.

#### To import `sampleStoredProcesses.spk` into your SAS Metadata Server:

**Caution:** We recommend that you import these stored processes into a SAS Metadata Server that is used for testing rather than into a production system.

1. Run SAS Management Console.
2. Connect to your SAS Metadata Server using an account with administrative privileges.
3. Expand the BI Manager node in the left pane of the SAS Management Console.
4. Navigate to the folder in the tree under which you would like to create the imported sample stored processes.
5. Right-click on that folder in either the left pane or the right pane of the SAS Management Console and select **Import**.
   The Import Wizard appears.
6. Enter the full path to `sampleStoredProcesses.spk` or use the **Browse** button to navigate to it.
7. Select **All Objects** in the Import Options section of the wizard.
8. Click Next.

The next panel reports that during the import process, you must specify values for Application servers and Source code repositories.

9. Click Next.

Select which of the application servers defined in your SAS Metadata Server that you would like to use to execute the imported stored processes.

10. Select an application server from the drop-down list under Target.

11. Click Next.

Select the source code repository (directory) defined on your SAS Metadata Server where you would like the SAS code for the imported stored processes to be placed.

12. Select a source code repository from the drop-down list under Target Path.

13. Click Next.

The next panel gives a summary of what occurs if you click Import.

14. Review the information about the panel, and if it looks correct, click Import.

15. During the Import process, you might be asked to provide login credentials for connecting to the metadata server to perform the import. Provide credentials with administrative privileges and click OK.

After the import completes, you will find a folder named BIP Tree under the folder that you imported the stored processes into. Under BIP Tree is a folder named JMP Samples, and in the JMP Samples folder are two sample stored processes: Shoe Chart and Diameter.

Please note that the paths to the sample stored processes needs to be adjusted in the sample scripts storedProcessHTML.jsl and storedProcessJSL.jsl to match the folder into which you imported the sample stored processes. Otherwise, these scripts will not work correctly.

---

**Working with MATLAB**

MATLAB, a product of MathWorks Inc., provides an interactive working environment for analyzing and visualizing computational models. MATLAB is available for Windows (both 32-bit and 64-bit), Macintosh OS X, and Linux (64-bit). JMP supports MATLAB on both Windows and Macintosh platforms.

You can interact with MATLAB using JMP Scripting Language (JSL):

- Submit statements to MATLAB from within a JSL script.
- Exchange data between JMP and MATLAB.
- Display graphics produced by MATLAB.
See the JSL Functions chapter in the *JSL Syntax Reference* book for details on using MATLAB functions in JMP.

Textual output and error messages from MATLAB appear in the Log window.

### Installing MATLAB

MATLAB must be installed on the same computer as JMP.

Because JMP is both a 32-bit and a 64-bit Windows application, you must install the corresponding 32-bit or 64-bit version of MATLAB. For the supported version of MATLAB, see the JMP website: [http://www.jmp.com/system/](http://www.jmp.com/system/).

### How JMP Finds MATLAB

JMP delays loading MATLAB until a JSL-based script requires access to it. When you run a JSL script that calls MATLAB, JMP locates the software based on the operating system’s PATH environment variable (for example, C:\Program Files\MATLAB\R2012a\).

### Test Your Install

To verify that your computer is able to run JSL-based scripts using MATLAB:

1. Run the following JSL script:

   ```julia
   MATLAB Init();
   MATLAB Submit( "m = magic(3)" );
   magicMat = MATLAB Get( m );
   Show( magicMat );
   MATLAB Term();
   
   The MATLAB function `M = magic(3)` returns a 3-by-3 matrix using integers in the range of 1 to $3^2$ with equal row and column sums. This matrix is called a magic square.
   
2. Select View > Log.

   You should see the following response in the log window:

   ```plaintext
   m =
   
   8 1 6
   3 5 7
   4 9 2
   
   magicMat =
   [ 8 1 6,
     3 5 7,
     4 9 2];
   0
   ```
If you see the following message in the log window:

An installation of MATLAB cannot be found on this system.

1. Add a new environment variable with the name of `MATLABROOT` and a value of `C:\Program Files\MATLAB\R2012a` or `C:\Program Files (x86)\MATLAB\R2012a`.

   **Note:** The path entered depends on the MATLAB installation path.

2. Verify that the MATLAB path is included in the `PATH` variable.

3. Run the script again to ensure JMP can access MATLAB.

---

**Working with R**

You can interact with R using JSL:

- Submit statements to R from within a JSL script.
- Exchange data between JMP and R.
- Display graphics produced by R.

Text output and error messages from R appear in the log window.

**Installing R**

Install R on the same computer as JMP. You can download R from the Comprehensive R Archive Network website:

[http://cran.r-project.org](http://cran.r-project.org)

Because JMP is supported as both a 32-bit and a 64-bit Windows application, you must install the corresponding 32-bit or 64-bit version of R. For the supported version of R, see the system requirements on the JMP website:

[http://www.jmp.com/support/system_requirements_jmp.shtml](http://www.jmp.com/support/system_requirements_jmp.shtml)

**Override Default R Install Location**

Normally JMP determines R_HOME internally if it is not defined in the Windows system registry:

**64-bit R Install**

```
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\R-code\R\InstallPath
```

**32-bit R Install**

```
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\R-code\R\InstallPath
```
To override the default R installation location, define the R_HOME environment variable using either of the two following methods:

1. Create the variable in your system environment variables using the Control Panel, select Start > Control Panel > System > Advanced system settings.
2. Click Environment Variables.
3. In the System variables pane, click New.
4. Type R_HOME for the Variable name.
5. Type the path to the R.exe file (for example, C:\Program Files\R\R-2.15.3).
6. Click OK and click OK again to close the System Properties window.

or

Create the variable using the JSL Set Environment Variable() function:

Set Environment Variable( "R_HOME", "C:\Program Files\R\R-2.15.3" );

How JMP Finds R

JMP delays loading R until a JSL-based script requires access to it. When JMP needs to load R, it follows the standard steps for finding R on a Windows computer:

1. Look up the environment variable R_HOME.
   If the variable exists, load R from the specified directory.
2. If the environment variable R_HOME does not exist, look up the InstallPath value in the Windows registry under the following key:
   HKEY_LOCAL_MACHINE\SOFTWARE\R-core\R
   For 32-bit JMP running on a 64-bit machine, the InstallPath value is under the following key:
   HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432NODE\R-core\R
   If the InstallPath value exists, load R from the specified directory.
3. If the InstallPath value does not exist, an error message states that R could not be found.

Testing Your Setup

To test that your computer is able to run JSL-based scripts that use R, run the following JSL script:

R Init();
R Submit( "
   x <- 1:5
   x
" );
R Term();
You should see the following output in the log:

```
[1] 1 2 3 4 5
```

**JMP to R Interfaces**

The following JMP interfaces are provided to access R. The basic execution model is to first initialize the R connection, perform the required R operations, and then terminate the R connection. In most cases, these functions return 0 if the R operation was successful, or an error code if it was not. If the R operation is not successful, a message is written to the log. The single exception to this is `R Get()`, which returns a value.

**R JSL Scriptable Object Interfaces**

The R interfaces are also scriptable using an R connection object. A scriptable R connection object can be obtained using the `R Connect()` JSL function.

**Conversion Between JMP Data Types and R Data Types**

Table 14.4 shows what JMP data types can be exchanged with R using the `R Send()` function. Sending lists to R recursively examines each element of the list and sends each base JMP data type. Nested lists are supported.

**Table 14.4** Equivalent JMP and R Data Types for R Send()

<table>
<thead>
<tr>
<th>JMP Data Type</th>
<th>R Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric</td>
<td>Double</td>
</tr>
<tr>
<td>String</td>
<td>String</td>
</tr>
<tr>
<td>Matrix</td>
<td>Double Matrix</td>
</tr>
<tr>
<td>List</td>
<td>List</td>
</tr>
<tr>
<td>Data Table</td>
<td>Data Frame</td>
</tr>
<tr>
<td>Row State</td>
<td>Integer</td>
</tr>
<tr>
<td>Datetime</td>
<td>Date and Time</td>
</tr>
<tr>
<td>Duration</td>
<td>Time/Duration</td>
</tr>
</tbody>
</table>

**Example**

```r
R Init();
X = 1;
R Send(X);
```
S = "Report Title";
R Send( S );
M = [1 2 3, 4 5 6, 7 8 9];
R Send( M );
R Submit( "X
S
M
" );
R Term();

Table 14.5 shows what JMP data types can be exchanged with R using the R Get() function. Getting lists from R recursively examines each element of the list and sends each base R data type. Nested lists are supported.

<table>
<thead>
<tr>
<th>R Data Type</th>
<th>JMP Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double</td>
<td>Numeric</td>
</tr>
<tr>
<td>Logical (Boolean)</td>
<td>Numeric (0</td>
</tr>
<tr>
<td>String</td>
<td>String</td>
</tr>
<tr>
<td>Integer</td>
<td>Numeric</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Datetime</td>
</tr>
<tr>
<td>Time/Duration</td>
<td>Duration</td>
</tr>
<tr>
<td>Factor</td>
<td>Expanded to a list of Strings or a Numeric matrix</td>
</tr>
<tr>
<td>Data Frame</td>
<td>Data Table</td>
</tr>
<tr>
<td>List</td>
<td>List of converted R data types</td>
</tr>
<tr>
<td>Matrix</td>
<td>Numeric Matrix</td>
</tr>
<tr>
<td>Numeric Vector</td>
<td>Numeric Matrix</td>
</tr>
<tr>
<td>String Vector</td>
<td>List of Strings</td>
</tr>
<tr>
<td>Graph</td>
<td>Picture</td>
</tr>
<tr>
<td>Time Series</td>
<td>Matrix</td>
</tr>
</tbody>
</table>
JMP Scoping Operators and R

A JMP object sent to R using `R Send()` uses the same JMP reference as the name of the R object that gets created. For example, sending the JMP variable `dt` to R creates an R object named `dt`. The colon and double colon scoping operators (`:` and `::`) are not valid in R object names, so these are converted as follows:

- A single colon scoping operator is replaced with a period (`.`).
  For example, sending `nsref:dt` to R creates a corresponding R object named `nsref.dt`.
- A double colon scoping operator (designating a global variable) is ignored.
  For example, sending `::dt` to R creates a corresponding R object named `dt`.

Using `R Name()` with `R Send()`

The `R Name()` option to `R Send()` has an argument that is a quoted string that contains a valid R object name. The JMP object sent to R becomes an R object with the name specified. For example:

```r
R Send( jmp_var_name, R Name( "r_var_name") );
R Submit( "print(r_var_name)" )
```

Example

This example creates a variable `x` in the `Here` namespace, a variable `y` in the global namespace, and a variable `z` that is not explicitly referenced to any namespace. The variable `z` defaults to `Global` unless `Names Default To Here(1)` is on. These variables are then passed to R.

```r
Here:x = 1;
::y = 2;
z = 3;

R Init(); // Initiate the R connection
R Send( Here:x );
/* Send the Here variable to R.
Here:x creates the R object Here.x */
R Submit( "print(Here.x)" );
/* Note that the JMP log labels the output with the original JMP variable
reference Here:x. */

R Send( ::y ); // ::y creates the R object y
R Submit( "print(y)" );

R Send( Here:x, R Name( "localx" ) );
// To use a different name for the R object, use the R Name() option
R Submit( "print(localx)" );
```
/* The R Name option to the R Send() command creates the R object named 
"localx" corresponding to the JMP variable "Here:x". Again the log shows 
the original corresponding JMP variable name. */

R Send( z ); // z creates the R object z
R Submit( "print(z)" );

Troubleshooting

Recording Output

On Windows, if you want to record output to the graphics window, send the following R code 
using R Submit( ).

    windows.options( record = TRUE );

Character Vectors

A JMP list of strings is not the same as an R character vector. If you send a list of strings to R, it 
becomes a list of strings in R, not a character vector. You can use the R function Unlist to 
convert it:

    R Init();
    X = {"Character", "JMP", "List"};
    R Send( X );
    R Submit( "class(X)" );
    /* R output is: 
       [1] "list"
    */

    R Submit( "Y<-unlist(X) 
               class(Y)" );
    /* Object Y is now a character vector. The R output is: 
       [1] "character"
    */

    R Term();

Element Names

A feature of an R list (called attributes) lets you associate a name with each element of the list. 
You can use the name to access that element instead of having to know the position of it in the list.

In the following example, the list that is created in R has two elements named x and y that are 
created using the List() function of R. When you bring the R list into JMP and then send it
back to R, the names are lost. Therefore in R, you cannot access the first matrix using pts$x. Instead, you must use the index using pts[[1]].

```r
R Init();
R Submit("pts <- list(x=cars[,1], y=cars[,2])
  summary(pts)
");

JMP_pts = R Get( pts );

R Send( JMP_pts );
R Submit("Summary( JMP_pts )
");
R Term();
```

**Examples**

**Sending a Data Table to R**

This example initiates an R connection, sends a data table to R, prints it to the log, and closes the R connection.

```r
R Init();
dt = Open( "$SAMPLE_DATA/Big Class.jmp", invisible );
R Send( dt ); // send the opened data table represented by dt to R;
R Submit("print( dt )" );
R Term();
```

**Creating Objects in R**

This example initiates an R connection, creates an R object, retrieves the object into JMP, and closes the R connection.

```r
R Init();
R Submit("L3 <- LETTERS[1:3]
d <- data.frame(cbind(x=1, y=1:15), Group=sample(L3, 15, repl=TRUE))
");
R Get( d ) << NewDataView;
R Term();
```
Using R Functions and Graphics

This example initiates an R connection and plots the normal density function in R using the R graphics device. Then the graph is retrieved from R and displayed in JMP. Finally, the R connection is closed.

```r
R Init();
R Submit("\[plot(function(x) dnorm(x), -5, 5, main = "Normal(0,1) Density")\]");
picture = R Get Graphics("png");
New Window("Picture", picture);
Wait(10);
R Term();
```

Simple Matrix Addition in R

This example initiates an R connection, sends a matrix to R, creates a matrix in R, adds them together, returns the new matrix to JMP, and closes the R connection.

```r
R Init();
X = J(2, 2, 1);
R Send(X);
R Submit("X"
X #Prints X to the log
Y <- matrix(1:4, nrow=2, byrow=TRUE) #Makes a 2x2 matrix object Y
Y #Prints Y to the log
Z <- X + Y #Matrix object Z is addition of X and Y
";
);
Z = R Get(Z);
R Term();
Show(Z);
```

A Bootstrap Sample

See the file JMPtoR_bootstrap.jsl in the sample scripts folder for an example script.

This script performs a bootstrap simulation by using the JMP to R Project integration.

The script produces a JMP window that asked the user to specify the variable to perform bootstrapping over. Then the user selects a statistic to compute for each bootstrap sample. Finally, the data is sent to R using the R interface in JSL.

The boot package in R is used to call the boot() function and the boot.ci() function to calculate the sample statistic for each bootstrap sample and the bootstrap confidence interval.

The results are brought back to JMP and displayed using the JMP Distribution platform.
Working with Microsoft Excel

You can script the Profiler interface to Microsoft Excel, although not the Transfer to JMP interface. The basic syntax is as follows:

```javascript
excel_obj = Excel Profiler(
  Workbook( "excel_workbook_path" ),
  Model( "name_of_model" )
);
```

The `Model` argument is optional. If you supply only the workbook, you are prompted to select the model. You do not need to specify the worksheet, because the model is found no matter where it is located.

Once you have a Microsoft Excel Profiler object, you can send the following messages to run the JMP prediction profiler using the Microsoft Excel model. For example:

```javascript
excel_obj <<Prediction Profiler( 1 );
```

Parsing XML

JSL has several commands available to parse XML.

```javascript
Parse XML( string, On Element( "tagname", Start Tag( expr ), End Tag( expr ) ) );
```

parses an XML expression using the `On Element()` expression for specified XML tags.

```javascript
value = XML Attr( "attribute name" );
```

extracts the string value of an XML argument when evaluating a `Parse XML()` expression.

```javascript
value = XML Text();
```

extracts the string text of the body of an XML tag when evaluating a `Parse XML()` expression.

Example of Parsing XML

Suppose that a Microsoft Excel file contains one row of data from Big Class.jmp. The file is saved as the valid XML document `BigclassExcel.xml`, shown here and also saved in the JMP Samples/Import Data folder.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<Workbook xmlns="urn:schemas-microsoft-com:office:spreadsheet"
  xmlns:o="urn:schemas-microsoft-com:office:office"
  xmlns:x="urn:schemas-microsoft-com:office:excel"
  xmlns:ss="urn:schemas-microsoft-com:office:spreadsheet"
  xmlns:html="http://www.w3.org/TR/REC-html40">
<Worksheet ss:Name="Bigclass">
```
The following script reads BigclassExcel.xml and creates a JMP data table with the information in it. This script, named ParseXML.jsl, is in the JMP Samples/Scripts folder.

```javascript
file contents = Load Text File( "$SAMPLE_IMPORT_DATA/BigclassExcel.xml" );
Parse XML( file contents,
  OnElement("urn:schemas-microsoft-com:office:spreadsheet^Worksheet",
    StartTag( sheetname = XML Attr("urn:schemas-microsoft-com:office:spreadsheet^Name",
      "Untitled" ),
      dt = New Table( sheetname );
      row = 1;
      col = 1;
    ) ),
  OnElement("urn:schemas-microsoft-com:office:spreadsheet^Row",
    StartTag( If( row > 1, // assume first row has column names
      dt << Add Rows( 1 )
    ) ),
    EndTag( row++;
```
OLE Automation

Most of JMP can be driven through OLE automation. Please see the Automation Reference.pdf in JMP/13/Documentation for details about automating JMP. This document introduces how to automate JMP through Visual Basic and using Visual C++ with MFC. It also contains details for the methods and properties that JMP exposes to automation clients like Visual Basic and Visual C++.

In addition to providing platforms for quickly analyzing data, JMP lets you create applications to support your specific needs. You often perform the same tasks every day (such as running Distribution and Fit Model analyses on a data table and viewing the results). In JMP’s Application Builder, you can create an application that shows the results for both analyses in one window. Application Builder’s drag-and-drop interface reduces the amount of scripting required to create an application.

Add-In Builder visually guides you through creating an add-in that users can install in JMP. And after creating an application in Application Builder, use Add-In Builder to save the application as an add-in. This allows users to install the application and quickly run it inside JMP.

Figure 15.1 Creating Customized Reports in Application Builder
Create Applications with Application Builder

Application Builder’s drag-and-drop interface lets you visually design windows with buttons, lists, graphs, and other objects. This saves you the step of writing scripts to create these objects. Then you write scripts to control the functionality of each object.

Application Builder also helps boost the productivity of experienced JMP Scripting Language (JSL) programmers. You can start designing a program in Application Builder and edit the automatically generated scripts. Integrate your own scripts to create even more powerful custom applications.

You can use Add-In Builder with Application Builder. First, use Application Builder to write complex scripts that create new platforms and interact with users and JMP. Then, use Add-In Builder to easily distribute your complex scripts so that any JMP user can access them without having to open and run scripts. See “Compile Add-Ins with the JMP Add-In Builder” on page 676.

**Note:** In each version of JMP, Application Builder takes advantages of new features that are not supported in earlier releases. For maximum compatibility, we recommend that you create applications in the earliest version of JMP that the application will be run in.

Example of Creating an Application

Application Builder helps you create instant applications without writing JSL. One example is a JMP window in which you arrange reports, graphs, and other objects to make them easy to interact with at once.

This example shows how to create a simple instant application for a Distribution report. This application lets you analyze preselected variables rather than having to select them in a launch window.

1. Select Help > Sample Data Library and open Big Class.jmp.
2. Run the Distribution table script to generate the report.
4. Click the Blank Application box.

   A new blank application appears. Notice the Distribution report in the left column.
5. In the Sources pane, drag the Distribution report onto the application workspace.

6. From the Application red triangle menu, select **Run Application**.

   The Distribution report appears in a new window (Figure 15.3). Note that the histograms are interactive and still associated with the data table. When the data changes, you run the application again, and the Distribution report is updated.
Application Builder Terminology

An application consists of modules. A module contains the objects and scripts that are compiled into an application. When you run an application, JMP can show a separate window for each module. For example, one window might show a Create Graphs button. After the user clicks the button, the graphs appear in a new window.

There are terms you should become familiar with before using Application Builder. Knowing these terms helps you understand how a module works, even if you need to minimally edit an automatically generated script.

**Application**  The top-level file that consists of one or more modules.

**Module**  A collection of objects, messages, instances, and other JSL statements that are compiled into an application to create new JMP features.

**Instant Application**  An application that typically consists of reports and does not require JSL scripting.

**Custom Application**  An application that demonstrates custom behavior through JSL scripting.
Objects and Messages  An object is a dynamic entity in JMP, such as a data table, a data column, a platform results window, a graph, and so on. Most objects can receive messages that instruct the object to perform some action on itself.

A message is a JSL statement that is directed to an object. That object knows how to evaluate the message.

Module Instance  The occurrence of a module in the application. In a complex application, you might create a start-up script that creates multiple instances of one or more modules.

Namespace  A collection of unique variable names and corresponding values that prevents collisions among scripts.

JMP creates the Application namespace and the ModuleInstance namespace automatically. Symbols in the Application namespace are visible only to scripts in the application; the namespace is not available to scripts not created in the application. For more information about namespaces, see “Advanced Scoping and Namespaces” on page 235 in the “Programming Methods” chapter.

Variable  A unique name to which you assign a value. JMP creates the thisApplication and thisModuleInstance variables automatically.

– The thisApplication variable (used in the Application namespace) contains module names, which are available in any script in the application.

– The thisModuleInstance variable (used in the ModuleInstance namespace) contains box and script names, which are valid only in their own modules.

Container  A display box object (such as a tab or outline) into which you drag other objects.

Design an Application

Before creating the application, you must identify its purpose, decide on which graphical elements to include, and figure out which JSL scripts you need to write.

Purpose  What do you want the application to accomplish? Which features of JMP do you need to customize (for example, a launch window, report, or graph)?

Graphical Elements  How many modules do you need? Look at the list of graphical objects in Application Builder and decide which objects to include in your application. The Sources pane shows dozens of boxes and icons that you can drag and drop into a module. Also look at the preinstalled samples to see whether a similar module exists.

Scripting  Depending on the complexity of the application, you write JSL scripts. See “Write Scripts” on page 669 for details about writing scripts for an application.

A non-interactive application that only shows objects does not require scripts. One example is a window showing reports that you have already generated in JMP.
Application Builder Window

Figure 15.4 shows an application under development in Application Builder.

**Figure 15.4** The Application Builder Window

![Application Builder Window](image)

The Application Builder window provides the following features:

- The toolbar provides quick access to many features, such as aligning objects and inserting common display boxes. (Select **View > Toolbars > Application Builder** to show the toolbar.)
- The Sources pane shows objects that you can include in the application, including open reports and graphs. Right-click an object and select **Scripting Help** for information about the object and its properties.
- The workspace in the middle shows dotted grid lines, which help you line up objects. Drag objects onto one or more Module tabs in the workspace and write scripts on the Scripts tab to control the objects’ functionality.
The Objects pane shows a hierarchical view of the application. Along with the application, each module and its nested objects are listed. You can click an object to show its properties or to select it on the workspace.

In the Properties pane, you set properties for each object, such as the location, width, or name of an object. The properties vary depending on the type of object.

Tip: To hide the grid and turn off snap-to-grid for all applications that you create, select File > Preferences > Platforms > JMP App and deselect these options. You can also deselect these features in the Application Builder red triangle menu.

**Application Builder Red Triangle Options**

The Application Builder red triangle menu provides options for running and debugging the application, opening sample applications, showing the grid, and more.

**Run Application**  Starts the application. A window for each module opens, and you can interact with the application as the user will.

**Debug Application**  Opens the script in the JSL Debugger to troubleshoot errors. See “Debug or Profile Scripts” on page 63 in the “Scripting Tools” chapter for more information.

**Open Sample**  Opens a sample application from the JMP Samples/Apps folder. These samples show you how to set up common applications, and you can modify them as you wish. Table 15.1 describes the samples.

**Snap to Grid**  Aligns (or snaps) objects to the nearest dotted grid lines as you drag them on the workspace. Selected by default.

**Show Grid**  Displays dotted grid lines on the workspace. Selected by default.

**Show Sources**  Shows or hides the Sources panel.

**Show Objects and Properties**  Shows or hides the Objects and Properties panels.

**Auto Scroll**  Automatically scrolls horizontally or vertically as you drag an object near the edges of the workspace. Selected by default.

**Script**  Lets you save the application to a data table, journal, script window, or add-in. See “Options for Saving Applications” on page 672 for details.

**Table 15.1** Sample Applications Installed with JMP

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Six Quality Graphs.jmpappsource</td>
<td>Creates three Control Charts, a Distribution report, and a Capability Analysis report.</td>
</tr>
<tr>
<td>Data Filter Compare.jmpappsource</td>
<td>Creates two Bubble Plots. Each plot has its own data filter and Tabulate report. See this application for an example of the Data Filter Context Box function.</td>
</tr>
</tbody>
</table>
Table 15.1  Sample Applications Installed with JMP  *(Continued)*

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Table</td>
<td>Lets the user select data table columns to stratify and the sampling rate. Display the data table to see the results.</td>
</tr>
<tr>
<td>Graph Launcher</td>
<td>Lets the user enter an equation and axes settings and then create a graph. The initial window remains open, so the user can modify the equation and create new graphs.</td>
</tr>
<tr>
<td>Instant App</td>
<td>Combines two Multivariate reports (Principal Components/Factor Analysis and T Square with All Principal Components).</td>
</tr>
<tr>
<td>Instant App Customized</td>
<td>A modified version of Instant App. Options for selecting the principal components report, changing the marker size, and showing means are included.</td>
</tr>
<tr>
<td>Launcher With Report</td>
<td>Lets the user select data table columns in a launch window and then creates a graph.</td>
</tr>
<tr>
<td>Parameterized Instant App</td>
<td>Lets the user select data table columns and then creates two Multivariate reports. An argument is assigned to the Y role. This means that the reports can be created from any open data table, not just the table specified in the application.</td>
</tr>
<tr>
<td>Presentation</td>
<td>Creates an onscreen presentation, similar to a slideshow, with navigation buttons and an embedded script.</td>
</tr>
<tr>
<td>R Application</td>
<td>Lets the user select columns and then shows multivariate data in the shape of a face (the Chernoff faces). Requires the R TeachingDemos package.</td>
</tr>
<tr>
<td>SAS Application</td>
<td>Runs a SAS script and then adds the output to a report. Prompts you to log on to a SAS server if you are not already connected.</td>
</tr>
</tbody>
</table>
Create an Application

After writing the application specifications, you create a blank application in JMP and begin adding objects and scripts.

This section provides the basic steps for creating an application:

- “Create a New Application” on page 661
- “Arrange and Remove Objects” on page 663
- “Customize Object Properties” on page 666
- “Write Scripts” on page 669

Note: In each version of JMP, Application Builder takes advantages of new features that are not supported in earlier releases. For maximum compatibility, we recommend that you create applications in the earliest version of JMP that the application will be run in.

Create a New Application

To create a new blank application, follow these steps:

   The Application Builder window appears.
2. Select File > Save and save the file as a JMP Source File. The extension is .jmpappsource.

After you create the blank application, you add open reports, display boxes, and other objects to the workspace. See “Example of Creating an Application” on page 654 for more information.

Manage Modules

When you create a new application, a Module tab appears by default. You can add objects to this module to create interface items. To create additional windows for your application, you can add and customize new modules.

Add Objects to a Module

Follow these steps to add objects to a module:

1. In the Sources pane, select the type of object that you want to add.
2. Drag the object onto the Module1 tab (or double-click the object).
3. Select the object and update its properties in the Properties pane. See “Customize Object Properties” on page 666 for details.
4. Add scripts to scriptable objects. See “Write Scripts” on page 669 for details.
5. (Optional) To prevent a module from launching when you run the application, select the module in the Objects pane and deselect **Auto Launch**. (You might do this while testing one out of multiple modules.)

6. From the Application Builder red triangle menu, select **Run Application** to test your application.
   
   Your application appears.

**Create a Module**

1. Select **Format > Add Module**.
2. In the Properties pane, select the **Module Type**:
   - Dialog
   - Dialog with Menu
   - Modal Dialog
   - Launcher
   - Report

**Tip:** When you run an application, the window title is the name of the data table, if applicable, followed by a hyphen and the application name. Change the application name by modifying text in the JMP App object’s **Name** property.

**Rename a Module**

Change the **Variable Name** in the module’s object properties.

**Delete a Module**

Select **Format > Delete Module**.

**Delete a Data Table**

Select the Data Table object, right-click and select **Delete**.

**Note:** You cannot delete the data table if it has any associated objects. Delete any objects and then delete the data table.

**Modal Dialog Modules**

Modal Dialog modules have some special behaviors to be aware of when using them.

- `ret = Module1 << Create Instance()` will not return until the dialog is complete. By this time, the dialog has been destroyed. Therefore, the return value will not be a handle to the Module Instance. Like `New Window()`, the return will instead be of the form
\{Button(1 \mid -1), \text{User Data}\}. \(1 \mid -1\) indicates whether the OK (1) or Cancel (-1) button was pressed.

- \text{User Data()} is a new property on the Module Instance. During execution of the dialog, the Module script can set the user data:

  \[
  \text{thisModuleInstance} \ll \text{Set User Data(...)};
  \]

  to store something to be parsed by the caller. The user data will be evaluated at the time that it is set. There is also a corresponding \text{Get User Data}.  

- Like \text{New Window()}, if there is no OK or Cancel button included, an OK button will be added.

- There is an optional \text{Validate} script property on the Module Instance. This script is only used for Modal dialogs and behaves like \text{On Validate()} in \text{New Window()}. It is called when the OK button is pressed, and returns 1 to accept the input or 0 to disallow the close.

\textbf{Tip:} If you use the Validate property, you can call \text{thisModuleInstance} \ll \text{Set User Data()}. 

- Unlike other module types, a Modal Dialog will not show until the module script has completed. For other module types, the window is created during the call to \text{thisModuleInstance} \ll \text{Create Objects}. JMP cannot display a Modal Dialog here because control would stop and there would be no way to initialize the contents of the boxes in the display. Since the window is not created yet, you will not be able to do actions like set the window title or set an on-close script.

\textbf{Arrange and Remove Objects}

Drag objects from the Sources pane onto the workspace or double-click them. A blue border appears around the edge of a selected object. Then you can position the selected object in several ways. You can also change the container of an object or insert an object into a new container.

\textbf{Tip:} To quickly select an object, select it in the Objects pane. This method is particularly helpful when the internal object completely covers the container, as with a border that has an internal text box.

\textbf{Drag an Object}

One way to position objects is by dragging them around the workspace.

- The top and left edges of an object align (or snap) to the nearest dotted grid lines as you drag them on the workspace. For a more precise placement, deselect \text{Snap to Grid} in the Application Builder red triangle menu. You can also turn off \text{Snap to Grid} in all applications in the JMP Preferences. (Select \text{File} > \text{Preferences} > \text{Platforms} > \text{JMP App} to change the option.)
• When you drag an object, press SHIFT to restrict movement to a single axis (for example, to move the object horizontally without moving the vertical position).
• When you drag an object into a container, the arrow indicates where you can drop the object.
• When you drag an object over another one, a blue line shows where you can drop the object.

Figure 15.5 shows the various methods for dragging objects inside a container.

**Figure 15.5  Examples of Dragging Objects into a Container**

Change the X and Y Positions on a Container Object

• To position a container object precisely, select the object and then change the X Position and Y Position properties. After you enter a new X position, press the TAB key to see the object move to the new position and then enter the new Y position.
• To place an object in the upper left corner, right-click the object and select Move to Corner. This is a shortcut to setting the X and Y positions to 0. On Macintosh, hold down CTRL and COMMAND and then select Move to Corner.
Line Up Multiple Objects

To line up objects horizontally or vertically, select the objects and then select an option from the **Format > Align Boxes** menu.

**Tips:**

- The **Align Boxes** options are unavailable when you select a container rather than the internal objects.
- If you right-click a container, you might inadvertently select one of the internal objects instead. Right-click in the workspace instead.

Change the Type of Container

After inserting some containers, you can change them to a different type of container without having to re-create the object. Suppose that you create a panel that contains text and a button. To see what the panel looks like as an outline, select the panel, right-click in the module, and then select **Change Container > Outline** (Figure 15.6).

**Figure 15.6** Change a Panel to an Outline

In this example, you would also change the outline title to match that of the panel.

**Tip:** To change the orientation of a list box quickly, select or deselect **Horizontal** in the object properties.

Insert Objects into a New Container

The toolbar at the top of the Application Builder window provides buttons for containers such as border boxes and mouse boxes (Figure 15.7).

To insert selected objects into a container, click the appropriate button on the toolbar or select **Format > Add Container**.

**Figure 15.7** Container Toolbar
**Duplicate Objects**

When you copy and paste an object, the second instance of the object is renamed. The scripts attached to the object are also renamed. Pressing CTRL (or COMMAND on Macintosh) and dragging the object also creates duplicates of the originals.

**Delete an Object**

- Remove one or more objects by selecting them and then pressing the DELETE key.
- Drag the objects outside of the module.
- On Macintosh, select the objects, hold down CTRL and COMMAND, and then select **Delete**.
- On Windows, select **Edit > Clear** to delete all objects in a module.
- Select the object and then press the BACKSPACE key.

If you no longer need the object’s script, you can delete the script also.

**Customize Object Properties**

After you drag an object from the Sources pane onto a module, customize the object properties in the Properties pane. Editing the object properties saves you the step of writing JSL for list items, button names, and so on.

Variable names are case- and space-sensitive. When a script contains an object named “Button1”, Application Builder warns if you try to rename another object “Button 1”.

To create the radio box list items in Figure 15.8, double-click the placeholder items “Item1” and “Item2” and enter the new list item.
For more information about an object, right-click the object and select **Scripting Help**. The JMP Scripting Index appears, and the object that you selected is highlighted. The Scripting Index often includes a script that you can run to see an example of the object.

To read more about values in the Properties pane, place your cursor over the value.

**Application Properties**

The Application properties identify the run password, data table name, and more. Select the application in the Objects list.

**Name**  Appears after the data table name in the application’s title bar.

**Auto Launch**  Shows a launch window in which the user selects the arguments that have been defined in the application. This launch window is not one of the defined modules; the modules will be instanced based on their own Auto Launch property.

**Encrypt**  Prevents users from editing the application in a text editor. Only applications that the user runs are encrypted (the .jmpapp file and the application in a JMP add-in). Scripts that you save to a data table, journal, and add-in are encrypted. For more information about encryption, see “Encrypt and Decrypt Scripts” on page 260 in the “Programming Methods” chapter.

**Run Password**  Enter the password required to run the application. To test the password, run the application outside Application Builder.
Table Module Properties

Inserting the Data Table object creates a data table object. To define properties such as the data table path, select the data table module in the Objects pane. Then modify the following options in the Properties pane.

**Variable Name**  Specifies the name of the data table object. This name appears in the Properties and Objects panes and in the application’s JSL script.

**Path**  Specifies the absolute or relative filepath for the data table used in the application. You can precede the data table name with a path variable (such as `$HOME` or `$USER_APPDATA`).

Application Builder opens the specified data table when you edit the application. If the Path property is empty or the data table cannot be found, you are prompted to open the table.

When you close a data table and objects in the application depend on the data table, the objects are removed from the application and a warning message appears. To restore the objects, reopen the application.

**Label**  Specifies the string used when prompting the user to open a data table. Figure 15.9 shows the default value.

**Figure 15.9**  Label in Data Table Prompt Window

**Location**  Determines how the data table used in the application is selected when the user runs the application.

- Current Data Table: Uses the current data table. If no data tables are open, the user is prompted to open one.
- Full Path: Uses the data table specified in the Path property.
- Name: Uses the first open data table with the specified name. Otherwise, JMP uses the data table specified in the Path property.
- Prompt: Asks the user to select an open data table or browse to select a data table.
- Script: Uses the data table defined in the application or module script.
– Embedded Script: Reads the Source script in the data table that was used to generate the report. The Source script is run when you open the application.

**Invisible** Hides the data table from view but lists it in the JMP home window. This option is available for the Full Path and Name locations.

**Write Scripts**

After adding an object to the module, you write a script for the object to provide functionality. For example, you might want the user to click a button, select a directory, and then select a data table. Or you might have an application that displays a different graph based on which radio button the user selects.

**Application and Module Namespaces**

To prevent variable names and values from conflicting among scripts, Application Builder automatically creates the Application namespace and a namespace for each module as follows:

- In the Application namespace, you write scripts that are executed when the user runs the application. Functions defined in the Application namespace can be used in any module.
- In the Module namespaces, you write scripts that are run when an instance of that module is created. If clicking a button in the application opens a new launch window, that launch window is an instance of the module. Two instances of the same module have their own copies of any variables or functions.

To see the scripts in these namespaces, click the **Scripts** tab and then select the namespace in the Namespace list (or in the Objects pane). See Figure 15.10.

**Figure 15.10 Application and Module Namespaces**
There are two types of scripts: named scripts and anonymous scripts.

**Write a Named Script**

A *named script* is a function that several controls can use. The `this` argument tells which control is calling the function. In the following example, `Get Button Name` is sent to the `this` argument to print the button name to the log when the button is clicked:

```
Button1Press = Function({this}, Print(this << Get Button Name))
```

On another button, use `Button1Press` script to produce the same results.

Two other advantages of named scripts: when you add a named script to an object, JMP inserts a placeholder script on the Scripts tab, which you then edit. On the Scripts tab, you can also select a script from the Method list to navigate to that code, which is particularly helpful in long scripts.

Add a named script as follows:

1. Right-click the object, select **Scripts**, and then select the script that you want to add. In this example of creating a button, select the **Press** script. (On Macintosh, press OPTION, and then select **Scripts > Press**.)

   The object’s placeholder script appears on the **Scripts** tab (Figure 15.11). The name of the named script, `Button1Press`, shows up in both the script and the object properties.

   **Figure 15.11** New Script and Script Properties

2. Edit the object’s placeholder script and properties to provide the necessary functionality. For example, the radio box shown in Figure 15.11 reflects the following changes:

   - The Title property was changed to *Submit*, the text that appears on the button.
   - The Close Window function was added to the object. When the user clicks the **Submit** button, the window closes.

**Tip:** After you add a script to an object and then delete the object, delete the object’s script from the **Scripts** tab if you no longer need the script. This feature prevents scripts that you might want in the future from being deleted.

If you rename the script in the object properties, rename it on the **Scripts** tab also. And if the script is used in another part of the application, rename it there as well.
Write an Anonymous Script

An *anonymous script* is available only to the object that defines it. For example, you might want a simple Print statement for one button that is not used elsewhere. By writing an anonymous script, you reduce the number of names to manage in the script. Anonymous scripts also reduce clutter among more important named scripts in the Scripts tab, because you add them to the object properties.

The following examples show two types of anonymous scripts:

```plaintext
Print(Button1 <<GetButtonName) // simple anonymous
Function({this}, Print(this <<GetButtonName)) // parameterized anonymous
```

Notice that the simple script sends a message to the “Button1” variable, but `this` is the control in the parameterized script.

Objects such as check boxes might provide additional arguments after `this` that are not otherwise available. One example is an argument that tells which check box in a column of check boxes just changed.

Write an anonymous script as follows:

1. Select the object and click `...` in the object properties.
   
   The anonymous script editor appears.
2. Enter the script and click `OK`.
   
   The text of the anonymous script appears in the object’s properties (rather than the name of a named script).

**Tip:** Avoid copying and pasting anonymous functions to simplify code maintenance; use a named script instead if the script is needed in more than one place.

Show Specific Scripts

There are several ways to view a script for a specific object:

- Double-click the object on the Module tab.
- When an object has multiple scripts, right-click the object, select *Scripts*, and then select the script name. You can also select the *Scripts* tab, select the module name from the *Namespace* list and then select the script name from the *Method* list. Likewise, to see the application scripts, select *Application* from the *Namespace* list.

In each case, the *Scripts* tab appears with the cursor in the first line of the object’s script.

**Tip:** To make a poorly formatted script easier to read, right-click and select *Reformat Script*. 
Copy and Paste Objects with Scripts

When you copy and paste an object that has a script, the second instance of the object and script are renamed.

Edit or Run an Application

To open an application for editing, select File > Open, select the .jmpappsource file, and then select Open.

Note: If the Table property is empty or the specified data table cannot be found, the application runs anyway but objects requiring the data table will fail to create and JMP displays a warning.

To run an open application, select Run Application from the Application Builder red triangle menu.

To run a closed application, select File > Open, select the .jmpapp file, and then select Open.

On Windows, you can also open or run an application from the JMP Home Window by doing one of the following:

- Drag the file from Windows Explorer onto the JMP Home Window or onto a blank application window.
- Double-click the file in Recent Files list.
- Right-click either the .jmpappsource or the .jmpapp file and select either Edit Application or Run Application.

Options for Saving Applications

JMP provides several options for saving application files. When you select File > Save As (or File > Export on Macintosh), you can choose to save as an application source file (.jmpappsource), an application (.jmpapp), or a script (.jsl).

The .jmpappsource file allows an application developer to save the application as is, in order to continue editing the application later. When reopened, the App Builder interface remains in same state as when it was saved. The data tables used to create the application must still be available.

The .jmpapp file is used to distribute applications for others to use. The application runs immediately after opening the file. The application resolves the data tables using the current data tables, files on disk, or by prompting the user, depending on the application settings.

The Save Script red triangle menu provides additional options for saving scripts. When an encrypted script is saved, JMP encloses the script in the JSL Encrypted() function to preserve white space and comments.
To Data Table  Saves the script to the data table that was used to produce the report. This enables you to run the script again from the data table to recreate the results. When you edit this script from the data table, the application opens in Application Builder, not the script editor.

To Journal  Saves a button that runs the script in a journal. The script is added to the current journal. The script contains the path to the data table. Note that if the data table cannot be found, the script does not run.

To Script Window  Opens a script editor window and adds the script to it. If you have already saved a script to a script window, additional scripts are added to the bottom of the same script window. Note that if you modify the application significantly in a script window, you might not be able to edit the application in Application Builder. This option is useful when you want to embed the application in a larger JSL process.

Tip: This can also be accomplished by saving as a .jmpapp file and using Open() to run the application. However, saving the script can reduce the number of files.

To Add-In  Lets JMP users install the application and launch it from a JMP menu. See “Compile Add-Ins with the JMP Add-In Builder” on page 676.

Additional Examples of Creating Applications

The following examples illustrate various uses for applications in JMP.

Parameterizing Variables

The following example shows how to create an application with parameterized variables. Users select the variables in a launch window, and then predefined reports are generated.

1. Select Help > Sample Data Library and open Quality Control/Steam Turbine Historical.jmp.
2. Run the Principal Component Analysis and Loadings plot table scripts to generate the reports.
   The Application Builder window appears.
4. Enlarge the window.
5. In the Sources pane, drag each Multivariate report onto the application workspace in a single row.
6. Select both reports and then select Format > Align Boxes > Align Top.
7. Select each report and type yvar next to Y Variable in the Objects pane.
8. From the Application red triangle menu, select Run Application.
9. Select the Fuel, Steam Flow, Steam Temp, and MW variables and then click the Y button.
10. Click **OK**.

New Multivariate reports appear in one window (Figure 15.12).

**Figure 15.12** Multivariate Application

![Multivariate Application](image)

**Tip:** The absolute path to the data table is inserted automatically in the application’s Table property. You can use the `$SAMPLE_DATA` path variable instead or enter another absolute or relative path. Remember that the user must have access to this path.

**Filtering Data in Multiple Reports**

In an application that contains several reports, you can select data in one report and then view only that data in other reports contained in the same window.

To set up the filter, follow these steps:

1. Create the application and add two reports to the workspace.

2. In the Application Builder window, right-click the primary report and select **Use as Selection Filter**.

   This places the primary report display box in a Data Filter Source Box and the parent report display box in a Data Filter Content Box.
3. Select **Run Application** from the Application Builder red triangle menu. The reports appear in one window (Figure 15.13).

4. Test the application by selecting a histogram bar in the primary report. Only data for the selected bar appears in the second report.

**Figure 15.13** Example of Filtered Content

---

**Selecting Dates**

To insert a date selector window into an application, follow these steps:

1. Drag a Number Edit Box from the Sources pane to the workspace.
2. Select the Number Edit Box and then click the button next to Format in the Properties pane.
3. Select **Date** from the list and then select **m/d/y**.
4. Type 12 in the Width box.
5. Click outside the list.
6. Select **Run Application** from the Application Builder red triangle menu. The Number Edit Box, which shows a date, appears in a new window.
7. To open the date selector window, place the cursor over the box until a blue triangle appears.
8. Click the blue triangle to view the date selector window.
The date selector enables you to select the month and year as well as the date and time for the box.

Compile Add-Ins with the JMP Add-In Builder

A JMP add-in is a JSL script that you can run anytime from the JMP Add-Ins menu. You can create submenus to group your JMP add-ins and have many levels of menus, if desired.

Experienced JSL script writers can create scripts that extend JMP in many ways (for example, add a custom analytical tool or a user interface to communicate with a database). The JMP add-in architecture simplifies deploying and using these complicated scripts.

You can send co-workers a suite of scripts and tell them how to run them. Another option is sending a single add-in file that any JMP user can install and then use just like any other part of JMP.

As a JMP user, you might be given add-ins to use by co-workers. You can also find add-ins on the JMP website at http://www.jmp.com/addins.

Compile Scripts into an Add-In Using Add-In Builder

To create a JMP add-in, you write the scripts and gather files that are used in the add-in. Then you compile the scripts into an add-in.

- On Windows, select File > New > Add-In.
- On Macintosh, select File > New > New Add-In.
- In Dashboard Builder, select the red triangle menu and then select Save Script > To Add-In.

The process of compiling scripts into an add-in involves the following steps:

- “Add General Information” on page 677
- “Create Menu Items” on page 678
Add General Information

First, in the **General Info** tab, add the general information that identifies and sets up your add-in.

**Figure 15.15** Add-In Builder General Info Tab

1. Enter a name for the add-in.
   
   This is the name of the registered add-in, which appears in the **View > Add-Ins** window.

2. Enter a unique identifier string.
   
   Unique ID strings are case-insensitive. To ensure uniqueness, it is strongly recommended to use reverse-DNS names (for example, `com.mycompany.myaddin`). The ID string must meet the following requirements:
   
   - It can be up to 64 characters in length.
   - It must begin with a letter.
   - It should consist only of letters, numbers, periods, and underscores.
   - It should contain no spaces.
   
   In JSL, use this string to refer to the add-in.

3. Enter the version of the add-in.

   If you decide to make changes to the add-in at a later date, you can update the version number and then verify that users have the correct version.

4. Select the minimum version of JMP that the add-in works on.

   **Note:** Add-ins were introduced in JMP 9, so no prior versions are supported. And when saving an application as an add-in, select 10 or 11 as the JMP minimum version.
5. Select whether you want the add-in to be supported on Windows, Macintosh, or both.

6. (Optional) Select the check box next to Install after save if you want to install the add-in after saving it.

   If you do not select this option, the add-in is not installed once you save it, and it does not appear as a selectable menu item in the Add-Ins menu.

Create Menu Items

1. Click the Menu Items tab.

**Figure 15.16** Add-In Builder Menu Items Tab

2. (Optional) Click Add Submenu.

   If you have multiple add-ins, you can group them under a submenu.

3. If you add a submenu, next to Menu item name, enter the name of the submenu.

   This name appears in the Add-Ins menu.

4. Click Add Command.

5. Next to Menu item name, enter the name of the add-in command.

6. (Optional) Next to Tooltip for menu item, enter the content that appears as a tooltip when the users place their cursor over the menu item.
Chapter 15
Creating Applications
Scripting Guide Compile Add-Ins with the JMP Add-In Builder

7. Add the script. Select either Run this JSL and copy and paste in your script, or select Run JSL in this file and click Browse to find the file containing your script.

8. (Optional) Select Use the “Here” namespace for unqualified JSL variable names to ensure that all unqualified JSL variables are in the Here namespace, and local only to the script.

Notes:

- If your script creates a custom menu or toolbar, the variables are in the Here namespace by default.
- For more information about the Here namespace, see “Advanced Scoping and Namespaces” on page 235 in the “Programming Methods” chapter.

9. (Optional) Browse to add an icon that appears next to the menu item in the Add-Ins menu.

10. (Optional, Windows only) Create a keyboard shortcut for the add-in.

11. To add multiple menu items, repeat the steps.

You can add multiple levels of submenus and add-in commands.

12. Click Save and save the add-in to the desired directory.

13. Click Close.

Note: For more information about customizing menus in JMP, see the Personalize JMP chapter in the Using JMP book.

Specify Start-up and Exit Scripts (Optional)

Click the Start-Up Script tab to add a script that runs when JMP starts up (and the add-in starts). You can select an existing script (Run JSL in this file) or copy and paste in a script (Run this JSL). For example, you could provide a message telling the user that the add-in is installed upon start-up.

Click the Exit Script tab to add a script that runs when JMP exits or when you disable the add-in. You can select an existing script (Run JSL in this file) or copy and paste in a script (Run this JSL). For example, you could provide a prompt for the user to export a JMP data table upon exiting or disabling the add-in.

Add Additional Files

If your script calls other scripts, or contains graphics or data tables, add those files here.

Save the Add-In

Save the add-in by clicking the Save button on any tab. This effectively creates the add-in.

- If you selected the Install after save option in the General Info tab, then the add-in menu item appears in the Add-Ins menu immediately.
• If you did not select the **Install after save** option, when you open the saved add-in file, you are prompted to install the add-in.

**Test the Add-In**

Once your add-in is installed, test your add-in as follows:

1. Select **View > Add-Ins**.
2. Select your add-in and click **Unregister**.
3. Reinstall your add-in by either selecting **File > Open** in JMP, or by double-clicking your .jmpaddin file.
4. Ensure that the menu and toolbar button run your script correctly and that the script itself runs correctly.

**Edit an Add-In**

To edit a saved add-in:

1. Select **File > Open**.
2. Navigate to and select the add-in file.
3. Select one of the following options:
   - On Windows click the arrow to the right of the **Open** button and select **Open Using Add-In Builder**.
   - On Macintosh, select the **Edit after opening** option.
4. Click **Open**.
   The file opens in the Add-In Builder. Update the arguments and then save the changes.

**Share an Add-In**

Once you have a .jmpaddin file, you can share that with other users. Email the file or you place it in a shared location, such as a network folder, or on the JMP File Exchange (located online in the **JMP User Community**).

When JMP users open the file, the add-in files are extracted into the appropriate folder, and the add-in is registered and installed. The add-in now appears in the user’s JMP **Add-Ins** menu.

**Installing Multiple Add-Ins**

If you want to install multiple add-ins, copy the add-ins into the following location:

• Add-In files on Windows are located here:
Scripting Guide Compile Add-Ins with the JMP Add-In Builder

– %ALLUSERSPROFILE%/SAS/JMP/AddIns (any user on this machine can access the add-in)
– %LOCALAPPDATA%/SAS/JMP/AddIns (only the current user on this machine can access the add-in)

• Add-In files on Macintosh are located here:
  – /Library/Application Support/JMP/AddIns (any user on this machine can access the add-in)
  – ~/Library/Application Support/JMP/AddIns (only the current user on this machine can access the add-in)

When JMP starts, the addinRegistry.xml file is read, which contains information about previously registered JMP add-ins. Then JMP looks in the add-in folders for any other add-ins and installs them automatically.

Note the following:
• The Home Folder for discovered add-ins does not have to be the AddIns subfolder in which the addin.def file was found. The addin.def file can be the only file in that subfolder and have a Home setting that points to some other location where the add-in files actually reside.
• If an automatically discovered add-in has the same unique ID as an add-in that was explicitly registered, the automatically discovered add-in is used.

Register an Add-In Using JSL

If your add-in files are not contained within a jmpaddin file, you can use the Register Addin() JSL function to manually register the addin.def file. This installs and registers the add-in.

• For information about the JSL functions, see the JSL Functions chapter in the JSL Syntax Reference for details.
• For information about creating the addin.def file, see “Create an Add-In Manually” on page 682.

Note the following:
• JMP might find a file named addin.def in the specified home folder. If so, values from that file are used for any optional arguments that are not included in the Register Addin() function.
• The addin.def file is used only for values that are not provided in the Register Addin() function. This function is useful while developing, but not necessary, since the addin.def file is enough to register an add-in.
Create an Add-In Manually

The addin.def file is a simple text file containing name-value pairs that provide registration information about a JMP add-in. Here are the name-value pairs to include in the addin.def file:

**name**  Optional. The name that can be displayed in the JMP user interface wherever add-in names are displayed, instead of the unique ID. This name is displayed if no localized names are provided or when JMP is run under a language for which you did not provide a localized name. Named *Add-In Name* in Add-In Builder.

**name_xx**  Optional. Allows the user-friendly name to be localized for different languages, where *xx* is the two-letter ISO 639-1 code for the language. If you include localized names, you should still include a language-neutral name in case JMP is running under regional settings for which you do not have a localized name. Not available in Add-In Builder.

**id**  Required. The unique ID for your add-in. The string can contain up to 64 characters. The string must begin with a letter and contain only letters, numbers, periods, and underscores. Reverse-DNS names are recommended to increase the likelihood of uniqueness. Named *Add-In ID* in Add-In Builder.

**home**  Optional. The path to the add-in files. The Home Folder for the add-in is assumed to be the folder where addin.def is located. You need to include a setting for home only if the Home Folder is somewhere else (for example, a network shared folder). Not available in Add-In Builder.

**home_win**  Optional. The path to the add-in files to be used when JMP is running on Windows. Overrides the value specified for home on Windows, if any. Not available in Add-In Builder.

**home_mac**  Optional. The path to the add-in files to be used when JMP is running on the Macintosh. Overrides the value specified for home on Macintosh, if any. Not available in Add-In Builder.

**autoLoad**  Optional, Boolean. The default value is True (1). Determines whether this add-in is initially configured to load automatically during JMP start-up. Named *Install after save* in Add-In Builder.

**host**  Optional. Valid values are *Win* and *Mac*. Named *Supported Host* in Add-In Builder.

**minJMPVersion**  Optional. Valid values are integers corresponding to the JMP major version that is the minimum version that the add-in supports. Named *Minimum JMP Version* in Add-In Builder.

**maxJMPVersion**  Optional. Valid values are integers corresponding to the JMP major version that is the maximum version that the add-in supports. Use this setting only if there is a known incompatibility between your add-in and a specific version of JMP. You should provide a new version of the add-in for later versions of JMP. Not available in Add-In Builder.
### Example of a addin.def File

```plaintext
id="com.mycompany.myaddin"
name="My Add-In's Friendly Name"
name_fr="My Add-In's French Name"
name_de="My Add-In's German Name"
home="\server\share\myjmpaddin"
Autoload=1
MinJMPVersion=9
```

### Example of a JMP Add-In

A sample add-in named Simple Calculator.jmpaddin is located in one of the following folders:

- On Windows: C:/Program Files/SAS/JMP/13/Samples/Scripts
- On Macintosh: /Library/Application Support/JMP/13/Sample/Scripts

**Note:** On Windows, in JMP Pro, the “JMP” folder is named “JMPPro”. In JMP Shrinkwrap, the “JMP” folder is named “JMPSW”.

To see what the add-in contains, change the extension to .zip and unzip it into a new folder. To see how it works, change the extension back to .jmpaddin and install.

The add-in contains the following files:

- **addin.def**
  
  Provides the specification for JMP to register the add-in. It contains only these two lines:
  ```plaintext
  id="com.jmp.sample.calculator"
  name="Simple Calculator"
  ```

- **addin.jmpcust**

  Provides the menu customization file that is created when you interactively create a custom menu. This example places the add-in menu item into the default **Add-Ins** menu.

- **calculator.jsl**

  A JSL script that creates a basic calculator.

- **calc_icon.gif**

  The image used as the calculator’s icon.

To download more add-ins, visit [https://community.jmp.com/community/file-exchange](https://community.jmp.com/community/file-exchange).
Manage JMP Add-Ins

Install Add-Ins

A JMP add-in is a file that has the . jmpaddin extension. You can install it in one of two ways:

1. Select File > Open.
2. Navigate to the . jmpaddin file and select it.
3. Click Open.

You can also double-click the . jmpaddin file or drag it onto the JMP Home Window.

View Your Add-Ins

Select View > Add-Ins to see the add-ins that you have already installed.

Update Add-Ins

If you are given an update to an add-in you already have installed, you can just install the update as you did the original add-in. Doing so overwrites the old version with the new one.

Disable, Enable, and Remove Add-Ins

To temporarily disable an add-in without removing it

1. Select View > Add-Ins.
2. Select the add-in that you want to disable.
3. Deselect the Enabled check box.

To enable a disabled add-in

1. Select View > Add-Ins.
2. Select the add-in that you want to enable.
3. Select the Enabled check box.

To unregister an add-in

1. Select View > Add-Ins.
2. Select the add-in that you want to remove.
3. Click Unregister.
Examining working scripts line-by-line is one of the best ways to learn JSL. This chapter describes common tasks in JMP, such as converting date/time values and extracting specific values from reports. Sample scripts that address these issues are installed with JMP in the Samples/Scripts folder so you can run them yourself.
Run a Script at Start Up

If you want to run the same script every time you start JMP, name it jmpStart.jsl and place it in one of the following folders, as appropriate for your operating system. When JMP starts, JMP looks for the jmpStart.jsl script in these folders in the order in which they are listed here. The first one that is found is run, and the search immediately stops.

**Note:** Some path names in this section refer to the “JMP” folder. On Windows, in JMP Pro, the “JMP” folder is named “JMPPro”. In JMP Shrinkwrap, the “JMP” folder is named “JMPSW”.

On Windows:
2. C:/Users/<username>/AppData/Roaming/SAS/JMP

On Macintosh:
1. /Users/<username>/Library/Application Support/JMP/13
2. /Users/<username>/Library/Application Support/JMP

The jmpStart.jsl script runs only for a particular user on a computer. You can add a script named jmpStartAdmin.jsl in one of the following places, as appropriate for your operating system. This script is run for every user on a computer. JMP searches for the administrator start-up script first, and runs it if found. Then JMP searches for the user start-up script, and runs it if found.

On Windows:
1. C:/ProgramData/SAS/JMP/13
2. C:/ProgramData/SAS/JMP

On Macintosh:
1. /Library/Application Support/JMP/13
2. /Library/Application Support/JMP

Convert Character Dates to Numeric Dates

Data might appear to be numeric in the data table. However, the column properties may specify a character data type. To manipulate the data as date/time values, convert the column to a numeric column and specify how you want the values to appear.

Convert Dates.jsl creates a data table, specifies the data input format, changes the column to a numeric continuous column, and applies the m/d/y format (Figure 16.1).

```javascript
// Create a data table with character dates.
```
dt = New Table( "Example",
    Add Rows( 3 ),
    New Column( "Dates",
        Character,
        Nominal,
        Set Values( {"25/01/2010", "30/09/2009", "15/12/2013"} )
    );
);

// Display a modal dialog for the user to confirm the format conversion.
nw = New Window( "Date Conversion",
    <<Modal,
    tb = Text Box( "Notice the d/m/y format of the character dates.
        Click OK to convert the column to a numeric column and apply the m/d/y format." )
    );

/* Apply the Numeric data type.
    Specify the Informat (input format) value "d/m/y".
    Specify the Format (display format) value "m/d/y".
    Apply the Continuous modeling type */
col = Column( dt, "Dates" );
col << Data Type( "Numeric", Informat( "d/m/y" ), Format( "m/d/y" ) );
col << Modeling Type( "Continuous" );

// Display the data table in front of the script.
dt << Data Table Window();

Figure 16.1 Converting Character Dates (Before and After)

When you change the column’s data type from character to numeric, defining the format in which the data were entered is important. In this example, Informat( "d/m/y" ) defines the
input format. Format("m/d/y") defines the new display format. If Informat() is omitted, the Format() value is applied as both the input and display format. This results in missing values for some data.

Modify Convert Dates.jsl to see for yourself.

1. Open Convert Dates.jsl from the sample scripts folder.
2. Right-click the script window and select Show Line Numbers.
3. On line 9, change "25/01/2010" to "01/25/2010".
4. On line 27, delete Informat("d/m/y"), (including the comma).
5. Run the script.

Format("m/d/y") is applied to the column. Only "01/25/2010" appears in the column. The other values are missing; "30/09/2009" and "15/12/2013" are not valid m/d/y values.

Format Date/Time Values and Subset Data

How can you work with dates in JSL? JSL provides a number of formats that you can use to make comparisons and then subset data based on the date.

Select Where Using Dates.jsl applies the Date MDY format to a column of departure dates and subsets the data. A summary table of mean net costs by departure date then appears (Figure 16.2).

```javascript
/* How can you work with dates in JSL? JSL provides a number of formats that you can use to make comparisons and then subset data based on the date. */

hdt = Open("$SAMPLE_DATA/Travel Costs.jmp");

/* Apply the Date MDY format to Departure Date values and then select only February dates. */
hdts = hdt << Select Where(
   (Date MDY(02, 01, 2007) <= :Departure Date < Date MDY(03, 1, 2007)));

/* Subset the selected rows into two tables: one table contains February departure dates, the other contains all data for those departure dates. */
nt1 = hdt << Subset( Columns( :Departure Date ),
   Output Table Name("February Departure Date") );
nt2 = hdt << Subset( Output Table Name("February Data") );

/* Create a summary table, grouping mean cost by day of week that departure took place. */
sumDt = nt2 << Summary(
```
Create a Formula Column

How do you create a formula column that combines conditional expressions with value comparisons? Create a Formula Column.jsl shows how to create a new formula column that evaluates ages in Big Class.jmp and returns the result in the new column (Figure 16.3).

/* Scenario:

How do you create a formula column that combines conditional expressions with value comparisons? This script shows how to create a new formula column that evaluates ages in Big Class.jmp and returns the conditional result in the new column. */

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

/* Create a new character column for the formula. */
Insert "early" in the new column if the age is less than or equal to 12. Insert "mid" if the age is less than or equal to 15 but greater than 12. For ages greater than 15, insert "late".

```javascript
dt << New Column( "Adolescent Phase",
    Character,
    Formula(
        If( :age <= 12, "early",
            12 < :age <= 15, "mid",
            "late"
        )
    );
```

**Figure 16.3** Conditional Expression in Formula

---

**Extract Values from an Analysis into a Report**

How do you capture specific results of an analysis into a custom report using JSL?

The JMP platforms in the Analyze and Graph menus contain two objects known as the analysis and report layers. Messages are sent to the analysis layer that generate the desired results.
Extract Values from Reports.jsl performs a Bivariate analysis and shows results such as the sample size, RSquare, and Correlation in a new report window. Figure 16.4 shows the Bivariate report along with the customized report, though the Bivariate report window closes after the script is finished.

/* Scenario: How do you capture specific results of an analysis in a report using JSL?

The JMP platforms in the Analyze and Graph menus contain two objects known as the analysis and report layers.

Messages are sent to the analysis layer that generate the desired results.

This script performs a Bivariate analysis and shows results such as the sample size, RSquare, and Correlation in a new report window. */

sd = Open( "$SAMPLE_DATA/Lipid Data.JMP" );

biv = Bivariate( // biv is the analysis layer.
   Y( :Triglycerides ),
   X( :LDL ),
   Density Ellipse( 0.95, {Line Color( {213, 72, 87} )} ),
   Fit Line( {Line Color( {57, 177, 67} )} ),
);

// Make sure the second Outline Box (called "Correlation") in the Bivariate report is open. You can then see which content is extracted into the Custom report.
report(biv) [Outline Box( 2 )] << Close( 0 );

reportbiv = biv << Report;  // reportbiv is the report layer.

// The density ellipse is generated first.
// Extract the correlation coefficient.
corrvalue = reportbiv[Outline Box( 2 )][Number Col Box( 3 )] << Get( 1 );

// ...followed by Fit Line
// Extract the numeric values from the Summary of Fit report
// and place them in a matrix.
sumfit = reportbiv[Outline Box( 4 )][Number Col Box( 1 )] << Get as Matrix;

// Extract the values of RSquare and AdjRSquare as one by one matrices.
rsquare = sumfit[1];
adjrsq = sumfit[2];
avg = sumfit[4];
samplesize = sumfit[5];

// Extract the first column of the Parameter.
// Estimates report as two objects.
term = reportbiv[Outline Box( 7 )][String Col Box( 1 )] << Get();

// Clone the report layer as a String Col Box.
cloneterm = reportbiv[Outline Box( 7 )][String Col Box( 1 )] << Clone Box;

// Extract the Parameter Estimates values as a matrix.
est = reportbiv[Outline Box( 7 )][Number Col Box( 1 )] << Get as Matrix;

// Extract the Standard Error values as a matrix.
stde = reportbiv[Outline Box( 7 )][Number Col Box( 2 )] << Get as Matrix;

dvalues = [];
dvalues = samplesize |/ adjrsq |/ rsquare |/ corrvalue;
sfactor = term[2];

dlg = New Window( "Custom Report",
    Outline Box( "Selected Values",
        /* The Lineup box defines a two-column layout, each of which contains
           a Text Box. */
        Lineup Box( N Col( 2 ),
            Text Box( "Factor of Interest: " ),
            Text Box( sfactor ), ),
        Table Box(
            /* Display an empty string in the first column
               and the text in the second column. */
            String Col Box( " ",
                    "Correlation:"}
            ),
            // Insert a 30 pixel x 30 pixel spacer between the columns.
            Spacer Box( Size( 30, 30 ) ),
            Number Col Box( " ", dvalues )
        ),
        // Insert a 1 x 30 spacer.
        Spacer Box( Size( 0, 30 ) ),
        Table Box(
            /* Display the cloned String Col Box followed by a spacer.
               Then insert the Parameter Estimates and Standard Error values. */
            
        )
    )
CloneTerm,
Spacer Box( Size( 10, 0 ) ),
, Number Col Box( "Estimate", est ),
Spacer Box( Size( 10, 0 ) ),
, Number Col Box( "Standard Error", stde )
);

Close( sd ); // Close the data table.

Figure 16.4 Customized Report from the Bivariate Analysis
Create an Interactive Program

How do you gather numeric input from the users, perform a calculation on that input, and show the results in a new window?

Prime Numbers.jsl asks the user to enter a number and then factors the number or confirms it as a prime number (Figure 16.5). This script is a good example of aligning several types of display boxes, concatenating text, and working with conditional functions.

    /* How do you gather numeric input from the users, perform a calculation on that input, and show the results in a new window? 
   
   This script demonstrates how to create an interactive program that asks the user to enter a number and then factors the number or confirms it as a prime number. */

    // Ask the user to enter a name and number.
    nw = New Window( "Factoring Fun",
        V List Box( 
            Text Box( "Choose a number between 2 and 100, inclusive. " ),
            Spacer Box( Size( 25, 25 ) )
        ),
        V List Box( 
            Lineup Box( 2,
                Text Box( "Your name   ",
                    uname = Text Edit Box( "< name > ", << Justify Text( Center ) ),
                    Text Box( "Your choice " ),
                    uprime = Number Edit Box( 2 )
            ),
            Spacer Box( Size( 25, 25 ) ),
            H List Box( 
                Button Box( "OK",
                    // Unload responses.
                    username = uname << Get Text;
                    fromUser0 = uprime << Get;

                    // Test input for out of range condition.
                    If( fromUser0 <= 1 | fromUser0 > 100,
                        // Send message to user that input value is out of range.
                        nw2 = New Window( "Factoring Fun: Message for ",
                            "The number you chose, " || Char( fromUser0 ) ||
                    )
            )
        )
    );

    If( fromUser0 <= 1 | fromUser0 > 100, 
        // Send message to user that input value is out of range.
        nw2 = New Window( "Factoring Fun: Message for ",
            "The number you chose, " || Char( fromUser0 ) ||
        )
    );

    /* How do you gather numeric input from the users, perform a calculation on that input, and show the results in a new window? 
   
   This script demonstrates how to create an interactive program that asks the user to enter a number and then factors the number or confirms it as a prime number. */

    // Ask the user to enter a name and number.
    nw = New Window( "Factoring Fun",
        V List Box( 
            Text Box( "Choose a number between 2 and 100, inclusive. " ),
            Spacer Box( Size( 25, 25 ) )
        ),
        V List Box( 
            Lineup Box( 2,
                Text Box( "Your name   ",
                    uname = Text Edit Box( "< name > ", << Justify Text( Center ) ),
                    Text Box( "Your choice " ),
                    uprime = Number Edit Box( 2 )
            ),
            Spacer Box( Size( 25, 25 ) ),
            H List Box( 
                Button Box( "OK",
                    // Unload responses.
                    username = uname << Get Text;
                    fromUser0 = uprime << Get;

                    // Test input for out of range condition.
                    If( fromUser0 <= 1 | fromUser0 > 100,
                        // Send message to user that input value is out of range.
                        nw2 = New Window( "Factoring Fun: Message for ",
                            "The number you chose, " || Char( fromUser0 ) ||
                    )
            )
        )
    );

    If( fromUser0 <= 1 | fromUser0 > 100, 
        // Send message to user that input value is out of range.
        nw2 = New Window( "Factoring Fun: Message for ",
            "The number you chose, " || Char( fromUser0 ) ||
        )
    );
" is not between 2 and 100, inclusive. Please try again. "
),
Button Box( "OK" )
),  // Else the number is within range.
// Test for a prime number. If not prime, factor it.
// Create a vector which holds the prime numbers
// within specified range.
primes = [2, 3, 5, 7, 11, 13, 17, 19, 23, 29, 31, 37,
41, 43, 47, 53, 59, 61, 67, 71, 73, 79, 83, 89, 97];
// Count the number of primes in the vector.
p# = N Row( primes );

isprime = 0;  // Set flag.
// Make a copy of the value for processing.
fromuser1 = fromuser0;
factors = {};  // Initialize list.

// Process the value by checking for prime then
// factoring if needed.
While( isPrime == 0,
    // Compare value to vector of prime numbers.
    If( Any( fromuser0 == primes ),
        // If found, place value in factor list.
        Insert Into( factors, fromUser0 );
        isPrime = 1  // Set condition to exit While loop.
    );  // End For loop.

    If( isprime == 0,
        For( q = 1, q <= p#, q++,
            If( Mod( fromuser0, primes[q] ) == 0,
                fromUser0 = fromUser0 / primes[q];
                Insert Into( factors, primes[q] );
                q = p# + 1  // End if-then loop.
            );  // End If loop.
        );  // End For loop.
    );  // End If/Then loop.

    );  // End while loop.

cfUser0 = Char( fromUser1 );
nf = N Items( factors );
If( nf >= 2,
   fmsg = "The number you have chosen has the following factors: ",
   fmsg = "The number you have chosen is a prime number: "
);
// Show message to user about results.
   nw3 = New Window( "Factoring Fun - Your Results",
   <<Modal,
      Text Box( username || ", you chose: " || cfUser0 ),
      Spacer Box( Size( 25, 25 ) ),
      Text Box( fmsg || " " || Char( factors ) ),
      Spacer Box( Size( 25, 25 ) ),
      Button Box( "OK" )
   );
), // End the main OK button script.
// Close the window and the program.
   Button Box( "Cancel", nw << Close Window )
);

Figure 16.5 Factor Numbers Interactively
This appendix provides information about changes that affect compatibility in JSL scripts.

Compatibility Issues

Application Builder Compatibility

In each version of JMP, Application Builder takes advantages of new features that are not supported in earlier releases. For maximum compatibility, we recommend that you create applications in the earliest version of JMP that the application is run in.

Random Index Function

To support Stratified Random Row Selection for Data Table Applications, the behavior of the Random Index() function has changed. Random Index (1,1) now returns a value of 1 instead of zero.

Escaped Backslash in Converted Blobs

Converting BLOBS into a printable format now escapes \ (in addition to ~ " ! and characters outside of the printable ASCII range) into hexadecimal notation (~5C for the backslash character).

This fix creates an incompatibility, starting in JMP 12.2, with the ASCII~HEX output. The issue might be seen in a user script that compares binary data using the ASCII~HEX notation:

```julia
x = Char To Blob( "abc\def\!n" );
y = Blob To Char( x, encoding = "ASCII~HEX" );
If(
    y == "abc~5Cdef~0A", "JMP 12.2 and later behavior",
    y == "abc\def~0A", "Pre-JMP 12.2 behavior"
);
"JMP 12.2 and later behavior"
```

Number Edit Box() No Longer Runs Script by Default

If you make a change to the value in a Number Edit Box(), it no longer runs the script after the change. To run the script, include the Run Script(1) function. Because JMP 11 behavior has been restored, the incompatibility exists only in JMP 12.
1x1 Matrices as Subscripts

When you use a 1x1 matrix as a subscript into a matrix or list, now the result is a matrix or a list instead of a scalar number. The following example compares the previous behavior with the JMP 13 behavior.

In JMP 12 and earlier:
```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
m = :height << Get Values(); // returns a matrix of values for height
tall rows = Loc(m >= 70); // returns [40]
m[tall rows];   // returns 70  (a scalar)
N Rows(m[tall rows]);  // returns an error
```

In JMP 13:
```julia
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
m = :height << Get Values(); // returns a matrix of values for height
tall rows = Loc(m >= 70); // returns [40]
m[tall rows];   // returns [70] (a matrix)
N Rows(m[tall rows]);  // returns 1
```

Get Marker Size() Message Returns a Number

The `marker seg << Get Marker Size()` message now returns a number instead of a name. If your script tests for a particular marker size, the test fails because of the name and number mismatch.

Save Script to Data Table Saves a Different Name

The `obj << Save Script to Data Table()` message saves a script by the report’s outline title now. Scripts that save the script and then try to access the saved script by the expected old name will fail.
```julia
dt = Open( "$SAMPLE_DATA/big class.jmp" );
ow = dt << Oneway( Y( :height ), X( :age ), By( :sex ) );
ow[1] << Save ByGroup Script to Data Table;
Wait( 0.5 );
ows = dt << Get Property( "Oneway 2" );
// This script now fails because the script is named "Oneway of height by age"  
// instead of "Oneway 2".
```

The workaround is to change the name that you use to access the script to the new name. You can also change the `Save Script to Data Table()` statement to explicitly save the script with the name that you want.

Showing the Result of a Display Box

When you show something that points to a display box, the class of the display box is returned along with the display box name.
Here is an example:

```plaintext
dt = Open( "$SAMPLE_DATA\Big Class.jmp" );
bivBy = dt << Bivariate( Y( :height ), X( :weight ), By( :sex ) );
Wait( 0 );
Show( bivBy << Report );
```

JMP 12 returns the following code:

```plaintext
bivBy << Report = {DisplayBox[], DisplayBox[]};
```

JMP 13 returns the following code:

```plaintext
bivBy << Report = {DisplayBox[OutlineBox], DisplayBox[OutlineBox]};
```

### Deprecated JSL

The following JSL functions are deprecated. Existing scripts continue to work. However, the old messages and syntax will be discontinued in the future.

#### Set Current Directory() and Get Current Directory()

The `Set Current Directory()` and `Get Current Directory()` functions are deprecated. In existing scripts, the behavior of these functions has changed.

- On Macintosh and Windows, the initial current directory is the user's Documents folder. Previously, Windows returned the folder that contained `jmp.exe` or the working folder set by the operating system when JMP is launched.
- Setting the current directory saves or returns the new value for backward compatibility though the value is not used.

#### Order Output Columns in the Split Platform

Split provides a new option to order output columns. Add a Value Order or Row Order Levels column property to the column and include `Sort by Column Property()`:

```plaintext
dt << Split(..., Sort by Column Property( "Value Ordering" {"string", "string"} | "Row Order Levels", ...));
```

`Sort by Value Order()` still works but will be deprecated in the future.
Arguments

An argument is something specified inside the parentheses of a JSL operator, function, message, and so forth. `Big Class.jmp` is the argument in `Open("Big Class.jmp")`. You can often infer the meaning by the argument’s position. For example, the values `200` and `100` in `size(200, 100)` are implicit arguments. The first value is always interpreted as the width; the second value is always interpreted as the height. See also named argument.

Booleans

A Boolean is a yes/no value, something that is on or off, shown or hidden, true or false, 1 or 0, yes or no. An operator listed as being a Boolean operator is one that evaluates to true or false (or missing).

cols

In syntax summaries, a placeholder for any reference to a data table column. For example, `Column("age")`.

Commands

A generic description for a JSL statement that performs an action. This book prefers the more specific terms operator, function, and message when they are applicable.

Current Data Table

The current data table is the data table that `Current Data Table()` either returns or is assigned.

Current Row

The current row for scripting is defined to be zero (no row) by default. You can set a current row with `Row()` or `For Each Row`, and so forth.

Databases

Although the term is much more general, for JMP’s purposes, the word “database” describes any external data source (such as SQL) accessed through ODBC with JSL’s `Open Database` command.

Datafeeds

A Datafeed is a method to read real-time data continuously, such as from a laboratory measurement device connected to a serial port.

dbs

In syntax summaries, a placeholder for any reference to a display box. For example, `report(Bivariate[1])`.

data tables

In syntax summaries, a placeholder for any reference to a data table. For example, `Current Data Table()` or `Data Table("Big Class.jmp")`.

Eliding Operators

An eliding operator is one that causes arguments on either side to combine and evaluate differently than if the statement were evaluated strictly left to right. For
example, 12<a<13 is a range check to test whether a is between 12 and 13: JMP reads the whole expression before evaluating. If < did not elide, the expression would be evaluated left to right as (12<a)<13. In other words, it would check whether the result of the comparison (1 or 0, for false or true) is below 13, which of course would always yield 1 for true. The << operator (for object<<message, which is equivalent to Send(object, message) is another example of an eliding operator.

function  A function takes an argument or series of arguments inside parentheses after the function name. For example, the infix operator + has a function equivalent Add(). The statements 3 + 4 and Add(3, 4) are equivalent. All JSL’s operators have function equivalents, but not all functions have operator equivalents. For example, Sqr(a) can be represented only by the function. Also see the Function operator for storing a function under a name.

global variable  A global variable is a name to hold values that exists for the remainder of a session. Globals can contain many types of values, including numbers, strings, lists, or references to objects. They are called globals because they can be referred to almost anywhere, not just in some specific context.

infix operator  In infix operator takes one argument on each side, such as + in arithmetic, 3 + 4, or the = in an assignment, a = 7.

L-value  Something that can be the destination of an assignment. In this manual, L-value describes an expression that normally returns its current value but that can alternatively receive an assignment to set its value. For example, you would ordinarily use a function such as Row() to get the current row number and assign it to something else. For example, x = Row(). However, since Row is an L-value, you can also place it on the left side of an assignment to set its value. For example, Row() = 10.

list  A list is a multiple-item data type entered in special brace { } notation or with the List operator. Lists enable scripts to work with many things at once, often in the place of a single thing.

matrix  A matrix is a JMP data type for a rectangular array of rows and columns of number. In JSL, matrices are entered in bracket [ ] notation or with the Matrix operator.

message  A message is a JSL statement that is directed to an object, which knows how to execute the message.

metadata  In JMP data tables, metadata are data about the data, such as the source of the data, comments about each variable, scripts for working with the data, and so on.

mousedown  An event generated by pressing down the mouse button. See “Handle()” on page 564 and “Mousetrap()” on page 568.

mouseup  An event generated by releasing the mouse button. See “Handle()” on page 564 and “Mousetrap()” on page 568.
name  A name is a reference to a JSL object. For example, when you assign the numeric value 3 to a global variable in the statement `a=3`, “a” is a name.

namespace  A namespace is a collection of unique names and corresponding values. Namespaces are useful for avoiding name collisions between different scripts.

named argument  A named argument is an optional argument that you select from a predetermined set and explicitly define. For example, `title("My Histogram")` in the `Graph Box` function is a named argument. In functions such as `New Window`, the `title` is not a named argument, because `title` is the first required argument.

ODBC database  The Microsoft standard for Open Database Connectivity. JSL supports access to any ODBC-enabled data source through the `Open Database` command.

obj  In syntax summaries, a placeholder for any reference to an analysis platform. For example, `Bivariate[1]`.

object  An object is a dynamic entity in JMP, such as a data table, a data column, a platform results window, a graph, and so forth. Most objects can receive messages telling them to act on themselves in some way.

operator  Usually operator refers to a one- or two-character symbol such as `+` for addition or `<=` for less than or equal to.

POSIX  POSIX is an acronym for Portable Operating System Interface and is a registered trademark of the IEEE. POSIX pathnames enable you to use one syntax for paths for any operating system, instead of having to use a different syntax for each.

postfix operator  A postfix operator takes on argument on its left side (before the operator), such as `a++` for postincrement or `a--` for postdecrement.

pre-evaluated statistics  Statistics that are calculated once and used as constants thereafter.

prefix operator  A prefix operator takes one argument on its right side (after the operator), such as `!a` for negation.

reference  A way to address a scriptable `object` in order to send it `messages`. For example, `column("age")` or `Current Data Table()` or `Bivariate[1]`. Typically a reference is stored in a `global variable` for convenience.

row state  A data element type to store any combination of the following attributes for data rows: excluded, hidden, labeled, selected, color, marker, hue, shade.

scalar  A simple non-matrix numeric value.

scoping operator  A scoping operator forces a name to be interpreted as a particular type of data element, for example the `:` operator in `:name` forces `name` to be resolved as a column; the `::` operator in `::name` forces `name` to be resolved as a global variable.

toggle  Omitting the Boolean argument for a row state command toggles the setting. If the option is off, the message turns it on. If the option is on, the message turns it off. Sending such a command repeatedly flips back and forth between on and off. If you include the
Boolean argument, the command sets an absolute on or off state, and sending the command repeatedly has no further effect. For all other messages, omitting the Boolean argument enables the option.

**vector** A matrix with only one column or row.
Symbols

__  262
; 81, 86
: 95, 369, 571
:: 94–95, 571
:* 177
!= 304
dbf file import 289
.shp file import 289
" 82
‘ 179
, 80
" 284
) 80
[ ] 167, 171, 486, 542
[...] 82
[Action] 278
[Boolean] 386
[Enum] 386
[New Entity] 387
[Scripting Only] 278
[Subtable] 278
{ } 160
//! 49, 53, 85
\! 82
\!" 82
\!\ 82
\!/ 82
\!b 82
\!f 82
\!N 82, 271
\!n 82
\!r 82
\!t 82
\!U 121
+ 155
+= 174
<< 37, 276, 383–384, 430, 435
= 85
== 368
>? 156
>> 156
| 39, 701
|/ 179, 202
|= 179
|| 156, 179, 202
||= 179
$1, regular expressions 154
$ADDIN_HOME variable 122
$ALL_HOME variable 122
$DESKTOP variable 122
$DOCUMENTS variable 122
$DOWNLOADS variable 122
$GENOMICS_HOME variable 122
$HOME variable 123
$SAMPLE_APPS variable 123
$SAMPLE_DASHBOARDS variable 123
$SAMPLE_DATA variable 123
$SAMPLE_IMAGES variable 123
$SAMPLE_IMPORT_DATA variable 123
$SAMPLE_SCRIPTS variable 123
$TEMP variable 123
$USER_APPDATA variable 124

A
Add Graphics Script 525
Add Multiple Columns 323
Add Rows 341
Add-In Builder 676
addin.def file, registering an add-in 682
adding script to graph 524
add-ins
    creating 676
    installing 680
    registering 681
Alarm scripts 397
algebra, in scripts 266
All 112, 175
analysis platform
by group 388
animated graphs 539
anonymous script 671
ANOVA 201
Any 112, 175
Append 479
applications
creating 661–671
editing and running 672
example of creating 654, 673–675
samples 659
saving 672
specifying data table 668
writing scripts 669–671
Arc 546
ArcBall 582–583, 585
arcs, drawing 546
Arg 222
argument
definition 38, 701
named, definition 38
Arguments (Enable command) 614
arithmetic, matrices 176
Arrow 543
arrows, drawing 543
As Column 95
As Global 95
As Row State 368
As Table 183
Assign 85
Associative Array 204
associative arrays 204–215
adding keys and values 207
assigning values 204
constructors 205
creating 204
default value 204
deleting keys and values 207
graph theory 211
N Items 206
traversing 209
attenuating light source 604
auto completion in scripts 54
Auto Scroll 659
auto-submit 85
axis property arguments 338
B
Background Color 554
background map, creating 573
back-quote 179
backreferences, regular expressions 154–155
backslash 82
Beep 271
Begin 586
Begin Data Update 371
Bézier curves 609
Bivariate 436, 538
blank space escape 82
BlendFunc 607
blinking display box 435
BLOB functions 139
Boolean
definition 701
Boolean commands 383
Border Box 442
Boundaries 573
Break 104
Break All 64
breakpoints in Debugger 67
Bullet Point 434
Button 507
Button Box 453, 484, 564
By 388, 390
By groups, in scripts 259
C
calendar 474, 675
Call List 583, 585, 596
call stack, debugger 67
cancel loop 101
capability analysis, script 488
Caption 272
carriage return 82, 284
Char 142, 225, 329
Check Box 454, 507, 516
Chol Update 197
Cholesky 196
Choose 109
Circle 548
circles, drawing 548
Clear 584
Clear Column Selection 330
Clear Globals 92
Clear Select 346
Clear Selection 457
Clone Box 528
Close 277, 294, 430
close button on tabs 496
closing outline node 430
code folding markers in script 59
coding (DOE) property arguments 338
col definition 701
Col List 508
Col List Box 443
Col List Box, Get Items 443
Col Maximum 375
Col Mean 375–376
Col Mean versus Mean 375
Col Minimum 375
Col N Missing 375
Col Number 375
Col Quantile 375
Col Span Box 444
Col Standardize 375
Col Std Dev 375–376
Col Sum 375
colons 94, 571
Color 577–578, 596
Color By Column 346
color definitions in JSL 364
color gradient arguments 338
Color Of 357, 360, 362, 366
Color Rows by Row State 347
Color State 360, 362, 365–366
color theme, Value Colors column
property 338
Colors 346
colors 554–557
Column 95, 320
Column Dialog 502, 504–505, 507
column formula 322
Column Name 328
column names
special characters 320
unscoped 96
Column Names Start, import argument 285
column properties
delete (JSL) 335
get (JSL) 335
set (JSL) 335
column references 320
column vector 169
Columns 505
columns
create new 321
exclude 280
grouping 323
numeric format 322
specify in Open 280
specify values 322
ungrouping 323
columnwise functions 376
Combine States 359–362, 546
Combo Box 455, 508
coma 80
and loops 101
command versus message 277
command, definition 701
comments 84
communications settings 618
Compare Data Tables 316
comparison operators 111
compatibility issues 421, 697
Concat 142, 202
Concat Items 142
Concat matrix 179
Concatenate 311
concatenate lists 168
conditional function 106
conditional logic 85
conditions in Debugger 69
connect libraries in SAS 636
container, Application Builder 657
Contains 163
Continue 105
Contour 552
Contour Function 536
contours, drawing 552
Control Chart Builder, Customize Tests 396
Control charts
  alarm scripts 397
control limits arguments 339
Convert File Path 125
converting character dates to numeric
dates 686
Copy Frame Contents 527
Create Database Connection 631
curly braces 160
currency codes 138
Current Data Table, definition 701
current data table, specifying 290
current row number 99, 349
  definition 701
current row versus selected row 349
Current Selection("extend") 344
current table row 97
custom graph 531
custom marker 563
custom platform 499
custom property arguments 341
Customize Tests, Control Chart Builder 396
customizing graph options 524
CV 375
Cylinder 596

D
dashboard, creating in script 490–496
data feed. See communications settings
Data Filter
  commands 352
    local 305
Data Filter 303
Data Filter Context Box 305, 468
Data Filter Source Box 469
data tables
  accessing values 369
  calculations 375
  capturing with a script 45
  closing 294
  column messages 319–341
  comparing 316
  creating 280
  hidden 280, 292
  importing 282
  invisible 292
  matrix 181–184
  naming 291
  opening 278
  printing 293
  private 293
  revert 292
  row messages 341–369
  row state scripting 352
  saving 291
  specify columns in Open 280
  specify in Application Builder 668
  testing for open 279
Data Type 331
database, open 629
datafeed
  control chart example 620
datafeed object 616
data-reading example 620
glossary 701
  messages 618, 622
  real-time data capture 616
date selector 474, 675
date-time
  formats 126–137, 332
  separators 132
  two-digit years 132
Day 130
Day Of Week 130
Day Of Year 130
db, definition 701
Debug Script 63
debugger
  breakpoints 67
  call stack 67
  log 67
  options 67
  preferences 67, 72
  set watch variables 67
  step options 64
  variable values 66
  view global variables 66
  view local variables 67
  view variables in namespaces 67
debugging
graphs 572
Index
Scripting Guide

With comments 84
Declare Function 623
decomposing matrices 194
decrement 165
decrypting scripts 260
default directory 125
Delete (Display box) 480
Delete Column Property 375
Delete Columns 328
Delete Formula 375
Delete Property 335, 375
Delete Rows 342
Delete Symbols 91
Delete Table Property 375
Delete Table Variable 375
deprecated JSL 699
Derivative 263, 265
Deselect 435
Design F 189
Design matrix 189
Design Nom 201–202
design role (DOE) arguments 339
DesignNom 189, 201
DesignOrd 189
Det 194
determinant, matrix 194
Diag 187
dialog boxes
creating 438–502
using JMP built in dialogs 257
Dialog versus New Window 514
Dialog, converting to New Window 511–520
Dif 351
difference summary matrix 317
Direct Product 190
Disable 614
disabled menu item 460
Disk 596
Dispatch 431
display boxes
blinking 435
containing platforms 488
creating 438–502
modal 502
showing properties 425
display trees, showing the structure 422
distribution property arguments 339
Divide 177
DLLs 623–624
docking tab boxes 494
DOE K Exchange Value 401
DOE Starting Design 401
double quotes 82
double underscore and variable names 262
DPI 453
drag and drop text, editor 58
Drag functions 570–572
Drag Line 570
Drag Marker 570–571
Drag Polygon 570–571
Drag Rect 570
Drag Text 570
drawing
arrows 543
circles 548
contours 552
cylinders 596
disks 596
lines 541
markers 545
ovals 549
pies and arcs 546
polygons 550
rectangles 549
spheres 597
text 598
drop-down list, JSL 455
dt, definition 701
dynamic link libraries 623

eager operator 218
Edge Flag 596
Edit Number 508
Edit Text 508, 518
editable combo box 455
eigenvalue decomposition 195
element-wise 87
elementwise matrix operator 177
eliding operator 384
definition 701
e-mailing tables or reports 260
empty data table, testing for 115
empty matrix 170
empty subscript 369
empty text 516
EMult 177
Enable 590, 603, 605, 614
encrypt applications 667
encrypting scripts 260
End 586
End Data Update 371
dead-end-of-field characters 285
dead-end-of-line characters 284
errors
column name resolution 95–96
debugging with Try and Throw 252
identifying in the Debugger 63
illegal row number 97
name resolution 97–98
scoping 96
escape sequences 82, 271
escaped characters, regular expressions 150
Eval 218, 220, 224–226
Eval Coord 596
Eval Expr 224, 226
Eval Formula 333, 374
Eval Insert 223
Eval List 160, 165, 224, 226
Eval Point 596
EvalMesh1 610
EvalMesh2 611
Evaluate OnOpen 373
evaluators
one-dimensional 609
two-dimensional 611
Excel Import Wizard, opening file in 287
Excel Profiler, scripting 649
exceptions 252
Exclude 352
exclude columns 280
Excluded 360–361
Excluded State 360–361
Execute SQL 631
Expr 218, 220, 225–226, 230, 234
Expr As Picture 453
expression definition 39
stored 228
expression column, subscript 163

F
factor changes (DOE), property arguments 339
Factorial 256
fence matching 56
field delimiters 285
file path format 125
Files In Directory 259
Fill Color 554
fill pattern, polygon 592
First 100
Fog 607
fonts, script editor 61
For 100, 437
For Each Row 99, 350, 357
Format 128, 134–135, 332
Format message versus Format function 332
Format() 134
formatting scripts 59
formfeed 82
Formula 377
formula column, creating 689
formulas
and Eval 220
column 322, 689
evaluation 373
freeze all 296
freeze frames 296
freeze frames with scripts 296
freeze pictures 296
Frustum 581
Function 253
function definition 37, 702
functions
local variables 254
operator equivalent 86

G
Get 438
Get Addr Info 627
Get All Columns As Matrix 181
Get As Matrix 181, 184, 330
Get Column Names 329
Get Data Table 294
Get Data Type 331
Get Format 332
Get Formula 330, 333
Get Items and Col List Box 443
Get List Check 334
Get Lock 335
get matrix from report 183
Get MM SAS Data Step for Formula Columns 633
Get Modeling Type 332
Get Name 291, 330
Get Path Variable 124
Get Picture 453
Get Properties List 336
Get Property 335–336
Get Range Check 334
Get Rows 345
Get Rows Where 182, 345
Get SAS DATA Step for Formula Columns 633
Get Script 334, 372
Get Selected 485
Get Selected Columns 326
Get Selected Indices 485
Get Selected Rows 182, 345
Get SQL Prediction Expression in Least Squares 412
Get Table Variable 371
Get Values 330
GetNameInfo 627
GInverse 192
Global Box 456, 473, 564
global variables 89, 92, 95
    and Expr 219
    and functions 256
    and in-place operators 229
    and matrices 195
    column names 369
definition 702
    interactive display elements 456
    prefix operator 369
    referencing a column 320
GLOBALREPLACE, regular expression 145
Glue 100
    glueing expressions 81
Go To 326
Go To Row 343
Gradient Function 538
Gram-Schmidt method 198
Graph Box 213, 239, 305, 449, 486, 531, 534
graph theory and associative arrays 211
    creating 531–533
    primitives 586
    resolution 453
greedy and reluctant regular expressions 151
grouping columns 323

H

H List 514, 516
H List Box 306, 445, 516
H Sheet Box 450
H Splitter Box 446
Handle 564–568, 571–572
Has Data View 292
HDF5 files, importing 289
HDirect Product 191
HeadName 223
Hex to Char 140
hexadecimals 139
Hidden 360–361
hidden data tables 292
Hidden State 360–361
Hide 352
HLine 543
HList 508
Host Is 117
Hour 130
HTML tags in text boxes 466
Hue State 360, 365–366

I

Identity 186
If 106
If Box 446
Ignore Columns 280
Images 573
Import Spec Limits() 407
importing
    create an import script 46
Index

Scripting Guide

data 281–290

data from website 288
database 290
HDF5 289
Microsoft Excel file 287
password-protected file 290
SAS data set 288, 635
shapefile 289
text file 282

In Days 132
In Format 128
In Hours 132
In Minutes 132
In Polygon 551–552
In Weeks 132
In Years 132
Include 256
indenting code 59
Index 175, 188
indexing, JSL 180
infinite loop, stopping 101–102
infix operator 85, 95
Informat 134
Informat() 134
in-place operators 229, 231
Insert 228, 233
Insert Into 228–229, 231, 233
instruments, connecting 618
interactive graph, creating 564–572
interactive program, creating 694
Interpolate 110
interpolation 223
Intersect, find common values 211
Invalid Row Number error 96, 370
Inverse 191–192
inverse matrix 191, 199
Invert Expr 266
Invert Row Selection 343
Invert Selection 304
invisible
data table 280, 292
Invisible Reports 393
Is Directory 116
Is Empty 115, 279
Is List 166
Is Matrix 114, 175
Is Missing 111, 113
Is Scriptable 115, 279
ISO 4217 codes 138
iterate 100, 348

J

J 187, 201
JMP Version 117
jmpStart.jsl 686
joining
data tables 312
lists 168
Journal 295
Journal Box 452
journals, creating 433
JSL Encrypted 262
JSL Quote 219
JSL, definition 33

L

Labeled 360–361
Labeled State 360–361
labels, column headers in text file 285
Lag 351
least squares estimates in script 268
legend, adding 540
LELE 334
LELT 334
Light 602
Light Model 604
light, attenuating 604
lighting, in 3-D scenes 597, 602
Line 541, 545
line break character 82
line delimiters 284
Line Stipple 590
Line Style 562
Line Up 509
Line Up Box 447, 514, 517
Line Width 590
LINE_LOOP 588
LINE_STRIP 588
linefeed 82, 284
LINES 587
lines, drawing 541
List 160, 166
list
  nested 169
List Box 449, 456, 509
List Check 333
list check
  arguments 337
  setting and getting 333
lists
  creating 160–169
  manipulating 228–230
Load DLL 624
Load Matrix 601
Load Text File 257
Loc 163, 184
Loc Max 185
Loc Min 185
Loc Nonmissing 185
Loc Sorted 185
Local 90, 92
local arguments 253
local data filter 305
Local Here 239
local variables 89
  in functions 254
Lock 335
Lock Globals 91
log
  debugger 67
  embedded 63
Look At 584
lookaheads, regular expressions 154
Lookaround 154
loops, cancel 101
lowercase 40
LTLE 334
LTLT 334
L-value 93, 229, 231, 233, 349, 571
  definition 702
Expression Role 340
  Multiple Response 340
  Profit Matrix 340
  property arguments 340
  Supercategories 340
Map1 610
Map2 611
Mapgrid1 610
Mapgrid2 611
maps, creating in script 573
Marker 366, 545–546
Marker by Column 346
Marker Of 360, 362
Marker Size 545
Marker State 360, 362
Markers 346
markers
  creating custom 563
  drawing 545
markers, numbers in script 363
Match 107
matching fences 56
matching parentheses 56
Material 596
MATLAB 639–641
Matrix 171, 542
matrix
  and data tables 181
  arithmetic 176
  arithmetic operators 263
  comparisons 175
  concatenation 179
  constructing 170
  convert expressions to 171
  converting list to 171
data tables 181–184
deleting rows and columns 173
diagonal 179
empty 170
extracting values from reports 183
get from report 183
inverse 199
logical operators 175
numeric functions 178
range checks 175
range of rows or columns 175
Index

Scripting Guide

ranking 186
selecting rows or columns 173
solving linear systems 191
sorting 186
special constructors 186
stack in 3-D scene 599
submatrix 172
subscripting 171
summarizing columns 183
transposing 179
Matrix Mult 176
Max 176
MaxCol 505
Maximize 267
Maximum 375
Mean 375
memory issues, data tables 293
menu separator 454
messages
column objects 320
definition 702
nested 431
messages definition 37
Meta Connect 635
Meta Get Servers 635
metadata 371
glossary 702
Microsoft Excel file import 287
Min 176
MinCol 505
Minimize 267
Minimum 375
Minute 130
Missing Data Pattern 316
missing value codes
arguments 337
in column formulas 376
missing values
comparisons 111
converting column from character to numeric 134
in comparison 113
mixture (DOE) arguments 338
modal dialog boxes, using JMP built in dialogs 257
Modeling Type 332
modules, Application Builder 656–657, 661
Month 130
Mouse Box 457
mouse, capturing activity 612
mousedown definition 702
MouseTrap 564, 568–569, 571–572
Mousetrap 568–570
mouseup definition 702
Move Rows 346
Move Selected Columns 327
Mult Matrix 601
Multiply 176
Munger 143–144

N
N Items 166
name 83
definition 703
Name Expr 142, 234
name resolution 92–99
named argument 38
definition 703
named script 670
NameExpr 218, 220, 226, 231
Names Default To Here( 1 ) 90, 235–236
namespaces 235–251
definition 703
in Application Builder 657
messages 243
NaN 83
NArg 221
NCol 175, 350
nested list 169
New Column 321, 377
New Data Box 294
New Namespace 241
New Table 277, 280
New Table Variable 371
New Window 531
New Window versus Dialog 511, 514
Next Selected 346
NMissing 375
Normal 596
Normal Contour 537–538
normal vectors 605
not equal, data filter 304
notes (column) arguments 337
not-in-place operators 229, 231
NRow 175, 343, 350
null character 82
Num 226
Num Deriv 264
Num Deriv2 264
Number 375
Number Col Edit Box 459, 519
Number Edit Box 459, 475, 515, 519
Number of Columns, import argument 283
numbers in JSL 83, 120
NumDeriv 265
NumDeriv2 265

O
obj definition 703
object 486
definition 703
objects definition 37
ODBC 629
definition 703
On Close 477
On Open 373
On Validate 477
Oneway 383
Open 277–278
open data table, test for 279
Open Database 290, 629
Open Datafeed 616–618, 620
OpenGL 576
OpenGL, transposed matrix 599
operating system, detecting 117
operators 85
definition 37, 703
function equivalent 86
numeric 263–265
precedence 86
optional arguments, definition 39
OR operator 39
Or, missing values 113
Ortho 198, 581
Ortho2D 582
orthogonal polynomial 199
Orthographic projections 579
orthonormalize 198

OrthoPoly 199
Outline Box 420, 429, 448
Oval 549
ovals, drawing 549

P
Panel Box 449, 518
parameter, definition 38
parentheses
matching 56
purpose 80
Parse 225–226
Parse Only 256
Parse XML 649–650
Partial Disk 597
Password 290
password-protect applications 667
Paste Frame Contents 527
Patch Editor.jsl 612
path format 125
path variables 121–126
pattern matching 155–158
patterns, case insensitive 158
Pen Color 554
Pen Size 562
Perspective 577, 580
Perspective projections 579
Phase Limits Table 398
Pick 613
Pick Directory 257
Pick File 257
Picture Box 420
Picture data type 452
Picture Object 452
Pie 546
pies, drawing 546
pipe symbol 39
Pixel Line To 563
Pixel Move To 563
Pixel Origin 563
platform
by group 388
platform scripting 379
writing interactively 380
platforms versus reports 428
Point Size 590
POINTS  587
Polygon  550
Polygon Mode  592
Polygon Offset  595
POLYGON primitive type  587
polygons, drawing  550
Pop Matrix  585
Popup Box  459
POSIX  125
   definition  703
Post Decrement  165
Post Increment  165
postfix operator  85
   definition  703
pre-decrement operator  165
pre-evaluated statistics  97, 375
   definition  703
pre-evaluated statistics versus Summarize
   arguments  375
preferences
   On Open scripts  373
      user customization file  124
pre-fill columns  505
prefix operator  85, 95, 369
   definition  703
Prepend  480
Preselect Role  335
Previous Selected  346
Print  218, 270–271
Print Window  293
private data tables  280, 293
procrastination operator  218
Product  103
projections
   orthographic  579
   perspective  579
Push Matrix  585, 599

Q
QR  199
QUAD_STRIP  588
Quadric Draw Style  597
Quadric Normals  597
Quadric Orientation  597
QUADS  588
Query  631

quotation marks  284
quoting an expression  218
quoting an expression as a string  219
quoting operator  218

R
R  641–648
Radio Box  460, 518
Radio Buttons  509, 515, 518
Random Reset  333, 374
Range Check  333
range checking  333
   arguments  337
Range Slider Box  472
Rank  186
Ranking Tie  186
rearrange columns  327
Rect  549, 553
rectangles, drawing  549
Recure  256
recursive, listing files in a directory  259
reference  486
   definition  703
reformatting scripts  59
Regex Match() example  146
Regex() and Regex Match()  147
Regex() examples  145
regression calculation  200–201
regular expressions  145
relative directory  125
Remove  228, 233
Remove From  228–229, 231, 233
Repeat  144
Report  489
reports
   creating in script  436
   getting values in script  439, 690
Reshow  435
response limits (DOE, desirability profiling)
   arguments  339
Return Result  439
Reverse  228, 233
Reverse Into  228, 234
reverse rotation  196
Revert  292
Rotate  578, 582, 593, 598
rotating a cylinder 583
rotation 196
Row 97, 99, 349
Row Legend 540
row order levels property arguments 338
Row State 357, 359, 362
row state combination 360
row states 352–369
   definition 703
row vector 169
rows
   adding 341
   colors and markers 346
   deleting 342
   moving 346
   selecting 343
rowwise functions 376
Run 401
Run Formulas 333, 374
Run Model 401
Run To Cursor 70

S
SAS
   data set import 288
   library reference 636
   macro variables 634
   metadata server 635
   scoring code in Model Manager 633
   variable names 634
   view libraries 636
SAS Assign Lib Refs 636
SAS Connect Libraries 636
SAS DATA Step code for formula columns 633
SAS Get Data Sets 636
SAS Get Lib Ref 636
SAS Name 634
SAS Open For Var Names 634
Save 291
Save Database 630
   save formula as picture 453
Save Picture 453
Save Text File 257
scalar 170
   definition 703
scaling 196
Scan Whole File to determine data type, import argument 284
Scene Box 576, 583, 589, 591, 593, 605, 607
Scene Display List 589, 593, 599
Schedule 268
scoping 92, 94–99, 238
   operator definition 703
   resolving unscoped names 93
scripts
   automatically completing 54
   automatically run 49
   collapsing code 59
   colors 53
   creating a new data table 45
   dragging and dropping 58
   encrypting and decrypting 260–263
   gluing together 47
   importing a file 46
   indenting code 59
   run at startup 686
   run automatically 53
   running 52
   saving to data table 44
   setting fonts 61
   showing tooltips 54
   splitting the window 55
   stopping 53
Scroll Lock 336
Second 130
Select 435
Select All Matching Cells 345
Select All Rows 343
select checkboxes 454
Select Columns 280
Select Matching Cells 345
Select Rows 343
Select Where 311, 343–344
Selected 360–361
Selected State 360–361
selecting rectangular block of code 57
semicolon 81
   and loops 101
Send 276, 320, 384
Send To Report 431
separators, date-time 132
Sequence 351
Set and Get messages 330
Set Data Table 294
Set Each Value 323, 374
Set Formula 330, 332–333
Set Function 483
Set Label Columns 336
Set Lock 335
Set Matrix 183
Set Name 291, 330
Set Property 335–336
Set Row States 368
Set Script 483
Set Scroll Lock Columns 336
Set Selected 326, 485
Set Style 465
Set Table Variable 371
Set Values 322, 330, 434
Set Wrap 434
Shade Model 605
Shade State 360, 365–366
Shape 188
shapefiles import 289
Sheet Box 450
Shift 228, 233
Shift Into 228, 233
Show 218, 270
Show Arcball 586
Show Globals 90
Show Properties 277–278, 320, 385
Sib Append 481
sigma property arguments 339
Simplify Expr 266
sine wave scripts 486, 533–535
singular value decomposition 197
slice matrix 173
Slider Box 461, 471, 473, 564
smart quotes 284
sockets 626–629
Solve 192
Sort 308
Sort Ascending 186
Sort Descending 186
Sort List 229, 234
Sort List Into 229, 234
Spacer Box 462
spaces in JSL 83
Speak 271
spec limits property arguments 338
special characters, regular expressions 148
Sphere 597
Split 309
splitter boxes 446
SQL
  writing a query 631
Stack 309
StatusMsg 273
Std Dev 375
Step 110
step through expressions in Debugger 64
stop a script 53
String Col Edit Box 463, 519
strings 120
strip quotes from imported data 284
Subscribe 318
Subscribe 171, 486
subscript in expression column 163
subscripting column names 370
subscripting to a row in a column 370
subscripts 162
  columns 321
  empty 369
  with column references 320
Subset 302
Substitute 230–231, 234
Substitute Into 230–231, 234, 499
Substr 120
Sum 375
Summarize 297, 300, 348, 476
Summary 297, 300
Summary table 317
Summation 103
supercategories, categorical 395
Suppress Formula Eval 373
SVD 197
Sweep 192, 194, 202

T
Tab Box 464
tab escape sequence 82
Tab Page Box 464, 491–492, 494
Tab Page Box, compared to Tab Box 521
Table Box 420
Index
Scripting Guide

V
V List Box 445, 516
V Sheet Box 450
V Splitter Box 446
value colors 347
value colors arguments 338
Value Labels 331
value labels arguments 337
value ordering arguments 337
Values 322
variables 89
  hiding 92
  override paths 125
  path 121
  resolving conflicts 250
VConcat 202
VConcat matrix 179
VecDiag 188
VecQuadratic 188
vector of integers 188
vectors
  definition 704
  normal 605
Vertex 596
vertical bar 39
virtually join data tables
  JSL 313
VLine 543
VList 509
V

U
underscores and variables names 262
ungrouping columns 323
Unicode 121
uninitialized variable 115
units of measure arguments 338
Unlock Global’s 92
unquoting operator 218
unscoped column names 96
unscoped names 92
Unsubscribe 318
Update 314, 577
uppercase 40
Use Value Labels 331

W-Z
Wait 271
watch, add in Debugger 71
web pages, import 288
Week Of Year 130
While 101
white space 40, 83–84, 86
wildcard 428
windows
  messages for 395
wrapping text, text box 434
Write 218, 271
X Function 534
XML, Parse XML 649
xmlAttr 649
xmlText 649
XY Function 535
Y Function 533
Y2K date interpretation 132
Year 130
year 2000 date interpretation 132
years, formatting 132
Zero Or Missing 111, 114